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Starting 
Overview 

WordStar® Professional Release 5 is a full-featured, flexible, word processing 
program. WordStar Professional offers two types of menus to meet your writing 
and business needs-the traditional classic Word Star menus and new pull-down 
menus. You can work with one type of menu all the time or switch back and 
forth at the touch of a key. 

If you already use Word Star, you'll be glad to know that the classic Word Star 
menus haven't changed except for the addition of many new commands. If 
you're a first-time or occasional WordStar user, you'll learn to work quickly, 
using the pull-down menus. Pull-downs make learning WordStar virtually effort­
less. You don't have to memorize any commands. 

The WordStar onscreen tutors and the "Training Guide" teach you how to use 
pull-down menus. The "Reference Guide" covers both pull-down menus and 
classic menus. Once you've learned the basics, you'll find practical suggestions 
and examples for using WordStar in the "Applications" tab section. Pocket 
WordStar is a handy little guide that you'll want to keep near your computer. It 
shows both pull-down and classic menus and lists all the Word Star commands. 
If you like to use function keys for word processing, the keyboard overlay shows 
the 40 function key combinations available with WordStar. (You can change the 
function key assignments if you want.) 

WordStar Professional Release 5 also includes several other programs to make 
your work easier: Mail LiseM-for preparing mailing lists and form letters, 
Tel Merge®-for sending and receiving electronic mail and using telecommunica­
tions services, ProFinder™-for organizing your hard disk and locating files 
quickly, and PC-Outline™ by Brown Bag Software®-for creating outlines and 
arranging information in an easy-to-use structure. 
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5-2 

For a summary of all the new features of Word5tar Professional Release 5, be 
sure to read What's New. Experienced WordStar users will appreciate the list of 
new and changed commands at the back of What's New. 

When you install WordStar, it's set for pull-down menus. You can change the 
default setting to classic menus, if you I ike, in the installation program. And you 
can always change back and forth between pull-down and classic menus while 
you're using WordStar, simply by changing the help level. 

highlighting OPENING menu bar 

!!!!t!he!r!!!~!id~di~t~io!n~al!!!!!!!!!!!!!!!!!!!!!!!!!!ol.'.G 
-Speed Write (new file) S 

L Open a document r i Ie ... D ~II He lease 5 
from MicroPro 

Open a nondocument file ... 
"I ..... ~~~~~ .... m 

.6k BOX Print a file ... P EHVELOPE . LST .5k HP-EHV.LST 
HP-E Merge print a file ... It HP2-EI'IVM. LST .6k I HUHTORV . DOT .4k 
IHVH I HVHTORV . JiDX .lk LAlIEL. LST .1k 
LABE Change dr ive/d irectory ... L LABELA .ak LABELXL. LST .1k 
LABE LASER2. DOC 3.1k LSHLABL3. LST 3.l!Ik 
MAIL Copy a file ... 0 PROOF. LST 1. ok ROLODEX. LST . ik 
ROLO Delete a fi Ie ... 'i SHOLAB3 3.1k SHOLABEL .9k 
SHOL Rename a file ... E TABLE. DOC .9k TEXT. DOC 5.5k 
WIHD Protect/unprotect a fi Ie ... C WSLIST.DTA .1k WSLIST. HDX .1k 

Ex it WordStar )( 

t 
commands 

PUll-down menu 

You'll notice the titles of the pull-down menus on the menu bar that runs across 
the top of the screen. The OPEN INC menu bar has three menus; the EDIT menu 
bar has seven. To pull down a menu, move the cursor to the title on the menu 
bar. To choose a task or command on a menu, move the cursor to it and 
press ~. Pull-down menus give you roomto use the entire screen for writing 
and editing. A menu appears at the touch of a key when you want it; when you're 
finished, it goes away. Although you'll find all the commands you need for your 
everyday word processing tasks on pull-down menus, you're not limited to those 
choices. You can also use classic commands when the menu bar is displayed. 



STARTING 

The classic menus are familiar to long-time WordStar users. The Opening Menu 
presents a list of file management tasks. Each task or command is assigned a 
letter. To choose a command, press the appropriate letter. 

D open a document 
S speed write (new file) 
" open a nondocument 
P print a file 
~ merge print a file 
I index a document 
T tah Ie of contents 
)( ex it WordStar 
J help 

I' " 
BOX .4k 
ENVELOPE.LST .5k 
HP-ENUMM.LST .6k 
I NVNTORV . DTA . 1k 
LABEL3. LST . 1k 
LABELXLA 1. 1k 
MAILLIST.DOT .4k 
ROLODEXA 1.4k 

BROCHURE. DOC .5k 
FIRST.BAK .Bk 
HP2-ENV.LST .&k 
I HVNTORV . LST 2. Bk 
LABEL3A 2.1k 
LASER 1. DOC B. 3k 
PHONE. LST 1. Bk 
RULER. DOC .9k 

~ E " U 
L change drive/directory 
C protect/unprotect a file 
E rename a file 
o copy a file 
'i 4elete a file 
F turn directory off 

Esc shorthand 
R run a DOS command 
AI additional 

DIARV.BAK 3.6k 
FI RST . DOC '. Bk 
HP2-ENVM.LST .&k 
I HUHTORV . NDX . 1k 
LABEL A . Bk 
LASER2. DOC 3. 1k 
PROOF. LST 1. &k 

II down 
DIARV.DOC 3.&k 
HP-ENV.LST .Gk 
INVNTORV.DOT .4k 
LABEL.LST .1k 
LABELXL. LST . . 1k 
LSRLABL3.LST 3.Bk 
ROLODEX.LST .1k 

Classic menu 

When you're typing a document, the classic Edit Menu is displayed at the top of 
the screen. To choose commands from the Edit Menu, hold down the Ctrl key 
while you press the command letter. Saine commands on the Edit Menu take 
you to other menus. 

Which set of menus should you use? If you've never used Word Star before, start 
with the pull-down menus. You'll be amazed how quickly you'll become pro­
ductive with WordStar. If you know a little about Word Star but use it only occa­
sionally, the pull-downs are great because you don't have to remember any 
commands from one time to the next. There's nothing to memorize. 

If you're an old hand at WordStar, you'll most likely decide to stick with the 
classic menus. You're accustomed to power typing with the classic commands, 
where you can do all your work and keep your fingers on the home keys. And 
you already know how the commands are grouped on the various menus. Re­
member that you can install Word Star with classic menus as the default setting. 

Now it's time to install WordStar Professional. Follow the easy instructions to set 
up WordStar and begin using it. 
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Notes for WordStar® Users 
Who Are Upgrading to Release 5 ________ _ 

If you're a very experienced WordStar user, you can probably just copy the disks 
from the WordStar Professional package and run WINSTALL. Be advised though 
that the basic installation has been changed. (Hard disk users, copy your disks 
into a new directory called WS5.) Keep these important points in mind: 

• The basic WordStar installation takes place in WINSTALL. Custoniization and 
technical changes to WordStar (patching) take place in WSCHANGE. If you 
patched WordStar extensively in a previous version, see Appendix C, 
"Customizing WordStar," and the README program for information about 
which patches will work in Release 5. 

• Your CONFIG.SYS file must have a FILES = 20 statement. WINSTALL checks 
for this and adds the statement. Be sure to complete this step during installa­
tion and reboot at the end. 

• When you install, you'll notice that WbrdStar is set for pull-down menus (help 
level 4). If you prefer, you can change the default to classic menus during 
installation. You can also change back and forth between pull-down and 
classic menus while you're using Word Star. If you plan to go through the 
lessons in the "Training Guide," make sure you're using the pull-down menus. 

• This release includes new dictionaries for the thesaurus and spelling checker. 
Personal dictionaries created in previous versions of Word Star are obsolete. If 
you want to continue using an old personal dictionary, do the following: 

Once WordStar is installed, open the personal dictionary file in nondocument 
mode. Mark the entire fi Ie as a block. Use "KZ to sort the contents of the 
personal dictionary into ascending order. If you have a two floppy disk system, 
save the personal dictionary file to the Spelling Dictionary and Thesaurus 
disk, not the Program disk. 

• For the convenience of hard disk users, WordStar is set up to run in a directory 
called \ WS5. If you want a different directory name, you need to change the 
name in WSCHANGE. 

• In WordStar Professional Release 5, the Esc key is used most often to escape 
or "back out" of a screen or menu without making a change. Esc is no longer 
used to accept defaults or to set tabs and margins at the cursor location. You 
can reprogram the Esc key in WSCHANGE to work as itdid in previous re­
leases. 

• The onscreen tutors provide a tour of pull-down menus. If you're installed for 
classic menus instead of pull-downs, the tutors prompt you to reset the help 
level to 4 (pull-downs). For the tutors to run correctly, a nonproportional 
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STARTING 

• This version of WordS tar has many new features and requires more disk space 
and memory (minimum 384K RAM) . 

• To get the most out of Word Star on a two floppy disk computer, refer to the 
README program for information about creating specially configured 
Program disks. 

Installing WordStar Professional Release 5 
First you'll copy your Word Star disks. Follow the instructions for your type of 
computer. 

IF YOU HAVE A HARD DISK COMPUTER 

These instructions are for copying either sl/4-inch or 31/2-inch disks (incl.uding 
hard disk laptop computers). You'll need the disks that came in your package. 

Usually, you'll have a floppy disk drive labeled A and a hard disk drive labeled C. 
If your disk drives are labeled differently, make the appropriate substitutions. 

You'll create a directory for WordStar. Of you would like more information about 
directories, see your DOS manual.) Then you'll copy the Word Star disks into 
that directory. 

1 Turn on your computer. 

2 At the system prompt (C », type md \ ws5 and press ~ to create a directory 
called WSS. 

3 Type cd \ws5 and press ~ to log on to this new directory. 

4 Put the disk containing the Program in drive A. 

5 Type copy a: * . * and press ~ . 

6 When the copying is finished and you see C> on your screen, remove the 
disk from drive A. 

7 Repeat steps 4, 5, and 6 to copy the remaining disks onto your hard disk. 
(You don't need to copy the Tutor disk.) 

Note: WordStar is set up to run from the directory you just created, \ WSS. If you 
want to put Word Star in a different directory, you must indicate the directory 
name in a program called WSCHANGE. See Appendix C, "Customizing 
WordStar." 

Now, turn to "Running WINSTALL" later in this section. 
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IF YOU HAVE A TWO FLOPPY DISK COMPUTER 

Follow the copying instructions for your type of disk drive. 

SIf4-inch or 3 1b-inch Disks (Including Two Floppy Disk Laptops) 
You'll need Your DOS disk 

The disks in your package 
Enough blank formatted disks to copy each disk plus one extra, 
if you plan to go through the "Training Guide. /I (See your DOS 
manual, if you need help with formatting.) 

Follow these steps to copy your disks. Two floppy disk drives are usually labeled 
A and B. If yours are different, make the appropriate substitutions. 

1 Turn on and boot your computer. 

You'll see A> on your screen. 

2 Remove the DOS disk from drive A and replace it with the disk containing 
the Program. Put one of your blank formatted disks in drive B. 

3 Type copy a: * . * b: and press ~ . 

The copying is finished when you see A> on your screen once again. 

4 Remove both disks from the drives. Label the newly created disk. 

S Repeat the procedure in steps 2, 3, and 4 to copy the remaining disks. (You 
don't need to copy the Tutor disk.) 

Use your copies of the Word Star disks. Store the originals in a safe place. If you 
plan to go through the lessons in the "Training Guide," you should have one 
extra blank disk. 

The README program has suggestions about customizing disks. To run 
README, see "The README Program" later in this section. 

Now, turn to "Running WI NSTALL" later in this section. 

High Capacity Disks (Floppy Disks with More than 1 Mb of Disk Space) 
The way you set up WordStar to run on your two floppy disk system depends on 
the capacity of the floppy disks. Following are suggestions for combining the 
disks from your package onto 1.2M or 104M blank, formatted disks. If you plan 
to go through the lessons in the "Training Guide," format one extra blank disk. 
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Assemble the disks containing these programs and copy them to a high capacity 
disk as follows: 

Disk 1 Program 
Dictionaries 
Definitions Dictionary or Advanced Page Preview 

If your second disk drive is also high capacity, copy the disks with these programs 
to another high capacity disk: 

Disk 2 Installation 
Pri nter Data 

If your second disk drive is low capacity, copy the disk with this program to a low 
capacity disk: 

Disk2 Installation 

Group the remaining programs according to your needs. Remember to copy to 
high or low capacity disks according to the disk drives where they'll be used. 
You don't need to copy the Tutor disk. The README program has more sugges­
tions about customizing disks. To run README, see "The README Program" 
later in this section. 

Use your copies of the WordStar disks. Store the originals in a safe place. 

Now you can install WordStar. 

Running WINSTALL 
You install Word Star so it will work with your computer, printer, and monitor. 
The basic installation takes place in a program called WINSTALL. 

If you have a hard disk computer, make sure you're in your WordStar di rectory 
\WS5 (type cd\ws5 and press ~). Type winstall ws and press ~ . 

/fyou have a two floppy disk computer, put your copy of the disk with the 
Program in drive A and your copy of the disk with the Installation in drive B. 
Type b: and press ~ to log on to drive B. Type winstall a:ws and press ~. 

You'll see the Main Installation Menu on your screen. 

Note: If you type just winstall to start the program, you'll be asked which file 
you want to install. Type ws to install the file WS.EXE. 
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The Main Installation Menu offers choices for the basic installation of your pro­
gram. Each selection leads to another menu with more specific choices. Don't 
worry if you make a mistake. After you've gone through all the menus, you can 
change your selections. 

Installing Your Monitor 
If you have a monochrome monitor that's 100% IBM® compatible, you can skip 
this section and go to "Selecting Your Printer." WordStar is already set up to 
work with this type of monitor. 

If you have a color monitor, a monitor that is not 100% IBM compatible, an IBM 
EGA monitor, or an IBM CGA monitor, follow these steps: 

1 Press A to display the Console menu. 

2 Press A to display the Monitor selection menu. 

3 If you have a 100% IBM-compatible monitor using video RAM directly, press A. 

If you have a 100% IBM-compatible monitor using CGA video RAM, press B. 

If you have a color monitor, or a monitor that is not 100% IBM compatible, 
press C to choose "ROM BIOS." 

If you have an IBM EGA monitor and want to display 43 screen lines, press D. 

If you want to display only 25 lines, press A. 

4 Press X to return to the Console menu. 

S You can also choose the followi ng: 

How you want underlined text displayed onscreen 

What character you want to display a soft space 

Default colors 

Default monochrome 

To make these changes, press the appropriate letter. If you're not sure what to 
do, skip this. 

6 Press X to return to the Main Installation Menu. 

Installing Your Printer 
Next you'll tell WordStar what kind of printer you have. If you have more than 
one printer, you'll install them one at a time. 

If you have a two floppy disk computer, have your Printer Data disks handy. (The 
Printer Data disks contai n the list of printers.) When it's time to insert a Printer 
Data disk, you'll see a message on the screen. For help during printer installa­
tion, press the key marked Fl. 
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STARTING 

1 Press B to see the Printer selection menu. 

2 Follow the instructions on the screen to find your printer and select it. (If your 
printer isn't listed on any of the menus, see the Printer Information booklet 
for suggestions on what printer to use.) 

Information aboutthe printer you select is stored in a printer description file 
called a "POE" 

3 To name the PDF file for your printer, type a filename of up to eight charac­
ters. (It's especially important to use a descriptive name if you're installing 
more than one pri nter.) 

4 You can also change these settings atthe Additional Installation Menu: 

Add and remove font groups, if they're available for your printer. 

Select a printer adapter port-how a printer is connected to the computer. 
Word Star assumes that the default printer is connected to your computer at 
the port called "LPT1." (Later, you'll select which of your printers should be 
the default printer, the one WordStar uses automatically to format and print a 
document.) If you're installing other printers, be sure to change the printer 
adapter port setting for each if necessary. 

Install a sheet feeder if your printer uses one. 

View (or print) printer information for each selected printer, if you like. 

To make these changes, choose the appropriate item from the menu. If you're 
not sure what to do, skip this. 

5 Return to the WINSTALL Main Installation Menu. If you have more than one 
printer, follow the same procedure to install each one. 

If you're an advanced user, you can modify PDF settings by running the WordStar 
custom ization program WSCHANG E. Just type WSCHANG E at the system 
prompt and press ~ . (If you have a hard disk, make sure you're at the WordStar 
directory prompt. If you have a two floppy disk system, WSCHANGE is on the 
Installation disk.) For more detailed information about PDF files or 
WSCHANGE, see Appendix C, "Customizing Wo rd Star. " 

Choosing the Default Printer 
If you've installed more than one printer, select which should be the default 
printer (the one WordStar uses if you don't specify a printer). 

1 Press C to select the default printer. 

2 From the list of installed printers, select which will be the default. 
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Naming Your Disk Drives 
Now, you'll tell Word5tar which disk drives your computer has and which one 
you'll run Word5tar from. 

1 At the WIN5TALL Main Installation Menu, press D to see the Computer 
menu. 

2 Press A to choose your disk drives. 

3 Press Y (for yes) to change the information. 

4 Type the letter of the drive where your Word5tar program files will be located. 
(On a two floppy disk computer, this is usually A, and on a hard disk com­
puter, C.) 

5 Ifthe disk drive you just named is floppy, press Y. If it's hard, press N. 

6 Type the letters of the remaining drive(s) on your computer and indicate if 
each is floppy or hard. 

7 Press ~ when you are finished. 

WIN5TALL displays your selections. An asterisk appears next to the disk drive 
where your Word5tar files will be located. 

8 At the prompt, Do you want to change this? (YIN), press N if your drive selec­
tions are correct. You'll return to the Computer menu. 

If you need to change your drive selections, press Y. Then follow steps 4 - 8 
above. 

Checking the CONFIG.SYS File 
The installation program needs to check a file called CONFIG.SYS. For WordStar 
to operate correctly, this file must have a FILES = 20 statement. WINSTALL checks 
the fi Ie and then adds the statement if necessary. 

Follow these steps: 

1 Press C to have WINSTALL check your CONFIG.5YS file. 

2 Read the information on the screen. Press Y to respond to the prompt. 

3 Follow the instructions on the screen. (If you have a two floppy disk computer, 
and have put system tracks on your Program disk, leave that disk in drive A. 
This is your boot disk. If you have a hard disk computer, your CON FIG.SYS 
file is on drive C.) 

4 When WINSTALL is finished checking the CONFIG.SYS file, press X to return 
to the Main Installation Menu. 
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Specifying the Location of the Dictionaries 
WordStar needs to know the location of your dictionaries. Dictionaries are used 
when you check spelling, ask for a word definition, or look for synonyms in the 
thesaurus. Refer to the list below for the location of your dictionaries: 

Type of Computer 

Two floppy with 5 1/4-inch disks 

Two floppy with 31h-inch disks 

Two floppy with a high capacity 
disk 

Hard disk 

Follow these steps: 

Location of Dictionaries 

Spelling Dictionary and Thesaurus 
disk 
Definitions disk 

Dictionaries disk 

Program disk 

Hard disk 

1 At the Main Installation Menu press E. 

2 Read the menu and make the appropriate selection for your computer. 

3 Press X twice to return to the Main Installation Menu. 

Changing the Help Level (Pull-down or Classic Menus) 
WordStar features two kinds of menus: pull-down menus and classic menus. 
Classic menus have not changed from previous versions of Word Star except for 
the addition of new commands. Pull-down menus are the default setting. They 
provide a way for first-time or occasional users to work quickly without a lot of 
memorization. 

If you already use WordStar, you'll probably want to work with classic menus. 
Follow these steps to change the default from pull-down to classic menus: 

Note: If you plan to go through the lessons in the "Training Guide," use pull­
down menus. You can change the default setting to classic menus later, if you 
like. 

1 Press F for Help level. 

2 Select B for classic menus. 

3 Select the level of menu display for classic menus (all menus, submenus 
only, or no menus). 

4 Return to the Main Installation Menu. 
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Finishing the Installation 
If you want to go back and change any of your selections, you can do so from 
the Main Installation Menu. Otherwise, follow these steps to finish the 
installation: 

1 Press X. 

2 At the prompt, Are you finished making changes? (YIN), press Y. 

3 When you see the system prompt on your screen, reboot your computer in 
one of these ways: 

If you have a hard disk computer, press Ctrl, Alt, and Del at the same time. 

If you have a two floppy disk computer, remove the Program disk from 
drive A and the Installation disk from drive B. Put your boot disk in drive A 
and press Ctrl, AIt, and Del at the same time. 

When you see the system prompt on the screen again, WordStar is ready to use. 

The README Program 
You'll find the latest information about Wo rd Star in a program called README. 

If you have a two floppy disk computer, README has suggestions for creating 
Program disks that reduce file swapping. By removing some files and adding 
others, for instance, you can customize an "executive" Program disk for a laptop 
computer. 

If you have a hard disk computer, make sure you're at the C:\ WSS > prompt. 
Type readme, and press ~ . 

If you have a two floppy disk computer, put the disk containing README into 
drive A. Type a: and press ~ to log on to drive A. Then type readme and 
press ~. 

Important Notes 
• To see how your printer works with WordStar, you can print a file called 

PRINT.TST. (If you're using a two floppy disk computer, this file is on the 
Program disk.) 

• If you have a two floppy disk computer, always start your computer with the 
DOS disk (or Program disk with system tracks) you used during installation. 
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You must use the same disk because the FILES = 20 statement was added to 
your CONFIG.SYS file. If you use other disks to boot your computer, the 
FILES = 20 statement must be added to the CONFIG.SYS file on those disks. 

• Be sure to send in your Registration Card to validate your warranty and receive 
current information about Word Star from MicroPro®. 

• The Customer Service booklet provides information about technical support, 
warranty replacements, and updates. 

• If you have a hard disk computer, and you want to start WordStar from any 
directory, you can add the \ WSS directory to your computer's path. See your 
DOS manual for information on changing your PATH statement. 

Starting WordStar ____________ _ 
Once you've installed WordStar, here's how to start the program each time you 
wantto use it. 

If YOU HAVE A HARD DISK COMPUTER 

1 Make sure your computer is on. You should see C> on your screen. 

2 Type cd \ ws5 and press ~ to log on to your Word5tar directory. 

3 Type ws and press ~ . 

If YOU HAVE A TWO fLOPPY DISK COMPUTER 

1 Make sure your computer is on and booted. You should see A> on your 
screen. (If you booted with the DOS disk, remove the disk from drive A. If 
you booted with your WordStar Program disk, leave the disk in drive A.) 

2 Put the Program disk in drive A and a blank formatted disk in drive B for your 
word processing. 

Always do your word processing on a disk in drive B. This time you're using a 
blank disk, but you can also use disks that have files on them. 

3 Type b: and press ~ . 

4 Type a:ws and press ~ . 

You're ready to begin learning and using Word Star. 
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Training 
The WordStar Professional Release 5 package includes two kinds of training 
materials to help you learn the program. An onscreen tutorial presents an 
overview of the program. If you're new to word processing, the tutors are a 
good place to start. For more specific training, the lessons in this book let you 
practice using the program with step-by-step instructions. 

Using the Onscreen Tutorial __________ _ 
The onscreen tutors are a great way to get acquainted with WordStar. 
They provide a guided tour of the program via the new, easy-to-use, pull­
down menus. 

Find the Tutor disk in your package. Remove the card enclosed in the disk 
envelope and follow the printed instructions to run the tutors. You can repeat 
the tutors as often as you I ike. 

The Training Lessons _____________ _ 
The "Training Guide" includes nine lessons to teach you WordStar. Lessons 
1-6 cover basic word processing; Lessons 7-9 teach you more advanced 
tasks. You may want to practicewhat you learned in the first six lessons, then 
go through the rest of the training later. 

With the "Training Guide" you can learn at your own pace and spend time 
working with the program as you learn. The lessons are written so you can 
review specific tasks individually without having to go through the entire 
lesson again. 

Now turn to Lesson 1 and start learning WordStar. The training lessons 
assume that you're using pull-down menus. 
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LESSON 1 

Learning 
the Basics 

In this lesson you'll learn about 

• Starti ng WordStar 
• Getting Onscreen Help 
• Creating a File 
• Typing Text 
• Saving and Naming a File 
• Printing 

You usually follow the same steps each time you write or edit. In Lesson 1 
you'll learn the basic steps. Then you'll be ready to try more specific tasks. 

Getting Ready _____________ _ 
If you have a hard disk computer, you can skip this section and go to "Starting 
WordStar." 

Floppy disk computer users need to set up a work disk for training. To do that, 
you need a blank, formatted disk. If you need to format a disk, do that now, 
then retu rn here. 

Follow these steps to set up a Training Work Disk: 

1 Make sure your computer is on and the system prompt A> appears on the 
screen. (If your disk drives aren't called A and 8, substitute the correct 
names in the steps.) 

2 Place your copy of the disk that contains MailLisCM in drive A. 
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3 Place a blank, formatted disk in drive B. 

4 Type copy maillist.dot b: and press ~. 

5 Remove the MailList disk from drive A and insert the WordStar Program 
disk in drive A. 

6 Type copy * .doc b: and press ~. 

The training files are copied onto the disk in drive B. 
7 When you see the message that the files are copied, remove the disk from 

drive B. Label the disk "Training Work Disk." 

8 Remove the WordStar Program disk from drive A. 

Now that you've prepared a Training Work Disk, you're ready to begin. 

Starting WordStar _____________ _ 
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IF YOU HAVE A HARD DISK COMPUTER 

To start WordStar, follow these steps: 

1 Make sure you're in the directory that contains the WordStar program files. 
If you're not, type cd\ws5 and press ~. (If you copied your files to another 
directory during installation, type cd\ and the name of that directory and 
press ~.) 

2 Type ws and press ~. 

IF YOU HAVEA TWO FLOPPY DISK COMPUTER 

You'll need the copy of the WordStar Program disk you created during 
installation and the Training Work Disk. 

To start WordStar, follow these steps: 

1 Place the WordStar Program disk in drive A. 

2 Place the Training Work Disk in drive B. 

3 Type b: and press ~. 

4 At the B> prompt, type a:ws and press ~. 

Always do word processing on a work disk in drive B. The Program disk in 
drive A runs the program, and it's a good idea never to put anything else on 
it. 
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The Opening Screen _____________ _ 
When you start WordStar, the Opening screen looks like this: 

directory 

drive help menu bar 

..-il~ther=l!~!d'd ~i t~io!n~a 1!!!!!!!!!!!!!!!!!!!!!!!!!!OP~E!H~IN!G!! ] 
I Press '1 for help I ~II Release 5 

r rOM M i croPro 

I ' 
" BOX .4k DIARV. DOC 3.5k ENVELOPE. LST .5k HP-EHV. LST .Ilk 

HP-EItIJMM. LST .6k HP2-EItV.LST .6k HP2-EItVM. LST .6k I HVNTORV . DOT .4k 
I HVNTORV . DTA .1k IHVHTORV.LST 2.Hk INVNTOR'r'.HDX .1k LABEL. LST .1k 
LABEL3. LST .1k LABEL3A 2.1k LABELA .8k LABELXL. LST . .1k 
LABELXLA 1.1k LASER1. DOC B.3k LASER2.DOC 3.1k LSRLABL3. LST 3. Hk 
MAl LLIST. DOT .4k PHOHE. LST 1. Hk PROOF. LST 1. 6k ROLODEX. LST .1k 
ROLODEXA 1. 4k RULER. DOC .9k SHOLAB3 3.1k SHOLABEL .9k 
SHOLABXL .5k SHOROLO 1.1k TABLE. DOC .9k TEXT. DOC 5.5k 
WINDOW. DOC .4k WSINDEX.XCL 1. 5k WSL 1ST. DTA .1k WSLIST. HDX .1k 

The directory lists files. If you have a hard disk computer, you probably see 
many files listed on the screen. These files are in the current directory on the 
current drive. If you have a floppy disk computer, you see the training files 
you copied onto the Training Work Disk in drive B displayed on the screen. 

The double line near the top of the screen is a menu bar. The menu bar con­
tains the names of pull-down menus. On each pull-down menu is a list of 
choices for performing word processing tasks. To perform a word processing 
task, "pull down" a menu and choose the item that will perform the task. 

You can get onscreen help by pressing the key marked Fl. 
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Getting Onscreen -Help 
As you're learning and using WordStar, remember that onscreen help is 
always available. 

Practice getting help at the Opening screen. 

1 Press the key marked Fl. (Fl is a function key located at either the left side 
of your keyboard or across the top.) 

2 Read the information. 

The information in the pop-up window tells you how to choose a pull­
down menu from the menu bar. 

3 When you're finished, press the Escape key (the key marked Esc). 

Creating a File 
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In word processing, documents are kept on a disk in a file. You can't start typ­
ing a document until you create the file it will be kept in. 

Take these steps to create a file: 

1 Press F to select the File pull-down menu from the menu bar. (If you don't see 
this pull-down menu on the screen, press the Spacebar and press F again.) 

highlighting OPENING menu bar 

f!!!t~h!e!r!!!n!dd~i't~io!na~I~!!!!!!!!!!!!!!!!!!!!!!!!!opl"I"G 
-Speed Write (new file) S 

Open a document fi Ie ... D 
Open a nondocument file ... " m 

BOX Pl'int a file ... P 
HP-E Mel'ge pl'int a file ... " II'IVN 
LABE Change dl' ive/d il'ectol'Y ... L 
LABE 
MAIL Copy a file ... 0 
ROLO Delete a file ... 'i 
SHOL Rename a file ... E 
WIND Pl'otect/unpl'otect a file ... C 

Exit WordStar X 

t 
commands 

ENVELOPE. LST .5k 
HP2-EHVM. LST . ok 
I HVHTORV . HDX • 1k 
LABELA . Bk 
LASER2. DOC 3. 1k 
PROOF. LST 1. ok 
SHOLAB3 3.1k 
TABLE. DOC .9k 
WSLIST.DTA .1k 

Release 5 
fl'om Micl'oPl'o 

HP-EHV. LST . ok 
I NVHTORV . DOT . 4k 
LABEL. LST . 1k 
LABELXL. LST . lk 
LSRLABL3. LST 3. 8k 
ROLODEX. LST . 1k 
SHOLABEL .9k 
TEXT. DOC 5. 5k 
WSLIST. NDX .1k 
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2 To create a new file press ~ to choose Speed Write, the highlighted com­
mand. With Speed Write, you get a quick start. 

You're at the Edit screen ready to type. 

cursor EDIT menu bar 

[ 
a ••• ,_m ;;'MU--)l'" 

_ File Edit===Go to=ilindow Layout===8tyle===Gther 
RgtJllst 1-EDIT= 

L-----! ----! ----! ----! ----! ----! ----! ---- ! ----! ----! ----! -------R 

~----------------------ty-p-in-g-l-in-d-ow------------------------~ 
Typmgrext ______________________________ _ 

Type the following letter, pressing the Enter key whenever you see this sym­
bol ~.Don't worry when you come to the end of a line; WordStar automati­
cally "wraps" text to the next line. Pressing ~ acts like the Return key on a 
typewriter. If you press ~ by mistake, use the Backspace key to get the 
cursor back in the right position. 

If you make typing errors, just leave them. You can correct them later when 
you learn editing in Lesson 2. 
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(If you make a lot of mistakes and want to start over, hold down the key 
t marked Alt while you press F to choose the pull-down File Menu. Press the 

key with the arrow pointing down to move the highlighting to Abandon 
changes. The arrow keys are located at the right of the regular keyboard . 

. Press ~ to choose Abandon changes and type Y. You'll be back at the Open­
ing screen and you can start over at "Creating a File.") 

Now type the letter. 

July7,1988..J 
~ 

Gulliver's Travel Service~ 
152 Lilliput Street~ 
San FranciSCO, CA 94118~ 
~ 

Dear Mr. Gulliver,~ 
~ 

I saw your recent advertisement in the newspaper and I am 
interested in the European tour package you are offering this 
month. My wife and I are interested in seeing all of the 
countries you've listed, but we were wondering if we can add 
Yugoslavia and Greece to the trip.~ 
~ 

With the kids all off to college now, we are ready for this 
trip. Could you please send me more information about the 
European Tour. Thank you.~ 
~ 

Sincerely,~ 

Saving a File 
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When you finish working in a file, you tell the computer to save and store the 
file containing the document. 
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Choices for saving a file are on the File pull-down menu. 

Save the fi Ie. 

1 Hold down the key marked Alt while you press F, for File. (At the Edit 
screen, press the Alt key before pressing the first letter of the pull-down 
menu. Then WordStar knows you're making a choice instead of typing a 
letter.) 

I 
I,' 
I 
I a 

--!----!-- --! -- ---- R 
-Save file, reSUMe editing )(8 

Save and name f lie IT 
Gull Save file. go to Opening screen AXD 
152 Save file. exit WordStar AXK 
San Abandon changes AXil 

Dear Pr i nt a file ... "'xpp 
Merge print a file ... A xpn 

I s newspaper and I am 
inte Change drive/directory ... AXL u are offering this 
mont seeing all of the 
coun Copy a file ... AXO ering if we can add 
'fuga Delete a file ... AXJ 

Rename a file ... AXE 
With are ready for th is 
trip. Could you please send me more information about the 
European Tour. Thank you. 

Sincerely. 

2 Move the highlighting to Save file, go to Opening screen. 
To move the highlighting, you press the keys marked with arrows p, 
i , .;-, and ~). These arrow keys are located to the right of the regular key­
board. On some keyboards they are located on the numeric keypad. (If a 
number appears, press the Num Lock key once an'd try again.) 

3 Press~. 

Now your file needs a name. 
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Choosing a filename 
Each time you write a document, such as a memo or letter, you give it a 
name, or filename. The computer stores and retrieves a document according 
to the filename. Once a file is named and saved, you can go back to it any 
time to edit or read it. 

A filename can contain from one to eight characters, including letters and 
numbers. In addition to the eight-character name, you can also add a file 
extension-a period followed by three more characters. 

TIP Use filenames that will remind you of the contents of your document. 
For example, if you're writing a memo to an auditor, you might name it 
AUDITOR. The extension could be a date reminder. A memo written to the 
auditor on December 13 might be named AUDITOR.D13. You can use 1-9 to 
represent January-September and O,N,D for the last three months of the year. 

Name the file. 

1 Type first.doc and press ~I. 

You've created a file called FIRST.DOC. You're back at the Opening screen 
with the file FIRST.DOC now listed in the directory display. 

Printing ____________________________________ _ 

14 

If your printer is set up, you might want to see your letter on paper. If you 
don't have a printer, skip this section. 

Print the file FIRST.DOC. 

1 At the Opening screen press F for File. 

2 Highlight Print a file and press ~. A dialog box appears because the pro­
gram may need information from you. Tbis is where you tell the printer 
what to print and how you want to printit. Most of the time you won't 
have to change any of the information. 
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docum~~p~R"I~"~TP!!!!!!!!!!!!!!!!!!!!!!! 
File first.lIloc 

f-irst.doc 

Page nUMbers All 
All/even/odd pages 
Printer name 

Ii Pause between pages 'l 
Use Form Feeds ? 
tlondocument " 
tlumber of copies 1 L 

Redirect output to (none) .................. 
Press F1 For help. 

BOX .4k BROCHURE. DOC .5k 
DIARV.BAK 3.&k DIARV.DOC 3.6k 
FIRST.BAK .Sk FIRST. DOC • Sk 
HP2-EMU. LST . 6k HP2-EttUM. LST .6k 
I tlUtiTORV • DTA • lk I ttUttTORV • LST 2. 8k 
LABEL3. LST • lk LABEL3A Z.lk 
LABELXLA 1. lk LASER 1. DOC S.3k 
MAILLIST. DOT .4k PHOttE. LST 1. 8k 
ROLODEX. LST • lk ROLODEXA 1.4k 
SHOLAB3 3.1k SHOLABEL . 9k 

CUSTOMER. DTA .4k 
EttUELOPE. LST • 5k 
HP-EttU. LST • 6k 
I ttUttTORV • DEF 2. 8k 
I ttUtiTORV • ttDX • lk 
LABELA .Sk 
LASERZ. DOC 3. 1k 
PROOF. LST 1. 6k 
RULER. DOC • 9k 
SHOLABXL .5k 

CUSTOMER. tlDX • lk 
EXTLIST.SF .1k 
HP-EtlUMM • LST • 6k 
I ttUttTORV • DOT • 4k 
LABEL. LST .1k 
LABELXL. LST • 1k 
LSRLABL3.LST 3.8k 
QUITMEttU. SF .1k 
SF. HLP 19k 
SHOROLO 1.lk 

3 Notice that the file information is current. FIRST.DOC is the file you just 
saved. 

4 Press the function key FlO to begin printing. 

Your first document prints. 

Reviewing the Basics _____________ _ 
You've covered the basics of word processing in a few short steps. For most 
word processing jobs, you follow these steps: 

1 Start the program. 

2 Create a file. 

3 Type your text. 

4 Save the file. 

S Print. 

What could be easier! Now move on to the next lesson, where you'll learn 
about editing with WordStar. (If you want to stop here and start the lessons 
again later, choose File from the OPENING menu bar. Then choose Exit 
WordStar to leave WordStar.) 
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LESSON 2 

Editing 
In this lesson you'll learn about 

• The Editing Screen 
• Moving Around in Your Document 
• Erasing and Inserting 
• Correcting with Overtype 

You've learned the basics-creating a file, typing text, saving and naming 
a file, printing. But the real power of word processing is editing. With the 
WordStar editing commands, you can correct typos, change wording, insert 
words and sentences, and more. 

To practice editing, you'll work with the file you created in Lesson 1, 
FIRST.DOC. 

Opening a File ______________ _ 

In Lesson 1 you learned how to create a file. Now you'll go back to the letter 
you wrote and edit some of the text. Start this lesson at the Opening screen. 

To open the file FIRST.DOC, follow these steps: 

1 From the OPENING menu bar, press F to pull down the File Menu. 

2 Notice the choices for opening files. 
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open an existing file 

open a new file 
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rite (new file) S 
Open a document file ... J 
Open a nondocument file ..• " m 

BOX Print a file •.. P 
HP-E Merge print a file ... n 
INVN 
LABE Change drive/directory ... L 
LABE 
LSRL Copy a file ... 0 
ROLO Delete a file ..• V 
SCRE Rename a file ... E 
SHOL Protect/unprotect a file •.. C 
TEXT 
WSLI Ex it WordStar Ie 

~II 
ENVELOPE. LST . Sk 
HP2-ENV.LST .Gk 
I NVNTOR't . LST 2. Elk 
LABEL3A 2. 1k 
LASER1. DOC B. 3k 
PHONE. LST 1. Elk 
RULER. DOC .9k 
SCREENEl3. CAP 4. 2k 
SHOROLO 1. 1k 
WSINDEX.XCL 1.Sk 

Release S 
from MicroPro 

FIRST.DOC .Bk 
HP2-ENVM. LST . Gk 
I NVNTOR't . NDX • 1k 
LABELA . Bk 
LASER2. DOC 3. 1k 
PROOF. LST 1. Gk 
SCREENElEI.CAP 4.2k 
SHOLAB3 3.1k 
TABtE.DOC .9k 
WSLIST.DTA .1k 

In Lesson 1 Speed Write was the choice for creating a new, unnamed file. 
To open a file containing an existing document, choose Open a document 
file. 

3 Press ~ once to select Open a document file. Press~. 

If you chose Speed Write by mistake, press Alt F to pull down the File 
Menu, choose Abandon changes, and start again at step 1. 

4 Type first.doc and press ~. 
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The Edit Screen 
Here's the letter you wrote in Lesson 1, ready for revisions. 

L-----! ----! ----! --- -! ----! ----! ----! ----! ----! ----! ----! -------R 
.kIly 7. 19BB 

Gu 11 iver' s Trave I Serv ice 
152 L ill iput Street 
San Francisco. CA 94118 

Dear Mr. Gu 11 iver. 

I saw your recent advertisement in the newspaper and I am 
interested in the European tour package you are offering this 
month. My wife and I are interested in seeing all of the 
countries you've listed. but we were wondering if we can add 
't'ugos lav ia and Greece to the tr ip. 

With the kids all off to college now. we are ready for this 
tr ip. Cou ld you p lease send me more information about the 
European Tour. Thank you. 

Sincerely. 

< 
< 
< 
< 
< 
< 
< 
< 

flag column t 
Look through (browse) the pull-downs on the EDIT menu bar to see what 
choices are available for editing a document. 

1 Hold down the Alt key and press E to pull down the Edit Menu. 

2 Press ~ to see the Go To pull-down. Continue to press~ until you've 
browsed all the menus on the menu bar. 

3 Press ~ enough times to move back to the first item on the menu bar. 
When you're finished, press the Spacebar to resume your work at the cur­
rent screen. 
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Look at the other parts of the Edit screen. 

The status line contains the following information: 

disk drive column number in columns and inches 

! r a

- n justification 

~ 
C:FIRST DOC P1 L1 C1 .88" Insert Align RgtJust 

t L numbe, 
page number 

t pa,laPh align on/off 
insert mode on/off 

Press the down arrow key 0) a few times and watch the line number change. 
Do the same with the right arrow key (~) and watch the column number 
change. (If you're typing numbers instead of moving the cursor, press the 
Num Lock key and try again.) 

The ruler line shows left and right margins and tab stops (the exclamation 
marks). The line is 65 spaces (6.5 inches) long, and the tabs are set at five­
space (.5-inch) intervals. You'll learn more about the ruler line in Lesson 3. 

The flag column contains characters, or flags, that WordStar displays to give 
you information about your document. For example, < means you ended the 
line by pressing ~, P indicates the end of the page, and" shows the end of 
the file. For a complete explanation of all the flag characters, see Flag column 
in the "Reference Guide." 

Moving Around in Your Document ________ _ 
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Learning to move the cursor around is an important part of word processing 
training. You need to know how to get around your document quickly in or­
der to fix and change text. If you already know how to move the cursor and 
scroll, then you can skip the next two sections and move on to "Erasing and 
I nserti ng." 
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Moving the Cursor 
You can move the cursor with the arrow keys. (You've already practiced using 
some arrow keys to move the highlighting.) 

Using the arrow keys shown below, move the cursor around. 

TO MOVE THE CURSOR 

up one line 
down one line 
left one character 
right one character 

PRESS 

t 
~ 

You can also make longer moves by pressing the Ctrl key in combination with 
an arrow key. The symbol" stands for the Ctrl (Control) key. When you see "-, 
for example, you hold down the Ctrl key while you press the left arrow key. 

Use the Ctrl key with arrow keys to practice making longer moves. 

left one word "-
right one word ,,~ 

When you're finished, move the cursor to line 1, column 1 of your document. 
Remember to use the status line to help find the location of the cursor. 

Scrolling 
Scrolling allows you to make bigger moves in your document. With scrolling, 
the cursor stays in one spot and the screen moves. 

Try a few scrolling moves. You should be at line 1, column 1. 

1 Press "PgDn a few times. Notice that the cursor is stationary and the screen 
moves up. 

2 Press "PgUp until the first line of the document shows on the screen again. 

When you have a file with more text than can be seen on the screen, you can 
also use these commands to scroll through your document a screen at a time: 

down a full screen PgDn 
up a full screen PgUp 
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TIP Touch typists who prefer not to remove their fingers from the home row 
position, can use the "Cursor diamond" and other arrow key equivalents to 
move the cursor. Cursor diamond keys are letter keys used with the CfTI key. 
Th~ "diamond" refers to their position on the keyboard. See Cursor diamond 
in the "Reference Guide." 

Erasing and Inserting _____________ _ 
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The ability to fix typos quickly and change wording in a document is one of 
the great features of word processing. 

You'll practice erasing and inserting by editing FIRST.DOC. Unless you've 
made some typos in your letter, this document looks all right. But, just for 
practice, try working your way through the letter, making a few changes as 
you go. Later, if you have your own typos to fix, go ahead and fix them. 

First, practice erasing a single character. Then try erasing a word and an 
entire line. 

Erasing a Character 
The Delete (Del) and Backspace (<E-) keys have erase functions. Del erases 
the character at the cursor and Backspace erases the character to the left of 
the cursor. 

1 Press J, to move the cursor down to the line beginning with "interested." 

2 Press"~ enough times to move the cursor under the "t" in the word 
"tour." 

Now capitalize this letter. 

3 Press Del and the "t" disappears. Notice how the text shifted to take up 
the space of the missing letter. 

4 Type T. 

Deleting a Word 
You've changed your mind about the extra countries you want to visit. 
Change "Yugoslavia" to "Italy." 

1 Press J, and "<E- until the cursor is under the "Y" in Yugoslavia. 

2 With the cursor under the "Y" in "Yugoslavia," press Ait E to choose the 
Edit pull-down. 

3 Choose Delete word. 

4 Type Italy and press the Spacebar once. 

5 Try the whole process again and change "Greece" to ''l\ustria.'' 
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Deleting a Line 
1 Press ~ to move the cursor down to the first line in the second paragraph. 

2 From the Edit pull-down, choose Delete line, and the line is gone. Notice 
how the text shifted up to take up the space left by the line you erased. 

Using Undo 
WordStar has a handy command that will save you time and frustration if you 
delete something by accident or if you change your mind. The Undo com­
mand wi II bri ng back the most recently removed text. 

You just deleted a line in the letter. With the cursor in the same place, choos~ 
Undo from the Edit pull-down and watch the line return to your document. 

Correcting with Overtype 
In the exercises above, you deleted text and WordStar inserted the replace­
ment text. You really have two ways (or "modes") to correct text in 
WordStar-by inserting characters or words or by typing directly over existing 
text. You choose this "mode," that is, turn it on or off, with the Insert (Ins) 
key. 

Look at the status line. Press the Ins key and watch what happens. Until this 
point, you've had insert on as shown by the word Insert in your status line. 
You just turned insert off and the word disappeared. Press it again and insert 
mode is back on. 

Turn insert off and correct some text by typing over it. 

1 Press the Ins key to turn insert off. (Watch the status line to make sure it's 
off.) 

2 Make sure the cursor is in the second paragraph under the "W" in 
"With." 

Let's remove this sentence by typing over the unwanted text. Type We 
want to begin making travel plans soon. 

3 Press Ins to turn insert mode back on. 

You've still got some extra text to erase. 

4 Press Del until all the extra text in that sentence is erased. 

23 



TRAINING 

Saving Your File-Backup Files 
Save and exit the file FIRST.DOC. 

1 Pull down File. 

2 Choose Save file, go to Opening screen. 
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Once you're at the Opening screen again, look at the directory. You'll notice 
a new file in the directory listing called FIRST.BAK. Once you've edited and 
saved a file, WordStar automatically creates a backup version of that file. 
Backup files always have the extension .BAK. You can't edit backup files, but 
you can use them to restore files that have been lost or erased. See the "Refer­
ence Guide" for more information about .BAK files. 

If you want to print FIRST.DOC, pull down File from the OPENING menu bar, 
choose Print a file, and press F10. 

In Lesson 3 you'll learn about document layout. (If you want to stop here and 
start the lessons again later, pull down File and choose Exit WordStar. Begin 
the training again at Lesson 3.) 



LESSON 3 

Formatting 
Your Document 

In this lesson, you'll learn another important element-how to format a docu­
ment. The format determines how the document will look when it prints. 
You'll cover these subjects: 

• Centering Text 
• Ruler Lines 
• Setting Tabs 
• Typing Columns 
• Dot Commands 
• Setting Margins 
• Setting Ragged Right Margins 

To learn about formatting, you'll type an itinerary. An itinerary requires a spe­
cial page design. You'll center text, set tabs and margins, and change the right 
margin from justified to ragged right. 

Starting Up 
Open a new file for a document in which you'll type an itinerary. 

1 Start at the Open i ng screen. 

2 Open a new file. If you've forgotten how, see "Opening a File" in Lesson 1. 
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The itinerary will look like this when it's printed: 

Itinerary 

Depart Date Time Arrive Date Time 

Vienna 10/19 09:00 a Zurich 10/19 10:25 p 
Zurich 10/20 12:05 a Berne 10/20 02:25 a 

Not included in the rates are 

Transfer services, sightseeing, meals (except 
as specified>, tips to station porters, 
wines, spirits, mineral waters, laundry, 
theater tickets, and other items of a similar 
personal nature. 

To create the special page design for this document, you'll choose items from 
the Layout pull-down menu. 

Centering Text 

Center and type the head i ng. 

1 On the line with the cursor, type Itinerary. 

2 From the EDIT menu bar, pull down Layout. (If you make the wrong 
choice, use ~ or ~ to move the highlighting to Layout.) 
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Sim~~ --.,..----------,-A 
Itinerary -Marg ins and tahs.. . OL 

AlIgn rest of paragraph 
A I ign rest of document 
Margin release 

lIew page 
Conditional new page ... 
Om it page number i ng 

Center line ... 
Right-justify text ... 
Single/double spacing .. . 
Paragraph number i ng .. . 

Header .. . 
Footer .. . 

Page preview 

3 Choose Center line. The title centers. 

4 Press ~ twice to create a blank line. 

The Ruler Line 

B 
"IIU 
"OX 

.pa 

.cp 

.op 

"oe 
"OJ 
"OS 
"Oz: 

.hI 

.tt 

"or 

An important part of designing a document is setting tabs and margins. You 
can see the current tab and margin settings in the ruler line at the top of the 
editing area. 

When you create a document, the left margin is automatically set at column 1 
(.00 inch) and the right margin is set at column 65 (6.5 inches). Tab stops are 
set at five-column (O.S-inch) intervals. 
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L-----! ----! ----! ----! ----! ----! ----! ----! ----! ----! ----! -------R 

The ruler line contains these symbols: 

Land R indicate left and right margins. 
! indicates tab stops. 
- indicates columns. 

TIP It's important to remember that you don't have to set page offset (how 
far text is offset from the left edge of the page). WordStar automatically offsets 
text approximately one inch. To change page offset, choose Margins and tabs 
from the Layout pull-down. 

If you change tabs and margin settings while you're typing a document, the 
ruler line reflects these changes. You'll learn more about the ruler line later. 

Setting Tab Stops _____________ _ 
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Some of the information in an itinerary is set up in columns. Before you type 
the travel information in cot-umns, you'll set tab stops at 1.1, 2.0, 3.2,4.3, 
and 5.2 inches. 

Set the tab stops on the ruler line. 

1 Pu II down Layout. 

Many of the items on the Layout pull-down are followed by three dots 
( ... ). These dots mean that the item is followed by a request for more 
information. 

2 Choose Margins and tabs. 

The Margins & Tabs dialog box is where you change the page layout for 
your document. 
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set page offset 
set margins set page length 

,-----~-:~-~-in-s--.l-III--.8-1t.-. -.1~ R G I • "Pa.: I':':: " ,,, ......... 1. I I 
Right . rill 6.41t" 
Paragraph . Pili (none) Even page off set . poe .81t"., ~ 
Top .rnt .58" Odd page oFFset .poo .88" l~ 

OL P1 L3 

Bottom .rnb 1.33" 
Header . hm .33" Line spaci ng .Is 
Footer .Fm .33" 

Tahs 
Tab stops .tb 6 11 16 21 26 31 36 41 46 51 56 

6 11 16 21 26 31 36 41 46 51 56 
Press Fl For help. 

clear and set tabs set line spacing 

3 Move the cursor to Tab stops. Press the Tab key to move the cursor forward 
and the Shift key with the Tab key to move it backward. 

4 Type the following numbers (each separated by a space): 1.1 2.03.24.3 
5.3. (You don't have to type the inch symbol.) 

5 Check to make sure the new tab settings are correct. If not, correct the 
incorrect number by backspacing over it and retyping. 

6 Press FlO. 

7 Look for the new tabs in the ruler line. WordStar also inserts a "dot com­
mand" .tb in column 1 followed by the numbers in inches for each tab 
stop. You'll learn more about dot commands later. 

Note: At the Margins & Tabs dialog box, you can press F2 to return to work 
without changing the layout. 

TIP To clear all tabs, follow the procedure for setting tabs and type O. 
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Typing the Column Headings and Text -------
Once the tabs are set, you can type the headings. The headings are Depart, 
Date, Time, Arrive, Date, Time. 

1 Type Depart and press the Tab key (located to the left of the Q key). 

2 Type Date and press the Tab key. 

3 Type Time and press the Tab key. 

4 Type Arrive and press the Tab key. 

S Type Date and press the Tab key. 

6 Type Time. 
7 Press ~I twice. 

Now that you've typed the column headings, type the next lines the same 
way. (If you tab too many times, you can press the Backspace key enough 
times to back up to the correct tab stop. Then press the Tab key again.) 

1 Type the rest of the text shown below. Be sure to press the Tab key to move 
the cursor to each tab stop. 

Itinerary 

Depart Date Time . Arrive Date Time 

Vienna 10/19 09:00 a Zurich 10/19 10:25 p ~ 

Zurich 10/20 12: 05 a Berne 10/20 02:25 a ~ 

Not included in the rates are ~ 
~ 

Setting Margins ______________ _ 
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You can set margins in the Margins & Tabs dialog box, or you can type these 
dot commands in your document: 

.1m n" sets the left margin (n is a number in inches) 

.rm n" sets the right margin (n is a number in inches) 

Before you continue, you should learn about dot commands. 
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Dot Commands 
You may have noticed dot commands listed next to some items on the pull­
down menus. When you choose an item with a corresponding dot command, 
WordStar puts the dot command into your document. The dot command 
shows where a layout feature such as margins takes effect. 

Here is some basic information you should know about dot commands: 

• A dot command begins with a dot (a period) in column 1, followed by a 
two-letter code, sometimes a space followed by more information, and ~. 

• You can remove a dot command by deleting the line. 
• Although you see it displayed on your screen, the dot command does not 

really occupy a line of text and it doesn't print. 
• A dot command is stored with the text when you save a document. 
• You can type a dot command directly into a document instead of choosing 

an item from a pull-down. 

Setting Margins with Dot Commands 
The margins for the document are currently set for 0.0 and 6.4 inches in the 
dialog box. Before you type the rest of the document, take these steps to set 
new margins for the paragraph you'll type next. Set the left margin at 1.0 
inches and the right margin at 5.5 inches. Try typing dot commands, an easy 
way to change margins within text. 

Change the left and right margin settings. 

1 With the cursor in column 1, type .1m 1.0" and press ~. Be sure to type 
the inch symbol (") in a dot command. (You can type dot commands in 
either uppercase or lowercase letters.) 

2 Starting in column 1, type .rm 5.5" and press ~. 

3 Type the last paragraph. As you begin to type, notice the new margin set­
tings. 
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Itinerary 

· t b 1 . 1" 2.0" 3.2" 4.3" 5.3" 

Depart Date Time Arrive Date Time 

Vienna 1 0 1 19 09:00 a Zurich 10/19 10:25 
Zurich 10/20 12:05 a Berne 10/20 02:25 

Not included in the rates are 

· I m 1.0" 
· rm 5.5" 

Transfer services, sightseeing, meals (except 
as specified), tips to station porters, 
wines, spirits, mineral waters, laundry, 
theater tickets, and other items of a similar 
personal nature. 

4 At the end of the paragraph, press ~. 

Changing Justified Text to Ragged Right 

p 
a 

Justified text has all lines the same length, so that the right margin is straight. 
WordStar inserts "soft" spaces between words to make the line extend all the 
way to the right margin. When you start WordStar, text is justified. 

Ragged-right text has an uneven right margin. When you turn justification off, 
everything you type will be ragged right until you turn justification on again. 

Change the right margin of the paragraph to ragged right. 

1 Move the cursor to the beginning,of the paragraph. 

2 Pull down Layout and choose Right-justify text. 

Notice that the dot command .oj off appears in column 1. WordStar has 
inserted a dot command to show that you've turned justification off. Next, 
realign the paragraph to form an uneven margin. 
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3 Move the cursor to the "T" in "Transfer." 

4 Pu II down Layout and choose Align rest of paragraph to al ign the para­
graph with an uneven right margin. (If you edit text within the paragraph, 
the margin realigns automatically.) 

The paragraph now has an uneven right margin. 
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Saving and Naming the File -----------
You've learned the basics for formatting a document: you've cleared and set 
tabs, changed margins, and turned off justification. 

If you want, you can practice resetting tabs and margins some more. When 
you're ready, save and name the itinerary TRIP.DOC. (Remember that a file­
name should describe the document's contents.) 

Printing the Itinerary ---------------
Pri nt the iti nerary. 

1 Make sure your printer is on and ready. 

2 From the OPENING menu bar, pull down the File Menu. 

3 Choose Print a file. 
4 Look at the questions in the dialog box. TRIP.DOC is the file you just 

saved. 

5 Press FlO. 

TRIP.DOC prints. 

In the next lesson, you'll add strength to your WordStar skills with block 
moves. (If you want to stop here and start the lesson again later, choose File 
from the OPENING menu bar and then choose Exit WordStar. Resume the 
training at Lesson 4.) 
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LESSON 4 

Working with 
B locks of Text 

In this lesson; you'll learn about working with blocks of text. You'll cover 
these subjects: 

• Marking a Block 
• Moving a Block 
• Hiding a Block 
• Block Math (Totaling Two Numbers) 

Block commands are power tools of editing. With block commands, you can 
easily move large sections of text and reorganize your writing. You can even 
do math. 

In this lesson, you'll type a short brochure and edit it with block commands. 
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Starting Up 

1 Start at the Opening screen. 

2 Open a new file for a brochure. (If you need help, see "Opening a File" in 
Lesson 1.) 

3 At the Edit screen, type the following text exactly as it is shown. 

Excurs ions..J 
..J 
Day 2..J 
Rome: Morning and afternoon city sightseeing by motorcoach. 

English-speaking gUide optional . ..J 
..J 
Day 1..J 
Florence-Rome: Leave at 8:30 a.m. by deluxe motorcoach. Arrive 

at Rome in the afternoon . ..J 
..J 
Fareinfirstclasshotels: $100.00. Bathoptional: $25.00 . ..J 

The paragraphs are out of sequence in the brochure: Day 2 comes before 
Day 1. You can reorganize the document with block moves. 

Marking a Block 
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A block is a piece of text. It can be any size-as large as an entire document 
or as small as a single character. You define the size of a block of text by put­
ting markers at the beginning and end of it. 



TRAINING 

Mark the beginning of a block. 

1 Move the cursor to the "0" in "Day 1." 

2 Pu II down Edit. 

Several choices on the Edit pull-down are for working with blocks of text. 

Day 2 
ROMe: Morn 
Engl ish-spea 

Day 1 
Florence-RoM 
at ROMe in t 

Fare in firs 

-Undo U 
Delete word 
Delete line 
Delete hlock 

Begin hlock 
End h lock 
Move'hlock 
Copy block 
Hide/show hlock 

ColuMn hlock Mode 
Co 1 ullin rep 1 ace Mode 

Insert a file ... 
Write hlock to file 

T 
Ay 

AIY 

AlB 
AIIC 
AiCU 
AIC 
AIU 

AIN 
All 

AIR 
AlII 

--!----!----!-------R 

eing hy Motorcoach. 

e Motorcoach. Arrive 

opt ional: $25.88 

Block commands 

3 Choose Begin block. 

The symbol <B> appears, marking the beginning of the block. 

Now mark the end of the block. 

T= 

< 
< 
< 
A 

1 Move the cursor to column 1 of the blank line following the paragraph. 

2 Pull down Edit. 

3 Choose End block. Notice the letters Band K in the flag column at the 
right edge of the screen. 
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The <B> symbol at the beginning of the block disappears and the block is 
highlighted. 

Note: If you put the markers out of sequence (the end marker before the 
beginning marker), a <K> appears in the text before the <B>. 

To mark a different block, YOl:J would repeat the procedure elsewhere in your 
file. 

Moving a Block ______________ _ 
Put the paragraphs in the correct order. 

1 Move the cursor to column 1 of the blank line below "Excursions" and 
press ~ to create another blank line. 

2 Pu II down Edit. 

3 Choose Move block. 

The block moves to the cursor position. The paragraphs are now in the cor­
rect sequence. 

Turning Block Display Off __________ _ 
You've moved a block of text, but the block is still highlighted. It's a good 
practice to turn block display off when you've finished working with it. 
WordStar works faster when block display is off. 

Turn off block display. 

1 P~ II down Edit. 

2 Choose Hide/show block. 

Note: The block is still there, but it is no longer displayed. If you chose Hide/ 
show again, the block would be highlighted. 

Block Math 
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With Qlock math you can total the numbers in the last paragraph. 

1 Mark the beginning and end of the paragraph beginning with "Fare." 

2 When the block is marked, pull down Other and choose Block math (add 
numbers). The total appears at the upper part of your screen. 

3 Press Esc to continue. 

4 Pu"1I down Edit and hide the block. 

WordStar also has a calculator that performs sophisticated calculations. See 
the "Reference Guide" for details. 
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Saving or Abandoning a Document ________ _ 
You've learned to mark a block of text and then tell WordStar what you want 
to do with it. You've moved a paragraph, and you've used block math to add 
two figures. Practice some more, if you want. Then you can save the docu­
ment, or you can abandon it if you don't want to edit it again. 

When you abandon a new document, you are returned to the Opening 
screen without saving the document. When you abandon a document that 
existed previously, you are returned to the Opening screen without saving the 
changes. 

1 From the File pull-down menu, save and name the file BROCHURE.DOC. 

or 

Abandon the file. 

In the next lesson, you'll find and replace a word in a document and check 
spelling. (If you want to stop here and start the lessons again later, pull down 
File and choose Exit WordStar. Begin the training again at Lesson 5.) 
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LESSON 5 

Finding Words, 
Checking Spelling, 
and Choosing 
Synonyms 

In this lesson you'll learn about 

• Finding Words 
• Finding the Next Occurrence 
• Finding and Replacing 
• Checking Spelling 
• Choosing Synonyms 

So far you've been working with short documents. Editing a short document is 
easy. But working with a longer document poses special problems. 
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WordStar has some features that are especially helpful for editing large docu­
ments. With the WordStar "find" feature you can search a document for spe­
cific text, numbers, or symbols. You can move the cursor quickly to a specific 
place in a long document. You can find and change certain text throughout a 
document. WordStar can also check the spelling in a document and correct 
misspelled words. To choose a substitute word or a synonym for a word, you 
can use the thesaurus. 

In this lesson you'll learn how to use the find, spelling check, and thesau-
rus features. You'll workwith a file that came on your program disk, 
DIARY.DOC. (If you have a two floppy disk system, you should have copied 
this file onto your Training Work Disk. If you didn't copy the file, do that now, 
then return here.) This lesson starts at the Opening screen. 

Starting Up ______________ _ 

1 Open the training file DIARY.DOC. (To open an existing document, re­
member to choose Open a document file from the File pull-down.) Be­
sides typing the name of the file and pressing ~, you can choose the file­
name another way. Use the arrow keys to move the cursor to the name of 
the file in the directory display, and press ~. 

finding a Word ______________ _ 
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WordStar can quickly locate up to 65 characters of text, including words, 
groups of words, numbers, and symbols. Locating words or phrases can be 
helpful when you're editing or when you want to find your place in a large 
document. 

Ask WordStar to find a word in DIARY.DOC. 

1 Pull down Go To. 

Look at the commands for locating text. 
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commands for locating text 

HM.II';; ••• "'. I 

~ File Edit indow Laydut====Sty le==other 

-Repeat previolls find/replace L 
Find text ... 

Septelllber HI Find and replace text ... 

What a wonderful ci Go to page ... 
have been literall Go to next font 
pretty exhausted, a Go to paragraph end 
our own. Go to line beginning 

Go to Ii ne end 
This lIIorning we too Go to block beginning 
took the undergrou Go to biock end 
We've found the L Go to file beginning 
around and less c Go to file end 
seeing Parlialllent, 

QF 
'"'QR 

'"'QI 
.o.Q,. 

'"'QG ... J 
'"'QS 
'"'QD 
'"'QB 
'"'QX 
'"'QR 
'"'Qe 

changing of the guard at the palace. Most illlpressive 
crown jewels in the Tower of London. 

! R 

days and 
We're 

ights on 

are. We 
r hotel. 

to get 
ind tour 
and the 

were the 

We have bein touring so lIIuch that this afternoon, we decided to 
do a little shopping. We went to one of the world falllous 
departlllent stores. The enorlll ity of the p lace was overwhe 1111 i ng. 
We found we were lIIore cOlllfortable shopping inthe slllaller shops. I 
bought a woo I scarf and a tea set. 

EDIT 

< 
< 
< 
< 

< 
< 

2 Choose Find text. In the dialog box, tell WordStar what text to locate. 

3 For the text to find, type London. 

4 Press FlO to begin the search. 

The cursor moves to the first occurrence of the word "London" in your docu­
ment. 

finding the Next Occurrence 
Ask WordStar to locate the next occurrence of "London" in the document. 

1 Pull down Go To. 

2 Choose Repeat previous find/replace. 

The cursor moves to the next occurrence of "London" in your text. A 
quick glance through the text reveals that London is mentioned nine more 
times. Instead of pulling down the Go To Menu several more times, try 
using the accelerator commands. 
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Accelerator Commands 
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Until now, you've chosen items from a pull-down menu to carry out word 
processing tasks. WordStar also has accelerator commands, shortcuts for se­
lecting the same items from pull-downs. Accelerator commands are listed on 
the pull-down menus. 

Pull down Go To and look at the commands. 

text choices accelerator commands 

21'1 1.91'1" I nsert A I i gn RgtJust 
==Window . Layout===Sty ~====Other 

-Repeat prev i OllS find/rep I ace L 
FInd text ... 

SepteMber 18 Find and replace text ... 

What a wonderfu lei Go to page... .0..11 
have been literall Go to next font Aq. 
pretty exhausted. a Go to paragraph end A qG<4J 

our own. Go to Ii ne beg inn i ng AqS 
Go to I ine end AqD 

This Morning we too Go to block beginning AqB 
took the undergrou Go to block end AqX 
We've found the L Go to File beginning AqR 
around and less c Go to File end AqC 
see i ng Par I iaMent, 
changing of the guard at the palace. Most iMpressive 
crown jewels in the Tower of London. 

!-------R 

days and 
We're 

ights on 

are. We 
r hote 1. 

to get 
ind tour 
a~d the 

were the 

We have bein touring so Much that this aFternoon, we decided to 
do a little shopping. We went to one of the world faMOUS 
departMent stores. The enorM i ty of the p lace was overwhe 1M i ng. 
We Found we were More COMFortable shopping inthe SMaller shops. I 
bought a wool scarf and a tea set. 

EDIT= 

The accelerator command for Repeat previous find/replace is "L. The symbol 
" stands for the Ctrl key. When you see the accelerator command "L, for ex­
ample, it means that you press the Ctrl key and the letter L at the same time. 

Locate the rest of the occurrences of "London" by using an accelerator com­
mand. 

1 Pull down Go To and press "L (hold down the Ctrl key while you press L). 
The pull-down Go To Menu disappears, and the cursor moves to the next 
occurrence of "London." . 



TRAINING 

2 Now that you know the accelerator command for Repeat previous find/ 
replace, you won't have to pull down Go To when you want to locate 
"London" again. At the Edit screen, press Al. 

3 Continue to press AL until you reach the end of the document. 

As you get more familiar with WordStar, you may want to speed up your work 
with accelerator commands. Look for them on pull-down menus. 

Finding and Replacing ____________ _ 

WordStar can find text and replace it with other text. This is helpful if you 
have to find a word or phrase in order to change it. WordStar can also search 
a document backward, that is, move from the end to the beginning. Because 
you're at the end of the file DIARY.DOC, tell WordStar to do a backward 
search this time. 

1 Pu II down Go To and choose Find and replace text. 

2 For the text to find, type London and press Tab. 

3 For the replacement text, type Rome and press Tab. 

Look at the options this time. The options let you ask for a more specific 
search. This time, tell WordStar to search backward through the docu­
ment. 

4 To search backward, type 8 and press FlO. 

WordStar finds the first occurrence of "London," this time moving back­
ward. 

S Look at the status line in the upper right corner of your screen. WordStar 
asks you if you want to replace the text. 

Press Y and watch your text. "London" changes to "Rome." 

6 Press the accelerator command AL to find the next occurrence of "London." 

7 Replace the text. (Remember, press Y to replace text.) 

8 Continue pressing AL and replacing "London" with "Rome" until you 
reach the beginning of the file. 

Automatic Replacing _____________ _ 

You can find and replace faster by letting WordStar replace text automatically. 
You've just replaced all references to "London" in your text with "Rome." 
This time let WordStar change "Rome" back to "London" and make your trip 
diary correct. 

1 Pull down Go To and choose Find and replace text. 

2 Type Rome and press Tab. 
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3 Type London and press Tab. 

You want to tell WordStar to replace all occurrences of "Rome" with 
"London" automatically. In other words, you don't want to be asked every 
time. 

4 For Options, press G (search file from beginning or end) and N (replace 
without asking) and press F10. (Just type the commands as gn.) 

Watch your screen to see the text replaced automatically. 

5 When WordStar reaches the end of the file, press Esc. 

6 Pull down Go To and choose Go to file beginning. You're back at the 
beginning of the file. 

You can use the find feature in a variety of ways in WordStar. Besides forward 
and backward searches and manual and automatic replacements, WordStar 
searches for parts of words, can ignore or search for specific case (upper or 
lower), and more. 

Checking Spelling ____________ _ 
WordStar can help find and correct misspellings and typos. You can use the 
WordStar spelling check feature in two ways: to check the spelling of a word 
before you type it in your document or to check spelling in an entire docu­
ment. 

WordStar checks the spelling against a large dictionary that came with your 
package. Hard disk computer users have already copied the dictionary onto 
their hard disks, and it's ready to use. If you have a two floppy disk computer, 
you may be prompted by WordStar to switch disks. 

You have another dictionary called the personal dictionary. As you use the 
spelling checker, you can add words (even names) to your personal diction~ry 
that aren't in the main dictionary. You can put specialized words like tech­
nical, legal, or medical terms in your personal dictionary. WordStar checks 
spelling against both dictionaries. 

The Spelling Check Commands ________ _ 
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The spelling check commands are listed on the Other pull-down. You can use 
them any time you're working in a file. 
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Checking the Spelling of a Whole Document 
WordStar can check the spelling of a single word in your document or an en­
tire document. It can even check the spelling of a word before you type it in 
your document. 

Run a spelling check on DIARY. DOC. 

1 Position the cursor in column 1, line 1. 

2 Pull down Other. It lists the spelling commands. 

check and correct spelling 

C:DIARY.DOC P1 L1 C1 .1'10" Ins ~ File Edit====Go to====tlindow-L<I~~!!!!~!!! 
L-----! ----! ----! ----! ----! ----! ----! ---

Trip Diary -{;heck docllment spe II i ng. .. QL 
Check word spe III n9. . . Q" 

SepteMber HI Thesaurus. . . A qJ 

What a wonderful city London is' We've been Run a DOS cOMMand... AIF 
have been literally running frOM one tour t Change help level... AJJ 
pretty exhausted, and look ferward to explori 
our own. Calcu lator. . . Aql1 

Block Math (add nUMbers) .0.111 
This Morning we took a tour that began at Tra 
took the underground (their word for subway) 
We've found the London underground to be a 
around and less costly than taxis. We had 
seeing ParI iament, the Tower of London, Towe 
changing of the guard at the palace. Most iM 

Footnote/endnote... .0.0" 
I ndex entry... AONI 
Table of contents entry .... tc 

Shorthand macros... Esc 
CrOWn jewels in the Towel' of London. L...-__ '--________ .....I 

We have bein touring so Much that this afternoon, we decided to 
do a little shopping. We went to one of the world faMous 
departMent stores. The enorMity of the place was overwhelMing. 
We found we were More COMfortable shopping inthe smaller shops. I 
bought a wool scarf and a tea set. 

3 Choose Check document spelling. 
(Some floppy disk users are prompted to switch disks.) 

The cursor stops on the word "ferward," a typo, and the Spelling Check 
Menu is displayed. WordStar offers correct spelling suggestions. 
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S PEL LIN G C H E C x n E N U 
I ignore, check next word E enter correction AU quit 
A add to pers~nal dictionary G global replacement is off 
I bypass this time only 

Word: "ferward" 
SU!J!Jestions: 1 forward 2 forwarder 3 forwarders 4 forwarded 

M display more suggestions 
Definition: 

4 Press 1 to tell WordStar to replace the incorrect word with the suggested 
correct spelling. 

The spelling check continues. 

WordStar stops on the word "Trafalgar" because it doesn't recognize this 
word. 

Look at the choices on the Spelling Check Menu. You need to decide 
whether to have WordStar skip this word or add it to your personal dic­
tionary. 

5 Press A to add this word to the personal dictionary. Later, if WordStar 
comes across this word, it'll know the correct spelling. 

WordStar stops on the word "bein," another typo. 

6 Look at the suggestions. Notice that you press M to see more suggestions. 
To practice, press M. Then press M again to return to the first group of 
suggestions. 

7 Press 3 to select the correct spelling of "been." 

WordStar stops on "inthe," a typo. In this case, you want to type a cor­
rection yourself. 

8 Press E to select enter correction. 

9 At the prompt, type in the and press ~. 

WordStar continues to check spelling until it reaches the end of the docu­
ment. You can stop a spell ing check at any time. 

10 Press the accelerator command "U~to stop the spelling check. 

(Some floppy computer users are prompted to switch disks.) 

11 Notice how many words were checked and press Esc. 

12 Pull down File and choose Save file, resume editing. 
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Turn to the "Reference Guide" for more details about the spelling checker 
and the Spelling Check Menu commands. For more practice, run a spelling 
check on your first training document, FIRST.DOC. 

Using the Thesaurus 
As you write or edit, you can use the WordStar thesaurus to help you find the 
exact word you want without having to stop and look it up in a book. 

Practice using the thesaurus in DIARY.DOC. 

1 Move the cursor to the word "scarf" in the last sentence of the third para­
graph. 

Use the thesaurus to find a different word to use. 

2 Pull down Other and choose Thesaurus. (Some floppy disk users are 
prompted to change disks.) 

Look at the Thesaurus Menu and notice the list of synonyms. 

QJ c: DI ARY. DOC Pi L22 CiS 1. 41'1" I nsert Al iyn RytJust 
THE S A U R usn E " U 

Word: "scarf" L cross ref 
~DY choose AU cancel I enter word X define at cursor P prev word 
NOlln MiaNI. bandanna, mantilla, muffler. 

3 The cursor is at "shawL" Press ~I to use the synonym. You've replaced 
"scarf" with "shawL" 

(If you have a two floppy disk system, you may be prompted to change 
disks every time you choose a synonym.) 

Try the thesaurus again. 

4 Move the cursor back to the word "wonderful" in the first sentence of the 
first paragraph. From the Other pull-down menu, choose Thesaurus. 

5 Use the arrow keys ~ and ~ to move the highlighting to "smashing." 
Press ~ to use the synonym. 
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Try some of the other thesaurus functions. 

1 Move the cursor to the word "guard" in the fourth sentence of the second 
paragraph. 

2 This time, use the accelerator command "QJ to display the Thesaurus 
Menu. 

There are many synonyms listed by parts of speech. The last synonym dis­
played is followed by a semicolon (;). This means that more synonyms can 
be displayed. 

3 Press J, several times to move through the list. Press i to move back to the 
first group. When "noun" is no longer enclosed in parentheses, you are 
back at the beginning of the list. 

4 Move the cursor to "guard." 

S Check the meaning of the word "guard." Press K. 

6 Press "U to remove the definition. 

You can also check the meaning of synonyms. 

1 Move the cursor to "sentry." Press K. 

2 Press "U to remove the definition. 

You can even check for synonyms of synonyms. 

1 With the cursor on "sentry," press L. Now "sentry" is the word to be 
checked, and you can see its synonyms. 

2 Move the cursor to "watchman" and press L. You see its synonyms. 

3 Perhaps "guard" is the best word after all. Press P twice. 

While you're at the Thesaurus Menu, you can look up synonyms for any 
word by pressing I and typing the word. The word doesn't have to be in 
your document. If a word is misspelled, idiomatic, or a proper noun, the 
thesaurus provides a list of "near alphabet guesses," words with similar 
spelling. 

4 Press "U to exit the Thesaurus Menu. 

S Save the file DIARY.DOC and go to the Opening screen. 

Now move on to Lesson 6, where you'll learn about special effects and print­
ing. (If you want to start the lessons again later, you can press the accelerator 
command FX to exit WordStar.) 



LESSON 6 

Special Effects 
and Printing 

This lesson covers these subjects: 

• Special Effects (Boldface and Underline) 
• Turning Off Display 
• Inserting Page Breaks 
• Omitting Page Numbers 
• Changi ng Page Offset 
• Interrupting Printing 

Reopening DIARY.DOC __________ _ 

To learn about adding special effects to your text, you'll edit the sample file 
DIARY.DOC again. 

1 Start at the Opening screen. 

2 Reopen the file DIARY.DOC. 

When you see the Edit screen, you're ready to begin. 

Adding Special Printing Effects 
Special printing effects like boldface and underline add emphasis and variety 
to documents. 

The special effects choices are on the Style pull-down menu. You choose 
printing effects such as boldface and place the commands in pairs at the 
beginning and end of the text to be emphasized. 
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Boldfucingkxt __________ ~ ________________ _ 
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Practice adding boldface to some characters. 

Boldface the heading. 

1 Move the cursor to "T" in "Trip Diary." 

2 Pu II down Style. 

~ F e Ed i t====Go 
L-----!----!----!----!----! 

ary -Bo Id PB < 
Underline 

September HI ltal ics 
PS < 

Apy < 
Subscript 

What a smashing city London is! We've been here Superscript 
have been literally running from one tour to an Strikeout 
pretty exhausted, and look forward to exploring a 

"'PU < 
ApT 
ApIC 

our own. Hide/display controls "OD 

This morning we took a tour that began at Trafal Choose font Ap= 
took the underground (their word for subway) fL..------------' 
We've found the London underground to be a great way to get 
around and less costly than taxis. We had a whirlwind tour 
seeing Parliament, the Tower of London, Tower Bridge, and the 
changing of the guard at the palace. Most impressive were the 
crown jewe Is in the Tower of London. 

We have been touring so much that this aFternoon, we decided to 
do a little shopping. We went to one of the world famous 
department stores. The enormity of the place was overwhelming. 
We Found we were more comfortable shopping in smaller shops. I 
bought a wool shawl and a tea set. 

3 Choose Bold. Notice that WordStar puts a "B on the screen to show where 
the boldface begins and highlights the text that follows. 

4 Move the cursor to the space following "Diary." 

5 Pull down Style, choose Bold again. The "B on the screen shows where 
the boldface ends. The highlighting stops before the second "B. 

WordStar knows that the "B symbols are not part of your text and will not 
print them. 

The text between the pair of "B print control symbols appears highlighted on 
a monochrome screen and in a different color on a color monitor. The high­
lighted text will print in boldface. 

TIP If you use boldface a lot, use the accelerator command "PH to turn 
boldface on or off. 
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Deleting Print Control Symbols 

When you revise a document, be careful not to rearrange or delete print con­
trol symbols. If you do, you may be surprised at the results. 

See what happens when you erase one of a pair of print control symbols. 

1 Erase one of the "6 print control symbols. Use the Del or the Backspace 
key. All the text following the remaining print control is highlighted and 
will print in boldface. 

2 Reenter the boldface command in the same place. Only the enclosed text 
is highlighted. 

Underlining Text ______________ _ 

Underlining works like boldface. Underline the headings "September 10" 
and "September 12." 

1 Move the cursor to the "s" in the first occurrence of "September." 

2 Pull down Style and choose Underline. The "S on the screen shows where 
the underlining starts. 

3 Move the cursor to the space following the number. 

4 Pull down Style and choose Underline again. The "S on the screen shows 
where the underlining stops. 

5 Move the cursor to the second diary entry, "September 12." Repeat steps 
2-4. 

The text between the "S symbols appears underlined on most monochrome 
screens and in a different color on a color monitor. The text will be under­
lined when the document prints. 

Turning Display On and Off _________ _ 
If you want to see how your text looks without print control symbols, you can 
hide them. Turn the display of print controls on or off from the Style Menu. 

Hide the print control symbols. 

1 Pull down Style and choose Hide/display controls. 
2 Notice that the print control symbols are gone, but the text is still high-

lighted and underlined. 

Print controls can be hidden, but they're still in effect. Choosing Hide/display 
controls again (or pressing the accelerator command "00) turns display on 
again. 
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Inserting Page Breaks ____________ _ 
Every page in a WordStar document is automatically set for 66 lines with 55 
lines of text. (Page length is like a sheet of paper 11 inches long with three 
lines in the top margin and eight lines in the bottom margin.) When the cur­
sor reaches the end of the page you're typing, WordStar automatically inserts 
a page break. The automatic page break, which is indicated by a broken line 
with a P iii the flag column, signals the end of one page and the beginning of 
another. 

Sometimes, though, you'll want to start typing on a new page before the cur­
rent one is filled. You can insert a page break anywhere. 

Insert a page break in DIARY.DOC. 

1 Move the cursor to column 1 of the blank line above "September 12./1 The 
status line tells you that you're on page 1. 

2 Pull down layout and choose New page. Look at the status line now­
you're on page 2. 

Notice how WordStar shows you the new page break. 

Remember, WordStar automatically starts a new page if the page fills with 
text. (The aLitomatic page break goes away if you delete lines of text, but the 
one you insert with a command doesn't.) 

Omitting Page Numbers ___________ _ 
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WordStar automatically numbers pages in a document. Page numbers appear 
at the bottom of each page when you print your document. Sometimes, 
though, you may not want page numbers in a document. 

Tell WordStar to omit page numbers. 

1 Pull down Go To and choose Go to file beginning (or press the accelerator 
command "QR) to make a quick cursor move to the top of the document. 
Be sure the column number in the status line says e1. 

2 Pu II down layout and choose Omit page numbering. 

When the document prints, there will be no page numbers. 

3 Save DIARY.DOC and return to the Opening screen. 
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Printing and Interrupting Printing ________ _ 
You may have several reasons to interrupt printing. Most often, it's to look 
over a page. Even if you need to stop printing altogether, you don't have to 
tu rn off the pri nter. 

Start to print DIARY.DOC. Then pause printing. 

1 Make sure your printer is on and ready. 

2 At the Opening screen, press FP, the accelerator command for Print a file. 

3 Press FlO. Printing begins and you're returned to the Opening screen. 

4 To pause printing, press FP to get to the Printing screen. 

S Press P again to make the printer pause. (It may take a few seconds.) 

6 Press C to continue. Printing begins again. 

If you should accidentally choose the wrong file to print, you can stop print­
ing by pressing the accelerator command "U at the Printing screen. WordStar 
returns you to the Opening screen where you can start again. 

What's Next? _______________ _ 
You've learned the basic techniques for opening, editing, and printing a doc­
ument. Now you may want to practice what you've learned before continuing 
with the remaining lessons. 

The lessons that follow cover features you won't want to miss. When you're 
ready, look through the remaining lessons to get an idea of what other 
WordStar features are available to you. Then you can start with Lesson 7 
and finish all the lessons, or you can select just the lessons that interest you. 
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LESSON 7 

More Features 
In this lesson you'll learn about 

• Windows 
• Classic WordStar Menus 
• Shorthand 
• Column Blocks 
• Using the Calculator 
• Changing Fonts 
• Footnotes 

WordStar is a word processing program rich in features and functionality. In 
the first six lessons of the "Training Guide" you were introduced to most of 
WordStar's menus and some basic commands. You'll find that the more you 
use the program, the more you'll learn, but there are a few features that merit 
some extra attention. This lesson contains exercises on some of these features. 

The lesson is written so you can work you r way from start to fi n ish or select 
individual subjects. 

If you have a floppy disk computer, you'll need your Training Work Disk. If 
you don't have a Training Work Disk, refer to Lesson 1 for instructions on 
creating one. If you have a hard disk computer, make sure you're in the 
WordStar directory. Start each exercise at the Opening screen. 

VVindows----------------------____________ __ 
When you're editing a file, you can open another file at the same time. When 
you do this, the screen splits and you have a "window" open on each file. 
This is a handy tool for editing two documents at the same time, because you 
can move text between documents. You can also use windows for looking at 
two different places in the same document. 
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Opening a Window 
Open a file, then open a window on another file and work with two docu­
ments at the same time. 

Start at the Opening screen. 

1 Open a new document file called PRACTICE.DOC. (Don't use 
Speed Write.) 

2 Type This is a practice document. Press ~ twice. 

Now you'll open a window on another file. (If your computer doesn't have 
enough random access memory, RAM, to open a new window, the com­
mand to open a window will be ignored.) 

3 Pull down Window from the EDIT menu bar. 

-open/sw i teh between windows 0)[ 
Size current window... on 
Copy block froM other window "IA 
Move block frOM other window "IG 

Close and save window "ID 
C lose and abandon window "Ilil 
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4 Choose Open/switch between windows to open a wi ndow on another 
document. 

5 When the dialog box appears, move the highlighting to WINDOW.DOC, a 
sample file in the directory, and press ~. (You can also create a new doc­
ument in a window.) Your screen looks like this: 

window 1 window 2 

.- HDOW.DOC P1 L1 C1 .ElEI" Insert Align RgtJust 
F Ie £dit====Go to==Window Layout===Style===Other= =EDIT= .. -This ; a practice document. < 

L-----! ----! ----! ----! ----! ----! ----! ----! ----! ----! ----! -------R 
~hen you're editing a file, you can open another file on the 
screen at the same time. The screen splits, and you have a 
"w i ndow" open on each file. 

< 

-

Notice that the'ruler line for WINDOW.DOC separates the two windows. The 
number 2 in the status line indicates that the cursor rests in the new window. 
Although you can see both documents, you can edit only the document in the 
window with the cursor. The information in the status line applies to the win­
dow where the cursor is. 

Moving the Cursor between Windows 
Next, you'll move the cursor to the other window. 

1 Pull down Window and choose Open/switch between windows. The cur­
sor moves to the other window. Now you can edit text in that file, and the 
status line applies to that window. 

2 Repeat step 1 and move the cursor back to the window containing 
WINDOW.DOC. 
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Copying Text from One Window to Another 

You can copy or move a block of text from one file to another by copying or 
moving text between windows. 

Next, copy a block of text from WINDOW.DOC to PRACTICE.DOC. 

1 Move the cursor to line 1, column 1 in WINDOW.DOC and mark the 
beginning of the block. (Block commands are on the Edit pull-down.) 

2 Pull down Go To and choose Go to file end. 

3 Mark the end of the block. 

4 Pull down Window and move the cursor into the window containing 
PRACTICE.DOC. 
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5 Pu II down Window and choose Copy block from other window to copy 
the block into PRACTICE.DOC. 

Changing the Size of the Current Window 
You can set the number of lines that will be in the window with the cursor 
when the screen is split. 

Split the screen so that WINDOW.DOC contains one line. 

1 Pu II down Window and choose Open/switch between windows to switch 
the cursor to WINDOW. DOC. 

2 Pull down Window again and choose Size current window. 

3 For a window two lines long, type 2 and press ~. (The ruler line counts as 
one line.) 
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2 C:WINDOW.DOC Pi L3 C29 2.88" Insert Align RgtJust 
rile Ed.i t===4:o to==W i ndow Layout===Sty le==Other===EDIT= 

L-----! ----! ----! ----! ----! ----! ---;--! ----! ----! ----! ----! -------R 
This is a practice document. 

When you're editing a file, you can open another file on the 
screen at the same time. The screen splits, and you have a 
"window" open on each file. 

L-----! ----! ----! ----! ---- !­
"window"~open on each file. 

- ! ----! ----! ----! --;--! ----! -------R , 

'----1----resized window 

Note: If you type 0, the upper window takes over the whole screen. When 
you move the cursor between windows, the screen changes from one docu­
ment to the other. The status line shows which window you're working in. 

Closing a Window 
When you want to exit, use the Close commands on the Window pull-down 
(or the same commands on the File pull-down) to close one window at a 
time. (Because you won't use these files again, you don't need to save them.) 

Close the window containing WINDOW.DOC. 

1 Make sure the cursor is in the window with WINDOW.DOC. 

2 Pull down Window and choose Close and abandon window. 

You've closed the window, exited WINDOW.DOC, and you're still in 
PRACTICE. DOC. 

3 Pull down Window again and choose Close and abandon window to 
abandon PRACTICE. DOC. 
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Classic WordStar Menus 

62 

Thus far in the lessons, you've created and edited documents by choosing 
items from Wordstar's easy-to-use pull-down menus. The pull-down menus 
list the basic Wordstar accelerator commands and dot commands. 

Wordstar also has an alternate set of menus called classic menus. The classic 
menus list every command available in Word Star. Power users, who edit com­
plicated documents, and touch typists might prefer using classic menus. 

You can use either set of menus or switch between them at any time. The 
command for changing from pull-downs to classic menus is on the Other 
Menu, available from either the OPENING or EDIT menu bar. 

Change to classic menus. 

From the OPENING menu bar, pull down Other and choose Change help 
level. You'll see the following help level information. 

F i le===Other~dd it iona I 

Press II for help I ~II 
OPEHIHG 

Release 5 
from MicroPro 

rr============ H I L P L I U I L ============jJ 

Choose a new help 
level or press Esc 
to cancel. 

Current help level: 

4 Pull-down menus 
3 Classic menus--all menus on 
Z Classic menus--Edit menu off, submenus on 
1 All menus off, confirmations off 
8 Function key labels off. allow hidden hlock changes 
4 g 

2 The help level for pull-down menus is 4. To choose classic menus, type 3. 

The classic Opening Menu is displayed. 
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OPE " I " G ~ E " U 
D open a document 
S speed write (new file) 
" open a nondocument 
P print a file 
~ merge print a file 
I index a document 
T tab Ie of contents 
Ie exit WordStar 
J help 

I' I' 
BOX .4k BROCHURE. DOC .Sk 
ENUELOPE. LST . Sk FIRST.BAK .Bk 
HP-ENUMM.LST .6k HP2-ENU.LST .6k 
I NUNTORV . DTA . 1k INUNTORV.LST 2.Bk 
LABEL3. LST . 1k LABEL3A 2.1k 
LABELXLA 1.1k LASER1.DOC B.3k 
MAILLIST.DOT .4k PHONE. LST 1. Bk 
ROLODEXA 1.4k RULER. DOC . 9k 

L change drive/directory 
C protect/unprotect a file 
E rename a file 
o copy a file 
II delete a file 
F turn directory off 

Esc shorthand 
R run a DOS command 
A additional 

DIARV. BAK 3. Gk 
FIRST.DOC .Bk 
HP2-ENUM. LST .6k 
I NUNTORV. NDX . 1k 
LABELA . Bk 
LASER2.DOC 3.1k 
PROOF. LST 1. Gk 

II down 
DIARV.DOC 3.6k 
HP-ENU. LST .6k 
INUNTORV.DOT .4k 
LABEL. LST . 1k 
LABELXL. LST . 1k 
LSRLABL3. LST 3. Bk 
ROLODEX. LST . 1k 

The classic Opening Menu lists commands and tasks. You decide what word 
processing task you want to perform and press the corresponding command. 
You'll find a brief discussion of the relationship between the two kinds of 
menus in "Starting." 

Open a file from the classic menus. 

1 At the classic Opening Menu, press s to open a Speed Write document. 
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Pi L1 Ci IHI" Insert Align RgtJust 
r;============ E I I T 

CURSOR SCROLL IELETE 
AE up All up AG char 
AK down AZ down AT word 
AS left AR screen up Ay line 
AI right AC screen lei char 
AA word left down AU undo 
AF word right 

!t E N U 
OTHER !tENUS 

AJ help AO onscreen format 
AI tab AX block & save 
AU turn insert off Ap print controls 
AD align paragraph Aq quick functions 
AN spl it the I ine Esc shorthand 
AL f ind/replace again 

L-----! ----! ----! ----! ----! ----! ----! ----! ----! ----! ----! -------R 

__ -_-__ -1 _I _-I _I •. -1 lB' 
1 - 2. 3 41. 51- -lil-. 7' S' - 9 -' 81. -

Notice that the classic Edit Menu lists commands for moving the cursor, 
scrolling, erasing, and general editing. On the right is a list of the five sub­
menus where you'll find the rest of the WordStar commands. 

Look briefly at the submenus. 

2 Press "0 to see the Onscreen Format Menu. When you're ready to go on, 
press the Spacebar. 

3 Look through the commands on the Print Controls Menu and Quick Func­
tions Menu. You'll recognize tasks from the pull-downs. When you're fin­
ished browsing, abandon the file. 

4 To quit the file, press "K for the Block & Save Menu. 

S Look for the command to abandon changes. Press Q. 
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Now that you've opened a file and abandoned it with classic menus, you're 
back at the classic Opening Menu. See Menus in the "Reference Guide" for 
information about using classic menus. 

Change back to pull-down menus. 

1 Find the Help command on the classic Opening Menu. Press J twice. 

2 To choose the pull-down menus, type 4. 

You're back at the OPENING menu bar listing the pull-downs. 

Shorthand Macros --------------
Shorthand (sometimes called macros) is a timesaving feature that allows you 
to assign a single character to a longer line of text or commands. Using short­
hand can save you many keystrokes on repetitive tasks. 

For example, if you type a specific name regularly, you can use shorthand to 
assign this text a single letter or number, N for instance. Then when you're 
working in a file, instead of typing the name, you press Esc, then N to have 
WordStar insert the name automatically. 

You need to learn two aspects of shorthand-how to use shorthand characters 
while you're working in a file and how to create the definitions and assign 
characters to them. 

Before you begin using shorthand, you should become familiar with the 
Shorthand Menu. The command to display the Shorthand Menu is located on 
the Other pull-down, reached from either the Opening or Edit screens. 

1 From the OPENING menu bar, pull down Other and choose Shorthand 
macros. The Shorthand Menu is displayed. 

- C: FILENAME. DOC Pi L9 Cll 1. ElEl" I nsert AI ign 
SHORTHAND rtE"U=======~ 

? display and/or change definitions F1 help 

= resu I t froM last "QM or "KM Math @ today' s da te 
$ forMatted result froM last AQM or AKM Math ! current tiMe 
• last AQM Math equation 

C Center rt MeMo S Sincerely 
T Transpose Word 
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The shorthand screen consists of a menu and a list of shorthand characters 
that have been defined. Notice that the shorthand character is displayed in 
boldface followed by a word or phrase to remind you what the shorthand 
character does. Five shorthand characters are listed on the menu itself (= , #, 
$, @, ! ). These are already set, and you can't change them. See the "Refer­
ence Guide" for more information on using these characters. 

The other shorthand characters (C, M, P, S, T) are already defined for you, but 
you can change them if you want. One shorthand character contains text (M 
for memorandum), three contain commands (P for cursor to previous para­
graph, T for transpose word, and C for center), and one contains text and 
commands (S for sincerely and three carriage returns.) 

When you're finished looking at the Shorthand Menu, press Esc to return to 
the Opening screen. 

Using Shorthand Characters 
Now, practice using shorthand characters. 

1 Create a file with Speed Write. 

2 Press ~ twice to move the cursor in column 1 to line 3. 

66 

First, you'll use a shorthand character and have WordStar insert some text. 

3 Pull down the Other Menu. Notice that the accelerator command for dis­
playing the Shorthand Menu is Esc. 

Esc and "JJ look dimmer than the other accelerator commands in the list 
(or if you have a color monitor, they're in a different color.) Accelerator 
commands displayed like this can't be issued when the pull-down menu is 
displayed. They must be issued directly from the Edit screen. 

4 Choose Shorthand macros. The Shorthand Menu is displayed. 

5 Press M. (Shorthand characters can be either upper- or lowercase.) 

WordStar inserts the word "Memorandum." 

Next, you'll use a shorthand character for some commands. 

6 Take a shortcut. Press the accelerator command Esc, then C. 

WordStar centers the text. 

Defining Characters 
Now you know how to use shorthand characters to speed up your word pro­
cessing. You might want to create and define your own shorthand characters. 
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You should be back at the Edit screen. 

1 Press Esc, then? (question mark). 

Under the heading MENU & KEY DEFINITIONS is a list of all the currently 
defined shorthand characters, along with a reminder of what each does. No­
tice that the five special shorthand characters (= , #, $, @, ! ) don't appear 
on the menu because you can't change their definitions. "Bytes available" in­
forms you of how much memory you have for more definitions. (You can set 
aside more memory in the WSCHANGE program.) 

A shorthand character can be any single letter or number, making a total of 
36 possible shorthand definitions. The maximum number of characters in a 
shorthand definition is 64. 

Define a shorthand character for some text. 

1 At the prompt Shorthand character, type E. 

2 At the prompt Description, type employees and press Tab. 

3 At the prompt Definition, type A special notice to all employees: and 
press FlO. (The small dots indicate spaces.) 

Notice that the shorthand character and definition are now listed with the 
other shorthand characters in alphabetical order. You can continue creat­
ing shorthand definitions, or you can exit by pressing ~I. 

4 Press~. 

5 At the prompt Store macro changes on disk?, type Y. Your shorthand char­
acter and definition are saved in a file. (For floppy disk systems, the file is 
on the Program disk.) 

You should be back at the Edit screen. 

6 To tryout your new shorthand character, put the cursor in column 1, line 6. 
Press Esc, then E. WordStar inserts the line of text. 

Now, define a shorthand character for commands. 

1 Press Esc to display the Shorthand Menu. Note that the shorthand character 
you just defined, E, is on the menu. 

2 Press? 

3 At the prompt Shorthand character, type H. 

4 At the prompt Description, type heading and press Tab. 
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At the next step you're going to use some commands from the classic 
menus to define the shorthand character. You'll type a heading and then 
the command for centering. If you were centering and typing a heading 
from the classic menus, you'd use these keystrokes: 

Gulliver's Travel Service "~C 

You need to enter this the same way for your shorthand definition. In other 
words, you must press the command for centering. Most important though, 
to enter any command you must press "P first. This is to tell WordStar not 
to execute the command while you're creating the definition. 

S At the prompt Definition, type Gulliver's Travel Service. Then press 
"P followed by the command "0. Release the Ctrl key and press C. 

Your definition should look like this: 

Gulliver's Travel Service"OC 

Notice that the "P isn't displayed. The C can be either upper- or lowercase. 

6 Press FlO. 
7 Press~, then type Y at the prompt. 

8 To tryout your new shorthand character, move the cursor to line 1, col-
umn 1. Press Esc, then H. WordStar inserts and centers the text. 

9 Abandon the file. 

Remember, the shorthand definition contains the keystrokes you would nor­
mally type. To enter a command you must press "P just before pressing the 
accelerator command. 

Advanced Shorthand 
So far, you've used very simple shorthand. As you become more familiar with 
shorthand, you'll figure out ways to use this feature to best meet your needs. 

Shorthand definitions are limited to one line. Following, though, is a lesson 
that ill ustrates how you can create shorthand characters that wi II insert text of 
more than one line. It's done by i nserti ng shorthand characters with ina short­
hand definition. 

Let's say you want to have the following heading typed with the first line 
boldfaced and all lines centered: 

Gulliver's Travel Service 
152 Lilliput Street 

San Francisco, CA 94118 

First, you define each line individually. 
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1 At the Opening screen, pull down Other and choose Shorthand macros. 

2 Follow the steps in the previous section and create three new shorthand 
definitions, one for each line of the heading. 

First line Give the first line the shorthand character 1 and call it "name./I 
In the definition, enter "PB to boldface and "OC to center the text. Enter 
"M (the accelerator command for a carriage return) at the end of the defini­
tion. 

Use the following series of keystrokes for the definition. Remember, you 
must press "P before you enter an accelerator command. 

"P"PBGulliver's Travel Service "P"PB"P"OC"P"M 

When you're finished entering the keystrokes, the definition should look 
like this on your screen: 

Second line Give the second line the shorthand character 2 and call it 
"street./I In the definition, enter the accelerator command to center the 
text. Enter "M (carriage return) at the end of the definition. 

Use the following series of keystrokes for the definition. Remember, you 
must press "P before you enter a command. 

152 Lilliput Street "P"OC"P"M 

When you're finished entering the keystrokes, the definition should look 
like this on your screen: 

152 Lillip~t Street"DC"M 

Third line Give the third line the shorthand character 3 and call it "city." 
In the definition, enter commands with accelerator commands to center 
the text. Enter "M (carriage return) at the end of the definition. 

Use the following series of keystrokes for the definition. Remember, you 
must press "P before you enter a command. 

San Francisco, CA 94118 "P"OC"P"M 

When you're finished entering the keystrokes, the definition should look 
like this on your screen: 

San Francisco, CA 94118"DC"M 

Next, you need to define a fourth shorthand character and include the 
three shorthand characters you just defined. 

3 Define a fourth shorthand character. Give this one the character H and call 
it "heading./I (This will change the shorthand character H you defined in 
the previous exercise.) Just type over the currrent information. 
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Use the following series of keystrokes for the definition. Esc stands for the 
Escape key. Press "P, press Esc, press 1, press "P, and so on. 

"PEsc1"PEsc2"PEsc3 

When you're finished entering the keystrokes, the definition should look 
like this on your screen: 

You've defined a shorthand character with the keystrokes that will tell 
WordStar to enter the three shorthand characters 1, 2, and 3 in succession. 

4 Press ~ twice, then Y at the prompt to save your definitions and return to 
the Opening screen. 

5 Open a new file. Try the shorthand character H you just created. 

6 With the cursor in column 1, line 1, press Esc, then H. WordStar enters 
three I ines with one shorthand character. 

If you don't get the three-line address, go back over the description of each 
definition to make sure you've typed the keystrokes exactly. Then try again. 

7 Abandon the file. 

This process is called nesting shorthand keys. You can also try chaining short­
hand definitions by putting the Esc-character sequence at the end of the defi­
nition. You could also have a shorthand definition reference itself by entering 
its own Esc-character sequence at the end. This process, called looping, 
would b~ useful for doing a repetitive task that can't be performed with a sin­
gle command. You press "U to stop the loop. 

Column Blocks 
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YOL! may need to type columns of text or tables. Editing columns can be tricky 
because altering one column can sometimes affect how another column lines 
up. WordStar has a handy feature called column blocks, which can help you 
edit and work with columns of text. By switching modes from a horizontal ar­
rangement of text to a vertical arrangement, you can work with columns of 
text easily. 

In this lesson you'll mark and move a block of text from a table. You'll use a 
sample file called TABLE.DOC. 

1 Open the file TABLE.DOC. Notice that the table includes columns of 
figures. 

2 Pull down Edit and find the command to turn column mode on. 

3 Choose Column block mode. Notice the word Column is displayed in the 
status line. This indicates column mode is on. 

Now, mark a column block. 
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4 Move the cursor to the space just to the left of the "M" in the phrase 
"Maximum g." Mark the beginning of the block. 

S Move the cursor down to the last line of the column to the number 3.10. 
Then move it to the right until it's positioned one space past the vertical 
column line. Mark the end of the block. The block is highlighted. 

Now, delete the block. 

6 From the Edit pull-down, choose Delete block. Notice how the other col­
umns to the right of the one you removed moved over to fill in the space. 

You may not always want to have the other columns shift to fill in. You'll 
remove the block again, this time turning column replace on. 

7 Pull down Edit and choose Undo (or press the accelerator command AU) to 
bring the block back. 

Now, start over and mark the block again. 

1 On the Edit pull-down, find the choice to turn column replace on. 

2 Choose Column replace mode. Look at the status line. Co/Rep! tells you 
column mode is on and column replace is on. 

3 Mark the block again. (Follow steps 4 and 5 above.) 

4 From the Edit pull-down, choose Delete block. Notice that this time with 
column replace on, the text left a space instead of moving. 

S Exit and abandon the file. 

You've just completed two very simple column operations. There's a lot more 
you can do with column blocks. See Column blocks in the "Reference Guide." 

Changing Fonts ______________ _ 
If your printer has a variety of fonts, you can change to another typeface 
within your text. 

Change some text to a different font. 

1 Open a practice file with Speed Write. 

2 Type the followi ng text: 

Final sale starts tomorrow. ~ 
~I 

Doors will be open at noon! ~ 
~ 

Bring your wallet and don't be late. ~ 
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Next, choose another font for the remaining text. 

3 Move the cursor to the "0" in "Doors." 

4 From the Style pull-down, choose Choose font. 

S Move the highlighting to one of the fonts 'displayed in the list. 

For nonproportional fonts, the list tells you the pitch of the available fonts, 
for example, 10 pitch or 12 pitch. For proportional fonts, the list also tells 
you the typeface of the fonts, such as Times Roman or Helvetica. 

6 Press ~I to choose the font you want. 

7 Notice the font name enclosed by angle brackets «». The text following 
the font name prints that font until you change the font again. The line 
breaks and page breaks displayed correspond to the chosen font. 

8 Save the practice file. Name it FONTS.DOC, then print it. 

Footnotes 
With WordStar you can type a variety of notes. Notes are automatically order­
ed and printed in the proper place in a document. One of these notes, a foot­
note, appears at the bottom of the page on which a reference occurs. 

Create a footnote. 

1 Open a practice file with Speed Write. 

2 Type The translation is formal. 

72 

3 From the Other pull-down, choose Footnote/endnote. 

WordStar offers endnotes and footnotes. You'll create a footnote. 

4 Press F for footnote. 

S With the cursor in the footnote window, type Susan Moran, ed. and trans. 

6 Press "KD to save the footnote. 

With display off, references to footnotes (numbers beginning with 1) appear 
in the text. With display on, the first few words of the footnote appear in 
brackets. 

References print in superscript. The footnote itself is separated by dashes 
from the text and printed at the bottom of the page. 

7 Save the file and name it NOTE.DOC. Print the file if you like. 

Note: You can choose some other sequencing method for references, such as 
ABC or * ** *** with the dot command .f#. See Footnotes and endnotes in 
the "Reference Guide." 
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To remove a footnote, delete its reference and type Y. (If you delete a refer­
ence accidentally, you can restore it with the Undo command.) 

You've covered some of WordStar's most useful features. In the next lesson, 
Advanced Formatting, you'll build on what you learned about formatting in 
Lesson 3. 
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LESSON 8 

Advanced 
Formatting 

In this iesson you'll learn about 

• More Onscreen Format Commands 
• Headers and Footers 
• The Ruler Line 
• Automatic Indentation 

Formatting determines how a document will look when it's printed. You can 
do a lot with WordStar in terms of designing documents. Lesson 3 introduced 
you to some basic formatting commands. In this lesson, you'll be introduced 
to a few more formatting techniques that you'll find helpful. 

You can work your way through the lesson from start to finish or select indi­
vidual subjects at random. 

More Onscreen Format Commands ----------------------
You should already be familiar with a few of the onscreen format commands. 
There are several other useful commands you can issue with commands from 
the classic menus. (The command to change to classic menus is on the Other 
Menu.) Following isan explanation of these commands. Open the file 
TEXT.DOC and practice using some of the commands. 
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COMMAND 

Margins 
"OA 

"OT 

"00 

Typing 
"OW 

"OH 

"DE 

''~C 

Display 
"OP 

FUNCTION 

Turns auto-align off and on. With auto-align off, WordStar doesn't 
force an edited line to fit within the margins. You must press "8 or 
"QU to align the text. With auto-align on, WordStar adjusts an 
edited line to fit the margins automatically. 

Turns the display of the ruler line on and off. This gives you more 
room on your screen to display text. 

Inserts a copy of the current ruler line in your document. The new 
ruler is inserted as a .rr command. You can edit this ruler line. 

Turns word wrap off and on. If you turn word wrap off, you have to 
end each line by pressing~, just as you would on a typewriter. 

Turns automatic hyphenation on and off. When auto-hyphenation 
is off, words that don't fit within the right margin wrap to the next 
line. When it is on, WordStar automatically hyphenates words that 
extend beyond the right margin. 

Enters a soft hyphen. A soft hyphen prints only when it occurs at 
the end of a line. When you use "DE to hyphenate a word, the 
hyphen won't print if the position of the word changes in the para­
graph. A word's position would change, for example, when text in 
a paragraph realigns. 

Sets a temporary indent. 

Turns preview on and off. You can't edit your document while pre­
viewing. 

Footers and Headers 
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Footers are special lines printed at the bottom of every page; headers are spe­
cial lines printed at the top of every page. Footers and headers can be useful 
in documents where you want certain information such as a chapter title to 
appear on every page. With footers and headers you don't have to type this 
information on every page. WordStar inserts it automatically. 

A footer or header can be up to three lines long. The page number that 
WordStar pri nts is actually a footer. 
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To create a one-line header or footer, choose Header or Footer from the 
Layout pull-down. You can also use the following dot commands: 

COMMAND FUNCTION 

Footer at the Layout Menu or type a dot command: 

.fl or . fo fi rst line of footer 

.f2 second line of footer 

.f3 third line of footer 

Header at the Layout Menu or type a dot command: 

.hl or .he first line of header 

.h2 second I ine of header 

.h3 th i rd line of header 

Practice inserting a header and a footer in the file TEXT.DOC. 

1 Make sure the cursor is at column 1, line 1 and insert is on. 

2 From the Layout pull-down, choose Header or type .hl~ to begin the 
header. (Remember, dot commands can be typed in either upper- or lower­
case.) 

3 Type Gulliver's Travels. 

4 Move the cursor to 5.1 inches and type Part I~ . 

5 Pull down Layout and choose Footer or type .fl~ . 
6 Move the cursor to 2.7 inches and type Page #. 

You can have WordStar put the page number anywhere you want in a 
header or footer. The symbol # stands for the page number. 

7 Save and print the file. (For quick printing, press the Ctrl key and the PrtSe 
key and then FlO.) 

Notice how the text in the one-line header and footer repeats on each page. 
The page number you typed as # prints with the actual page number. 

You can use footers and headers in many ways. See Headers and footers in 
the "Reference Guide" for more information. 

The Ruler Line 
The ruler line displays a document's left and right margins and tab stops. 
When you create a new document, the left margin is automatically set at col­
umn 1 (.00 inch), and the right margin is set at column 65 (6.5 inches). Tab 
stops are set at five-column (O.5-inch) intervals. In Lesson 3 you learned how 
to set and clear tabs and change the left and right margins. But there's more 
to know about working with ruler lines in WordStar. 
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It's important to understand how WordStar reads the formatting commands in 
your document. 

1 Open the file RULER.DOC. 

2 With the cursor on the first line, slowly move the cursor down through the 
document and watch the ruler line as the cursor moves past dot commands. 

WordStar gets its formatting signals from the dot commands. 

You can type a ruler line yourself. Just start the line with .rr and type the ruler 
using the standard ruler line characters, such as an exclamation point for a 
tab. 

TIP In WSCHANGE, you can create up to ten preset versions of the ruler 
line. To insert a preset ruler line in your document, type the dot command .rr 
and the number of the ruler line with the tabs and margins you want. This 
shortcut eliminates resetting tabs and margins for frequently used page styles. 

Automatic Indentation ____________ _ 
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Word wrap is one of the features that makes word processing fast and easy. 
You don't have to insert a carriage return at the end of every line. But some­
times you need to create documents with text that requires specific indenta­
tions-a paragraph or numbered list, for example. WordStar has an auto­
matic indentation command, .pm, that you use to manage word wrap for 
indented text. 

We'll look at the technique for using .pm to indent a paragraph and create a 
hanging indentation in a numbered list. 

Paragraph Indentation 
1 Open a practice file. 

2 Pull down Layout and choose Margins and tabs. In the box, move to 
Paragraph and type .5. Press FlO to return to editing. 

A P for paragraph indentation appears in the ruler line. The dot command 
.pm inserted in column 1 tells WordStar to indent the first line of a para­
graph to .5 inch. 
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3 Type this text: 

Word processing is a computer-age term for typing and edit­
ingany kind of text like letters, memos, articles, reports, 
even books. Word processing involves typing into a com­
puter, but it's more than just typing.~ 
~ 

Wi th a typewr iter, you see words on paper as you type. When 
you use a word processor, you see words on the computer 
screen as you type.~ 
~ 

4 Notice how the first line of each paragraph indented five spaces. 

5 At the Margins & Tabs dialog box, move to Paragraph, and type .0. Press 
FlO to return to editing. Watch the ruler line-the P for paragraph inden­
tation disappears. 

Hanging Indentation 
Sometimes you need to wrap text continuously to an indented space. This 
time, type dot commands to create a hanging indentation. 

1 In the practice file, place the cursor on column 1, line 10. 

2 Move the cursor under the second .pm in column 1. 

3 Type .lm.S". 

4 Move the cursor under the .1m in column 1. Type 1. and press the Tab key. 
Now type this text: 

As you read your text on the screen, you can change it and 
rearrange it until it looks just thewayyouwant. 

5 Press ~ twice. 

Notice how the text wrapped and held where you set the left margin at 
.5 inch. The text will continue to hold until you press the ~'key. 
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6 Type 2., press the Tab key, and type this text: 

You can save text typed wi th a word processor and use it again 
later. Your text is saved electronically in a file. 

7 Press ~ twice. 

You can remove the indentations by typing .pmO and .lmO in column 1, 
again pressing ~ after each. 

8 Save and exit the file. 

As you gain experience with WordStar, you'll find other ways to design and 
format your documents. The next lesson covers merge printing. You'" print 
personalized form letters with WordStar's merge print feature. 
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Merge Printing 
The WordStar MailList function lets you store mailing lists that contain names, 
addresses, and other information. Merge printing commands insert informa­
tion from a mailing list into a document when you print, enabling you send 
individualized letters to each person on your mailing list. 

Note: You can also merge print with mailing lists typed in WordStar or cre­
ated in other programs such as Lotus® 1-2-3®, Symphony®, or dBASE®. For 
information, see "Using data files from other programs" in the Merge printing 
section of the "Reference Guide." 

In this lesson, you'll learn about 

• Creating a Mailing List 
• Making Changes to the Mailing List 
• Creati ng a Master Docu ment 
• Printing Form Letters to the Mailing List 

Creating a Mailing List -------------
Use MailList to create a short mailing list. 

1 Unless you're continuing from Lesson 8, start WordStar. 

If you have a two floppy disk system and MailList is not on your Program 
disk, you'll run the MailList program at the system prompt. Make sure your 
Training Work Disk is in drive B. As you go through the steps in this lesson, 
you'll be prompted onscreen to change disks. 
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2 From the OPENING menu bar, pull down Additional and choose MailList. 
The MailList Menu appears. 

Some floppy disk users may see instructions to run MailList from the sys­
tem prompt. If so, do the following: 

Exit WordStar. 

Remove the Wordstar Program disk from drive A and insert the disk con­
taining MailList. 

At the B> prompt, type a: and press ~ to log on to drive A. 

Type wslist and press ~ . 

FORM: .,..1".i-
~hoose a data file 

rildd new records 

!liew and edit records 

A ILL 1ST MEN U 

~ocate records by number 

mort records 

Illse another form 

Press a high I ighted letter. 

iii Help 

!!luit 

3 Press C to choose a data file. (A mailing list is kept in a file called a data 
file.) 

4 Type customer.dta (or b:customer.dta if you have a two floppy disk computer) 
and press ~. 

The mailing list you're creating is named CUSTOMER.OTA. Next, you'll type 
information into the mailing list form. 

1 Press A to add records to the data file. A record is the information about 
one person on the mail i ng list. 

A form called the data entry form appears on the screen. Each piece of 
information on the form is called a field. The cursor is in the Record 
Number field. 
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2 Type 1, then press ~I. This assigns the number 1 to the first record. 

The cursor moves to the Date field. 

3 Type 082688 and press ~I. This is displayed as 08/26/88. 

4 Fill in the rest of the form so that it looks like the screen below. 

If you don't need to fill in a field, just press ~ to skip to the next field. If 
you make a typing error, you can erase characters with the Backspace key. 
You can move the cursor around the form using these commands: 

Left one character 

Right one character 

Previous field 

Next field 

Top (first) field 

Last field 

"5 or~ 

"0 or~ 

"A or"-<­

"F or" ~ 

"T or Home 

"L or End 

ADD NEW R E COR D S 

liopy from previous record ferite/save record in file 

Type data and press =. 
Record Humber: Date: IiIS1llJiIil 

Mr.lMs.: mm/dd/yy 
First, Init., Last: Jr./M.D.: •••• 

Title: 

Company: 
Address Line 1: 
Address Line 2: 

City, State, Zip: 
Country: 
Phone-I: 
Phone-2: 

rite Schoo 1 _______________________ _ 
233El Lark Ave. _____________________ _ 

B~~~~-Vi;t~==========-CA=-95912===== 

lel=555=7676~======================= 
-----------------------------------

User Fields- Remarks-
1: 
2: 
3: 

--------------------------------------------------------
--------------------------------------------------------
--------------------------------------------------------

5 Check to make sure you typed everything correctly. Notice the line at the 
top of the screen that says "Write/save record in file. Press "W to save this 
information in the data file. 

6 Notice the three choices at the top of the screen. Press ~ to save the rec­
ord. 
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7 Repeat steps 4-6 to add these two records to your data file: 

FORM: [8M""- ADD HEW R E COR D S 

lDopy from prev ious record reI' i tel save record in f i Ie [II Help 

l!I!ape 

Record Number: 
Mr./Ms. : 

First. Init .• Last: 
Title: 

Company: 
Address Line 1: 
Address Line Z: 

City. State. Zip: 
Country: 
Phone-1: 
Phone-Z: 

User Fields-
1: 
Z: 
3: 

FORM: [8M'.'-

T!;Ipe data and press =. 

Dogwood Schoo 1 _____________________ _ 
1 Schoo lhouse Rd. __________________ _ 

------------------------------------
Lynv ill e _____________ OH_ 47308 ____ _ 

------ -----------------------------
101-5 5 5-7 4 97= _______________________ _ 

-----------------------------------
'Remarks-

Da te: l!!l1Ili!II 
mm/dd/!;llJ 

Jr./M.D. : 

--------------------------------------------------------
--------------------------------------------------------
----------------------------------------------------------

ADD HEW R E COR D S 

lDopy from previous record reI' i tel save record in f i Ie 

Record Number: 
Mr./Ms. : 

First. Init .• Last: 
Title: 

Company: 
Address Line 1: 
Address Line 2: 

City. State. Zip: 
Country: 
Phone-1: 
Phone-Z: 

User Fields-
1 : 
2: 
3: 

Type data and press =. 

Oakvale High School ________________ _ 
770 Burton St. _____________________ _ 

-----------------------------------
Oakva le ______________ H}, _ 32701 ____ _ 

-------------- ---------------- -----
513-5 5 5-e 3 8 0 = ______________________ _ 
-----------------------------------

Remarks-' 

Date: Im1llJiE 
mm/dd/!l!;l 

Jr.lM.D. : 

-~------------------------------------------------------

--------------------------------------------------------
----------------------------------------------- ---------
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8 When you're finished typing and saving all three records, press Esc. The 
MailList Menu appears. 

You now have three customers on your mailing list. 

Making Changes to the Mailing List _______ _ 
Once you've added records, you can look at them and make changes any 
time. Next, you'll look through your records and make a correction. 

1 Press V to view and edit records. The first record appears on your screen. 
Notice the View and Edit Records Menu at the top of the screen. 

2 Press "N to see the next record. 

3 Press "P to see the previous record. 

4 Press "P again. You're now at the beginning of the file. 

S Press Esc to go to the end of the file. 

6 Correct Ms. Hannis's name to Ms. Harris. Use the same commands to 
move the cursor as you did in adding records. 

7 Press "W to save the updated record. 

8 Press Esc. 

9 Press Q to exit Mail List. 

If you have a two floppy disk computer and you ran MailList at the system 
prompt, start WordStar. 

The WordStar Opening Menu appears. 

Creating a Master Document __________ _ 
You're ready to write a letter to each customer on the mailing list you just cre­
ated. You can create this letter, called a master document, with WordStar and 
use MailMerge® commands to insert names and addresses from the mailing 
list. 

Start at the WordStar Opening screen with Speed Write. 

1 Open a new file. 

2 From the Edit pull-down, choose Insert a file and insert the file 
MAILLlST.DOT. (If necessary, include a pathname file for the 
MAILLlST.DOT file.) 

MAILLlST.DOT contains the dot commands you need in a master docu­
ment. (If your mailing is contained in a program other than MailList, you 
shouldn't use MAILLlST.DOT to set up the master document.) You can find 
complete information about these dot commands later in this manual. For 
now, notice the lines beginning with .df and .rv. 
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3 Move the cursor to the line beginning with .df. 

The .df dot command defines the data file as WSLlST.DTA. (WSLlST.DT A is 
an empty file you can use for your main mailing list.) You want to use 
CUSTOMER.DTA, the data file you created. 

TIP If you have a two floppy disk computer, put Mail List format files (such 
as MAILLlST.OOT) and your mailing list files (.OTA) on the same disk. 

4 Following .df, erase WSLlST.DTA and type customer.dta. (Include a 
pathname, if necessary.) 

The next three lines begin with .rv. The words in these lines are names that 
correspond to the fields on your mailing list form. You'll use these names 
in the letter where you want to insert data from the mailing list file. 

5 Move the cursor to the blank line above the line that says (Type text and 
variable names here.) Press "Y twice to remove the blank line and the line 
following it. These lines shouldn't appear in the letter. 

6 Type the letter shown below. When you're finished, check your work. All 
the words enclosed in ampersands (&) are called variable names. Variable 
names occur wherever information is to be inserted. They must exactly 
match the corresponding names in the .rv dot commands. (Upper- and 
lowercase letters are acceptable.) Be sure that all the text is above .pa, the 
dot command that tells WordStar to start a new page. 

Sonoma Textbooks~ 
30 School St . <.oJ 
Lake City, WI 53701~1 
~ 

September 28, 1988~1 
~ 

&full-name&~ 
&tompany&~ 
&addr1&~ 
&city&, &state&, &ZiP&~1 
~ 

Dear &Mr-Ms& &last&:~1 
~ 

Sonoma Textbooks introduces Modern Classics, the reading and 
writing game that adds creativity to computerized learning.~1 
~ 

We are sure that you and your students at &company& will be 
pleased wi th thi s product .~I 
~ 

Sincerely,~ 
~ 

~ 

Sam Hergenrather 
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Note: The .op dot command omits page numbers. Most form letters don't 
need page numbers. You can delete it if you want to print page numbers. 

Printing Form Letters to the Mailing List _____ _ 
Next, you'll print form letters using the mailing list and master document you 
just created. 

1 Save the file and name it CLASSICS.DOC. 

2 From the File pull-down, choose Merge print a file. Make sure your 
printer is ready and has continuous feed paper if appropriate. 

3 CLASSICS.DOC is the filename of the master document. Press FlO to start 
printing. 

Three letters are printed, one to each person on the mailing list. The first let­
ter should look like this: 

Sonoma Textbooks 
30 School St. 
Lake City, WI 53701 

September 28, 1988 

Albert G. Alvarez 
Wright School 
2330 Lark Ave. 
Buena Vista, CA 95912 

Dear Mr. Alvarez: 

Sonoma Textbooks introduces Modern Classics, the reading and 
writing game that adds creativity to computerized learning. 

We are sure that you and your students at Wright School will be 
pleased with this product. 

Sincerely, 

1 Sam He'gen,athe, 

;1 

Now that you've created a mailing list and a master document and used them 
together to print form letters, you've finished the lesson and learned the 
basics of MailList and merge printing. Read the information in the "MaiIList" 
tab section and in the Merge printing section of the "Reference Guide" to 
find how much more you can do with mailing lists and merge printing. 

87 



( 



REFERENCE CONTENTS 

A Accent marks .............................................. 93 
Additional features .......................................... 93 
Aligning text .............................................. 93 
ASCII .................................................... 94 
Auto-indent ............................................... 95 

B Backup fi les ............................................... 96 
Bidirectional printing ........................................ 96 
Binding space ............................................. 97 
Blank lines ............................................... 97 
Block math ............................................... 97 
Blocks ................................................... 98 
Boldface .................... ' ............................ 100 

C Calculator ............................................... 101 
Caps Lock key ............................................ 102 
Case conversion .......................................... 102 
Centering text ............................................ 103 
Character width ........................................... 103 
Clearing the screen ........................................ 104 
Color .................................................. 104 
Column blocks ........................................... 104 
Columns ................................................ 106 
Command files ........................................... 107 
Comment lines ........................................... 108 
Control key .............................................. 108 
Copyi ng ................................................ 1 09 
Creating a document or nondocument .......................... 109 
Cursor .................................................. 110 
Cursor diamond .......................................... 110 
Cursor movement keys ...................................... 111 
Cursor movement and scrolling ............................... 112 
Custom print controls ...................................... 114 
Customizing WordStar ...................................... 115 

D Data files ................................................ 116 
Decimal tabs ............................................. 117 
Defaults ................................................ 118 
Delays ......... ' ......................................... 118 
Delete key ............................................... 118 

89 



CONTENTS 

Deleting text ............................................. 119 
Dialog boxes ............................................. 120 
Directories .............................................. 120 
Displayingprintcodes ...................................... 121 
Documents and nondocuments ............................... 121 
Dot commands ........................................... 122 
Double strike ............................................. 128 
Drawing ................................................ 129 

E Editing ................................................. 130 
Enter key ................................................ 1 30 
Error messages ............................................ 1 31 
Exiting .................................................. 131 
Extended character set ...................................... 1 31 

F Fi les and fi len ames ........................................ 132 
Finding and replacing ...................................... 132 
Finding your place ......................................... 135 
Flag column ............................................. 135 
Fonts ................................................... 136 
Footnotes and endnotes ..................................... 138 
Formatti ng ............................................... 140 
Form feeds ............................................... 140 
Function keys ............................................ 141 

H Headers and footers ........................................ 141 
Help levels .............................................. 143 
Help messages ........................................... 144 
Hyphenation ............................................. 144 

I Indenting ............................................... 145 
Indexing ................................................ 146 
Inserting text and files ...................................... 148 
Installing WordStar ........................................ 149 
Italics .................................................. 150 

J Justification .............................................. 150 

K Keyboard ................................................ 150 

L Landscape and portrait mode ................................. 152 
Line feeds ............................................... 152 
Line height .............................................. 153 
Line numbering ........................................... 153 

90 



REFERENCE 

Line spacing ............................................. 154 
Logged drive and directory ................................... 155 
Lotus 1-2-3 and Symphony ................................... 155 

M MailList ................................................. 155 
Margins ................................................. 156 
Maximum document size ................................... 160 
Memory usage ............................................ 161 
Menus .... " ......... " ................................. 161 
Merge printing ............................................ 164 
Merge printing conditional commands .......................... 171 
Merge printing variable formatting ............................. 177 
Merge printing variable number formatting ...................... 178 
Messages while printing .................................... 180 
Microjustification ......................................... 181 
Moving text .............................................. 181 

N Near letter quality printing ................................... 182 
Nesting and chaining ....................................... 182 

o Overprinting ............................................. 184 

P Page breaks .............................................. 184 
Page length .............................................. 185 
Page numbering .......................................... 186 
Page preview ............................................. 187 
Paragraph margins ......................................... 189 
Paragraph numbering ...................................... 190 
Paths ................................................... 191 
Pause printing ................................ ~ ........... 191 
PC-Outline .............................................. 192 
Phantom space and rubout .................................. 192 
Pitch ................................................... 192 
Place markers ............................................ 193 
Ports ................................................... 193 
PRCHANGE ............................................. 193 
Previewing .............................................. 193 
Printer description files ..................................... 194 
Printing a file ............................................. 194 
Printing multiple copies ..................................... 196 
Printing to disk ........................................... 197 
ProFi nder ............................................... 198 

91 



CONTENTS 

Prompts ................................................. 198 
Proportional spacing ....................................... 199 
Protecting a file ........................................... 199 

Q Quattro spreadsheets ....................................... 200 

R README ................................... ; ............ 200 
Renaming a file ........................................... 200 
Repeating ............................................... 200 
Ruler lines ............................................... 201 
Running a DOS command ................................... 202 

S Saving a file .............................................. 203 
Scrolling ................................................ 204 
Sheet feeders ............................................. 205 
Shorthand ............................................... 206 
Soft spaces and carriage returns ............................... 208 
Sortin-g text .............................................. 209 
Speed Write ............................................. 209 
Spelling check ............................................ 209 
Spreadsheets ............................................. 212 
Starting WordStar .......................................... 212 
Statusline ............................................... 213 
Strikeout ................................................ 214 
Subscript and superscript .................................... 215 

T Table of contents .......................................... 216 
Tabs ................................................... 217 
TelMerge ................................................ 218 
Temporary files ........................................... 218 
Thesaurus ............................................... 218 
Toggles ................................................. 21 9 

U Underlining ............................................. 219 
Undo and unerase ......................................... 220 

W Windows ............................................... 221 
Word count .............................................. 221 
Word wrap ............................................... 222 
WSCHANGE ............................................. 223 

92 



Reference Guide 
The "Reference Guide" gives detailed explanations of WordStar's features, functions, 
and commands. Topics are presented in alphabetical order. The entry titles are func­
tional. For example, you don't have to know that the command for boldfacing a word 
is on the Style pull-down. Simply look for Boldface. If you don't immediately find the 
topic you are looking for, refer to the index. 

A 
Accent marks 

Many non-English words have accent marks; for example, ecran or atces. To print 
accent marks, use the "PH overprint command. "PH causes the printer to backspace 
and overprint the previous character. See also Overprinting. 

Additional features 

WordStar has additional features that you can use to create mailing lists or use a tele­
communications service. These are on the Additional pull-down at the Opening 
screen. If you're using the classic menus, press A at the Opening Menu. For more 
information on these features, see the appropriate tabbed section in this book. 

Aligning text 

When you edit a document, you usually change the length of some of its lines. 
WordStar then aligns the paragraph you're working in to make the lines fit within the 
margins. This feature is called auto-align. While editing, you can turn auto-align off 
(and on again) with "OA. You can change the default setting for auto-align by using 
WSCHANGE. You can also decide how long typing must pause before aligning 
begins. 
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AS C" 

While WordStar aligns new text to the current margins and tabs, it does not automati­
cally realign existing text after you change margins, tabs, or fonts. To realign an ex­
isting paragraph, move the cursor to the first line of text that you want to align, then 
choose Align rest of paragraph from the Layout pull-down, or press "B. If the new left 
margin indents the paragraph, place the cursor at the beginning of the line before you 
align. 

If you are using a temporary indent ("OC), the temporary indent column is used as the 
left margin. WordStar stops aligning at the next hard carriage return (shown by the < 
flag at the right side of the screen). 

You can align more than one paragraph by choosing Align rest of document at the 
Layout pull-down or by pressing "QU. You can stop aligning by pressing"U. 

When aligning a whole document, you can mark certain sections of text, such as 
tables or charts, that you do not want to align. Place the cursor on the line above the 
section and type the dot command .aw off. Type .aw on on the line before you want 
aligning to resume. 

When you use .aw off to turn auto-align off, word wrap and justification are turned off 
as well. When the cursor is in a portion of text that will be aligned, the word Align ap­
pears in the status line. 

If you change margins in a note and want to realign all subsequent notes, press 
"ONU. For more information, see Footnotes and endnotes. 

With auto-hyphenation on ("OH), WordStar hyphenates words while you're aligning. 
See Hyphenation. 

TIP Use the "PO command to create a binding space between words you want to re­
main together on the same line. A phrase that uses binding spaces instead of normal 
spaces is treated as one word. See Binding space. 

"OA turns off auto-align for the current editing session, but the next time you edit the 
file, auto-align will be on again. 

TIP You can use the .pi command to align text at print time. This command is mostly 
used with merge printing but can also be used with regular printing. See Merge 
printing. 
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You can align paragraphs automatically after substitutions during find and replace op­
erations by using the A option on the Find and Replace screen. See Finding and 
replacing. 

Alternate type. See Pitch and Fonts. 

Annotations. See Footnotes and endnotes. 

ASCII 

ASCII (American National Standard Code for Information Interchange) is a standard 
file format that lets different types of computers interpret information in the same way. 



AUTO-INDENT 

Files in ASCII format do not include formatting such as justification or word wrap. 
WordStar nondocument files are ASCII files. Using WordStar, you can create ASCII 
files or convert files from document format to ASCII format. 

Creating ASCII files 

To create an ASCII file, you must open a nondocument file. To do this, choose Open 
a nondocument file from the File pull-down at the Opening screen, or press N at the 
classic Opening Menu. 

C AUT ION Don't add print enhancements (such as boldfacing) to a nondocument 
file; you're likely to get unexpected results if you do. Also, should you open an ASCII 
file in document mode by mistake, exit the file without saving it (AKQ). If you save it, 
WordStar adds formatting codes to the file. 

For more information, see Documents and nondocuments. 

Converting files to ASCII format 

To convert a document file to ASCII format, print the file to disk. Use one of the print 
commands to display the Print dialog box. At the Printer name prompt, choose ASCII. 
At the Redirect output to prompt, type the name you want to give the ASCII file. Press 
FlOor "K to start printing. 

If you don't type a filename, the file is named ASClI.WS. See also Printing to disk. 

Converting ASCII files to document files 

To convert an ASCII (or nondocument) file to a document, reopen it as a document. To 
make paragraphs, press "6 at each line, except at the last line of each paragraph and 
the blank lines between paragraphs. (Use the 6 at the top of the keyboard and not the 
6 in the numeric keypad.) This changes hard carriage returns to soft returns. Then 
align the entire file ("QU). 

Auto-align. See Aligning text. 

Auto-hyphenation. See Hyphenation. 

Auto-indent 
Auto-indent is available only for nondocuments. As lines are typed, this feature 
indents them automatically. Auto-indent is especially useful for programming in lan­
guages such as C, since the practice in structured programming is to indent the same 
amount for each level of nesting. 

To turn auto-indent on, use the "6 command. Hold down Ctrl and type the number 6. 
(Use the number key above the letter keys; do not use the number on the numeric key­
pad.) When auto-indent is on, Auto-In appears in the status line. Press the Tab key, "I, 
or the Spacebar to move the cursor to the column to which you want subsequent lines 
to be indented. Begin typing. Each time you enter a carriage return, WordStar begins 
the next line at the column you chose. 
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To increase the amount of the indent, add blanks or tabs at the beginning of the line 
where you want the increased indent. To decrease indenting, erase blanks and tabs. 
WordStar indents the next line with exactly the same number of tabs and spaces as the 
previous line. 

To turn auto-indent off, press "6 again. 

For information on indenting the first line of every paragraph in a document, see 
Paragraph margins. 

B 
Background printing. See Printing a file. 

Backup files 
Each time you save a file, WordStar saves the previous version of the file as a backup 
and gives the backup filename a .BAK extension. 

TIP While you're working in a file, it's a good idea to periodically save the work 
you've done so far. Choose Save file, resume editing from the File pull-down, or press 
>oKS. If your working file is damaged, you can use the backup version. For important 
files, it's also a good idea to keep extra copies of your files on separate disks in case 
the original disk is lost or damaged. See Copying. 

Note: On some computers, you can have WordStar back up your file automatically 
every few minutes. Use WSCHANGE to choose this option. 

If you open a .BAK file, you'll be in Protected Mode. (The word Prtect appears in the 
status line.) You can view the file but not edit it. See Protecting a file. To edit a .BAK 
file, you must first rename it with a different extension. See Renaming a file. 

Bidirectional printing 
Many printers can print lines while the printing element is moving to the left. On some 
printers, you can turn bidirectional printing off to improve print quality, or on to speed 
up printing. 

The default setting for bidirectional print is on. You can turn bidirectional printing on 
or off using the .bp on and .bp off dot commands. 

TIP .bp 0 (zero) is the same as .bp off; .bp 1 (one) is the same as .bp on. 

You can change the default setting for each of your printers with PRCHANGE. 



BLOCK MATH 

Binding space 
The binding space command ("PO) keeps two words together on the same line. To in­
sert a binding space between two words in your text, press "PO between the words in­
stead of pressing the Spacebar. On the screen, the binding space is displayed as "0 
when display is on. You can insert binding spaces between a string of words to keep a 
phrase together on the same line. See also Aligning text. 

Blank lines 
To insert a blank line in your text, be sure that insert is on, move the cursor to column 
1, and press ~. The hard carriage return symbol ( < ) appears in the flag column, and 
the cursor goes to the beginning of the next line. You can also press "N to insert a 
blank line and leave the cursor at its original position. 

If the text is single-spaced, ~ inserts one blank line. If multispacing is turned on with 
"OS or .Is, ~ adds the appropriate number of lines, with the first one having a soft 
carriage return at the end; for example, if text is double-spaced, ~ inserts two blank 
lines. You can customize this feature with WSCHANGE to make ~ create one blank 
line in double-spaced text. See also Line spacing. 

Block math 
You can total the numbers in a marked block, even if the block has words in it. First 
mark the block. Then choose Block math (add numbers) from the Other pull-down, or 
press "KM. WordStar displays the total at the top of the screen. Press Esc to return to 
editing. 

~o insert the last math total in your document, press Esc and then = (or Esc $ for dol­
lar amounts). See also Shorthand. 

WordStar uses the following rules to determine whether digits it encounters in a 
marked block are part of a number: 

• A number is any set of digits (the characters 0-9). 

• A hyphen in front of a digit is considered a minus sign. 

• A period is considered a decimal point when the character immediately after it is a 
digit. 

• The letter "e" surrounded by digits is considered scientific notation (for example, 
"2e2S" means 2 x 1025). 

• The maximum number of digits in a number is 30. 

• A number within parentheses is considered negative. 

Numbers in dot command lines are ignored. 

Answers have a maximum precision of 12 digits. If the answer is longer, WordStar 
gives the closest answer it can, using scientific notation. 

See also Blocks and Column blocks. 
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Blocks 
A block is text that you mark so you can perform a task on it, such as delete, move, or 
copy it. It can be one character, a phrase, or pages long. You can also mark a column 
as a block. See Column blocks. The maximum block size depends on your computer. 

To create a block, mark its beginning by placing the cursor there and choosing Begin 
block. Then place the cursor at the end of the block and choose End block. These 
commands are on the Edit pull-down. The corresponding classic commands are .... KB 
(beginning) and "KK (end). 

TIP /t's a good idea to turn display on ("00) before you mark a block to see what 
commands you're including in the block. For example, if you mark boldfaced text, be 
sure to include both the beginning and end boldface commands. 

When you mark a block, the marker for whichever end you mark first appears. The 
marker <B> appears at the beginning of the block or <K> at the end. On most com­
puters, once you've marked both ends of the block, the marker disappears and the 
block is highlighted. The Band K flags appear in the flag columns of the lines con­
taining the beginning and end of the block. 

TIP If both markers appear in your text and the block isn't highlighted, you may not 
have marked the block correctly. Make sure the beginning marker precedes the end 
marker. If column mode is on, be sure the end marker is to the right of the beginning 
marker. See also Column blocks. 

Only one block at a time can be marked in each window. To move a marker (and 
change the beginning or end of the block), move the cursor to the new location and 
use the begin block or end block command again. 

To include the carriage return in the last line of a block, place the end marker at the 
beginning of the next line. 

To erase a marker, use the same marker command with the cursor immediately to the 
right of the marker. 

WordStar deletes block markers from a file when you exit it. 

TIP Operations with two or more small blocks can be faster than with one large 
block. The distance involved in block operations can also affect the speed of the oper­
ations. For example, when you need to move a block a distance of 25 pages, writing 
the block to a new file, then reading in the file at the new location may be faster than 
moving the block. 



BLOCKS 

Block commands 
The chart below shows the commands for manipulating blocks of text. 

COMMAND FUNCTION 

These commands are on the Edit pull-down or the Block & Save classic menu: 

"KB Marks the beginning of a block. 

"KK Marks the end of a block. 

"KH 

"KC 

"KV 
"KY 

"KW 

"KR 

"KN 

"KI 

Hides the block markers (and block highlighting) on the screen. 
Use "KH again to make them reappear. If you hide a block or a 
marker, and then mark a new block, WordStar displays the new 
block. At all help levels but 0, hiding the markers is also a safety 
measure. At these levels, WordStar won't move, copy, erase, or 
write blocks when the markers are hidden. 

Copies a block to the current cursor position in the same window. 

Moves a block to the current cursor position in the same window. 

Deletes a block. The cursor doesn't have to be anywhere near the 
block. After deleting, the cursor is positioned where the block used 
to be. You can restore an erased block using the undo command 
("U). See Undo and unerase. 
Stores (writes) the block on a new file on the disk, or appends the 
block to an existing file. If the file already exists, WordStar asks if 
you want the existing file to be replaced with the new block or if 
the block should be added to the end of the existing file. The orig­
inal block remains in your working file. 

Inserts (reads) a file into the document you're currently editing. 
This command is useful for inserting standard paragraphs, combin­
ing documents, or inserting spreadsheets. See Inserting text and 
files. 

You can also use "KR to insert a copy of the current file into itself. 
The inserted text is the original version of the document before you 
started editing, or the version you saved with the most recent save 
and continue command ("KS). 

Turns column mode on or off, allowing you to work with column 
blocks. See Column blocks. 
Turns column replace on or off, changing the way column blocks 
are handled. Column replace works only if column mode is on. 

99 



BOLDFACE 

COMMAND FUNCTION 

These commands are on the Window pull-down or the Block & Save classic menu: 

"KA 

"KG 

Copies a block from one window to the current cursor position in 
the other window. See Windows. 

Moves a block from one window to the current cursor position in 
the other wi ndow. 

This command is on the Other pull-down or the Block & Save classic menu: 

"KM Totals the numbers in the block and displays the result. You can 
then insert the result into the document by pressing Esc and 
then =. See Block math and Shorthand. 

These commands are on the Go To pull-down or the Quick classic menu: 

"QB 

"QK 

Moves cursor to the beginning of block. 

Moves cursor to the end of block. 

These commands are on the Block & Save classic menu: 

"KZ 

"K' 

"K" 

"K. 

"K? 

Sorts lines in the block alphabetically. See Sorting text. 

Converts all characters in the block to lowercase. See Case con­
version. 

Converts all characters in the block to uppercase. See Case con­
version. 

Converts the case in the block so the first letter of each sentence is 
uppercase and all other text is lowercase. See Case conversion. 

Displays the number of words and characters in a block. See Word 
count. 

See al so Block math and Column blocks. 

Boldface 
To boldface text (as in this example), place the cursor where you want the boldfacing 
to start and choose Bold from the Style pull-down, or press "PB. The symbol "B ap­
pears on your screen but is not counted as a character space in the status line. Any 
text after the "B is highlighted on the screen. 

To mark the end of the boldfacing, place the cursor where you want boldfacing to 
end, and use the boldface command again. The highlighting stops. The printer 
boldfaces the highlighted text. 

To delete boldfacing, place the cursor on the "B and press Del or "G. Be sure to 
remove both the beginning and end boldface markers. 
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CALCULATOR 

Note: With many proportional fonts, bold characters are larger than regular charac­
ters, so you may not get as many characters on a line. 

See also Double strike. 

c 
Calculator 
To use the onscreen calculator while you are editing, choose Calculator from the 
Other pull-down, or press "QM. WordStar displays the Math Menu. 

QM C: FILENAME. DOC P1 Ll C1 00" Insert 'AI ign RgtJust 

Type a Math equation. 

(none) 

+ add It Multiply 
- subtract I divide 
A exponentiate 

Press 11 for help. 

~ A T H ~ E " U 
Last result: tJ 

int integer 
In base e log 

log base 18 log 

ex, e x 
Sill' sq root 
atn arc tan 

sin sine 
cos cosine 
tan tangent 

Type the equation you want to solve and press ~. (Do not type an equal sign (=) at 
the end of the equation.) WordStar displays the answer. 

When you're done with the calculator, press "U (or press ~ again) and WdrdStar 
returns you to editing. 

At the Math Menu, you can use "R to reenter the previous equation. You can then edit 
the equation and recalculate it. 

The Math Menu provides all the usual mathematical operations: addition, subtraction, 
division, multiplication, and exponentiation. It also provides natural and common log­
arithms, square root, integer, and the trigonometric functions sine, cosine, tangent, 
and arctangent, which work with angles in degrees; for example, to find the sine of 45 
degrees, type sin(45). (Do not type a space before the parentheses.) 

Equations are normally evaluated from left to right, except that exponentiation takes 
precedence over multiplication and division, which take precedence over addition 
and subtraction. You can change the order in which WordStar performs operations by 
using parentheses ( ) to enclose operations that are to be done first. Be sure to use 
parentheses in pairs. For example: 

500*.001 *«(.001 + 1 )"180)/«(.001 + 1 )"180)-1» 
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CAPS LOCK KEY 

WordStar always performs the operation within the innermost set of parentheses first. 
WordStar uses its normal order of precedence when performing the operations within 
parentheses. You can nest up to 32 pairs of parentheses; however, the equation can 
become too complicated for WordStar before that level is reached. If an equation is 
too tompl icated, a message appears. 

You can use scientific notation to enter a long number. For example, 1.23e25 repre­
sents the number 12300000000000000000000000. Answers have a maximum pre­
cision of 12 digits. If an answer is longer, WordStar gives the closest answer it can, 
using scientific notation. The largest number WordStar can work with is 1 e63. The 
smallest number is 1e-63, which is written out as a decimal point followed by 62 
zeros, then a1. (WordStar uses 14-digit BCD floating-point math internally.) 

After you return to editing, you can enter the result of the last calculation (or the last 
equation itself) into your text at the cursor position with one of the three shorthand 
commands described below. 

COMMAND 

Esc = 
Es.c $ 

Esc # 

FUNCTION 

Enters the number result of the last calculation. 

Enters the number result formatted as a dollar amount; for exam­
ple, 12345 would change to 12,345.00. (You can us~ 
WSCHANGE to change the format of the number displayed for 
ESC $.) 

Enters the last equation. 

For information about performing calculations on merge-printed variables, see Merge 
printing. 

Canceling a command. See Undo and unerase. 

Caps Lock key 
Press the Caps Lock key to type text in capital letters. Press the key again to return to 
lowercase. The Caps Lock key affects only the alphabetical keys on the keyboard. It 
does not affect the number keys or symbol keys. 

Case conversion 
You can convert all the letters in a block to lowercase or all to uppercase, or you can 
convert all letters to lowercase except the first letter of every sentence. After you mark 
a block ("KB, "KK), press "K" to convert to all uppercase letters. To convert to lower­
case, press "K'. To convert to sentence case, press "K •. When you convert to sentence 
case, the fir~t letter following a p~riod, question mark, or exclamation point and a 
space is capitalized. All others, except the letter I when it appears by itself, are lower­
case. Do not hold down the Ctrl key when you press II or lor •• See also Blocks. 
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CHARACTER WIDTH 

Centering text 
To center a line of text, place the cursor anywhere on the line and choose Center line 
from the Layout pull-down, or press "OC. WordStar centers all the characters on the 
line between the current margin settings. Spaces before or after the text are ignored. 

If you add or delete characters on a centered line, use "~C again to center the edited 
line. 

If you later want a centered line to align on the left margin, move the cursor to column 1 
and press Del or "C. 

To center a group of lines, type .oc on on the line above the lines you want centered 
and .oc off on the line following the lines you want centered. To center existing text, 
place the cursor on the first I ine to be centered and use "8 or "QU after you enter the 
dot commands. Centered lines must end in a hard return. To delete centering, remove 
the dot commands and realign the text. 

You can also center data during merge printing by using a special formatting com­
mand. See Merge printing variable formatting. 

Chaining files. See Nesting and chaining. 

Character width 
Character width is the amount of horizontal space taken up by each character in a 
nonproportional font. In a proportional font, where characters take up different 
amounts of space, the character width is an average. 

The easiest way to change character width is to choose a font with the desired charac­
ter width. See Fonts. 

You can also use the .cw dot command. The .cw command measures character width 
in units of 11120 inch. For example, 121120 inch (10 characters per inch) is written as 
.cw 12. 

Character width has a direct effect on the number of characters you can fit on a line. 
The following table shows several settings for the .cw command, and the resulting 
number of characters per inch. 

DOT COMMAND 

.cw 6 

.cw 7.5 

.cw 10 

.cw 12 

.cw 15 

.cw 24 

CHARACTERS/INCH 

20 
16 
12 
10 

8 
5 

TIP You can use .cw to specify your two most frequently used fonts, then quickly 
change fonts using "PN and "PA. See also Fonts. 
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CLEARINC THE SCREEN 

If you're using a proportional font, changing the character width may cause WordStar 
to select a different font that more closely matches the new character width. 

Clearing the screen 
Although it happens rarely, electrical interference or a message from the operating sys­
tem can cause extra characters to be displayed on your screen. They're not actually in 
the file-they're only onscreen. To clear the screen and redisplay everything correctly, 
press "\. 

To clear the screen for printing messages, use the .cs dot command. For more informa­
tion, see Messages while printing. 

Color 
To print text in a different color (if you have a color printer), place the cursor where 
you want the new color to start and press "P-. You'll see the color currently in effect 
and a list of 16 standard colors. Move the highlighting to the color you want and press 
~. If display mode is on, a command tag stating the color (for example, <RED» 
appears on your screen. Text following the command tag prints in the new color until 
you change the color again. 

To remove the color, place the cursor on the command tag and press Del or "G. 

If your printer isn't capable of printing the color you choose, the tag will be ignored at 
print time. If you have a laser printer that can't print colors, the text prints in reverse or 
with different background patterns. See your printer manual for more information on 
the colors available on your printer. 

You can set the default color in WSCHANGE. 

If you have a color monitor, you can use WSCHANGE to change the colors of the 
WordStar menus and other items onscreen. 

Column blocks 
In column mode, you can perform block operations with column blocks, as opposed 
to regular blocks. When you mark a block with column mode on, the beginning and 
end block markers define the top left and bottom right corners of the block. 
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COLUMN BLOCKS 

You could use column mode, for example, to switch two columns of information in a 
table. 

TIP If your text contains print control characters (such as "'B for bold), turn on the 
display of print controls ("'DO) before marking the block to be sure you include the 
print controls in the block. (If the last character in a column block is a print control 
character, place the cursor directly after the control character before marking the end 
of the block.) Then turn off the display of print controls to make sure you have in­
cluded all the columns you intend. 

A dot command is not considered to be a part of a column block. If you move or de­
lete a column block, a dot command within the block remains at its original location. 

When working with column blocks, use the regular block commands for your block 
operations. 

e AUT ION When you insert a file ("'KR) in column mode, WordStar expects the 
file being read to be a column (that is, it inserts the file one line at a time, and it ex­
pects all the lines to be the same length). If a line in the block is not the same length as 
the previous lines, WordStar stops and warns you. 

When sorting a column block, WordStar uses the highlighted portion of each line to 
determine how to sort the entire line. See Sorting text. 

The commands used for column blocks (described below) are on the Edit pull-down. 

COMMAND 

"KN 

"KI 

FUNCTION 

Turns column mode on and off. If there are block markers in the 
text, the display changes to show the new mode. When column 
mode is on, the word Column appears in the status line. 

Turns column replace on and off. Column replace is effective only 
when column mode is on. When column replace is on, ColRepl 
appears in the status line, and a moved, copied, or inserted block 
replaces any text at the cursor. If a block is moved or deleted, 
spaces replace the block at its original location, leaving a "hole." 
If column replace is off, a moved, copied, or inserted block pushes 
over any text at its new location. For a moved or deleted block, 
surrounding text fills in the space that was originally occupied by 
the block. 

When column replace is on, you can use the undo command (AU) to restore any text 
that was replaced by the block most recently moved, copied, or inserted. For exam­
ple, you can use "U if you moved a column and intended to insert it, but forgot that 
column replace was on. 

e AUT ION When you delete text that's too long to fit in the undo buffer, WordStar 
usually displays a warning message and gives you a chance to cancel the command. If 
a block that is erased during a column replace operation is too long, no message ap­
pears and you can lose text. See also Undo and unerase. 
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COLUMNS 

Columns 
You can use two types of columns, tabbed columns (good for charts and tables) and 
newspaper-style columns (good for newsletters). 

Tabbed columns 
Use tabbed columns to type charts or tables. First set tab stops where each column of 
text is to begin. If you're typing columns of numbers, you probably want to set deci­
mal tabs for each column. Decimal tabs align all the numbers by their decimal points. 

TIP If you type the same type of chart often, you can set up a customized ruler line 
that automatically sets tabs for the chart. See Ruler lines. 

Use either "I or the Tab key to move the cursor to the beginning of each column and 
type the text for that line. You may want to turn word wrap off (.aw off) when you type 
a chart so text doesn't accidentally wrap to the next line. 

TIP When you proofread columns, it helps to turn off the display of print control 
characters ("00) so you can see how your text will line up. 

Newspaper-style columns 
Newspaper-style columns are used for newsletters. To turn on newspaper-style col­
umns, type .co and a number from 1 to 8 to specify how many columns you want. You 
can also add a comma and the amount of space you want between columns. For 
example, .co4,2 gives you four columns of text with two tenths of an inch between 
them. You can specify this space in columns (2) or inches (.2"). 

Each column is as wide as the current ruler line and uses the margin and tab settings 
in effect when you enter the column command. 

When you fill the first column on a page with text, WordStar enters a column break 
and wraps text to the next column. The column break appears onscreen as a dashed 
line with a C in the flag column. To show what column you're in, one arrow appears 
at the beginning of each line in column 1, two arrows in column 2, and so on. When 
you fill the last column on a page, WordStar starts a new page. 
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COMMAND FILES 

one column ...... 

..-- two columns 

TIP The columns do not appear next to each other onscreen. To see how they will 
look when printed, use the page preview feature (if you have a graphics monitor). For 
information, see Page preview. 

If you edit your document, column breaks adjust as necessary. If you want to keep a 
number of lines together in the same column, for example, a holiday schedule, use a 
conditional column break. Type the dot command .cc directly above the lines you 
want kept together, then type the number of I ines. For example, .cc4 keeps the next 
four lines together in the same column. 

To start a new column before the end of the page, type the dot command .cb. If you 
type .cb in the last column on a page, WordStar starts a new page. This kind of col­
umn break does not move when you make changes in your document. 

To turn off newspaper-style columns and begin regular page layout, type the dot com­
mand .col or .co at the top of the next page. 

To change existing newspaper-style columns to regular page layout, remove the .co 
command and any .cb and .cc commands you might have entered, and realign the 
text. 

If you use newspaper-style columns, any footnotes within the columns will become 
endnotes. 

See also Column blocks, Decimal tabs, and Tabs. 

Command files 
Command files contain only dot commands and no text; they can be very useful for 
merge printing and for chaining files. Command files often contain merge print dot com­
mands, commands that display messages while you print (.dm), and the.fi (insert a file) 
command. 
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COMMENT LINES 

The example below is a sample command file for chain printing several files and dis­
playing messages as you print . 

. fi cover. let 

.dm The letter is printed ... 
• fi proposal.doc 
.dm The proposal is printed ... 
.fi spec.doc 
.dm The specification is printed. Printing is finished. 

If any of the inserted files contain merge printing variables, be sure to use merge print 
to print the command file. The actual command file is' not printed because it has noth­
ing in it but dot commands. 

See also Dot commands, Merge printing, Messages while printing, and Nesting and 
chaining. 

Comment lines 
You can enter comments and instructions that appear on the screen but are not print­
ed. Unprinted comments are useful for reminders about what print wheel to put in the 
printer, when the document was created, who processed it, and what page formatting 
commands were used, as well as questions for reviewers. 

To insert a comment in your text, place the cursor where you want the comment to 
begin and press "ONe. Type the comment in the new window at the bottom of the 
screen. When you finish typing the comment, choose Close and save window from 
the Window pull-down, or press "KD. The window disappears. When display ("00) is 
on, the first few words of the comment appear in a tag onscreen to remind you of its 
contents. If display is off, the tag does not appear. ' 

To view or edit the contents of a comment, turn display on, move the cursor to the 
comment tag in your text, and press "OND. 

TIP Any comment entered with "ONe can be converted to a footnote, endnote, or 
annotation. For more information, see Footnotes and endnotes. 

If you want to enter short comments that appear onscreen even when display is off, 
type the dot comman'd •• (or .ig) followed by the text of the comment. Word wrap 
doesn't affect dot commands, so you can make the lineas long as you want. See also 
Dot commands. 

Control key 
The key labeled Ctrl on your keyboard is used with other keys to form WordStar com­
mands. On menus and in documentation, the control key is shown by the caret 
symbol ("). To issue a control command, hold down the (:trl key while you press the 
letters of the commands. ' 
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CREATING A DOCUMENT OR NON DOCUMENT 

Copying 
You can copy blocks of text and files. Copying makes an exact duplicate of whatever is 
being copied; the original is preserved, not erased. 

Copying a file 
To copy a file, choose Copy a file from the File pull-down (Opening or Edit screen). 
The classic commands are 0 at the Opening Menu or AKO while you're editing. Type 
the name of the file to be copied and press ~. Type the name of the file to copy to 
and press ~. 

Unless you specify otherwise, WordStar assumes the file you name to be copied is on 
the current drive and directory. You can copy a file that is on another drive or direc­
tory by typing the path with the filename. You can also put the copy on another drive 
or directory by typing the path with the filename. 

You can use the same filename if you copy from one drive or directory to another. But 
you cannot have two files with the same name in the same directory. 

If the filename you give for the new copy already exists, WordStar asks if you want to 
replace the old file with the new copy. If you answer Y, WordStar deletes the old file 
and replaces it with the new file. If you answer N, WordStar does not copy the file. 
You can start again and use a different filename. 

Copying text 
To copy text, first mark the text as a block. Then use one of these commands: 

• To copy the block within a document, choose Copy block from the Edit pull-down, 
or press AKC. 

• To copy a block from a window, choose Copy block from other window from the 
Window pull-down, or press AKA. 

• To copy a block from a document into a new file or to append the block to an 
existing file, choose Write block to file from the Edit pull-down, or press "KW. 

• To copy an entire file into the current document, choose Insert a file from the Edit 
pull-down, or press "KR. 

See also Blocks, Windows, and Inserting text and files. 

Creating a document or nondocument 
To create a document, choose Open a document file or Speed Write from the File 
pull-down (Opening screen). The classic commands are D or S at the Classic Opening 
Menu. If you choose Open a document file (D), you name the file before you open it; 
if you choose Speed Write (S), you name the file when you save it. See also Speed 
Write. 
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CURSOR 

To create a nondocument (a program or data file), choose Open a nondocument file 
from the File pull-down or press N at the classic Opening Menu. (To have Speed Write 
(S) open a nondocument file, use WSCHANGE to make nondocument the default file 
format.) 

The following explanation applies to both documents and nondocuments. 

At help level 2 or above, when you give a name for the file that's not in the current 
directory, WordStar asks, Create a new one? WordStar doesn't assume you want to 
create a new document, since there's a chance you mistyped the name of an existing 
one or the file is on a disk or in a directory other than the one you specified. (At help 
level a or 1, WordStar opens a new document without asking.) 

When you open a new file, it's blank. You can begin typing or insert other files. 

You can also open a file without going through the Opening screen. When you start 
WordStar, name the file at the operating system prompt as shown in the example 
below. . 

A>ws first.doc 

If necessary, include a drive letter or directory path: 

A>ws c:\ws5\leUers\first.doc 

Files you open from the operating system prompt are always documents. To open a file 
in nondocument mode, type an n after the filename: 

A>ws first.doc n 

To change the default file format to nondocument, use WSCHANGE. 

See also Documents and nondocuments and Starting WordStar. 

Cursor 
The cursor is a small blinking rectangle or line on the screen that marks your place. 
Whatever you type appears where the cursor is. 

TIP Some monitors have difficulty displaying some cursor shapes. To change the 
shape of the cursor, use the WSCHANGE program. 

Cursor diamond 
You can move the cursor in your document without moving your fingers from the 
home keys on your keyboard. 
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CURSOR MOVEMENT KEYS 

The four basic keys that are used with the Ctrl key as commands to move the cursor 
up one line ("E), left one character ("S), right one character ("D), and down one line 
("X) form a diamond on the keyboard. The keys used with the Ctrl key as extended 
movement commands radiate out from the center of the diamond. 

See also Cursor movement keys and Cursor movement and scrolling. 

Cursor movement keys 
The cursor movement keys are used to move the cursor. Depending on your key­
board, they may be located on the numeric keypad or at another location on the 
keyboard. 

TIP If the cursor movement keys on the numeric keypad don't work, press the Num 
Lock key. The Num Lock key switches between the cursor movement commands and 
the numbers on the keys. 

Most of the cursor movement keys work one way when pressed alone and another 
way when pressed together with the Ctrl key. Each cursor movement key command 
can also be entered using the cursor control commands on the cursor diamond. The 
chart below shows all the cursor movement key commands, their functions, and the 
corresponding cursor control commands. 
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CURSOR MOVEMENT AND SCROLLING 

CURSOR MOVEMENT WHERE THE CURSOR 
KEY 

Home 

"Home 

t 
PgUp 

"PgUp 

"+-

"---+ 

End 

"End 

~ 

PgDn 

"PgDn 

MOVES 

column 1 in first onscreen line 

beginning of file 

up one line 

previous screen 

scroll up 

left one character 

left one word 

right one character 

right one word 

left end of last onscreen line 

end of file 

down one line 

next screen 

scroll down 

See also Cursor diamond and Cursor movement and scrolling. 

Cursor movement and scrolling 

COMMAND 

"QE 

"QR (also on the 
Go To 
pull-down) 

"E 
"R 
"W 
"S 
"A 
"0 
"F 
"QX 
"QC (also on the 

Go To 
pull-down) 

"X 
"C 
"Z 

When you're editing, you can use the cursor movement keys and the cursor control 
commands to move the cursor and to scroll the text. Scrolling allows you to move 
another portion of text onto the screen, either vertically or horizontally. The cursor 
commands move the cursor across text. Moving the cursor does not change the text in 
any way. 

The cursor cannot move into parts of the screen where you haven't already typed a 
character (a blank space you enter with the Spacebar is considered a character). For 
example, if the cursor is at the end of a line of text, and you use "X to move the cursor 
down, it usually doesn't go straight down. Instead, it moves to the end of text on the 
lower line. 

You can use the cursor control commands combined with "Q for quick movement and 
scrolling. 
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CURSOR MOVEMENT AND SCROLLING 

The chart below describes all commands ,used for cursor movement and scrolling, 
including the AQ quick movement commands. 

TO MOVE 

~ 
one line 

to col. 1 in first onscreen line 

one line (scroll up) 

line by line to beginning of file 

to previous screen 

directly to beginning of file 

screen by screen to beginning of file 

Left: 
one character 

one word 

to column 1 of current line 

Right: 
one character 

one word 

to end of current line 

Down: 
one line 

to last onscreen line 

one line (scroll down) 

line by line to end of file 

to next screen 

directly to end of file 

screen by screen to end of file 

Other: 
to marker (previously set) 

to beginning of marked block 

to end of marked block 

to page or line (number) 

to next page 

to previous page 

to previous position 

PRESS 

"E or t 

"QE or Home 

"Wor"PgUp 

"QW (0-9 for speed) 

"R or PgUp 

"QR or "Home (also on the Go To pu II-down) 

"QQ"R (0-9 for speed) 

"S or­

"Aor"-

"QS (also on the Go To pull-down) 

"Dor-

"F or"-

"QD (also on the Go To pull-down) 

AX or ! 

"QX or End 

"Z or "PgDn 

"QZ (0-9 for speed) 

"C or PgDn 

"QC or "End (also on the Go To pull-down) 

"QQ"C (0-9 for speed) 

"QO-9 

"QB (also on the Go To pull-down) 

"QK (also on the Go To pull-down) 

"Qln (also on the Go To pull-down 

"QI+ ~ 
"QI- ~ 

"QP 
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CUSTOM PRINT CONTROLS 

TO MOVE 

Other: continued 

to last block location or find string 

to specified letter (forward) 

to specified word or phrase 

to paragraph end 

to specified letter (backward) 

to next font change 

to next note 

to other wi ndow 

PRESS 

"QV 

"QGx 
"QF word or phrase (also on the Go To pull-down) 

"QG ~ (also on the Go To pull-down) 

"QHx 

"Q= (also on the Go To pull-down) 

"ONG 

"OK (also on the Window pull-down) 

Note: To move the cursor forward or back a specified number of pages, press "QI + n 
or "QI-n. For example, "QI +6 moves the cursor forward six pages. 

See also Scrolling and Finding and replacing. 

Custom print controls 
The custom print controls let you take advantage of your printer's special features. For 
example, you can use the custom print controls to get double-width printing or to 
change the font socket on your printer. Once you define them, "PQ, "PW, "PE, and 
"PR add the specified command to your document whenever you use them. You 
define "P! each time you use it. 

Before you use the custom print controls, you need to define them. (For some printers, 
the print controls are already set up for features on your printer. Refer to the informa­
tion screen when you install your printer to see how these commands are set up for 
your printer.) 

To define a custom print control, you tell WordStar the printer code for the special fea­
ture you want the command to enter in your text. You can define the custom print 
controls two ways: by using PRCHANGE or by using dot commands in your docu­
ment. When you use PRCHANGE, you can customize the controls for each of your 
printers. When you use dot commands, they override PRCHANGE for that document 
only. 

The dot commands.xq, .XW, .xe, and .xr each define the corresponding "P custom 
print control command. For example, the .xq dot command defines the "PQ print con­
trol command. 

Each custom print control dot command can be followed by up to 24 hexadecimal 
character codes. 
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CUSTOMIZING WORDSTAR 

For example, if you want APQ to turn on double-width printing on an Epson printer 
(look in the printer manual to find out what the printer codes are for your printer), you 
would type: 

.xq 1 B OE 

When you press APQ below this dot command in your file, "Q appears on your screen 
and WordStar inserts the Epson code for double-width printing at print time. 

If you type a dot command without hex codes, the corresponding print control is dis­
abled. 

You can redefine the print controls as many times as you wish in a document. If you 
print a document that doesn't have dot commands redefining the custom print con­
trols, WordStar uses the customizations from PRCHANGE if there are any. 

TIP If you want the custom print controls to issue codes that are more than 24 hex­
adecimal characters long, you can use PRCHANGE to type a longer code. 

"P! is useful for codes you use only once in a document, such as a special print com­
mand. Each time you press "P!, you are prompted for the print code. To include a con­
trol character, type a caret (A) before the character. To include a caret, type %A. To 
include a percent sign, type %%. To include an escape, type A[. 

To use the hexadecimal code for the characters, type %x before the hex code. For 
example, to type the hex code FB, type %xfb. 

When you use any of the custom print controls, keep these points in mind: 

• Control codes for different brands and models of printers are usually different. Cus­
tom print controls that work on one printer may not work properly on another. 

• Don't use the custom print controls for standard print features like boldface and 
underscore. 

" There may be interactions between the print controls you are using and the printer 
description file (PDF). In fact, the PDF may inadvertently cancel your print control. 
If you need more control over your printer than the custom print controls allow, 
you can experiment with the CUSTOM and SIMPLE PDFs. 

See also Dot commands, Printer description files, and Appendix C, "Customizing 
WordStar."· . 

Customizing WordS tar 
WordStar has two programs that let you easily customize how WordStar works: 
WSCHANGE and PRCHANGE. 

Use WSCHANGE to tell WordStar about your computer or to change the default set­
tings; for example, you might want to change WordStar so that justification is normally 
off instead of on, or you might want to change the default left or right margin. The 
menus in WSCHANGE allow you to change a number of settings easily. 
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DATA FILES 

WSCHANGE has a feature called the auto-patcher that lets you save all or any portion 
of the settings you've customized so that you can easily transfer them to a fresh copy 
of WordStar. If you make extensive customizations, it can be very convenient to use 
the auto-patcher so that you don't have to reenter all of your changes in WSCHANGE. 

Use PRCHANGE to customize how WordStar works with your printer and to change 
the default printer settings; for example, you can specify a different port for each 
printer or turn form feeds on for a laser printer. 

For information on using WSCHANGE and PRCHANGE, see Appendix C, "Customiz­
ing WordStar." 

D 
Data files 
A data file is a nondocument file that holds information to be merged into a document 
using merge printing. For example, you can merge data from a mailing list into a form 
letter. 

A data file consists of a series of records. Each record consists of several fields, or 
items of information. For example, a mailing list has one record for each person, and 
each record has a field for name, a field for address, and fields for city, state, and ZIP 
code. 

You can create your own data files, or you can use data files from dBASE, Lotus 1-2-3, 
Symphony, or MaiILisCM

• For information on creating your own data files, see the sec-
tion below. For information on LJsing other data files, see Merge printing. . 

Creating data files 
To create a data file, choose Open a nondocument file from the Opening screen File 
pull-down, or press N at the classic Opening Menu. Then type your information. 

Make sure that the fields are in the same order in all records. Separate fields with com­
mas or carriage returns. If a field contains a comma, enclose the entire field in quot~­
tion marks. If a field is empty (you have no information for it in this record), indicate 
the blank field with a comma. You can enter blank spaces at the beginning and end of 
any fields if you want; they will be ignored when you use the data file for merge print-
ing. Do not use dot commands in a data file. . 

C AUT ION The rules above are very important. If you enter any records incor­
rectly, you will not be able to merge print correctly. 
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DECIMAL TABS 

The example below shows a data file with three records. Each record has seven fields: 
last name, first name, first address line, second address line, city, state, and ZIP code. 
Note that in the first and second records, the blank second address line is shown with 
commas, and in the second record, the first name field is enclosed in quotation marks 
because it contains commas. 

Weiss, Steven, 702 Rosemund Place, , Sebastopol, CA, 95472 
Praskin, "Alan, Laurie, & Elena", 25 Oak St., , Salem, MA, 01976 
Jaffe, Joe, 1120 25th Ave., Suite 155, San Diego, CA, 90010 

If a field contains both a comma and quotation marks, you can use apostrophes to 
enclose the field. For example: 

'John "Bud" Moore, Jr.' 

You can select another character, such as the asterisk (*), to use instead of the comma 
as the data separator character. Use WSCHANGE to change the default data separator 
for all data files. You cari also use the .df command. Before you use .df, create the 
data file using the data separator character you want. Then use .df in the document file 
you are using with the data file for merge printing. Normally .df is followed by the file­
name. If the file uses a different data separator than the default, follow the filename 
with acomma and the data separator character. In the example below, the data file 
MAILlNG.LST uses the / character as the data separator . 

. df MAILlNG.LST, / 

The rules given above for commas apply to any data separator character. 

See also Merge printing. 

Decimal tabs 
A decimal tab stop allows you to vertically align the decimal points in a column of 
numbers. The example below shows a column aligned using a decimal tab. 

1234.56 
$432,697 

.99 
1.414679 

3,419,733.00 

TIP You can also use decimal tabs to right-align columns of one word per line. The 
column aligns on the first space after the word. 

To set a decimal tab stop, choose Margins and tabs from the Layout pu II-down and 
move the cursor to the Tabs field, or press "01. To specify a decimal tab, type # 
before the tab location. For example, #3 sets a decimal tab at 3 inches. 

When you type new tab settings, the previous tabs are erased. To restore the existing 
tabs to the Tabs field, press "R. To clear all tabs, type 0 as the new tab setting. 

You can also set a decimal tab by typing a # in a .rr ruler line or before a column 
number in a .tb command. 
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DEFAULTS 

When you uSe "I or Tab to move the cursor to a decimal tab stop, the word Decimal 
appears in the status line. Each number (or other character) that you type is inserted to 
the left of the c!Jrsor until you type a decimal point or press the Spacebar. If no space 
remains to the left of the cursor, the decimal tab function is turned off. When you type 
a decimal point, Decimal disappears from the status line, and characters you type are 
added to the screen as they normally are. 

See also Ruler lines and Tabs. 

Defaults 
Almost every option in WordStar has a preset, or default, setting. You can leave the 
settings as they are, change them for the file you're working in, or change them per­
manently. 

To change settings within a document, use control commands or dot commands. For 
example, the default setting for justification is on. You can use .oj off to turn justifica­
tion off for the current document. 

You can use WSCHANGE to permanently change the default settings for many op­
tions. 

Delays 
In WordStar, a delay is a pause before an instruction is executed. WordStar uses delays 
for your convenience. For example, you may notice a one-second delay between 
pressing "P and the appearance of the classic Print Menu. This delay allows you to 
press the other key in the command, so WordStar can perform the command without 
displaying the menu. And, as you edit existing text, you notice a delay before the 
paragraph realigns. 

You can change the length of the delays with WSCHANGE. Note that setting the 
delays to zero slows down WordStar because all menus will be displayed no matter 
how fast you type. 

Delete key 
The Delete key is marked Del on most keyboards. Press Del to delete the character at 
the cursor position. Hold down Del if you want to delete multiple characters. 

After you delete characters to the end of a line, pressing Del deletes the carriage re­
turn. The next line jumps up to the cursor, and you continue to delete the characters in 
the new line. 
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DELETING TEXT 

Deleting text 
The chart below shows the commands for deleting text. 

TO DELETE 

character, space, or 
print control at cursor 

previous character, 
space, or print control 

word 

carriage return 

line, blank line, or 
dot command line 

line right of cursor 

line left of cursor 

from cursor to specific 
character 

sentence 

paragraph 

page or text block 

file 

footnote 

FOLLOW THESE INSTRUCTIONS 

Press "G or Del. 

Press "H or Backspace. 

Place cursor on first character to delete and choose Delete 
word from the Edit pull-down, or press "T. 

Place cursor at end of line and choose Delete word from 
the Edit pull-down, or press "G, Del, or "T. 

To change a hard return to a soft return, press "6 (using the 
6 at the top of the keyboard and not the 6 on the numeric 
keypad). 

Choose Delete line from the Edit pull-down, or press "Y. 

Press "QY. 

Press "Q Del. 

Press "QT and type the character. 

Press "QT and type a period. 

Press "QT and press ~. 

Mark beginning ("KB) and end ("KK) of block, then choose 
Delete block from the Edit pull-down, or press "KY. 

Choose Delete a file from the File pull-down, or press Y at 
the classic Opening Menu or "KJ whi Ie editing. 

Place cursor on tag and press Del or "G. 

Note: If you want the Del key to delete the previous character, as it does in older versions 
of Word Star, you can change its function using WSCHANGE. You can also change the 
Backspace key to move left without deleti ng. 

When you delete a file, you can use the * wild-card character to delete several files at 
once. For example, if you type *.BAK at the prompt, WordStar erases all backup files. 
You can also use the? wild-card character unless you have DOS 2.1, which doesn't 
recognize it. 

TIP Choose Undo from the Edit pull-down or press AU to restore the last text deleted 
(except for single characters and files). See Undo and unerase. 
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DIALOG BOXES 

Dialog boxes 
Dialog boxes appear onscreen when you have choices to make. Each dialog box con­
tains one or more fields where you can enter information. For example, if you change 
the font in your document, the Font dialog box shows you the current font and a list of 
the fonts available on your printer. You choose the new font you want. 

If a dialog box has more than one field, you can use Tab and Shift-Tab to move for­
ward and backward among the fields, or use the arrow keys. 

If a field offers choices from a directory, such as choosing a filename, use the arrow keys 
to move the highlighting to the name you want from the directory, then press ~ to move 
the highlighted name to the field. 

To accept the current answers in a dialog box, press FlOor "K. If the cursor is in the 
last field on the screen, you can press ~ to accept all the answers. 

To abandon any changes and keep the original settings, press F2 or"U. 

Directories 
A DOS directory is an area of a disk that you can create for storing files. When you 
first install WordStar, you create a directory (usually WS5) on your hard disk to store 
your WordStar files. 

The directory display is a list of the files and subdirectories on a disk or in a directory. 
At the WordStar Opening screen, the directory display shows the files and subdirec­
tories on the logged drive or directory in alphabetical order. To the right of each file­
name is the number of kilobytes the file takes up. Subdirectories are displayed above 
the filenames. To the right of each subdirectory is a backslash (\). If there are more 
files and subdirectories than can be displayed at one time, you can scroll the list using 
"Wand "Z. 

If you have more files than WordStar's directory storage area can hold (370), three dots 
( ••• ) appear as the last item in the directory display; 

Sorting the filenames in alphabetical order can take several seconds in a large direc­
tory. If you like, you can use WSCHANGE to permanently turn the sorting off. 

Some files shouldn't be edited with a word processing program. These include com­
mand files (with the .COM or .EXE extension), program overlay files (.OVR), and tem­
porary files ($?$, where? can be any character). WordStar does not list files with these 
extensions in its directory display even though the files are on the disk. You can 
change the filename extensions to be excluded using WSCHANGE. 

You can p~ess F at the classic Opening Menu to turn the directory display on and off. 
You can also use WSCHANGE to change the default setting for directory display to off. 
When you turn the display on, WordStar asks for a file specification for the directory 
display. You can use a wild-card file specification to display only certain filenames. 
For example, X*.LTR displays only filenames that begin with X and have the .LTR 
extension. 
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If you are editing and want to see the directory display, press the command to copy or 
rename a file. When you are finished looking at the filenames, cancel the command. 

If you change the logged drive or directory ("KL), the directory display changes to 
show the files on the new logged drive and directory. 

See also Logged drive and directory and Paths. 

Displaying print codes 
Print control characters show you which commands are in effect in your document. 
However, they take up space onscreen and may make text appear out of line. You can 
remove these codes from the screen while you edit. (Note that the commands remain 
in effect even when the codes aren't displayed.) 

To remove print controls from the display, choose Hide/display controls from the Style 
pull-down, or press "00. Use the command again to redisplay the print controls. You 
can edit text with the display on or off. 

Documents and nondocuments 
Document files are usually text files, such as letters, memos, reports, or chapters in a 
book. Nondocument files are ASCII files, such as data files or computer programs. 

When you work with documents, you can use all of WordStar's word processing capa­
bilities, such as aligning, word wrap, and justification. With nondocuments, you can­
not use many of these word processing features. 

You open a document or nondocument from the File pull-down at the Opening 
screen. The classic commands are 0 for a document and N for a nondocument at 
the Opening Menu. 

To choose a filename, use the cursor movement keys to move the highlighting to the 
filename and press ~. You can also type the filename. If the file is on a different drive 
or directory, be sure to type the complete path and filename. 

To go directly to a new document file without specifying a filename, choose Speed 
Write from the File pull-down, or'press S at the classic Opening Menu. You'll be 
prompted to name the file when you save it. For more information, see Speed Write. 

riP To go directly to a specific file when you start WordSta" type the filename on the 
command line. For example, type ws \wsS\status.jan to go directly to the STATUS.JAN 
file. For a list of options you can specify on the command line, see Starting WordStar. 

Before editing a document in nondocument mode, you should convert the file to an 
ASCII file. Before editing a nondocument in document mode, you should change the 
hard carriage returns to soft returns. For more information, see ASCII. 

The differences between documents and nondocuments are described below. 
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Menus Documents have the complete menus; nondocuments have abridged menus. 
In a nondocument, the "0 command sets tab width rather than starting the onscreen 
format commands, and the "6 command turns auto-indent on and off rather than 
changing hard carriage returns to soft returns. 

Formatting The following functions are not available for nondocuments: centering, 
automatic hyphenation, justification, line spacing, margins, ruler line, soft hyphen, 
and word wrap. 

Tab Stops Document tab stops are initially set every half inch, but you can reset 
them anywhere on the ruler line. Tabs in nondocuments usually use a special tab 
character and are customarily set every 8 spaces; you can use "0 to reset them only to 
a binary multiple, such as 1,2,4, or 16 spaces. You can also use WSCHANGE to set 
nondocument mode to use regular tab stops. 

Cursor Indicator In documents, the indicator on the status line shows page, line, and 
column. In nondocuments, the indicator shows only line and column. 

Dot Commands WordStar checks dot commands in documents and changes the 
screen display accordingly. WordStar does not check dot commands in nondocuments. 

Embedded Information If you open a document file as a nondocument, you will see 
printing-related information embedded in codes throughout the document. 

Find The Go to page command on the Go To pull-down ("QI) finds a page number 
in documents; it finds a line number in nondocuments. 

Note: WordStar marks the end of a file with a "Z code. If you're creating nondocu­
ments for use with a program that doesn't accept the "Z code, use WSCHANGE to tell 
WordStar not to add this code. 

Dot commands 
Dot commands perform a variety of functions, mostly related to formatting. They are 
also used for merge printing, indexing, and creating tables of contents. You can enter 
a dot command on any line in a document. Type a period (dot) in column 1 and fol­
low it with the command code and any other information that goes with it. (WordStar 
doesn't distinguish between uppercase and lowercase letters in dot commands.) 
Press ~ to end the line. The line remains in your file but does not appear in the 
printout. 

Note: Some dialog boxes and control commands automatically add the correct dot 
command to your file. 

TIP To have the dot commands in your file appear in the printout, print the file as a 
nondocument. See Printing a file. 

C AUT ION A dot command must start in column 1, and the line above it should 
end in a hard return. 
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When you type a period in column 1, a question mark appears in the flag column. 
This is replaced by a colon, a period, or a 1 as soon as you type the second letter of 
the command. If you mistakenly type an invalid dot command, the question mark 
stays, but the line still isn't printed. 

TIP Sometimes a period within your text falls in column 1. This may happen when 
you use ellipses or decimals. WordStar interprets the line as a dot command and does 
not print it, unless you precede the period with two print control commands that can­
cel each other out, such as "PH "PH for beginning and ending boldface. The print 
control commands do not affect the printed page, and the period prints in column 1. 

For dot commands that require additional information, you can put a space between 
the command code and the other information, but it isn't required. If you don't enter a 
number where a number is required, zero is used. Where on or off is required, you 
can also use 1 for on and 0 for off. 

In a header or footer line, if you put more than one space between the dot command 
and the text, the extra spaces will appear in the header or footer. 

"Applications" and the lessons in the "Training Guide" give examples of how dot 
commands work. 

Note: Dot commands are not included as part of a column block. 

The lists below show each dot command with the type of additional information 
required (if any), a brief description of the command's function, and the heading 
where you can find more detailed information. The commands are grouped by 
function. 

Print formatting dot commands 

These dot commands affect the printout but have no effect onscreen. WordStar flags 
these commands with a colon (:) in the flag column. 

COMMAND 

.bn 

. bp 

.cv 

ADDITIONAL 

INFORMATION 

number 

on/off 

x>x 

FUNCTION 

Selects a sheet feeder bin number, 1 
through 4. See Sheet feeders . 

Turns bidirectional print on and off. 
See Bidirectional printing. 

Converts notes of one type to another 
at print time. See Footnotes and 
endnotes. 
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.fo text Gives the text for the first line of a 
footer. Type an 0 or an e after the dot 
command to specify separate footers 
or odd and even pages. See Headers 
and footers . 

.fl text Same as .fo. 

.f2 text Gives the text for the second line of a 
footer. See Headers and footers. 

.f3 text Gives the text for the third line of a 
footer. See Headers and footers . 

. fi filename Inserts the named file while printing. 
See Nesting and chaining. 

.fm number Sets a footer margin. See Headers and 
footers. 

.he text Gives the text for the first line of a 
header. Type an 0 or an e after the dot 
command to specify separate headers 
for odd and even pages. See Headers 
and footers. 

. hl text Same as .he . 

.h2 text Gives the text for the second line of a 
header. See Headers and footers. 

.h3 text Gives the text for the third line of a 
header. See Headers and footers. 

.hm number Sets a header margin. See Headers 
and footers. 

.1# style spacing, Turns line numbering on and off and 
column can specify whether numbers are con-

tinous or restart on each page, 
whether numbers are single or double 
spaced, and where numbers print. 
Type .1#0 to turn line numbering off. 
See Line numbering. 

.op Turns off page number printing. See 
Page numbering. 

.pe number Specifies where to print page num-
bers. Type 0 to center page numbers. 
See Page numbering. 

.pe Specifies the location to pri nt end-
notes. See Footnotes and endnotes. 

.pg Turns on page number printing when it 
was turned off. See Page numbering. 
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.pn number 

.po number 

.rp number 

.sr number 

.uj on/off/dis 

.ul on/off 

.xe text 

. xl text 

.xq text 

.xr text 

.xw text 

.xx character 

Onscreen formatting dot commands 

DOT COMMANDS 

Changes the page numbering, using 
the specified number for the current 
page. See Page numbering. 
Sets the page offset from the left edge 
of the paper. Type an 0 or an e after 
the dot command to specify separate 
page offsets for odd and even pages. 
See Margins. 
Prints the file the specified number of 
times. 

Sets a subscript/superscript roll in 
48ths of an inch. See Subscript and 
superscript. 
Turns microjustification on and off or 
leaves it to the discretion of the 
pri nter. See Microjustification. 
Turns underlining of spaces on and off. 
See Underlining. 
Defines the custom print control 
turned on and off with "PE. See Cus­
tom print controls . 
Defines the form feed string. See 
Form feeds. 
Defines the custom print control 
turned on and off with "PQ. See Cus­
tom print controls. 
Defines the custom print control 
turned on and off with "PR. See Cus­
tom print controls. 
Defines the custom print control 
turned on and off with "PW. See Cus­
tom print controls. 
Redefines the strikeout character. See 
Strikeout. 

These dot commands affect both the onscreen display and the printout. WordStar flags 
these commands with either a period or a 1. The 1 means the dot command is most 
effective if it's placed at the top of the page. 
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ADDITIONAL 

COMMAND INFORMATION FUNCTION 

text Enters a comment line. See Comment 
lines. 

.aw on/off Turns word wrap and aligning on and 
off. See Aligning text and Word wrap . 

• cb Inserts a column break. Text after the 
column break will print in the next 
column. See Columns. 

.cc number Sets a conditional column break, 
which keeps the specified number of 
lines in the same column. See Col-
umns. 

.co number, spacing Turns on multiple columns with the 
specified number of columns. You can 
also specify the spacing between col-
umns. See Columns. 

.cp number Sets a conditional page break, which 
keeps the specified number of lines on 
the same page. See Page breaks. 

.cw number Sets character width, in 120ths of an 
inch. See Character width. 

.e# value Sets the starting value for endnotes. 
Values can be numbers, letters, or 
symbols. See Footnotes and endnotes . 

. f# value Sets the starting value for footnotes. 
Values can be numbers, letters, or 
symbols. See Footnotes and endnotes. 

.ig text Enters a comment line. See Cominent 
lines. 

.lh number Sets the line height in 48ths of an 
inch. See Line height . 

.1m number Sets a new left margi n. See Margins. 

.lq on/off/dis Turns near letter quality printing on 
and off. See Near letter quality print-
ing . 

.Is number Sets line spacing. See Line spacing. 

. rrib number Sets the bottom margin. See Margins . 

.mt number Sets the top margin. See Margins. 

.oc on/off Turns centering of lines on and off. See 
Centering text. 
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.oj on/off 

.p# value, style 

. pa 

.pl number 

.pm number 

.ps on/off 

.rm number 

.rr text 

.rr number 

. tb numbers 

DOT COMMANDS 

Turns right justification on and off. See 
Justification. 
Sets the starting value and style for 
paragraph numbers. Values can be 
numbers or letters. See Paragraph 
numbering. 
Inserts a page break. See Page breaks . 

Sets the page length. See Page length. 

Sets a paragraph margin. See Para­
graph margins. 

Turns proportional spacing on and off. 
See Proportional spacing. 

Sets a new right margin. See Margins. 

Inserts an embedded ruler line. See 
Ruler lines. 
Inserts a preformatted ruler line. See 
Ruler lines. 

Sets new tab stops. See Tabs . 

WordStar keeps track of the dot commands that affect the margins and page length so 
that, as you move through the document, it can change the margins and page length 
accordingly. WordStar sets aside 2000 bytes of memory, which is partly used for stor­
ing these dot commands while you are editing. If you use more dot commands than fit 
in this memory, the message Dot-Limit appears in the status line. If this happens, the 
screen display may be wrong, but the document will print correctly. You can set aside 
more memory with WSCHANGE. 

Merge print dot commands 

These dot commands are used bnly for merge printing. WordStar flags them with a 
colon (:), indicating that the printout is affected but not the onscreen display. See 
Merge printing and Merge printing conditional commands for more information on 
these commands. 

COMMAND 

.av 

.df 

.ei 

.el 

.go 

ADDITIONAL 

INFORMATION 

"text", variable 

filename 

top/bottom 

FUNCTION 

Uses this text to ask for this variable. 

Reads the named data file or 
spreadsheet. 

Ends a conditional merge print 
statement. 

Specifies a conditional alternative 
(ELSE) in merge printing. 

Skips to the beginning or end of file. 
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COMMAND 

.if 

.ma 

.pf 

.rv 

.sv 

ADDITIONAL 

INFORMATION 

text 

variable = equation 

on/off/dis 

variable 7, variable2, 
etc. 

variable = text 

Other dot commands 

FUNCTION 

Begins a conditional statement in 
merge printing. 

Gives a math equation for merge print­
ing. 

Aligns while printing. The dis setting 
means discretionary; aligning is done 
only where merge print variables are 
inserted. 

Reads the variable(s) in the data file using 
these variable names. Use the * option to 
have WordStar read the data file record 
by record. 

Sets the value of a variable. 

This group includes commands that control the way WordStar displays information 
onscreen while it is printing, and commands used for indexing and creating tables of 
contents. WordStar flags these commands with a colon (:). 

COMMAND 

.cs 

.dm 

. ix 

.tc 

ADDITIONAL 

INFORMATION 

text 

.. text 

text 
text 

Double spacing. See Line spacing. 

Double strike 

FUNCTION 

Clears the screen and displays the text, 
if any, as a message. See Messages 
while printing. 

Displays the text as a message. See 
Messages while printing. 

Creates an index entry. See Indexing . 

Creates a table of contents entry. See 
Table of contents. 

When you use the double strike command ("PO), the printer strikes each character 
twice to produce alight boldface for emphasizing words or phrases. Place the cursor 
where you want the double striking to start and press "PD. The symbol "D appears on 
your screen but is not counted as a character space in the status line. Any text after the 
"D is highlighted on the screen. To mark the end of the double striking, move the cur­
sor to where you want it to end and press "PO again. 
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To delete double striking, place the cursor on the "D and press Del or "G. Be sure to 
remove both the beginning and end markers. See also Boldface. 

Drawing 
You can easily draw lines and boxes using function keys. When used with the Alt key, 
ten of the function keys are preset to produce a line-drawing character. You can use 
these characters to draw lines and boxes. The function key settings are shown below: 

Alt-Fl 

Rlt-F3 

AIt-F5 

AIt-F7 

Alt-F9 

r 

L. 

T 

I-

AIt-F2 

Rlt-F4 , 

AIt-F6 .J 

Alt-F8 ..I­

Ait-FIO -f 

As with all function key settings, you can change these using WSCHANGE. 

A file named BOX is supplied on your WordStar Program disk. It consists of a box 
drawn with the function key characters. This box is 23 columns wide and 7 lines 
deep. You can use it to enclose a title or text up to 21 columns wide and 5 lines long. 
You can insert this box into a file with the insert a file command ("KR). 

When you edit inside a box, turn insert off. With insert on, characters and spaces you 
type push the right side of the box to the right on the line you're editing. Use column 
blocks to move text inside a box. Also be careful when using the Backspace and Del 
keys. If you accidentally erase a character that's part of the box, you can replace it 
with the appropriate function key character. You should also use the .aw off command 
before a box in your text to be sure the box is not accidentally realigned. 

You may want to use a non proportional font before a box. Otherwise, the right side 
of the box may be uneven when it's printed. 

TIP To quickly add height to an existing box, place the cursor on one row of the box 
and remove the line (Ay). Then use the undo command (AU) to restore the row. Con­
tinue to use undo until the box is as high as you want. To change the width of a box, 
use column blocks to add or delete characters. 

If you use certain boxes or line drawings frequently, keep each one in a separate file. 
You can then insert the files when you want them ("KR). 

You can define a shorthand character to insert a box or line file. For example, you 
could define the shorthand character 0 to insert the file BOX. The definition would be 
"KR box ~. If you use a shorthand character to insert a file, either make sure the file is 
always on the current logged drive and directory or specify the drive letter or directory 
path in the shorthand definition. 
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EDITING 

The characters that make up the lines and boxes you print depend on your printer. If 
your printer cannot draw the graphics characters, WordStar instructs it to use the avail­
able characters that are most similar to the graphics characters. 

You can use any special line drawing characters your printer has by specifying the 
extended character code. For information, see Extended character set. 

f 
Editing 
Editing is the process of making changes to the content or appearance of an existing 
document. Adding, deleting, and moving text, and boldfacing a heading are examples 
of editing. 

To edit an existing document, choose Open a document file from the File pull-down 
at the Opening screen. If you're using the classic menus, press D at the Opening 
Menu. To edit a nondocument, choose Open a nondocument file from the File pull­
down or press N at the classic Opening Menu. Then move the highlighting to a file­
name or type the filename, and press ~. When the document appears on the screen, 
use any of the WordStar commands to edit it. 

TIP When you do extensive editing in one session, it's a good idea to save your work 
periodically. Use the Save file, resume editing command on the File pull-down or press 
"KS. 

You can use any special line drawing characters your printer has by specifying the ex­
tended character code. For information, see Extended character set. 

A> ws first.doc 

If necessary, include a drive letter or directory path: 

A> ws c:\wp\letters\first.doc 

WordStar takes you straight to the file. See also Documents and nondocuments and 
Starting WordStar. 

You can edit two files at the same time by opening a window on the second file. See 
Windows. 

Endnotes. See Footnotes and endnotes. 

Enter key 
The Enter or Return (~) key (or the command "M) moves the cursor to the next line. 
When insert is on, ~ inserts a hard carriage return (the symbol < in the flag column) 
at the end of the line. When insert is off, ~ moves the cursor to the next line. 
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Note: As you type, the cursor moves to the next line when it reaches the right margin. 
This type of return is called a soft carriage return. Don't press ~ at the end of a line 
unless you want a hard return. (You can use "6 to change hard returns to soft returns.) 

You also press ~ to signify the end of your response to a WordStar prompt. 

Erasing. See Deleting text. 

Error messages 

When an error occurs, WordStar displays a message to explain what has happened. 
The message often suggests what to do next. Most errors are minor; you can correct 
them and proceed. A few are serious and can mean that you've lost work. 

See Appendix A, "Error Messages," for a list of these messages and their meanings. 

Exiting 
To exit a document, you can use any of the following commands: 

• Save file, go to Opening screen ("KD) or Save file, exit WordStar ("KX) on the File 
pull-down save the work you've just done on your file. 

• Save and name file ("KT) on the File pull-down saves the changed file under a new 
name or names a Speed Write file. 

• Abandon changes ("KQ) returns you to the Opening screen without saving your 
latest changes. See also Saving a file. 

To exit WordStar, choose Exit WordStar from the File pull-down at the Opening screen 
or press X at the classic Opening Menu. If you're printing in the background when you 
issue the exit command, the Printing screen appears. You must finish or quit printing 
before you exit WordStar. See Printing a file. 

Extended character set 

Some printers can print special characters such as graphic characters, Greek letters, 
and letters with accent marks. These special characters are called the extended char­
acter set. However, because there is no standard for these characters, they may vary 
from printer to printer. 

To print a character from the extended character set; check your printer documenta­
tion to find the corresponding ASCII character code. WordStar recognizes all codes 
between 0 and 255. To enter the code, hold down the Alt key and press the number 
on your numeric keypad. When you release the Alt key, a character appears on the 
screen. Depending on your computer, the character that appears may not be the same 
one that prints. 
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TIP If your printer uses the IBM extended character set, you can choose extended 
characters from a menu. Press ~PO to see a menu of the codes for extended characters. 
Then type the code for the character you want and press ~. WordStar enters the code 
into your text. 

See also Appendix 0, "ASCII Conversion Chart," and your printer documentation for 
more information. 

F 
Files and filenames 
Files contain documents you've typed, computer programs, or other types of informa­
tion. You assign a name to every file you create so you can find and use it later. A file­
name can have up to eight characters and an optional three-character extension. Type 
a period between the name and extension. Don't use spaces between characters. 

WordStar doesn't distinguish between uppercase and lowercase letters in filenames. 
Filenames can include letters, numbers, and the following symbols: 

$ & # @ % I' ( ) __ " _ 

Use filenames to remind you of what's in your files. For example, you can give all 
your letters the extension .LTRor give a file the extension .915 if you revised iton Sep­
tember 15. Files with the extensions .COM, .EXE, .OVR, and .$?$ (where? can be any 
character) do not show up in WordStar's directory, so don't use them to name your text 
files. 

For help in locating files on your disk, use the file catalog. For more information, see 
the "ProFinder" tab section in this book. 

Finding and rep/acing 
WordStar can find, find and replace, and find and delete any word or phrase in a file. 

To locate text, choose Find text or Find and replace text from the Go To pull-:down, 
The classic commands are "QF to find text and "QA to find and replace. At the Find 
screen, type the text to find, the text to replace it with (if you're finding and replacing), 
and choose any options you want. Then press FlO or"K to start the find operation. 

if you use the find text command, WordStar moves the cursor to the n~xt occurrence 
of the text and returns you to the editing screen. You can then choose Repeat previous 
find/replace from the Go To pull-down or press "L to find the next occurrence. 

If you use the find and replace command, WordStar finds the next occurrence of the 
text, asks you whether you want to replace it, replaces it if you answer yes, then 
returns you to the editing screen. You can then find and replace the next occurrence 
("L). If you use the G or R option, WordStar finds and replaces all occurrences of the 
text without pauses for editing. 
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To interrupt a find or find and replace operation, press "U. 

Typing text to find or replace 

The text to find or replace can be any sequence of characters, including spaces and 
control characters. To specify a control character, use the "P (literal) command to sig­
nify "Accept the next character I iterally." For example, to find the "B boldface com­
mand, hold down the Ctrl key and press PB. You can use "P"M "p"J to find hard car­
riage returns (hold down the Ctrl key and press PMPJ). The text can be up to 65 char­
acters long. 

You can use the question mark (?) as a wild-card character. For example, to find all 
occurrences of Suzy, Susy, and Suzi, type sun. 

To delete text, use the find and replace command. At the Replace prompt, press "Y ~ 
to replace the string with nothing. 

C AUT ION When you type the text to find, you must be precise because WordStar 
will search for exactly what you type. If you put an extra space after a word, WordStar 
will find it only if you used an extra space in the text too. 

Refer to the chart below to see how to find elements in your text. 

TO LOCATE 

footnote, endnote, 
comment, or annotation 

soft hyphen (end of line) 

soft hyphen (middle of line) 

font change 

hard carriage return 

Options 

TYPE 

"ONG 

"QF"P"­

"QF"P"6 

"Q= 
"QF "P"M"P"J 

When you find or find and replace text, you can choose from a number of options. 
You can choose as many options as you want. Just type them one after another and 
press FlO or"K when you finish. The options are explained below. 

OPTION 

W 

U 

B 

RESULT 

Searches for whole words only. For example, if you're locating "can" 
and you don't use this option, WordStar finds "can," "can't," 
"canned," "American," and "scandal." 

Ignores the case of the characters (uppercase or lowercase). Use this 
option to find text regardless of whether any letter is capitalized or not. 

Searches backward from the cursor toward the beginning of the file. 
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OPTION 

? 

A 

M 

n 

G 

N 

R 

RESULT 

Treats the? character in the search string as a wild card, matching it 
with any character in that position. If you don't use this option and use 
a ? in the text, WordStar searches for the? character. 

Aligns paragraphs after replacement. After reaching the end of the 
paragraph, WordStar returns the cursor to the spot where the replace­
ment was made. If the G or R option is also selected, WordStar 
continues finding and replacing, aligning after each replacement. 

If you don't use the A option, you may need to go back and align the 
paragraphs after replacing text. 

TIP You can use the .aw off dot command to prevent alignment of 
text (such as tables) you don't want realigned. See Aligning text. 

The replacement text uses the same case as the text you're replacing. 

With Find text ("QF), this option moves the cursor to the nth occur­
rence of the text. For example, to find the fifth occurrence of the word 
"the" in your document, type the number 5 as an option. With Find 
and replace text ("QA), this option indicates how many occurrences of 
the string are to be replaced. For example, to replace the next five 
occurrences of "the" with "a," type the number 5 as an option. (This 
option is not displayed on the screen.) 

Moves to the beginning (or end, if the B option is also used) of the file 
before beginning the search. With Find and replace text ("QA), 
searches globally (for all occurrences of the string) through the entire 
file starting from the beginning (or end). 

Replaces the text without asking if you want to make the replacement. 
The replace operation is displayed onscreen so you can keep track of 
it. Unless you are also using the G or R option, WordStar stops after 
the first replacement, with the cursor at the beginning of the replace­
ment text, and you have to find and replace the next occurrence ("L). 

Searches through the rest of the document for all occurrences of the 
text. This option works only with the Find and replace text ("QA) 
command. 

You can set default options with WSCHANGE. If you don't select any options at the 
Options prompt, WordStar uses the default options you set in WSCHANGE. (If you do 
select any options, none of the default options are used unless you specifically select 
them.) If you press the Spacebar and ~ at the Options prompt, WordStar doesn't use 
any options. If you use WSCHANGE to select the N, A, or R options as defaults, 
WordStar ignores them when it is finding without replacing. 

TIP When you use the G or R option with the N option, you can turn off the display 
of replacements to speed up the operation. Just press the Spacebar after you see the 
operation start on the screen. 
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Finding your place 
Several commands move the cursor to a particular place in the text. These commands 
are described below. 

COMMAND FUNCTION 

These commands are on the Go To pull-down: 

"Q8 

"QI 

"QK 

Goes to the beginning of the marked text block. 

Goes to the page (or line, in nondocuments) whose number you 
type at the prompt. You can also type + or - to go to the next or 
previous page. To go forward or backward a specified number of 
pages, type a number after the + or -. After you type the page 
number and press ~, WordStar searches and stops on the page. If 
it's searching forward, it goes to line one. If it's searching back­
ward, it goes to the last line of the page. 

Goes to the end of the marked text block. 

These commands are not found on pull-down menus: 

"Q 0-9 Goes to a marker that you previously set with "K 0-9. See Place 
markers. 

"QG character 
"QH character 
"QP 

Goes to the next occurrence of the specified character. 

Goes to the previous occurrence of the specified character. 

Returns the cursor to its location before the previous command. 
Press this immediately after the previous command is executed. 

"QV Goes to the most recent find string or to the previous location of 
the most recent marked block. 

Flag column 
On the right side of the screen, WordStar displays a "flag" for each line to remind you 
what you typed on the line. Flags are displayed automatically. The flags and their 
meanings are listed below. 

FLAG 

< 

P 
F 
C 

MEANING 

This line ends with a hard carriage return. 

A blank space in the flag column means the line ends with a soft carriage 
return produced by word wrap within a paragraph. 

This is a page break; a new page begins below this line. 

This line ends with a form feed produced by the "PL command. 

This is a column break. 

The file ends on or above this line. 
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FLAG 

+ 
MEANING 

Text on this line extends beyond the right edge of the screen. 

The dot command on this line changes the onscreen format and the 
printout. 

The dot command on this line changes only the printout. 

? The dot command on this line is not recognized by WordStar. 

The dot command on this line changes the onscreen format and the 
printout; it works best if it's placed at the beginning of a page. 

This line ends with a carriage return but without a line feed (produced by 
"P ~); it will be overprinted by the next line. 

The line ends with a .Iine feed but without a carriage return (produced by 
"PJ); the next line will print on the line below, but may not begin at the left 
margin. 

B The beginning block marker is in this line. 

K The end block marker is in this line. 

Fonts 
A font is a particular size and style of type, for example, pica, expanded print, or 
Helvetica 10 point. Some printers let you choose from a number of fonts. Below are 
some examples of fonts. 

EXAMPLE 

Courier 10 point 
Helvetica 10 point 
Helvetica 12 point italic 
Times Roman 18 point bold 
Changing fonts 
To print text in a different font, place the cursor where you want the new font to start 
and choose Choose font from the Style pull-down or press"P=. WordStar shows you 
the font currently in effect and a list of the fonts available on your printer. For non­
proportional fonts, the font name shows the pitch of the fonts, for example, 10 pitch 
or 12 pitch. For proportional fonts, the font name shows the typeface of the fonts, 
such as Times Roman or Helvetica, and the size of the fonts, such as lapoint. On 
some printers, the font name may also show the cartridge where the font is located. 

Move the highlighting to the font you want and press ~. If display ("00) is on, a com­
mand tag showing the font name appears in the text (for example, <HELV 10 pt». 
Text following the command tag prints in the new font until you change the font again. 
Text that you type after the command tag displays the correct line breaks and 
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page breaks for the font you choose. The highlighting in the ruler line shows where 
the character at the cursor will print on the page. For example, if you use a small font, 
the highlighting moves slowly across the ruler line. Each column on the ruler line rep­
resents one-tenth of an inch. You can use WSCHANGE to alter how much space each 
column represents. 

TIP You can use "PA and "PN to quickly change to the fonts you use most fre­
quently. To change the font used for "PN and "PA in a document, use the .cw dot 
command. This command sets the character width for whichever command is in effect 
when you type the dot command. For example, to set the alternate font to 12 charac­
ters per inch, press "PA and type .cw 8 on the next line. You can set new normal and 
alternate fonts as often as you want in your document. To change the default fonts for 
"PN and "PA, use W5CHANGE. 

Existing text is not affected by a font change until you align the text ("8 or "QU) or 
make changes in it. 

If you choose a font that c;an fit many characters per inch, text may extend past the 
right side of the screen. As you type the text, the screen scrolls so you can see the por­
tion you're typing. For more information, see Scrolling. 

TIP If you change fonts in the middle of a document and need to change the print 
wheel or cartridge on you printer, use the "PC command to pause printing. For more 
information, see Pause printing. 

To remove the font command, place the cursor on the command tag and press Del 
or "G. 

If you print your document with a different printer than the default printer, WordStar 
tries to match both typeface and style. If that's not possible, WordStar maintains the 
line breaks and adds soft spaces to justify the new font to the margins. 

You can customize the list of available fonts (choosing up to 255 fonts) in 
PRCHANGE. See your printer manual for more information on the fonts available on 
your printer. 

To see a list of fonts for a different printer, change the default printer. Press "P? and 
choose the printer you want, then choose Choose font or press "P= to see a list of 
fonts for the new pri nter. 

To move the cursor to the next font change in a file, choose Go to next font from the 
Go To pull-down, or press "Q=. 

Proportional versus nonproportional (fixed pitch) fonts 

In a nonproportional font, each character takes up the same amount of space on the 
page. Nonproportional fonts are measured in pitch, or characters per inch. For exam­
ple, a COURIER 10lin font is a nonproportional font with 10 characJers per inch 
(pica); in COURIER 12/in, there are 12 characters per inch (elite). On dot matrix 
printers, expanded print is usually 5 characters per inch and compressed print is 17 
characters per inch. 
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In proportional fonts, different letters take up different amounts of space; for example, 
an "m" takes up more space than an ilL" Proportional fonts are usually measured in 
points. For example, standard text characters are 10 points, but footnotes might be 
in a smaller size, such as 8 points. For more information, see Pitch and Proportional 
spacing. 

Footers. See Headers and footers. 

Footnotes and endnotes 
When you add a footnote or endnote to your text, WordStar automatically numbers it 
and puts it in the proper place. Commands let you design the note's style, switch foot­
notes to endnotes or vice versa, locate notes, and more. 

Footnotes appear at the bottom of a page; endnotes appear on the last page. There are 
two other kinds of notes to choose from: annotations, when several entries in a chart 
or table refer to the same note at the bottom of the page; and comments, for notes that 
appear onscreen (when display is on) but don't print. All four kinds of notes can 
appear in the same document. 

Creating notes 
To create a note, place the cursor where you want the reference to the note to appear 
in the text and choose Footnote/endnote from the Other pull-down or press "ON. 
Then type E (for endnotes), F (for footnotes), A (for annotations), or C (for comments). 
Type the note in the wi ndow at the bottom of the screen. 

When you finish typing the note, choose Close and save window from the Window 
pull-down, or press "KD. The window disappears. When display ("OD) is on, the first 
few words of the note appear in a tag onscreen to remind you of its contents. If display 
is off, only the highlighted reference to the note appears. 

When you print the document, the reference to the note is superscripted. Footnotes 
and endnotes are numbered. If you want to use some other sequencing method, you 
can specify it with one of these dot commands: 

.e# specify endnote initial value 

.f# specify footnote initial value 

You can choose from these sequencing methods: 

alpha A B ... Z AA BB ... ZZ AAA ... 

a b ... z aa bb ... zz aaa ... 

numeric 1 2 3 ... 

symbol * ** *** 
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For example, to get lettered footnotes, place the dot command .f# A at the beginning 
of your file. You can also determine the value to be used for marking the first note. To 
begin your footnotes with 4 rather than 1 (if, for example, your chapter is divided into 
two files), use the dot command .f# 4. 

You specify the reference for an annotation when you create the note. Comments are 
not referred to in the text. 

References to notes print in the current font for that point in the text. The notes them­
selves print in the default font, unless you select a different one when you create or 
edit the note, or specify a different font in WSCHANGE. 

Footnotes are separated from the text by a line of 20 dashes. If a footnote doesn't fit at 
the bottom of the page, the continued text is printed in the footnote area at the bottom 
of the next page (except after the last page of regular text, where footnotes are printed 
at the top of the page). 

A minimum of three lines of regular text are printed on a page regardless of the size of 
the footnote area except onthe last page of the document. 

Editing and removing notes 
When display ("OO) is on, the first few words of each note appear onscreen to remind 
you what the note is about. To see the full text of a note, or to edit a note, move the 
cursor to the note and press "ONO. To see or edit a comment, first turn display 
on, then move the cursor to the reminder in brackets and press"ONO. You have 
WordStar's full editing capabilities available for editing notes, including changing 
margins and tabs, choosing fonts, and using thespelling corrector. (To check the 
spelling in your notes, press ':'ONL. For more information, see Spelling check.) 

If you change margins and tabs for a note and want to realign all subsequent notes, 
press "ONU. 

To locate a note, press "ONG. You are prompted for the type of note, the note 
number, or the text of the note you want to locate. 

To remove a note, delete its reference (number, letter, or symbol). All subsequent notes 
of that type are automatically renumbered. To restore a note you've deleted acciden­
tally, use the undo command tU}. 

Converting notes 
You can convert one type of note to another. For example, you can convert a footnote 
to an endnote, or vice versa. Place the cursor on the note number and press "ONV. 
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You can also print all notes of one type as another type. For example, if you have both 
footnotes and endnotes in one document, you can print all the notes as footnotes and 
they will be numbered consecutively. These are the dot commands to use (placed at 
the beginning of your file): 

.cv f>e 

.cve>f 

.cv c>f 

.cv c>e 

print foqtnotes as endnotes 

print endnotes as footnotes 

print comments as footnotes 

print comments as endnotes 

To make endnotes print anywhere other than at the end of the file, put the dot com­
mand .pe where you want the endnotes to print. This is useful when you have more 
than one chapter in a file. For example, if you have three chapters of a book in one 
file, you can type .pe at the end of each chapter. That way all the endnotes for that 
chapter will print at the dot command. 

In WSCHANGE you can set defaults for note margins, spacing, line height, position 
on page, font, title line, separator and continuation lines, and a number of other for­
matting options. 

Index entries 
You can create an index entry by using the command "ONI. At the prompt, type the 
entry the same as you would when using the .ix command. Nothing appears in the 
text if display is off. If you turn display on ("00), you see a reminder in brackets con­
taining the first part of your index entry. See Indexing for more information. 

Formatting 
The format of a document is its design or appearance. You can change document for­
mat with onscreen format commands, and with dot commands. You can also insert a 
preformatted ruler line into your document to change tabs and margins. 

See the following entries for information on the corresponding format elements: 
Aligning text, Centering text, Hyphenation, Indenting, Justification, Line height, 
Line spacing, Margins, Page breaks, Page I~ngth, Ruler lines, Tabs, and Word 
wrap. 

Form feeds 
To begin a new page without moving the cursor to a new line, press "PL where you 
want the page and line to end. The symbol "L appears, followed by a line of hyphens. 
The letter F appears in the flag column. When you print the document, the"L causes 
the printer to move to the start of the next page, but not return to the left margin. The 
footer, footnotes, and page number for this page are not printed. 

Note: Your printer must be capable of accepting form-feed characters in order to use 
this feature. 
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The dot command .xl is used to define the form-feed string. Use it only if your printer 
requires a different form-feed string than the printer description file uses. 

See also Page breaks. 

Form letters. See Merge printing. 

Function keys 
The function keys, which are usually labeled F1, F2, F3, and so on, enable you to 
execute the most often used WordStar commands with a single keystroke. 

You get four different commands when you press a function key alone, or with one of 
these keys: Shift, Ctrl, or Alt. For example, pressing F9 is the same as choosing Save 
file, resume editing ("KS) from the File pull-down. Pressing the Shift key and F9 is the 
same as choosing Begin block ("KB) from the Edit pull-down. Pressing the Ctrl key and 
F9 is the same as choosing Go to line beginning ("QS) from the Go To pull-down. 
Pressing Alt and F9 inserts a box-drawing character. (See Drawing.) 

At help levels three and below, two function key settings for each key are shown on 
the bottom of the screen while you are editing. The lower one is for the key when 
pressed alone, and the upper one is for the key when pressed with the Shift key. 

See Pocket WordStar or the keyboard overlay for a complete list of the function key 
settings. You can use WSCHANGE to change any of the function key settings or to 
suppress or change the onscreen display of the settings. . 

H 
Headers and footers 
A header is text that prints at the top of every page; a footer prints at the bottom of 
every page. You can use headers and footers to print information such as document 
title, page number, author, or date. . 

You can definE:! up to three lines each for headers and footers and specify different 
headers and footers for odd and even pages.· . 

If you don't define a footer in your file, WordStar prints the page number centered on 
the page. (You can turn off the page number by using .op, omit page number, or 
change its placement using .pc. See Page numbering.) 

To define headers and footers, use these commands, followed by the text for the 
header or footer. 
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COMMAND 

.he or .hl 

.h2 

.h3 

.fo or .fl 

.f2 

.f3 

DESCRIPTION 

First header line 

Second header line 

Th i rd header line 

First footer line 

Second footer line 

Third footer line 

Note: The pull-down commands for the first line of a header or footer are on the 
Layout pull-down. 

To specify different headers or footers for odd or even pages, type an 0 (for odd) or 
an e (for even) after the dot command, for example: 

.heo Chapter 1 

.hee The Gray Cat 

"Chapter 1" will print at the top of every odd page and "The Gray Cat" will print at 
the top of every even page. 

The Gray Cat Chapter 1 

If you don't type an 0 or an e, the header or footer prints on all pages. 

To turn off a header or footer, type the same dot command that began it (without any 
text), then press ~.' If you turn off all footers, the default page number footer is re­
stored. 

To include the page number in a header or footer, use the # character. For example, 
.fo Page # prints as Page 1 on the first page. To print the # character itself rather than 
the page number, precede it with a backslash. For example, .he Draft \#2 prints as 
Draft #2. To print a backslash,. use two backslashes (\ \). 
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You can use print enhancements such as boldfacing and underlining in headers and 
footers. These features print; however, the marked text is not highlighted on the 
screen. Print enhancements you add to headers and footers do not affect text in the 
rest of the document, nor do print controls in the rest of the document affect headers 
and footers. 

To put a blank line between two header or footer lines, add the text on lines 1 and 3 
and define the second line as blank. For the blank line, type .h2 or .f2, press the 
Spacebar twice, then press ~. 

On the printed page, the amount of space between the command and the text in a 
header or footer determines the position of the header or footer on the page. If you 
type no spaces (.fotext) or one space (.fo text) the footer or header text will begin at 
column 1. To see how headers and footers will look when printed, use the page pre­
view feature (if you have a graphics monitor). For information, see Page preview. 

Headers or footers print using the font and line height in effect where you enter the 
.fo, .fl, .he, or .hl dot command. You can change the font within the header or 
footer. 

To change the amount of space between the header or footer and the text of the docu­
ment, change the header or footer margin. 

top f' margin header --+-

head~r { rgm 

:...---------------

The default top margin of .5" and header margin of .33" leaves you only .17" (one line) 
for header text. If you want a header with two or three lines, use a larger top margin or 
a smaller header margin. See also Margins and Page length. 

WordStar prints a maximum of 100 characters in a header or footer, including carriage 
returns, extended characters (which count as three characters), and control characters. 
This length can be changed with WSCHANGE. If you are using wide paper, you may 
want to set it higher, for example, 150. 

See also the "Applications" tab section. 

Help levels 
Once you're an experienced WordStar user, you might want to display classic menus 
instead of pull-downs, or turn off the display of menus and confirmation prompts 
altogether. You can do either of these by changing the help level. 
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The classic menus take up one third of most screens, so turning them off by changing 
from level three to two allows you to see considerably more of a document while you 
edit. Even when menus are not displayed, you can still use the commands. 

You can set help levels by choosing Change help level at the Other pull-down. If 
you're at level three or below, press J atthe Opening Menu, or press "J"J while editing 
a document. The help levels are described below. 

HELP LEVEL 

4 

3 

2 

1 

o 

DESCRIPTION 

Pull-down menu names are displayed in the menu bar at the top 
of the screen. To see a menu, hold down the All key and press 
the first letter of the menu. All prompts are displayed. Help level 
four is the default setting. 

All classic menus and prompts are displayed. 

The classic Edit Menu is not displayed, but prompts are displayed. 
This gives a full-screen display of the document. Other classic 
menus will be displayed if you pause after pressing the menu let­
ter ("K, "0, "P, "Q). 

No menus are displayed during editing unless you ask for help. 
Prompts asking you to confirm a response are not used either. 

Menus are not displayed unless you ask for help. Confirmation 
prompts are not displayed. You can move, copy, and delete hid­
den blocks. 

At help levels two and below, you can display the classic Edit Menu by pressing "J. 

You can change the default help level with WSCHANGE. 

For more information on classic and pull-down menus, see Menus and the "Over­
view" section in "Starting." 

Help messages 
You can get onscreen help for every command. When using pull-down menus, press 
Fl or "J for help with the highlighted command. 

With classic menus, press Fl or J at the Opening Menu, then the command you want 
help with. To get help while editing a document, press Fl or "J, then the command 
you want help with. 

While editing, you can also press "U for help with the screen display and "J. for help 
with dot commands. 

Hyphenation 
You can have WordStar hyphenate words at the ends of lines when aligning text. Auto­
hyphenation is on by default; use "OH to turn it off (and on again). 
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The hyphens you type yourself during editing are hard hyphens. They stay in the text 
until you erase them. The hyphens WordStar adds during auto-hyphenation are called 
soft hyphens because they're printed only when a word breaks at the end of a line. 

Using WSCHANGE, you can change how WordStar decides which words to hyphen­
ate and change the default setting of auto-hyphenation to off. 

To specify that a word can be hyphenated even when auto-hyphenation is off, or to 
change the location of a soft hyphen, place the cursor where you want the word to be 
hyphenated and press "OE. This adds a soft hyphen to the word. If this word extends 
past the right margin, WordStar hyphenates it at the location you specified. 

If subsequent alignment moves a soft hyphen away from the end of the line, it's dis­
played onscreen as an equal sign (=), but it's not printed. You can change the = to 
another character with WSCHANGE. 

TIP To specify that a word not be hyphenated, place the cursor on the first character 
of the word, and press "'DE. Even if the word contains a hard hyphen, the entire word 
always remains on the same line. 

Soft hyphens disappear when display ("00) is off. 

I 
Indenting 

WordStar has five ways to indent. Use whichever method works best in your situation. 

• Press the Spacebar to add a hard space. The cursor moves right one space each 
time it's pressed. This method is efficient for indents of one or two spaces. See 
Inserting. 

TIP Keep in mind that a space may be different sizes in different fonts. If you 
change fonts in your document, it's best to use tabs or change margins to indent 
text. 

• Press the Tab key to indent an individual line without changing the left margin. 

• Use the temporary indent command "OG to indent the left margin to the next tab 
stop (excluding decimal tabs). The margin returns to its original setting after you 
press either ~ at the end of a paragraph you're typing or "8 to align an existing 
paragraph. If you press "OG once, the left margin indents to the first tab stop; if 
you press "OG twice, the left margin indents to the second tab, and so on. The 
temporary margin is indicated by a V in the ruler line. 
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• Change the left margin to indent a number of paragraphs or an entire file. Choose 
Margins and tabs from the Layout pull-down or press "Ol, and enter the new left 
margin. This command is stored with your text, allowing you to maintain the new 
left margin when you align paragraphs in subsequent editing sessions. Reset your 
original left margin when you finish typing the indented part of your text. See also 
Margins. 

• Set a separate margin for the first line of each paragraph by setting a paragraph 
margin. Choose Margins and tabs from the Layout pull-down and go to the Para­
graph field, or use the .pm dot command. For example, if you type .pm .5" and 
your left margin is at 0, the first line of each paragraph is indented half an inch and 
the following lines start at the left margin. 

The paragraph margin command is also useful for entering numbered lists where 
you want the numbers to hang out to the left of the text. If you set the paragraph 
margin at 0 and the left margin at .5", the first line of each paragraph starts to the 
left of the rest of the paragraph. See also Paragraph margins. 

Indexing 
WordStar can create an index for a document. You can choose specific entries for the 
index, or you can index every word in the document except those you put on an ex­
clusion list. 

Choosing specific entries 

You can mark index entries in your text by pressing "PK at the beginning and end of 
each word or phrase you want to include in the index. 

If the word or phrase doesn't appear in your text as you want it to appear in the index, 
you can type the word or phrase to be indexed using one of the following methods. 

• Place the cursor at the beginning of the information you want to index. Choose 
Index entry from the Other pull-down or press "ONI. Type the entry at the prompt 
and press ~. 

• Place the cursor in column 1 on the line just before the paragraph that contains the 
topic to index. Type .ix followed by the index entry and press ~. 

When typing an entry, first type the main entry. Then, if you want to add a subrefer­
ence, type a comma and the subreference, for example: 

Phrase to index, subreference 

The subreference is optional. When you print the index, a subreference appears under 
the main reference, indented two spaces, as shown below: 

Phrase to index 
subreference, 17 

Capitalize the entry the way you want it to appear in the index. 
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To boldface the page number for an entry, type a plus (+) before the text in the entry. 
For example: 

+ Files, naming 

When WordStar creates the index, the page number for this entry will be boldfaced. 

For a cross-reference, type a hyphen (-) before the word or phrase, as shown below. 

- Naming files, see Files 

When WordStar creates the index, it won't add a page number for this entry. 

When you use "ONI to create an index entry, the first few characters of the entry 
appear on screen to remind you of its contents (if display is on). To view or edit the 
complete entry, place the cursor on the reminder and press "OND. 

The maximum length of a phrase to be indexed is 50 characters including the sub­
reference. Extra characters are ignored. 

TIP To quickly add entries for every occurrence of a specific word, type the first 
entry for the word, and mark the entry as a block. Then locate every other occurrence 
of the word, and copy the marked block to each location. 

Indexing every word 
You can tell WordStar to index all the entries you've typed, the phrases you've 
marked, and all the words in the document minus any words that appear in exclusion 
lists. 

An exclusion list is a nondocument file that contains an alphabetical list of words to 
exclude from an index. WordStar uses two exclusion lists. The general exclusion list is 
named WSINDEX.XCL and is supplied with WordStar. It contains a list of the most 
common words in English (articles, pronouns, prepositions, conjunctions, and so on) 
that are rarely indexed. 

The document-specific exclusion list has the same name as the document for which 
you are making the index, but with the .XCL extension. To create this list, create a 
nondocument file with the appropriate name, and type the specific words from your 
document that you want to exclude from the index. Be sure to type each word on a 
separate line. 

When you create the index, type Y at the Index every word field. 

TIP You can quickly create a document-specific exclusion list. First, index every 
word in your document. Next, open the index file as a nondocument and delete the 
words you do want in the index. Then change the extension of the file to .XCL. This file 
is now an exclusion list. 
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Creating the index 
To make an index, choose Index from the Additional pull-down at the Opening 
screen. Classic menu users type I at the Opening Menu. At the prompt, type the docu­
ment name and press ~. Use Tab and Shift-Tab to move around in the dialog box. 
The default at the Index every word field is N (you can change this with WSCHANGE), 
which causes WordStar to index only the words and phrases you've marked or 
entered. Type Y if you want to index every word, minus the words that appear in the 
exclusion lists. The default at the Page numbers field is all pages. To index a portion of 
the document, type the starting and ending page numbers for that section. Press FlO or 
"K when you're finished with the dialog box. 

WordStar creates an index file that has the same filename as the document, but with 
a .IDX extension. All entries are sorted in alphabetical order with the page numbers 
added, and duplicate entries are combined into one listing. Once the index is created, 
you can edit the index file to make any formatting corrections or changes. 

See also Table of contents. 

Inserting text and files 
You can insert characters, lines, blocks of text, even whole files into the current docu­
ment. 

Press either "V or the Ins (Insert) key to turn insert on and off. When insert is on, new 
characters you type are inserted between previously entered characters. When insert is 
off, new characters type over previously entered characters, erasing them. When insert 
is on, the word Insert appears in the status line. 

The default for insert is on. You can change the default using WSCHANGE. When 
insert is on, use the commands in the chart below for inserting text. 

TO INSERT 

a line above the cursor 

a line below the cursor 

a block from another file 

a dot command 
or print command 

FOLLOW THESE INSTRUCTIONS 

With cursor at the beginning of the line, press "N or ~. 

With cursor at the end of the line, press "N or~. See 
Blank lines. 

Choose Open/switch windows from the Window pull­
down or press "OK. See Windows. 

Type the command. (A dot command must 
begin in column 1 and end with +--l.) 

When you're working in column mode, column replace affects block insertion. See 
Column blocks. 
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Inserting files 

You can insert an entire file into your document. To do this, place the cursor where 
you want the file inserted and choose Insert a file from the Edit pull-down or press 
"KR. At the prompt, type the name of the file you want to insert, including a drive or 
path if necessary, and press ~. 

If column mode is on, the file is inserted as a column at the cursor position. Text to the 
right of the column moves right if there is room within the margins. Otherwise, the 
text moves down to make room for the column. For more information, see Column 
blocks. 

you can also insert a file at print time using the .fi command. See Nesting and chain­
ing for more information. 

Inserting a spreadsheet 

To insert a Lotus 1-2-3, Symphony, or Quattro® worksheet into your document, place 
the cursor where you want the worksheet inserted and choose Insert a file from the 
Edit pull-down or press "KR. At the prompt, choose the name of the worksheet. Word­
Star then prompts you for the range to insert. If you have assigned range names to the 
worksheet, these names are displayed for your selection. To insert the entire work­
sheet, press ~. If you want to insert only part of the worksheet, type the range of cells 
or a range name and press ~, or move the cursor to the highlighted range name you 
want and press ~. 

If you created additional windows in the worksheet file, select the window to use for 
inserting data into your document. If you restricted a window in Symphony, only the 
restricted area is imported. If the window you select is smaller than the range you 
select or vice versa, you will be limited by the smaller of the two. 

TIP Be sure you're in a nonproportional font before you insert the worksheet. You 
can change back to a proportional font at the end of the worksheet. Also, use the dot 
command .dW off before the worksheet and .dW on after the worksheet to prevent 
realigning. 

Installing WordStar 
See the "Starting" tab section for instructions on installing WordStar. Normally, you go 
through the WINSTALL installation program only once, before you use WordStar for 
the first time. However, if you change computers, printers, or other features of your 
computer system, you should repeat the installation procedure to tell WordStar the 
new information. 

WordStar also has two customization programs, WSCHANGE, which allows you to 
set up advanced features and to change defaults, and PRCHANGE, which lets you 
customize how WordStar works with your printer. See Appendix C, "Customizing 
WordStar," for information on WSCHANGE and PRCHANGE. 
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italics 
If your printer supports italics, place the cursor where you want the italics to start and 
choose Italics from the Style pull-down or press "PY. The symbol "Y appears on your 
screen. To mark the end of the italics, place the cursor where you want the italics to 
end and use the command again. 

To delete italics, delete both "Y symbols. 

J 
Justification 
When justification is on, WordStar adds spaces to the text so all lines extend to the 
right margin. When justification is off, the right margin is ragged. 

To turn justification on or off ina document, choose Right justify text from the Layout 
pull-down or press "OJ. WordStar adds a .oj on or .oj off dot command to your file. 
(You can also type the dot command directly in your file.) 

To change the justification for existing text, first set justification to the setting you want, 
then align the text using "8 or "QU. 

The default setting for justification is on. You can change the default setting using 
WSCHANGE. 

See also Microjustification and Soft spaces and carriage returns. 

K 
Keyboard 
Keyboards differ slightly from one computer to another. The positions and names of 
some of your keys may be different from those described in this manual, but they have 
the same functions. 

The numeric keypad on the right side of most keyboards can be used either to move the 
cursor around or to enter numbers. Press the Num Lock key to switch between the two 
modes. See Cursor movement keys for a description of the keys used to move the cursor. 

The keys labeled Fl, F2, and so on are the function keys. For an explanation of these, 
see Function keys. 
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Other special keys are described below. 

KEY 

Caps Lock 

Ctrl 

Del 

Esc 

1..­
~, 

Ins 
Alt 

DESCRIPTION 

Backspace key. Moves the cursor one space to the left and erases the 
character there. 

Caps Lock key. Shifts letter keys to uppercase (doesn't shift number, 
punctuation, or symbol keys). Press it once to turn it on and again to 
turn it off. 

Control key. Signals the computer that the next character to be typed is 
a command. This key is shown in documentation as a caret ("). It must 
be held down while the next character is typed. 

Delete key. Erases the character at the cursor. 

Escape key. Used when WordStar prompts Press Esc to continue or to 
start a shorthand operation. It is sometimes used to back out of a situa­
tion. 

Enter key. Inserts a hard carriage return in the text or marks the end of 
your response to a prompt. It's sometimes called the Return key. 

Shift key. Allows you to type uppercase letters and the upper set of 
characters on other.keys. 

Tab key. Moves the cursor to the next tab stop to the right. 

Insert key. Turns insert on and off. 

Alternate key. At help level 4, used to display the pull-down menus. Used 
with the function keys for special functions that you can set up with 
W5CHANGE. Also accesses the extended character set. 

Switching the Ctrl and Caps Lock keys 
On some keyboards, the Ctrl key and the Caps Lock key are in different positions than 
your fingers are used to. You can use the SWITCH.COM program supplied with Word­
Star to exchange the functions of these two keys. (This does not affect the Ctrl key on 
the right side ofthe keyboard.) Follow these steps: 

Type the word switch on a separate line in your AUTOEXEC.BAT file. 

2 Copy the SWITCH.COM file from the Installation disk to your root directory. 

3 Reboot your computer by pressing Ctrl-Alt-Del. (For this one time, use the Ctrl key 
on the right side of the keyboard.) 

From now on, you can use the new Ctrl key exactly as you used the old key with one 
exception: when you press Ctrl-Break, use the Ctrl key on the right side of the key­
board. 

You may want to put stickers on the Ctrl key and Caps Lock key to remind yourself of 
their new functions. 
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To set the Ctrl key and Caps Lock key back to the way they were before you switched 
them, log on to your root directory and type switch Ix. This is effective only until you 
reboot the computer. If you want to change the keys back permanently, remove the 
line "switch" from your AUTOEXEC.SAT file. 

Note: When you use certain programs (for -example, Microsoft Windows), the switch is 
ignored. 

L 
Landscape and portrait mode 

To print in landscape mode (lengthwise on the page), type .pr or = Ion the first line of 
the page. To return to normal printing (portrait mode), type .pr or = p. (Landscape 
mode is not available on all printers.) 

portrait landscape 

Printers can't combine landscape and normal mode on a single page. 

When you print in landscape mode, be sure to change the right margin and page 
length accordingly. For 8V2-by-ll-inch paper, set the right margin to 9.6 inches and set 
the page length to 8.5 inches. Remember to change the right margin and page length 
back when you return to portrait mode. 

Line feeds 

To insert a line feed, press"PJ. The cursor moves to the beginning of the next line, and 
the letter J appears in the flag column. When the printer encounters the line-feed sym­
bol, it moves down a line without returning to the left margin and prints in the column 
following the one that contains the line feed. 
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Line height 

The distance between lines of print is called the line height. It is measured from the 
bottom of one line to the bottom of the following line. 

Line height is measured in 48ths of an inch. WordStar's default line height is %8 inch, 
which means there are six lines per inch. 

To change the line height, type .Ih followed by the number of 48ths of an inch for the 
neW line height. For example, to change the line height to 1%8 (three lines per inch), 
type .Ih 16. 

TIP You can use .Ih 16 to print a document double-spaced. 

Line height can vary between 2 and 255, although these extremes are not very useful. 
The chart below shows the relationship between several different settings for the .Ih 
command and the number of lines per inch in the printout. 

COMMAND 

.Ih 5 

.Ih 6 

.Ih 7 

.Ih 8 

.Ih 10 

.Ih 12 

.Ih 16 

.Ih 24 

LINES/INCH 

9.6 
8 
6.8 
6 (standard line height) 
4.8 
4 
3 
2 

If a printer can't move in increments of 48ths of an inch, WordStar uses the closest 
line height available on the printer. 

Changing the line height affects the number of lines that can be printed on a page. The 
onscreen display changes to show where the new page breaks fall, but does not show 
the new line height. To see how the line height will look when printed, use the page 
preview feature (if you have a graphics monitor). For information, see Page preview. 

See also Line spacing and Page length. 

Line numbering 

You can have line numbers print in the left margin of your document. This makes your 
document look like legal pleading paper. Line numbers do not appear on screen; they 
appear only on the printed page. 

Type .1# in column 1 on the line above the first line to be numbered. Use the follow­
ing format: 

.1# style spacing, column 
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To set the style of numbering, type p to have numbers restart on each page, or d to 
have continuous numbering throughout the document. If you don't specify a style, 
WordStar restarts numbers on each page. 

To set the spacing, type 1 for single spacing or 2 for double spacing. If you don't type 
a number, or if you type 0, line numbering is turned off. 

You can set the column where line numbers will print by typing a comma followed by 
a number. This number represents columns to the left of column 1. The default is 3. 

For example, .1# d2,4 turns on line numbers that print continuously throughout the 
document, double-spaced, four columns to the left of column 1. 

To turn off line numbering, type .1# O. If you place the command to start or stop line 
numbering in the middle of a page, the command does not take effect until the next 
page. 

If your page offset does not allow room for the page numbers to be placed there, 
WordStar increases the page offset. You can change the default style and placement of 
the numbers with WS~CHANGE. 

I 

Line spacing 
Line spacing allows you to print your text double-spaced, triple-spaced, and so on. 
Choose Single/double spacing from the Layout pull-down or press "OS. This takes you 
to the Margins & Tabs dialog box. Move the cursor to the Line spacing field and type a 
number from 1 to 9. Typing 1 gives you single spacing (no blank lines between the 
lines of text), 2 gives you double spacing (one blank line between text lines), and so 
on. WordStar enters the dot command .Is in your document. You can also type the dot 
command (followed by the spacing number) directly in your document. 

When you change line spacing, you see the new spacing onscreen. When you change 
line height, you do not. For example, .lh16 (line height) and .ls2 (line spacing) both 
give you a double-spaced printout, but you see the double spacing onscreen only 
when you use line spacing. Using a line-spacing command to get double- or triple­
spaced text takes up more room on disk than changing line height, because the blank 
lines become part of your file. Whichever method you use, WordStar adjusts the page 
breaks accordingly and shows the correct page breaks onscreen. 

If you change both line spacing and line height, the blank lines added for line spacing 
are at the specified line height; for example, if you enter both .Ih16 and .Is2, you get 
quadruple spacing. 

The message LinSp-n (n represents the spacing number) appears in the status line for 
anything other than single spacing. 

If you change the line spacing for existing text, realign the text to reflect the new spac­
ing ("8 or "QU). 
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To see how line spacing will look when printed, use the page preview feature (if you 
have a graphics monitor). For information, see Page preview. 

See also Line height. 

Logged drive and directory 

The logged drive or directory is the one you're currently working in. WordStar looks 
for and stores files on the logged drive unless you tell it otherwise. 

WordStar displays the logged drive and directory in the directory heading and displays 
the logged drive in the status line while you're editing. 

The command to change the logged drive or directory is on the File pull-down. You 
can also press l at the classic Opening Menu or AKl while editing. Type the name of 
the new drive at the prompt. To change the logged directory, move the highlighting to 
the name of a subdirectory in the file listing (indicated by a backslash after the name) 
and press ~ or type the path (for example, \DOC). Include the drive letter if you also 
want to change the drive (for example, C:\DOC). 

When you choose a file (for example, to open or erase it), WordStar assumes the file is 
on the logged drive and directory. If the file is on a different drive or directory, you 
have to include the drive or path with the filename (for example, A:MEMO.DOC, 
C:\WS5\027S1.BID or \DOC\TOM.MEM). Include the drive or directory to copy a file 
to another drive, too. 

C AUT ION When you change disks in the floppy drive, log on to the drive again. 
If you don't, your operating system may refuse to write to the disk, or it may even de­
stroy data on your new disk. 

See also Directories and Paths. 

Lotus 1-2-3 and Symphony 

You can insert Lotus 1-2-3 or Symphony worksheets directly into your WordStar docu­
ments or use the worksheet as a data file for merge printing. For information, see 
Inserting text and files, and Merge printing. 

M 
Macros. See Shorthand. 

MailList 

MailList lets you easily create, update, and sort mailing lists and inventories by provid­
ing you with ready-made forms on which to enter your data. You can then print letters, 
reports, or lists using this data. For information, see the "MaiIList" tab section. 
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Margins 
The margins in a document specify the limits of the text area. WordStar has eight mar­
gins. 

MARGIN DEFAULT VALUE 

left margin 0.0" 

right margin 6.4" 

page offset .8" 

top margin .5" 

bottom margi n 1.33" 

header niargi n .33" 

footer margin .33" 

paragraph margi n off 

Refer to the following graphic to see how the margins affect your page. 
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You can change the margins in a document using the commands described below, or 
you can change the defaults using WSCHANGE. 

To see how the margins affect your printed page, use the page preview command. See 
Page preview. 

The Margins & Tabs dialog box 
When you choose Margins and tabs from the Layout pull-down, or press any of the 
margin control commands such as "Ol, the Margins & Tabs dialog box appears. This 
screen shows the current setting for each margin and for tabs, page length, and line 
spacing. It also shows the corresponding dot command for each setting. 

To change a setting, use Tab and Shift-Tab or the up and down arrow keys to move for­
ward and backward to the item(s) you want to change, then type a new number for the 
setting. For example, to set the left margin at half an inch, type .5. 

To exit the Margins & Tabs dialog box after making your changes, press FlO or"K. To 
exit and abandon your changes, press F2 or "U. See also Dialog boxes. 

WordStar adds the appropriate dot command in your document when you change a 
setting. You can also change a setting by typing the dot command directly in your doc­
ument. 

left and right margins 
The left and right margins are text boundaries. They're shown in the ruler line as L 
and R. 

You can set the left margin to any values between 0 and 25.4/1, and the right margin 
between 1/1 and 25.5/1, but there must be at least .2/1 between them. 

To change a margin, choose Margins and tabs from the Layout pull-down and move 
the cursor to the correct field, or press "Ol to set the left margin and "OR to set the 
right margin. Type in the new value for the margin and press FlO or "K to leave the 
screen. WordStar adds the appropriate .rm or .1m dot command to your file. For exam­
ple, if you type 4 as the new right margin, WordStar adds the dot command .rm 4". 
You can also type the dot command directly in your text. 

Note: If you set the left or right margin at the Margins & Tabs dialog box, WordStar 
adds the inch indicator to the dot command. If you type the dot command directly, be 
sure to type the inch indicator to set inches. Otherwise, WordStar assumes the number 
represents columns. For example, .1m 7 sets the left margin at column 7; .1m 7/1 sets it 
at 7 inches. 

TIP You can change your margins by moving them a specified distance from the cur­
rent margin. For example, .1m + .5" sets the left margin half an inch to the right of the 
current margin. With this method, all indented material maintains the correct rela­
tionship to the margin if you then change the original left margin. 

As an alternative, you can add a preformatted ruler line (.rr) to change the left and 
right margins. See Ruler lines. 
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To temporarily type outside the left and right margins, use the margin release com­
mand, "ox. This command turns the release on and off. When margin release is on, 
Mar-ReI appears in the status line. Margin release works only as long as the cursor is 
on the line and outside the margin. If you move the cursor back within the margin or 
to another line, margin release is turned off. 

Page offset 
Page offset is the amount of space between the left edge of the paper and column 1 of 
your text. The default page offset is .8 inch. If you want to print closer to the left edge 
of the paper, make the page offset smaller. 

For some documents, you may want to set different page offsets for odd and even 
pages. For example, if you'll be putting the pages in a binder, you'll want a bigger 
page offset on odd pages to leave room for the binder holes. 

~ small page offset ~Iarge page offset 

even page odd page 

Refer to the section above for information on typing numbers at the dialog box. 

To set different page offsets for odd and even pages, use .poe for even pages and .poo 
for odd pages. For example, .poe .5" and .poo 1" gives you a page offset of half an 
inch for even pages and an inch for odd pages. Use .po to set a page offset for all 
pages. 

Top and bottom margins 

Even though they aren't shown on the screen, the top and bottom margins affect the 
screen display by changing where page breaks occur. 
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Larger top and bottom margins result in fewer lines of text on a page and more fre­
quent page breaks. For example, on a normal 8Vz-by-11-inch page, if the top margin is 
.33" and the bottom margin is 1.33", the space for text is 11" minus 1.66", or 9.33". At 
the default line height, you can get 55 lines of text. Larger or smaller line heights de­
crease or increase the number of lines of text. 

The dot commands for changing the top and bottom margins are .mt and .mb. 

Header and footer margins 

The header margin is the space between the last header line and the first line of text. 
The header plus the header margin must fit into the top margin. If they are larger, your 
text may "creep" down the page as it's printed because there will be extra text lines 
on a page. 

The footer margin is the space between the last line of text (on a full page) and the first 
footer line. Again, to prevent creeping, the footer plus the footer margin must fit into 
the bottom margin. 

If you use a footer margin of 0, be sure to turn page numbering off (.op). 

Header and footer margins aren't displayed onscreen. To see how your margins will 
look when printed, use the page preview feature (if you have a graphics monitor). For 
information, See Page preview. 

The dot commands for header and footer margins are .hm and .fm. 

See also Headers and footers. 

Paragraph margins 

Paragraph margins set a separate left margin for the first line of each paragraph. This is 
useful for indenting the first line, or for outlines where you want the first line of a para­
graph to hang out to the left of the text. For information, see Paragraph margins. 

Math. See Block math, Calculator, and Merge printing. 

Maximum document size 
Files are stored in random-access memory (RAM) while you're working on them. 
When you're editing a document and less than 3K bytes of RAM are left, WordStar 
displays the message Large-File in the status line and stores some of the document in 
temporary files on disk. 

In general, a file is too long when it takes up more than one third of the total space on 
the disk. Because WordStar needs room for the temporary files it creates, the available 
disk space must be at least twice the size of the document. For example, if you are 
editing a 120K file, you must have an additional 240K free. If less space is available, 
WordStar may be unable to store all your work. You may have to erase other files in 
order to save it. 

See also Memory usage and Temporary files. 
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Memory usage 
WordStar is loaded into the computer's random-access memory (RAM). If there is 
enough memory (and you have asked WordStar to do so), the spelling dictionary is 
also loaded into RAM the first time you use the spelling checker. 

WordStar uses any remaining memory to hold the text being edited. The more mem­
ory that is available, the less WordStar needs to use the disk to handle the portion of 
the document that won't fit, and the faster the program runs. 

You can also use DOS to allocate more memory for buffers. This lets programs run 
faster. For more information, see your DOS manual. 

If your computer does not have enough available memory to load WordStar, it displays 
a message then returns you to the operating system. 

TIP To find out how much RAM is used by WordStar and your text and data files, 
choose Display RAM usage at the Other pull-down, or press? at the classic Opening 
Menu. 

See also Temporary files. 

Menus 
A menu is a list of commands from which you choose the task you want to do. 
WordStar has two types of menus: pull-down and classic. 

Pull-down menus 
Pull-down menus contain WordStar's most-used control commands and dot com­
mands. You'll see a menu bar at the top of the Opening and Edit screens. This bar lists 
the menus available at that screen. The menu bar on the Opening screen looks like 
this: 

WOl"dStal" Classic 
~F i le===Other~dd it ional=============OPEI'III'IG= 

I Press '1 for help I 
I ' I' 

AUTOLF. PDF .9k BOX .4k 
CRT86. DOC 7.7k CATHB. DOC 7.3k 
CUSTOMER. DTA .4k CUSTOMER. I'IDX .1k 
DRAFT. PDF .9k EI'IIJELOPE. L8T .Sk 
FIRST. DOC .Bk FXBIJ.PDF 1. 7k 

~II 
BROCHURE. DOC .Sk 
CIB511J. PDF 2.1k 
DIARY. BAK 3.6k 
EXTLI8T.8F .1k 
FXBS. PDF 2.8k 

Release S 
from MicroPro 

CAT8S. DOC 26k 
CITM8P. PDF 1. 9k 
DIARY.DOC 3.Sk 
FIRST .BAK .Bk 
GEM18X. PDF 1. 7k 

To display a pull-down menu at the Opening screen, press the first letter of the menu 
you want. You can move between menus using the right and left arrow keys or 
"S and "D. 
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When you're editing a file, you see the Edit screen: 

C:FILENAME.DOC P1 L9 C111 00" Insert Align 
rile Idit===Go to==Window Layout==Styfe==Other'===EDIT= 

! = • ----! ----! -----! ----. ----! ---- !----! ---- !----! ------R 

Trip Diary 

September 18 

What a wonderful city London is! We've been here two days and 
have been literally running from one tour to another. We're 
pretty exhausted, and look forward to eXp lor i ng a f'ew sights on 
our own. -

At the Edit screen, press Alt and the first letter of a menu. You can also press Alt and 
the Spacebar to move the highlighting to the menu bar. Use arrow keys to move the 
cursor to the menu you want. 

Once a menu is displayed, use the right and left arrow keys or "S and "0 to move 
between menus. To choose a command, use the up and down arrow keys or "E 
and "X to move the highlighting to a menu choice and press ~. In this example, 
if you pressed ~, you would save your file and return to the Opening screen. 

le==Other 
--! ----! ----! ------R 

Save file, resume editing AIS 
Save and naMe file An 

-Save f i I e, go to Open i ng screen XD 
Sept Save fI Ie, ex It WordStar IX: 

Abandon changes Alq 
What 
have Print a file ... 
pret Merge pr i nt a file ... 

n here two days and 
AI.. 0 another. We're 
AlPn ring a few sights on 

our 
ClJange drive/directory... AIL 

Copy a file... AIO 
De lete a file... AIJ 
Rename a File... All 

To leave a pull-down menu without choosing a command, press Esc. 

Prompts and Help 

EDIT= 

Some commands are followed by th ree dots (. .. ). Th is means that you'll be asked for 
information if you choose one of these commands. For example, if you choose Copy a 
file, you're asked for the name of the file to copy from and the filename to copy to. 

If you need help, highlight the command you want information about and press Fl. 
WordStar displays a screen of information about that command. 
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Accelerator commands 
Every pull-down command has an accelerator command listed next to it. For example, 
the accelerator command for opening a document file is D. An accelerator command 
is a shortcut. Instead of moving the highlighting to the function you want, you can 
press the accelerator command to choose it. 

You can choose any command from the pull-:down menu by pressing its accelerator 
command. The accelerator commands aUhe Opening screen are single letters. The 
accelerator commands at the Edit screen ate either control commands or dot com­
mands. The accelerator commands are the classic WordStar commands. 

Note: Some accelerator commands cari't be used while the pull-down menu is dis­
played. These commands appear dim onscreen. To use these accelerator commands, 
press Esc to leave the pull-down menu, then press the accelerator command. 

Once you've learned accelerator commands, you can skip most of the pull-down 
menus entirely. The accelerator commands work even when the menus are not dis­
played. 

A control command uses the Ctrl key. You hold down the key marked Ctrl and press 
the letter or letters of the command. For example, to boldface text, you hold down 
Ctrl and press PH. The control key is usually shown in text as a caret ("),for 
example, "PH. 

A dot command begins with a period and is on a line by itself. The period must be in 
column 1 of the line. Type the period, the two- or three-letter code, and whatever text 
or setting is required. For example, to turn right justification on, you would type 
.oj on. To put a header line into a document, you would type .he and the text of the 
header, for example, .he Casper Project: Initial Proposal. 

As you become more familiar with WordStar; you'll use qccelerator commands more 
often. At that point, you may want to learn more of WordStar's commands that don't 
appear on pull-downs. 

Classic menus 
When the help level is set at three or below, the pull-downs don't appe~r, and the 
classic Opening Menu is displayed when you start WordStar. It lists commands for 
operations such as editing, printing, and deleting files. 

The other classic menus are displayed when you are editing a file. When you open a 
document, the Edit Menu is displayed. It contains basic editing commands, including 
the commands to display the other classic menus. 

The Block & Save Menu lists commands for operations on blocks of text and files. The 
On screen Format Menu lists formatting commands. The Print Controls Menu lists com­
mands for printing enhancements. The Quick Menu lists commands for quick versions 
of editing commands, finding and replacing, math, and spelling checking. The Short­
hand Menu allows you to use shorthand versions of common command sequences or 
phrases. 
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To see the classic menus, hold down the etrl key and press the command forthe 
menu you want. For example, to see the Print Controls Menu, press "P. You can then 
choose any item on .the menu by pressing the appropriate letter, for example, B for 
boldface. Once you're familiar with the commands, you can press the entire com­
mand at once, for example "PB. 

To cancel a menu without choosing a command, press the Spacebar. 

You can choose which menus you see by changing the help level. For example, if you 
choose help level 3, all the classic menus are displayed, but if you choose help level 
2, the Edit Menu isn't displayed, so you have more room onscreen for your do<;:ument. 
Choose help level 4 to use the pull-down menus. No matter which level you choose, 
all the control commands work. 

If you're working in a protected file, the menus don't list any commands that can mod­
ify the file. Menus are also slightly different in nondocument mode. 

See also Help levels, Protecting a file, and Documents and nondocuments. 

Merge printing 
Merge printing is the process of inserting information into a document while it's being 
printed. The most common uses of merge printing are form letters and mailing labels. 
Other applications include invoices, contracts, reports, and any other standard docu­
ment that requires you to "fill in the blanks." 

To merge print you need a master document that contains both the text of the docu­
ment and the instructions for inserting the merged information. These instructions 
include variables and merge print dot commands. 

A variable is information that changes from one copy of a document to another, for 
example, a name or an address. When you merge pririt, WordStar merges the informa­
tion for the variables into the copies of the document. This merged information cah 
come from various places. It can come from a data file, such as a mailing list. Or you 
can specify the information when you print the document. You can use data files from 
Lotus 1-2-3, Symphony, dBASE, Quattro, and MailList, or you can create your own. 
For more information, see Data files. 

Variables 
Master documents contain variables wherever data is to be inserted. You assign a 
name to each variable. At the spot in the text where you want to insert variable data, 
type the variable name with ampersands (&) before and after it. For example, to insert 
the contents of the name field from your mailing list, type &name&. You can place a 
variable within a paragraph or on a line by itself. 

A variable name can contain up to 39 characters. You can use uppercase and lower­
case letters interchangeably, and you can put a space between the name and the 
ampersands. For example, &address&, &ADDRess&, and & address & are all the same 
to WordStar. You can't use a comma in a variable name, but you can use other punc­
tuation marks. 
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To use a variable name with two or more words, use a hyphen (-) or underline char­
acter (_) where the space would otherwise be, for example, &first-name&. 

If the data file doesn't contain any information for the variable, WordStar doesn't print 
anything in the document; for example, if you typed &name& &title&, and the person 
didn't have a title, WordStar would print just the person's name. 'However, if the vari­
able is the only text on a line, as in an address, the line probably also contains a 
carriage return. In this case, if the variable is empty, the printout will include a blank 
line. To avoid leaving a blank line, use the 10 (omit) option at the end of the variable 
name. (This is the letter o-uppercase or lowercase-not a zero.) 

For example, it's common for some addresses on mailing lists to have more lines than 
others. The 10 option allows you to use an extra line of address where needed without 
having a blank line for shorter addresses. The example below shows how an address 
would be specified with variable names without the 10 option, and how it would print 
for one mailing list record. 

&name& 
&addressl& 
&address2& 

Richard Kelley 
72 Live Oak Dr. 

&city&, &state& &zip& NovatQ, CA 95390 

The next example shows how the same record prints using the 10 option. 

&name& 
&addressl& 
&address2/0& 

Richard Kelley 
72 Live Oak Dr. 
Novato, CA 95390 

&city&, &state& &zip& 

For 10 to work, the variable name must be alone on the line in the master document. 

You can also include formatting information with the variable by inserting a slash (I) 
and the number of a format you have predefined. See Merge printing variable format-
ting and Merge printing variable number formatting. ' ' 

There are four predefined variables. Data for these variables is supplied by WordStar 
when you print; you need to enter only the variable name. 

VARIABLE 

&#& 

&_& 

&@& 

&!& 

DESCRIPTION 

Inserts the current page number. 

Inserts the current line number. 

Inserts today's date. The format for the date is the same as for the 
shorthand date and can be changed with WSCHANGE. 

Inserts the current time. The format for the time is the same as for 
the shorthand time and can be changed with WSCHANGE. 

If you use these variables in a document, be sure to print using Merge prin~ a file (M). 
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You can use variable formatting with predefined variables to control the way the data 
is inserted in your form documents. See Merge printing variable formatting. 

See also Shorthand. 

Merge print dot commands 
You type dot commands in the master document to tell WordStar the variable names 
and where to get the data that goes with them. If you use variable names in your docu­
mentbut don't define the variables, WordStar will print the variable name instead of 
the data. ' 

You cannot use a piece of data that is longer than 255 characters. In addition, the total 
number of characters in all the data inserted in anyone copy of the document during 
merge printing cannot be more than 4,000. 

Be sure to end each master document with a page break (.pa ~) so that each copy of 
the document starts printing on a new page. To check this, move the cursor to.end of the 
file (":QC). The cursor should be in column 1 on the line following the page break. 

To merge data from a data file into your document, use the .df and .rv commands in 
the master document. If you want to insert variable data into a document without 
using ~ data file, use the .av or the .sv dot-command in the master doc~ment. 

The .df (Define file) command This command tells WordStar what data file to use; 
for eXilmple, .df wslist.dta. Include a drive letter or directory path if necessary, for ex­
ampl~, .~f b:wslist.dta or .df \lists\wslist.~ta. 

You can use the change (or c) option to indicate that you need to change disks while 
printing, to. access the data file. For example, type .df b:wslist.dta change to say that 
the data file named WSLlST.DTA will be on drive B, but it's not there now. When you 
merge print, WordStar asks you to change the disk before it reads the data file. 

You can also use .df to tell WordStar that the data file uses a character other than the 
comma as the data separator. This is useful if your data contains many commas. For 
example, if the data file STAR.DTA uses the asterisk (*) as the data separator, you 
would type 

.dfstar..dta, * 
You can use dBASE, Lotus 1-2-3, Symphony, Quattro, or Mail List files as data files. See 
"Using data files from other programs," later in this section. 

The .rv (Read variable) command This command tells WordStar the variable names 
for the fields in your data 'file. The .df and .rv commands are always used together in a 
master do~ument, and .df must c9me first. The example below tells WordStar to read 
the data·from the WSLlST.DTA file and use it to replace the variables name, address1, 
address2, city, state, and zip. ' 

.dE wslist.dta 

.rv name,addressl,address2,city,state,zip 
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When you merge print, WordStar keeps putting data in copies of the form document 
until all the data is read from the data file. The .rv command must name all the fields 
in the data file, and name them in the same order in which they appear in each data 
file record. Even if data from a field is not used in a form document, you must name 
the field in the .rv command. You must also be sure that all records in the data file 
have the same number of fields. 

If the .rv command and the data file records don't correspond exactly, WordStar reads 
the wrong data. This happens because WordStar counts the number of variable names 
in the .rv command and then reads that many fields. Because fields can be separated 
either by commas or carriage returns, WordStar reads fields from the next line (or rec­
ord) if there aren't enough fields in the current line (or record). 

You can use more than one .rv to refer to the same data file. For example, the com­
mands below have the same effect as the one in the previous example . 

. df wslist.dta 

.rv name,addressl,address2 

.rv city,state,zip 

If you want to use only the first few fields from each record, use the .rv* command. 
This command tells WordStar to get the named fields, then go to the next line. (The 
.rv* command works with comma-delimited data files and won't work with data files 
that use a hard return to separate each field.) 

To use this command, type .rv* and specify all the fields up to the last field you want 
to include; for example, if each record in your data file contains 15 fields, but you 
want to use only items from the first, second, and fifth fields, type .rv* namel, 
name2, name3, name4, nameS. Note that you must list each field up to the last field 
you want. When you merge print, WordStar reads only the first five fields in each rec­
ord. 

Note: If you use more than one .rv* command in a single master document, be sure 
to give each variable a different name. For example, if you have a data file that lists the 
sales for each month, you could print a report listing sales for the quarter by using a 
separate .rv* command for each month in the quarter: 

.rv* distAl, distBl, distCl 

.rv* distA2, distB2, distC2 

.rv* distA3, distB3, distC3 

You can use .rv and .rv* commands to specify up to 4000 characters in a single mas­
ter document. 

The .av (Ask for variable) command This command tells WordStar to pause during 
printing and ask you for the data to use to replace a variable. For example, if you want 
to insert a different name in each document, type 

.av name 

When you merge print this document, WordStar pauses in each document and asks 
NAME? 
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You then type the name and press ~. Wherever &name& appears in the document, 
WordStar replaces it with the data you typed. 

This is a convenient for contracts, where you can specify the person's name once at 
the beginning of the file, and have WordStar fill in this name wherever the variable 
occurs in the file. With the .av command, you can also include a promptfor WordStar 
to display when it asks for the data. This prompt could be instructions to whoever 
prints the file. Type the prompt after the .av and before the variable name. Enclose it in 
quotation marks and follow it with a comma. To add a prompt to the example above, 
you cou Id type 

.av "Type the full name of the client: ", name 

If you use quotation marks within the prompt, enclose the prompt in apostrophes: 

.av 'Enter the "Schedule G" rate: " rate 

A prompt or question and its answer cannot be more than one line long because the 
cursor will stop when it reaches the right edge of the screen. This limits the size of 
answers, so if you want to leave room for longer answers, keep your prompts short. 

TIP For a long prompt, use the .dm command to display the prompt message, then 
use .av with no message or a short message. See Messages while printing. 

When WordStar encounters the .av command, it displays the Print wait message in the 
status line. To enter the data for the variable, choose Print a file from the File pull­
down, or press P at the classic Opening Menu or "KP at the editing screen. 

The .sv (Set variable) command This command allows you to include in a master 
document the data you want to replace a variable with. It is useful in documents 
where a frequently used word changes from copy to copy of the document. Type .sv 
followed by the variable name, a comma or equal sign, and the data. 

For example, you might have a contract between two people, referred to in the master 
contract as partyl and party2. Each time you print the contract, you want to use new 
names. At the beginning of the document, enter two .sv commands. Each time you 
need a new contract, edit the master document to enter the appropriate names in the 
.sv command. For one contract, the commands might read 

.sv partyl, Roberta Kachinsky 

.sv party2, Anna Marie Casini 

WordStar ignores any spaces after the comma or equal sign. If you want to include 
leading or trailing spaces in data in the .sv command, enclose the variable in quota­
tion marks or apostrophes. In the example below, there are four blank spaces before 
the name, so four spaces will be inserted at the beginning of the data. 

.sv company = " MedCom,lnc." 
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The .ma (Math) command This command enables you to perform calculations while 
you are merge printing. It lets you define a variable in terms of an equation that uses 
information from other variables. For example, you could total the dollar amounts of a 
customer's monthly purchases and insert a different total for each customer. 

The .ma command is used in the following format: 

.ma variable = equation 

The equation is written like equations used with the onscreen calculator, except that 
you can use merge print variables. So, the merge print variable that contains the total 
amount of a customer's purchases could be calculated during merge printing by using 
the dot command shown below . 

• ma total = &item1 & + &item2& + &item3& + &item4& 

You can use the comma instead of the equal sign, as shown below . 

• ma total,&item1 & + &item2& + &item3& + &item4& 

Notice that the merge print variables to the right of the comma (or equal sign) are sur­
rounded by ampersands (&), while the variable to the left of the comma (or equal sign) 
is not. This is because the ampersands mean "substitute the data here." 

When you print, WordStar reads data for the variables iteml, item2, item3, and 
item4 from a data file, adds them, and inserts the total in the text as the data for the 
total variable. You can then go on to use the total variable in another equation 
(&grandtotal& = &total& * .06 + &total&). You also need to use the .df and .rv 
dot commands. (As an alternative, you could supply data without a data file using 
the .av or .sv dot command.) See Calculator. 

The .pf (Print time reformatting) command Your master document includes variable 
names that are replaced by actual data when you print. The data may be different 
lengths in each copy of the document, so the length of lines changes as data is in­
serted. WordStar can align each document at print time to format the text around the 
data . 

• pf on aligns every paragraph in the document. .pf off turns print time reformatting off . 
• pf dis aligns paragraphs at WordStar's discretion, meaning that WordStar reformats 
only the paragraphs where data has been inserted in a variable. The aligning begins at 
the line where the insertion occurred .• pf dis is the default; if you don't use the .pf 
command in your form document, WordStar will use discretionary (dis) reformatting. 

The example below shows text from a master document and actual printed text for one 
copy. The data in the printed document is longer than the variable names in the mas­
ter. WordStar reformatted the text as it printed so it stayed within the margins. 

This contract is entered into on the &day& day of &month&, &year& between 
&party1 & and &party2&. 

This contract is entered into on the twenty-seventh day of 
September, 1988 between Roberta Kachinsky and Anna Marie Casini. 
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If you are printing data that may extend beyond the text margins, you may want to use 
.pf off so that your lines won't wrap. As an alternative, you can use .aw off to mark 
sections of text that you don't want al igned (see Aligning text). 

TIP Reformatting may change page breaks. Use the .cp command if you want to 
keep certain lines of text together on the same page. See Page breaks. 

When WordStar reformats, it uses the margins and line spacing that are in effect at that 
point in the document. 

Printing a form document 

To merge print, choose Merge print a file from the File pull-down. The classic com­
mands are M at the Opening Menu or "KP at the editing screen. Type the master docu­
ment name and press FlO or "K to begin printing. See Printing a file for information 
on print options. 

If you use the Print a file command to print a document that contains merge print vari­
ables and dot commands, WordStar does not substitute data for variables, and the .av, 
.SV, .df, .rv, and .rna dot commands do not work. 

Using data files from other programs 

You can use files from Lotus 1-2-3 (all versions except 3), Symphony, Quattro, dBASE 
II®, III, or III Plus, and MailList as data files for merge printing. 

To specify the worksheet or database, type .df filename in your WordStar master docu­
ment, using the database or worksheet filename. WordStar treats the rows and cells in the 
spreadsheet as records and fields, respectively. 

When you use a spreadsheet as a data file, Wordstar ordinarily uses the entire spreadsheet 
and window 1 (or the MAIN window for Symphony). You can specify a different range or 
window. For example, to use just the range H3 to T33 and window 2, type .df filename, 
h3 ... t33, 2. Keep these points in mind: 

• You can specify the range by using range names or cell numbers. If you use cell num­
bers, you can type an asterisk to represent the last cell in the worksheet; for example, 
A3 .. * specifies a range from A3 to the end of the worksheet. 

• If you want to specify just a window, type two commas before the window number, for 
example, .df filename,,2. 

• If the data file is on a separate d:,k and you want Word Star to prompt you to insert the 
disk at print time, use the c option. Type the c after the filename and before the range 
or window, for example, .df filename c, he .. t33. Don't type a comma before the c. 

• If you specify a Symphony worksheet and don't specify a window, WordStar looks for 
the window called MAIN. If you've deleted or renamed this window, be sure to specify 
a different window name. 

After you use the .df command to specify the data file, use the .rv command to name the 
variables. 
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If you specify a dBASE data file, type .rv* and don't type any variable names. 
WordStar automatically picks up all the dBASE names for the fields. Be sure the 
variables in the text of the master document match the dBASE field names. 

dBASE III Plus™ lets you create memo fields of unlimited length. You can name a 
memo field as a variable and thus include a customized sentence or paragraph in each 
letter at pri nt ti me. 

If you specify a worksheet as a data file, you can name the variables as in a regular 
.rv command, or you can use the * option and specify selected columns, rows, or 
cells from the worksheet. 

To specify columns, type a dollar sign ($) in front of each column letter; for example, 
if you want to use only information from columns C, J, and M, type .rv* $C,$),$M. 

If you're using a column-major (vertically based) worksheet, specify the selected rows, 
for example, .rv* $1,$5,$7,$25. You can't select both columns and rows in the same 
.rv* command. 

When you're specifying either columns or rows, you can also specify a specific cell 
reference, for example, .rv* $C,$),$K,$T$33. This is useful if your worksheet con­
tains a constant, such as an hourly wage or a unit price, that you want to use in all the 
form letters. 

Note: When you type the variable names in your master document, be sure to include 
the dollar sign before the row and before the column, for example, &$)& or 
&$T$33&. 

By using data from dBASE or worksheet files, you can print reports from spreadsheet 
results, use 1-2-3 as a mailing list manager, compile reference lists for footnotes and 
bibliographies, or print invoices based on data in these files. See the "Applications" 
tab section for more information. 

For information on MailList data files, see the "MaiIList" tab section. 

See also Command files, Data files, Merge printing conditional commands, Merge 
printing variable formatting, Merge printing variable number formatting, Messages 
while printing, and the ''l\pplications'' tab section. 

Merge printing conditional commands 
WordStar's conditional merge print dot commands allow you to use the same master 
document to produce letters that contain different types of data, depending on condi­
tions you set. For instance, you can use one master document and one data file to 
generate letters that each contain one of four customized paragraphs depending on 
where the recipient lives. 

There are three conditional merge print dot commands: .if for "if," .ei for "end if," 
and .el for "else." -' 
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The IF condition 
WordStar usually determines if a condition is met by comparing one item with an­
other. The items can be data items taken from a data file oritems that never change 
(constants). For example, you can send letters only to clients who purchased more 
than $1000 worth of merchandise, or only to clients who live i'n New Jersey. Typically, 
one item is a data item and the other is a constant, but you can use any combination. 

WordStar can compare items to determine whether or not they are the same (for text) 
or equal (for numbers), or if one comes before or after the other in alphabetical or 
numerical order. You tell WordStar how to compare items by using one of the follow­
ing symbols, called operators. 

OPERATOR 

< 
> 
<= 
>= 
<> 
#= 
#> 
#< 
#>= 
#<= 
#<> 

MEANING 

is the same as 

comes before (alphabetically) 

comes after (alphabetically) 

comes before or is the same as (alphabetically) 

comes after or is the same as (alphabetically) 

is not the same as (alphabetically) 

is equal to (numerically) 

is greater than (numerically) 

is less than (numerically) 

is greater than or equal to (numerically) 

is less than or equal to (numerically) 

is not equal to (numerically) 

The most common way to specify a condition to be evaluated with the .if command is 
to use the following format. 

.if item 7 operator item2 

For example, you can compare a merge print variable to a constant (a word, phrase, 
or number that does not change) as shown below . 

. if &PET & = dog 

In this example, the condition is met if the data item for the variable PET is dog. 

The operators that begin with the # symbol are used with numbers rather than with 
words. It is possible for either number item being compared to contain nonnumeric 
characters, but before WordStar proceeds with the comparison, it removes all the non­
numeric characters except the minus sign (-) and the period (.). 
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So, numerically the following items are equal because WordStar ignores all non­
numerals. 

12.45 
$12.45 
abel d2.des45 

If each of these three items is in the &amt& field, and you use the following dot com­
mand, all three items meet the condition . 

. if &amt& # = 12.45 

However, if you use the operator without the # symbol, only the first item would meet 
the condition because numerals are considered to be alphabetic characters that come 
before A. Generally, it is best to use the operators with the # symbol when comparing 
numbers. 

You can also compare one data item with another, as in the examples below . 

.if &VARl & > &VAR2& 

.if &VAR1 & #> &VAR2& 

The condition in the first example is met if the data for VARl comes after the data for 
VAR2 in alphabetical order. In the second example, the condition is met if the number 
in VARl is greater than the number in VAR2. 

Normally, WordStar ignores any spaces that come between the operator and the fol­
lowing item. The following commands are equivalent. 

.if &PET & = dog 

.if &PET& dog 

In order for two items to be the same (=), they must have exactly the same characters 
(differences in uppercase and lowercase are ignored). If you know that a data item 
from a data file has spaces in front of the letters, you need to include the leading 
spaces in the comparison. To include spaces, enclose both the variable and the con­
stant in quotation marks (or apostrophes). Thus, the condition shown below will be 
met only if the data in &PET & is dog preceded by eight spaces . 

. if /I &PET &" = II dog" 

To use quotation marks in the constant along with leading spaces, enclose the entire 
item in apostrophes. To use an apostrophe in the constant along with leading spaces, 
enclose the entire item in quotation marks, as in the example below . 

. if /I &PET &" = II dog's" 

You cannot have quotation marks, apostrophes, and leading spaces in the same con­
stant. If the constant has no leading spaces, you can use quotation marks and apos­
trophes freely anywhere. 
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Words are compared in alphabetical order. The word "cat" comes before the word 
"catalog" in alphabetical order, so the following conditions are true: 

.if cat < catalog 

.if catalog > cat 

In alphabetical order, numbers come before the letter A. For example, the following 
condition is true: 

.if 2 < apple 

You can also use the .if command with just one variable name, as in the example 
below: 

.if &PET& 

Notice that there is no operator. The condition is met if the data for &PET& is not zero 
and not blank. 

The END IF command 

The .if dot command is followed by the action to be taken when the condition is true. 
If there is text after the dot command, that text will be printed only if the condition is 
true. If there is another dot command after the .if command, the new dot command 
will be performed if the condition is true. To indicate the end of the conditional text or 
commands, use the dot command .ei (End If). 

What comes between .if and .ei? 

Almost anything can come between a .if command and its corresponding .ei. In the 
following example, a paragraph of text is printed in the letter when the condition spec­
ified in the .if command is true . 

. if &PET& = dog 
We know that your dog will love new BEEFO dog food, made from the highest 
quality beef alld beef by-products. As an inducement for you to come in and look 
over our new facility, we are offering a 25-pound bag of BEEFO for just 10 cents, this 
week only . 
. ei 
.if &PET & = cat 
Your cat will just love new FISHO cat food, made from real fish and aromatic herbs. 
Come in, look over our new f~cilities, and take home a 50-pound bag of FISHO for 
just 25 cents, this week only . 
. ei 

If the client has a dog, the first paragraph will print in the document. If the client has a 
cat, the second paragraph will print. 

You can also insert text from other files; for example, a retailer could include free 
delivery information only for customers within certain ZIP codes. 

TIP By keeping often-used conditional paragraphs in their own files, you can easily 
insert them into different master documents. 

174 



MERGE PRINTING CONDITIONAL COMMANDS 

The ELSE condition 

The previous example uses two IF statements to take advantage of two possible condi­
tions (that is, if the variable PET is dog or if it's cat). You can combine these two IFs 
into one. First, in English: 

If the data for the variable PET is dog, insert a paragraph about dog food, or else, insert 
the paragraph about our low prices for all pet food. 

Notice that there is a slightly different meaning here. The second paragraph will be in­
serted if the variable is anything other than dog, for example, if it's fish or if the data is 
missing. 

The phrase "or else" translates into the .el merge print dot command as shown below . 

• if &PET & = dog 
We know that your dog will love new BEEFO dog food, made from the highest 
quality beef and beef by-products. As an inducement for you to come in and look 
over our new facility, we are offering a 25-pound bag of BEEFO for just 10 cents, this 
week only • 
• el 
We are proud to carry quality pet food at low prices. As an inducement to visit our 
new store, present this letter to get 10% off your first purchase • 
• ei 

The .GO command 

The .go top/bottom command tells WordStar to skip to the beginning or end of a file 
and then resume printing. It can be useful for conditional merge printing as shown in 
the example below . 

.if &PET & < > dog 

.go bottom 

.ei 

In this example, if the data for the variable &PET& is not dog, the rest of the text in the 
master document is not printed in the current letter, and WordStar skips to the bottom 
of the file before it starts printing again. Add these commands before any text if you 
want a document printed for certain people only. 

The command .go t is the same as .go top. The command .go b is the same as .go 
bottom. 

Nested .if commands 

You can use conditional merge print commands to have WordStar choose among three 
or more alternatives by nesting the commands. For example, you might want to have a 
special dog paragraph in your letters to dog owners, a special cat paragraph to cat 
owners, and a general paragraph to all the other pet owners on your list. So your con­
ditions are 

If the data for the variable &PET& is dog, insert the file DOG. DOC; or else, if the data is 
cat, insert the file CAT. DOC; or else, insert the file ANIMAL.DOC. 
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The commands for the conditions are shown below . 

. if &PET& = dog 

.fi dog.doc 

.el 

.if &PET& = cat 

.fi cat.doc 

.el 

.fi animal.doc 

.ei 

.ei 

Every .if command must have a corresponding .ei command. The .if command mayor 
may not have a corresponding .el command. 

TIP When you type nested conditional commands, you may want to indent each 
nested condition. Indenting can make it easier to work with nested IFs. However, if 
you indent, you must delete the indents before you print, because all dot commands 
must begin in column 1. The example below shows how the commands shown above 
appear with indenting. Note that each column begins with the .if command and ends 
with the .ei command . 

. if &PET & = dog 

.fi dog.doc 

.el 

.ei 

.if &PET& = cat 

.fi cat.doc 

.el 

.fi animal.doc 

.ei 

The example below shows another way to use nested I Fs. You want to send a letter to 
everyone on your list who lives in St. Louis, Missouri except for the people who live 
around the University of Missouri. ZIP codes in St. Louis range from 63101 to 63199, 
and the ZIP code for the university is 63121. You would create a command file with 
the following conditional merge print commands . 

. if &zip& #< = 63199 

.if &zip& # > = 63101 

.if &zip& #<> 63121 

.fi letter .doc 

.ei 

.ei 

.ei 

The first .if command eliminates ZIP codes greater than 63199, and the second elimi­
nates codes less than 63101. The third .if eliminates the 63121 ZIP code. Only ZIP 
codes that meet all three conditions generate letters. All others are ignored. 

See also Command files, Nesting and chaining, and the "Applications" tab section. 
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Merge printing variable formatting 
Variable formatting allows you very close control of the appearance of your form doc­
uments, especially those that use merge print variables in tables or charts. 

For variable formatting, you must first define formats for variables. Use the .sv dot 
command to define each format. You can then include any format with any variable in 
the master document. After the variable name, but before the closing ampersand, type 
a slash (/) and the format name. For example, if you define a format named 6 and you 
want to use it with the name variable, when you enter the variable in the master docu­
ment, type &name/6&. 

You cannot use variable formatting and the /0 option with the same variable. See 
Merge printing. . 

The sample format definition below defines the format named 6 . 

• sv 6 = LLLLLLLLLLLLLLLLLLLL 

After the .sv comes the format name (6), followed by either an equal sign or a comma, 
then the format definition. You can use any digit or letter (except the letter 0) as a for­
mat name. WordStar does not distinguish between uppercase and lowercase letters in 
format names. 

The number of characters in a format definition sets the number of spaces in the for­
mat. Each character in the definition represents one character space. In the example 
above, the format is 20 spaces wide because there are 20 Ls. So the total number of 
spaces and characters used to replace the variable in the form document is 20. 

The first letter in a format definition sets how the data will be justified within the for­
mat. It is either L, R, or C. L means that data is to be inserted into the format flush left, 
or left-justified. R means that data is to be inserted flush right, or right-justified. 
C means that the data is to be centered in the format. Again, WordStar does not dis­
tinguish between uppercase and lowercase letters. If the format definition does not 
begin with one of these characters, then WordStar assumes that the format is for num­
bers. See Merge printing variable number formatting. 

If a data item is longer than the format, WordStar truncates the data item. If the field is 
left-justified or centered, WordStar truncates any data left over at the right end of the 
data item. If the field is right-justified, WordStar truncates from the left end of the data 
item. 

If the first character is L, each L in the format definition will be substituted with data 
or, if there is no data for the corresponding position, with a space. If the first character 
is R, each R will be substituted with data or space, and likewise for C. 

Any character (including a space) that is different from the first character in the field 
format definition is printed literally even if there is data for that position. For example, 
if the format is LLXL and the data item is 1234, WordStar prints 12X4. The X is dif­
ferent from the L so it is printed literally. 
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This process is called masking because characters in the format definition mask out 
characters in the data item. The most common masking character is the space. You 
can use spaces in a format definition to the left of the first L or R in the definition. (Any 
other character used to mask can't be the first character in the format definition.) In 
order to include leading spaces in the format definition, you must enclose the defini­
tion in apostrophes or quotation marks. In the example below, there are two spaces 
between the initial quotation mark and the first L. 

.sv 6 =" LLLL" 

If the data is 1234, the variable in the form document is replaced with: 

(two spaces)34(two spaces) 

The leading spaces in the format definition mask out the first two characters of the data 
item. The last two Ls in the format definition are replaced with spaces because the 
field is six characters long and the data is only four characters long. 

Masking works only with left- and right-justified fields. When C is the first character in 
the definition, characters oth.er than C are inserted into the data but do not replace any 
characters in the data. 

Merge printing variable number formatting 
You can use variable formatting to control the appearance of numeric data items that 
replace variables in your form documents. You can read the numeric data from a data 
file or use the Word5tar .rna command to calculate numbers during merge printing. 

First, you must set up formats for numeric variables using the .sv dot command. You 
can then include any format with any variable in the master document. After the vari­
able name, but before the closing ampersand, type a slash (I) and the format name. 
For example, if you set a format named 3 and you want to use it with the amount vari­
able, when you enter the variable in the master document, type &arnount/3&. 

The sample number format definition below defines the format named 3 . 

• sv 3 = $$,$$$.99 

After the .sv comes the format name (3), followed by either an equal sign or a comma, 
then the format definition. You can use any digit or letter (except the letter 0) as a for­
mat name. Word5tar does not distinguish between uppercase and lowercase letters in 
format names. 

The number of characters il"J a format definition sets the number of spaces in the for­
mat. Each character in the definition represents one character space. In the example 
above, the format is nine spaces wide because there are nine characters. 50 the total 
number of spaces and characters used to replace the variable in the form document 
will be nine. 
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Numbers are always right-justified in their formats. Several different symbols are used 
in number formats to specify what to do with any extra spaces at the left of the for­
mat (for example, print zeros or print spaces) and where to put decimal points and 
commas. 

The chart below shows characters you can use in a number format and how they 
work. 

CHARACTER 

9 

z 

* 

$ 

DESCRIPTION 

Substitutes a digit here. If there is no digit in the data item for this 
position, substitutes a zero. For example, if you use the format 
99999.99, the data 74.97 prints as 00074.97. 

Substitutes a digit here. If there is no digit in the data item for this 
position, or if the digit is a leading zero, substitutes a space. For 
example, if you use the format ZZZZZ.ZZ, the data 74.97 prints 
as (three spaces)74.97. 

Substitutes a digit here. If there is no digit in the data item for this 
position, or if the digit is a leading zero, substitutes an asterisk (or 
a zero after the decimal point). For example, if you use the for­
mat ***** .**, the data 74.97 prints as *** 74.97 and the data 
74 prints as *** 74.00 
Substitutes a digit here if the digit is not a leading zero; other­
wise, substitutes a space. Places a dollar sign to the left of the 
first digit. For example, if you use the format $$$$$.99, the data 
74.97 prints as (two spaces)$74.97. Note that in this example, 
you can only use numbers up to 9999.99. In other words, with 
the $, you must have one more character in your numb~r format 
than the largest number you expect to have as data. 

Substitutes a digit here if the digit is not a leading zero; other-' 
wise, substitutes a space. Places a minus sign directly before the 
first digit if the number is negative. For example, if you use the 
format -$$$$$.99, the data -24.41 prints as (two spaces) 
-$24.41. As with the $, be sure to leave enough spaces in the 
format for the largest number you expect to have plus the minus 
sign and the $ if you use it. 

Puts the decimal point here. If the data has more decimal places 
than the format, the data is truncated (the extra digits are not 
printed). For example, if you use the format 9999.999, the data 
4.7885 prints as 0004.788. If the data does not include a decimal 
point, the whole number is printed to the left of the decimal 
point. For example, with the same format, the data 1111 prints as 
1111.000. 

Puts a comma here. For example, if you use the format 99,999, 
the data 7497 prints as 07,497 and the data 74 prints as 00,074. 
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CHARACTER 

( ) 

DESCRIPTION 

Puts parentheses around a number if it is negative; otherwise, 
substitutes spaces. The parentheses must be the first and last 
characters in the format definition. For example, if you use the 
format (****.99), the data -74.97prints as (two spaces)(74.97). 
As with the $ and -, be sure to leave enough spaces in the format 
for the largest number you expect to have plus the minus sign 
and the $ if you also use it. For example, in order for the data 
-12345.67 to print correctly as a dollar amount, the format must 
have six characters within the parentheses before the decimal 
point. The shortest format for this example would be 
($$$$$$.99) . 

The characters above are the only characters you can use in a number format. If you 
use other characters, the results are unreliable. 

If data is longer than the format specified for it (except for extra digits after the decimal 
point), WordStar prints a series of question marks the width of the format in the form 
document. 

Messages while printing 
You can use the.dm and .cs dot commands in a document to affect the screen display 
while you print the document. They are useful for displaying messages that explain 
what's going on while you're printing .. cs clears the screen and .dm displays a mes­
sage. These commands allow you to do the following: 

• Show how much of a document has been printed. 

• Display the data that's being inserted into variables during merge printing. 

• Give reminders and instructions to the person doing the printing. 

For example, you can type the following dot command at the beginning of Chapter 3 
of a document. 

.dm Chapter 3 is being printed now. 

The following example shows how you can use these commands in merge printing 
when you have a long question or answer . 

• cs Type the data for "union name" after the question mark • 
• av "? ",union-name 
.dm Thank you. 
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During printing, when WordStar encounters the .cs command it clears the screen and 
displays 

Type the data for "union name." after the question mark. 
? 

After you type the data and press ~, it displays 

Thank you. 

Messages are displayed only on the Printing screen. You don't ordinarily see these 
screens during background printing. To display the Printing screen, choose Print a file 
from the File pull-down or press P at the classic Opening Menu or "KP at the editing 
screen as soon as printing begins. If you display messages for most of your files, you 
may want to use WSCHANGE to change the background printing default. 

See also Merge printing. 

Microjustification 
When text is justified, microjustification spreads the white space between words (and 
sometimes between the letters of each word) as evenly as possible. 

This makes text look more even, but on some printers, it slows down printing. 
WordStar turns microjustification on or off depending on your printer. 

If you have a slow printer, but you want microjustification, use the .uj on command 
to turn microjustificatioh on. To turn it off, type .uj off. To let WordStar determine 
whether to use it, type .uj dis. 

You can use PRCHANGE to permanently change the default for each of your printers. 

Moving text 
After you mark a block of text, you can move it to a new location in the same fi Ie or to 
a file in a different window. 

To move text in the same file, place the cursor where you want the text to appear, and 
choose Move block from the Edit pull-down or press "KV. To move text from a dif­
ferent window, choose Move block from other window from the Window pull-down 
or press "KG. For more information, see Blocks and Windows. 
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N 
Naming a file. See Files. 

Near letter quality printing 
Many dot matrix printers have both a draft quality print and a high quality print that is 
referred to as "near letter quality" or "correspondence quality." 

I{your printer has this capability, you can turn letter quality off by typing .lq off at the 
beginning of the file. This is useful for quickly printing a draft of your document. To 
turn letter quality on for the final draft, type .lq on. Keep in mind that near letter 
quality printing is often slower than draft quality printing. 

The default setting is .Iq dis (discretionary), where the setting is determined by the 
fonts you use. You can change the default with PRCHANGE. 

TIP .Iq 0 (zero) is the same as .Iq off; .Iq 1 (one) is the same as .Iq on. 

Nesting and chaining 
Use the .fi dot command to link files for printing. You can chain them so that they 
print one after the other, or nest them, inserting one inside the other. The files are con­
nected only for printing; their contents remain separate. (For information on 
permanently adding a copy of one file to another, see Inserting text and files.) 

TIP Use .f; to create indexes and tables of contents for a document that is made up 
of several files. 

To insert a file, place the cursor at the start of the line where you want the inserted file 
to print, and type .fi followed by the name of the file you're chaining or nesting. If the 
file is on a different drive or directory, include the drive letter or directory path: 

.fi b:part2.pkg 

.fi \doc\part3.pkg 

.fi d:\work\part4.pkg 

If the file is on a different disk, use the c (change) option to tell WordStar to pause dur­
ing printing and prompt you to insert the new disk. For example: 

.fi b:addendum.pkg c 

To chain files, put the .fi command for the next file at the end of each file. If you want 
the next document to begin on a new page, add a .pa command to insert a page break 
just above the .fi command. See Page breaks. 

TIP WordStar automatically numbers all the pages in order. If you want an inserted file 
to use different page numbers, assign a starting page at the beginning of the inserted file. 
For more information, see Page numbering. 
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To nest files, type the .fi command where you want the next file to be inserted into the 
present one. Once the nested file is printed, printing of the original file resumes where 
it left off. 

You can nest one file inside another, and those two inside a third, and so on, up to 
eight levels. 

Note: The nesting level is very important when you merge data files and documents. 
The printout repeats only the file containing the .df command and any files nested 
within this file. 

To print the files, type the name of the first file in the series. The .fi commands tell 
WordStar to insert all the other files on cue. 

You can create a command file containing only the .fi commands instead of putting 
the commands at the end of each document. For example, if you have a document 
with five chapters, you can create a command file called BOOK.ALL, as shown 
below: 

. fi b:chapter 1 

.fi b:chapter2 

.fi b:chapter3 

.fi b:chapter4 c 

.fi b:chapter5 

To start the printout, print the command file, BOOK.ALL. WordStar reads the file and 
prints each chapter on cue. In this example, Chapters 1, 2, and 3 are on the first lib:" 
disk, and chapters 4 and 5 are on the second. The c option tells WordStar to prompt 
you to change disks. Because you need to change the disk in drive B while printing, 
the BOOK.ALL command file can't be on drive B. 

See also Command files and Merge printing. 

Newspaper-style columns. See Columns. 

Nondocuments. See Documents and nondocuments. 

Numbering. See Line numbering, Paragraph numbering, Paragraph margins, 
and Page numbering. 

o 
Opening a file. See Creating a document or nondocument, Editing, and Speed 
Write. 
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Overprinting 
You can overprint a character using the "PH command, and you can overprint a line 
using the "P ~ command. These commands are described below. 

COMMAND 

"PH 

p 
Page breaks 

DESCRIPTION 

Two characters are printed in one space. After you type the first 
character, press "PH. The symbol "H appears at the cursor posi­
tion. Then type the second character. When you print the docu­
ment, the character after the "H prints on top of the previous char­
acter. 

For example, if you type c, then press "PH, then type I, you'll see 
c"H I onscreen, but it will print as ¢. 
To overprint more than two characters, press "PH again before 
each additional character. 

Note: If you frequently overprint with the same characters you can 
use WSCHANGE to have WordStar automatically overprint the 
characters. Once you enter a character into the auto backspace 
table, WordStar automatically adds "PH to the character so that it 
overprints the previous character. 

Two complete text lines are printed on top of each other. First, type 
either of the lines. Don't let the line wrap to the line below; in­
stead, end the line by pressing "P and then ~. A hyphen appears 
in the flag column. Type the next line, and end it by pressing ~. 
When you print, the two lines print on the same line. 

TIP To make sure the two lines line up correctly, turn micro­
justification off (.uj off). For more information, see 
Microjustification. 

To overprint more than two lines, press "P ~ between the lines to 
be overpri nted. 

A page break is the division between two pages. It's shown onscreen as a line across 
the screen ending with a P in the flag column. This line doesn't print. The line right 
after the onscreen page break prints as the first line of the next page. 

WordStar inserts page breaks automatically when the text fills a page. If you're using 
newspaper-style columns, WordStar inserts the page break when the last column is 
filled. These are "soft" page breaks. If you later add or delete text, the soft page breaks 
move accordingly. 
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You can insert hard page breaks anywhere you want to begin a new page. Hard page 
breaks stay with specific text and don't move when you edit the document. 

To insert a hard page break, place the cursor on the first line you want to appear on 
the next page, and choose New page from the Layout pull-down. WordStar inserts a 
.pa command and a page break indicator line in your text. (You can also type the dot 
command directly in your text.) 

To delete a hard page break, delete the .pa command. 

You can also insert a conditional page break, which tells WordStar to insert a page 
break only if necessary to keep a certain number of lines together. Use conditional 
page breaks to keep a table or chart on one page or to prevent a paragraph from 
breaking at the wrong place. 

To insert a conditional page break, place the cursor on the first of the I ines you want to 
keep together, and choose Conditional new page from the Layout pu II-down. Then 
type the number of lines you want to keep together. WordStar inserts the .cp com­
mand in your text. (You can also type the dot command directly in your text.) For 
example, .cp 4 keeps the next four lines together on the same page. If there isn't 
enough room for all four lines to print on this page, the lines will move together to 
the next page. 

Remember that if you chain or nest files, or use print formatting commands for merge 
printing, the soft page breaks onscreen may not match those on the printout. This is 
because WordStar has no way of knowing how many lines are in the inserted files or 
data. 

See also Page length and Columns. 

Page length 
Page length is the total length of the paper. WordStar is set up for standard 8V2-by-11-
inch paper. If you use paper of a different size, change the page length setting. 

To change the page length, choose Margins and tabs from the Layout pull-down or 
press "OL. Move the cursor to the Page length field and type the new number in 
inches. Press FlO or "K when you're finished. WordStar adds a .pl dot command to 
your file. (You can also type the dot command directly.) For example, .pI14" sets the 
page length to 14 inches for legal-size paper. 

You can use WSCHANGE to change the default page length. 

TIP If you have standard margins and line height, you'll get 55 lines of text per 
page. To change the number of lines of text you can fit on a page, change the size of 
the top or bottom margins. You can also use larger or smaller line heights. For more 
information on changing the amount of text per page, see Line height and Margins. 

See also Page breaks. 
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Page numbering 
WordStar keeps track of a document's page numbers during editing and printing. 
When you edit, the current page number is displayed in the status line, following the 
letter P. Page breaks show where each page ends and the next begins. (Page breaks 
and numbers are not used with nondocuments.) 

To move to a specific page, choose Go to page from the Go To pull-down or press 
"QI. Then type the page number and press ~. Instead of typing the page number, you 
can type + to go to the next page or - to go to the previous page. If you type a num­
ber after the + or -, the cursor moves forward or backward that number of pages. 
For example, "QI + 3 moves the cursor forward three pages. 

To change the page number that will be printed on a page, use the .pn dot command. 
Type .pn followed by the new page number; for example, .pn 21 sets the page number 
to 21. 

This command is useful if you split a document into several files and want to set con­
secutive page numbers from one file to the next. It can also restart page numbers at 1 
after a table of contents or another unnumbered section. You can use as many .pn 
commands in a file as you want. 

If you use the .fi command to insert another file during printing, or if you use print 
time reformatting for merge printing, page numbers on the screen won't necessarily 
match those printed because WordStar doesn't know how many pages are in the 
inserted fi Ie. 

WordStar usually prints the page number in the footer line. Four dot commands con­
trol the printing of this default page number. These dot commands are described 
below. 

COMMAND 

.pc n 

. op or 

Omit page numbering 
(on Layout pull-down) 

.pg 

.pn n 
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DESCRIPTION 

Prints the page number at the specified location. Type .pc 
followed by the column number or by the number of 
inches using the inch symbol, for example, .pc 1.5". To 
center the page number between the current margins, type 
.pcO. The default is centered. 

Omits printing of page numbers . 

Turns printing of page numbers back on. This command is 
needed only if you previously used .op to turn printing of 
page numbers off. 

Restarts the page numbers at the specified number. Type 
.pn followed by the starting number. If you previously used 
.op, this command also turns printing of page numbers on. 



PAGE PREVIEW 

If you enter your own footer, printing of the default page number is automatically 
turned off. However, you can print page numbers in your footers or headers. Type the 
number symbol (#) in the footer or header text where you want page numbers to print. 

See also Headers and footers. 

Page offset. See Margins. 

Page preview 

Advanced Page Preview™ lets you see onscreen exactly how your document will look 
when printed. The preview includes columns, headers, footers, footnotes, endnotes, 
fonts, line spacing, and so on. (This feature works only on graphics monitors.) 

To start page preview, choose Page preview from the Layout pull-down or press Alt-l 
or "OP. You see the current page onscreen. You can choose from a number of views; 
for example, you can zoom in to magnify a section of the page, or you can zoom out 
to see more than one page. 

To change the view, press AIt-V to see the View pull-down. If you want to make the 
page larger, choose 2x zoom or 4x zoom. Zooming in is useful to see exactly how text 
will align on the page. 

TIP To check alignment, you can display a grid across the page. Choose Grid 
display from the Options pull-down. 

When you zoom in, your monitor can't display the entire page onscreen. Use the cur­
sor movement keys to move the display window to a different portion of the page. For 
example, press t or "X to move the window down. 

You can also move the window on the page by choosing Adjust window from the 
View pull-down. You'll see a small picture of your page with a box showing where the 
window is currently placed. 

Use the arrow and cursor movement keys to move the window on the page, or use the 
arrrow keys with the Shift key to move the window directly to a portion of the page. 
For example, End moves the window down and to the left; Shift-End moves the win­
dow directly to the lower-left corner of the page. When the window is where you want 
it, press Esc to return to the page. The screen displays the portion of the page you 
selected. 

To zoom out, you can choose from three views: 

Facing pages This view shows you two pages next to each other. It's good for seeing 
how a book or newsletter will look when opened to those two pages. 

Multiple pages This view shows between four and ten pages, depending on your 
monitor and the page size. It's good for checking page breaks and general layout. 
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Thumbnail display This view shows ten or more pages, depending on your monitor 
and the page size. It's good for looking at the overall layout of a document. 

At any of these views, press PgDn or PgUp to see the next or previous set of pages. 
Press Home or End to see the first or last page of the document. 

To zoom back in to a specific page, use the arrow keys to move the highlighting to the 
page number, then use the View pull-down to choose the magnification. (If the highlight­
ing is on the menu bar, press Esc to move it down to the page numbers.) 

TIP You can quickly change the magnification by using the + or - keys. For exam­
ple, if you're at the thumbnail display, press + to see the multiple pages display. 

To move the preview to a specific page, choose Specified page from the Go To pull­
down, type the page number, and press ~. If you're in a view that displays more than 
one page, the page you specify will be the first page at the top of the screen. 

To scan your document, choose Automatic scan from the Options pull-down. 
WordStar continuously displays the document until you press Esc. You can scan a 
specified number of pages by choosing Scan range. 

TIP To quickly locate a portion of your document, scan the document in thumbnail 
view, then press Esc when you see the page you want. Move the highlighting to that 
page number and press AIt-l to quit page preview. 
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When you quit page preview, you can return to editing the current page or your orig­
inal page. To return to editing the page you're currently viewing in page preview, 
press Alt-l or choose Current page from the Return to Editing pull-down. If you're in 
a view that displays more than one page, you'll return to the page whose number is 
highlighted. To return to the page you were editing before you started page preview, 
press AIt-2 or choose Original page from the Return to Editing pull-down. 

Paper trays. See Sheet feeders. 

Paragraph margins 
The paragraph margin is a special left margin used only for the first line of paragraphs. 
It is useful both for indenting the first line of each paragraph and for hanging indents, 
where you want numbers or other characters to hang out to the left of the rest of the 
text. 

2 

3~ 

paragraph indentation hanging indent 

To set a paragraph margin, choose Margins and tabs from the Layout pull-down or 
press "Ol, then move the cursor to the Paragraph field. Type the number in inches 
where you want the first line of each paragraph to begin and press FlO or"K. 
WordStar adds a .pm command to your document. (You can also type this com­
mand directly in your document.) For example, if you set .pm .5" and your left 
margin is at 0", the first line of each paragraph is indented half an inch. 

To set a hanging margin, set the paragraph margin to a lower number than the left 
margin. For example, with a left margin of A" and a paragraph margin of 0", the first 
line of each paragraph starts to the left of the rest of the paragraph. This command is 
useful for outlines and numbered lists where you want the numbers to stand out to the 
left of the text. 
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TIP If you type a + in front of the number, the paragraph margin will indent that dis­
tance from the previous paragraph margin. For example, .pm +.3" indents the first 
line of every paragraph three tenths of ah inch more than the previous paragraph 
margin. 

Note: If you set the paragraph margin at the Margins & Tabs dialog box, WordStar 
adds the inch symbol (") to the dot command. If you type the dot command directly in 
your text, you must type the inch symbol yourself to indicate inches. Otherwise, 
WordStar assumes you are specifying columns. 

To stop using the paragraph margin, delete the number in the Paragraph field or type 
.pm in your text. 

TIP You can use a temporary indent (,'OC) to quickly change the margins for a para­
graph of text. For information, see Indenting. 

Paragraph numbering 

Paragraph numbers are useful for proposals and legal contracts. To number para­
graphs, place the cursor where you want the number to appear and choose Paragraph 
numbering from the Layout pull-down, or press "oz. The prompt displays the number 
for the current paragraph. For the first paragraph you number in a document, 1. is the 
default value. For subsequent paragraphs, the prompt displays the number of the pre­
vious paragraph (for reference) and the next consecutive number. Press ~ to accept 
the number, or use the left arrow key or "5 to move up in the levels, or the right arrow 
key or "D to move down in the levels, then press ~ when you're finished. 

For example, if the previous paragraph was number 2.1.1, these are some of the 
possibilities: 

~ 2.1.2 

2.2 

3 

2.1.1.1 

When you press ~, a command tag appears in your text showing the paragraph 
number. To change a paragraph number, place the cursor on the number, use the 
paragraph number command again, and choose a new number. To delete a paragraph 
number, place the cursor on the number and press Del. WordStar automatically 
renumbers subsequent paragraphs when you change or delete a paragraph number. 

To specify a different starting number, use .p# and type the new starting number. For 
example, .p# 3.3 starts the paragraph numbers at 3.3. 
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Normally, paragraph numbers contain only numerals up to eight levels deep. You can 
change the numbering system to include uppercase and lowercase letters and Roman 
numerals or to be a different number of levels. To specify a different numbering sys­
tem, use the dot command .p#. Type a 9 wherever you want numerals to appear. Type 
a l where you want uppercase letters, a z where you want lowercase letters, and I and 
i for uppercase and lowercase Roman numerals. For example, .p# l.9.z would use a 
numbering system that started with A, then A.l, then A.l .a. 

If you include other characters in the .p# command, WordStar assumes you want to 
print those actual characters as part of the paragraph number. For example, if you type 
.p# {l.9.l}, the paragraph numbers will be enclosed in braces. 

TIP You can use your printer's extended characters to add the paragraph symbol (~) 
or the section symbol (§). If your printer uses the IBM extended character set, the para­
graph symbol is AIt-20 and the section symbol is AIt-21. For more information, see 
Extended characters. 

To change both the starting number and the style, list the starting number first, then 
the style, for example, .p# 3.3, l.9.z. 

You can use WSCHANGE to change the default starting number and style. 

Paths 
You can divide a disk into directories and subdirectories. This lets you put files into 
separate sections on your disk. Directories are used primarily on hard disks. 

The basic directory is called the root directory, with other directories forming a tree 
structure off the root directory. Each directory can contain files and other directories. 

The di rectories you go through from the root directory to a specific fi Ie is the path to 
that file. To specify a file in a different directory, list the complete path to the file, sep­
arating each directory name with a backslash (\ ) character. When the backslash is the 
first character after the drive letter in a path, it signifies the root directory. 

If the file is on a different drive, start the path with the drive letter. For example, the 
path for a file called REPORT.DOC in the WS5 directory on drive C is 
C: \ WS5 \ REPORTDOC. 

To log on to a particular drive or directory, choose Change drive/directory from the 
File pull-down, or press L at the classic Opening Menu or "KL while you're editing. In 
response to the prompt, move the highlighting to the directory name you want, or type 
the path to the drive or directory, and press ~. 

See also Logged drive and directory. 

Pause printing 
Occasionally you may want your printer to pause at a specific location in your docu­
ment. For example, you might want to change the print wheel before you print a title, 
or insert an envelope before you print an address. 
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To pause printing, press "PC at the spot in your document where you want printing to 
pause. "C appears on the screen. When WordStar prints the file and encounters the 
AC, it pauses. If you are printing in the background, the message Print wait appears in 
the status line. To display the Printing screen, choose Print a file from the File pull­
down, or press "KP at the editing screen or P at the classic Opening Menu. When 
you're ready to resume printing, press C. Then, to return to the editing or opening 
screen, press B. 

You can also pause between pages by answering Y at the Pause between pages print 
option when you start printing. (Use PRCHANGE to change the default answer to this 
question for any of your printers.) When printing pauses, the message Print wait 
appears in the status line. Use the procedure described above to display the Printing 
screen and to continue printing when you're ready. 

PC-Outline 
PC-Outline is a comprehensive outlining program you can use to organize information 
and create outlines to do lists, schedules, and electronic scratch pads. For information 
see the "PC-Outline" tab section. 

Phantom space and rubout 

Print wheels on daisy wheel or thimble printers often have a special character or two 
called phantom characters because they're not shown on standard keyboards. "PF 
prints the phantom character at a print wheel's hex code 20 (space) position. "PG 
prints the character at hex code 7F (rubout) position. 

"PF and "PG also print special characters on some dot matrix and laser printers. You 
can change the phantom characters for these printers using PRCHANGE. 

When you press "PF or "PG, "F or AG appears on the screen. When you print the file, 
the phantom character is printed at that location. 

Pitch 

Pitch is the number of characters in an inch of text. Nonproportional fonts are usually 
measured in pitch. The standard pitch is 10 characters per inch (10 CPI), or pica type. 
EI ite type is 12 CPl. 

Proportional fonts are usually measured in points, which specify the height of the 
letters. 

When you choose a font with a different pitch, WordStar determines how many char­
acters of the new pitch will fit on a line and displays the correct line breaks onscreen. 
For more information, see Fonts. 

TIP If you change fonts in the middle of a document and need to change the print 
wheel or cartridge on your printer, use the "PC command to pause printing. For more 
information, see Pause printing. 
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Place markers 
Place markers are temporary markers you add to your files to help you find your place. 
Once you set a marker, you can quickly'move the cursor to that marker. You can put 
up to 10 place markers in a file. 

To insert a place marker, move the cursor to the spot you want marked, Then press"K 
followed by a number from 0 to 9. The number appears highlighted on the screen. 

To move the cursor from anywhere in the file to a place marker, type "Q and the 
appropriate number. The cursor moves to the place marker. 

You can hide the display of place markers and block markers by using the command 
"KH. If you set a place marker when you previously used "KH to hide the display of a 
marked block, WordStar redisplays the marked block and all place markers until you 
press "KH again. 

If you sort text that contains place markers, the markers stay in their original location 
and do not move with the text. 

To move a place marker, move the cursor to the new location and set the marker 
there. The marker disappears from the old location. 

To delete a place marker, move the cursor to the marker and type "K and the number 
of the marker. 

Place markers are in effect only as long as you are editing the file. They are not saved 
when you exit the file. 

Ports 
Printers are usually connected by cables to ports at the back of your computer. 
WordStar looks for printers on the LPTl port. If your printer is connected to a different 
port, be sure to specify the correct port during installation. 

You can also specify a port at print time. At the Redirect output to prompt on the Print 
dialog box, type the name of the port. 

PRCHANGf 
You can customize how WordStar works with each of your printers. Use PRCHANGE 
to specify default settings for your printers. For information on PRCHANGE, see 
Appendix C, "Customizing WordStar." 

Previewing 
You can hide the print controls while you edit to see how text will align when printed, 
or you can preview how an entire page or group of pages will look. For information, 
see Displaying print codes and Page preview. 

You can also use the PRVIEW printer description file to produce a disk file that serves 
as a preview of the printed document. See Printing to disk. 
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Printer description files 
Each time you install a printer, WordStar creates a printer description file (PDF), a 
small file that includes the appropriate information to make WordStar work with the 
printer. 

For example, if you install an Okidata Microline 84 dot matrix printer, WordStar creates a 
PDF that takes advantage of the printer's correspondence mode to produce correspon­
dence quality print. 

During installation, you choose a default PDF (see the "Starting" tab section). When 
you create a file, WordStar assumes you will print it on the default printer. If you 
choose fonts in the file, WordStar shows you the fonts for that printer. The line breaks 
and page breaks you see onscreen reflect these fonts. 

You can change WordStar's default PDF by using WSCHANGE, or you can change the 
default PDF for an individual file by pressing "P? while editing the file and choosing 
the new PDF. When you choose fonts in this file, WordStar shows you the fonts for the 
new PDF. 

Each time you print a file, WordStar asks you which printer to use. Press F10 or"K to 
accept the defau It pri nter, or choose a different pri nter from the I ist of installed PDFs. If 
you choose a different printer, WordStar chooses fonts and colors on the new printer 
that most closely match those specified in the file. 

WordStar provides several PDFs that are not for specific printers. These include three 
"generic" PDFs, DRAFT, TYPEWR, and AUTOLF, for draft, typewriter, and auto line feed 
printers. With most printers, you can use one of these three PDFs. Two other PDFs, CUS­
TOM and SIMPLE, allow you to create a customized PDF. For information on customizing 
PDFs, see Appendix C, "Customizing WordStar." 

Four other PDFs, ASCII, PRVIEW, XTRACT, and WS4 are used for printing files to disk. 
For information, see Printing to disk. 

Printing a file 
To print a file, choose Print a file or Merge print a file from the File pull-down. The 
classic commands are P (regular printing) or M (merge printing) at the Opening Menu 
or "KP while editing. If you press "KP, WordStar asks if you want to print or merge 
print. 

Note: You can print any file while editing, but if you print the same file you're editing, 
the most recent backup copy of the file prints, and you can't save the file until printing 
is done. 

After you press the print command, you see the Print dialog box listing the print 
options. To accept the default answers to all the questions, press F10 or"K. To change 
any of the answers, move the cursor to the answer you want to change and type the 
new information. When you finish making changes, press F10 or "K. 
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The print options and their defaults are described below. 

File Choose the file to print. The default is the last file you edited or printed. 

Page numbers Choose which pages to print. All prints every page in the file. To 
specify a range of pages, type the first page number of a sequence, a hyphen, and the 
last page number in the sequence. To print individual pages, separate page numbers 
with commas. For example, to print pages 1 through 3 and pages 5 and 7, type 
1-3,5,7. If you've reassigned page numbers in your document, be sure to specify the 
new page numbers. The default is all pages. 

All/even/odd To print only odd or only even pages, type 0 or e. The default is all 
pages. 

Printer name Choose which printer to use. A menu of the printers you've installed 
appears below the prompt. Move the highlighting to the printer you want, or type the 
printer name, and press ~. You choose the default printer during installation, or 
change it while editing. See Printer description files. 

Number of copies? You can print more than one copy of the document. The default 
is one copy. 

Pause between pages If you need to feed individual sheets of paper to the printer, 
you must pause between each page, so press Y for yes. The default is no. You can use 
PRCHANGE to specify a different default for each of your printers. 

Use form feeds If you want WordStar to use form feeds when moving to the next 
page of a printout, answer Y for yes. To use a laser printer or other sheet feeder, you 
must answer Y. The default is no. You can use PRCHANGE to specify a different 
default for each of your printers. 

Nondocument To print a nondocument, press Y for yes. WordStar uses the defaults 
for the page layout. You can also print a document as if it were a nondocument, in 
which case all the dot commands are printed and not executed. The default is no. 

Redirect output to The output normally goes to whatever port you specified for this 
printer. If you want to redirect the output, type a different port or filename. See also 
Printing to disk. 

Note: You can change the default answers to many of the print questions by using 
WSCHANGE or PRCHANGE. 

Printing is normally done in the background. This means that you can continue with 
what you were doing before you started printing. The word Printing appears at the 
right of the status line. If printing stops during background printing, Print wait replaces 
Printing. You can use WSCHANGE to turn background printing off. This makes print­
ing somewhat faster. 

TIP The default speed for printing is full speed. However, some printers can't receive 
the printing input fast enough. If you're printing while editing, you may notice a time 
lag between pressing keys and the resulting onscreen operation. To eliminate this lag, 
use PRCHANGE to change to a slower printing speed. 
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PRINTING MULTIPLE COPIES 

Messages and commands related to printing are shown on the Printing screen, which 
is hidden during background printing. You must display the Printing screen before you 
can see a printing-related message or enter a printing-related command during print­
ing. To display the screen during background printing, choose Print a file from the File 
pull-down or press P at the classic Opening Menu or "KP while editing. 

C:FILENANE.DOC Pl 111 
rr============= P R I " T I " G ===========;t 

P pause 
C continue after pausing 
B pr i nt from background 

AU cancel printing 
F pr i nt at fu 11 speed 

IM'y",iMM4" Press C to continue or P to pause again at next page. 

Messages appear below the Printing screen commands. The commands are described 
below. 

COMMAND 

P 

C 
B 

"U 

F 

DESCRIPTION 

Pauses. printing temporarily. 

Continues printing after a pause. 

Starts background printing, and leaves the Printing screen. 

Cancels printing completely and leaves the Printing screen. 

Starts full-speed printing if you used PRCHANGE to install a slower 
printer speed. 

During printing, the Printing screen status line shows the page number that is currently 
printing. It also shows the copy number that is currently printing. This is useful if you 
are printing more than one copy of a document. 

Printing multiple copies 
You can print more than one copy of a file in one printing session. In most cases, the 
best way to print multiple copies is to use the Number of copies option on the Print 
dialog box. See Printing a file. 

The .rp (repeat printing) command also prints multiple copies of a file. Add this com­
mand to the beginning of the file if you always want the file printed a certain number 
of times or if you want to print multiple copies of a file that is nested or chained in 
another file. Type .rp followed by the number of times you want the file to be printed, 
for example, .rp 5. 
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Don't use .rp in a master document that uses a data file. If you want to print multiple 
copies of each version of the document, use the Number of copies print option. 

Printing to disk 
Sometimes you may want to "print" a document into a file on disk rather than printing 
it on paper. For example, you can use this function to review merge printed form let­
ters onscreen before you print them on letterhead paper. 

You can print to disk either by using one of the special printer description files or by 
typing a filename to redirect the output to. Both methods are described below. 

Special printer description files (PDFs) 

WordStar allows you to choose any of four "printers" that make disk files rather than 
sending text to a regular printer. They are named PRVIEW, ASCII, XTRACT, and WS4. 
You can choose one in response to the Printer name option on the Print dialog box. 

The PRVIEW PDF produces a file that looks as much like an actual printout as possi­
ble, with headers and footers and with data inserted if you are merge printing. It 
begins with the .pl command so that the page breaks will appear in the proper spots 
when you later look at the file in document mode. Each line ends with a hard carriage 
return. 

The ASCII PDF produces a file that is an ASCII version of the document, with all print 
controls, dot commands, and high-order bits on characters removed. Each line ends 
with a hard carriage return. 

The XTRACT PDF produces a file that is similar to the PRVIEW'file, but does not con­
tain headers, footers, or page breaks, and has soft carriage returns. This format allows 
you to perform some simple manipulations on text and data files. 

For example, if you had a data file named FORM1.DTA with several fields (such as 
name, title, company, address, state, and zip), you could use XTRACT to create a data 
file containing only the information in the name field. Create a file called FORM1.LTR 
containing these commands: 

.op 

.df form1.dta 

.rv NAME,TITLE,COMPANY,ADDRESS,ClTY,STATE,ZIP 
&NAME& 

Note that this file ends with a carriage return after &NAME& so that each name prints 
on a separate line. 

When you merge print this file and use the XTRACT PDF, the output file contains only 
the names from the data file. 

The WS4 PDF creates a file that is compatible with WordStar Professional, Release 4. 
For more information, see Appendix B, "Transferring Files Between Releases." 
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When you use any of these PDFs, specify a name for the output file by typing the new 
filename at the Redirect output to prompt on the Print dialog box. If you don't specify 
a new filename, the output file is given the same name as the PDF with a .WS exten­
sion, for example, ASClI.WS. 

Sending printer-formatted output to a file 
To tell WordStar to run a file through a specific PDF and send the output to a new file 
rather than sending it to the printer, specify the new filename at the Redirect output to 
prompt on the Print dialog box. 

You can use this feature if you're word processing on a computer not connected to the 
printer. It produces a copy of the document formatted with all the proper codes for the 
printer. You can then take the file on a floppy disk to a computer connected to the 
printer and print the file using the DOS COpy command. For example, if the printer is 
connected to port LPT1, type copy output.doc Iptl at the system prompt. For more 
information on the DOS COpy command, see your DOS manual. 

Print options. See Printing a file. 

ProFinder 
ProFinder helps you manage all the files on your disk. For information, see the 
"ProFinder" tab section. 

Prompts 
A prompt is an onscreen message that asks you to type an answer or gives you direc­
tions. 

In answering a prompt, you can sometimes type as many as 80 characters. When you 
reach WordStar's limit or the right edge of the screen, the cursor stops. 

TIP Sometimes when the cursor stops at the right edge of the screen, you have not 
reached the aD-character limit. To enter a long response, you can enter the right por­
tion of the response first. Then use AS to move to the left and insert the left portion. 

If the screen is a dialog box containing a number of fields (boxes where you can type 
answers), use Tab and Shift-Tab or the cursor movement keys to move forward and 
backward through the boxes. You can also press ~ to move to the next box. When 
you're done making changes, press FlO or "K to accept all the answers. If you change 
your mind, you can press F2 or "U to abandon all your changes. For more informa­
tion, see Dialog boxes. 

For many prompts, you can use the "R (repeat) command to repeat the information 
entered the previous time you saw a similar prompt. This command is handy for spec­
ifying the same filename for several different operations, or keeping all the existing 
tabs and adding one more. 
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PROTECTING A FILE 

Proportional spacing 
Proportional spacing means that each character is allocated space that is proportional 
to the character's actual width. For example, an i is narrower than an m, so it is allo­
cated less space in the line when printed. In nonproportional spacing, such as that 
used on most typewriters, all characters are allocated the same space regardless of the 
actual character width. 

Because each letter in a proportional font has a different width, the best way to align a 
column of proportional text is by using tabs. If you set a tab at 1.5 inches, text prints 
1.5 inches from the page offset no matter what font you use. 

Note: You may notice that a line of proportionally spaced letters appears wider than 
your margins. Because proportionally spaced letters often take up less space than non­
proportional letters, you can fit more characters on a line. The characters you see 
onscreen will all print within the margins you've specified. 

TIP To see where the characters will print on the page, look at the marker in the 
ruler line. As you move the cursor across a line of text, the marker shows where the 
text at the cursor will print on the page. 

To printtext in a proportional font (if your printer has this capability), choose Choose font 
from the Style pull-down or press "p =, then choose the font you want. For more informa­
tion, see Fonts. 

To see how the fonts will look when printed, use the page preview feature (if you havp 
a graphics monitor). For information, see Page preview. 

Note: You can also use the .ps on and .ps off dot commands to switch between pro­
portional and nonproportional fonts. 

Protecting a file 
You protect a file so it can't be accidentally changed. Protect your own files if you 

,share disks with other operators, or protect master versions of form documents and 
final drafts of any documents. You can remove the protection whenever you want. 

To protect a file or remove protection, choose Protect a file from the File pull-down or 
press C at the classic Opening Menu. Then type the filename (including the drive let­
ter or directory path if necessary) and press ~. WordStar shows whether the file is 
currently protected and asks if you want to change the setting. 

When you edit a protected file, Prtect is displayed in the status line. You'll see pro­
tected versions of the classic menus that don't contain commands that would change 
the file. 

You can read a protected file and copy it, but you can't add or delete anything. To 
leave a protected file, choose Abandon changes from the File pull-down or press "KQ. 
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QUATTRO SPREADSHEETS 

Backup files (.BAK) are automatically protected from changes as a safety measure. 

Protecting files is useful with a local area network (LAN). If you are running WordStar on 
a LAN, contact your dealer for information about LANs and site licensing. 

Q 
Quattro spreadsheets 

You can insert a Quattro spreadsheet directly into your WordStar documents or use the 
spreadsheet as a data file for merge printing. For information, see Inserting text and 
files and Merge printing. 

R 
README 
README contains information that came in too late to be included in the manual. For 
instructions on how to view the README information, see the "Starting" tab section. 

Reforming a paragraph. See Aligning text. 

Renaming a file 

To rename a file, choose Rename a file from the File pull-down, or press E at the clas­
sic Opening Menu or "KE while editing. When prompted, type the file's current name 
and press ~. Include a drive letter or directory path if necessary. Then type the new 
name and press ~. 

To rename the edited version of the file you're working on, choose Save and name file 
from the File pull-down or press "KT, then specify the new filename. The original file 
. is not changed; the edited file is saved to the new filename. 

Repeating 

The repeat command, "QQ, tells WordStar to continuously repeat a single-letter com­
mand or a keyboard character until you tell it to stop. You can use this feature for a 
repetitive task such as scrolling screen by screen toward the end of the file ("QQ"C). 

To begin the repeat operation, press "QQ, followed by the command or character to 
be repeated. 

To stop repeating, press the Spacebar. 
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RULER LINES 

To vary the speed of the repeat command, use the number keys at the top of the key­
board. Press 0 for the fastest repetition, 9 for the slowest, or another number between 
a and 9 for the speed you want. 

C AUT ION Be sure to press CfTI to repeat a command. For example, "QQ"C 
scrolls down screen by screen. "QQC repeats the character C. 

Replacing. See Finding and replacing. 

Return key. See Enter key. 

Ruler lines 
The ruler line above the text shows the margins and tab stops that currently apply to 
your text. The marker on the ruler line shows the position of the cursor on the page 
and moves as you move the cursor. (Ruler lines are not used with nondocuments.) 

In WordStar's default ruler line the left margin is set at a", the right margin at 6.5 
inches, and tab stops every half inch. 

L----! ----! ----! ----! ----! ----! ----! ----! ----! ----! ----! --------R 

When you change the margin or tab settings in your document, the ruler line changes 
to show the new settings. The new ruler line affects any text that follows. 

The ruler line can contain the following characters. 

CHARACTER 

L 
R 
P 

# 

v 

MEANING 

left margin 
right margin 
paragraph margin 
tab stops 
decimal tabs 
columns between the margins 
temporary indent 

You can change individual settings on the ruler line by using the margins and tabs com­
mands. See Margins and Tabs. 

You can change all the settings at once by using the .rr command to embed a ruler in 
your document. 

There are three ways to use the .rr command: you can embed a preformatted ruler, 
type a new ruler, or use the settings from the current ruler line. These methods are 
described below. Any text below an embedded ruler uses the settings on the embed­
ded ruler. 
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RUNNING A DOS COMMAND 

• WordStar comes with predefined rulers you can (quickly add to your documents. To 
add a predefined ruler, type .rr followed by the number of the ruler. For example, 
to return to the standard margin settings, type .rrO. The chart below shows the pre­
defined ruler settings. 

NUMBER 

o 

2 

3-9 

SETTINGS 

default margins and tabs 

left and right margins indented .5" from standard margins; good for 
quoted material 

.5" hanging indent; good for outlines. 

not defined 

To customize your own preformatted rulers, use the WSCHANGE program. 

• You ca.n change the margin and tab settings by typing a new ruler in your text. To 
type a new ruler, type .rr followed by the new ruler line, using the symbols shown 
above. To set the left margin at 0", type a hyphen immediately after the command; 
do not use an L. (Note: To set the left margin at .1" or .2", use an overprinted line 
(with "P ~) after the dot command, and type the L in the desired location.) 

In the example below, the ruler sets the left margin at 0", a tab at ]", a decimal tab 
at 1.1", and the right margin at 1 .4" . 

. RR----!---#--R 
• To embed a copy of the current ruler line settings, press "00. (Note: Because the 

fi rst th ree characters in the ru ler line are changed to .rr, if the left margi n was at .1" 
or .2", it is changed to 0".) 

TIP You can press "OF when the cursor is in a line of text to change the margins to 
correspond to the margins of the text line. 

Press "OT to turn the display of the ruler line on and off. You don't have to display the 
ruler line to change it. 

See also Indenting, Margins, and Tabs. 

Running a DOS command 
To run a DOS command without leaving WordStar, choose Run a DOS command from 
the Other pull-down, or press R at the classic Opening Menu or "KF at the editing 
screen. WordStar temporarily moves into the background, and you can type the com­
mand you want. 

For example, while you're editing a file, you can start Lotus 1-2-3 and look up infor­
mation from a spreadsheet or you can use the DOS CHKDSK command to find out 
how much free memory you have. 

To run a program in a different drive or directory, type the complete pathname for the 
program. 
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SAVING A FILE 

If you have a two floppy disk system and COMMAND.COM is not on your disk, you'll 
be prompted to insert your DOS disk. 

The amount of memory you can use to run DOS commands depends on how much 
memory WordStar is using, and whether you are using any memory-resident pro­
grams. 

C AUT ION If you plan to use a memory-resident program (such as DOS PRINT 
or SideKick®) from inside WordStar, be sure to load it from DOS before you start 
WordStar. 

TIP You can run several DOS commands in a row without returning to WordStar 
between commands. When you see the system prompt, type command and press ~ to 
run the DOS command processor. You can then run as many commands as you want. 
When you finish with your DOS commands, type exit and press ~, then press any key 
to return to WordStar. 

s 
Saving a file 
Saving a file stores it on the disk. 

When you open a document, the original file stays on the disk while you work on a 
copy in the computer's memory. When you save the document, the copy in memory 
(with all your changes and additions) goes back to the disk and replaces the original 
file. The original file is saved as the backup file, with the .BAK extension. 

Use the following commands to save your work. These commands are on the File pull­
down. 

COMMAND 

"KS 

"KD 

"KT 

"KX 

DESCRIPTION 

Saves the file, then resumes editing in the same place. It's a good 
idea to use this command periodically while you're working in a 
file to guarantee you won't lose your work if there's a power failure 
or another problem. 

Saves the file, then goes to the Opening screen. 

Saves the changed file to a new filename and returns to the Open­
ing screen. The original file is unchanged. 

TIP This command is useful if the current disk is full and you 
want to save the changed file to another disk. Simply specify the 
new drive as part of the filename, for example, b:filename. 

Saves the file, then exits to the operating system. 
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COMMAND 

"KQ 

"KW 

DESCRIPTION 

Quits the file without saving any current changes. The saved docu­
ment is the same as it was before you opened it (or the last time 
you used "KS). If you have made any changes, WordStar asks if you 
really want to abandon the changes. 

Saves a copy of a block in a separate file. See Blocks. 

TIP To save the file, then print it, press APrtSc. 

To save a file in a window, use any of the commands above. Remember that if you 
have two windows open on the same file, the.version you save last overwrites the ver­
sion you save first. 

Scrolling 
When you look at a document onscreen, you can see only one screenful of text at a 
time. To see different parts of your document, scroll the screen. 

When you edit a file that is wider than the computer screen, the screen scrolls as you 
type or move the cursor past the right edge of the screen. To quickly move the cursor 
back to column 1, choose Go to line beginning from the Go To pull-down or press 
"QS; to quickly move the cursor to the right edge of your document, choose Go to 
line end or press "QD. 

Several commands allow you to scroll up and down in your document, either line by 
! i ne or page by page. 

COMMAND 

"Wor"PgUp 

"Z or "PgDn 

"R or PgUp 

"C or PgDn 

"QW 

"QZ 

DESCRIPTION 

Scrolls up a line (the text moves down). 

Scrolls down a line (the text moves up). 

Scrolls up a screenful.The cursor goes to the left margin on the 
previous screen. 

Seroils down a screenful. The cursor goes to the left margin on the 
next screen. 

Scrolls continuously up, one line at a time. 

Scroll~ continuously down, one line at a time. 

With "QW and "QZ, YOL! can control the speed of the scrolling by typing a number, 0 
through 9, during scrolling. 0 is fastest; 9 is slowest. 

For more information on moving the cursor, see Cursor movement and scrolling. 

Searching for text. See Finding and replacing. 

204 



SHEET FEEDERS 

Sheet feeders 

Single-sheet printers such as laser printers use sheet feeders to advance the paper. 

If you have a sheet feeder on your printer, be sure to install it. If your sheet feeder isn't 
listed during installation, you can use PRCHANGE to tell WordStar the codes used for 
each bin on your sheet feeder. For information, see your printer manual. 

When you print a file using a sheet feeder, answer Y to the Use form feeds option on 
the Print dialog box. You can use PRCHANGE to specify the default answer for each of 
your printers. See also Form feeds. 

Because of the way sheet feeders move the paper through the printer, they usually 
require a shorter page length and a smaller top margin. If you notice that text is 
"creeping" up or down on the page, try changing the page length. For most sheet 
feeders, setting the page length to 62 lines, the top margin to 2 lines, and the bottom 
margin to 5 lines makes the paper feed correctly. If your document requires more 
room for headers or footers, adjust the margins accordingly. 

If your sheet feeder has more than one paper bin, you can use paper from different 
bins in one document by using the .bn command. For example, if you keep letterhead 
paper in bin 1 and plain paper in bin 2, add a .bn1 command at the top of page 1 and 
a .bn2 command at the top of page 2. The first page will print on the letterhead from 
bin 1 and all remaining pages will print on plain paper. 

Type .bnO to disable the sheet feeder. 

TIP If you keep envelopes or other odd-sized paper in a bin, remember to change 
the page length for the pages that will print from that bin. 

The following example is for a sheet feeder with three bins. Bin 1 contains letterhead, 
bin 2 contains plain paper, and bin 3 contains envelopes . 

. mt2 

.hm1 

.he Document header 

.p162 

.bn 1 
This is the first page. It is loaded from bin 1 . 
. pa 
---------------------------------------------p 
.bn 2 
The second page is loaded from bin 2 . 
. pa 
---------------------------------------------p 
The third page is also loaded from bin 2 . 
. pa 
---------------------------------------------p 
.bn 3 
.p120 
The fourth page (the envelope) is loaded from bin 3 . 
. pa 
---------------------------------------------p 
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SHORTHAND 

Shorthand 
WordStar's shorthand feature allows you to automatically issue a series of customized 
keystrokes by pressing a two-key code. Whenever your press Esc plus a letter or 
number, WordStar carries out the instruction for that character. For example, you can 
define a shorthand character to type your name and address, choose fonts, or add 
print enhancements to text in headings. You can also use shorthand characters to 
insert special text in your files. 

To use a shorthand character while editing, place the cursor where you want to insert 
the character's definition, press Esc or choose Shorthand macro from the Other pull­
down, then type the shorthand character. WordStar issues the customized definition 
for that character. 

TIP For information on issuing shorthand commands when you start WordSta" see 
Starting WordS tar. 

To look at the current shorthand characters or define new ones, use the shorthand 
command, but don't type the shorthand character. You'll see the Shorthand Menu. 

- C:FILENAME.DOC Pi L9 C111.ee" Insert Align 
SHORTHA"D IIE"U============jJ 

? display and/or change de'Finitions Fl help 

= result from last AQM or AKM math @ today's date 
$ formatted result from last AQM or AKM math ! current time 
• last AQM math equation 

C Center II Memo S Sincerely 
T Transpose Word 

The top of the menu lists the shorthand commands that WordStar offers. The screen 
also shows any shorthand characters that have been defined followed by a description 
to help you remember what the character does. (Note that WordStar comes with cer­
tain predefined shorthand characters.) 

The chart below describes the commands on the Shorthand Menu. 

COMMAND 

Esc ? 

Esc "J or Fl 
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DES C RIP T ION" 

Displays definitions. You can define new shorthand characters, 
redefine current ones, or look at the current definitions. 

Displays onscreen help for shorthand. 



COMMAND 

Esc = 

Esc $ 

Esc # 

Esc @ 

Esc! 

SHORTHAND 

DESCRIPTION 

Inserts the result of the last mathematical calculation ("QM calcu­
lator or "KM block math) into your text. If the cursor is at a decimal 
tab, the number is aligned at the decimal point. 

Formats the result of the last mathematical calculation as a dollar 
amount and inserts it into your text. The dollar format has two dig­
its to the right of the decimal point and commas every three digits 
to the left of the decimal point. For example, if the last result was 
1234.5, pressing Esc $ inserts 1,234.50 into the document. You 
can change the dollar format with WSCHANGE. 

Inserts the last math equation you entered using the onscreen cal­
culator ("QM) into your text. 

Inserts today's date into your text. (You may need to set the date 
when you turn on the computer.) An example of the date format 
is September 9, 1988. You can change the date format with 
WSCHANGE. (The same format is used by the merge print variable 
&@&.) 

Inserts the current time into your text. (You may need to set the 
time when you turn on the computer.) An example of the time 
format is 9:30 AM. You can change the time format with 
WSCHANGE. (The same format is used by the merge print variable 
&!&.) 

Defining a shorthand character 
To define a shorthand character, type? at the Shorthand Menu. The shorthand defini­
tions screen appears, displaying a list of all the currently defined shorthand characters, 
along with their description (the words that appear on the Shorthand Menu) and defi­
nition (the actual commands or letters the shorthand adds to your text). 

You can choose one of the characters listed and change the description or definition, 
or you can type a new character to create a new shorthand character. A shorthand 
character can be any letter or digit. 

You can create as many shorthand characters as you want until you run out of letters 
or run out of memory. The Bytes available line onscreen tells you how much memory 
is left for more definitions. (You can set aside more memory with W5CHANGE. The 
default size is 512 bytes.) 

If all the shorthand definitions don't fit on the screen, use "Wand "Z to scroll the dis­
play up and down. 

Once you choose a character, type a description (up to 50 characters) that will appear 
on the Shorthand Menu to remind you what the character does. It's best to keep 
descriptions short to conserve memory. 
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SOFT SPACES AND CARRIAGE RETURNS 

After you type the description, type the definition of the shorthand character. The defi­
nition is the actual text and commands that the shorthand character wi II enter. 

When you type a definition, type the actual letters or commands you want WordStar 
to type for this character. To enter a control character, press "P followed by the control 
character. The ~ key is entered as "P"M; Esc is "P Esc. 

For example, the description for the M shorthand character is Memo and its definition is 
Memorandum. When you type Esc M, WordStar types Memorandum into your text at 
the cursor location. The description for the C shorthand character is Center and its def­
inition is "Oc. When you type Esc C, WordStar types "OC to center the current line. 

When you finish typing the description and definition, press FlO or "K. 

When you define a shorthand character, WordStar adds it to the menu in alphabetical 
order, numbers before letters. 

To erase a shorthand character, erase both the description and the definition. 

When you finish changing the shorthand characters, press ~. WordStar asks if you 
want to save your changes. If you press V, WordStar saves all the current shorthand 
settings in a file on the disk. You can use them again whenever you run WordStar. 
If you answer N, WordStar saves the changes in memory for this editing session. 
When you quit WordStar, the changes are erased. 

TIP If you press N, but then decide you do want to save the changes for future work 
sessions, press Esc? to display the definitions screen. Choose one of the existing short­
hand characters, and press ~ twice. When you press ~ to quit, answer Y to save all 
the changes. 

Soft spaces and carriage returns 
When WordStar justifies text, it inserts extra "soft" spaces between words to make 
the line extend all the way to the right margin. When you edit or align paragraphs, 
WordStar inserts and removes these soft spaces as needed for indents and justification. 

Note: Spaces you enter with the Spacebar are hard spaces and are not removed when 
you al ign text. 

To see which spaces are soft spaces, press "OB; each soft space appears as a small 
dot. Press "OB again to turn off the soft-space display. (You can change the soft-space 
display dot to a different character with WSCHANGE.) 

To remove soft spaces from a paragraph, turn justification off and realign the 
paragraph. 

Carriage returns can also be hard and soft. A hard return is one you enter by 
pressing ~. A soft return is one that is added automatically when text wraps down 
to the next line. When you realign paragraphs, soft returns may move to a different 
location. 
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SPELLING CHECK 

A hard return is flagged with a < in the flag column; a soft return is flagged with a 
blank space. 

To change a soft return to a hard return, move the cursor to the end of the line and 
press ~. (A blank line may also be inserted.) To convert a hard return to a soft return, 
place the cursor anywhere on the line, and press "6. (Use the 6 key above the letter 
keys, not the 6 on the numeric keypad.) 

See also Aligning text, Justification, and Word wrap. 

Sorting text 
You can sort lines in your text to put them in alphabetic and numeric order. To sort 
your text, mark the text as a block, then press "KZ. When prompted, type A or D to 
choose ascending (A-Z) or descending (Z-A) sort order. 

If column mode is on, WordStar determines the sort order based on the highlighted 
text. If column mode is off, the sort order is based on all the characters on the line. For 
example, if you want to sort an address list by ZIP code, turn column mode on and 
mark the ZIP code column as a block. Then sort the text. WordStar rearranges the 
addresses according to the ZIP codes. In either case, the entire line is moved. 

Lines are sorted based on the following sort order: 

spaces 
symbols 
numbers 
letters 

You can change the sort order using WSCHANGE. 

For information on sorting MailList data files, see the "MaiIList" tab section in this 
book. 

Speed Write 
To go directly to the editing screen without choosing a filename, choose Speed Write 
from the File pull-down or press S at the classic Opening Menu. When you save or 
exit the file, you're prompted for a filename. This feature is useful if you want to start 
typing right away and name the document later. 

Speed Write creates a document file. You can change the format to nondocument by 
using WSCHANGE. 

Spelling check 
Use the spelling corrector to quickly check and correct the spelling in your documents 
and to check for double words, such as the the. You can check the spelling of your 
entire document, or of a single word. 
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SPELLING CHECK 

TO CHECK 

the rest of the document 

text in notes 

a word 

FOllOW THESE INSTRUCTIONS 

Choose Check document spelling from the Other pull­
down or press "QL. 

The spelling check begins at the current cursor position 
and goes to the end of the file. To check the whole docu­
ment, move the cursor to the beginning of the document 
before starting the spelling check. Words in notes and dot 
commands aren't checked. 

Use "U to stop the spelling check before the end of the 
document. 

Press "ONL. 

Because notes often contain proper names, they are 
ignored during a normal spelling check. Use this com­
mand to check just the text in notes, starting at the 
current cursor position. If you want to use a special per­
sonal dictionary for the notes, read the information on 
personal dictionaries later in this section. 

Place the cursor on the word and choose Check word 
spelling from the Other pull-down or press "QN. 

To check a word that is not in your document, press "QO 
and type the word. 

If the word is spelled correctly, WordStar shows you the 
definition of the word. (Depending on how you've 
installed WordStar, you may not see the definition.) 

TIP If you're using a two floppy disk computer, you're prompted to insert the dictio­
nary disk when you start a spelling correction. To make your work go faster, check the 
spelling of the entire document at once rather than checking small sections as you 
work. If you have enough memory, you can use WSCHANGE to have WordStar load 
the spelling dictionary into memory so you don't have to swap disks. 

When you start the spelling corrector, WordStar checks each word in the document 
against its dictionary of over 100,000 words. If the word is not in the main dictionary, 
WordStar checks the personal dictionary, a customized list of words you use such as 
proper names or technical terms that are not in WordStar's dictionary. (The personal 
dictionary contains only the word "WordStar" when you first use WordStar. You can 
add whatever words you want to this dictionary. For more information, see the section 
on personal dictionaries below.) 

If WordStar finds a word that is not in the dictionaries, it displays the word onscreen 
along with suggestions on how to correct it. The suggestions match the capitalization 
and part of speech of the original word. For example, if the original word is plural and 
capitalized, the suggestions will be plural and capitalized. 
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SPELLING CHECK 

A sample Spelling Check Menu is shown below. 

QL C:FILENAME.DOC P1 L8 CSS S.411" Insert Align 
SPELLI"G CHECK III"U========= 

I ignore, check next word 1 enter correction AU quit 
A add to personal dictionary G global replacement is off 
B bypass this time only 

Word: "sihts" 
Suggestions: 1 sights 2 sits 3 silts 4 sifts 5 sight 6 sightsee 

II display more suggestions 

A brief description of each command in this menu is given below. 

COMMAND 

I 

A 

B 

E 

G 

R 

DESCRIPTION 

Ignores the word and goes to the next word. With "Ql, the word 
is ignored throughout the file. With "QN, WordStar moves to the 
next word in the text. With "QO, you can type another word to 
check. 

Adds the word to your personal dictionary. Once you add a word 
to your dictionary, WordStar doesn't stop at the word each time it 
appears. 

Bypasses th is occurrence of the word but stops at subsequent 
occurrences. 

Prompts you to type a replacement word. After you type the word 
and press ~, WordStar checks the word you've typed. 

Uses the specified correction throughout the file. 

Used only with "QO. Inserts the word into your file at the cursor 
position. 

If there are more suggestions than fit on the screen at once, the command M display 
more suggestions appears. Press M to see additional suggestions. 

To choose a suggestion, press the number of that suggestion. The corrected word 
replaces the misspelled word in your file. If auto-align is on, WordStar realigns the 
paragraph after replacing a word. 

Personal dictionaries 
The personal dictionary contains words you use that are not in the main dictionary, for 
example, proper names and technical terms. Any time you run a spelling check, you 
can add a word to the personal dictionary by pressing A. 
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SPREADSHEETS 

If you'll be adding many words to the personal dictionary, it's a good idea to create a 
number of smaller dictionaries rather than one large one. A large personal dictionary 
can slow down the spelling corrector. You can organize words in the personal dictio­
naries according to the different kinds of documents you work with. 

If you want to have more than one personal dictionary, use WSCHANGE to tell 
WordStar to prompt you for the name of the personal dictionary when you run a spell­
ing check. When you're prompted for a personal dictionary name, you can choose an 
existing personal dictionary, or type a new name to create a personal dictionary. Any 
words you add during this spelling check are added to the personal dictionary you 
specified. 

You can also add or delete words from a personal dictionary by editing the dictionary 
as a nondocument. You can add, change, or delete words, or block insert words from 
another file, such as names from a data file. Make sure each word is on a separate line 
and sort the file ("KZ) in ascending order when you're finished adding words. 

TIP If you have personal dictionaries from a previous release of WordStar, you can 
use them with this release. Be sure to edit the personal dictionary as a nondocument 
file and sort the words ("'KZ) in ascending order before you use the file with this 
release. You may want to check that some of the words in your old personal diction­
aries are not in the new, larger main dictionary. You can easily do this by running a 
spelling check on the old personal dictionary and creating a new personal dictionary 
containing just the words WordStar flags. 

Spreadsheets 
You can insert a spreadsheet directly into your WordStar documents or use the 
spreadsheet as a data file for merge printing. For information, see Inserting text and 
files and Merge printing. 

Starting WordStar 
Before you use WordStar for the first time, follow the installation instructions in the 
"Starting" tab section. 

To start WordStar, type ws at the system prompt and press ~. The first screen that 
appears shows the version number, serial number, copyright notice, and the names of 
your computer and printer. Then the Opening screen appears. 

TIP If you press the Spacebar as soon as you see the version number, the Opening 
screen appears sooner. 

You can bypass both the copyright and Opening screens to begin editing a document 
immediately. To do this, type ws followed by the name of the file you want to edit, as 
shown below. 

A>ws first.doc 

WordStar opens the file in document mode. To specify nondocument mode, use /n 
option, for example, ws first.doc/n. 
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STATUS LINE 

The chart below shows the options you can use. 

OPTION 

In 

Id 

Is 
Ip 

lni 
I [shorthand 
Ix 

10 hhh 

Status line 

DESCRIPTION 

open the named file as a nondocument 

open the named file as a document (Use this option if you've changed 
the default file mode to nondocument.) 

open a Speed Write fi Ie 

pri nt the named fi Ie 

merge print the named file 

execute the shorthand macro 

exit WordStar upon returning to the Opening screen (Use with another 
option; for example, type filename.doc Ip Ix to print the file, then exit 
WordStar.) 

go to hex location hhh (24-bit) 

The status line appears at the top of the screen when you're editing a file. It shows the 
cursor location, warnings, and other messages. The status line can be turned off using 
WSCHANGE. 

The status line cursor indicator helps you keep your place in the file. It's helpful if you 
change fonts often, because it shows you where the text will print on the page. Other 
messages, like the filename and the words Insert and Prtect, keep you informed about 
the current status of the file. 

The status line can contain the following information. 

ITEM 

command 

filename and drive 

Wait 

cursor indicator 

Insert 

Prtect 

Align 

RgtJust 

DESCRIPTION 

Any command in progress. 

Name and location of the file you're editing. 

Displayed in place of the filename during lengthy operations 
and when WordStar is accessing the disk. If you type quickly 
while this message is displayed, you may lose some of the 
characters you type. 

Shows the page, line, column number, and inches of the cur­
sor's present position. 

Indicates that insert is on. (The Ins key or "V turns on and 
off.) 

Indicates that the document you're working on is protected. 

Indicates that auto-align is on for this text. (.aw switches it on 
and off.) 

Indicates justification is on. ("OJ, .j, and Right-justify text on 
the Layout pull-down switch it on and off.) 
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STRIKEOUT 

ITEM 

Mar-Rei 

LinSp-n 

Column 

ColRepl 

Decimal 

Replace? YIN 

Large-Fi Ie 

Dot-Limit 

Printing 

Print wait 

DESCRIPTION 

Indicates that margin release is on. ("OX and Margin release 
on the Layout pull-down switch it on and off.) 

If the line spacing is anything except 1 (single spacing), indi­
cates the current line spacing. 

Indicates you are in column mode. 

Indicates you are in column mode and column replace is on. 

Displayed when you use Tab or "I to move the cursor to a deci­
mal tab. 

Appears during find and replace operations when you need to 
decide whether to replace the word at the cursor. 

Displayed when the document becomes so large that only 3 K 
bytes of working memory are left, or if the document is too 
large to fit entirely in working memory. 

Warns you that the number of dot commands in the document 
is more than the number that WordStar can keep track of dur­
ing editing. (The document will print correctly.) 

Appears when you're printing in the background. 

Appears when you're printing in the background and printing 
is paused. When you see this message, choose Print a file from 
the File pull-down or press "KP while editing or P at the classic 
Opening Menu. Then choose the appropriate command when 
you're ready to resume printing. 

In nondocuments, the status line is slightly different. The differences between a non­
document status line and a document status line are described below. 

cursor indicator 

Auto-In 

See also Ruler line. 

Strikeout 

Because nondocuments have no pages, the indicator shows 
only line and column numbers. The line number can go as 
high as 65535, and the column number as high as 999. 

Displayed when auto indent is on. ("6 switches it on and off.) 

Text you mark for strikeout is overprinted with hyphens, for example, te~t This is 
useful for legal documents where you want to cross out text that you propose be 
deleted. 

To strike out text, place the cursor on the first character to be struck out and choose 
Strikeout from the Style pull-down or press "PX. The symbol "X appears on the 
screen. To mark the end of the strikeout, move the cursor to the end of the text to be 
struck out and use the strikeout command again. 
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SUBSCRIPT AND SUPERSCRIPT 

To delete strikeout, place the cursor on the"X and press Del or"G. Be sure to remove 
both the beginning and end strikeout markers. 

To change the character used to strike out text, type .xx followed by the new character. 

TIP To get double underline, change the strikeout character to an underscore char­
acter (.xx_J. Then mark the text for both underline and strikeout. 

To permanently change the character used for strikeout, use WSCHANGE. 

Subscript and superscript 
Subscripted text is printed slightly below the rest of the text on the line, for example, 
H20. To subscript text, place the cursor at the beginning of the text you want sub­
scripted and choose Subscript from the Style pull-down or press "PV. The symbol "V 
appears on the screen. 

To mark the end of the subscripting, move the cursor to the end of the text you want 
subscripted and use the subscript command again. 

Superscripted text is printed slightly above the rest of the text on the line, for example, 
WordStar®. To superscript text, place the cursor at the beginning of the text you want 
superscripted and choose Superscript from the Style pull-down or press "PT. The sym­
bol "T appears on the screen. 

To mark the end of the superscripting, move the cursor to the end of the text you want 
superscripted and use the superscript command again. 

To delete subscripting or superscripting, placed the cursor on the "V or "T and press 
Del or "G. Be sure to remove both the beginning and end markers. 

On some printers, you can specify how far subscripts and superscripts are printed 
below or above the rest of the text. This amount is normally 3148 inch. You can change 
it by typing .sr followed by the number of 48ths of an inch of roll you want. For exam­
ple, to change to 'Y48-inch roll, type .sr 4. 

Some dot matrix printers have a special half-high font available specifically for sub­
scripts and superscripts, for example, subscript. If your printer has such a font available, 
leave the roll set to zero. Otherwise, WordStar will print full size subscripts/super­
scripts moved up or down as described above. 

On other printers, WordStar may have to roll the carriage a whole line in order to print 
subscripts and superscripts. 
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TABLE OF CONTENTS 

T 
Table of contents 
To create a table of contents, first mark the table of contents entries in your text. Place 
the cursor at the beginning of the heading line and choose Table of contents entry 
from the Other pull-down. You'll see a .tc command in your text. (You can also type 
the dot command directly in your text.) Type the entire text you want to appear in the 
table of contents, including punctuation and indentation. To indent an entry in the 
table of contents, add extra blank spaces before the text. You can add print enhance­
ments such as boldface or italics. 

Type the # symbol in the dot command where you want the page number to print. 
When you generate the table of contents, the # is replaced with the number of the 
page where the dot command is located. If you use .pn to change the page numbers in 
your document, the table of contents will show the new page numbers. If you want 
the actual # symbol to appear in the table of contents, precede it with the backslash 
character (\) in the dot command line. 

For example, if you enter this dot command on page 1 : 

.tc DEFINITION ..................... # 

and this one on page 3: 

.tc Looking It Up ................... # 

the entries below will appear in the table of contents: 

DEFINITION ......................................... 1 
Looking It Up .............................. 3 

TIP Use the "P. command to insert periods up to the next tab stop. 

To produce the table of contents, choose Table of contents from the Additional pull­
down or press T at the classic Opening Menu. You'll see the Table of Contents dialog 
box. Choose the file that contains the .tc commands, and specify the range of pages 
you want to create the table of contents for. Then press FlO or "K to begin creating the 
table of contents. 

WordStar reads through the document and finds all the .tc commands and notes their 
page numbers. It places the table of contents entries and page numbers into a new file 
on the logged drive and directory. The filename is the same as the original document, 
with the extension .TOC. You can edit the table of contents file. 

A variation of the .tc command allows you to prepare up to nine additional separate 
tables of contents from one document at the same time. The variation involves adding 
a digit from 1 to 9, like this: 

.tcl Figure 1 ......................... # 
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When you use this variation, WordStar gathers the entries for all numbered .te com­
mands and places them into separate document files. These files all have the original 
document filename, but with a numbered extension: .T01, .T02, .T03, and so on. 

Tables. See Columns. 

Tabs 
Tab stops provide a convenient way to indent text. You can set a tab stop anywhere 
except the left and right margins. 

To set a tab, choose Margins and tabs from the Layout pull-down and move the cursor to 
the Tab stops field, or press "01. Type the settings for the new tab stops in inches. For 
example, to set a tab at two inches, type 2. Type # in front of a number to set a decimal 
tab. Press "R if you want to keep all of the existing tabs as well. You can edit the list of 
tabs to include just the ones you want. Separate tab settings with spaces or commas. 

When you've set the tabs you want, press FlOor "K. WordStar adds a .tb command to 
your file indicating the new tab settings. 

You can bypass the Margins & Tabs dialog box and type the dot command directly into 
your text. If you type the dot command directly, be sure to type the inch symbol (") 
after a number to indicate that the number is inches; otherwise, WordStar assumes the 
setting is in columns. 

TIP You can quickly change tabs to their default settings, or to other customized set­
tings, by using .rr. See Ruler lines. 

To move the cursor to a tab stop, press the Tab key or "I. Each time you press the key, 
the cursor moves to the next tab to the right. When the cursor reaches the last tab stop 
in a line, it stops. 

TIP Press "P. instead of the Tab key to have WordStar insert periods instead of blank 
space. This is useful for tables of contents. You can use WSCHANGE to change the 
character that >''P. enters in your text. 

Regular tab stops are shown in the ruler line as exclamation points (!). They align col­
umns of text by the first character you type after tabbing. Decimal tabs are shown as 
number signs (#). They align columns by the decimal point. 

To reformat tabbed text to new tab settings, choose Align paragraphs or Align one 
paragraph from the Layout pull-down or press "QU or "8. 

For nondocuments, tab stops are at fixed intervals, usually every eight columns. To 
change this interval, press "0, type the new interval, and press ~. The interval must 
be a binary multiple (1, 2,4, 8, and so on). The new interval is in effect only as long 
as you are editing; it is not saved with the file. You can also use WSCHANGE to auto­
matically set the interval based on filename extensions. 
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In a nondocument, when you press Tab or "I, WordStar puts a special nondocument 
tab character into the text. You can insert this nondocument tab in a document file by 
pressing "PI. This character is very rarely used in documents. 

To use regular tab stops in a nondocument, use WSCHANGE. 

See also Columns, Decimal tabs, and Indenting. 

TeiMerge 
The TelMerge telecommunications program lets you easily link to telecommunications 
services such as CompuServe® or electronic bulletin boards. It also lets you send files 
over your phone lines. For information, see the "Tel Merge" tab section. 

Temporary files 
WordStar creates and uses up to three temporary files while you're editing a docu­
ment. These files have extensions that start with the dollar sign ($). WordStar uses 
temporary files to keep track of documents that are larger than the available memory 
on your computer, and for block move or copy operations. When you finish editing a 
document, WordStar erases these temporary files. 

See also Memory usage. 

Temporary indenting. See Indenting. 

Thesaurus 
To look up a synonym for a word in your document, place the cursor on the word and 
choose Thesaurus from the Other pull-down or press "QJ. You'll see a list of syn­
onyms for that word. If the synonyms don't all fit on the screen, use PgDn and PgUp 
(or "C and "R) to scroll the screen. To select a synonym, move the cursor to the word 
you want and press ~. 

The word you selected automatically replaces the original word in your document. If 
auto-align is on, WordStar aligns your text after replacing a word. 

The thesaurus contains 220,000 synonyms; usually, the word you want will be among 
them. However, if WordStar cannot find the word you request, it looks up synonyms 
for the root word. If it still can't find the word, it displays a list of the closest words 
alphabetically, with the cursor resting on the word most like the word in your docu­
ment. Press ~ to look up synonyms for that word, or move the cursor to another word 
and press ~. 

Synonyms are grouped according to definition and part of speech. The most com­
monly used synonyms are listed first. When the synonyms are displayed, you can 
choose any of the following options. 
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COMMAND 

«-I 

L 

K 

p 

"U 

UNDERLINING 

DESCRIPTION 

Replaces the original word in the text with the synonym at the cur­
sor. You can use the cursor keys to move the cursor to the 
synonym you want before pressing ~. 

Displays a list of synonyms for the synonym at the cursor. You can 
then move the cursor to the synonym you want and press ~, or 
press P to return to the previous screen. 

Displays the definition for the word at the cursor. You can move 
the cursor to the original word in quotes at the upper left of the 
menu. Press N to see the next definition of the word; press P to see 
the previous definition. (Press "U to return to the synonym screen.) 

Type a word to check for synonyms, then press ~. 

Returns to the synonyms for the previous word in this session of 
using the thesaurus. This only works if you have requested syn­
onyms for more than one word in a session. 

Returns to the editing screen without choosing a synonym. 

If you're using a two floppy disk computer, you're prompted to insert the disk con­
taining the thesaurus when you start the thesaurus. If your computer has enough 
memory, you can use WSCHANGE to tell WordStar to load the thesaurus dictionary 
into memory so you won't have to swap disks. 

Toggles 
A toggle command is like a light switch: Press it once to turn an option off, press it 
again to turn the option on. For example, the first time you press "OJ, you turn justi­
fication off; when you press "OJ again, you turn justification on. 

For most toggle commands, the classic menu tells you what will happen when you 
press the command. For example, if justification is on when you press"O, the menu 
says: j turn justification off. 

u 
Underlining 
To underline text, place the cursor where you want the underlining to start and choose 
Underline from the Style pull-down or press "PS. The symbol "S appears on your 
screen. To mark the end of the underlining, place the cursor just after the last charac­
ter you want underlined and use the underline command again. 

TIP You can get double underlining by redefining the strikeout command. For infor­
mation, see Strikeout. 
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To delete underlining, place the cursor on the "S and press Del or "G. Be sure to 
remove both the beginning and end underline markers. 

Usually, spaces between underlined words are not underlined when you print. To 
underline spaces as well as words, use the .ul on dot command. (Spaces 'are under­
lined at print time, but do not appear underlined onscreen.) To stop underlining 
spaces, use .ul off. You can change the default setting by using WSCHANGE. 

Undo and unerase 
You can undo many commands with "U. The following list shows some of the ways 
you can use undo: 

• Cancel a response to a prompt before the response is final. 

• Stop "QR and "QC from going all the way to the top or bottom of your file. 

• Stop a find or find and replace operation. 

• Stop a spelling check. 

• Stop printing. 

• Restore text. 

Restoring text 
Undoing an erasure is called unerasing. When you choose Undo from the Edit pull­
down or press "U, the last group of characters you erased is restored to the screen at 
the current cursor location. 

Single characters erased with "G, "H, Backspace, or Del cannot normally be unerased 
(except for note tags). You can use WSCHANGE to specify that they can be unerased. 

TIP Unerasing is an easy way to move a phrase. Erase the text, move the cursor to 
the new location, and use the undo command. 

Unerasing works because WordStar stores your last erasure in a special memory 
buffer. Only the last erasure is stored. Each time you erase something, WordStar emp­
ties the buffer of what was previously erased and puts the current erasure in its place. 

Using Undo ("U) copies the contents of the buffer into the text. It does not empty the 
buffer. You can unerase the same text repeatedly. This can be handy for duplicating 
words and phrases. 

Normally, WordStar unerases a maximum of 500 bytes, but you can change that value 
with WS~HANGE. Keep in mind that the buffer is in working memory. Therefore, the 
larger the buffer, the less memory is avai lable for your fi les. 

v 
Variables. See Merge printing. 
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w 
Windows 
Windows let you look at two documents at once, or at two parts of the same docu­
ment. To open a window when you're editing, choose Open/switch between windows 
from the Window pull-down or press "OK. Then choose the name of the second file, 
either an existing file or a new one. The screen splits in half, with your original file at 
the top and the new file at the bottom. The cursor is in the new window. 

You can edit in either window. To move the cursor to the other window, use Open/ 
switch between windows ("OK) again. 

The status line at the top of the screen shows a 1 when the cursor is in the top window 
and a 2 when the cursor is in the bottom window. The status line also displays the 
name of the file where the cursor is currently located. 

You can mark blocks in both windows at once. To move or copy a block from one 
window to the other, place the cursor where you want the block to appear, then 
choose Copy block from other window or Move block from other window from the 
Window pull-down, or press "KG to move the block or"KA to copy it. 

(To move or copy a block within the same window, use Copy block and Move block 
on the Edit pull-down, or press "KC and "KV. For more information, see Blocks.) 

TIP To see an unchanged version of the document you're editing, open a window on 
the same document. You see the version you saved last, without any of the changes 
you've made in the current editing session. This is convenient if you've accidentally 
deleted information. Remember that the window you save last is the one you'll keep 
on disk. For this reason, it's better to use the second window for information only. If 
you edit in both windows and want to save both versions of the changes, rename one 
of the windows when you save it. Otherwise, the version of the file that you save last is 
the one you will keep on disk. 

To change the size of the windows, choose Size current window from the Window 
pull-down or press "OM. When prompted, specify a size for the second window. If 
you type 0, each window will take up the full screen. When you move the cursor 
between windows, the screen will flip from one file to the other. In WSCHANGE you 
can specify a default window size. 

You cannot edit notes while you have a document in the second window. 
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TIP If you want to create a nondocument in a window, use WSCHANGE to have 
WordStar prompt you whether to open a document or a nondocument when you open 
a window on a new file. 

To close a window, move the cursor to the window and use any of the save or abandon 
file commands. See Saving a file. 

Word count 
To get a count of the words and characters in a marked block, press "K? If no block is 
marked, you get a count for the entire file. 

While you are editing, you can press "Q? to display the number of characters from the 
beginning of the file to the current cursor position. 

Word wrap 
As you type, WordStar automatically moves the cursor to a new line when you reach 
the end of the current line. This is called word wrap. You press ~ only to mark the 
end of a paragraph. 

When you start WordStar, word wrap is normally on. You can change this default with 
WSCHANGE. 

To turn word wrap on and off while editing, press "OW. This is useful for typing tables 
and charts. When word wrap is off, you can type past the right margin, up to column 
255. The computer beeps when you type past the right margin. 

You can also turn off word wrap with the dot command .aw off, and back on with 
.aw on. These commands allow you to turn off word wrap permanently for a section 
of a file. It also turns off aligning and justification for this section. For example, you 
can use .aw off before a table and .aw on after it. Even if you later realign the docu­
ment, this section of text won't be changed. 

See also Aligning text and Justification. 

WSCHANGf 
WSCHANGE is WordStar's customization program. Use it toset up WordStar to run 
exactly the way you want. You can specify the initial setting for many features, such as 
margins, justification, and auto-align. You can also customize how WordStar works 
with your computer, for example, choosing new colors for the screen display or spec­
ifying whether to load the spelling dictionary into memory. 

222 



WSCHANGE 

For information on how to run WSCHANGE, and a list of the items you can change, 
see Appendix C, "Customizing WordStar." 

TIP As you use WSCHANGE, descriptions of each item you can change appear on 
help screens. Be sure to refer to this onscreen documentation for help. 

WordStar's printer customization program, PRCHANGE, is also described in 
Appendix C. 
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Introduction 
WordStar® Professional Release 5 includes Mai I List'" , which makes it easy to work with 
mailing lists. You can use merge printing to insert information from your mailing list 
into personalized letters for mass mailings. You can also print reports, labels, and 
envelopes with the inforrnation from a mailing list. 

With MailList, you can create one or more mailing lists. You just display a form on the 
screen and type information in the blanks. Besides keeping names and addresses in 
your mailing list, you can also keep telephone numbers and other information you 
may want to save. MaiiList gives you a choice of two forms, one for mailing lists and 
the other for lists such as inventories. You can update your lists any time and sort them 
in any order you want. 

The MailList documentation is organized into three chapters: 

Creating and Updating a Mailing List covers the basic operations for creating and 
maintaining mailing lists. 

Creating Form Letters gives guidelines for using the WordStar merge print commands 
to create form letters for use with a mailing list. 

Printing Envelopes, Labels, and Lists contai ns instructions for easy pri nti ng of enve­
lopes, labels, and reports using the information in a mailing list. 

You can run Mail List either through WordStar Professional or as a stand-alone program. 

If you have a hard disk computer, the MailList files should be in the same directory as 
your WordStar files (normally \WS5). If you didn't copy these files to your hard disk 
when you installed WordStar, do so now. 

If you have a two floppy disk computer, be sure to make a copy of the MailList disk. 
Always work with the copy and store the original in a safe place. 
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Creating and Updating 
a Mailing List 

MailList enables you to create lists of names, addresses, and other information. Each 
list is kept on disk in a file called a data file. The following pages give step-by-step pro­
cedures for creating and maintaining your mailing lists. 

Starting MailList™ 

Follow these steps to start using MailList. 

1 To start MailList using pull-down menus, select Additional at the WordStar Opening 
screen, then choose MailList. 
To start MailList using classic menus, press A at the WordStar Opening Menu, then 
press L for MailList. 

To start Mail List as a stand-alone program, log on to the disk or directory that con­
t'ains the MailList files, type wslist, and press ~. 

The MailList Menu appears. 

FORM: [ew .. ,-

tihoose a data fi Ie 

rildd new records 

~iew and edit records 

A ILL 1ST MEN U 

!!ocate records by number 

mort records 

I!Jse another form 

Press a llighligllted letter. 

!I! Help 

Wuit 
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2 Press C to choose a data file. MailList displays a list of the data files (files with the 
.DTA extension) in the current directory. 

MailList comes with a data file named WSLlSTDTA, which is empty. WSLlST.DTA 
is the default data file; if you don't choose a data file, this is the file you will work 
with. 

TIP You can use WSLlSTDTA as your main mailing list file. Just choose it as the 
data file when you're ready to start your mailing list, then enter your list as describ­
ed below in "Adding Names and Addresses." If you do this, you won't have to 
choose a new data file each time you start working on your mailing list. 

If you want to display a list of data files in another drive, type the drive letter fol­
lowed by a colon and press ~. To see the list of data files in a different directory, 
first type \ and press ~ to display a list of directory names, then move the high­
lighting to the directory you want and press~. 

3 Type the name of the data file you want to create or update and press~. Include 
the drive letter or directory path if necessary. You don't have to type the .OTA ex­
tension; MailList automatically adds th!s extension. (If you're updating a mailing 
list, you can move the highlighting to the filename and press ~ instead of typing 
the name.) 

C AUT ION To choose a file that you entered using the inventory form rather 
than the mailing list form, you must first choose the inventory form. Otherwise, 
when you type the filenarpe, an error message appears. See "Using Another Data 
Entry Form" in this chapter. 

Adding Names and Addresses 

You add names, addresses, and other information to your mailing list by filling in an 
onscreen data entry form. You fill in the form once for each person on the list; the 
entry for each person is called a record. Each piece of information in a record, such as 
first name or phone number, is called a field. The information that you enter in a field 
is called data. The data for the entire mailing list is kept on disk in a data file. 

You assign a number, usually 1, to the first record in each MailList data file. MailList 
sequentially numbers the rest of the records for you. 

1 Press A at the MailList Menu. The data entry form appears, with the Add New Re­
cords Menu at the top of the screen. If this is the first record in a new mailing list, 
the cursor is in the Record Number field. Otherwise, the record number is the first 
available number, and the cursor is in the First Name field. 
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The example below shows the mailing list data entry form, WSLlST.DEF. (Another 
form, INVNTORYDEF, is also available. You work with it in the same way as with 
the mailing I ist form. It is shown in "Using Another Data Entry Form.") 

FORM: [M'~i'i.i. t.W •• iW; __ ,W;---e"81* 

liopy from prev ious record rill' i te/save record in file 

Record Itumber: 
Mr./Ms.: 

First, Init., Last: 
Title: 

Company: 
Address Line 1: 
Address Line 2: 

City, State, Zip: 
Country: 
Phone-1: 
Phone-2: 

Type data and press =. 

-----------------------------------
-----------------------------------
-----------------------------------
-------------------- --- ----------
-----------------------------------

-----------------------------------
------------------------------------

Date: 1::~.m.mJ 
mm/dd/yy 

Jr.lM.D. : 

User Fields- Relnarks-
1: 
2: 
3: 

I --------------------------------------------------------
--------------------------------------------------------
--------------------------------------------------------

Note: If you keep data files on any disks or directories other than the MailList direc­
tory, copy WSLlST.DEF and INVNTORY.DEF to each of these disks or directories. 

2 For a new data file, type the number you want the first record to have (generally 1) 
and press ~. 

3 Fill in the data entry form for the first person on your list or the next person you 
want to add. At each field, type the information and press ~. The cursor moves to 
the next field. 

All the fields are optional; you are not required to fill in any field. To skip a field 
and go on to the next one, press ~. 

Always start typing in the first space of a field; if the data in the field begins with a 
blank space, you won't be able to ~ort it properly. 
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If you make a typing error, you can erase characters with the Backspace key. 
You can move the cursor around the form using these commands: 

Left one character 
Right one character 
Previous field 
Next field 
Top (first) field 
Last field 

"S or~ 
"Dor~ 

"A or" ~ 
"F or" ~ 
"T or Home 
"lor End 

4 When the form is completed, press ~ after the last field or press "W from any 
other field. Then press ~ agai n to save the data as a record. 

A blank form appears, with the next record number already entered. 

S Enter the rest of your records in the same way. Be sure to save each record (using 
step 4 above) as you complete it. You can't save records in groups. 

TIP At any field, you can copy the same information you previously typed for the 
field by pressing "C For example, if you're adding several records and they all 
have the same date, type the date in the first record. Then when you get to the Date 
field in each subsequent record, just press "c, and the same date is automatically 
inserted. 

6 After you enter and save all your records, press Esc to return to the MailList Menu. 

Updating and Correcting a Mailing List 
After you create your mailing list, you can look at your records and make changes. To 
change any information, use the steps below to display the record on the screen, make 
your changes, and save the updated record. 

Press V at the MailList Menu. The View and Edit Records Menu appears with the 
first record in your mailing list. 

2 Make any changes you want. Use the same cursor commands as you do to add a 
record. 

3 Press "W. Then press ~ to save the updated record. The next record appears. (If 
you press "Wand then decide you don't want to save the changes, you can press 
Spacebar to return to the record without saving the changes, or you can press Esc 
to abandon the changes and return to the MailList Menu.) 

4 Continue editing your records. If you don't want to change a record, you can press 
"N to display the next record or "P to display the previous record. 

S After you save the last record you want to change, press Esc to return to the 
MailList Menu. 
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Normally, you view and edit your records in order of record number. However, if 
you've sorted your mailing list in another order, the records appear in the sorted order. 
See "Sorting Mailing Lists." You can also view and edit particular records without go­
ing through all the records in order. See "Working with a Specific Group of Records" 
and "Finding a Particular Record." 

After you edit several records, you should sort your mailing list. See "Sorting Mailing 
Lists." 

Working with a Specific Group of Records 
You may want to view or update a specific part of your mailing list, such as all records 
with the name "Weiss" or all records with the city of "Summertown" in the state of 
"TN." You can use a record filter to display only certain records. The record filter "fil­
ters out" the records you don't want. 

At the MailList Menu, press V to display the View and Edit Records Menu. 

2 Press "C for Create or Change Filter. The data entry form appears with asterisks in 
place of the data in each field. The Record Filter Menu is at the top of the screen. 

3 Move the cursor to a field you want to use as the filter, and type the information 
you want to match in that field. If you want to use more than one field, move the 
cursor to each field you want to use and type the information to match. 

In the following example, two fields are used as the filter, "CA" for state and "95" 
for the first two digits of the ZIP code. 

R E COR D F I L T E R 

IlIrase r i 1 ter Illse th is filter 

Type data in the field(s) you want to Match and press Ill. 

Record /lUMber 
Mr./Ms. 

First, Init., Last 
Title 

Company 
Address Line 1 
Address Line 2 

City, State, Zip 
Country 
Phone-1 
Phone-2 

User Fields-

1: I 2: 
3: 

******************************** Da te: ~ 

*********************************** 
*********************************** 
*********************************** 
******************** CA* 95 ..... ****** 
*********************************** 
*********************************** 
*********************************** 

ReMarks-

mM/dd/yy 
Jr./M.D.: !iii'n,,'''' 

******************************************************** 
************************************************.w.******* 
******************************************************** 
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4 Press "U to start using the filter. The View and Edit Records Menu appears with the 
fi rst record that matches the data in the fi Iter. 

You can keep viewing and editing records as usual, except that only the records 
that match the filter are displayed. 

While you are using a filter, you can press "C again at the View and Edit Records 
Menu to change the filter. To stop using the filter, press "E at the Record Filter Menu. 
Otherwise, the filter is automatically erased when you exit the current View session. 

Finding a Particular Record 
You can select a specific record to view or edit by giving its record number. 

At the MailList Menu, press L. The Locate Records by Number Menu appears with 
a blank data entry form. The cursor is in the Record Number field. 

2 Type the number of the record you want to see and press ~. The matching record 
appears. 

3 You can either edit the record or view other records in numerical order beginning 
with the record on the screen. 

To edit the record, make changes the same way you do when adding or viewing a 
record. After you finish editing, press "W, then ~. A blank record appears again 
with the cursor in the Record Number field. You can enter another record number 
to display another record. 

To view other records, press "P to display the previous record or "N to display the 
next record. 

4 When you are finished locating and editing records, press Esc. The MailList Menu 
appears. 

Erasing Records 
You can erase a record only when it is displayed on the screen. 

Use either V (View) or L (Locate) at the MailList Menu to display the record you 
want to erase. 

2 Press "E. 

3 Press R to confirm that you want to remove the record. MailList removes the record 
from the mailing list. 

After you erase several records, you should sort the mailing list as explained in the fol­
lowing section. 

Sorting Mailing Lists 
When you view your mailing list, records normally appear in the order in which you 
entered them. You can sort the mailing list to make records appear in any order you 
want. After you sort the list, records appear in the sorted order until you sort them 
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again. You can save up to 32 different orders for sorting mailing lists; for example, 
sometimes you may want to sort by name and other times by date, by state, or ZIP 
code. (You can also save up to 32 sort orders for the inventory data entry form.) 

After you update or erase records, you should sort your list to put the records in the 
order you want and to use disk space more efficiently. Sorting the mailing list puts the 
updated records back into place in the data file and erases information left from before 
you updated the mailing list. 

TIP When you merge print with your mailing list, the form letters (or labels, enve­
lopes, etc.) are printed in the sorted order. Sorting your mailing list before printing en­
ables you, for example, to print labels in ZIP code order. 

To sort your mailing list without changing the sort order, use the following steps: 

Press S at the MailList Menu. The Sort Records Menu appears with a data entry 
form that shows the current sort order, which is the order you used the last time you 
sorted a mailing list. If you haven't used any sort orders, the default sort order is in 
order of record numbers. 

2 Press "U. MailList sorts the mailing list. When sorting is finished, a message 
appears. 

3 Press Esc to return to the MailList Menu. 

C AUT ION If you sometimes use leading spaces or zeros in a field, remember that 
MailList will consider these spaces and zeros when it sorts. Be sure to use these char­
acters consistently 50 that you can sort the records in the way you want. 

You may want to sort your mailing list into different orders for different purposes. For 
example, you may want to edit records in order of record number, print out phone lists 
in alphabetical order, and print labels in ZIP code order. The following sections tell 
you how to create a new sort order and how to change between sort orders. 

Creating cl Sort Order 
Follow the steps below to create a new sort order. 

Press S at the MailList Menu. The Sort Records Menu appears at the top of the 
screen. 
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Below the menu is a data entry form that shows the current sort order. This is the 
order you used last time you sorted a mailing list. If you haven't created any sort 
orders, the form looks like the one below. This form shows the default sort order, 
RECORDNO. The 1111 A in the Record Number field means that the list will be 
sorted in order of record number. 

SORT ORDER IlD!IiIim!l S 0 R T R E COR D S 

Irase order 
ey rield 
ave sort order E

se th is order 
• scend/jiJescend 

hoose/Create sort order 

Record !'lumber: 
Mr.lMs. : 

First, lnit., Last: 
Title: 

Company: 
Address Line 1: 
Address Line 2: 

City, State, Zip: 
Country: 
Phone-1: 
Phone-2: 

Press a highlighted letter or number. 

*********************************** 
*********************************** 
*********************************** 
******************** *** ******)1(-*** 
*********************************** 
*********************************** 
*********************************** 

Date: ~ 
mm/dd/yy 

Jr./M.D.: 1ii""U"i1 

User Fie lds- 'Renlarks-

1: I 2: 
3: 

******************************************************** 
******************************************************** 
******************************************************** 

system r ields: [**1 [*********1 Sort this field ror yymmdd --)[******1 

2 Press "C to choose a new sort order. A list of the available sort orders appears. If 
you haven't created any sort orders, the only one listed is RECORDNO. 

3 Type the name you want to give to the new sort order and press ~. A sort order 
name can have up to eight letters and numbers. The data entry form appears for 
you to enter the sort order. 

The sort order is based on up to nine fields called keys. The first key is the first field 
that is checked when sorting. If several records have the same information for the 
first key, the second key is checked, and so on. For example, if the first key is the 
State field, all the records with AK will be first, those with AL will be next, and so 
on. If the second key is Last (last name), the records within each state will be in al­
phabetical order by last name. If the third key is First (first name), whenever more 
than one record has the same state and last name, those records will be in alpha­
betical order by the first name. 

4 Move the cursor to the field you want to be the first key. Use the same keys you use 
when editing records: "F or "~ to move to the next field and "A or "<,- to move to 
the previous field. 

236 



CREATING AND UPDATING A MAILING LIST 

5 When the cursor is in the field you want, press "K. The field fills with the number 
1, except for the last character in the field, which is an A for ascending order. 

When MailList sorts, it uses this order for characters: first spaces, then digits starting 
with 0, then letters starting with A (for each letter, lowercase immediately follows 
uppercase). This is considered ascending order. You can have MailList sort any key 
in descending order, which is the opposite order. In descending order, for example, 
Z is the first letter of the alphabet and A is the last, and letters come before num­
bers. Just put the cursor in the key field and press D. The A that is the last character 
in the key changes to a D. To change a key back to ascending order when it is in 
descending order, move the cursor to the key field and press A. 

6 Move the cursor to the second key field and press "K. The field fills up with the 
number 2, with A as the last character. 

Mark the rest of your keys in the same way. When you're finished, your screen 
should look similar to the following example, in which four keys are used, State, 
Last, First, and Initial. 

SORT ORDER ~ 

Irase order 
ey field 
ave sort order 

S 0 R T R E COR D S 

E
se this order 

'scend/iiJescend 
hoose/Create sort order 

[II Help 

l!Illape 

Press a high I ighted I etter or number. 

Record HUMber: 
Mr./Ms. : 

First, Init., Last: 
Title: 

COMpany: 
Address Line 1: 
Address Line 2: 

City, State, Zip: 
Country: 
Phone-1: 
Phone-2: 

*********************************** 
*****************)()II)()()( M ****-)E-******* 

*******************)f*************** 
******************** 11A ********** 
************************** ********* 
*********************************** 
****************** -)( ****-)( **** ******* 

Date: === 
Ml!l/dd/yy 

Jr.lM. D.: Iii"""'''' 

Fields- Remarks:'" 
******************************************************** 
********it*********** )!f*********)( MM)()()()( ******************* 
****************"************}f*************************** 

, system fields: [**~ [*********] Sort thi's Held for yYMmdd ---H*****~] 

7 You can press "U to save the new sort order and sort your mailing list, or you can 
press "5 to save the sort order without sorting. 

8 Press Esc to return to the MailList Menu. 

Note: To sort by date, you need to choose a special date field. When you enter the 
date in a record, you enter it as month, day, and year. This date also appears on the 
bottom right of the sort screen as year, month, and day. This extra field is the one you 
must use as a key for sorting. 
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Choosing a Sort Order 
To change from one sort order to another, press "C (Choose sort order) at the Sort Rec­
ords Menu. A list of the available sort orders appears. Choose the order you want. A 
data entry form appears showing the order you chose. 

Note: The sort orders you create are stored in a file named MAILSORT.OVR in the cur­
rent disk or directory. If you don't see the list of sort orders you expect, you may need 
to copy this file from the disk or directory where you created it. 

When the sort order is on the screen, you can use it to sort the mailing list or you can 
edit or erase the sort order as described below: 

• To sort the mailing list using the displayed sort order, press "U. 

• You can edit a sort order to add keys or to change a key from ascending order to 
descending order or vice versa. You can't change the order of keys that are already 
in the sort order, and you can't delete keys. For example, if you have a sort order 
that has two keys, ZIP code and last name, you can add first name as the third key, 
or you can change from ascending ZIP code order to descending order. To edit the 
displayed sort order, just use "K and the A and D commands as you do when creat­
ing a sort order. When you finish editing, press "S to save the sort order or "U to 
save the sort order and sort the mailing list. 

• If you have created the maximum 32 sort orders and want to create another one, 
you need to erase an existing sort order. You can also erase sort orders you no 
longer use. To erase the displayed sort order, press "E, then answer Y to confirm 
that you want to erase the sort order. After you erase a sort order, it no longer 
appears in the list you see when you press "C to choose a sort order. 

Exiting MailList 
When you finish working with your mailing list, press Q at the MailList Menu to return 
to WordStar. Be sure to exit WordStar before you turn off your computer. (Using pull­
down menus, select File at the Opening screen, then choose Exit WordStar. Using 
classic menus, press X at the Opening Menu.) If you exit incorrectly, your data file 
may be damaged. 

M ailList Index Files 
When you create or update a mailing list data file, MailList also creates or updates an 
index file. The index file has the same filename as the data file with the .NDX exten­
sion. For example, if you name your data file CLiENTSDTA, the index file is named 
CLiENTS.NDX. 

Data files and index files go together. MailList needs to use the index file whenever 
you work with your mailing list. If you've erased your index file, when you try to work 
on your mailing list, a message appears telling you that the index file is missing and 
instructing you to press R to rebuild the index file. 
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Backing Up Mailing Lists ____________ _ 

Make frequent backup copies of your data and index files. Always keep at least one ex­
tra copy of your mailing list on a floppy disk. This is your insurance against accidental 
erasures, damaged disks, and other 'Problems. 

Using Another Data Entry Form __________ _ 

In all the examples so far, the mailing list data entry form was used. MailList provides 
an alternate data entry form that is for lists other than mailing lists. You can use this 
form for any list that doesn't include name and address information. This form is 
called the inventory form. You can work with the inventory data entry form the same 
way you do with the mailing list form. 

The data entry forms are stored in files with the .DEF extension. The mailing list data 
entry form, which is shown in the previous sections, is WSLISTDEF. The inventory 
form is INVNTORYDEF; it is shown below. 

ADD NEW R E COR D S ,pl;LfJ;i'·I;i'Wtji.j 

liopy hom prev i ous record rIlrite/save record in file [IJ Help 

.ape 

Type data and press alii. 
Record Number: mpprn Date: 

Item: __ Code: ••••• Status: 

-------------------------------~------------------------------

-----------------------------------------------------------------------------

- ------ - - ------ -- ---- -------------- ------------------------------------ ----

Account: 

Quantity: 

Price: 

Remarks-
-----------------------------------------------------
-----------------------------------------------------
-----------------------------------------------------

Each time you start MailList, the WSLlST.DEF form is the current form. This form is 
used for any mailing list you create unless you select the inventory form. 

239 



MAILLIST 

Follow the steps below to change to the inventory form, or from the inventory form 
back to the mailing list form. 

Press U at the MailListMenu. A list of the form files appears. 

2 Type the name of the form you want or move the highlighting to the name. 
Press ~. 

The form name you chose is now the current form until you exit MailList or choose an­
other form. If you try to edit a mailing list that uses a form different from the current 
one, an error message appears, and you must select the correct form before you can 
edit the list. 
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Creating Form Letters 
You can use information from your mailing list in form letters and other documents. 
You do this by creating a master document, which contains both the text of the letter 
and the merge print commands and variables. Before you create a master document 
for your mailing list, read the Merge printing section of the "Reference Guide." 

Starting the Document 
Use the following steps to create a master document to use with your MailList list. 

TIP If you have a two floppy disk system, it's best to create your master document on 
the disk that contains your data file. You should also make sure this disk contains the 
MAILLlST.DOT file that came on the MailList disk. 

1 Open a WordStar document file. For the filename, type the name you want to give 
the file and press ~. 

TIP You may want to give all your master documents the same filename extension 
(for example, .MRG) so that you can easily identify them. 

2 Use the command to insert a file ("KR). At the Document? prompt, type the file­
name maillist.dot and press ~. If necessary, include a directory path for the 
MAILLlST.DOT file. (To create a master document for an inventory list, type 
invntory.dot and press ~.) 

Your master document should look like the one below. The document is followed by 
brief explanations of the commands. For more information on these commands, refer 
to Merge printing in the "Reference Guide." (If you used INVNTORY.DOT, the dot 
commands contain different information.) 
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.op 

.df wslist.dta 

.rv x,number,full-name,first,mi,last,Mr-Ms,title 

.rv company,addr1 ,addr2,city,state,zip,country 

. rv phone1 ,date,Jr-MD,u5er1 ,phone2,U5er2,x,U5er3,remark1 ,remark2,remark3,ymd 

<Type text and variable names here.) 

.pa 

The .op command omits page numbers, since most form letters don't need page num­
bers; you can delete this command if you want to print page numbers. 

The .df command defines the data file as WSLlSTDTA. If you are not using 
WSLlSTDTA, substitute the name of your data file. 

The .rv command loads the data from your file into the variable names shown. The 
names in this command correspond to the MailList fields. Three commands are used 
so all the fields can be named. All the fields must be named here even if you use only 
a few of them in your letter. 

The line of text is a reminder for you. Be sure to remove this line before you type your 
letter. 

The .pa command causes each letter to print on a separate page. 

Typing the Document 
After you open the document, you can type your text. In each place where you want 
to use information from your mailing list, type the corresponding variable name, en­
closed in ampersands (&). When you finish typing your master document, save it as 
you would any document. For more detailed information on using variables, see 
Merge printing in the "Reference Guide." 

The variable names you can use to enter mailing list information are the same names 
used in the .rv dot commands. These names refer to the fields on your MailList data 
entry form. The list below shows the variable names in the MAILLlST.DOT file and the 
names of their corresponding MailList fields. 
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VARIABLE MAILLIST VARIABLE MAILLIST 

NAME FIE L D NAME FIE L D 

&number& Record Number &state& State 
&full-name& First, Initial, &zip& Zip 

and Last &country& Country 
&first& First &P.honel & Phone-l 
&mi& Initial &phone2& Phone-2 
&Iast& Last &date& Date 
&Jr-MD& Jr.lMD. &userl & User Field 1 
&Mr-Ms& Mr.lMs. &user2& User Field 2 
&title& Title &user3& User Field 3 
&company& Company &remarkl & Remark 1 
&addrl & Address Line 1 &remark2& Remark 2 
&addr2& Address Line 2 &remark3& Remark 3 
&city& City &ymd& * 

*The &ymd& variable represents the date in year, month, date format (for example, 
880826). MailList generates this field automatically, and you can use it for sorting 
and with MailMerge conditions. 

The variable names for the inventory form and their corresponding fields are shown 
below. > 

VARIABLE MAILLIST VARIABLE MAILLIST 

NAME FIE L D NAME FIE L D 

&number& Record Number &qty2& Quantity 2 
&date& Date &price2& Price 2 
&item& Item &acct3& Account 3 
&code& Code &qty3& Quantity 3 
&status& Status &price3& Price 3 
&descl & Description Line 1 &userl & User Field 1 
&desc2& Description Line 2 &user2& User Field 2 
&desc3& Description Line 3 &user3& User Field 3 
&acctl & Account 1 &remarkl & Remark 1 
&qtyl & Quantity 1 &remark2& Remark 2 
&pricel & Price 1 &remark3& Remark 3 
&acct2& Account 2 &ymd& * 

*The &ymd& variable represents the date in year, month, date format (for example, 
880826). MailList generates this field automatically, and you can use it for sorting 
and with MailMerge conditions. 
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Printing Form Letters 

To print a form letter, choose Merge print a file. (Using pull-down menus, this com­
mand is on the File Menu. Using classic menus, this command is on the Opening 
Menu.) Type the filename of your master document. Press" K to start printing, or 
answer the prompts as you would with any document. . 

Sa.mple Master Document 

The following example shows a master document and two printed letters . 
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. op 

.df w5li5t.dta 

.rv x,number,full-name,fir5l,mi,last,Mr-M5,title 

.rv company,addr1 ,addr2,city,5tate,zip,country 

. rv phone1 ,date,Jr-MD,user1 ,phone2,llser2,x,llser3,remark1 ,remark2,remark3,ymd 

. oj off 

November 18, 1988 

&full-name& 
&company& 
&addr1& 
&city&, &5tate& &zip& 

Dear &Mr-M5& &la5t&: 

Sonoma Textbook5 
30 School St. 

Lake City, WI 53701 

Sonoma Textbook5 introduce5 New51etter, the reading and 
editing game that add5 creativity to computerized learning. 

New5letter i5 a learning game that takes the excitement of 
computer5 out of the arcade and PUt5 it into the cla55room. It 
combine5 the enrichment of language skil15 with the fun and 
imagination of the high tech world. 

We are sure that you and your 5tudent5 at &company& will be 
pleased with thi5 product. 

Newsletter i5 available from yo~r Sonoma repre5entative and at 
guality book5tores everywhere. 

Si.ncerely, 

SU5an Skinner 
Sonoma Textbook5 
.pa 
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Sonoma Textbooks 
30 School St. 

Lake City, WI 53701 

November 18, 1988 

Albert G. Alvarez 
Wright School 
2330 Lark Ave. 
Buena Vista, CA 95912 

Dear Mr. Alvarez: 

Sonoma Textbooks introduces Newsletter, the reading and 
editing game that adds creativity to computerized 
learning. 

Newsletter is a learning game that takes the excitement 
of computers out of the arcade and puts it into the 
classroom. It combines the enrichment of language skills 
with the fun and imagination of the high tech world. 

We are sure that you and your students a~ Wright School 
will be pleased with this product. 

Newsletter is available from your Sonoma representative 
and at quality bookstores everywhere. 

Sincerely, 

Susan Skinner 
, Sonoma Textbooks 

$ ;';; 
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November 18, 1988 

Mary E. Bowen 
Dogwood School 
1 Schoolhou5e Rd. 
Lynville, OH 47308 

Dear M5. Bowen: 

Sonoma Textbook5 
30 School St. 

Lake City, WI 53701 

Sonoma Textbook5 introduce5 New5letter, the reading and 
editing game that add5 creativity to computerized 
learning. 

New5letter 'i5 a learning game that take5 the excitement 
of computer5 out of the arcade and PUt5 it into the 
cla55room. It combine5 the enrichment of language 5kill5 
with the fun and imagination of the high tech world. 

We are 5ure that you and your 5tudent5 at Dogwood School 
will be plea5ed with thi5 product. 

New5letter i5 available from your Sonoma repre5entative 
and at quality book5tore5 everywhere. 

Sincerely, 

SU5an Skinner 
Sonoma Textbook5 



Printing Envelopes, 
Labels, and Lists 

MailList comes with ready-made files for printing your mailing list on envelopes, 
labels, and Rolodex® cards and for printing proof reports of your mailing list. These 
files are WordStar documents that contain the merge print commands to insert the 
data from your list. Just use the following procedures. 

Note: If you want to print envelopes, labels, or lists for only part of your mailing list, 
you can edit these files and insert the appropriate merge print commands. See "Merge 
Printing Conditional Commands" in Merge printing in the "Reference Guide." 

TIP If you have a two floppy disk system, it's best to keep these ready-made files on 
the disk that contains your data file. Note, in the procedures below, the names of the 
files you plan to use, and copy those files to your data file disk. 

Printing Envelopes 
You can print standard 4%-by-9V2-inch envelopes for a mailing list using the 
ENVELOPE.LST file. 

Note: Special files are provided for printing envelopes with Hewlett-Packard® LaserJet® 
printers. For the LaserJet or LaserJet + , use HP-ENVMM.LST. For the LaserJet Series II, 
use HP2-ENVM.LST. 

If your data file is not named WSLlSTDTA, before you print envelopes, you need to 
edit the envelope file and substitute your filename for WSLlST.DTA, in the .df dot com­
mand. If your data file is not in the current drive or directory, you need to edit the 
envelope file and add the directory path. 

Choose Merge print a file. (Using pull-down menus, this command is on the File 
Menu at the Opening screen. Using classic menus, this command is on the Open­
ing Menu.) 
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2 For the name of the document, type envelope.lst (or hp-envmm.lst or 
hp2-envm.lst) and press ~. Include a drive letter or directory path if necessary. 

3 If you want to change any of the printing defaults, answer the questions as you go 
th rough the I ist. Don It start pri nti ng yet. 

4 Make sure your printer is ready and the paper is removed. Then press" K. 

5 Choose Print a file to go to the printing screen. (Using pull-down menus, this com­
mand is on the File Menu. Using classic menus, this command is on the Opening 
Menu.) 

A message saying printing is paused appears on the screen. 

6 Insert an envelope in the printer, rolling the platen until the top of the envelope is 
just visible. The top of the envelope should be at the same spot as the top of the 
page is when you align paper. (Don't align the envelope where you want printing 
to begin. It will advance the correct number of lines before printing.) 

7 Press C to print the first envelope. 

The name and address from the first record are printed on the envelope, and print­
ing pauses. 

8 Repeat steps 6 and 7 until you have addressed envelopes for the entire list. 

Sample printed envelopes are shown below. 
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Albert G. Alvarez 
Wright School 
2330 Lark Ave. 
Buena Vista, CA 95912 

Mary E. Bowen 
Dogwood School 
1 Schoolhouse Rd. 
Lynville, OH 47308 

Lucy Harris 
Oakvale High School 
770 Burton St. 
Oakvale, KY 32701 
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Printing Labels or Ro/odex® Cards 
You can print names and addresses from your mailing list on three different sizes 
of labels. The LABEL.LST file prints on 3V2-by-l-inch one-across labels. The 
LABELXL.LST file prints on 5-by-3-inch one-across labels. The LABEL3 .LST file 
prints on 3V2-by-l-inch three-across labels. The LSRLABL3.LST file prints on 
three-across labels using a laser printer. 

You can also print names and addresses on 3V2-by-4-inch continuous strip Rolodex 
cards, using the ROLODEX.LST file. 

If your data file is not named WSLlSTDTA, before you print labels or Rolodex cards, 
you need to edit the label or Rolodex file and substitute your filename for WSLlST.DTA 
in the .df dot command. If your data file is not in the current drive or directory, you 
need to edit the label file and add the directory path. 

LABEL.LST LABELXL.LST 

3V2" xl" one-wide labels 5" x 3" one-wide labels 

0 0 0 0 

o [ )0 0 0 

o ( ) 0 0 0 

: [ ): 
0 0 

0 0 

o[ )0 0 0 

o [ )0 0 0 

0 0 0 0 

LABEL3.LST 3V2" xl" three-wide labels 

0 0 

o[ ) [ ) [ Jo 
o[ ) [ ) [ )0 

o[ ) ( ) [ )0 

0 0 
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1 Choose Merge print a file. (Using pull-down menus, this command is on the File 
Menu. Using classic menus, this command is on the Opening Menu.) 

2 For the name of the document, type label,lst for 31/2-by-l-inch one-across labels, 
labelxl,lst for 5-by-3-inch one-across labels, label3.1st (or Isrlabl3.1st) for 3V2-by-l­
inch three-across labels, or rolodex.lst for Rolodex cards, and press ~. Include a 
drive letter or directory path if necessary. 

3 If you want to change any of the printing defaults, answer the questions as you go 
th rough the list. Don't start pri nti ng yet. 

4 Remove the paper from your printer. Insert the labels (or cards), rolling the platen 
until the top of the label is just visible. The top of the label should be at the same 
spot as the top of the page when you align paper. (Don't align the label where you 
want printing to begin. It will advance the correct number of lines before printing.) 

5 When the printer is ready, press" K. WordStar prints a sample label (or row of 
labels) to help you align the labels correctly, then pauses printing. 

6 Choose Print a file to go to the printing screen. (Using pull-down menus, this com­
mand is on the File Menu. Using classic menus, this command is on the Opening 
Menu.) 

7 Check the sample label. If the text is not centered on the label, realign the labels. 
Press C to continue. 

Two more sample labels are printed, with pauses after each one. At each pause, 
make any necessary adjustments to the alignment, then press C to continue print­
ing. After the third sample label, WordStar prints your labels, one for each record 
in your data file. 

When printing is complete, you are returned to the Opening screen. 

Sample printed labels are shown on the following page. 
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o 

o 

o 

o 

*********************************** 
* 
* 
* 

Label Alignment 3.5" x 1" 
* 
* 
* 

* * ************* 1 of 3 ************** 
*********************************** 
* * 
* 
* 

Label Alignment 3.5" x 1" * 
* 

* * 
************* 2 of 3 ************** 

*********************************** 

o 

o 

o 

o 

o * * 0 
* 
* 

Label Alignment 3.5" x 1" * 
* o * * 

************* 3 of 3 ************** 

o Mr. A. Alvarez 
Wright School 
2330 Lark Ave. o Buena Vista, CA 95912 

o Ms. M. Bowen 
Dogwood School 
1 Schoblhouse Rd. o Lynville, OH 47308 

OMs. L. Harris 
Oakvale High School 
770 Burton st. o Oakvale, KY 32701 

o 

o 

o 

o 

o 

o 

o 
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Printing Reports 
You can print two types of reports that list ihformation from your mailing list. A proof 
report is a listing of all the information in the mailing list; a phone report is a list of 
names and phone numbers only. You can also print a proof report for your inventory 
list. 

If your data file is not named WSLlSTDTA, before you print reports, you need to edit 
the report file (PROOF.LST, PHONE.LST, or INVNTORY.LST) and substitute your file­
name for WSLlSTDTA in the .df dot command. If your data file is not in the current 
drive or directory, you need to edit the report file and add the directory path. 

Choose Merge print a file. (Using pull-down menus, this command is on the File 
Menu. Using classic menus, this command is on the Opening Menu.) 

2 For the name of the document, type proof.lst (or invntory.lst for an inventory data 
file) for a proof report or phone.lst for a phone report and press ~. Include a drive 
letter or directory path if necessary. 

3 If you want to change any of the printing defaults, answer the questions as you go 
through the list, then press" K to start printing. 

WordStar prints the report. 

A sample phone report and a sample proof report for a mailing list are shown below. 

00001 Alvarez, Albert 

00002 Bowen, Mary 

00003 Harris, Lucy 
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PHONE DIRECTORY 
August 26, 1988 

Phone Number 
101-555-7676 

101-555-7497 

513-555-0380 



P R I N TIN G E N VEL OPE 5, LAB E L 5, AND L I 5 T 5 

MAILING LIST PROOF REPORT 
August 26, 1988 

00001 
Albert G. Alvarez 
Wright School 
2330 Lark Ave. 
Buena Vista CA 95912 

User Fields: 
1 : 
2 : 

3: 

00002 
Mary E. Bowen 
Dogwood Schobl 
1 Schoolhouse Rd. 
Lynville OH 47308 

User Fields: 
1 : 
2 : 

3 : 

00003 
Lucy Harris 
Oakvale High School 
770 Burton st. 
Oakvale KY 32701 

User Fields: 
1 : 

2 : 

3: 

08/26/88 
Mr. 
101-555-7676 

English Teacher 

08/26/88 
Ms. 
101-555-7497 

Principal 

08/26/88 
Ms. 
513-555-0380 

English Teacher 
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A sample proof report for an inventory list is shown below. 

Record: 00000 

Description: 

Account 
manila 
blue 

Remarks-

Record: 00001 

Description: 

Account 
8 1/2 x 11 
81/2x14 

11 x 1 7 

Remarks-

INVENTORY PROOF REPORT 

Date: 
Item: 
Code: 
Status: 

QuantitJ:: 
1050 
380 

Date: 
Item: 
Code: 
Status: 

QuantitJ:: 
7 boxes 
8 boxes 
2 boxes 

August 26, 1988 

08/26/88 

File folders 1 : 
01960 2: 
N 3: 

Price 

08/26/88 

Copier paper 1 : 
10843 2 : 
RS 3 : 

Be sure to reorder legal size paper if less than two 
boxes. 

If you want, you can change a proof report to put the information in another order or 
to exclude information you don't use. Copy PROOF.LST or INVNTORY.LST to a new 
file, then edit the file as you would a master document so that the variable information 
you want is in the correct place. (Don't change the .rv commands; just change the 
placement of the variables enclosed in ampersands.) 
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Introduction 
TelMerge® makes electronic communications easy by enabling your computer to com­
municate with computers all around the world. You can use TelMerge to 

• send and receive electronic mail ("Email") 

• check the progress of stocks and bonds with online communications services like 
MClsM's Dow Jones service 

• set up a data collection terminal for salespeople in the field 

• do computer work at home using dial-up lines to a mainframe 

• exchange messages and fi les with other personal computer users 

The TelMerge documentation is organized as follows: 

Getting Ready to Use TelMerge explains how to prepare your equipment for 
TelMerge. 

Calling a Service with TelMerge and Sending and Receiving Electronic Mail illustrate 
the most common data communications tasks with basic exercises. 

Talking to Other Computers shows how to transfer data files in different ways. 

Shortcuts with TelMerge contains tips to speed up and customize the program. 

There are also sections listing TelMerge's keywords (special commands), preprogram­
med communications services, and function key assignments. If you have a problem 
using TelMerge, see the Troubleshooting section. If you have a two floppy disk com­
puter, see the section called Using TelMerge with Floppy Disks. 
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Getting Ready to 
Use Te/Merge® 
What You Need ______________ _ 

To run TelMerge, you must have the following: 

• An IBM® PC or an IBM-compatible system with at least 128K of internal memory 
and 90K of available disk space 

• A private telephone line with a plug-in connector (RJll C jack) 

• An asynchronous communications card (if you don't have an internal modem) 

• A Hayes®-compatible modem 

TelMerge may not work if you have any of the following: 

• A multiline or "hold button" phone system 

• A pri nter and modem on the same port 

• A "call waiting" feature on your phone 

• RAM-resident programs running concurrently with TelMerge 

Note: In some areas you can turn call waiting off for the duration of a phone call. Call 
the local business office of your telephone company for details. 

Setting Up Te/Merge 
TelMerge requires no special installation. If you have a hard disk system, the 
TELMERGE.EXE and TELMERGE.SYS files should be in the same directory as your 
word processing program files. (If you didn't copy Tel Merge onto your hard disk when 
you installed WordStar Professional, do that now.) 

If you have a two floppy disk computer, see "Using TelMerge With Floppy Disks." 
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You can also run TelMerge as a stand-alone program. Log on to the directory contain­
ing the TelMerge files, type telmerge, and press ~. 

Setting Up Your Modem 

Tel Merge is set up to work with the default switch settings on a Hayes modem. (These 
are the switch settings set by the factory.) Unless your modem has different factory de­
faults, you don't need to change any switches. 

Hayes 300 and 1200 
Hayes 300 and 1200 modems are freestanding and require a serial port and a serial 
cable from your computer. To use these modems without a serial port, you must buy 
an asynchronous communications adapter card (an "async card"). Follow the direc­
tions in the Hayes manual to connect the modem. 

Hayes 300 and 1200 Switch Settings 

The Hayes 300 and 1200 modems have a row of switches, found behind the front 
panel, that have the following settings: 

SWITCH SWITCH 

NUMBER SETTiNG FUNCTION 

1 Down TelMerge ignores the Data Terminal Ready (DTR) sig-
nal 

2 Up Puts result codes (CONNECT, RING, etc.) into English 
words ... 

3 Down . . . and sends them to your computer 

4 Up Shows modem commands onscreen while dialing 

5 Down Modem doesn't answer incoming calls automatically 

6 Down Tel Merge ignores the carrier 

7 Up Sets modem for single-line phone 

8 Down Enables modem command recognition 
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Hayes 12008 Switch Settings 

The Hayes 1200B is an internal modem that plugs into one of your computer's short 
slots. The 1200B has a row of switches near the top of the card that are set as follows: 

NUMBER 

2 

3 

SWITCH 

SETTING 

On 

Off 

Off 

SWITCH 

FUNCTION 

Selects the communications port [ON = port COM1, 
OFF = port COM2) 

Sets modem for single-line phone 

TelMerge ignores the carrier 

If You Have a Phone System with Built-in Modems 

Many offices install phones that contain modems so you can use the same telephone 
line for both voice and data. If you have such a system-and it has a Hayes-compat­
ible mode-you can use TelMerge with it, but it may require special initialization (see 
PREMOPEM in the "Keywords" chapter for more information). 
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Calling a Service 
with TelMerge 
Registering with a Communications Service 

You get information for TelMerge from services and networks. The leading services and 
their phone numbers are listed in the "Communications Services" chapter. To register 
with a service, call the one you want directly, or ask your local computer store. Either 
way, when you register with a service, you receive a subscriber package with informa­
tion for TelMerge. 

How to Use Te/Merge 
There are two ways to call a service with TelMerge: 

• You can create individual service files that each contain the information necessary 
to call one service. If you subscribe to only one or two services, this is the easiest 
way to use TelMerge. 

• You can set up the TELMERGE.SYS control file with the information for several ser­
vices. Then, when you run Tel Merge, you can call any service by choosing it from 
the TelMerge Communications Menu. If you subscribe to a number of services, this 
method is more efficient in the long run. 

Both methods are described below. Be sure to have your subscriber packages handy. 
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Creating Individual Service Files 
You can create a file for each communications service you want to call. 

1 Start TelMerge. Either pull down the Additional Menu at the Opening screen and 
choose TelMerge, or, if you're using classic menus, press A at the Opening Menu, 
then press T for TelMerge. You see the TelMerge Communications Menu. 

Note: If you're running Tel Merge as a stand-alone program, log on to the directory 
containing the TelMerge files, type telmerge, and press ~. 

2 Press F5 (Other) at the TelMerge Communications Menu. Any files in the current 
directory with the extension .TEL are displayed. You can choose an existing .TEL 
file or create a new one. 

3 To create a new one, press ~. TelMerge asks you for the name of the service to 
call, your user 10 and password, and the service's phone number. This information 
is contained in your subscriber package. 

4 TelMerge also asks for information about your system, like your baud rate, and so 
on. In most cases, you can use the default settings, which are: 

Modem HAYES specifies that you are connected to a modem. If you are cabled 
directly to another computer, replace HAYES with the appropriate description. See 
MODEM in the "Keywords" chapter. 

Port COM1 means that TelMerge expects to find a modem connected to the COM1 
port on your computer. If you are using a different serial port for your modem, type 
the correct port number here. 

Baud 1200 means that you will be transmitting and receiving at 1200 bits per sec­
ond-about 1200 words per minute. You can change to any baud rate that your 
modem allows. The correct setting for this keyword may vary for different services. 
Some telexes, for instance, use baud 300. 

Duplex Full means that the remote computer will "echo" your typing back to you. 
That way, you can be sure it received what you sent. Some services requires half 
duplex-check your subscriber package. 

Press ~ to accept the default answer for the current question and go to the next 
one. If you press Esc after giving the phone number, default answers are used for all 
the remaining questions. 

5 Your answers to these prompts are stored in a new file (in the current directory) 
with the extension .TEL. You can use it again by pressing F5 (Other) at the TelMerge 
Communications Menu and then choosing it. 

If you need to change a .TEL file later, edit it as you would any nondocument file. You 
can add any additional keyword commands you like. See the "Keywords" chapter for 
more information. 
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Using the TELMERGE.SYS Control File 
If you subscribe to a number of services, you can store the information for every ser­
vice in one file, which is called a control file. This file (TELMERGE.5YS) is already 
provided for you. All you need to do is fill in the necessary information. For hard disk 
users, TELMERGE.SYS is usually stored in the \WSS directory. 

The TELMERGE.5YS file contains the TelMerge menu. Below the menu is a series of 
"scripts" containing information for each service. If you are calling a service that is 
preprogrammed into TELMERGE.SYS, all you add are the phone number of the ser­
vice, your user 10, and your password. 

Once you add the necessary information to the control file, connecting to a service 
is simple. You start TelMerge and type the name of the service you want to call when 
TelMerge asks for it. TelMerge consults the script for that service for the information 
it needs to make the connection and to log you on. 

Note: If you're running TelMerge as a stand-alone program, the TELMERGE.SYS file 
must be in the current directory or in a directory on your DOS path. To specify a .SYS 
file to use other than TELMERGE.5YS, type telmerge filename.sys at the command 
line. 

Adding Information 

Adding Information to TELMERGE.SYS 
Start WordStar and edit the TELMERGE.5YS file in nondocument mode. 

2 Press the PgDn key until you see the "System Section." 

;***************** 
; System Section 
;***************** 
, 
;The following keywords set the basic defaults for your system. 
;The current settings work for most systems. If the setting for 
;any keyword here doesn't match your system's requirements, replace 
;it with one of the other choices listed for that keyword. 
, 
;Specify the settings that you will use most of the time. If a 
;particular service requires different settings, specify them 
;in that service's script. Settings in a script override settings 
;in the System Section. 

Each entry listed in this part of the file is a keyword that tells TelMerge how to work 
with your system. The default values for these keywords work in most cases. However, 
check the MODEM, PORT, and BAUD keywords now to make sure they are set up 
correctly for your system. See the "Keywords" chapter for a full description of these 
keywords. 
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Adding Information about a Service 

Once you receive your subscriber package from a service (CompuServe® is used in the 
example below), you enter information into TELMERGE.SYS. 

1 Each preprogrammed service has its own script with the information TelMerge 
needs to place a call. Press the PgDn key a few times until you see the CompuServe 
script, which starts with LABEL CIS. LABEL CIS tells TelMerge to use this script 
when you specify CIS as the name of the service to call. 

The SERVICE CIS tag tells TelMerge what technical information to send to the ser­
vice. This information is already programmed into TelMerge. 

Fill in the next three lines using the information you received from the communica­
tions service. 

2 Put the cursor after the word NUMBER, press the Tab key twice, and type the tele­
phone number of the service. Type 9 or 1 before the number if your telephone sys­
tem requires it. You can also include the code to turn call waiting off if you need to. 

Note: When you use 9 to get an outside line, type one or two commas after it. Each 
comma makes the modem wait about two seconds so the second dial tone has time 
to sound before the modem dials the rest of the phone number. 

3 Put the cursor after the keyword USERID, press the Tab key twice, and type your 
user ID. 

4 Put the cursor after the keyword PASSWORD, press the Tab key twice, and type 
your personal password. The rest of the CompuServe script is already filled in for 
you. 

LOGFILE ClS.LOG means that if LOGGING is ON, the record of your CompuServe 
session is saved to a file called ClS.LOG. See "Logfiles" in "Sending and Receiving 
Electronic Mail." 

END tells TelMerge that it has come to the end of the script for CompuServe. Once 
you finish a CompuServe session, TelMerge returns you to the TelMerge Communi­
cations Menu. 

Note: Printing is off when you start to use CompuServe even if you changed PRINT 
to YES. You must press F8 to turn printing on. 

5 Save the fi Ie. 

Calling a Service through a Network 
Many people use commercial data networks to contact databases and services. To call 
a service through a commercial data network, add the name of the network, change 
the phone number in the service script, and add the HOSTID code provided by the 
network. This example shows the proper entries. 

Label 
Service 
Network 
Hostid 
Number 
Userid 
Password 
Logfile 
End 
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Adding a New Service to TfLMfRGf.SYS 

The procedure for adding a new service (one that isn't preprogrammed) to TelMerge 
is the same as the one discussed in the previous section, with two exceptions: 

• You add the service name to the Tel Merge Communications Menu. 

• You create a new script in TELMERGE.SYS for the new service. 

To add a new service to TELMERGE.SYS, follow these instructions: 

Use WordStar to edit the TELMERGE.SYS file in nondocument mode. 

2 Move the cursor to the Menu section in the file, which contains a series of SAY 
statements. Mark the line containing NEW as a block. Press ~ to create a blank 
line and copy the block. 

3 Replace NEW with the name of your service. 

4 Move down to the Service section and mark the text between LABEL NEW and 
the next END statement as a block. Move the cursor down one line and copy 
the block. 

Now customize the information in the copied section for your new service: 

Replace NEW with the name of the new service. This name must match the name 
you typed on the Menu. 

2 Add the phone number, your user 10, and your password. 

3 Change any other data that you want to modify. 

4 Quit and save the file. 

Note: If you want the menu entries you add to be highlighted when you run TelMerge, 
type a vertical bar (I) before and after the service label. 

Adding a Telex Service 

You can add any telex service the same way you add other new services, but with 
these additions: 

On the line above the phone number, type INTERACTIVE, press the Tab key twice, 
and type the phone number of the interactive (real-time) telex service. The service 
supplies you with this number. 

2 On the line below the interactive number, type ANSWERBACK, press the Tab key 
twice, and type the answerback name for that service. The service gives you this 
name when you sign up. 

Add the INTERACTIVE and ANSWERBACK responses only if your service provides 
telex communications. See INTERACTIVE and ANSWERBACK in the "Keywords" 
chapter. 
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Electronic Mail 
Preparing Messages for Electronic Mail 

Most communications services allow you to compose messages online, but you are 
charged for the time you are connected to the service. It is less expensive to type your 
messages first, using WordStar. Then, when the service prompts you for your message, 
press the SEND function key and specify the file containing your message. Your mes­
sage is sent to the service. 

A document file won't always print properly when it's received by the service. For this 
reason, TelMerge strips most of the print control commands from a file before trans­
mitting it. Tabs, indents, margins, and centering are maintained, though spacing may 
change slightly. Boldfacing, underlining, and other print features are removed. You 
can control a file more closely by printing it to disk and then sending the disk file. 

Sending Electronic Mail 
There are several ways to send electronic mail: 

• You can send an electronic letter to someone if you both have an account with the 
same service. You deposit the letter in your correspondent's electronic mailbox. 

• You can send a paper letter. In this case, you still send the letter electronically, but 
the service prints and delivers it. This may cost more than regular mail, but it can 
be much faster. 

• If your correspondent has a telex machine, YOLJ can direct the letter to the telex net-
work. In this case, your- mail is printed on your correspondent's telex machine. 

Examples of each of these methods follow. Each example shows the use of a particular 
communications service. Many services offer all of the methods and not just the meth­
od shown in the example. 
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Sending an Electronic Letter 

EXAMPLE 

To send an electronic letter using CompuServe, follow these steps: 

1 Write the letter with WordStar and save the file. 

2 Start Tel Merge. 

3 Type CIS (for CompuServe) and press ~. TelMerge dials CompuServe. 

As TelMerge dials, it counts the seconds it takes to reach that service. At 45 sec­
onds, TelMerge redials the number. After dialing twice, TelMerge gives up. You 
can change the number of times TelMerge dials with the TRY keyword. See the 
"Keywords" chapter. 

Note: If TelMerge does not find a phone number for a service you specify, it 
prompts you for that information. At each prompt, type the required information 
and press ~. TelMerge saves the information in a file that you name and calls the 
service. TelMerge gives the file a .TEL extension and stores it in the \WS5 directory. 
If you call that service again, press F5 at the TelMerge Communications Menu and 
type the .TEL filename. TelMer&e calls the service for you. 

4 When CompuServe answers, TelMerge automatically issues your password and 
identification number and logs you on. You are now at the CompuServe Main 
Menu. 

From the CompuServe Main Menu, go to the Email Menu (see your CompuServe 
manual). From the Email Menu, enter CompuServe's editing workplace. 

S When you are online in Tel Merge, you have two sets of function keys to use. The 
"TelMerge Function Keys" chapter explains each one and how they are used. 

Press the F2 function key to see function key set 2 (if it is not already displayed). 
Then press F4 to send a file. When prompted, type the full pathname of the file that 
contains your letter and press ~. TelMerge transmits your file to CompuServe. 

6 Follow CompuServe's instructions to close and send the letter. 

7 Exit the Email Menu, then exit CompuServe. 

8 Press FlO to hang up. Press FlO again to exit TelMerge and return to WordStar. 

Sending an E{rctronic Paper Letter 

EXAMPLE 

To send an electronic paper letter using MCI Mail®, follow these steps: 

1 Write the letter with WordStar and save the file. 

2 Start TelMerge. 
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3 Type Mel and press ~. TelMerge dials the number of MCI Mail and logs you on. 
You are now at the MCI Mail Main Menu. 

See your MCI Mail manual (or follow onscreen instructions) to reach MCI Mail's 
editing workplace. Type the name and address of your correspondent. MCI Mail 
prompts you for the letter. 

4 Press F4 of function key set 2 to send a file. Type the full path name of the file con­
taining your letter and press ~. TelMerge sends your file. 

S When you are prompted for the end-of-text marker, type a forward slash (I) and 
press ~. 

6 Select the menu choice that sends your letter. MCI acknowledges receipt of your 
letter. The letter will be laser-printed and delivered to your correspondent. 

7 At the MCI Mail prompt, type exit to disconnect from Mel. 

8 Press FlO to hang up. Press FlO again to exit TelMerge and return to WordStar. 

Sending a Telex 
Below is a sample telex document. This format is prescribed by ITT. For variations of 
this telex format, see instructions from your service. 

0000000+ 

TO: Barbara Jones 
FROM: Andy Smith 
DT: 11/21/88 

Greetings from the Fall Cookware Show! We have just unveiled. 
our new food processor. Along with its many powerful features, 
this machine kneads dough, grinds meat, and purees vegetables. 
To see all of the new features of this state-of-the-art product, 
you must try it for yourself. 

NNNN 

In telex messages you put the addressee's number in the top left corner of the docu­
ment. End-of-document and disconnect signals come at the end. You then use 
TelMerge to send the document to the telex service. 

There are two ways to send a telex document: store-and-forward mode and interac­
tive mode. > 

271 



TELMERGE 

When you use store-and-forward mode, you communicate with an intermediate com­
puter system. Your letter is stored temporarily and transmitted later to its destination. 

When you communicate in interactive mode, you are connected to your correspon­
dent's individual telex machine, which prints each character as you send it. There is 
no intermediate computer system. 

Using Store-and-forward Mode 

EXAMPLE 

To send a telex using ITT TIMETRAN®, follow these steps: 

1 Write the letter with WordStar and save the file. 

2 Start Tel Merge. 

3 Type ITT and press ~. You see the prompt What file do you want to send? 

4 Type the full pathname of the file that contains your letter and press ~. 

5 If there is an INTERACTIVE number in your control file script, you see the prompt 
Want to access interactive mode? YIN. Type N for no. 

ITT displays your account number, password, and destination account number, 
then transmits the file. You receive verification-"CALL ACCEPTED." If you have 
messages in your mailbox, ITT says "MESSAGES WAITING." 

6 Press the SEND function key (F4 of function key set 2) to see your messages. ITT 
displays all of your messages. When it has finished, it displays "END OF TRANS­
MISSION." 

7 Press FlO to hang up. Press FlO again to exit Tel Merge and return to WordStar. 

Using Interactive Mode 

EXAMPLE 

To send a telex using ITT telex, follow these steps: 

Write the letter with WordStar and save the file. 

2 Start TelMerge. 

3 Type ITT and press ~. 

4 If there is an INTERACTIVE number in your control file script, you see the prompt 
Want to access interactive mode? YIN. Type Y for yes. 

5 After the service answers and TelMerge logs you on, type the telex number of your 
correspondent followed by a + (plus sign). The systems exchange answerback 
codes. 
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6 At this point, if your correspondent is there, you could communicate back and 
forth in real time. Instead, you'll send a prepared document. Press the SEND key 
(F4 of function key set 2), type the filename, and press ~. TelMerge sends your file. 

7 Press the WHO ARE YOU key (F7 of function key set 1). TelMerge verifies that you 
were connected during the entire session. 

8 Press FlO to hang up. Press FlO again to exit TelMerge and return to WordStar. 

Note: If you have a problem using interactive mode with a particular service, use that 
service's store-and-forward mode instead. 

Receiving Electronic Mail _____________ _ 

The way you receive mail varies with different services. With store-and-forward telex 
services like ITT and RCA, you give a command after you log on to the service. The 
service then tells you if you have mail waiting. 

With menu-driven communications services like CompuServe and MCI Mail, you are 
told if mail is waiting as soon as you log on to the service. 

If you have mail, make sure the TelMerge logging feature is on and then ask the ser­
vice to send your mail. When logging is on, all mail is saved in a file on the disk. You 
turn logging on and off by pressing F7. With telex services, however, logging is always 
on. Check the status line to see if logging is on. 

e AUT ION Make sure you have enough room on your disk for your logfile before 
you turn logging on. If you run out of disk space during a session, TelMerge imme­
diately disconnects from the service to avoid loss of information. If this happens, make 
room on your disk and log on to the service again. Your mail is probably not lost; in 
most cases, the service still has it. 

Logfiles 
When you turn LOGGING ON, information is saved in a logfile in the current direc­
tory (unless you change the pathname for it in your service script). Unless you specify 
otherwise, the filename is TELMERGE.LOG. (Logfiles for preprogrammed services have 
been named individually in the TELMERGE.syS file. For instance, TELMERGE.SYS 
names a CompuServe session logfile ClS.LOG.) Each session is saved in its own file. 
Files received by Tel Merge can be edited with WordStar in nondocument mode. 

When you start a new session, TelMerge saves your previous session by automatically 
renaming the old .LOG file as .sAV. The new session is then saved in the .LOG file. 
The contents of the earlier .sAV file are discarded. If you want to save the logfiles 
of previous sessions, rename the .LOG file at the end of each session. Choose a file­
name that reflects the date of your session and the service that you used, for example, 
JUN06.ITT. 
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You can use the APPEND keyword to have information from each online session add­
ed to the existing logfile without creating a new file each time. See APPEND in the 
"Keywords" chapter for more information. 

You can also create prompts that ask you for a logfile name each time you call a ser­
vice. To do this, type a ? after the keyword LOGFILE in that service's script. Insert 
a blank line just before the LOGFILE statement and type say Name for logfile? See 
"Shortcuts with TelMerge" for more information. 

Printing 
If you have a "PRINT YES" statement in a control file script, you can print your session 
while you're online. Use the F8 (PRINT) function key to turn printing on or off. To 
check the current setting, look at the status line. If you have no printer, you can direct 
the printed output to a disk file. See PRINT in the "Keywords" chapter for more infor­
mation. 

274 



Talking to 
Other Computers 
Methods of Data Transfer 

If you use TelMerge exclusively for sending Email through an Email service, you don't 
need to read this chapter. You can always use the F4 (SEND) function key to transfer 
data. However, if you intend to call a mainframe or send program files, read on. 

There are two general methods of transferri ng data between computers: 

• ASCII transfer allows you to send and receive standard text files. This transfer 
method will not work for files that contain print controls or for binary and program 
files. All communications programs and commercial communications services sup­
port ASCII transfers. 

• Protocol transfer allows you to send a file with print controls in place. You can also 
use this method to send and receive program files. 

A protocol is a set of conventions for exchanging data between two computers 
and checking for errors that may occur during transmission. TelMerge uses the 
CompuServe A, XMODEM checksum, and XMODEM CRC protocols. Both the send­
ing and receiving computers must be runni ng the same protocol for a protocol transfer 
to work. 

The protocol TelMerge uses to send the file depends on the function key you send it 
with and the service specified in the script. . . 

• If you specify SERVICE Tel Merge or SERVICE CIS and press the F4 (SEN D) function 
key, TelMerge uses the CompuServe A protocol. 

• If you specify any other service and press F4, TelMerge performs an ASCII file 
transfer. 

• If you press the F6 (XM SND) function key, TelMerge uses the XMODEM protocol. 
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Talking to Mainframes 
Mainframes expect to be talking to terminals, not to your personal computer. If you 
are simply using Email or doing ASCII file transfers, this should not be a problem. 
However, the mainframe may require that your personal computer emulate (behave as) 
one of the more common terminals. TelMerge can be set up to emulate two terminals: 

• VT100 The DEC™ VT100 is a popular ASCII terminal. This is the default emula­
tion. You don't need to add it to your script. 

• VIDTEX A VIDTEX™ (or VT52) terminal is the CompuServe standard ASCII termi­
nal. If you specify SERVICE CIS, your personal computer automatically emulates a 
VIDTEX terminal. If another mainframe requires this emulation, you can put the 
command EMULATE VIDTEX in your control file script. 

See EMULATE in the "Keywords" chapter for more information. 

Note: TelMerge may not support certain communication controls required by 
mainframes. 

Online Databases 
Online services such as CompuServe and The SourceSM are large mainframe comput­
ers with local nodes distributed throughout the country. 

When you send Email and simple text files to an online database, use the F4 (SEND) 
function key to send in ASCII mode (without any print controls). When you do a pro­
tocol transfer, the service usually asks you which protocol you are using. If you have 
problems with transmissions (losing characters, etc.) see BAUD and lINEDELAY in the 
"Keywords" chapter. 

Talking to Another Personal Computer ________ _ 

With TelMerge, you can communicate with personal computers and computer "bul­
letin boards" that use any asynchronous communications software. You add these 
services to Tel Merge just as you would any other new service. If the other computer is 
usir)g TelMerge too, see "Talking to Another TelMerge User" later in this chapter. 

Use the SEND function key to send ASCII files. For other files, use a protocol transfer 
(XMODEM CRC or checksum). Modify your TELMERGE.SYS file as follows. First add 
the new service name (either "ORIGINATE" or "RECEIVE" in our example) to your 
TELMERGE.5YS menu, then add these scripts: . 

ORIGINATING 

CQMPUTER 

Label ORIGINATE 
Say Originating Computer 
Number (number of other computer) 
End 
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RECEIVING 

COMPUTER 

Label RECEIVE 
Say Receiving Computer 
Modem ANSWER 
End . 
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If you are the receiving computer, set the modem switch setting for auto-answer 
to ON, restart your modem (to reinitialize it), start TelMerge, and type receive (or 
whatever name you chose). Then wait for the originating computer to call and 
establish communication. The modem is placed in answer mode. 

If you are the originating computer, wait until the receiving computer is set up. 
Then start TelMerge and type originate (or whatever name you chose). TelMerge 
dials the number. The receiving computer answers the call and the two computers 
connect. 

2 To talk with the other computer, type your message. Messages are transmitted. 

To send an ASCII file, press the F4 (SEND) function key, type the name of a file to 
send, and press ~. 

For protocol transfers, tell the remote system that you are about to send a file. 
When the system indicates that it is ready, press the XM SND function key (F6 of 
function key set 2) and type the filename (when prompted). 

The default protocol is XMODEM checksum. To use XMODEM CRC protocol, put 
PROTOCOL XMCRC in the control file script. See PROTOCOL in the "Keywords" 
chapter for more information. 

When the transfer is complete, TelMerge indicates that it was successful. 

3 Receiving an ASCII file is automatic. To receive a file via protocol transfer, tell the 
remote system to initiate a file transfer. When the system indicates that it is ready, 
press the XM REC fL!nction key (F5 of function key set 2) and type the filename 
(when prompted). 

4 The originator or receiver presses F10 twice to disconnect. 

With an ASCII file transfer, you can see the text on your screen as it comes from the 
modem; if you have LOGGING ON, the file is stored to disk. With a protocol transfer, 
incoming data is captured in a buffer and written to disk without being displayed on­
screen. Instead, the status line displays, for example, RECORD #4. 

Using Your Personal Computer for Data Collection 
With TelMerge's auto-answer ability, you can set up your personal computer to receive 
data automatically. For example, sales staff can call in reports and data. 
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ASCII File Transfers 

To u5e your personal computer for data collection, add a control file script with this 
information: 

Label 
Say 
Service 
Logfile 
Modem 
Duplex 
End 

.. 

COLLECT <or whatever> 
Now ready for data collection 
TELMERGE 
COLLECT.LOG 
ANSWER 
HALF 

With your modem in answer mode, TelMerge treats all incoming calls as one session, 
adding each call to the same logfile. If your correspondents are using TelMerge and 
add the following script to their control files, each file they send you creates a new file 
on your disk. If this is the case, run TelMerge from a directory that has no files in it that 
you want to save, since files sent to you will overwrite files with the same name on 
your disk. 

Label 
Say 
Service 
Duplex 
Number 
End 

CALLHOME <or whatever> 
Now calling home office for file transfer 
TELMERGE 
HALF 
<your phone number> 

Protocol Transfers 

In protocol transfers, if a caller tries to send you a filename that already exists on your 
disk, the file on your disk is overwritten. 

C AUT ION If you expect a lot of incoming calls through TelMerge, be sure your 
disk has plenty of space to accommodate incoming files. If your disk fills up, the caller 
is disconnected and all subsequent connections fail. 
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Talking to Another Te/Merge User 
If you are communicating with another computer that is running Tel Merge, set up your 
script as follows. 

Label 
Say 
Service 
Duplex 
End 

TMERGE2 
Now connected to another TelMerge user 
TELMERGE 
HALF 

Protocol transfers between two computers running TelMerge use the CompuServe A 
protocol. 

If you are sending files to the other computer, type the name to give to the file when it 
reaches the remote computer. You can use the wild-card character * to send multiple 
files with the same extension (*.DOC) or all the files in a directory (C:\DOCS\*.*). 
During a personal-computer-to-personal-computer transfer, the user who presses the 
SEND function key provides the filename for the other user. 

You can use TelMerge to transfer files directly between computers (without modems) if 
the serial ports of the computers are connected by a special serial cable adapter. Both 
computers must have TelMerge. Set up the control file scripts as follows. 

Label 
Say 
Service 
Modem 
Duplex 
End 

DIRECT 
Now set up for direct connection 
TELMERGE 
DIRECT 
HALF 

The direct transfer procedure is the same as for a transfer over the telephone. See 
"Talking to Another Personal Computer" earlier in this chapter for more information. 
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A Summary of Techniques to Send and Receive Files 
Send F4 Sends ASCII files. (When contacting another TelMerge user, F4 uses the 
CompuServe A protocol.) 

XmSnd F6 Uses the current protocol (the one set in the service script) to send a file to 
a service or to a personal computer that is not using TelMerge. 

XmRec F5 Uses the current protocol (the one set in the service script) to receive a file 
from a service or from a personal computer that is not using TelMerge. 

No action is required to receive an ASCII file. When you contact another TelMerge 
user, no action is ever required to receive a file. 
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TeiMerge 

This section contains some suggestions for customizing TelMerge for your personal 
needs. The shortcuts are most useful if you are using the TELMERGE.5YS file to call 
your services. The shortcuts in this section include 

• programming function keys 

• reprogramming TELMERGE.SYS: 
prompting for a password 
prompting for a logfile name 
prompting for printer or disk output 

• automating an online session 

• exiting while online 

• using Snap Shot and ShoFil 

Programming function Keys -------------
You can customize F7 and F8 of the online function key set 2 for each service you 
use. In this example, the F7 function key (FK1) is programmed to check mail on 
CompuServe's EasyPlexSM service. 

Use WordStar to edit the TELMERGE.SYS file. 

2 Page down until you come to the section that begins Label CIS. 

3 At any point after the Say statement, press ~ to insert a blank line. 

4 On the blank line, type fkl r.email go_mail. 

S Save the fi Ie. 
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What does fkl r.email go_mail mean? 

• FKl stands for the F7 function key. The R sends a carriage return at the end of the 
command. 

• When you are online with CompuServe, Email is the new label for the F7 function 
key (at the bottom of your screen). 

• Go_mail (followed by ~) is the command issued when you press F7 while logged 
on to CompuServe's EasyPlex electronic mail service. 

You can program F7 and F8 to send commands, passwords, or other information while 
online. They can have different functions for each service. 

Reprogramming TELMERGE.SYS 
TelMerge has a built-in scripting language with conditional commands like IF and 
ELSE. The following examples demonstrate the use of this scripting language. 

EXAMPLE 

Here is an example of reprogramming TelMerge to prompt you for a password. 
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Say Password? 
Hold ? 

If =MyPassword 

Goto GoodPassword 

Else 
Say Sorry. Incorrect password. 
Exit 
EndIf 

Label GoodPassword 

Password ! 
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EXAMPLE 

Here is an example of reprogramming TelMerge to prompt you for a logfile name. 
Insert the following lines into the appropriate section of your control file just after 
the Label line that gives the service name. 

Logfile MYFILE.LOG 
Say What would you like to call this session's logfile? 
Say 
Say Type a filename and press <i-I, 

Say or press ~ to use the filename .... MYFILE.LOG." 
Say 
Hold? 

Logfile 

EXAMPLE 

Here is an example of reprogramming TelMerge to prompt you for printer or disk out­
put. 

Print MYFILE.PRN 
Say Type the name to use 
Say for the diskfile 
Say (Type P to use the printer) 
Hold? 
If =P 
Print YES 
Else 
Print 
Endif 

Automating an Online Session 
You can use the TelMerge keywords to issue commands automatically, so you have a 
minimal amount of typing to do. Here are some examples. 
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Changing the Log-on Script 

TelMerge issues the commands in its control file in a particular order (see the "Key­
words" chapter for a full listing). If you have a service that needs information in a 
different order-or one that calls for input that TelMerge doesn't understand-use 
the LOGON keyword to customize your log-on sequence. 

Suppose that you subscribe to a service that requires you to log on by giving (in order) 
the network identification number, your first name, your last name, and your pass­
word. The LOGON keyword is designed to handle this. You would type the following 
line into your control file: 

LOGON networkidl firstname I/astname Ipassword 

Each vertical bar ("1") in the LOGON command tells TelMerge to issue a carriage 
return and wait for a prompt from the service before continuing. 

Since LOGON is one of the last keywords that TelMerge checks, remove the lines con­
taining the network identification and your password from the control file script before 
using this new version. 

Automating an Entire Session 
TelMerge can automatically call a service and request the information you need. You 
can even make several automated calls in sequence without pressing any keys in be­
tween. The following keywords work together to create an automated session. (They 
are described in more detail in the "Keywords" chapter.) 

KEYWORD 

CALL 

WAIT word 

SEND word 
PAUSE secs 

QUIET secs 

FILESEND filename 

LOGGING ON or OFF 

PRINT ON or OFF 

HANGUP 
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DESCRIPTION 

Dials the service now 

Waits for this word from the remote service (after logging 
on) 

Sends this word (or words) to the service 

Waits this number of seconds for the service to start 
sending 

Waits until the serial line is quiet for this number of 
seconds 

Sends the specified file 

Turns logging on or off at this point in the session 

Begins or ends printing at this point in the session 

Hangs up the phone 
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In an automated session, when Tel Merge finds a CALL keyword, it dials the service 
using the preceding information. Then the script keywords are executed. When it 
reaches HANGUP, it looks at the next script to see if it contains a CALL keyword. 
If it does, TelMerge calls that service. Otherwise, it exits the service and goes to 
the TelMerge Communications Menu. 

If you press any key but FlO during an automated session, TelMerge terminates the call 
and switches to hormal interactive mode. If you press FlO during an automated call, 
the current script (including any other calls that follow in the script) is canceled, and 
the phone is hung up. You can automate part of a session and then continue it in in­
teractive mode by leaving out the HANGUP keyword after the last CALL keyword. 

EXAMPLE 

Here is an example of an automated session. 

Service mci 
Print yes 
Number (800)123-4567 
Baud 1200 
Userid kputman 

Logging on 
Ga 11 

Wait command: 
Send dowj 
Wait guery 
Send Ildjnews 
Wait help 
Send . I/EDP 
Pause 2 
Quiet 1 
Send AM 
Pause 2 
Quiet 1 
Send Ilcge 
Wait guery 
Send mpro 
Wait return. 
Send f 
Pause 2 
Quiet 1 

01 

Send disc 
Wait command: 
Send exit 
Hangup 
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Exiting While Online 
While you're online, you may want to check a file before sending it. With TelMerge, 
you can exit a service while online without logging off. To do this, press the F9 (Edit) 
fUhction key, while you're online. You return to the WordStar Opening screen. When 
you are ready to reconnect, restart Tel Merge and press the F8 (Go Online) function 
key. SeleCt the service from the menu. You can skip the automatic log-on process (by 
pressing any key after you reconnect), since the remote computer thinks you have 
been logged on all the time. 

To go to DOS while you're online, press the F3 (DOS) function key of set 2. You can 
use any DOS command or run another program. When you're finished, press Esc to 
return directly to your online session. 

Using Snap Shot and ShoFiI --_________ _ 
Use the F5 (SnapSh) key to save the current screen in your logfile or in memory. You 
can S9,ve up to five screens in memory, but they are saved for the current session only. 
Use the ShoFil function key to look at any file while you're online. 

You can use Snap Shot during ShoFil. For example, if a service displays a list of files 
available for downloading, turn logging on, and ask the service to display the list. 
Logging saves the display on disk. Then press the F8 (ShoFil) function key and ~ to 
view the logfile. Take snap shots of the parts of the list that interest you. Then use the 
Recall function to display them. Find the file you want to download. 

You can use the ShoFil function to create a customized help screen. Edit the previous 
logfile in WordStar to display the information you want to see while you're online. 
For example, you can consol idate all the commands for a given service onto one 
screen. Copy that screenful of information to a file with a descriptive name, like 
C1SHELP.DOC. Then, when you're online with that service, use ShoFil to view the 
screen whenever you want. 

You can also use ShoFil to review the logfile of the current session. To do this, press F8 
(ShoFil) and then press ~. 
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Keywords 
Keywords determine the actions that TelMerge takes. All the TelMerge keywords are 
listed in this section, with explanations and examples of their use. See "Calling a Ser­
vice with Tel Merge" for more information on using each keyword. Press Fl to display 
the current settings for keywords while you're using TelMerge. 

How Keywords Are Sent _____________ _ 

This list shows the order of keywords sent in a call. The NUMBER keyword is 
required; all others are optional. See individual entries for default values for the 
optional keywords (except USERID, HOSTID, FILESEND, and PASSWORD). 

KEYWORD 

PREMODEM 
INIT 
INIT2 
PREFIX 
NUMBER 
SUFFIX 
ATTENTION 
ATDELAY 
ATTENTION 
TERMINAL 
HOSTID 
USERID 
PASSWORD 
LOGON 
FILESEND 

HANGCOM 
POSTMODEM 

DESCRIPTION 

Modem initialization 
Additional modem initialization 
Dial-default ATDT 
Or INTERACTIVE if interactive telex 
Wait for carrier reply from modem 

Wait this many tenths of a second 
If more than one in control file 
If network 
If network 
Or ANSWERBACK for Telex 

In a normal session, TelMerge enters interactive online mode. In an 
automated session, CALL, WAIT, SEND, PAUSE, QUIET, FILESEND, 
and HANGUP take effect. Press FlO to hang up the phone, unless 
there is a HANGUP keyword after the CALL keyword. 
Modem hangs up 
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Special Characters 
The following special characters can be used with TelMerge keywords. 

CHARACTER 

{ 

FUNCTION 

Subsequent characters on the line are ignored. Use this symbol 
to add comments to the control file. 

Waits for your response from the keyboard. If followed by a 
number, your response is limited to that number of characters. 
When used with HOLD, puts the character(s) you type into a 
memory buffer. You can use a ! to assign these characters later as 
an entry for a keyword. (See the HOLD keyword.) 

Assigns the contents of the buffer (as described above) to the pre­
ceding keyword. 

Entries for the modem keywords (lNIT, INIT2, PREMODEM, POSTMODEM, 
HANGUP) and log-on keywords (TERMINAL, HOSTID, USERID, PASSWORD, 
LOGON) can include the following special characters. 

CHARACTER 

\d 

FUNCTION 

Causes a delay of one second. 

Sends the next character as a control character. "E sends a Ctrl-E. 

Sends a caret (") to the remote service. When the caret is the last 
character of a string, no carriage return is sent after that string. 
For instance, SEND Y" sends the letter Y without a carriage 
return. 

Ctrl-M and a carriage return are interchangeable. To send one carriage return, type 
"M". Without the last", a carriage return is added after the string"M, resulting in two 
carriage returns. 

Keyword Listing 

ANSWERBACK Issues your personal ID code at a Who are you request (used 
by telex systems only). 

Usage: 

Example: 

ANSWERBACK string 
ANSWERBACK Charlie 

Telex-based services request your user identification to verify that you dialed correctly. 
The code you type for the answerback string (up to 30 characters) is provided by the 
service when you register. 
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APPEND Adds information from new sessions to the named logfile, without 
starting a new one. 

Usage: APPEND YES 
APPEND NO (default) 

Use APPEND in automated sessions when you make several calls, or to avoid renam­
ing .LOG files to save them. 

ATDELAY 

Usage: 

Default: 

Pauses before sending first character to a service. 

ATDELAY tenths of seconds 

ATDELAY 5 

Some networks require a delay before the first character (usually the ATTENTION 
character-see ATTENTION) can be received. If the service doesn't respond when 
you first call, increase the setting to ATDELAY 20 or ATDELAY 30. 

ATTENTION Issues any special characters required by a service at the 
beginning of transmission. 

Usage: 

Example: 

ATTENTION character 

ATTENTION "C 
(sends Ctrl-C) 

ATTENTION "M 
(sends Ctrl-M or carriage return) 

To specify more than one ATTENTION character, put each one on a separate line fol­
lowing the keyword. You can specify a maximum of six. Supplied automatically for 
preprogrammed services and if NETWORK keyword is used. 

AUTOLOG Turns automatic log-on on and off. 

Usage: AUTOLOG YES (default) 
AUTOLOG NO 

If you are testing a new control file script, you may want to disable the automatic log­
on process by specifying AUTOLOG NO. 

BAUD Sets the rate at which information is transmitted between two devices. 

Usage: BAUD 110 
BAUD 300 
BAUD 1200 (default) 
BAUD 2400 
BAUD 4800 
BAUD 9600 
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TelMerge can use six different baud rates. The lower the baud rate, the slower the rate 
of transmission. When an information service supports various baud rates, there may 
be different phone numbers and charges for each setting. 

BITS Sets the number of bits sent for each character. 

Usage: BITS 7 
BITS 8 (default) 

Already set internally for preprogrammed services. Change as needed when you add a 
new service. 

CALL Used instead of END in automated sessions to call the service. 

Usage: CALL 

All information for contacting a service should be above the CALL keyword in the 
script. When CALL is encountered, Tel Merge calls, attempts to log on, and then ex­
ecutes any subsequent keywords in that script. (See END.) 

CLS (Clear Screen) Clears the display. 

Usage: CLS 

Returns the cursor to the upper-left corner of the screen. 

DUPLEX Determines which computer controls the onscreen display of characters 
you type. 

Usage: DUPLEX FULL (default) 
DUPLEX HALF 

Characters you type can be displayed onscreen by your computer or by the host com­
puter. FULL DUPLEX means the host computer "echoes" your characters to the screen 
as you send them. HALF DUPLEX means your computer echoes the characters. Pre­
programmed services already have the proper DUPLEX setting. 

ELSE See IF. 

EMULATE Enables monitors to behave like different terminals. 

Usage: EMULATE VT100 (default) 
EMULATE VIDTEX 
EMULATE NONE 

Use this keyword to emulate a mainframe terminal. VT100 (ANSI standard) is a widely 
used terminal. VIDTEX (VT52) is used by CompuServe. This emulation is already set 
up in the CIS script. See also FUllSCREEN. 
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VT100 emulation accepts and display:s ANSI standard sequences for cursor movement, 
colors, and special attributes. These sequences include foreground color, background 
color, high intensity, foreground/background reverse, and underlining. Some electron­
ic bulletin boards use these sequences to display color screens with highlighted text. 

VIDTEX (VT 52) emulation accepts and displays sequences for cursor movement and 
printer enabling and disabling. 

END Ignores subsequent commands in a control file script and runs it. 

Usage: END 

TelMerge starts at the service label, reads in the keyword commands up to the END 
command, and calls the service. END is,similar to th~ CALL keyword. CALL is used 
for automated sessions, and END is used for interactive sessions. 

ENDIF See IF. 

EXIT Stops and returns to WordStar. 

Usage: EXIT 

Use with IF/ELSE to end a session if certain conditions are not met. See IF. 

FILESEND Sends an ASCII or WordStar file that you specify. 

Usage: FILESEND filename 

Example: FILESEND \MEMO.WS 

In interactive sessions (no CALL keyword included), the file is sent after you are logged 
on to the service. In automated sessions, the file is sent when Tel Merge encounters the 
FILESEND command. 

FIRST Waits for a particular character from the remote service before 
displaying characters onscreen. 

Usage: 

Example: 

FIRST character 

FIRST p 

Some services send a series of characters before the prompt you need to read. Use 
FIRST to specify the first character you want to display. In the example, thefirst text 
displayed is Please log in, because lip" was specified as the first character to display. 
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FK Programs a Function Key (F7 or F8 of function key set 2) to issue a 
specified command. 

Usage: 

Example: 

FK1,Iabel space string 
FK2,1abel space string 
FKl R,/abel space string 
FK2R,Iabel space string 

FKl R.Email GO_Mail 

In the example, Email defines the screen label for function key F7. R sends a carriage 
return at the end of the command. Go_Mail is the command-go to the electronic 
mail menu. FKl represents F7 and FK2 represents F8. Commands can be up to 60 
characters long. You can program these keys differently for each service. 

FULLSCREEN Works with EMULATE to allow better VT100 or VIDTEX screen 
emulation. 

Usage: FULLSCREEN YES 
FULLSCREEN NO (default) 

Removes the status line q,t the top of the screen to display 24 lines. When you toggle 
logging (F7) or printing (F8) on or off while in FULLSCREEN mode, the status line is 
temporarily displayed to show this change. Then the status line is overwritten or scrolls 
off the screen. 

Goro Goes to a LABEL in the control file. 

Usage: GOTO label name 

Example: GOTO Menu 

GOTO and LABEL are always used together. 

GRAPHIC Uses the extended character set for graphic display. 

Usage: GRAPHIC YES 
GRAPHIC NO (default) 

The extended character set is used by some electronic mail services and bulletin 
boards to enhance screen displays. 
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HANGCOM Gives hangup instructions to the modem. 

Usage: 

Default: 

HANGCOM string 
HANGCOM ATH 

The command ATH tells your modem to hang up. If your modem uses a different 
hangup command, use HANGCOM to specify it in your control file. (See USEDTR for 
more information.) 

HANGUP Used in an automated session to hang up the phone. 

Usage: HANGUP 

To add another call to the automated session, use the NUMBER keyword after 
HANGUP. Specify any keywords that differ from those in the last call. Then type 
the CALL keyword. (See CAll for more information.) 

HARDCOPY See PRINT. 

HOLD Waits for user input from the keyboard, and stores the response in a 
buffer. 

Usage: HOLD? 

A buffer stores information temporarily. Test the buffer contents with the IF and IFNOT 
keywords. You can use the information in the buffer as the response to another key­
word by typing! after the keyword. Stores up to 80 characters. 

HOSTID 

Usage: 

Default: 

Example: 

Issues the host ID code. 

HOSTID string 
No HOSTID is sent 

HOSTI D XYZZY 

HOSTID (up to 30 characters) is the network's internal "phone number" for the ser­
vice you are calling. Include it if you use NETWORK in the script. 

IF, IFNOT, ELSE, ENDIF Tests for a specific condition and proceeds 
accordingly. 

Usage: IF string 
IFNOT string 
ELSE 
ENDIF 

Example: See "Reprogramming TELMERGE.5YS" in the "Shortcuts with TelMerge" 
chapter 

Use together to create program logic for TelMerge. 
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IFNOT See IF. 

INCLUDE Interrupts the current script and runs the script in the included file. 

Usage: INCLUDE filename 

Example: INCLUDE SCRIPT.5YS 

Use INCLUDE to pass control between several files. When the included script is com­
plet~d, TelMerge returns to the original script at the line following the INCLUDE 
keyword. Use as many INCLUDE statements as you want and nest up to four files. 

INIT Initializes the modem before a call is made. 

Usage: INIT string 

Default: INIT ATQOVl E1 F1 

Specify the initialization string for your modem if it differs from the default. In the default, 
AT prepares the modem for a command; QO (zero) sends responses from the modem to 
TelMerge; V1 sends verbal result codes; E1 echoes input to the screen; F1 sets full duplex 
mode. A carriage return follows the string. A \d with INIT adds a delay of one second. 
(See "Special Characters" at the beginning of this chapter.) 

INIT2 

Usage: 

Example: 

Adds other initialization information. 

INIT2 string 

INIT2 ATS 7 = 20 

The string sent by INIT2 follows the INIT string. The example sets the number of 
seconds TelMerge will wait for a carrier signal after dialing. (The Hayes default is 
20 seconds.) 

INTERACTIVE Specifies the phone number of a telex real-time 
(interactive) service. 

Usage:' 

Example: 

INTERACTIVE phone number 
INTERACTIVE P phone number 

INTERACTIVE 9 (800) 555-1212 

Numbers specified can be up to 30 characters long. Include any dialing prefix 
required by your PBX system and the area code. 
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The default dialing mode is tone dialing. The "P" preceding the number in the second 
usage form indicates pulse dialing to the Hayes Smartmodem®. 

See your modem manual for information about special punctuation marks. For the 
Hayes Smartmodem, a comma creates a two-second delay. This is useful for dialing 
out of a local PBX, which requires a second dial tone. 

lABEL Marks a position in the control file as a destination for a GOTO keyword. 

Usage: 

Example: 

LABEL label name 

GOTO MCI 

LABEL MCI 

Each GOTO statement must have a corresponding LABEL. Labels can be up to 80 
characters long. 

llNEDElAY Pauses after each line sent with the F4 (SEND) function key. 

Usage: 

Example: 

LlNEDELAY tenths of a second 

LlNEDELAY 3 

Use LlNEDELAY if the receiving computer cannot keep up with your SEND speed. In 
the example, Tel Merge waits three tenths of a second after each carriage return before 
sending the next line. 

lOGFllE 

Usage: 

Default: 

Example: 

Names the file that records an online session. 

LOGFILE filename 

LOGFILE telmerge.log 

LOG FILE MCI.LOG 

With logging on, the online session is recorded in the current directory (unless you 
specify a pathname for it). The name of the logfile defaults to the service name and a 
.LOG extension. The previous logfile is saved to a .sAV file. The .SAV file from the ses­
sion before that is overwritten. 

lOGGING Sets the initial status of the logging function. 

Usage: LOGGING ON (default) 
LOGGING OFF 

When logging is on, a logfile is opened and incoming information from an online ses­
sion is recorded. You can turn logging on or off during any online session with the 
LOG function key (F7 of function key set 2). 
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LOGON 

Usage: 

Example: 

Automates the log-on process and much of an online session. 

LOGON stringlstringlstring 
LOGON JoeISmithlpasswordl"M"I"M"lf 

LOGON replaces the USERID, PASSWORD, TERMINAL, and HOSTID keywords. It 
automates the session up to the point of logging. You can automate the rest of the ses­
sion with CALL, WAIT, and SEND. LOGON can have up to 80 characters. 

In the example, LOGON logs Joe Smith on to a bulletin board service that prompts 
with First Name?, Last Name?, Password?, Want to see bulletins? (carriage return for 
no), Want messages?, and, finally, a menu in which" f" goes to the file section. The 
vertical bar character (I) after each item in the string sends a carriage return and waits 
for the next prompt. (See the PROMPT keyword.) 

MODEM Defines the type of modem you are using. 

Usage: MODEM AUTOMATIC (default) 
MODEM ACOUSTIC 
MODEM 01 RECT 
MODEM ANSWER 
MODEM HAYES 
MODEM HAYES 2400 

The default is a Hayes Smartmodem that automatically dials and answers. Use 
MODEM HAYES 2400 if you are using the Hayes Smartmodem 2400. 

For an acoustic modem, change the response to ACOUSTIC and dial the service man­
ually. TelMerge resumes operation after the connection is made. Note: If the setting is 
MODEM ACOUSTIC, AUTOLOG is set to NO for that service, even if you specify 
AUTOLOG YES in that script. Once the telephone connection is made, you must com­
plete the log-on procedure yourself. 

For a direct-cabled connection (without modems), change the response to DIRECT. 

For a personal-computer-to-personal-computer transfer, change the response to 
AUTOMATIC or ANSWER. See "Talking to Another Personal Computer./I 

NETWORK Specifies a network to use to contact a particular service. 

Usage: NETWORK TYMNET 
NETWORK TELENET 
NETWORK UNINET 

A network allows you to reach a service with a local phone call rather than with a 
long distance one. If you use the NETWORK keyword, you must use HOSTID as well, 
but you don't need the ATTENTION and TERMINAL keywords. 
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NUMBER Specifies the telephone number for a service. 

Usage: NUMBER phone number 
NUMBER P phone number 

Example: NUMBER 9,,(201)555-1212 
NUMBER P9,,(201 )555-1212 

NUMBER can be up to 38 characters long. Include any dialing prefix required by your 
PBX system and the area code. The commas shown in the examples create two-sec­
ond delays for a PBX that requires a second dial tone. See your modem manual for 
more information about special punctuation marks. 

If you have call waiting and your local telephone company provides a way to disable 
it, you can add the call waiting cancel code to the NUMBER string. Put it before the 
area code of the service number. Call waiting is reinstated as soon as the HANGUP 
signal is issued. 

The default dialing mode is tone dialing. If you have a Hayes Smartmodem, which 
requires pulse dialing, type a P after the NUMBER keyword. 

PARITY Specifies an error-checking procedure. 

Usage: PARITY NONE (default) 
PARITY ODD 
PARITY EVEN 
PARITY ZERO 
PARITY ONE 

This keyword is already set internally for preprogrammed services. For new services, 
change the response to the setting required by that service. 

PASSWORD Issues your password to a service automatically. 

Usage: 

Example: 

PASSWORD string 
PASSWORD BLU EFOX 

Passwords can be up to 30 characters long. If you don't want to include passwords in 
your control file scripts, type the following to have TelMerge prompt you for your pass­
word just before logging on to the service. 

SAY What is your password 
PASSWORD ? 
CLS 
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PAUSE Pauses for the number of seconds you specify to allow the remote 
service to begin sending. 

Usage: 

Example: 

PAUSE number of seconds 

PAUSE 3 

Use PAUSE in an automated session when you don't know how the service will re­
spond. Use PAUSE in conjunction with QUIET to insure that the service is finished 
sending characters. In this example, TelMerge waits three seconds before proceeding 
to the next instruction in your script. 

PORT Specifies the port on your computer TelMerge will use to communicate. 

Usage: PORT COMl (default) 
PORT COM2 

If you use the COMl port for your printer, connect Tel Merge to the COM2 port and 
change the entry for PORT to COM2. 

POSTMODEM Sends a string of characters to an electronic switch after a call is 
made. 

Usage: 

Example: 

POSTMODEM string 

POSTMODEM ATEl Vl"M 

Use POSTMODEM to initialize the modem for the next user. If a PREMODEM com­
mand tells switching equipment to use modem 3, POSTMODEM can unhook modem 
3 to make it available. 

In the example, "ATE 1 " leaves the modem in echo mode. "Vl" uses long responses 
(words) instead of single characters. The ""M" is needed because neither PREMO OEM 
nor POSTMODEM automatically sends a carriage return. 

PREFIX 

Usage: 

Default: 

Example: 

Specifies a condition for dialing a phone number. 

PREFIX string 

PREFIX ATDT 

PREFIX ATMODT 

The Hayes Smartmodem dials the "Dial String," which consists of the prefix, the 
number, and the suffix. 

Entries for the PREFIX keyword can be up to 30 characters long. Begin each one with 
AT and end with a dial command (DT for tone dialing or DP for pulse dialing). In the 
example, MO (zero) silences the modem's speaker during dialing. Check your modem 
manual for more information about dialing prefixes. 
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PRfMODfM Sends a string of characters to the communications port before the 
modem initialization string is sent. 

Usage: 

Example: 

PREMOOEM string 

PREMO OEM "l\d\d\d 

A premodem command (up to 32 characters) can be sent to an electronic switch con­
necting several modems, a corporate phone system with built-in modems, or a 
modem that requires a special command before normal Hayes-type initialization. 

Use" to specify control characters and \d to specify a one-second delay. (See "Special 
Characters" at the beginning of this chapter.) 

In the example, a Ctrl-l (required by some phones with built-in modems) is sent, fol­
lowed by a three-second pause (one second for each \d). 

PRINT Records an online session on your printer or in a disk file. 

Usage: PRINT YES 
PRINT filename 
PRINT port 
PRINT NO (default) 

Example: PRINT LPT2 

PRINT YES sends a record of your session to your default printer. PRINT port sends the 
information to a printer connected to a different port. PRINT filename sends the infor­
mation to a disk file with that name. 

If PRINT is set to YES, turn printing on and off with the F8 (PRINT) function key. Before 
you begin printing, be sure that your printer is ready and has enough paper. 

Printing is initially ON for preprogrammed telex services. Printing begins as soon as 
you connect with the service. You can turn it off and on again with F8. 

PROMPT 

Usage: 

Example: 

Adds new characters to the prompts TelMerge recognizes. 

PROMPT character 
PROMPT J 

A prompt is used by the remote service to tell you that it's waiting for your response. 
For example, in the phrase "Command :" the colon (:) is a prompt, since it is the ser­
vice's signal that it is ready for you to respond. 

These prompt characters are recognized by TelMerge: @,:, =, I,?, >,", and Q. Use 
PROMPT to add up to nine new prompts. Prompts can be up to 14 characters long. 
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PROTOCOL Changes the file transfer protocol. 

Usage: PROTOCOL XMCRC 
PROTOCOL XMCHK (default) 

F5 of function key set 2 (XM REC) defau Its to XMODEM checksum protocol. To use 
the CRC protocol! add PROTOCOL XMCRC to the service script. 

QUIET Waits until no character has been received from the remote service for a 
specified number of seconds before sending new information. -

Usage: 

Example: 

QUIET number of seconds 
QUIET 3 

Use in conjunction with PAUSE in automated sessions. In this example, TelMerge 
waits until no characters have been received for three seconds before followingthe 
next instruction in your script. 

SAY Displays the subsequent text on that line when you run TelMerge. 

Usage: 

Example: 

SAY string 
SAY Check the printer 
SAY . 
SAY and press ~ 
SAY to conti n ue 
HOLD? 

Each SAY command can be up to 80 charac::ters long. Create blank lines by using SAY 
alone with no text. 

SEND 

Usage: 

Example: 

Sends a string of characters and a carriage return to the service. 

SEND string 
SENDIINEWS 

In the example, the word NEWS is sent to the remote service, followed by a carriage 
return. (The slashes are part of an MCI command.) Use SEND in automated sessions. 
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SERVICE Logs on to a particular service automatically. 

Usage: SERVICE CIS 
SERVICE ESL 
SERVICE ITT 
SERVICE MCI 
SERVICE OAG 
SERVICE ONT 
SERVICE RCA 
SERVICE SOU 
SERVICE Telmerge 

CompuServe 
EasyLinkSM 
ITT Telex/TIMETRAN 
MCI Mail 
Official Airline Guides® 
ONTYME® Messaging Service 
RCA TelexlTELEXTRA™ 
The Source Telecomputing 
Another Tel Merge user 

SERVICE is a description of your communications service (up to 32 characters long). 
It appears in the status line when you are connected to that service. Any service not 
listed here can be added with the SERVICE keyword. (See "Adding a New Service 
to TELMERGE.SYS.") . 

If you add a new service without specifying a service name, TelMerge displays Remote 
System when you connect with that service. 

STOPS Sets the number of stop bits. 

Usage: STOPS 1 (default) 
STOPS 2 

This keyword is already internally set for preprogrammed services. Check the service 
requirements for this setting when adding a new service. The default setting works for 
most services. 

SUFFIX 

Usage: 

Default: 

Example: 

Issues a post-dial command to the modem. 

SUFFIX string 
A carriage return is sent 

SUFFIX Ml 

SUFFIX (up to 30 characters) follows NUMBER. In the example, "Ml" turns on the 
modem speaker after the number is dialed. This is useful if you use PREFIX to tell the 
modem to be silent during dialing, but you want to hear busy or no-answer signals 
when dialing is completed. 

The Hayes Smartmodem dials the "Dial String," which consists of the PREFIX, 
NUMBER, and SUFFIX keywords. See your modem manual for more information. 

TERMINAL Specifies your terminal type. 

Usage: 

Example: 

TERMINAL strin~ 

TERMINAL A 
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During an automatic log-on to a network, TERMINAL (up to 6 characters) specifies the 
equipment you are using. Do not use TERMINAL with a preprogrammed NETWORK 
keyword, since these terminal settings are already internally programmed into TelMerge. 

TRY Specifies how many times to redial a busy number before giving up and 
returning to WordStar. 

Usage: 

Default: 

Example: 

TRY number from 1 to 99 

TRY 2 

TRY 9 

When a number is busy, TelMerge does not redial immediately. It waits until the dial­
ing clock registers about 45 seconds. 

USfDTR Controls how TelMerge hangs up the modem. 

Usage: USEOTR YES 
USEOTR NO (default) 

You can use this keyword with modems that have a switch that uses the OTR serial 
port signal to hang L1p. The Hayes 2400 modem can use the OTR switch, but it 
requires special i'nitializatiQn. For this modem, use the INIT2 keyword ("INIT2 
AT&03"). If the phone doesn't hang up when it should, add USEDTR YES to your con­
trol file script and set the modem switch to use OTR. (See also HANGCOM.) 

USfRID Issues your identifying name when you log on to a 
communications service. 

Usage: 

Example: 

USERIO string 

USERIO 1456 

When you subscribe to a communications service, you receive a user 10 code (up to 
30 characters long) that you must send each time you call the service. 

WAIT Waits for a particular string from the remote service before continuing with 
the next instructipn. 

Usage: 

Example: 

WAIT string 

WAIT Command: 

In this example, "WAIT Command:" tells TelMerge to wait until the word "Com­
mand:" is received from the remote service before proceeding. Use WAIT for 
automated sessions. 
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Troubleshooting 
This section lists some commonly reported TelMerge problems and their solutions. 

C AUT ION Some problems have been reported in running Tel Merge with RAM­
resident programs. If you have problems using TelMerge, disable any RAM-resident 
programs you have. To do this, you may need to remove the commands in your 
AUTOEXEC.BAT file that start these programs. Then reboot your computer and 
run TelMerge. 

Connection Problems 
The modem dials the phone, but there is no answer. 

The telephone number in the script for this service is probably incorrect. Be sure to 
include the appropriate prefix ("9" for a PBX or "1" for long distance) and the area 
code. 

The modem dials and connects, but TelMerge doesn't log on to the service. 

There may be something wrong with the script for that service. You may have typed 
the wrong user 10 or password, or specified the wrong baud rate setting for your 
modem. See the "Communications Services" chapter and edit the control file. You 
can also try increasing the character delay. Set the ATOELAY keyword to 20 or 30. 
(See ATDELAY in the "Keywords" chapter.) 

Transmission is erratic, or is cut off when sending a document to a service. 

The end-of-document marker for that particular service may have been inadver­
tently included somewhere in the text of the message. For instance, MCI uses a 
slash ( / ) to indicate the end of a letter. Edit the document and remove the offend­
ing character(s). See the information packet from your service for more 
information. 

Also, check the LlNEOELAY keyword in your control file script. Try increasing the 
LlNEOELAY setting to 10. (See LlNEDELAY in the "Keywords" chapter.) 

303 



TELMERGE 

When connecting to a service, everything freezes. 

Perhaps the keyword in that script is set for PRINT YES, but when you connect to 
the service, your printer is turned off. Turn on your printer and try again. This can 
also happen if you run Tel Merge while using a RAM-resident program. Disable any 
RAM-resident programs, reboot your computer, and run Tel Merge again. 

Screen Display Problems 
During a session, none of the characters typed appear on the screen. 

The service you are using requires half duplex. Edit the control file and add the line 
DUPLEX HALF to the service's script. 

During a session, each character typed appears twice on the screen. 

The service you are using requires full duplex. Edit the control file and replace 
DUPLEX HALF with DUPLEX FULL for that service's script. 

The screen fills with random characters when connected to a service. 

The baud rate of the service and the baud rate of your computer don't match. The 
baud rate information for the service is in the packet that the service sent you. Edit 
the service's script in the control file and specify the proper baud rate. 

During a telex service session, lines in the text wrap before the end of the line. 

Telex services allow fewer than 80 characters across the page. Use a right margin of 
65 in document files to be safe. 

File Problems 
The logfile is erased each time a new session is initiated. 
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TelMerge renames the previous logfile 10gfile.5AV at the beginning of each new 
session. The same logfile name is used for every session and is specified in the 
script for that service after the keyword LOGFILE. If you want to keep old logfiles, 
rename the file after each session or add APPEND to the scripts whose logfiles you 
want to save. (See APPEND in the "Keywords" chapter for more information.) 
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Printing Problems 
Documents do not retain print commands like bold, underline, and overstrike 
when sent. 

Because of compatibility constraints, TelMerge strips all print commands from 
WordStar document files, unless you use a protocol transfer. The balance of the 
document is transmitted faithfully. 

C AUT ION If you are sending files that you created with another word pro­
cesso,- and these files contain print enhancements, you must use a protocol 
transfer. Otherwise, serious problems could occur. 

During a telex service session, certain punctuation marks don't appear in the docu­
ment received. 

The character set for telex is a subset of the typewriter character set. Generally, 
lowercase characters are converted to uppercase. Certain punctuation marks are 
discarded during the transmission, and others are converted. The communications 
service representative can supply more specific information. 
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Using TelMerge 
with Floppy Disks 

Be sure to make a copy of the Tel Merge disk. Always work with the copy and store the 
original in a safe place. 

To Send a Document File 

1 Put your WordStar Program disk in drive A. Put the disk containing your document 
file in drive B. Start WordStar. 

2 Start TelMerge. If you need to change disks, you'll be prompted to do so. Follow 
the onscreen instructions to display the TelMerge Communications Menu. 

3 When you connect with the communications service, press the F4 (SEND) function 
key to send the file. You are prompted for the name of the file to send. Type b: and 
the filename. 

4 When the letter is sent, type the character required by the service to signal the end 
of the letter. Log off from the service and press FlO to hang up. Press FlO again to 
return to WordStar. ' 

5 If you need to change disks, you'll be prompted to do so. 

To Receive a Document File (or Open a Logfile) 

1 Put your WordStar Program disk in drive A and your data disk in drive B. 

2 Start WordStar from drive A, log on to drive B, and start TelMerge. 

3 If you need to change disks, you'll be prompted to do so. Follow the on screen 
instructions to display the TelMerge Communications Menu. 

4 When you finish your session, log off from the service and press FlO to hang up. 
Press FlO again to return to WordStar. 

5 If you need to change disks, you'll be prompted to do so. The logfile is written to 
drive B. 

Note: When you leave TelMerge, remember you're still logged on to drive B. 
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Function Keys 
Te/Merge Communications Menu 
Function Key Assignments _____________ _ 

FUNCTION 
KEY 

Fl 

F5 

F8 

FlO 

LABEL 

Help 

Other 

Go Online 

Exit 

PURPOSE 

Displays Tel Merge function keys and current 
settings 

Creates a new service fi Ie or allows you to 
specify an existing one 

Returns to a service after you go offline tem­
porarily 

Exits the service 

Online Function Key Assignments - Set1 

FUNCTION 
KEY 

Fl 
F2 

F3 

LABEL 

Help 

Set2 

Userl D/Hereis 

PURPOSE 

Explains each function key 

Switches between function key sets 1 and 2 

Sends the user identification code you typed in 
this service's script to the service 

(continued) 
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FUNCTION 

KEY 

F4 

F5 

F6 

F7 

F8 

F9 

FlO 

LABEL 

PassWd/Maii 

SnapSh 

Recall 

Log/WRU 

Print 

Edit 

Hangup 

PURPOSE 

Sends the password you typed in this service's 
script to the service. For telex services, gets 
messages 

Saves current screen in logfile or in memory. 
Saves up to 5 screens 

Displays screens saved with F5 

Turns logging on and off. For telex services, 
issues a WHO ARE YOU command 

Turns printing on and off 

Exits to WordStar while online. Use F8 (Go 
Online) to return to the service 

Hangs up the phone. Be sure to log off from 
your service first if required 

Online Function Key Assignments - Set2 

FUNCTION 

KEY LABEL PURPOSE 

Fl ShoFil Displays any file, including the current logfile 

F2 Set1 Switches between function key sets 1 and 2 

F3 DOS Goes to operating system without disconnecting 
from servic~ (type exit to go back online) 

F4 Send Sends a WordStar or ASCII fi Ie 

F5 XM Rec Receives a file using the XMODEM protocol 

F6 XM Snd Sends a file using the XMODEM protocol 

F7 Userl Can be programmed for your own commands. 
(See the FK keyword) 

F8 User2 Can be programmed for your own commands. 
(See the FK keyword) 

F9 Break Issues an RS-232C break signal (not normally 
used) 

FlO Hang up Hangs up the phone. Be sure to log off from 
your service first, if required. 
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Communications 
Services 

This chapter provides information about TelMerge's preprogrammed services. For 
more information, contact the service directly. When you register with a service, you 
receive the information required to call that service with TelMerge. See "Calling a 
Service with TeIMerge." 

You can also use Tel Merge to call services or networks that are not preprogrammed. 
For instructions, see "Adding a New Service to TELMERGE.SYS." If you use a network 
to call a service, see NETWORK in the "Keywords" chapter. 

CompuServe Information Service 
5000 Arlington Centre Blvd. 
Columbus, OH 43220 
(800) 848-8990 

TelMerge Service Name: CIS 

CompuServe offers an information service as well as electronic mail (EasyPlex and 
InfoPlex®). CompuServe provides business news, computer games, special interest 
group bulletin boards, online conferencing, newspapers, and much more. Note: 
When you call CompuServe, TelMerge uses the CompuServe A protocol to exchange 
files. 

fasyLink by Western Union 
Western Union Telegraph TelMerge Service Name: ESL 
4230 Altha Road 
Dallas, TX 75244 
(800) 527-5184 (Sales); (800) 435-7375 (Help) 

Western Union offers EasyLink electronic mail service (a store-and-forward system), an 
information service called FYI, and a Mailgram service. EasyLink cables your message 
if it can't be delivered by a telex network. 
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ITT Telex and TIMETRAN ___________ _ 

ITT World Communications 
100 Plaza Drive 
Secaucus, Nj 07096 
(800) 922-0184 

Tel Merge Service Name: ITT 

ITT offers telex services, a store-and-forward service (TIMETRAN), and a paper mail 
service. ITT cables your message if it can't be delivered by telex. ITT also offers an 
information service called UPDATE. TelMerge turns logging and printing on automat­
ically for ITT. If you don't want to print your sessions, change the PRINT setting to 
NO. 

A40Mail ____________________________ __ 

MCI Mail Tel Merge Service Name: MCI 
1150 17th St. N.W., 8th floor 
Washington, DC 20036 
(800) 444-6245; (202) 833-8484 (Washington, DC) 

MCI Mail offers an electronic mail service, an information service (in cooperation with 
Dow jones News/Retrieval®), and a courier service. Access to telex networks is also 
available. 

Official Airline Guides _____________ _ 

Official Airline Guides 
2000 Clearwater Drive 
Oak Brook, IL 60521 
(800) 323-4000 

TelMerge Service Name: OAG 

The Official Airline Guides Electronic Edition provides airline schedules and fares for 
commercial air carriers. 

ONTYME Messaging Service --------___ _ 

ONTYME Marketing TYMSHARE TelMerge Service Name: ONT 
2560 North First St. 
San jose, CA 95131 
(800) 435-8880 

ONTYME is an electronic store-and-forward message service that provides worldwide 
local-call access. You can route messages through the telex networks if you want. 
TYMSHARE® has another network called TYMNET®. 
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RCA Telex and TfLfXTRA 

RCA Global Communications 
201 Centennial Ave. 
Piscataway, NJ 08854 
(800) 526-3969 

Tel Merge Service Name: RCA 

RCA provides real-time telex services, TELEXTRA store-and-forward service, and an 
information service called HOTLlNpM. RCA Telegram turns your telex into a telegram 
if necessary. TelMerge turns LOGGING and PRINT on automatically for RCA. If you do 
not have a printer or prefer not to use one, change the PRINT setting to NO. 

The Source Te/ecomputing ____________ _ 

The Source Telecomputing Corp. TelMerge Service Name: SOU 
161 6 Anderson Road 
McLean, VA 22102 
(703) 734-7500 

The Source is an information service that also provides an electronic mail service 
called SourceMailsM. With The Source you can find information on topics ranging from 
business news to sports to stock quotes and more. 
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Introduction 
ProFinder™ helps you keep your files and programs organized and accessible. 
ProFinder displays a file list similar to the one displayed with the DOS DIR command. 
Besides looking at the filenames, you can 

• Scroll up and down through the list 

• Assign a descriptive label to each file so you can identify its contents easily 

• Sort the filenames so you can see the list, for example, in alphabetical order or by 
filenanie extension 

• Locate all the files in a directory that contain certain words or phrases 

• View individual files and search for text within a file 

• Tag any number of files in the directory and perform operations such as deleting or 
copying quickly 

• Print the directory file list 

• Run a program by choosing either the program or one of its data files at the file list 

• Change with one keystroke to a file list for another disk or directory 

• Start WordStar (or another program) from within ProFinder, then use a special "hot 
key" to flip between ProFinder and WordStar as often as you want while you're 
working 

• Automate frequently performed activities by creating and using personal menus 

ProFinder is most useful with a hard disk computer. If you have a floppy disk system 
with a high capacity disk drive, ProFinder may be useful if you have many files on 
each disk. 
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Installing ProFinder 
If you have a hard disk computer, the ProFinder files are usually in the same directory 
as your WordStar files (normally \WSS). If you didn't copy these files to your hard disk 
when you installed WordStar, do so now. Wherever you choose to keep these files, be 
sure that this directory is on your DOS path, so that you can start ProFinder from any 
directory. 

If you plan to run ProFinder from a floppy disk computer, be sure to make a copy of 
the ProFinder disk. Always work with the copy and store the original in a safe place. 

ProFinder has its own installation program, PFINST, which contains monitor and color 
settings and other program configuration settings. Most users don't need to run 
PFINST, but you may find it helpful. You must run the installation program if: 

• You have a gas plasma monitor or other monochrome monitor but have a color 
graphics board in your computer. 

• You move your ProFinder files from one directory to another. (Otherwise, your con­
figuration settings may not be saved and you may not be able to access help.) 

• Your computer is not totally IBM compatible and when you run ProFinder, the sys­
tem freezes or the screen doesn't look right. In this case, set Speed on the Video 
submenu to Slow. 

To run the installation program, type pfinst and press ~. The program asks for the 
name of the directory that contains the ProFinder files. Press ~ to accept the displayed 
name (the current directory), or type the correct directory name and press ~. 

The installation menu appears. To choose an option, move the highlighting to it and 
press ~, or just press the first letter of the option. Follow the onscreen instructions. 
You can press Fl for help with any option. 

Video allows you to change monitor and color settings. 

Sort, File, Locate, Options, and Configuration allow you to change the same setti ngs 
you can change in the ProFinder menus with the same names. More information on 
these options is given later in this manual. Changing settings in PFINST is the same as 
changing the same settings in ProFinder and choosing Save all settings. The Options 
menu has one additional command, Insert, which allows you to set the typing mode 
to insert or overtype for typing information in ProFinder's prompts. 

Restore changes settings for all options back to their original settings, whether you've 
changed them here or from inside ProFinder. 
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The instructions in this chapter are for hard disk users. If you are using ProFinder on 
floppy disks, you'll need to insert the disk that contains the ProFinder files in order to 
start ProFinder, and you may need to do some disk swapping while you're working. 

Running Profinder 
To start ProFinder, type pf and press ~. A list of the files in the current directory ap­
pears on the screen. Each file's name, extension, size, date, and time are shown in the 
same way the DOS DIR command shows them. Disk space information is shown 
below the last file in the list. 

The ten main ProFinder commands are shown on function key tags on the bottom line 
of the file list screen. To use any of these commands, just press the corresponding 
function key or the corresponding number key at the top of your keyboard (use 0 for 
FlO). You can also hold down the Ait key and press the first letter of the command (for 
example, Alt-H for Help). 

Some of the ProFinder commands display menus. To choose a command from a 
menu, either move the highlighting to the command and press ~, or just press the first 
letter of the command. 

When you are using ProFinder, you can press. (period) to go back one step. For ex­
ample, if you are displaying a submenu, pressing. causes ProFinder to go back to the 
previous menu. 

Press Fl (or 1 or Alt-H) whenever you need help for the command you're using. Press 
Esc after you finish reading the help screen to return to where you were. 
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Working with the File List ___________ _ 

When you start ProFinder, the file list is displayed. You can scroll through the file list 
using the keys shown below. 

PRESS 

i or "E 

~ or "X 
-'PgUpor"R 

-- PgOn or "C 

Home or"QE 

End or "QX 

"Home or"QR 

"End or"QC 

"z 
"W 

TO 

Scroll up one filename 

Scroll down one filename 

Scroll up one screenful 

Scroll down one screenful 

Move the highlighting to the top of the screen 

Move the highlighting to the bottom of the screen 

Move the highlighting to the top of the list 

Move the highlighting to the bottom of the list 

Scroll the screen up one filename (highlighting doesn't move) 

Scroll the screen down one filename (highlighting doesn't move) 

You can also press the first letter of a filename to move the highlighting to the next file­
name that begins with that letter. Press the Shift key plus the first letter of a filename to 
move the highlighting to the previous filename that begins with that letter. 

Using File Titles 
On the right side of the file list screen is space for file titles. A file title is descriptive 
text that further identifies a file. You'll find file titles helpful if you have many files and 
sometimes can't remember the name of the file you're looking for. To add or edit a file 
title, move the highlighting to the filename and press ~ (or Tab, "0, or "F). Type the 
title. You can edit the file title with the WordStar editing commands. When the title is 
the way you want it, press ~. 

You can move up in the titles column using i or "E; you can move down using ~ or "X. 

ProFinder stores file titles in a file named TITLES.PF. Each directory that contains files 
with titles has its own TITLES.PF file. When you use ProFinder to copy, move, or de­
lete files, ProFinder also copies, moves, or deletes their titles. 

You can remove the display of file titles from the file list. Press F6 (Options) and 
choose Titles. The default setting for this option is Yes (titles are displayed). Choosing 
the option changes it to No. You can change back to Yes by choosing this option 
again. To quit displaying file titles for longer than the current work session, use the 
Save all settings option (see "Setting the Configuration Options"). 
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Changing to Another Directory 
If you are in a subdirectory, the first line of the list says UPDIR in the file size column. 
This signifies the parent directory. If the directory has any subdirectories, the file size 
column for each of them says DIR. The table below shows how to change to a listing 
of another directory or disk. 

TO CHANGE TO 

Another directory 

Another disk drive 

DO THIS 

Press \ (backslash) and type the name of the directory 

Press: (colon) and type the drive letter, then either press ~ 
to accept the default directory path (\*.*) or type a new 
path and press ~ 

The parent directory 

A subdirectory 

The root directory 

Press. (period), or move the highlighting to the UPDIR line 
and press ~, or press the Backspace key 

Move the highlighting to the DIR line and press ~ 

Press "\ (Ctrl-backslash) 

Displaying Selected Filenames 
To specify which filenames you want to display in the file list, press \, or press F6 
(Options) and choose Directory list. The default directory search path is all files (*.*) 
in the current directory. Edit the search path so that it is the one you want and press ~. 
(You can use the WordStar editing commands.) As soon as you enter the new search 
path, the file list changes accordingly. Some sample search paths are shown below: 

C:\WSS\*.DOC 

C:\MEMO?* 

A:WSS.* 

All files in the \WSS directory with the .DOC extension 

All files in the root directory with filenames that consist of MEMO 
and one more character, with any extension 

All files named WSS with any extension on the disk in drive A 

To display only program filenames (with the .EXE, .COM, and .BAT extensions), press 
F6 (Options) and choose Programs only. The default setting is No. Choosing the 9P­
tion changes it to Yes. 

To display only the names of subdirectories of the current directory, press F6 (Options) 
and choose Subdirs only. The default setting for this option is No. Choosing the option 
changes it to Yes. 

After displaying selected filenames, you can return to the full file list quickly by press­
ing * (asterisk), or you can press F4 or F6 and choose List all files. 
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Sorting a File List 
You can display your directory in several orders. 

To sort the current file list, press F7 (Sort), and choose the options you want from the 
submenu. The default sort order is by Extension, then Name. The options are de­
scribed below. 

Begin sort sorts the file list in the order shown in the sort order box. 

Order of sort .allows you to specify a new sort order. The displayed options, Name, 
Extension, DatelTime, and Size, are the orders you can use to sort. You can use any 
combination of these options for sorting. For each option you choose, another prompt 
asks you for the sort direction; choose either the default, Ascending (regular alpha­
betical), or Descending (reverse alphabetical). Choose the options in the order you 
want them used. For example, if you want to sort first by filename, then by extension, 
choose Name first, then Extension. After you set the sort order, choose Resume or 
press Esc or • (period). When you set up a new sort order, it remains in effect until you 
change it again or exit ProFinder. If you want to keep the sort order longer than the 
current work session, use the Save all settings option (see "Setting the Configuration 
Options"). 

Auto sort allows you to sort all directories automatically as soon as you change to 
them. The default is No; choosing this option changes it to Yes. When auto sort is off, 
if you want to see sorted file lists, you need to sort each list as you display it. When 
you turn auto sort on, it is in effect until you change it or exit ProFinder. To keep auto 
sort on for longer than the current work session, use the Save all settings option 
(see "Setting the Configuration Options"). 

Using the Hot Keys 
ProFinder recognizes two "hot keys." The flip hot key allows you to flip back and 
forth between WordStar and ProFinder. The copy hot key allows you to copy a block 
of text from a file you display with ProFinder into a WordStar file. 

The hot keys can be very handy. For example, if you're not sure of the name of the file 
you want to edit, you can use ProFinder to find the file you want, then automatically 
start WordStar and open the file. While you're editing, you can go back to ProFinder, 
look through several files to find text you want, and mark it as a block. You can then 
go back to WordStar and copy the marked block into your document with a single 
keystroke. 

Flip hot key This is the plus key on the numeric keypad. To use it, start at the 
ProFinder directory display. Move the highlighting to the name of a file you want to 
edit and press +. ProFinder starts WordStar and opens the file you selected. You can 
now edit the file and do any other WordStar operations (save the file, print, open a 
new file, and so on). 
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When you start WordStar using the + key, ProFinder remains in your computer's 
memory. You can access ProFinder from WordStar by pressing + again. You can flip 
back and forth between WordStar and ProFinder as often as you like. When you exit 
WordStar, you return to ProFinder. You can't exit ProFinder until you exit WordStar; if 
you try, ProFinder displays a message and returns you to WordStar. 

You can change the flip hot key from + to another key. You can also use the flip hot 
key to flip between ProFinder and another program instead of WordStar. For more 
information, see "Setting the Configuration Options." 

Copy hot key This is the minus key on the numeric keypad. It works only when you 
have started WordStar from ProFinder (using the flip hot key). When you use ProFinder 
to view a file, you can mark a block in the file (see "Working with Blocks" in "View­
ing Files"). After you flip back to WordStar, while you're editing a file, you can press 
the copy hot key anywhere in the file to copy the marked block. If you are not viewing 
a file with ProFinder, the copy hot key copies the highlighted filename into WordStar 
or, if you have tagged filenames, copies each tagged filename in turn. For example, if 
you want to read several files into a WordStar file, you can tag the filenames in Pro­
Finder, then press "KR from WordStar, and press the copy hot key at the filename 
prompt. Repeat this procedure for each file to be read. Each time you press the copy 
hot key, the next tagged filename appears. 

You can change the copy hot key from the minus key (-) to another key. See "Setting 
the Configuration Options." 

Working with Files 
When you're displaying a file list with ProFinder, you can do several operations on the 
files in the list. These operations are described in the following sections. 

You can select, or tag, any number of files for a file operation. Here's how tagging 
works: 

• To tag a file, move the highlighting to the filename and press F3 or "K. You can 
press F3 again to untag the highlighted file. 

• To tag a group of files, press F4 (Files), choose File tag by wild cards, and type the 
filename, using the * and? wild-card characters. For example, to tag all files with 
the .BAK extension, type *.bak. 

• To see a file list of only the tagged files, press F4 (Files), then choose Select tagged 
files. To return to a full directory display, press * or press F4 or F6 and choose List 
all files. 

• To remove the tags from all files that you have tagged, press F4 (Files), then choose 
Untag all. 

• To retag files that you untagged or that ProFinder untagged after a file operation, 
press F4 (Files), then choose Retag. 

While a file operation such as copying or deleting is in progress, you can press any 
key to interrupt the operation. A prompt asks whether you want to quit or continue. 
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Copying and Moving Files 
To copy files to another directory, press F4 (Files); then choose Copy. To move files to 
another directory or to rename files, press F4 (Files), then choose Move. 

If you have tagged any files, all tagged files will be copied or moved. If you have not 
tagged any files, type the name of the file(s) to copy or move at the prompt that ap:.. 
pears. Inc:lude the drive letter or directory path if necessary. You can use the DOS 
wild-card characters * and? to name a group of files. For example, you could type 
\ws5\*.doc to specify all the files in the \WS5 directory with the .DOC extension. 

At the Copy to or Move to prompt, type the directory you want the files copied or 
moved to. If you have not tagged files, you can include the filename if you want the 
copied or moved file to have a new name. You cali use wild-card characters in the 
filename. 

After you enter the file information, you can start copying or moving, or you can set 
several options. Choose Begin to start. The other options have yes/no settings; you just 
need to choose the option to change the setting. These options are described below. 

Confirm overwrites This option determines whether Profinder asks if you want to 
overwrite an existing file (if you are about to overwrite it in a copy or move operation). 
The default is No. 

Transfer titles This option determines whether ProFinder file titles will be copied and 
moved with files. The default is Yes. 

Verify This option allows you to verify as you copy and move. It is the same as the 
DOS Verify (Iv) option. The default is Yes. 

Skip same version If you set this option to Yes, ProFinder won't over,write an existing 
file that has the same file size, time, and date as the file you are copying or moving. 
This can save time. For example, if you are backing up a directory of files to a floppy 
disk, ProFinder can copy only the files that have changed since you last backed up. 
The default is No. 

If you change any of these settings and want to keep your changes for longer than the 
current work session, Lise the Save all settings option (see "Setting the Configuration 
Options"). 

Deleting Files 
To delete files, press F4 (Files), then choose Delete. 

If you have tagged any files, all tagged files will be deleted. If you have not tagged any 
files, type the name of the file(s) to delete. Include the drive letter or directory path if 
necessary. You can use the DOS wild-card characters * and? to name a group of files. 
For example, you could type \ws5\*.bak to delete all the files in the \WS5 directory 
with the .BAK extension. 

At the prompt, press ~ to begin. The files you tagged or named are deleted. 
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Changing File Dates and Times 
To change the dates and times shown with filenames, press F4 (Files), then choose 
Time/date stamp. 

If you have tagged any files, the date and time of all tagged files will be changed. If 
you have not tagged any files" type the name of the file to stamp. Include the drive let­
ter or directory path if necessary. You can use the DOS wild-card characters * and? to 
name a group of files. For example, you could type \ws5\*.doc to change the date 
and time for all the files in the \WSS directory with the .DOC extension. 

For the date, press ~ to accept the default, which is the current date, or type another 
date and press ~. For the time, press ~ to accept the default, which is the current 
time, or type another time and press ~. (You can type 0 (zero) to omit the time from 
the list.) At the prompt, press ~ to begin. ProFinder changes the dates and times. 

Printing the File List 
To print the file list, be sure your printer is ready. Press F4 (Files), then choose Print file 
list. ProFinder prints the current file list. If you have tagged any files, they are under­
lined in the printed list. 

Writing Filenames to a File 
You c;:an create a file that contains the filenames in the current list. If you have tagged 
files; the file contains only the tagged filenames. Press F4 (Files), then choose Write 
fiI~names. Type the name of the file to write the filenames to and press ~. If the file­
name you type is an existing file, a prompt appears. Press 0 to overwrite the file, A to 
append the new filenames to the end of the file, or Esc to exit. 

Next you can specify up to 20 characters that will appear before (prefix) or after (suf­
fix) each filename in the new file. At each prompt, type the text you want and press ~. 
If you don't want a prefix or suffix, just press ~. As soon as you answer the last 
prompt, ProFinder writes the filenames to the file you specified. 

Viewing Files 
You can use ProFinder to look at the contents of any file in the current file list, and you 
can do several operations with a file you're viewing. To view a file, move the high­
lighting to the name of the file and press F5 (View). Pressing ~ also allows you to 
view the highlighted file. ' 

While you are viewing a file, you can use the cursor movement keys or the WordStar 
cursor movement commands to move the cursor around in the file. For a complete list 
of these commands, press Fl or "J for help while you are viewing a file. You can also 
locate specific text, mark blocks, and use several other commands. The following sec­
tions give complete instructions on how to work with a file you're viewing. 
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File Format 
ProFinder normally assumes the file is in WordStar format. You can usually view ASCII 
files correctly in WordStar format. However, graphics characters from ASCII files are 
not displayed correctly, so you may sometimes need to switch from WordStar to ASCII 
format. You can also view WordStar 2000 files, which have a different format. To 
switch between formats while you are viewing a file, press "QG. 

You can change the default format; see "Setting the Configuration Options." 

ProFinder also automatically recognizes Lotus 1-2-3 files and displays them in the cor­
rect format. When you view a Lotus 1-2-3 file, you can see only the top-left screenful 
of the file; you can move the cursor through the displayed portion of the file, but you 
~an't §<::roll to other portions of it. 

Finding Text 
While you're viewing a file, you can easily find a specific word or phrase. Press F8 or 
"QF and choqse Text to locate. ProFinder prompts you for the text to locate. Type up 
to 20 characters of text and press ~. You can press ~ again at the Begin search 
prompt to begin the search, or you can first change any of the search options. To 
change a search option, choose the option you want to chal"!ge. The options are 
described below. .. 

Whole words only specifies that the text to search for must be whole words. Tbe 
default is No. Thus, if you search for the word "cat" with the No setting, ProFi'nder 
will ·Iocate "concatenation" or "catered." 

Case ignore tells ProFinder to find all instances of the text whether or not any charac­
ters are uppercase or lowercase. T~e default is Yes. 

Lightning synonyms is for Turbo Lightning® users. It allows you to use a Turbo Light­
ning synonym file with your searches. The default is No. 

User synonyms lets you use a synonym file that you create yourself. For more informa­
tion, see "Setting the Configuration Options." The default is No. 

Direction lets you run a forward, backward, or global search. The default is global; 
pressing <E---l toggles among the three choices. 

The settings for these options (except for Direction) apply to locating files as well as 
finding text within a file. If yo~ want to keep your changes longer than the current 
work session, choose the Save all settings option (see "Setting the Configuration 
Options"). 

Once you've searched for specific text in a file, you can press F4 or "L to find the next 
instance of the current search text, and you can press F3 or "QV to find the previous 
instance. 
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Working with Blocks 
While you're viewing a file, you can mark a block within the file. You can then write 
the block to another file or use the copy hot key to copy the block to a WordStar file 
(or to a file in whatever program you use with the flip hot key). See also "Using the 
Hot Keys." 

PRESS 

F7 or "KB 

F2 or "KK 
FlO 

"KH 

F5 or "KW 

F6 or "KP 

TO 

Mark the beginning of a block. 

Mark the end of a block. 

Automatically mark the line the cursor is on as a block (Auto block). 
Press FlO again to add the next line to the block. Mark as many con­
secutive lines as you want. If you mark a line that is not the next line 
below the current block, that line begins a new block. 

Hide the display of the marked block. 

Write the marked block to a new file. At the prompt, type the name of 
the file to write the block to and press ~. If the filename is an existing 
file, press 0 to overwrite the file, A to append the block to the end of 
the file, or Esc to exit. (The block is always written as it is shown on the 
screen.) 

Print the marked block. At the Left Margin prompt, type the number of 
columns you want the text offset from the left edge of the paper, or 
press ~ to accept the default, O. 

Viewing Another File 
While you're viewing a file, you can press F9 or "OK to open another file. If the cursor 
is on a word that is the name of a file in the current directory, ProFinder opens that 
file. Otherwise, at the prompt, type the name of the file you want to open and press ~. 

When you open a file while viewing another one, you can see both filenames at the 
top of the screen. When you press Esc or . (period) to back out of the second file, the 
first file is displayed again. You can view up to three files in this manner. 

Locating files ________________ _ 

ProFinder can find all the files in the current list that contain certain text. For example, 
you can quickly find all your documents that mention Gerald Seagraves, the Houston 
contract, or June 4, 1988. You can also search file titles instead of the files themselves. 
This allows you, for example, to display a list of the files that have "report" or 
"Fjerstad" in their titles. 

Note: When you are searching through WordStar document files, the file format 
should be set to WordStar (the default) for best results. See "Setting the Configuration 
Options." 
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To locate files, press F2 (Locate) at the file list. Then choose Search files by text to 
search for text in files, or choose Find files by title to search in file titles. You can now 
specify the text and set several options, as described below. 

Text to locate You can specify up to three text strings (words or phrases), each up to 
.20 characters long. After you type each search string, press ~, or press Esc when 
you're finished entering search strings. 

Begin search When you choose this option, ProFinder searches for all files (or titles) 
that contain any of the search strings you entered. The file list changes so that it dis­
plays only the files that contain a search string. It also shows which search strings each 
file contains. When you use the View command to examine any of these files, each 
instance of a search string in the file is highlighted, and the cursor is on the first 
instance. 

TIP If you have a lengthy search, you can continue to work while ProFinder 
searches. Just use any commands you want. The search will resume the next time 
you're at the file list and you stop using the keyboard for a few seconds. 

Whole words only tells ProFinder that the text to search for must be whole words. The 
default is No. Thus, for example, if you search for the word "cat," ProFinder will lo­
cate "concatenation" or "catered." 

Case ignore tells ProFinder to find all instances of the text whether or not any charac­
ters are uppercase or lowercase. The default is Yes. 

lightning synonyms is for Turbo Lightning users. It allows you to use a Turbo Lightning 
synonym file with your searches. The default is No. 

User synonyms allows you to use a synonym file that you create yourself. For more 
information, see "Setting the Configuration Options." The default is No. 

The settings for these options apply to finding text in a file while viewing the file as 
well as to locating files. If you want to keep your changes for longer than the current 
work session, use the Save all settings option (see "Setting the Configuration Options"). 

After you finish examining the list of files you located, you can return to the full file list 
by pressi ng * (asterisk), or you can press F2 and choose List all files. 

TIP To avoid lengthy searches of files that you don't want to include in a search, you 
can specify up to 15 filename extensions to skip. Press F2 (Locate) and choose Exten­
sions to skip. You see a preset list of 13 extensions: .EXE, .OBJ, .COM, .LlB, .OVR, 
.BAK, .HLp, .MAp, .DTY, .$$t .SYN, .DCT, and .ARC. To add or change an extension, 
move the highlighting to it and type the extension you want. The new extensions you 
choose are in effect until you exit ProFinder. To make your changes permanent, use the 
Save all settings option (see "Setting the Configuration Options"). 
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Exiting ProFinder 
Press F8 to exit ProFinder. When you use F8, if you've changed from one directory to 
another since starting ProFinder, you exit to the directory you've changed to. You can 
also exit by pressing Esc. When you press Esc, you exit to the directory you were in 
when you started ProFinder. 

If you are running WordStar (or another program) from ProFinder, you can't exit 
ProFinder until you exit WordStar (or the other program). If you try to exit, you'll find 
yourself back in WordStar. For more information, see "Using the Hot Keys./I 

You can also exit by choosing Quit from the menu displayed when you run the Menu 
command (FlO). For more information about using this menu, see "Creating and 
Using Menus./I 
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More About 
ProFinder 

This chapter gives information about more advanced ProFinder functions. You should 
be somewhat familiar with ProFinder before using these functions. 

Setting the Configuration Options _________ _ 

The Configuration submenu of the Options Menu contains several options that you 
can set. To set these options, press F6 (Options) at the file list, then choose Configure. 
When you change a setting, the new setting is used until you exit ProFinder. To make 
the setting permanent, choose the Save all settings option. The configuration options 
are described below. 

User synonym file This option allows you to give the name of the synonym file used 
when you use ProFinder to locate files (or file titles) that contain certain text. If your 
search string contains any word that is the first word in a line of the synonym file, 
ProFinder will search for all the other words in the line as well. 

The default synonym file is USERSYN.PF. You can edit the USERSYN.PF file that comes 
with ProFinder, or you can create another file. To change to a different synonym file, 
choose this option and give the name of the synonym file. 

The synonym file is an ASCII file, which you can create and edit with WordStar in 
nondocument mode. It consists of one line for each word for which you are naming 
synonyms. The line consists of the word followed by all its synonyms. All the words in 
the line are separated by commas. 

Hot key settings This option allows you to change the hot keys, the program started 
by the flip hot key, and the keyboard delay. The four choices are explained below. 
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Program is the program that is started when you first press the flip hot key. Normally 
this is WordStar, in the \WSS directory. You can change this if you keep WordStar in 
another directory or if you want to run another program with the flip hot key. The 
default program command line is c:\wsS\ws-f-e lo-h. The -f and -e insert the high­
lighted filename and extension into the command line. The loh tells WordStar to 
place the cursor at the first instance of ProFinder search text or at the last cursor posi­
tion used when you viewed the file with ProFinder. For more information on these and 
other options, see the list in "Creating and Using Menus." If you enter a different pro­
gram name, you must include the program file extension if it is not .EXE. 

Flip hot key and Copy hot key allow you to change the + and - hot keys to other 
keys. When you choose one of these options, press the hot key you want to use. You 
can use any function key or a combination of the Alt key and a letter, number (not 
those on the numeric keypad), hyphen, or equal sign. The new hot key is in effect as 
soon as you press it. Take care not to select a hot key that conflicts with a WordStar 
command or a hot key for a memory-resident program you use. 

Keyboard delay allows you to set the speed at which your keyboard copies a block 
when you use the copy hot key. The default is 0, no delay. This works fine with 
Word Star. However, if you set up ProFinder so that the flip hot key starts a different 
program, and you notice that you lose characters when you use the copy hot key to 
copy a block, you may need to set a keyboard delay. Try increasing the delay to 1 or 
2; no system should require a delay greater than 5. 

Print margin This option sets the distance from the left edge of the paper where 
printing begins when you use ProFinder to print a file you're viewing. Enter the 
number of columns you want for the margin. 

File format This option sets the format that ProFinder uses when you view a file. The 
default is WordStar. You can choose WordStar, ASCII, or WordStar 2000 format. (This 
setting also changes when you use "QG to toggle file format when you're viewing a 
file.) ProFinder automatically recognizes Lotus 1-2-3 files regardless of which format is 
chosen. 

Tab settings This option determines how document tabs are displayed when you 
view different types of files. You can have different tab sizes for all files with three spe­
cific filename extensions (which you can specify), and one tab size for all other files. 
The defaults are 4 for files with the .C and .H extensions and 8 for all other files. To 
change any extension or tab size, move the cursor to the item you want to change and 
enter the new setting. 

Display fast The default for this option is Yes. If you notice "snow" on your screen 
while you type, you may want to set it to No. When you choose this option, the set­
ting is immediately changed. 

About This option displays program information about ProFinder. 

Save all settings This option saves all the configuration settings and several other set­
tings. Be sure to choose it if you want the new settings to be permanent. If you don't 
save your settings, the new settings remain in effect only until you exit ProFinder. 
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Besides the configuration settings, this option saves the on/off options on the Options 
Menu, the sort order for sorting, automatic file list sorting, settings for four options for 
copying and moving files, settings for four options for locating files or text, and the list 
of extensions to skip while searching for files. If you have changed any of these set­
tings, the new setting will now be the default until you change it again and save the 
setting. You can also change and save these options using the PFINST installation pro­
gram. See "Installing ProFinder." 

Command Line Options 
When you type pf to start ProFinder, you can add other information to have ProFinder 
automatically do certain operations as it starts. The complete command line syntax is 

pf filespec search 1 search2 search3 loption 

filespec is the search path for the file list to display; for example, C:\MEMOS\*.MEM, 
or A:*.*. The default is a file list of all files in the current directory; use a filespec if 
you want to display a different list. If you want the default directory list and you want 
to specify a search string or option, you can put a period (.) in the filespec position to 
indicate *.*. 

search 1, search2, and search3 are search strings. If you specify any search strings, 
ProFinder automatically runs its Locate function, and the file list that appears includes 
only the files that contain any of these strings. If a search string contains any spaces, 
enclose the string in quotation marks. For example, to search all files in the current 
directory for the words yacht and party, type pf • yacht party. To search all .DOC files 
for Apri I 9, 1988, type pf + .doc "April 9, 1988" 

loption is either Ik or 1m. 1m tells ProFinder to display the menu in the file named after 
the equal sign. Ik tells ProFinder to run the commands signified by the keystrokes that 
follow the equal sign. All the keystrokes must be enclosed in quotation marks. For 
example, you can use the Ik option to sort a file list; type pf Ik="{F7} {enter}". {F7} 
chooses the Sort function, and {enter} accepts the default sort order. For more infor­
mation about these options, see "Creating and Using Menus." 

Running Another Program or DOS Command ------
You can run another program or command from ProFinder in several ways. One sim­
ple way is by using the flip hot key; this enables you to run ProFinder and another 
program (usually WordStar) at the same time. Other ways to run a progr~m or com­
mand are described below. 

The Go to DOS Command 
To go to DOS without exiting ProFinder, press F4 (Files), then choose Go to DOS, and 
use any DOS commands you want. When you are finished, type exit and press ~ to 
return to ProFinder. Don't use this command to load a memory-resident program; exit 
from ProFinder first. 

You can't use Go to DOS when you are flipping between ProFinder and Word Sta r. 
(You can use the WordStar command to run a DOS command.) 
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The Run Command 

This command allows you to run a program from ProFinder in two ways. You can't use 
this command while you are flipping between ProFinder and Word Star. 

First, when you move the highlighting to a filename with the .EXE, .COM, or .BAT 
extension and press F9, ProFinder exits to DOS and starts the program. 

Second, when you press F9 while .highlighting files with certain filename extensions, 
ProFinder can start the program you use to edit these files. With many programs, it can 
automatically open the highlighted file. A file named EXTLlST.PF contains a list of 
extensions and one or more commands to run for each extension. 

The EXTLlST.PF file supplied with ProFinder has two extensions. You can add, change, 
or delete items in this file by editing it in WordStar nondocument mode. Notice that 
you can give several commands to be run for an extension. Put each command on a 
new line and indent each of these additional lines at least one column. Use a comma 
between the extension and the first command. This file is shown below: 

DOC,c:\wss\ws-d-p-f-e 
WKS,c: 

cd\lotus 
123 
pf -d -p 

The first line in the file tells ProFinder to start WordStar and open the highlighted file 
when the highlighted file has the .DOC extension and you press F9. From the \WSS 
directory, it types ws followed by the current drive letter Cd), directory path Cp), file­
name C f), and extension (-e). 

The rest of the file tells ProFinder to start Lotus 1-2-3 when the highlighted file has the 
.WKS extension and you press F9, and to restart ProFinder on the current drive (-d) 
and path Cp) after you finish using Lotus 1-2-3. 

The next section, "Creating and Using Menus," contains more information on the 
options you can use in the EXTLlST.PF file. 

Creating and Using Menus 
You can set up a system of menus of things you can do from ProFinder. To display your 
main menu, you press FlO (Menu) at the file list. 

TIP You can have several menus to use in different directories if you want. When you 
choose F10, ProFinder first looks in the current directory for a USERMENU.PF file. If it 
doesn't find one, it then looks in the directory where you installed ProFinder. 
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A sample menu has been set up for you. To choose any option on the menu, move the 
highlighting to the option and press ~ or just press the first letter of the option. You 
can use this menu as it is, or you can change it by adding, modifying, and deleting 
choices. The menu is in a file named USERMENU.PF, which you can edit as a 
WordStar nondocument file. The sample file is shown below. 

>Sample Menu 
Documents,lk = ":c {enter} {F3}\doc{enter} {F7} {enter}" 
<------1 nset ------
Inset ,c: 

cd\inset 
inset 
pf ~d~p 

Remove Inset, e: 
cd\inset 
ri 
pf ~d~p 

< ------PC-Outl i ne----­
Normal version, e: 

cd\pco 
pco Ir 
pf ~d~p 

Small version, e: 
cd\pco 
pco Ir 1m =20 
pf ~d~p 

< ------Other -- ----
Lotus ,e: 

cd\lotus 
123 
pf ~d~p 

Quit ,1m = quitmenu.pf 

Here is the format for the menu file: 

• The menu title ("Sample Menu") begins with a right angle bracket (». This tells 
ProFinder to center the title at the top of the menu. 

• Each of the lines that is a heading on the onscreen menu begins with a left angle 
bracket «). The bracket does not appear on the menu. (The left angle bracket can 
also be used to create an inactive menu item; the menu line appears dim and the 
highlighting skips over the line so that you can't choose it.) 

• Only the lines that are to appear on the onscreen menu start in the first column. 
The other lines must be indented at least one space. 

• The lines that appear on the onscreen menu can be no longer than 30 characters. 
Fewer characters are better; ProFinder automatically adapts the size of the menu 
window to the length of the longest menu line. 
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• Each line that appears on the onscreen menu is separated from the other informa­
tion in the file by a comma. 

• Each line that appears on the onscreen menu causes ProFinder to run all the 
commands following it in the file until the next menu (unindented) line. These 
commands can be any DOS commands. 

The commands in the menu file can include several ProFinder options, which are 
listed below: 

-d This is replaced with the current drive letter and a colon (for example, C:). 

-p This is replaced with the current directory path (for example, \WSS\DOC). 

-f This is replaced with the current filename. 

-e This is replaced with the current filename extension (including the dot). 

-h This is replaced with the hexadecimal offset (position in the file) of the first 
instance of the search text if you've used the Locate command. If you haven't 
used Locate and you've viewed the file since starting ProFinder, the offset used 
is the most recent cursor location. You can use -h with the WordStar 10 com­
mand line option to start WordStar, open a file, and go to this location in the 
file. 

-0 This is replaced with the same offset as -h, but in decimal notation. You can 
use it with any program that recognizes a decimal offset. 

Three special ProFinder commands enable you to use the menu for advanced 
ProFinder functions. They are described below. 

Ik= tells ProFinder to close the menu and then do the ProFinder functions signified by 
the following keystrokes. All the keystrokes must be enclosed in quotation marks 
(" "). For example, the command for the Documents menu line uses the Ik command 
to switch to the \DOC directory and display a sorted file list as explained below. 

Documents,lk =" :c{enter} {F3}\ doc {enter} {F7}{enter}" 

The: displays the disk drive prompt, and c{enter} changes to drive C. At this point, 
the directory path prompt is on the screen. {F3} clears the displayed path and 
\doc{enter} changes the directory to \DOC. {F7} chooses the Sort function, and 
{enter} accepts the default sort order. 

Notice that the names of certain keys are enclosed in curly brackets ({ }). The function 
keys are {F1} through {FlO}, the ~ key is {enter}, and Esc is {esc}. (You can use either 
uppercase or lowercase letters.) 

If= tells ProFinder to place the highlighting at the specified filename. For example, 
pf -d -p If=-f -e would start ProFinder, change to the same directory, and highlight 
the same filename as when you chose the menu option. 

336 



MORE ABOUT PROFINDER 

1m = tells ProFinder to close the menu and then display the menu in the file named 
after the equal sign. For example, the Quit line in the menu reads: 

Quit,lm = quitmenu.pf 

This command displays the menu in the QUITMENU.PF file, which is shown below. It 
works just like USERMENU.PF. It is supplied with ProFinder as an example of a sub­
menu you can construct. 

>Exit to: 
Current directory,lk = I/{F8}" 
Initial directory,lk= I/{ESC}" 
Resume,lk = 1/11 

The first menu line, Current directory, sends ProFinder the F8 command, and you exit 
to the directory of the current file list. The second line sends ProFinder the Esc key­
stroke, and you exit to the directory where you started ProFinder. The last menu line, 
Resume, sends ProFinder no keystrokes, and you return to the ProFinder file list. 

You can construct as many levels of submenus as you like, as long as the main menu 
is named USERMENU.PF. 

Tips for Advanced Users 
ProFinder is great for creating and working with a list of files. Here are a few tips you 
may find useful: 

• Need to create a batch file to do something with several files? Tag the files, then 
choose F4 (Files) and choose Write filenames. Give the filename you want for your 
batch file and give a prefix or suffix (or both) to put commands or other information 
into your batch file. For example, to create a batch file to copy a group of files to a 
floppy disk, use the prefix copy and the suffix a:. The resulting batch file might 
look like this: 

copy filel.ext a: 
copy file2.ext a: 
copy file3.ext a: 

• Here's another way to mark a group of files. Place an identifying tag in the file title 
of each file; for example, make sure each file title contains the characters #1. 
Then, whenever you want to do something with these files, pre~s F2 (Locate) and 
choose Find files by title. Specify #1 as the text to locate. The new file list will 
include only this group of files, and you can copy, move, or do another operation 
with them. 

• It's easy to back up your files to floppy disks. First, tag all the files you want to back 
up. (Use F3 or File tag by wild card on the F4 Files Menu.) Then press F4, choose 
Copy, and name your floppy disk drive. ProFinder copies the files. When the 
floppy disk is full, copying automatically pauses to let you insert another disk. 
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• The example below shows how a programmer can quickly locate and edit all the 
C source files that reference a certain procedure whose argument list has changed. 

338 

1 To see a list of the source files, start ProFinder by typing pf *3 to display all the 
.C and .H files. 

2 To list only the source files that reference a specific procedure, press F2 (Locate) 
at the file list and choose Search files by text. Use the name of the procedure or 
other identifying text as the text to locate, and run the search. 

3 To note which of these files require changes, move the highlighting to each file­
name in turn and press ~ or F5 (View). When you view each file, the cursor is 
on the first instance of the search text. You can scroll through each file if neces­
sary to find if you need to change it. If you need to change the file, when you 
return to the file list, press F3 to tag the filename. 

4 When you finish viewing and tagging files, move the highlighting to the first file­
name you tagged and press the flip hot key (the + key unless you've changed 
it). ProFinder starts WordStar and opens the highlighted file. (The default hot key 
program is WordStar; if you have changed it, you must change it back for this 
step to work.) Edit the file to make your changes, then save it. 

5 Choose the WordStar command to open a file. At the prompt for the file to edit, 
press the copy hot key (the - key unless you've changed it). ProFinder copies 
the next tagged filename from the file I ist. Edit the file, and repeat this procedure 
until you've edited all the tagged files. While you're editing files, you can use 
the flip hot key at any time to flip back to ProFinder to check something about 
your files, then flip back into WordStar right where you left off. 
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Getting Started 
Introduction 

You're about to discover one of the easiest, most comprehensive outlining programs 
available on the market today. With PC-Outline ™ by Brown Bag Software® you can 
quickly arrange large amounts of information into an easy-to-use structure. Once your 
outline structure is in place, finding the information you need is a snap. 

With PC-Outline you can enter your information in any order, and the program keeps 
track of each piece. When you're ready to organize those pieces, PC-Outline provides 
an impressive list of functions to help you. Once your information is organized into an 
outline format, you can use PC-Outline to view or find your information in a variety of 
ways. 

Because PC-Outline keeps track of not only the information, but also the relationships 
to other information, your job is made easier. 

PC-Outline is more than just an outlining program. Its uses are limited only by your 
needs and your imagination. Here is a list of just a few of the ways you can use 
PC-Outline: 

• To-do lists 

• Project planner 

• Daily scheduler 

• Writing tool 

• Word processor 

• Procedure writing 
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• Class notes 

• Law case preparation 

• Project proposals 

• Screenplay writing 

• Electronic scratch pad 

The chapter '~pplying PC-Outline to Your Needs" illustrates some of these uses. 

To use PC-Outline, you need an IBM PC or an IBM-compatible system with at least 
128K of internal memory and a copy of DOS 2.0 or greater. 

To install a printer see Appendix B, "Additional Printer Information." To install a 
monitor, see Appendix C, "Command Parameter Options." 

Installing PC-Outline ™ by Brown Bag® Software 

Note: If your copy of PC-Outline'came with WordStar 2000, you can install it as an 
additional feature of WordStar 2000. Follow the instructions in the "Starting" section 
of the WordStar 2000 documentation. 

IF YOU HAVE A HARD DISK COMPUTER 

This section explains how to install PC-Outline on a hard disk using either 5V4-inch or 
3V2-inch disks. You'll need the disk containing PC-Outline. 

1 Turn on and boot your computer so that the operating system prompt (C» is on the 
screen. 

2 Type md\pco (or any other name you choose) and press ~ to create the directory 
for PC-Outline. 

3 Type cd \ pco (or other directory name) and press ~ to change to the PCO 
directory. 

4 Insert the PC-Outline disk into your floppy disk drive. 

S Type copy a:*.* (or the appropriate drive letter) and press ~ to copy all files on the 
disk into the PCO directory. 

6 Remove the disk from the floppy drive and store it in a safe place. 
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IF YOU HAVE A FLOPPY DISK COMPUTER 

This section explains how to install PC-Outline on a floppy disk system using either 
5%-inch or 3V2-inch disks. You'll need the disk containing PC-Outline, a copy of your 
DOS di.sk, and one blank formatted disk. 

1 Insert your DOS disk in drive A and turn on and boot your computer. 

2 Remove your DOS disk and insert the disk from your PC-Outline package into 
drive A. 

3 Insert the blank formatted disk into drive B. 

4 At the operating system prompt (A», type copy a:*.* b: and press ~. 

5 Remove the original disk from drive A and store it in a safe place. 

6 Remove the copy from drive B and use it as your working copy of PC-Outline. 

Starting PC-Outline 
Note: If you installed PC-Outline to run as an additional feature of WordStar 2000, 
choose Additional features at the Opening Menu. You'll see a list of programs that you 
installed with your word processing software. Choose PC-OUTLINE. 

You can load PC-Outline as a non-memory-resident program or as a memory-resident 
program. These instructions tell you how to load PC-Outline as a non-memory­
resident program. If you want to use PC-Outline as a memory-resident program, read 
the section following these instructions. 

IF YOU HAVE A HARD DISK COMPUTER 

1 Turn on the computer. 

2 At the system prompt (C», type cd\pco (or the name of the directory you created) 
and press ~ to change to the directory containing the PC-Outline files. 

3 Type pco and press ~. 

4 After the program is loaded, you'll see the PC-Outline Opening Menu. 
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IF YOU HAVE A FLOPPY DISK COMPUTER 

1 Turn on and boot your computer. 

2 Insert your copy of the PC-Outline disk into drive A. 

3 At the operating system prompt (A», type peo and press ~. 

4 After the program is loaded, you'll see the PC-Outline Opening Menu. 

Loading PC-Outline as a Memory-Resident Program 

When PC-Outline is loaded as a memory-resident program, it is loaded into your com­
puter's memory once and remains there running in the background while you run 
other software programs. When you want to use PC-Outline, you just press a special 
key combination, and PC-Outline will be displayed right in the middle of your other 
application program. 

Note: If you plan to run the memory-resident version of PC-Outline, load PC-Outline 
before you start up your word processing software. You may want to add the 
PC-Outline loading command line to your AUTOEXEC.BAT file, if you use one. 

To load PC-Outline as a memory-resident program, follow the start-up instructions 
above for your type of computer, with one exception. At the operating system prompt, 
type peo/r instead of just peo. 

This loads the program into memory and displays a short message on your screen. You 
then return to the operating system prompt. 

Once PC-Outline is loaded as memory resident, you can activate it at any time from 
any program by pressing "\ (Ctrl-Baekslash). When you quit PC-Outline, you'll be re­
turned to whatever you were doing before you invoked PC-Outline. You can move 
quickly back and forth between your program and PC-Outline by pressing "\ at any 
time. 

Note: Sometimes when you press "\ it doesn't work. When this happens, press ~. 

TIP If you want to change "\ to another shortcut keystroke, use the KEYSET.COM 
utility program provided on your PC-Outline disk. 

Removing PC-Outline from Memory ________ _ 

If you want to completely remove PC-Outline from memory, follow these steps: 

1 Save all outlines. 

2 Exit PC-Outline and return to your other application. 

3 Exit your other application to return to the DOS prompt. 
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4 Load PC-Outline and position the cursor in the main editing mode where you can 
type into an outline (not in a menu or option box). 

5 Press "Backspace three times in a row. PC-Outline is removed from memory. The 
memory it occupied is recovered by DOS only if there were no other memory­
resident programs loaded after PC-Outline. 

C AUT ION Don't use this command if another memory-resident program is 
loaded after PC-Outline. 

Where to Go from Here _____________ _ 

This manual is divided into four main chapters. Where you start depends on your level 
of familiarity with computers, outlining, and PC-Outline in particular. 

If you're familiar with several software packages, but are new to outlining, start with 
the "Trying It Out" chapter. This guides you through the creation of an outline and 
covers all the options you'll need to make PC-Outline a useful tool. 

If you're famil.iar with other outlining software packages but are new to PC-Outline, go 
directly to the "Reference" chapter. This chapter contains detailed information about 
every menu and function in PC-Outline. 

If you're already familiar with how to use PC-Outline and you want to explore some 
real-life applications, start with the "Applying PC-Outline to Your Needs" chapter. 
This chapter will guide you through several useful applications that demonstrate many 
of the program's features. 

Included with this manual are several sample files that are designed to be used with­
out the manual to help demonstrate key features of PC-Outline. You can either read 
the manual alone, work through the manual in conjunction with the disk-based out­
lines, or load the disk-based outlines and experiment from there. The choice is yours. 
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Trying It Out 
If you've installed PC-Outline properly for your computer, you're ready to try it out. 

In the next few pages, you'll learn some of the basics of PC-Outline, create a new out­
line, work with and change the outline, and print your document. 

If you haven't already done so, start PC-Outline following the directions for your type 
of computer shown in the previous chapter. 

The Opening Menu 

The first screen you see is the Opening Menu. 

WELCOltE TO PC-OUTLIIiE - HAUE FUll! 

The command you want is the first one on the Opening Menu, Open an Outline. If 
the highlighting is not on Open an Outline, use l' or t to move the highlighting to it. 
Press ~ to choose this command. 

The PCO File screen then appears. Type the name of your new outline and press ~. 
1b.e filename can be any legal DOS path and/or filenam.!- withoutan extension. The 
extensIon .PCO is automatically appended to tne hrename you speoty.-=--
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The Working Screen 

After you enter a filename, the working screen is displayed. This screen is the same for 
all work you do with PC-Outline. See the "Reference" chapter for an explanation of 
the different parts of the screen, 

window bar menu bar status column 

t :\PCO\LIST-lk-IIiS-PAGI=1 LIIII=6 COL=5 

1 1 FILE OUTLINE EDIT DISPLAY PRINT HIDE SHOW WINDOW ADVANCED 
--------:12:34 pn-l 

A. ~ 

PRESS THE AL T KEY FOLLOWED BY A MENU LETTER FOR MENUS SZ6k ~==--=-~r-==-.I R~ 
ruler bar message bar 

Typing with PC-Outline 

Typing with PC-Outline is much the same as typing with a conventional word pro­
cessor. Characters are inserted into your outline at the cursor location as you type 
them. If a line gets too long, it automatically wraps to the next line. 

The cursor in PC-Outline is indicated by a reverse video rectangle. The cursor moves 
as you type, or you can move it by using special cursor movement keys located on the 
numeric keypad of your computer's keyboard. These keys are PgUp, PgDn, Home, 
End, t, ~, --, and ~. 
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PC-Outline has several keys to help speed up editing the text of a document. A com­
plete list of these can be found in the "Editing in PC-Outline" section of the 
"Reference" chapter. Two of the most commonly used editing keys are 

• Del Deletes the character on which the cursor is currently located, including car­
riage returns. All other text is adjusted accordingly. 

• Backspace Deletes the character immediately preceding the cursor, including car­
riage returns. All other text is adjusted accordingly. 

Using Menus 
The program options available in PC-Outline appear in one of the nine pull-down 
menus, an example of which is shown below. The title of each of these menus appears 
across the top line of the screen in the menu bar. 

--------IZ:33 rn-l 

Before you create your first outline, remember these points about using menus: 

~ . • Choosing a Menu One way is to press the FlO key. This displays the first menu, 
the File Menu. Another way is to press the Alt key and the first letter of the menu 

~ name simultaneously. 
• Changing Menus To choose one of the other menus, use ~ or~. 

, • Choosing an Option To choose a function on any menu, move the highlighting to 
your selection using t or ,(. and press ~. You can also press the letter preceding 

" the option you want. 
". Leaving a Menu without Choosing an Option At any time before choosing an 

~. 
option, you may bypass all options by pressing Esc. This will return you to the cur­
rent outline with no changes made. 

Shortcut Keystrokes PC-Outline also offers a complete set of shortcut keystrokes 
that can accomplish many of the functions contained in the menus. These keys are 
displayed to the right of the function in the menus. See Appendix A, "Quick Key 
Reference" for a list of all the shortcut keystrokes. 

For more information about using menus and screens, see the "Reference" chapter. 
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Terminology Used in PC-Outline 
This manual and some PC-Outline function names contain special terminology to 
describe an outline structure. The terminology compares an outline to a family tree 
where each member in the family has both parents and children. An outline about a 
family might look something like this: 

A. John and Jan's family 
John and Jan Smith have four children 

1. Their sons 
a. Peter 
b. Pau 1 

2. Their daughters 
a. Kathy 
b. Kelly 

The terminology you'll encounter is as follows: 

,---,. Element or Entry An element or entry is any single portion of an outline, for 
example, "John and Jan's family," "Paul," and "Their daughters." 

'---. Text All text that follows the first line of an element is referred to simply as the 
element's text. The sentence "John and Jan Smith have four children" is the text of 
the element "John and Jan's family." 

'----. Family Elements are arranged in families that consist of the head of the family and 

"--. 
~. 

all of its children, grandchildren, etc. 

Children Children are subelements grouped under an element. The element 
"Their sons" is a child of "John and Jan's family," and the elements "Peter" and 
"Paul" are children of "Their sons." 

Parent Parent is the element under which all elements on a level are grouped. 
The element "Their daughters" is a parent of the elements "Kathy" and "Kelly." In 
turn, the element "John and Jan's family" is a parent of the elements "Their sons" 
and "Their daughters." 

Creating Your First Outline 
Now it's time to build your new outline. You should have a blank working screen on 
your monitor with "A." in the left-hand corner of the screen. Follow these steps to cre­
ate the outline: 

1 Type the word January. 

2 Press the FlO key, use the cursor keys to display the Outline Menu, and choose 
Create New Outline Entry. 
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3 Type February next to I/B." 

4 Continue to enter the months March through June. You can create new elements as 
you did in step 2 above, or you can use the shortcut keystrokes"~ or "N. (Be sure 
to press"~ after typing the word "June.") 

Your outline should now look like this: 

A. January 
B. February 
C. March 
D. April 
E. May 
F. June 
G. • 

5 Use t to move the cursor to the position directly below March, then press~ once. 
You'll notice that this creates the subelement 1/1." 

6 Type July and press"~. Notice that a new subelement is created at the same level 
as 1. By using the cursor keys before you type anything into an element, you can 
change its level. 

7 Type August and press "~. 

8 Move the cursor to the position below June (G.). 

9 Finish typing the outline so it looks like this: 

A . January 
B. February 
C. March 

1. July 
2. August 

D. April 
E. May 
F. June 
G. September 
H. October 
I. November 
J. December 
K. The 13th month. 
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Hiding and Showing Text and Children 
PC-Outline has the ability to hide and show (unhide) various parts of the outline. 
Using the sample outline you've created, follow these steps: 

1 Move the cursor up to "March." 

2 Display the Hide Menu and choose Current Entry's Children. Notice that "1. July" 
and "2. August" disappear from the screen. These elements still exist; they are just 
hidden until you decide to show them again. 

3 You can also hide and show outline elements using the gray + key to the right of 
the numeric keypad. Press the gray + key twice. "1. July" and "2. August" will 
reappear and then disappear again. 

4 Display the Show Menu and choose Current Entry's Children. 1/1. July" and 
"2. August" reappear. 

As you can see, there are many different ways to hide and show outline elements. 

Moving Elements 
Since the months still aren't in order, follow these steps to rearrange them: 

Move the cursor to 1/1. July" if it isn't already there. 

2 Choose Move Outline Entries from the Outline Menu. The element number and 
the element itself will be highlighted. 

3 Using the cursor keys, position "July" under "June." Notice that PC-Outline auto­
matically renumbers the outline as you move the element. 

4 When the element is positioned properly, press ~. The highlighting disappears, 
and your outline should look like this: 

A. January 
B. February 
C. March 

1. Augu5t 
D. April 
E. May 
F. June 
G. July 
H. September 
I. October 
J. November 
K. December 
L. The 13th month 

5 Now repeat the same steps to move "August" to its proper place. 
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Deleting Elements 
You can also delete elements that you don't want. Since there are only twelve months, 
eliminate the last outline entry by following these steps: 

1 Move the cursor to the last line in the outline. 

2 Choose Delete Outline Entries from the Outline Menu. 

3 You will see a message asking you to confirm this deletion. This gives you a chance 
to change your mind since you could accidentally delete an element and all of its 
children with this command. Move the highlighting to "Yes" and press ~ to delete 
the last line. 

Printing an Outline 
When you are finished creating an outline, you'll probably want to print it. To print 
the outline you just created, follow these steps: 

1 Make sure your printer is connected to your computer, loaded with paper, turned 
on, and online. If you don't know how to do any of these things, refer to your 
printer manual. 

2 If any of your outline elements are hidden, choose All Text and Children from the 
Show Menu to expose the entire outline. Parts of the outline that are hidden will 
not print unless you first show them on screen. 

3 Choose Go Start Printing from the Print Menu. Your printer should respond quickly. 
If it doesn't, press "Break (this stops printing) and then repeat all of these steps. 

Note: The printing in PC-Outline is designed for quick, draft printing. If you want to 
take advantage of more elaborate print functions, use the Set Device for Output func­
tion on the Print Menu. This function allows you to convert your outline to various file 
formats. See "Set Device for Output" in the "Using the Print Menu" section in the 
"Reference" chapter. 

Saving an Outline 
Now that you've created and printed your outline, you should save it to disk the way 
you'll save all the outlines that you create in the future. Choose Save Current Outline 
from the File Menu to save your outline. For more information about this function, see 
the "Reference" chapter. 

Quitting PC-Outline 
When you're finished using PC-Outline and have saved all work you want to keep, 
choose Quit PC-Outline from the File Menu. 

Once your work is saved, you'll be returned to the operating system prompt or to the 
other program that was running when you started PC-Outline. 

TIP Remember that you can also return to your other program by pressing "\. 

353 



PC-OUTLINE 

What's Next? 
At this point, you know everything necessary to use PC-Outline. Try creating several 
outlines that you find useful. If you run into trouble, refer to this chapter or read about 
a particular function in the "Reference" chapter. 

Once you're comfortable with PC-Outline, move on to the "Applying PC-Outline To 
Your Needs" chapter. This chapter contains several applications designed to demon­
strate new uses for PC-Outline. See if some of these meet your needs. 
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The first few pages of this chapter tell you how to use the menu system and how to 
enter necessary information. The second part describes the functions that appear on 
each menu. 

U sing the Menus and Screens 
The next few pages explain the methods and options for using the menus and screens 
in PC-Outline. 

Choosing a Menu 
~ You can use two methods to choose a menu: 

• One way is to press the FlO key. This displays the first menu, the File Menu. From 
the File Menu, you can use <- and ----> to move from one menu to another. To choose 
a function from a menu, use t and t to move the highlighting to that function and 

'~ press~. 
• Another quick way to display a menu is to press the Alt key in combination with 

the first letter of the menu you want. For example, to display the Window Menu, 
press Alt-W. 

Choosing a Function from a Menu 

Once you're in a menu, you can use one of these two methods to choose an item: 

• Use t and t to move the highlighting to the function you want and press ~. 

~. Press the letter preceding the function you want. 

. You can also select a function directly from the working screen by pressing the Alt key 
with the menu and function letters. For example, press Alt-FS to choose Save Current 
Outline from the File Menu. 

355 



PC-OUTLINE 

'~ Leaving a Menu without Choosing an Option 
At any time before choosing a function from a menu; you may bypass all options 
by pressing the Esc key. This returns you to the current window without making 
any changes. 

Shortcut Keys 
Many of the more common menu options also have shortcut keystrokes that complete 
the same function. These keystrokes are listed to the right of the option shown on the 
menu. For example, the shortcut for the Current Paragraph Style function on the Dis­
play Menu is "T. 

TIP You can add shortcut keys or change the existing ones using the built-in macro 
facilities. For more information, see "Key Definition" in the "Using the Advanced 
Menu" section of this chapter. For a complete list of original key assignments, see 
Appendix A, "Quick Key Reference." 

Option Boxes 
Some menu selections lead to an option box from which you may change several pro­
gram settings at once. All of these boxes work the same way: 

• To move from one setting to another, use l' and ~ . 

Ii io change a setting, put the cursor on the desired option. The message bar (the bot­
tom line of the screen) indicates what you should do to change the current option. 
There are three types of options: 

Choices Using - or the Spacebar, cycle through the predefined choices for this 
particular option. Use ~ to cycle through the choices in reverse order. You can also 
press the first letter of the desired option to choose it directly. 

Numbers Enter the new number by typing it over the existing number. If you hear 
a beep when you try to leave a number option, it is because you entered an invalid 
number. 

Text Enter the appropriate new text. 

• To confirm a new setting, simply move to another option or press ~ if you're 
finished with all options. If you move to another option, an arrow appears beside 
the setting to indicate that it has been changed. 

• To avoid changing a setting, press Esc or ~ before you move to a new setting. 

• To save your changes to the program start-up file so they will be active the next 
time you start PC-Outline, press FlO. 

• To exit an option box, press ~. 
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Specifying Ranges 
Many of PC-Outline's functions require that you specify a range, or portion of the out­
line, for use with the function. For example, the Copy Block function requires that you 
mark the range of text to be copied. To specify the range, position the cursor at one 
end of the range and then choose the function you want. The range begins at the loca­
tion of the cursor when the function is chosen. To extend this range, use the standard 
cursor movement keys (t, !, PgUp, PgDn, etc.). The range you define is always high-
lighted. 

If you decide you want to cancel the currently selected function while marking the 
range, just press Esc. When you're finished specifying the range, press ~ to complete 
the operation. 

The Working Screen 

window bar menu bar status column 

1 1 FILE oun I NE ED lTD I SPLAY PRI NT H I DE SHOW WINDOW ADVANCED 
:\PCO\LIS.T-lk-IIiS-PAGI=1 LIIII=6· COL=5 --------12:34 P"-1 
~. I . 

PRESS THE ALT KEY FOLLOWED BY A MENU LETTER FOR MENUS 52611 

--1--------1 
message bar 

The screen shown here will be the same for all work you do with PC-Outline. The 
important parts of this screen are as follows: 

• The Menu B~r This is the top line of the screen. Each of the words you see is the 
title of a menu. To view these menus, see "Choosing a Menu." 
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• The Window Bar This is the line immediately below the menu bar. Tbis line con­
..Bins information ahQllt the C! ([[ent window: the complete DOS path and filename 

...... for this outline, the size of the outline in bytes, the insert or overstrike mode indica­
~ j9.r, the cursor position, the system clock time, and the Window number. 

Note: On some IBM-compatible systems, the time may not be the same as your 
system time. If this is the case, you must run the program GOODCLK.COM each 
time you boot your computer before you run PC-Outline. 

• The Status Column This is the column on the right, just inside the window 
border. This column can contain the following symbols: (1) a highlighted down 
arrow directly across from the bottom of an element indicates that there are hidden 
children of this element, (2) a dash means there are no children, and (3) a high­
lighted dash means that there is hidden text. 

• The Ruler Bar This line is located just above the message bar at the bottom of the 
screen. The ruler bar shows the margins, tab stops, and cursor position. 

• The Message Bar This line appears at the bottom of the screen and contains help­
ful information about what you are currently doing. If you get stuck, look at this 
line for help. 

Editing in PC-Outline 
PC-Outline has just one editing mode, whether you're editing text or your outline 
structure. There are different keystrokes available to edit text and outlines. 

fditin.g Text 
Use the following keys to edit text in PC-Outline: 

KEYS 

t J, 

Shift---,> 

Shift-~ 

"Home 

Shift-Home 

"En~ 

Shift-End 

"y. 

Shift-Del 
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Move through text like word processor 

Deletes word to the right 

Deletes word to the left 

Moves cursor to right one word 

Moves cursor to left one word 

Move cursor to beginning of outline 

Move cursor to end of outline 

Deletes text line 

Deletes to end of line 
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Editing Outlines 
Use the following keys to edit the outline structure in PC-Outline: 

KEYS 

i t 

Shift- i 

Shift- t 

Shift-PgUp 
Shift-PgDn 
"PgUp 
"~or" N 

FUNCTION 

Move a family being moved with "M or an empty inserted heading up 
or down from heading to heading 

Moves cursor up from heading to heading on the same (if it exists) or 
higher level 

Moves cursor down from heading to heading on the same (if it exists) 
or higher level 

Move cursor up or down from paragraph to paragraph 

Moves cursor up to parent heading 

Create entry at same level. Immediately press ~ or ~ to change the 
entry level. 

See Appendix A, "Quick Key Reference," for a complete list of all editing and short­
cut keystrokes. 

Using the File Menu ______________ _ 

The File Menu contains the following functions: 

--------12:34 .It-l 

Save Current Outline CS) 
This function saves the current outline under the filename displayed in the upper left 
corner of the window bar. The filename extension .PCO is added to the name. 

359 



PC-OUTLINE 

Each time you save a file, PC-Outline saves the previous version as a backup file and 
gives the backup filename a .BAK extension. To recover a backup version, rename it 
to change its extension from .BAK to .PCO. 

TIP The automatic backup feature can be turned off using the Configuration Settings 
option on the Advanced Menu. 

Load Existing Outline 
Use this function to load a file into the current window from a list of all outlines in the 
current directory. This function replaces the contents of the current window. 

If there are no outline files in the directory, you will be prompted automatically for a 
new filename (see "Start New Outline"). 

TIP The list of files is sorted in date and time order, the newest files first. If you set 
the 005 time and date correctly, you will find the outlines you worked on most re­
cently are the first ones in the list. 

Start New Outline 
Use this function to create a new outline in the current window. The contents of the 
current window are replaced with the new outline. You can enter just a DOS filename 
or a complete path and filename, but do not enter a filename extension. 

8: Sff~tL- ~\\.t'N,,,,,,,v' 
If the filename you type does not exist, a new blank outline is created in the current 
window. If the file does exist, it is loaded from disk. 

Rename Current Outline 
Use this function to rename the outline in the current window. 

To save an outline to a disk drive other than the default drive, simply rename the out­
line by specifying the new drive with the same filename. 

Change Current Drive or Directory 
Use this function to specify a new default drive or directory name. You may specify 
just the new drive, for example, C:, or a complete directory path name, for example, 
C:\OUTLlNE\TODO. 

Outlines in existing windows are still saved to the directory from which they were 
loaded regardless of the current default directory. To save them to a different location, 
use the Rename Current Outline function. 

Note: You can always start from the same directory by specifying the directory name 
using the Configuration Settings function on the Advanced Menu. If no value is spec­
ified, the starting current directory will be set to the DOS current directory when 
PC-Outline is loaded. 
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File Options 

This function displays a submenu of options for directory maintenance. 

Pick a Subdirectory 
Use this function to choose a new current directory from a list of the subdirectories in 
the current directory. 

Set Parent Directory 
Use this function to make the current directory be the directory above the current 
directory in the directory tree. 

Create New Subdirectory 
Use this function to create a new subdirectory in the current directory. 

Erase an Outline 
Use this function to delete an outline from the current directory. You must confirm 
your choice. 

Input Other File Types 
Use this function to read other files into an outline in PC-Outline. 

Read In an ASCII File 
This function inserts the contents of the ASCII file you specify at the cursor position in 
the current window. 

Read In a WordStar Professional 4.0 File 
This function inserts the contents of the WordStar Professional 4.0 file you specify at 
the cursor position in the current window. 

Read In a Structured File 
This function inserts the contents of the file you specify at the cursor position in the 
current window. This type of file is compatible with ThinkTank ™ and Ready! ™ and 
contains outline structure. 

To transfer information from another PC-Outline file, ThinkTank, or Ready! to 
PC-Outline, save an outline in ThinkTank to structured format (or just save an outline 
normally in Ready!), create a blank outline in PC-Outline, and then read the file into 
the blank outline with this function. 

Note: If you want to read in a PC-Outline file, first write the file to a structured format 
using Set Device for Output at the Print Menu. Then read in the structured file using 
Input Other File Types as described here. 

Read In a WordStar Classic 5.0 File 
This function inserts the contents of the WordStar Classic Release 5.0 file you specify 
at the cursor position in the current window. 
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TIP The structured file format has several other uses because it is both an ASCII for­
mat and it maintains the outline format. One way to check spelling in an outline is to 
write it to a structured file format (see "Set Device For Output" in the "Using the Print 
Menu" section), check the spelling, and then read the corrected file back into 
PC-Outline. Because the normal outline file format is not ASCII, it cannot be checked 
for spelling directly. 

Read In a WordStar 2000 file 

This function inserts the contents of the WordStar 2000 file you specify at the cursor 
position in the current window. 

Quit PC-Outline 
Use this function to exit PC-Outline. In the memory-resident version, this function just 
returns you to the application that was active when you started PC-Outline. You can 
also leave the memory-resident version of PC-Outline by pressing A\. 

Using the Outline Menu 
The Outline Menu contains the following functions: 

Move Outline Entries f'M) 
Use this function to move the current element and all of its children to a new location 
in the outline. After selecting the function, you will be prompted to move the entry to 
a new location with the cursor keys. When the element moves, the outline numbering 
is automatically adjusted to reflect its new location. 

Note: When you start this function, the children and text of the element are tempor­
arily hidden to give you a clear view of where you are moving the outline family. 

TIP To move a number of outline elements all at once, use the Mark/Unmark Out­
line Entry and Move Marks commands also located on the Outline Menu. 
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Delete Outline Entries ("D) 

Use this function to delete an outline entry and all of its children. 

Note: You'll be prompted for confirmation before the entry is actually deleted. If you 
don't want to be prompted for confirmation, you can start PC-Outline with the /p com­
mand parameter. See Appendix C, "Command Parameter Options," for more 
information. 

Create New Outline Entry (,,~ or AN) 

Use this function to create a new outline element after the current element at the same 
outline level. 

After you've created the element, but before you've typed anything into it, you can 
move the element to a new location using the ~,-'>, t or t keys. Pressing any other 
key cancels this movement mode. For example, to create a new outline element that is 
a child of the current element, press "~I or" N and then press -'> to indent the new 
entry to the next level. 

Mark/Unmark Outline Entry 2 
Use this function to mark or unmark an element and all of its children. Once an ele­
ment is marked, you can promote, indent, copy, or move it using one of the other 
Outline Menu commands. 

Marking an element marks the entire outline family, and you can mark several ele­
ments before you actually perform some movement activity. You are not allowed to 
mark or unmark any children of a marked entry because they are already marked by 
virtue of their parent being marked. 

To unmark a marked entry, position the cursor at the top of the marked family and 
repeat this function. 

Promote Marks (F7) 

Use this function to move all marked outline elements one outline level to the left. 

EXAMPLE 

Before promoting marks: 

A. Parent Element 

1. First Child 

2. Second Child 

3. Th i r d Chi 1 d ..... t------This element marked 
4. Fourth Child • This element marked 
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After promoting marks: 

A. Parent Element 
1. First Child 
2. Second Child 

8. Third Child ...... l------This element promoted 
C. Fourth Child. This element promoted 

Note: Only the last element on a level or a series of last outline elements on a level 
can be promoted. If you are trying to promote an illegal entry, PC-Outline ignores 
the command. 

TIP To promote an element in the middle of a level, you must first indent all the ele­
ments on the same level. 

Indent Marks (F8) 
Use this function to move all marked outline elements one outline level to the right. 

EXAMPLE 

Before indenting marks: 

A. Parent Element 
1. First Child 
2. Second Child 

3. Th i r d Chi 1 d ...... 1------This element marked 
4. F ou r t h Ch i 1 d • This element marked 

After indenting marks: 

A. Parent Element 
1. First Child 
2. Second Child 

a. Th i r d Ch i 1 d '4 This element indented 
b. Fourth Child..-This element indented 
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All elements but the first one on a level may be indented. If you are trying to indent an 
illegal entry, PC-Outline ignores the command. 

Copy Marks (F9) 
This function copies all marked outline entries to the location following the current 
element at the same outline level. Copy Marks is useful for duplicating a series of out­
line entries several places in the outline. 

Note: You cannot use Copy Marks to copy outline entries to a location within a cur­
rently marked family. This prohibits you from copying an outline family to the position 
immediately after a marked family. To accomplish this task, simply copy it before the 
marked family. If you just want to duplicate the marked element, the order will not 
matter (they are duplicates of each other). If you want to copy it after a marked ele­
ment that isn't the same, copy the original to a location before the location you want, 
and then move it to the location you want using Move Outline Entries. 

Move Marks (Shift-FlO) 
This function moves all marked outline entries to the location immediately following 
the current element at the same outline level. 

Note: You cannot use Move Marks to move outline entries to a location within a cur­
rently marked family. 

TIP Move Marks is useful as an information-gathering function. You can browse 
through your outline, marking all the elements that you want to gather at a new lo­
cation, and then move them to the new location with one keystroke. 

Join Outline Entries (AJ) 
This function joins the current element to the next sequential outline element at the 
same level to form one new element. 

EXAMPLE 

Before joining elements A. and B.: 

A. Fir5t Element. 
8. Second Element 

1. Fir5t Child 
2. Second Child 

C. Third Element 
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After joining elements A. and B.: 

A. First Element. 
Second Element ...... I-------This element joined to A. 
1. First Child 
2. Second Child 

B. Third Element ...... i--------This element renumbered 

Note: The Join Outline Entries function works only when two sequential elements 
are on the same level and the first element does not have any children. 

Divide Outline Entries (AU) 

This function divides one outline element into two elements. Any children of the orig­
inal element are reassigned to the new element. 

EXAMPLE 

Before element A. is divided: 

A. First Element Cursor Here-.-CUrSor on "C" 
1. First Child 
2. Second Child 

B. Third Element 

After element A. is divided: 

A. First Element 
B. Cursor Here LOt Newly created element 

1. First Child .. Children assigned to B. 
2. Second Child 

C. Third Element .. This element renumbered 
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Sort Outline Level 

Use this function to sort all outline elements in one family on one particular level of 
the outline. For example, a sort of the following outline with the cursor positioned as 
shown would sort the elements First, Second, Third, and Fourth Child. 

EXAMPLE 

Before sorting: 

A. Parent Element 
1. First Ch i 1 dl 
2. Second Child 
3. Third Chi ld 

a. Ch i 1 d of Third Child 
4. Fourth Child 

B. Element After Parent 

After a decreasing order sort: 

A. Parent Element 
1. Third Child 

a. Child of Third Child 

·G 

2. Second Child 
3. Fourth Child 
4 . Fir s t Chi 1 dl 

B. Element After Parent 

Note: When an outline level is sorted, the children of each element remain attached 
to it and move along with it in the sort. 

Sorts are controlled by the following settings: 

• Sort Direction Can be either increasing or decreasing order. 

• Type of Sort Can be either (1) Dictionary order: punctuation, numbers, letters 
(without regard to uppercase/lowercase), blanks; or (2) Pure ASCII order: blanks, 
punctuation, numbers, uppercase letters, lowercase letters. 

• Field Number to Sort Can be 0 through 9. 
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A field begins immediately after a colon. For example, there are three fields in the out­
line in the example below. The a field starts at the beginning of each outline entry, and 
each new field begins after a colon. 

EXAMPLE 

A. Parent Element (Field #1) (field #2) 
1. First Child :Name1 :Address1 
2. Second Child :Name2 :Address2 
3. Third Child :Name3 :Address3 

a. Child of Third Child 
4. Fourth Child :Name4 :Address4 

If you sort by the Field 1, the sort is done based on the characters following the first 
colon. When fields are used to their best advantage, they can give PC-Outline some 
simple database capabilities. 

Using the Edit Menu 
The Edit Menu contains the following functions: 

Insert Deleted Text (AIt-V) 
Use this function to restore the last characters you erased or deleted. You can undo the 
deletion if you used commands to delete a block, a word, a line, or the rest of the line. 
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Find String (AF) 
Use this function to search an outline for the first occurrence of any word or phrase 
(string) you specify. There are three settings that control a search: 

• Search for what string? Type the exact string to be searched for. A l may be used 
as a wild-card character to match any character. For example, if you want to find 
all occurrences of either "play" or "pray," you could search for "p?ay." Do not put 
a ? at the beginning of a search word because the first character matches everything 
and will significantly slow down the search. 

• Force case to be the same? A "Yes" answer finds a match only if capitalization 
matches perfectly; a "No" answer finds a match regardless of capitalization. 

• Search scope? Choose Only ON entries to search only the portions of the outline 
that are not hidden. Choose All entries to search the entire outline and unhide any 
parts where a match is found. 

Searches are circular. If you start the search near the end of the outline and no matc­
hes are found, the search will continue at the beginning of the outline. If no matches 
are found on a search, you will just hear a beep. 

Find and Rep/ace (AR) 

This function works exactly the same as the Find String function except that it allows 
you to replace the matching string with another string. Use these three settings, plus 
those described for Find String, to control this function: 

• Replace with what string? Type the exact string you want as a replacement for the 
matched string. 

• Ask before replacing? Specify whether you want to be prompted for confirmation 
before each replacement. 

• All Occurrences? Specify whether you want to replace all matches or just the 
next match. 

Find Again (A A) 
Use this function to find the next match of the last string specified with Find String 
during this session. 

Note: The Find Again function uses the same settings you selected for the original Find 
String operation. 

TIP This function is useful for moving around in the outline. For example, you could 
mark a number of places in your outline with four asterisks (****). You could then 
search for "****" and use the Find Again function to move from one place to the next. 
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Copy Block ("C) 
Use this function to copy a block of text (not outline structure) from one outline loca­
tion to another. Follow these steps to copy a block of text: 

1 Position the cursor at the start or end of the block of text you want to copy. 

2 Choose Copy Block from the Edit Menu or press "c. 
3 Position the cursor at the other end of the block (the text between the two ends will 

be highlighted). 

4 Press ~ to finish marking the block. 

S Position the cursor where you want the marked text copied. You can switch win-
dows with the AIt-# command if you want to copy text to another window. 

6 Press ~ to complete the copy. 

Note: The Copy Block function works on text only. A marked block may span outline 
boundaries, but outline structure is not copied, only the text in each outline entry. 

Move Block ("B) 
This function works just like Copy Block except the text is moved instead of copied 
(the original copy of the text is deleted after the new copy is inserted). 

Delete Block ("E) 
This function works the same as the Move Block and Copy Block functions except that 
the block is deleted instead of copied or moved. 

If any outline elements are left empty after a Delete Block (and they don't have any 
children or their children are also empty), they are deleted from the outline structure. 

Printer Format 
This function allows you to make use of your printer's special features like boldface, 
underline, italics, etc., by inserting codes into your outline that instruct your printer 
where to start one of these special features and where to end it. These are the settings 
to use: 

FUNCTION NAME 

Underline On 
Underline Off 
Boldface On 
Boldface Off 
Italics On 
Italics Off 

370 

FUNCTION KEY 

"Fl 
"F2 
"F3 
"F4 
"FS 
"F6 



FUNCTION NAME 

Superscript On 
Superscript Off 
Subscript On 
Subscript Off 
Double Strike On 
Double Strike Off 

FUNCTION KEY 

Shift-F7 
Shift-FB 
"F7 
"FB 
Shift-FS 
Shift-F6 

REFERENCE 

To use one of these features, position the cursor first at the beginning and then at the 
end of where you want it to take effect, and either choose the appropriate menu 
option or press the function key combination you want. 

The codes appear in one of three ways in your outline: 

• If the cursor is positioned over the character where the code was inserted, the bot­
tom line of the screen tells you what the code is (for example, "BOLDFACE ON"). 

• If the cursor is not positioned over the character and printer code display is turned 
off, the character where the printer code is inserted appears in a different intensity 
than the rest of the text. (See also "Printer Code Display" in the "Using the Print 
Menu" section.) 

• If the printer code display is turned on, the printer code is displayed as a graphics 
character. You can then edit the graphics character just like any other character. 
Graphics characters pointing to the right mean a print feature is on, and graphics 
characters pointing to the left mean a print feature is off. 

TIP The best approach is to turn on the display so you can then edit the codes as if 
they were normal characters. 

Indent Paragraph ("I) 

Use this function to move the left margin of the current paragraph to the next tab stop. 

EXAMPLE 

Before indenting: 

This is a normal paragraph that we will show both before and 
after an indent. You can either choose this function from 
the menu, or you can use the shortcut keystroke AI. 
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After indenting: 

This is a normal paragraph that we will show both before 
and after an indent. You can either choose this function 
from the menu, or you can use the shortcut keystroke AI. 

Repeat this function to indent more than one tab stop. If you want to indent a number 
of paragraphs at once, use Range Paragraph Style on the Display Menu. 

This function can be undone with Clear Indent (AX). 

Indent and Hang (AO) 

This function works exactly like the Indent Paragraph function except that the first line 
of the paragraph is not indented. This is useful for creating hanging indents as shown 
below. 

EXAMPLE 

These next two paragraphs contain examples of hanging indents: 

This paragraph and the one below both contain hanging indents. 
The first line has a left margin of 1 while the rest of 
the lines have a left margin of 6. 

1) This is also a type of hanging indent. The first line is 
not indented so we can type the number where we want it, 
but the rest of the lines are indented to give this 
effect. 

TIP You can undo a hanging indent by choosing Current Paragraph Style from the 
Display Menu and setting First Line Alignment back to SAME AS REST OF PARA­
GRApH and the Left Margin back to 1. 

Clear Indent (AX) 

Use this function to undo an Indent Paragraph command and set the left margin back 
to 1. 
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Page Breaks 
This function allows you to insert two types of page break controls into your outline to 
divide it into separate pages during printing. 

Hard Page Break 
A hard page break instructs PC-Outline to start a new page wherever you insert the 
break. To insert a hard page break, choose this function and type .P. 

A page break appears in your outline in one of three ways: 

• Whenever you position the cursor anywhere in the line where a hard page break is 
located, a ".P" is displayed on the bottom line of the screen. 

• :f the page break is not located on an empty line, the page break location is dis­
played in reverse video. 

• The left-hand column of the screen always contains a square bullet (or quad) on the 
line where the page break is located. 

To delete a page break, position the cursor exactly on the location where you inserted 
it, choose the Page Break function, delete the ".P", and press ~. 

Conditional Page Break 
A conditional page break allows you to specify that a certain number of lines of text 
must stay together on one page. If the lines won't all fit together at the end of the cur­
rent page, a new page will be started before them and all the lines will appear 
together on the top of the next page. 

To insert a conditional page break, position the cursor at the top of the range to keep 
together, choose the Page Break function, and type .C n (n is the number of lines to 
keep together). 

Tab Stops 
Use this function to set tab stops wherever you want. Move the cursor along the ruler 
line when it appears, and set or clear tab stops where you want them. The ruler is 
saved with your outline and affects the entire outline. There is only one ruler per out­
line. 

373 



PC-OUTLINE 

Using the Display Menu 
The Display Menu contains the following functions: 

----1.":34 '"-1 
A. I 

Current Paragraph Style (A T) 

Use this function to control the format of the current paragraph. These optional five 
settings appear in the Current Paragraph Style option box: 

• ParagraphlAlignment Choose one of these four options to control the paragraph 
alignment: 

Left Aligned: Left edge even, right edge ragged. 

Justified: Left and right edges even. Extra spaces are inserted between words to 
align justified paragraphs. 

Centered: Left and right edges ragged. Extra spaces are added before and after the 
line to center it between the margins. 

Right Aligned: Left edge ragged, right edge even. 

• First Line Alignment Controls the left margin setting for the first line of a para­
graph. Choose one of these two options: (1) keep the first line the same as the rest 
of the paragraph, or (2) make the first line flush left. 

• Left Margin Controls the starting left column for each paragraph. Left margin val­
ues are always relative to the start of the outline entry. For example, a left margin of 
1 always starts in the first column of the outline entry regardless of how far indented 
the outline entry is. If the outline entry is indented 12 spaces, a left margin of 1 
starts in column 13 (12 + 1). 

• Right Margin Allows you to change the right margin. Like the left margin, the 
right margin is relative to the start of the outline entry. For example, a right margin 
of 65in an outline element that is indented 12 spaces is actually in column 77 
(12+65). 
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See "Even Right Margins" for a discussion on how to set the right margin to an 
absolute column (instead of a relative column as described above). See "Range 
Paragraph Style" for a discussion on how to set several paragraphs all to the same 
format. 

• Make Default Settings Use this function to make the default paragraph settings 
the same as the current paragraph settings. This setting is an easy way to change 
the default settings and works just like the Default Paragraph Style function. 

TIP When you first start a new outline, choose Current Paragraph Style and set 
the margins you want for the current document. Then answer "Yes" to this ques­
tion, and all subsequent paragraphs will get the new format. 

Range Paragraph Style 
This function works just like the Current Paragraph Style function except that it 
prompts you to mark a range and modifies the paragraph format for the entire range. 

The settings in the Range Paragraph Style option box are identical to those in the Cur­
rent Paragraph Style option box except that this function does not include the default 
settings choice. See the previous discussion on "Current Paragraph Style" for a 
description of each setting. 

Note: Only the settings that you actually change (marked with an arrowhead) will be 
applied to the range. If you want a setting that is already correct to be applied to the 
range, you must reenter the setting. For example, if the right margin already says 70 
and you want it to be 70, you must reenter the 70 before it wi II work properly. 

Default Paragraph Style 
This function controls the format of all future paragraphs created whenever you press 
the ~ key. The settings are the same as those for Range Paragraph Style and Current 

\. Paragraph Style. See those previous sections for a discussion of the settings . 
. '~ 

Pressing FlO in this option box saves the current settings to the configuration file 
PCO.CFG so that they will be loaded automatically the next time you start 
PC-Outline. 

Global Outline Style 
This function leads to an option box that contains 20 settings that control the outline 
format. 

Indent Per Outline Level 

Use this setting to specify the number of spaces of indent per outline level. The default 
value is 3 spaces per level. You can change this setting to any value between 0 and 20. 
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"~. 
Spaces For Numbering 
Use this setting to specify the indent for the top outline level (the numbers for the top 
outline level have to fit in this number of spaces). This defaults to a value of 4. If you 
set it to less than 4, some of the numbers may be truncated. 

TIP Roman numerals in particular require a setting of at least 6. If you ever get a 
numbering sequence that looks like I, II, II, it is probably because you haven't 

'~ increased the spaces for numbering to 6 and the leftmost I in 11/ is being truncated. 

First Entry Number 
This setting allows you to control the beginning number of the top level of your out­
line. A setting of 1 starts the top level with lorA or I, etc., depending on which 
numbering type you choose. A setting of 3 starts the top level with 3 or C or III, etc. 

Note: This setting is provided in order to allow you to link the numbering styles of sev­
eral outlines. For example, because each outline is limited to 64K, you could divide a 
very large outline into several smaller outlines and specify their first entry numbers 
accordingly. 

Numbering Type 
This setting gives you global control over the type of numbering scheme. The global 

"~ options are as follows: 

• Sequential Numbering: A, 1, a, ••• When you select sequential numbering, the 
numbering style for each level of the outline is determined by the eight levels of let­
ters and punctuation you set. You can choose from five different letter or number 
combinations for each level. You can then specify the punctuation you want for 
each level. For example, you could set sequential numbering as follows: 

EXAMPLE 

A. First Level 
1. Second Level 
2. Second Level 

a) Third Level 
b) Third Level 

B. First Level 

• Procedural Numbering: 1.2.2.1.3 Use this option to set the entire outline to pro­
cedural numbering. 
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EXAMPLE 

1.0 Fir5t Parent 
1.1 Fir5t Child 
1.2 Second Chi ld 
1.2.1 Child of Second Child 

2.0 Second Parent 
3.0 Third Parent 

• Bullets This option sets the entire outline to bullet numbering. This option is in­
cluded only for compatibility with earlier versions and should no longer be used. 
Marks will not show up in your outline if you are using this setting. The best way to 
achieve bullet numbering on all levels is to set this option to sequential numbering 
and set all eight levels to bullets. 

• None This option turns all numbering off and has the same effect as setting the 
indent per level to 0 and spaces for numbering to O. 

Place Outline Entry 
This function gives you ultimate control over the left/right placement of each outline 
entry. Follow these steps to place an outline element: 

1 Position the cursor on the element to be placed. 

2 Choose the Place Outline Entry function. 

3 Using - and~, position the outline element where you want it. 

4 Press ~ when the element is properly positioned. 

Note: The distance you move an outline entry is always relative to its default position. 
If you move it three spaces to the left of its default position, it will always be in that re­
lational position even if you change the default position. 

TIP This function can be combined with Skip Numbering to add nonoutline format­
ted text in the middle of an outline formatted document. 

You can undo a Place Outline Entry by either placing it back to its default location or 
resetting all places with the Reset All Places function. 

Reset All Places 
This function resets all outline element place values to their default locations. 
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Start New Numbering 
This function restarts the numbering of the current element so that this element is 
numbered as the first element on that level. 

Note: This function affects appearance only. Functions such as Sort and Hide ignore 
Start New Numbering. 

Skip Numbering 
Use this function to skip the numbering of the current element. To undo this function, 
use Reset Numbering. 

TIP This function can be very useful for inserting nonoutline formatted text in an out­
line structure. You can also combine this function with Place Outline Entry to insert 
nonoutline formatted text in an outline structure that is not indented with the rest of 
the structure. 

Reset Numbering 
This function resets the numbering of the current element to its default appearance by 
undoing Start New Numbering and Skip Numbering. 

Title Toggle 
Use this function to skip numbering on the first outline element. This works as a tog­
gle. If the first element is numbered, its numbering will be turned off and vice versa. 

Once you set the title on, you may type the title as if PC-Outline were a word proces­
sor. In fact, if you start a blank outline and turn the title on immediately, PC-Outline 
will work just like a simple word processor. 

Even Right Margins 
Use this function to align the right margins of a number of differently indented outline 
entries, usually before printing. This function prompts you first for a range over which 
you want to align the right margin and then for the new right margin. 

Note: Unlike other right margins that are relative to the start of the outline entry, this 
right margin is an absolute column number. This function goes through each para­
graph in the range and calculates where to set the relative right margin in order to 
have it appear in a particular printed column. 

TIP During the normal process of creating an outline, you will end up with a right 
margin that moves further to the right as the indentation in the outline increases. To 
align the right margin right before printing, choose Even Right Margins, mark the 
whole outline, and enter the right margin you want. 
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Using the Print Menu 
The Print Menu contains the following functions: 

Go Start Printing ("P) 

This function starts printing the current block. If no range is marked, the entire outline 
is printed. 

Note: Some printers do not print bullets correctly. If you experience problems printing, 
either create a printer substitution file to correctly print bullets or remove the bullets. 
See Appendix B, "Additional Printer Information," to solve other printer problems. 

Set Range to Be Printed 

This function allows you to specify only a portion of the outline to be printed. After 
you select this function, you're prompted to mark a range to be printed. 

Set Device for Output 

This function allows you to specify the destination for printing. You will usually use 
this function to write outlines to other files as described below. 

• Send to Printer Prints normally to the printer. 

• Send to File Sends the exact same information that would have gone to the printer 
to a file instead. The file will automatically have the same root name as the outline, 
but with the extension .PRN. You can then use the DOS print command to print 
this file. 

• Send to ASCII File Strips out all printer information and other non-ASCII charac­
ters, such as page breaks, page numbering, etc., and sends the output to an ASCII 
file. Every line in the outline is terminated with a hard carriage return. When you 
choose Go Start Printing, you're prompted for a filename. This option can be 
useful for transferring outline formatted material to your word processor. 
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• Send to WordStar Professional 4.0 File This option converts the outline to 
WordStar Professional Release 4 file format. Save the converted file in WordStar 
before printing it. 

• Send to WordStar Classic 5.0 File This option converts the outline to WordStar 
Classic Release 5 file format. Save the converted file in WordStar before printing it. 

Ii Send to Structured File Creates.a specialiy formatted ASCII file that has ASCII out­
line formatting information embedded in it describing the outline structure. 

• Send to WordStar 2000 File This option converts the outline to WordStar 2000 
file format. WordStar 2000 high bits are retained for paragraph formatting when 
reading the file into WordStar 2000. Save the converted file in WordStar 2000 
before printing it. 

Note: After you execute a Go Start Printing function, the Device for Output is set 
back to the printer . 

. ~ Set Page Format 

Use this function to select settings for many of the page formatting options like page 
size, margins, etc. The settings are as follows: 

Ii Top Margin Sets the number of blank lines at the top of each page. The top mar­
ginmust be less than the number of lines per page minus the bottom margin. 

• Bottom Margin Sets the number of blank lines at the bottom of each page. The 
bottom margin must be less than the number of lines per page minus the top mar­
gin. 

• Lines per Page Sets the total number of lines per page, including top and bottom 
margins. A standard printed page is 66 lines long with 53-55 lines actually printed. 
The number of lines per page must be greater than the top margin plus the bottom 
margin. 

• Left Print Margin Sets the number of qlank columns at the ieft side of each page. 
Although the default value is 5, setting this to 0 allows you full access to the whole 
page. 

• Printer Feed You have two choices based on the type of printer you have: (1) Con­
tinuous prints the entire document on continuous feed paper without interruption, 
and (2) Pause after each page pauses at the end of each printed page for inserting a 
new sheet, 

• Page Numbering You have five options for page numbering: left, right, centered, 
manually specify the column number for the page number, and off (don't print any 
page numbers). 

• Page Column for Numbering If page numbering is set to Manually Specified, this 
option controls the starting column of the page number. 

• Start Page Numbering With Starts page numbering with this value. Typically this 
is set to 1. 

• Page Breaks Determines whether you produce a document with page breaks or a 
continuous document with no top or bottom margins and no page breaks. 
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Set Printer Font 
This function sends a code sequence directly to your printer to set it to a certain type 
characteristic. The built-in options are as follows: 

• Boldfaced 

• Italics 
• Double strike 

• Condensed 

• Elite 

Note: This function immediately sends your printer a printer code and changes the 
mode of the printer for all subsequent printing. You can use it for printing an entire 
document in a particular font or for changing your printer so that some other program 
will print in the desired font. Don't confuse this function with Printer Format in the 
Edit Menu which is used for actually embedding print commands within a document. 

See Appendix B, "Additional Printer Information," to customize these options for your 
printer. 

Advance Printer One Line 
This function sends a line feed to the pririter. 

Advance Printer Page 
This function sends a form feed to the printer. 

Printer Code Display 
Use this function to display or hide (toggle with AIt-F1) the embedded printer codes on 
the screen. These are the Printer Format codes available from the Edit Menu. 

Note: This option distorts the onscreen location of certain parts of your outline, since 
the codes take up space onscreen that they don't take up in printing. 
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Using the Hide Menu 
The Hide Menu contains the following functions: 

41 

I 

r
: \PCO\LIST-lk-IIS-PAGE=l LIIE=~ 

A. I 

Current Entry's Children ("H) 

Use this function to hide all the children of the current element. You can also use 
the gray + key as a toggle to hide and show the children. 

EXAMPLE 

Before hiding the children of First Child: 

A. Fir5t Parent 
1 . Fir 5 t Chi 1 dl 

a> Fir5t Grandchild 
b> Second Grandchild 

2. Second Child 
a> Fir5t Grandchild 
b> Second Grandchild 
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After hiding the children of First Child: 

A. First Parent 
1 . Fir s t Chi 1 dl 
2. Second Child 

a) First Grandchild 
b) Second Grandchild 

All Children at Level (" L) 
Use this function to hide all the children of all the outline elements at the same level 
within the same family as the current element. 

EXAMPLE 

Before hiding all children at level: 
" 

A. Fir~:;t Parent 
1. First Child 

a) First Grandchild 
b) Second Grandchild 

2 . Sec 0 n d Chi 1 d. 
a) First Grandchild 
b) Second Grandchild 

8. Second Parent 
1. First Child 

a) First Grandchild 
b) Second Grandchild 

2. Second Child 
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After hiding all children at level: 

A. First Parent 
1. Fir s t Ch i 1 d ...... ,....-----Children hidden 
2. Second Chi ldl .. Children hidden 

B. Second Parent 
1. First Child 

a) First Grandchild 
b) Second Grandchild 

2. Second Ch il d 

Note: This function can be reversed using All Children at Level on the Show Menu. 

Current Entry's Text 
Use this function to hide all text following the first line of the current element. You 
can also use "PgDn as a toggle to hide and show all text fo1lowing the first line of 
the current element. 

All Text at Level 
Use this function to hide all text at the current level. This function operates on the 
same outline entries as All Children at Level except that text is hidden instead of chil­
dren. 

All Text in Outline 
Use this function to hide all text in the outline. 

Using the Show Menu 
The Show Menu contains the following functions: 

A. I 
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Current Entry's Children 
Use this function to show all the children of the current element. You can also use the 
gray + key as a toggle to show and hide the children. 

All Children at Level 
Use this function to show all the children of all the outline elements at the same level 
within the same family as the current element. This function is the reverse of All Chil­
dren at Level on the Hide Menu. 

Current Entry's Text 
Use this function to show all text following the first line of the current element. You 
can also use "PgDn as a toggle to show and hide all text following the first line of the 
current element. 

All Text at Level 
Use this function to show all text at the current level. This function operates on the 
same outline entries as All Children at Level except that text is shown instead of chil­
dren. 

All Text in Outline 
Use this function to show all text in the outline. 

All Children in Outline 
Use this function to show all children in the outline. 

All Text and Children 
Use this function to show everything in the outline. 

All Family Children 
Use this function to show all children, grandchildren, etc., of the current element. 

All Family Text 
Use this function to show all text in each of the children, grandchildren, etc., of the 
current element. 
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Using the Window Menu 
The Window Menu contains the following functions: 

A. I 

Load Outline New Window 
This function works exactly like Load Existing Outline on the File Menu except that 
the outline is loaded into a new window. Both the current outline and any other out­
lines already open are all open at once. You can have up to nine windows/outlines 
open at one time. 

The window number appears in the upper right corner of the window. You can switch 
directly between windows by either pressing the Alt key and the number of the win­
dow you want or by using the Transfer Windows function on the Window Menu. 

New Outline New Window 
This function works exactly like the Start New Outline function on the File Menu 
except that the outline is started in a new window. 

Close Window 
Use this function to close the current window and release its memory for use by other 
windows. If you have made any unsaved changes to the current window, PC-Outline 
will prompt you to save these changes. 

Note: You cannot close the last remaining window because there must always be at 
least one window open. 

Move Window 
This function allows you to reposition the currently active window on your screen 
using the cursor keys. Since the window can't be moved off the screen, you must first 
reduce its size before you have any room to move it. Use the Size Window function or 
the Zoom Window function to reduce the window size. 
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Size Window 
Use this function to change the size of the currently active window. Use the cursor 
keys to move the lower right corner to the new size. 

Note: You cannot make a window smaller than 4 lines high by 7 columns wide. 

Arrange Windows 

Use this function to return all windows to their default size and position. When win­
dows are in their default position, they line up neatly in overlapping fashion showing 
you the top line of every open window. 

Transfer Windows (Alt 1-9) 

Use this function to switch directly to the specified window. 

List Windows ("Z) 
Use this function to list all the open windows, their window number, their memory 
size, and whether any unsaved changes have been made to the window. 

Zoom Window 
Use this function to shrink (or expand) the currently active window from full screen 
size to partial screen size (or vice versa). You can use the gray - (minus) key to toggle 
the screen sizes. 

TIP The best way to use the Zoom Window function is to use the Arrange Windows 
function to unzoom all the windows, switch to the window you want, and then zoom 
it to full size for working. When you want to go to another window, un zoom the cur­
rent one, switch to the window you want, and zoom again. 

Copy Family ("Q) 

Use this function to copy the entire family (the element, all children, all grandchil­
dren, etc.) of the current element and make it a child of the location you specify. 
Follow these steps to use th is function: 

1 Position the cursor at the top of the family you want to copy. 

2 Choose this function. 

3 Move the cursor to the new location for the family. You can even switch windows 
(press Alt and the window number to switch to). 

4 Press ~ to start the copy. 

Note: This function is primarily designed for copying families of outline structure be­
tween windows. The Mark functions on the Outline Menu are usually easier to use for 
copying within the same outline. 
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Move Family ("W) 
This Function works exactly like the Copy Family function except the family is moved 
instead of copied. 

Using the Advanced Menu -----------_ 
The Advanced Menu contains the following functions: 

1 LI 
fl. I 

Configuration Settings 

This function allows you to change 13 of PC-Outline's default settings. To permanently 
save the settings to the configuration file, press the FlO key from within the Configur­
ation Settings option box. 

The configuration settings are: 

• Cursor Delay Specify "Yes" if you want to change the cursor delay, or "No" if 
you don't want to change it. 

• Speed of Cursor 1-240 You can type a number between 1 and 240 to change the 
speed of the cursor movement in PC-Outline. The fastest speed is 1 and the slowest 
speed is 240. 

• Starting Directory Path Sets the starting directory for PC-Outline files. If this field 
is blank, the DOS current directory will be used as the starting directory. If you al­
ways keep your outlines in the same directory, enter that directory here. The name 
entered in this field must be a complete DOS directory name (including optional 
path). 

• Macros File/Path Sets the pathlfilename for macro files. This defaults to 
PCOMAC.CFG (in the current directory). If you want to keep your macro files in a 
directory other than the current directory, enter that name here. The name entered 
in this field must be a complete DOS directory name (including optional path). 
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• Printer Description File Sets the pathlfilename for the printer description file. 
The name entered in this field must be a complete DOS directory name (includ­
ing optional path). See Appendix B, "Additional Printer Information," for more 
information. 

• Configuration File/Path Sets the pathlfilename for the configuration file 
PCO.CFG. Use this option if you want to keep your configuration file in a location 
other than the current directory. When PC-Outline starts up, it looks for its config­
uration file in three places: 

1. In the current directory. 
2. In the directory and filename specified in the environment with the 

"SET PCO = <path/filename>" command. 
3. In the directory and filename specified as a command parameter with the 

"/L = <pathlfilename>" command. 

If a valid configuration file isn't found in any of these places, PC-Outline starts up 
with built-in default values for all configuration settings. 

• Automatic Timed File Saving If this is set to "Yes," the current outline will be 
saved at regular intervals as determined by the value entered in Time Between 
Automatic Saves. The outline will not be saved if no changes have been made. 
Only the current window is saved; other changed windows are not saved. 

• Time Between Automatic Saves If Automatic Timed File Saving is set to "Yes," 
this value determines how long a time interval passes between automatic saves. 

• Create Automatic Backup Files If this is set to "Yes," each time you save an out­
line, the previous version becomes the backup file. 

• Prompt Before Overwriting If this is set to "Yes," you are prompted for con­
firmation before an existing file is overwritten during a save operation. If this setting 
is set to "No," no warning will be given. 

• Video Retrace This setting is provided to speed up screen performance on some 
computers. If you have a monitor capable of displaying graphics, experiment with 
setting this on "No." If you see snow on the screen every time you type, you can­
not use this setting and should set it back to "Yes." If you don't see any snow on 
the screen, you can use this setting and should leave it set to "No." You can also 
set video retrace to "No" by using the command parameter "/5." 

• Printer Port Sets the printer port for all printing in PC-Outline. The possibilities 
are LPT1, LPT2; LPT3, COM1, COM2, and COM3. 

• Force Black and White If you have a graphics monitor that isn't color, PC-Outline 
will try to use color attributes on it. If you would prefer to only use black and white 
attributes, set this option to "Yes./I You can also set this to "Yes" by using the com­
mand parameter "/B." 
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Key Definition Options 
This function presents a submenu with the following four options: 

• Clear a Key Definition Prompts you for a key definition to clear if you want to 
unassign a definition to a key. 

• Save All Key Definitions Saves all currently defined keys to a disk file called 
PCOMAC.CFG (unless you have changed the name in the Configuration Settings 
option box). These definitions will be loaded automatically the next time you start 
PC-Outline. You must save the definitions in order for PC-Outline to remember 
them. 

• Inhibit All Key Definitions Temporarily suspends all key definitions. 

• Restart All Key Definitions Reverses the Inhibit All Key Definitions function. 
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Insert Static Date (Shift-Fl) 

This function inserts the current DOS system date. 

Insert Live Date (Shift-F2) 

This function inserts and continuously updates the current DOS system date. The 
screen and printing always represent the current system date. 

Insert Static Time (Shift-F3) 

This function inserts the current DOS system time. 

Insert Live Time (Shift-F4) 

This function inserts and continuously updates the current DOS system time. The 
screen is updated every time it is redrawn (almost every time you press a key), and 
printing is always updated. 

Export Block 

This function exports a block of an outline directly into another program. You can use 
this function only if you've loaded the memory-resident version of PC-Outline. 

C AUT ION Make sure you have set the export options correctly before you start 
the exporting process. See "Export Options" below for more information. 

Follow these steps to export a block from an outline: 

1 Position the cursor where you want the exported text to go in the other program. 

2 Invoke PC-Outline and load or create the text to export. 

3 Position the cursor at the beginningof the block of text you want to export. 

4 Choose this function. 

S Move cursor to end of text you want to export. 

6 Press ~ to signify you have completely marked the block (Esc cancels the com­
mand), and exporting begins. 

Export Options 

When exporting files, you have to determine how the text is to be exported. You can 
pick a predefined mode containing certain settings or you can manually create your 
own. 

After you choose Export Options at the Advanced Menu, you'll see an option box 
where you choose the export mode. If you pick any mode other than "Manual," the 
rest of the setti ngs in the option box are automatically set when you press FlO to save 
the options. In Manual mode, you have to pick each setting yourself. 
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Once you save your settings with FlO, they remain the same until you change them 
again. All exported files will use these same settings. The modes available and their 
default settings are listed below. 

Word Wrap Mode 

Use word wrap mode for programs that support word wrap. Soft carriage returns 
(where word wrap occurred) are typed as a space in order to let the receiving program 
format the word wrap itself. Text is exported as follows: 

• Hard carriage return = hard carriage return 

• Soft carriage return = space 

• Soft space = noth i ng 

• Leading space = nothing 

• Start each line with = nothing 

Line-By-Line Mode 

Use line-by-line mode for programs that require a hard carriage return at the end of 
each line. Text is exported as follows: 

• Hard carriage return = hard carriage return 

• Soft carriage return = hard carriage return 

• Soft space = space 

• Leading space = space 

• Start each line with = nothing 

Spreadsheet Mode 
Use spreadsheet mode for a spreadsheet that requires a ~ at the end of each line. Text 
is exported as follows: 

• Hard carriage return = ~ 

• Soft carriage return = ~ 

• Soft space = noth i ng 

• Leading space = nothing 

• Start each line with = apostrophe 
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Manual Mode 

Use manual mode if you want to individually set each of the five settings. Any time 
you change one of the settings, it will automatically switch into manual mode. These 
are the options for each setting: 

,,,,. Hard carriage return = hard carriage return or ~ 

• Soft carriage return = hard carriage return, ~ , or space (simulate word wrap) 

• Soft space (from justification) = nothing or space 

• Leading space (from paragraph indents) = nothing or space 

• Start each line with = nothing, apostrophe (/), quotation mark ("), caret ("),orplus 
sign (+) 

Export Speed 

Use this option with any of the four modes described above to set the speed of export­
ing keystrokes to slow, medium, or-fast. The default is medium because some pro­
grams can't handle very fast typing. Most applications can handle the fast speed, so 
it's probably worth your while to try it. 

Import Block 
Use this function to copy information from another program's screen into PC-Outline. 
This function works only with the memory-resident version of PC-Outline and does 
not work properly with applications running in any graphics modes. 

C AUT ION Make sure you have set the import options correctly before you start 
the importing process. See "Import Options" below for more information. 

Follow these steps to import information from another program: 

1 In your other program, display the information that you want to copy into 
PC-Outl i ne. 

2 Invoke PC-Outline. 

3 Position the cursor in PC-Outline where you want the text to be inserted. 

4 Choose the Import Block function. 

S You will be shown your previous program's screen. Position the cursor in the upper 
left corner of the text you want to import and press ~. 

6 Position the cursor in the lower right corner of the text you want to import and 
press ~. 
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Import Options 
When importing files, you have to choose whether each line of imported text should 
be ended with a hard carriage return or with word wrap. 

After you choose Import Options at the Advanced Menu, you'll see an option box 
where you choose the import mode. Once you save your import mode with FlO, it ':' 
will remain the same until you change it again. All imported files will use this same 
setting. 

Key Help (F1) 
This function displays a help screen' containing the function of most of the special keys 
used in PC-Outline. 

Flatten Whole Outline 
Use this function to flatten the entire outline, pr6moting all elements up to the top 
level. 

C AUT ION This function is not reversible and should be used with great caution. 
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to Your Needs 

Now that you're familiar with the basics of outlining, it's time to learn some of 
PC-Outline's many features. These features are designed to provide a complete, 
efficient program for you to use to develop your ideas and organize your thoughts. 

This chapter is divided into five applications. Each application demonstrates several of 
PC-Outline's features while introducing a new way of using PC-Outline to accomplish 
your daily tasks. 

Note that each application starts by listing the features introduced in that section. The 
text is designed to allow you to learn the features by reading or by following along in 
PC-Outline. 

The five applications are 

• To-Do Lists How to organize your daily activities. 

• Sorted Lists How to use PC-Outline as a simple database to keep track of con­
tacts, phone numbers, and other information. 

• Templates and Macros How to create frequently used pieces of outline structure 
and store them for repeated use. Also shows you how to customize shortcut key­
strokes. 

• Project Management How to use PC-Outline as a simple project manager. 

• Using Windows How to use several windows to your advantage in all your other 
applications. 
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Application 1: To-Do Lists 
Features covered in this section include 

• Using the Title Toggle function 

• Creating outline elements 

• Moving outline elements 

• Marking/unmarking outline elements 

• Moving marked outline elements 

One of the most valuable uses of PC-Outline is management of your daily tasks. By 
taking just a few minutes every morning to add new items to your list and to generate 
a list of today's activities, you can control even the most hectic jobs. Try the following 
method to get your day under control. 

List Making 
On the first level of the outline, keep your list of tasks to do. Whenever you think of a 
new task, just add it using Create New Outline Entry from the Outline Menu (or "N or 
"~). As children of each of these tasks, keep the subtasks or the little tidbits of knowl­
edge that you'll need to remember. 

If you're using PC-Outline in the memory-resident mode, just press "\ from within your 
other software, and PC-Outline will pop up instantly. In this mode, you'll be able to 
jump in and out of your to-do list whenever a new idea strikes. . 

By just jotting down tasks as you think of them, you might end up with a to-do list like 
the one shown below. Try putting together your own to-do list in this format. 

TIP If you want the title of your list, liMY TO-DO LIST," to be unnumbered, use Title 
Toggle on the Display Menu to turn numbering off for the first element. 

MY TO-DO LI ST 
A. Finish the Johnson Company contract 

1. Deliver to post office by 5 p.m. !!! 
B. Talk to the boss about a raise 

1. How about a 10% increase? 
2. Maybe a stock option? 

C. Roses for our anniversary 
1. DON'T FORGET!! 26 Feb 
2. Get pearl earrings wrapped at jewelers 
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Prioritizing Your List 
Now you can prioritize your tasks using Move Outline Entries (I'M) from the Outline 
Menu. Don't worry about the subtasks; PC-Outline will automatically move them with 
the task. In fact, to help you move an element quickly around a complicated outline, 
PC-Outline will hide all the text and subtasks while you manipulate the position of the 
main level task. 

Prioritizing could help make your outline more orderly like this: 

MY TO-DO LIST Cranked in order of importance) 

A. Roses for our anniversary 
1. DON'T FORGET!! 26 Feb 
2. Get pearl earrings wrapped at jewelers 

B. Finish the Johnson Company contract 
1. Deliver to post office by 5 p.m. !!! 

C. Talk to the boss about a raise 
1. How about a 10% increase? 
2. Maybe a stock option? 

Remembering Today's Tasks 
If you use a to-do list frequently, you may find that certain items become important 
each day and have to be done that day. Every morning after you enter any new tasks, 
just browse through the outline and use Mark/Unmark Outline Entry from the Outline 
Menu (or the F2 key) to mark any items that require attention today. PC-Outline uses 
the concept of marks to allow for faster editing of multiple elements. Note that a 
marked element's number will appear in reverse video. 

Then, at the top of the outline, create a new element called "TODAY'S LIST." Remem­
ber to use Title Toggle to turn off numbering for this line. You can then use Move 
Marks from the Outline Menu to gather all of today's high priority items in one place. 
Notice that these elements are on the same level as the element they were copied to. 
To make them children of "TODAY'S LIST," mark these same two again and choose 
Indent Marks (F8) from the Outline Menu. 
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MY TO-DO LI ST 

A. TODAY'S LIST 
1. Roses for our anniversary 

a) DON'T FORGET!! 26 Feb 
b) Get pearl earri~gs wrapped at jewelers 

2. Finish the Johnson Company contract 
a) Deliver to post office by 5 p.m. !!! 

8. ITEMS FOR LATER CONSIDERATION 
1. Talk to the boss about a raise 

a) How about a 10% increase? 
b) Maybe a stock option? 

Application 2: Sorted Lists 
Features covered in this section include 

• Sorting an outline level 

• Hiding and showing children and text 

You can use PC-Outline like a simple database to keep track of categories of data. For 
example, the sample file shown below keeps track of prospective customers and some 
pertin'ent data pertaining to each of them. The colons (:) indicate the start of a new 
field of information. 

PROSPECTIVE CUSTOMERS 

Talked to Ordered 
Name Phone# Last Week Last Month 
A. Sue Smi th :555-9316 :Yes :Yes 
8. Jim Johnson :555-6133 :Yes :No 
C. Pam Miller :555-0456 :No :No 
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Now, when you get ready to make your weekly sales calls, you can quickly sort 
through all your prospective customers and call those you haven't talked to in the last 
week. Or, using Sort Outline Level from the Outline Menu, you can sort the last field 
to see who hasn't ordered for over a month. This would leave the outline looking like 
this: 

PROSPECTIVE CUSTOMERS (Organized by important contacts to make> 

Ta I ked to Ordered 
Name Phone# Last Week Last Month 
A. Pam Miller :555-0456 :No :No 
B. Jim Johnson :555-6133 :Yes :No 
C. Sue Smith :555-9316 :Yes :Yes 

As you get ready to call each person on your list, just use Current Entry's Text from 
the Show Menu to display any information you recorded about this individual. These 
hidden notes could help you be a better salesperson. 

In the expanded form for a specific customer, your outline might look something like 
this: 

PROSPECTIVE CUSTOMERS (with some notes to help you make the 
sale to Pam Miller> 

Name 
A. Pam Miller 

Phone# 
:555-0456 

Talked to 
Last Week 
:No 

Ordered 
Last Month 
:No 

During our previous phone call, Pam preferred XYZ Company's 
lower prices. Be sure to tell her about our new quantity 
discounts that make our prices lower than XYZ! 

B. Jim Johnson 
C. Sue Smith 

:555-6133 
:555-9316 

:Yes 
:Yes 

:No 
:Yes 

Application 3: Templates and Macros ________ _ 
Features covered in this section include 

• Copy marks 
• Writing and reading structured files 

• Creating and using redefined keys 
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Some of your uses of PC-Outline may call for a repetitive pattern of keystrokes. These 
patterns usually fall into one of two categories: (1) a form (called a "template") that 
allows you to just fill in the blanks, or (2) a set of keys that either form a series of com­
mands or a text string (called a "macro"). In this section, you'll learn how to create 
both templates and macros. 

Using Templates Repetitively in an Outline 
Some outlines may call for the repetitive use of certain groups of elements. If so, try 
organizing your outline so that all elements in a series are members of the same fam­
ily. For a simple project management exercise, you might organize elements like this: 

A. TASK NAME: 
1. Leader: 
2. Team Member5: 

a) 
b) 
c) 

3. Date Next Action Due: 
4. De5cription: 

To use this family as a template, choose Mark/Unmark (F2 key) from the Outline 
Menu to mark this entire family. Then move up to the title element (since you can't 
copy an element onto itself) and choose Copy Marks (F9 key) from the Outline Menu 
to reproduce this simple template. By repeating this several times, you can generate 
plenty of templates, each ready for you to enter only the pertinent new information 
without having to retype the pattern each time. 

TIP Don't forget to keep an extra blank copy of the template at the bottom of your 
document so you'll still have a blank template left to copy. 

Using Templates to Form an Entire Outline 
If you use a general purpose outline like the weekly form memo shown below, you 
can create an outline template to be used each week. To build the outline template, 
use Set Device for Output from the Print Menu and Input Other File Types from the 
File Menu. 
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To begin typing this memo, choose Title Toggle on the Display Menu. Type the top 
part of the memo, pressing ~ at the end of every line. When you're ready to turn out­
line numbering back on, press "~, and finish the memo. 

MEMO 

To: Distribution 
From: Joe Team Leader 
Date: 
Subject: Weekly Project Meeting Notice 

The next meeting will be held _________ _ 

in the conference room. 

A. Old Business 
1. 
2. 
3. 

B. New Bus i ness 
1. 

2. 
3. 

C. Distribution: 
1. Manufacturing Manager 
2. G.A. Manager 
3. Engineering Manager 

After typing the memo, save it to disk by choosing Set Device for Output from the 
Print Menu. Since you want the structure of the outline to be maintained for future 
use, choose the Structured File option from the submenu. When you choose Go Start 
Printing, you'll be prompted for a filename for the outline. 

Now the next time you have another meeting and want to use the template, choose 
Input Other File Types from the File Menu. Choose Structured File again, and when 
you are prompted for a filename, type the name you used to file the outline originally. 

Creating Macros by Redefining Keys 
PC-Outline provides a Key Redefinition function you can use to assign any series of 
keystrokes to a single key. For example, you could create the same outline family that 
is shown in "Using Templates Repetitively in an Outline," and assign it to a single key­
stroke. 

To redefine a key, choose Key Definition ("K) from the Advanced Menu. Then choose 
a key to define. You can choose any single keystroke to define or any key together 
with Shift, Alt, or Or!' For this example, the F3 key will do. 
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Notice that the cursor is now a blinking half cursor. This is to remind you that you 
are in the Key Definition mode and that every key you press is being remembered 
by PC-Outline. 

You can type just about anything into a macro that you could normally type. The only 
restriction is that you can't redefine another key. For this example, create the same 
outline family that is shown in "Using Templates Repetitively in an Outline./I 

A. TASK NAME: 
1. Leader: 
2. Team Members: 

a) 
b) 
c) 

3. Date Next Action Due: 
4. Description: 

Note: If you make a mistake, press "Break and start over. 

When you're-done, press "Break to tell PC-Outline to stop remembering keys. Press 
Alt-A, 0, and S to save the new key definition permanently. Now whenever you press 
the F3 key, all the keys that you typed will be inserted into PC-Outline. You don't even 
have to keep a copy of the template around. Just press the F3 key and you'll have a 
new copy. 

TIP You may want to reassign the cursor diamond keys-AE, AS, AX, and AD-to 
work as they do in WordStar. Follow the steps above, pressing the appropriate arrow 
key. Remember, however, that once you've created macros for these keys, you can no 
longer use the original functions for these commands. Disregard the "shortcut" refer­
ences to these keystrokes on the menus. 

Application 4: Project Management ________ _ 

Features covered in this section include 

• Creating outline elements 

• Moving outline elements 

• Sorting outline levels 

• Finding strings 

In the early stages of a project, many people find that the most difficult task is getting 
the jumble of ideas, tasks, resources, and time durations organized into a legible and 
sensible order. As the project progresses, it becomes necessary to track progress and 
figure out how things are going on a regular basis. You may find that PC-Outline offers 
a very simple and convenient solution to both of these problems. 
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Start your project by letting your ideas flow into PC-Outline. Just create a new element 
for each idea using Create New Outline Entry ("~) from the Outline Menu. Once 
you have all or most of your ideas out of your head, you can think about organizing 
them. You can use the straightforward method of moving individual elements around 
with Move Outline Entry ("M) from the Outline Menu, or you can try using a more 
efficient method like sorting. 

Take a look at a couple of methods of organizing a project. Your projects might require 
different formats for organization, but these examples will help you think of just what 
you need to track and how best to track it. 

Tracking Solutions to Problems 
For tracking the solution of several problems, try this format: 

A. PROBLEM: Next Action Due: Stage of Completeness ... 
(Use the text region to fully describe the problem) 
1. Symptom 

(Use text to describe fully) 
a) Observer-
b) Date Found -

2. Cause 
(Use text to describe fully) 
a) Researcher-
b) Ne~t Action Due_Date Found -

3. Solution 
(Use text to describe fully) 
a) Solver-
b) Next Action Due_Date Found -

Note: Save this file on filename PROJECT. You'll need it to complete the next applica­
tion. 
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Tracking and Sorting Tasks 
For tracking tasks, try this format: 

A. TASK :Date Due :Person Responsible 
(Use text to describe task fully> 

1. Subtask A :Date Due :Person Responsible 
(Use text to describe subtask fully> 

2. Subtask 8 :Date Due :Person Responsible 
3. Subtask C :Date Due :Person Responsible 
4. Subtask D :Date Due :Person Responsible 

As your project list gets longer, you can become more efficient by using the sort func­
tion. In the above example, you can use Sort Outline Level from the Outline Menu to 
sort by any of the fields preceded by a colon (:). 

To quickly find all the tasks that involve a specific item, use Find String ("F) from the 
Edit Menu to locate the first mention of that item. Just follow the instructions and an­
swer the questions that appear on your screen, and PC-Outline will start the search 
and find the first occurrence of the string you specify. 

To find the next occurrence, use Find Again ("A) from the Edit Menu. This will repeat 
Find String using the same settings. 

Application 5: Using Windows 
Features covered in this section include 

• Opening new windows 

• Switching between windows 

• Using multiple windows 

• Transferring text and elements 

• Closing windows 

In this application, you'll open two windows containing two different outlines and 
share information between them. This application uses the file you created in Applica­
tion 4 in addition to the new file you'll create in this application. 
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Opening New Windows 

To get started, load the file PROJECT into PC-Outline. Then choose New Outline New 
Window from the Window Menu. When you're prompted for a filename, type list. 

You'll then see the familiar working screen with the "A." that indicates the start of a 
new outline document. Although it appears that you've just replaced the PROJECT 
outline with a new blank outline, notice the "2" in the upper-right corner of the 
screen. This indicates that you've opened up a second window in PC-Outline. 

Each window contains a separate outline file. By repeating the above process, you can 
load up to nine windows into PC-Outline at one time, provided your computer has 
sufficient memory. Note that by using Load Outline New Window from the Window 
Menu, you could also load an existing file into a new window. 

Switching between Windows 

Multiple windows allow you to switch between outline files and exchange material 
between them. Use Transfer Windows from the Window Menu (or AIt-1) to switch 
back to the first window, where the PROJECT file is located. Your screen reverts to the 
outline from the previous application. Use Transfer Windows again (or AH-2) to return 
to the LIST wi ndow. 

Listing and Arranging Windows 

Before entering any information into this outline, briefly examine a few of the features 
that will help you use windows efficiently in PC-Outline. 

To see a list of the windows in use, choose List Windows from the Window Menu. 
This list shows all windows and the files they contain, whether any unsaved changes 
have been made to them, and their current file size. The following example shows 
what List Window would show if you had two windows open. 
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To view all currently open windows, choose Arrange Windows from the Window 
Menu. The open windows will be displayed in an orderly fashion as shown below, 
with the window bar of each outline displayed. 

FILE OUTLINE EDIT DISPLAY PRINT HIDE SHOW WINDOW ADVANCED 
:\PCO\LISr . 11 
A :\PCO\PROJICT-2k--IIS--PAGI=1 LIII=21 COL=39 2 

a) Researcher -
h) lext Action JuelBate Founi - I 

3. Solution 

a) Solller -
h) lext Action Juellate Found -~ 

I 
'-

Changing the Size of Windows 

Although a window fills up the entire screen, you can use Size Window from the Win­
dow Menu to change a window's size. You can change the size of a window from full 
screen all the way down to just a very small rectangle. By using this feature, you can 
see the contents of one or more other windows while working in your current window. 

Once you have a window adjusted to a smaller size, you may want to bring it back to 
full size, work in it, and then reduce it to its original size. To do this, choose Zoom 
Window from the Window Menu. You can also use the gray - (minus) key to toggle 
between the full screen and its reduced size. 

Finally, to make this process of using multiple windows easier, you can move a win­
dow to any location on the screen as long as the window is always visible and is not 
full size. Just choose Move Window from the Window Menu, and use the cursor keys 
to move the window. Once you have it where you want it, you can lock it into place 
by pressing ~. 
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Transferring Information between Windows 
Now that you know how to use multiple windows, you can share material between 
them. First, create the following heading in LIST. 

A. TRACKING PROJECT XYZ 

Now use Transfer Windows to move back to the PROJECT outline. Then copy the en­
tire PROJECT outline to LIST as a child of this element. To do this, put the cursor on 
the top line and press "Q (Copy Family). Then press Alt-l, position the cu rsor under 
the heading in LIST, and press ~. The result should look like this: 

A. TRACK I NG PROJECT XYZ 

1. PROBLEM: Next Action Due: State of Completeness .•. 

a) Symptom 
1) Observer-

2) Date Found -
b) Cause 

1 ) Researcher -
2) Next Action Due/Date Found -

c) Solution 
1) Solver -
2) Next Action Due Date Found --

Closing Windows 
In this application, you've learned how to create a window, how to manipulate infor­
mation within a window, and how to exchange information between windows. There 
is only one other item to learn about windows: how to close them. 

First, save the new outline by choosing Save Current Outline from the File Menu. 
Then choose Close Window from the Window Menu to close the currently active win­
dow. You cannot close the last open window. But if you want to get rid of an outline in 
the last open window, just use Load Existing Outline or Start New Outline from the 
File Menu to replace the existing outline with the new one. 
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Quick Key 
Reference 

FUNCTION 

Block, copy 
Block, delete 
Block, move 
Boldface, begin 
Boldface, end 
Change current drive/directory 
Children hide/show toggle 
Clear all marks 
Code display toggle 
Configuration settings 
Copy block 
Copy family 
Copy marks 
Cursor left one word 
Cursor right one word 
Cursor to beginning of line 
Cursor to bottom of screen 
Cursor to end of file 
Cursor to end of line 
Cursor to end of paragraph 
Cursor to next element on same level 
Cursor to parent 
Cursor to previous element on same level 
Cursor to top of file 
Cursor to top of paragraph 
Cursor to top of screen 

KEY 

Alt-EC or "C 
Alt-ED or "E 
Alt-EM or "8 
"F3 
"F4 
Alt-FC 
Gray + 
Alt-F2 
Alt-Fl 
Alt-AC 
Alt-EC or "C 
Alt-WQ or"Q 
Alt-OY or F9 

Home 
End End 
"End or Shift-End 
End 
Shift-PgDn 
Shift! 
"PgUp 
Shift- i 
"Home or Shift-Home 
Shift-PgUp 
Home Home 

(continued) 
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FUNCTION 

Date, insert live 
Date, insert static 
Delete block 
Delete line 
Delete outline family 
Delete to end of line 
Delete word left 
Delete word right 
Directory/drive, change 
Display codes 
Display menus 
Divide outline element 
Double strike, begin 
Double strike, end 
End of file 
Export block 
Export options 
Family move 
File options 
Find and replace 
Find string 
Find string again 
Flatten outline 
Font select 
Format page 
Hanging indent 
Help 
H ide all text entries 
Hide children 
Hide level children 
Hide/show children toggle 
Hide text toggle 
Hide this text entry 
Hide this text level 
Import block 
Import options 
Indent and hang 
I ndent, clear 
Indent current entry 
Indent marks 
I ndent paragraph 
Ins/overwrite toggle 
Insert deleted text 
Insert live date 
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KEY 

Alt-AV or Shift-F2 
Alt-AD or Shift-Fl 
Alt-ED or "E 
"Y 
Alt-OD or "0 
Shift-Del 
Shift-~ 
Shift-­
AIt-FC 
Alt-PI or Alt-Fl 
FlOor Alt-menu letter 
Alt-OU or"U 
Shift-F5 
Shift-F6 
"End or Shift-End 
Alt-AE 
Alt-AP 
Alt-WWor"W 
Alt-FF 
Alt-ER or "R 
Alt-EF or "F 
Alt-EA or "A 
Alt-AF 
Alt-PS 
AIt-PF 
Alt-EH or "0 
Alt-AH or Fl 
Alt-HE 
Alt-HA or"H 
Alt-HB or "t 
Gray + 
"PgDn 
Alt-HC 
AIt-HD 
Alt-Al 
Alt-AM 
Alt-EH or "0 
Alt-EX or "X 
F6 
Alt-Ol or F8 
Alt-El or "I 
"G or Ins 
Alt-U or Alt-EU 
Alt-AV or Shift-F2 



FUNCTION 

Insert live time 
Insert non-break space 
Insert static date 
Insert static time 
Italics, begin 
Italics, end 
Join outline elements 
Jump to parent 
Key, define 
Key definition options 
Line, delete 
Line feed, printer 
List windows 
Load existing outline 
Load outline new window 
Mark/Unmark 
Marks, clear all 
Marks, copy 
Marks, indent 
Marks, move 
Marks, promote 
Menu display 
Move block 
Move family 
Move marks 
Move outline elements 
Move cursor word left 
Move cursor word right 
New outline elements 
New window new outline 
Numbering, reset 
Numbering, skip 
Numbering, start new 
Page advance, printer 
Page break control 
Paragraph down 
Paragraph indent 
Paragraph style 
Paragraph up 
Place outline entry 
Print 
Print code display 
Print destination 
Print range 

QUICK KEY REFERENCE 

KEY 

Alt-AX or Shift-F4 
"FlO 
Alt-AD or Shift-Fl 
Alt-AT or Shift-F3 
"FS 
"F6 
Alt-OJ or "J 
"PgUp 
Alt-AK or "K 
Alt-AO 
"Y 
Alt-Pl 
Alt-WI or "Z 
Alt-Fl 
Alt-Wl 
Alt-OO or F2 
Alt-F2 
Alt-OY or F9 
Alt-Ol or F8 
Alt-OV or Shift-FlO 
Alt-OP or F7 
FlOor Alt-menu letter 
Alt-EM or "8 
Alt-WWor"W 
Alt-OV or Shift-FlO 
Alt-OM or"M 

Alt-OC or "N 
Alt-WN 
Alt-DU 
Alt-DS 
Alt-DN 
Alt-PP 
Alt-EP 
Shift-PgDn 
Alt-EI or "I 
Alt-DC or "T 
Shift-PgUp 
Alt-DP 
Alt-PC or "P 
Alt-PI 
Alt-PD 
Alt-PR 

(continued) 
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FUNCTION 

Printer formatting 
Promote current entry 
Promote marks 
Quit PC-Outline 
Read other fi Ie types 
Rename current outline 
Replace 
Reset outline places 
Right margins, even 
Save outline 
Show all children 
Show all children at level 
Show all family text 
Show all offspring 
Show all text at level 
Show entry's children 
Show text, current entry 
Show text, whole outline 
Show whole outl i ne 
Sort outline entries 
Space, insert non-break 
Start new outline 
Style, default set 
Style, global set 
Style, range set 
Subscript on 
Subscript off 
Superscript on 
Superscript off 
Switch to window number 
Tab set 
Time, insert live 
Time, insert static 
Title, add 
Top of file 
Underline, begin 
Underline, end 
Undelete 
Un indent paragraph 
Up one entry same level 
Window arrange 
Window close 
Window family copy 

412 

KEY 

Alt-EO 
F5 
Alt-OP or F7 
Alt-FQ 
Alt-Fl 
Alt-FR 
Alt-ER or "R 
Alt-DA 
Alt-DE 
Alt-FS or "S 
Alt-SF 
Alt-S8 
All-SI 
Alt-SH 
Alt-SD 
Alt-SA 
Alt-se 
Alt-SE 
Alt-SC 
Alt-OS 
"FlO 
Alt-FN 
Alt-DD 
Alt-DC 
Alt-DR 
"F7 
"FB 
Shift-F7 
Shift-FB 
Alt-WT or Alt-1-9 
Alt-ET 
Alt-AX or Shift-F4 
Alt-AT or Shift-F3 
Alt-DT 
"Home or Shift-Home 
"Fl 
"F2 
Alt-Eu or Alt-U 
Alt-EX or "X 
Shift- i 
Alt-WA 
Alt-We 
Alt-WQ or"Q 



FUNCTION 

Window family move 
Window list 
Window move 
Window number, switch to 
Window size 
Window zoom 
Word left 
Word right 
Zoom/unzoom toggle 
Zoom window 

QUICK KEY REFERENCE 

KEY 

Alt-WW or"W 
Alt-Wlor"Z 
AIt-WM 
Alt-WT or AIt-1-9 
Alt-WS 
Alt-WZ 
"-<-

Gray­
Alt-WZ 
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APPENDIX B 

Additional 
Printer Information 
Installing Printer Description Files 

IF YOU HAVE WORDST AR2000 RELEASE 3 

You must install a printer description file (.PDF). There are .PDF files for some of the 
more popular printers on your PC-Outline disk. 

If you've installed WordStar 2000, you can use the same .PDF for both programs. 

Follow these steps to install a printer description file: 

1 Log onto the directory containing the PC-Outline files (usually \PCO). Type pco and 
press ~ to start PC-Outline. Open an outline. 

2 Choose Configuration Settings at the Advanced Menu. 

3 Type the full pathname and file for your printer description file at the Printer 
Description File: prompt. 

4 Press FlO, followed by ~, to save your changes. 

5 Exit PC-Outline. 

Note: If you have WordStar 2000 installed on a hard disk computer, the .PDF files are 
located in the \WS2000\PRINTER subdirectory (or directory where you installed 
WordStar 2000). If you installed WordStar 2000 on a 3V2-inch dual floppy system, the 
.PDF files are located on your WordStar 2000 Program & Help disk. 
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PC-OUTLINE 

IF YOU HAVE WORDS TAR PROFESSIONAL RELEASE 5 

If you are using PC-Outline with WordStar Professional Release 5, you must use one of 
the two .PRN files on the PC-Outline disk: PCOSTAN.PRN or PCODAISY.PRN . ..Ql.oose 
..fCOSTAN PRN for printing on a dot matrix printer Qr..any laser printer. Choose 
PCODAISY.PRN for printing on a daisy wheel printer. 

Follow these steps to install a printer description file. 

Note: If you are installing WordStar on a hard disk, first copy the .PRN file(s) to the 
directory that contains your PC-Outline files (usually \PCO). 

1 Log onto the directory containing the PC-Outline files. Type pco and press ~ to 
start PC-Outline. Open an outline. 

""- 2 Choose Configuration Settings at the Advanced Menu. 

"" 3 Type the full path name and filename for the appropriate .PRN file at the Printer 
Description File: prompt. 

4 Press FlO, followed by ~, to save your changes. 

5 Exit PC-Outline. 

Printing on a LaserJet® 

To print on an Hp® LaserJet (and most other laser printers) from PC-Outline, follow 
these steps: 

1 Choose Set Page Format at the Print Menu. 

2 Set the page length to 60. 

3 Set the top margi n to 3. 

4 Set the bottom margin to 3. 

5 Save these new settings to the configuration file by pressing FlO in the Set Page For-
mat option box. 

The configuration file affects only newly created outlines. To change the above settings 
on existing outlines, you must change them for each outline and then resave the 
outline. 

Note: If you are using WordStar Professional, choose the PCOLASER.PRN file. If you 
are using WordStar 2000, choose either the PCOLASER.PRN file or an appropriate 
.PDF file. 
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Printer Problems 
PC-O!Jtline supports most printers. However if you have installed PC-Outline as 
directed and some of the print attributes don't work correctly (for example, boldface 
doesn't print), try printing your files through your word processor. Follow these steps: 

1 Press Alt-P (print). 

2 Press D (Set Device for Output). 

3 Choose your word processor. 

4 Press G and type a filename. 

S Exit PC-Outline and print the file using your word processor. 

Most printer problems are caused by one of these situations: 

• The printer is not connected properly. Make sure you're using the correct printer 
port and that it's linked properly. Make sure the printer is turned on and is online. If 
you're on a network, make sure your printer is linked whether you're using the 
network or not. 

• You don't have the correct printer driver installed. If you're using WordStar 2000, 
you must either install the correct printer description file or use one of the two 
.PRN files supplied with the program. If you're using WordStar Professional, you 
must use one of the two .PRN files. The internal default file works on most printers. 
See "Installing Printer Description Files" at the beginning of this appendix. 

• Your printer cannot print bullets and you have bullet numbering set in your outline. 
There are several symptoms of this problem. You may see some nonsensical char­
acter printed instead of bullets, or your printer may mysteriously change fonts in 
the middle of an outline. To fix these problems, either change the bullet numbering 
to some other type of numbering or follow the steps above to print the file through 
your word processor. 

TIP If you have WordStar 2000 or WordStar Professional, you can use Find and 
Replace to change the bullet character to any character you want. You must first 
convert the file to WordStar Professional or WordStar 2000 format. See IISet Device 
for Output" in the IIReference" chapter for more information. 

• If your printer prints part of your outline and then stops, you may have a particular 
hardware/printer combination that is causing the problem. If this is the case, you 
need to use the DOS MODE command before printing to set the printer for infinite 
retry. See your operating system manual for details on how to do this. 

• If all else fails, it is possible that you either embedded a printer code in your outline 
that is not set up correctly for your printer (turn printer codes on with Printer Code 
Display on the Print Menu and look for graphics characters in your outline), or your 
outline could be corrupted in some way. To rid your outline of all unwanted char­
acters, write it to a structured file and then read it back as a structured file. This 
will preserve 95% of the outline structure but will clean out all paragraph and 
printer formatting. 
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APPENDIX C 

Command Parameter 
Options 

There are a number of command parameter options you can use when starting 
PC-Outline. These options control how the program will work. To use a command 
parameter, type the parameter as shown below after the program name in DOS. For 
example, you would type pco/p to suppress the deletion confirmation message in 
PC-Outline. 

These are the command parameter options and their functions: 

PARAMETER 

IR 

IS 

IM=xx 

18 

IL=xx 

ID 

FUNCTION 

Loads PC-Outline as a memory-resident program. 

Uses fast video (for graphics video cards not requiring retrace syn­
chronization). 

Specifies the amount of data memory to reserve for your outlines. 
For example, IM=30 would reserve 30K of memory for your out­
lines. This value defaults to 64K and can be set to anything 
between 20 and 640. 

Black and white only, no color. 

Specifies the location of the configuration file by typing 
IL= <path and filename of configuration file>. 

Ignores the starting current directory in the configuration file and 
uses the DOS current directory as the starting directory. (You must 
have a path statement telling DOS where to find PCO.EXE.) 

(continued) 
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PARAMETER 

IK 

IT 

II 

IP 

420 

FUNCTION 

Gets keys directly from the keyboard buffer to bypass keyboard 
enhancers. If you have redefined some keys using a keyboard 
enhancer, the redefinitions may confuse PC-Outline. If you want 
the redefinitions to normally be active for your other programs, 
but not for PC-Outline, then use this option. The use of IK pro­
vides special built-in support for Pro Key ™ and SuperKey® that will 
detect their presence and deactivate them temporarily whenever 
you are in PC-Outline. This support is necessary because these 
programs will not let PC-Outline get keys directly from the key­
board buffer. 

Updates the onscreen time only when a key is pressed. This 
option is provided for non-IBM video cards that cause snow on 
the screen. By using this option, you will prevent continuous 
snow and will get snow only when you press a key. 

Note: If you have snow, first try setting Retrace to "Yes" in the 
Configuration Settings option box on the Advanced Menu. 

Uses low-intensity video instead of high-intensity video. You may 
want to use this option if you're running PC-Outline on an IBM 
monochrome monitor. 

Skips the confirmation prompt when you're deleting outline en­
tries with the "D command. If you use the IP parameter, you will 
not be prompted before potentially large deletions. 
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Introduction 
The purpose of a word processing program is to make your work easier and faster. 
While a program may have many exciting features, they aren't much help unless you 
know how to use them for the work you do every day. 

This is a how-to instruction section. It tells you how to use the WordStar Professional 
feature set to do office-related tasks. In using it, you'll learn many "tips and tricks" of 
word processing in general, and WordStar in particular. You can use these techniques 
in every document you create. 

A chart on the following pages lists the major tasks that are covered and indicates 
which application handles them. For instance, if you use boilerplate text often, you 
will find tips on that subject under "Contracts," even if you aren't interested in con­
tracts specifically. 

As with any how-to book, the instructions may require some adaptation. Your printer 
may not be able to do some of the things we describe here, or your needs may be 
sl ightly different. But the instructions should give you some good ideas about how to 
make WordStar work for you. 

Each application in this section is independent: you can go directly to the one you 
want without reading the others. All the information, commands, and so on, are 
included, so you won't need to refer to other books. Where applicable, there are pic­
tures of the finished product, too. 

Note: Although this section provides step-by-step instructions for each task, the 
applications are sophisticated, and the instructions assume an understanding of the 
program. If you want instructions for simpler tasks, see the "Training" section of Start­
ing and Learning. It's also advisable to run the onscreen tutorial, which allows you to 
experiment with the program itself. 

We welcome your comments. If there are other applications you'd like to see in the 
future, or if you create an application of your own, please let us know. Send your 
ideas to: Technical Communications, MicroPro International Corporation, 33 San 
Pablo Ave., San Rafael, California 94903. 
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Finding a 

Particular Task 
This chart lists the major tasks covered in this booklet and indicates which application 
hand les them. 

TASK 

Alpha,betizing 

Block math 

Boi lerplate text 

Bulleted lists 

Business letters 

Chain printing files 

Changing fonts 

Changing page numbering 

Compound page numbering 

Conditional text 

Controlling page breaks 

Copying a block from one file to another 

Copying one file into another 

dBASE 

Displaying onscreen messages 

Double underlines 

Envelopes 

Figuring interest 

WHERE TO FIND IT 

Phone Directori'es 

Invoices, Loans and Interest 

Contracts 

Meeting Minutes 

Business Letters and Envelopes 

Long Documents 

Newsletters 

Meeting Minutes 

Long Documents 

Contracts, Invoices 

Long Documents 

Meeting Minutes 

Meeting Minutes 

Invoices 

Invoices, Long Documents 

Newsletters 

Business Letters and Envelopes, 
Form Letters and Mass Mailings 

Loans and Interest 
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TASK 

Footers 

Form letters 

Headers 

Keeping sections of text on a page 

Landscape mode 

Li ne and box d rawi ng 

Lotus 1-2-3 

Macros 

Mail merge 

Math 

Newspaper-style columns 

Numbered lists 

Omitting page numbers 

Opening a window on the same file 

Organizing files 

Orphan/widow control 

Outlining 

Overprinting several lines 

Page breaks 

Page numbering 

Pausing the printer 

Printing labels 

Printing on letterhead 

Putting commands in macros 

Recovering deleted text 

Right-aligning text 

Snaking columns 

Sorting a list 

Standard paragraphs 

System date 

Two-column or three-column text 

Variable number formatting 

Variable text formatting 

Variables specified at print time 
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WHERE TO FIND IT 

Meeting Minutes 

Form Letters and Mass Mailings 

Business Letters and Envelopes, 
Meeting Minutes 

Long Documents 

Phone Directories 

Organization Charts 

Invoices 

Meeting Minutes, Phone Directories 

Form Letters and Mass Mailings, 
Invoices, Loans and Interest 

Invoices, Loans and Interest 

Phone directories 

Meeting Minutes 

Meeting Minutes 

Long Documents 

Long Documents 

Long Documents 

Meeting Minutes 

Newsletters 

Long Documents 

Meeting Minutes, Long Documents 

Form Letters and Mass Mailings 

Form Letters and Mass Mailings 

Business Letters and Envelopes 

Meeting Minutes, Phone Directories 

Long Documents 

Newsletters, Meeting Minutes 

Phone Directories 

Phone Directories 

Contracts 

Meeting Minutes 

Phone Directories 

Invoices, Loans and Interest 

Invoices 

Invoices 



Business Letters 
and Envelopes 

You probably already use WordStar for your business correspondence. This applica­
tion illustrates some new techniques you can use to make your letters look more 
professional, and make more efficient use of your time. 

This application will show you how to print business letters on letterhead paper and 
how to set up a file for printing envelopes for each letter. You can use the resulting 
files as "formats," with the proper page settings in place. Just change the text and the 
addressee for new letters. 

Designing the First Page of the Letter 
1 Begin a new file and name it something descriptive, like BUSLETR. 

2 Press "OL to see the Margins & Tabs dialog box. Specify the following: 

Left margin 

Right margi n 

Top margin 

Bottom margi n 

Tabs 

.10" 

6.50" 

1.00" 

.50" 

.3,.9,1.5,2.1,2.7,3.3,3.9 

Page offset 1.00" 

When you're finished changing settings, press F10. 

3 Since this is a business letter, omit page numbers from the first page. Press .,...J to 
begin a new line and type .op. 
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Designing Subsequent Pages 
The subsequent pages of a business letter are usually printed on blank paper, instead 
of letterhead. This means that there is room for several header lines and the top mar­
gin can be made smaller. Also, subsequent pages will be numbered (on the first page, 
numbers were omitted). 

1 To start page numbering, move the cursor to the first line after the page break. Type 
.pg. Page numbers are centered. If you want the numbers to print in a different 
location, use a .pe command. 

2 If you want headers that print on each subsequent page, set them up here. Type .hl 
and the text of your header. If the header is longer than one line, use the .h2 and 
.h3 commands. 

3 Set a smaller top margin, now that you don't need to leave room for the letterhead. 
Type .mt 6. 

TIP You might want to save this format on disk as a document. Every time you 
type a letter, use "'KR to insert the document into the letter. 

4 When you print your letter, select the printing option that lets you pause between 
pages. Replace the letterhead paper with blank paper after the first page is printed. 
(Your printer must be capable of printing one sheet at a time to do this.) , 

Printing a Standard Business Envelope 
To print an envelope, set a shorter page length and special margins. You can create a 
standard format for envelopes and store the format in a separate file. Then, when you 
want to print an envelope, you can read in the format file after the last page of your 
letter with the "KR command. 

The format in the example below is suitable for a standard 9V2-by-4-inch business 
envelope, printing 10 characters per inch. 

1 Begin a new page by typing .pa. 

2 Press "OL to see the Margins & Tabs dialog box. Specify the following: 

Top margin 2.00" 

Bottom margin 0.00" 

Page length 4.00" 

Page offset 4.00" 

3 Omit page numbers from the envelope (.op). 
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BUSINESS LETTERS AND ENVELOPES 

If you use different sized envelopes, you can create your own formats using different 
values for these dot commands. 

Follow these steps to print your envelope: 

At the end of the letter file, turn off any headers or footers you included. To do this, 
type the same dot command you used to begin the header or footer (without any 
text) and press ~. 

2 Bring the envelope file into the letter at the end with "KR. The .pa at the beginning 
of the envelope format ends the lett~r. 

3 Type the name and address for the envelope beginning in line 1, column 1 (imme­
diately below the dot commands). Alternately, use block commands to mark and 
copy the name and address from the beginning of your letter. 

4 Save the document with "KD. 

5 Print the file, selecting the print option to pause between pages, so you can replace 
the stationery with an envelope at the appropriate time. 
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Form Letters 
and Mass Mailings 

WordStar's powerful merge printing feature allows you to easily create a form letter to 
send to your entire mailing list. In this application you'll learn how to set up the mas­
ter document for a form letter. There are also instructions for merge printing envelopes 
and three-across labels. 

This application assumes that you've created a data file containing the names and 
addresses of the addressees. This data file can be created with the WordStar MailList 
program, with WordStar (as a nondocument file), with dBASE, Lotus 1-2-3, or with any 
program that creates a comma-delimited ASCII data file. 

Creating a Master Document 
You'll type the commands and text for a form letter to all the customers in your data 
file. 

Begin by typing the commands that tell WordStar the data file to use and the names 
of the variables. Remember, each dot command must be on its own line, and must 
begin in column 1. 

In our example, the data file is called SERVICEDTA. Note: the variables used here 
are just examples-your variable names may be different. 

.df service.dta 

.rv Mr-Ms,full-name,address1 ,address2,address3 
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2 If you like, you can add some information that is displayed onscreen when you 
print this file, but that won't be printed. For example, type 

.cs Printing letter to &full-name& . 

. dm Make sure there is room for logo on letterhead. 

3 Add commands to change the design of your page. For example, you can increase 
the top margin to leave room for a letterhead (.mt 3"). You might also want to omit 
page numbers in a formal letter (.op). 

4 Now, type the text of the letter. Each variable (a word surrounded by ampersands) 
will be replaced by actual data when the file is printed. If you type /0 after a vari­
able, the line won't be printed if there's no data in that field. Here's an example of 
the letter text. 

&Mr-Ms& &full-name& 
&address1/0& 
&address2/0& 
&address3/0& 

Dear &full-name&: 

Thank you for your recent purchase at our store. I know that 
you will be satisfied for many years. However, if a problem 
ever arises, remember that our customer service department is 
located at 

1234 Van Ness Avenue 
San Franc i sco, CA 94900 

You can also call us at (415) 123-1212 during normal business 
hours. 

Sincerely, 

. Charles Darwin, Customer Service Manager 
.pa 

5 To include the current date in your letter, type the system date variable, &@&. 

Now, when you print this file, WordStar will print one letter for each customer in the 
data file you specified. The information in each record will replace the variables in the 
letter. The current system date will replace the &@& variable. 
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Merge Printing Envelopes for a Mass Mailing ___ _ 
You can use the data file in the previous example to print envelopes for your mailing. 
Follow these instructions to create a master document for printing standard envelopes. 

Note: If you used MailList to create your data file, you must use MailList's .LST files to 
print envelopes or labels. This technique is described in detail in the MailList docu­
mentation. However, if you created your data file manually, or with another 
program, you can use the techniques described here unless you have a laser printer. 
With a laser printer, use the envelope .LST files supplied with Word Star. 

Start by opening a new document file from the opening screen in Word Star. 

2 Turn page numbering off by typing .op on the first line of the file. 

3 Type the dot commands to select the data file and read the data variables. In our 
example, we use the same data file (SERVICEDTA) and variables that we used in 
the previous example. For example, type 

.df service.dta 

.rv Mr-Ms,full-name,address1 ,address2,address3 

4 You must pause before each envelope is printed so you can put in a new envelope. 
You'll use a .av command to do this. The "X" variable in the .av command below 
is not really used. It's there because the .av command requires a variable for its 
answers. Using .av is a trick to make the printer pause. For example, type 

.av "Put envelope in printer. Press Enter when ready.",X 

5 Type .cs to clear the screen after the .av message is displayed. 

6 Now, set the page length, offset, and top and bottom margins for your envelope. 
Press "OL to see the Margins & Tabs dialog box. Specify the following for a stan­
dard 9V2-by-4-inch envelope: 

Top margin 2.00" 

Bottom margin 0.00" 

Page length 4.00" 

Page offset 4.00" 
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7 Use variables to print the name and address from the data file. The command .pa 
starts a new envelope. For example, type 

&full-name& 
&a~dress1/0& 

&address2/0& 
&address3/0& 
.pa 

Your envelope file should look like the one shown here: 

.op 

.df service.dta 

. rv Mr-Ms, full-name ,address1 ,address2 ,address3 

.av "Put an envelope in the printer now. Press Enter when ready.",X 

.cs 

.pl 4.00" 

.mt 2.00" 

.mb 0 

.po 4.00" 
&full-name& 
&address1/0& 
&address2/0& 
&address3/0& 
.pa 

Use this file to print an envelope for each record in your data file. When printing 
pauses, read the message, insert an envelope, and press ~ to continue. The .cs com­
mand clears the screen after you insert each envelope and press ~ 

Merge Printing Three-Across Mailing Labels 
This example shows you how to set up a format for merge printing names and ad­
dresses from a data file onto maHing labels. The commands used here are appropriate 
for three-across, general purpose labels measuring 3V2-by-15A6-inches, printed with 10 
characters per inch and 6 lines of text per inch. 

Note: If you created your data file with MailUst, you must use the .lST files supplied with 
MailUst to print labels. If you created your data file with another program, you can use 
the procedures in this example. Alternately, you can use the MailUst .lST files and change 
the .dland .rv commands to match your data file. 

I Start by creating a new document file from the opening screen in WordStar. 

N~li M~f-1f.gL'J, , ls T 
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2 At the beginning of the file, type the following commands to set the offset, page 
length, and top and bottom margins. Note that page length is set to 1" (each row of 
labels is considered to be a page) . 

. po .2" 

. P 1 1.00" 

.mt 0 

.mb 0 

3 Type the commands to omit page numbers (.op) and turn print-time formatting off 
(.pf off). 

4 You want each line to line up on the left side of the label. You'll use a .sv command 
to do this. Set up a format named l to left-justify fields. Each such field can be 30 
characters wide. Type the .sv command below. (There are 30 Ls.) 

.sv L LLLLLLLLLLLLLLLLLLLLLLLLLLLLLL 

5 Type the dot commands to select the data file and read the data variables. For 
example, type 

.df label.dta 

.rv name1 ,address1 ,city1 ,state1 ,zip1 

.rv name2,address2,city2,state2,zip2 

.rv name3,address3,city3,state3,zip3 

6 You'll use a special trick to combine three different variables into a new one. 

The last line of each label must be the same width as the other two lines. You could 
define formats for the city, state, and zip variables, so their combined widths would 
be 30 characters. !-iowever, the method shown here is easier. Type these com­
mands: 

.sv cityline1=&city1&, &state1& &zip1& 

.sv cityline2=&city2&, &state2& &zip2& 

.sv cityline3=&city3&, &state3& &zip3& 
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7 Type the variables for the labels. Type 5 spaces between each variable on each line. 
The spaces will position the printer at the left side of the next label. For example, 
type 

&name1/L& &name2/L& &name3/L& 
&address1/L& &address2/L& &address3/L& 
&cityline1/L& &cityline2/L& &cityline3/L& 

8 Insert a page break to go to the next set of three labels. (Do not use form feeds 
when you merge print.) 
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Your file should now look like this: 

.op 
· pf off 
· po .2" 
· pI 1.00" 
.mt 0 
.mb 0 
.sv L = LLLLLLLLLLLLLLLLLLLLLLLLLLLLLL 
.df label.dta 
.rv name1 ,address1 ,city1 ,state1 ,zip1 
.rv name2,address2,city2,state2,zip2 
.rv name3,address3,city3,sta~e3,zip3 
.sv cityline1=&city1&, &5tate1& &Zip1& 
.sv cityline2=&city2&, &state2& &Zip2& 
.sv city1ine3=&city3&, &state3& &zip3& 
&name1/L& &name2/L& '&name3/L& 
&address1/L& &address2/L& &address3/L& 
&cityline1/L& 
.pa 

&cityline2/L& &cityline3/L& 
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What if Some Records Have Missing Data? 
What happens if there is no street address for someone in a mailing list? A row of 
labels might look like this: 

Franz Reichsman 
12345 Healing Street 
Marlboro, VT 05301 

Roland Turns Rebecca Fies 
54321 Dolphin Drive 

Tinyhamlet, MO 64423 Santa Fe, NM 85102 

The middle label would Qe more professional looking if the city, state, and ZIP 
appeared on the second line, like this: 

Roland Turns 
Tinyhamlet, MO 64423 

If this were a letter, you could use the "/0" option to leave out the line if there is no 
data for the variable. However, /0 won't work for these mailing labels, because the 
variable is not the only text on the line. 

The problem can be solved by using conditional dot commands. You can ask 
WordStar to check for missing data in a particular variable. If the data is missing, 
WordStar can replace the data for that variable with the data from another variable. 

The mailing list record consists of a name, street, city and state, and zip code. The 
variable most likely to have missing data is the street. 

After WordStar has read all the variables from the data file for a row of labels, it can 
check to see if any street addresses are missing. If they are, WordStar can move the 
data from namel into the street address space. Then the data from namel is removed. 
The result is an empty line at the top of the label, instead of in the middle. For 
example, 

namel 

addressl 

citylinel 

(which is now empty) 

(which now contains the data that was in name1) 

(which is riot affected) 

WordStar will check each address in your mailing list the same way. 

437 



APPLICATIONS 

To set this up in your file, follow these steps. 

1 Move the cursor just before the first line of labels (that is, to the line above 
&namellL&). 

2 Type the first conditional command, as shown here. When you include a variable 
surrounded by ampersands (&) in an .if command, WordStar checks the data con­
tained in that variable. Type '.if &addressl & = . 

3 Now move that data into the variable called addressl. (Both namel and addressl 
will contain the same data') Type .sv addressl,&namel&. 

4 Finally, remove the data from the NAMEl variable and make it an empty field. Type 
.sv namel. 

5 End the condition by typing .ei. 
6 Repeat these steps for the remaining two lines of variables. When you're finished, 

the added commands in your file should look like this: 

· if &address1 &= 

.sv address1 , &name1 & 

· sv name1 

· e i 
· if &address2&= 

· sv address2, &name2& 

· sv name2 

.ei 

.if &address3&= 

• sv address3, &name3& 

· sv name3 

· e i 

If the ADDRESS field is empty, the NAME field information is moved to the ADDRESS 
position, and the NAME field is left empty. When there is data for all three ADDRESS 
variables, the .if commands are skipped. You can use more .if commands to modify 
this basic procedure if two or more variables are missing. 

TIP You might want to create a "dummy" data file of three names and addresses that 
you print just before printing your real data file. That way, you can check the position 
of the labels in the printer and make any necessary adjustments. 
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Creating a Boilerplate Format 

In this application you'll set up a file as a boilerplate format. This file contains the 
page layout settings and standard text for the minutes of a regularly scheduled meet­
ing. You need to create the boilerplate format only once. Then you can read it in every 
time you type the minutes. 

The boilerplate format shown in this example is designed for a Hewlett-Packard 
LaserJet+ printer with several sizes of Helvetica and Times Roman type. Adapt the 
format for your own printer. 

Setting Up the Parameters 
You'll create a new file that contains settings especially for use with your meeting 
minutes. 

1 From the opening screen in WordStar, open a new document file. 

2 Type a name for the new file. For instance, type meeting.for and press ~. 

3 Choose a font for your minutes. Press "p = and select a font. Text, headers, and footers 
will appear in this font unless you change it later. In this example, choose TmsRmn 10 pt. 

4 Now, set the margins for your document. Use the following list asa guideline. The 
list shows the settings you need to change and the commands to change them. The 
values shown for page margins are appropriate for most laser printers. Adapt them 
for your printer if necessary. Remember that each dot command must be on its own 
line, and must begin in column 1 . 

Top margin .mt . 10" 

Bottom margi n .mb .50" 

Page length .pl 11.00" 

Text ragged right .oj off 
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Adding Text 
Your boilerplate format sets up the basic page design for your meeting minutes. It can 
also include text. When you read the boilerplate format file into any new document 
file, both the page design and text are inserted into the new file. This is useful for 
meeting minutes, where you have things that don't change from meeting to meeting. 

Start by creating a template that includes the distributor, distribution list, date, and so 
on. 

1 On the first text line of the file, center the title for your meeting minutes. In our 
example, type MONTHLY STATUS MEETING and press "Oc. Use "PB to boldface 
this title. 

2 Skip a line and type TO:, FROM:, DATE:, and SUBJECT:, each on its own line. Fill 
in these entries with the appropriate names and information. 

3 Skip a line and use the shifted hyphen key (underbar) to draw a line across the page. 

4 You can set up a hanging indent if your distribution list is more than a line long. A 
hanging indent means that the first line of a paragraph starts at the left margin, but 
the other lines are indented. 

To do this, move the cursorto the beginning of the line just above TO. Set a paragraph 
margin by typing (.pm 0"). Now, the first line of each paragraph will begin in column 
one. Indent the rest of the paragraph by changing the left margin. Do this by typing 
.Im 1.00". 

5 Move the cursor to the end of the file by pressing "QC. Change your margins back to 
normal by typing .pm and .1m 0". 
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In our example, the file now looks like this: 

C:MEETING.FOR P1 L9 C8 Insert Align 
rile Edit==Go to==Window Layout===Style==Other===EDIT= 

L-----! ----! ----! ----! ----! ----! ----! ----! ----! ----! ----! ------R 
<1:Helv 14.4 pt.> 
.mt .HI" 
.mb .58" 
.pl 11.88" 
. oj off 

.pm .8" 

.Im 1. 88" 

MONTHLY STATUS MEETING 

TO: Leo Williamson, Tom Black, 'Ricki Chapman, Joan Sparrow, Dave Gunn, 
Rosy ](le in, Rob in B i lIson 

FROM: He I ene Se 11 ers 
DATE: &@& 
SUBJECT: Monthly product status meeting 
.pm 
. hI .8" 

< 
1 
1 
1 

< 
" 
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6 You can either leave the space for the date blank (and fill it in for each report), or 
you can type the merge-print variable &@&. If you use the merge-print variable, 
the current system date is inserted when you print the file. (Make sure you leave 
enough room, because the actual date takes up more space when it's printed than 
the variable does onscreen.) 

Meeting minutes often have a standard opening and closing paragraph, as well as a 
regular agenda. You can add this text to the boilerplate format too. 

Make sure the cursor is on the blank line below the last text in the file. Type the 
standard opening. In our example, type 

The product status meeting was called to order at 3:00 p.m. on 
Wednesday. The president and Vice-presidents of Product Develop­
ment, Product Marketing, and Sales attended, as well as representa­
tives from Documentation, Support, and Testing. 

2 Skip a few lines and type the standard closing paragraph. In our example, type 

Written status reports were presented by each representative 
(attached). This group will reconvene on the second Wednesday of 
next month. The agenda will be circulated a week before the meet­
ing. If you have items to add to the agenda, please send them to 
Helene Sellers within the next three weeks. 

Adding a Header to the Boilerplate Format 
If there is information you want to include on every page, set up headers and footers 
so you don't have to retype the information each time. 

1 Move the cursor to the beginning of the file by pressingAQR. 

2 To create a header that prints on each page, type .hl. 

3 On the same line, type the text for the header. In our example, type Monthly Status 
Report, then press the Tab key to move to the right side of the line and type Big Busi­
ness, Inc. (The number oftab stops between the sections of text will vary, depending 
on your margin settings and font size you're using.) 
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Omitting the Page Number from the First Page 

You may want to use the first page of your meeting minutes as a cover memo. In that 
case, you would omit the page number on the first page. You can begin the text of 
your minutes with page number 1 (even though this is actually page 2 of the docu­
ment). To do this, follow these directions: 

1 With the cursor on the first line of the file, type .op. 

2 Move the cursor to the line just above the first paragraph. Type .pa to insert a page 
break. Move the cursor to the first line on the second page. 

3 Press "N to insert a blank line. On the blank line, type .pn 1 to have this page num­
bered as page 1. Subsequent pages will be numbered consecutively. 

Creating a Footer for the Boilerplate Format 

1 Press "N to insert another blank line. 

2 To create a footer that prints on each subsequent page, type .fl. 

3 On the same line, type the text for the footer. The text for this footer includes the 
&#& merge print variable, which prints the correct page number on each page. 
Remember to leave enough room for the printed date after the &@& variable. The 
footer line should look like this: 

. f1 &@& Company Confidential &#& 

Finishing the Boilerplate Format 

You've finished setting up the boilerplate format for the meeting minutes. From now 
on, every time you type the minutes, you'll use this file. You can either read the file 
("KR) into a new document file, or you can open this file, add new information, and 
save the changed version with a different name ("KT). 
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The file in our example now looks like this (with display on): 

<TmsRmn 10 pt. > 
· mt .10" 
.mb .50" 

· pI 11.00" 

· OJ 6ff 
.h1 Monthly Status Report 
. op 

Big Business, Inc . 

~BMONTHLY STATUS MEETING~B 
.pm 0" 
.lm1.00" 

TO: Leo Williamson, Tom Black; Ricki Chapman, 
Joan Sparrow, Dave Gunn, Rosy Klein, Robin Billson 

FROM: Helene Sellers 
DATE: &@& 

SUBJECT: Monthly product status meeting 

.pm 
· I m 0" 
.pa 

.pn1 
· f 1 &@& Company Conf ident ial &#& 

The product status meeting was called to order at 3:00 p.m. on 
Wednesday. The president and vice-presidents of Product 
Development, Product Marketing, and Sales attended, as well as 
representatives from Documentation, Support, and Testing. 

Written status reports were presented by each representative 
(attached). This group will reconvene on the 5econd Wednesday of 
next month. The agenda will be circulated a week before the 
meeting. If you have item5 to add to the agenda, plea5e 5end them 
to Helene Seller5 within the next three week5. 

Look over your text. If it is just the way you want it, save the file. 

1 Press ~KD to save the document. 

Outlining an Agenda 
A meeting agenda is often structured like an outline. You can use WordStar's para­
graph-numbering feature to construct a standard meeting agenda. You can easily read 
the agenda into a WordStar file to distribute it and to use the outline as the basis for 
your minutes. 
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1 Open a document file and name it something descriptive. For instance; call it 
c:\ws5\agenda. 

2 Create the agenda in outline form. Press "OZ for each consecutive number. Use 
the right arrow key to move in a level. Use the left arrow key to move out a level. 
Press ~ to accept the displayed level. In our example, the resulting outline looks 
like this: 

1. Opening remarks 
1.1. President's report 

2. Report from Product Marketing 
2.1. Progress 

2.1.i. action items from last month 
2.1.2. major accomplishments 

2.2. Issues needing resolution 

3. Report from Product Development 
3.1. Progress 

3.1.1. action items from last month 
3.1 .2. maj or accompl i shment s 

3.2. Issues needing resolution 

4. Report f~om Sales 
4.1. Progress 

4.1.1. action items from last month 
4.1.2. major accomplishments 

4.2. Issues needing resolution 

5. Current issues 

6. Action items 

Updating and Distributing the Agenda 
Often, when it's time to send out the agenda, there are changes to incorporate. In our 
example, the vice-president of Sales is out of town and won't present a report; the rep­
resentative from Testing has a presentation to make; and the president wants to have a 
special discussion on documentation. 

You can make changes to the agenda and send it to everyone on the distribution list. 

1 At the opening screen in WordStar, open the file containing your agenda. 

2 Press "KR and read if! the MEETING.FOR file you treated for meeting minutes. This 
file has the correct distribution list; you just need to delete the text pertaining to 
minutes. 
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Adjusting the Boilerplate information 

Although this document is a boilerplate format desigried for the meeting minLltes, it 
can easily be adapted for use as the agenda. Make the following adjustments: 

The title of the document, "MONTHLY STATUS MEETING," is still appropriate 
since this is the agenda for that meetirig. However the text of the header, "Monthly 
Status Report," is not. 

2 Move the cursor to the header line. Change "Monthly Status Report" to Agenda for 
Monthly Status Meeting. 

3 Mark the two paragraphs as a block ("KB to begin the block arid "KK to end the 
block). Delete the block by pressing "KY. 

Now make any necessary changes to the agenda items . .In our example, delete the 
section about the report from Sales and add two specific items under "Current issues." 

Move the cursor to the section beginning "4. Report from Sales." Mark the section 
between that line and the next agenda item ("5. Current issues") as a block. Delete 
the block. 

2 Move down to the blank line below "5. Current issues." Type the following text, 
using the "QZ command to number each entry. 

5.1. Report from Testing 
5.2. Discussion of documentation 

Next, you'll add a title to the agenda and make the important items stand out with 
print enhancements. 

Add a few blank lines above the agenda outline. On the top blank line; type 
AGENDA. Press "QC to center the line. Boldface or underline the title to make it 
stand out. 

2 On the second blank line, type the name and date of the meeting. In our example, 
type Monthly Status Meeting, 12/11/88. You can center this line, too. 

3 You can also boldface each of the major outline entries. 

4 Add any other pertinent comments. For instance, you might want to add a note 
about where the meeting is and mention that the vice-president of Sales won't be 
able to attend. 

S Save and print the memo. 
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Typing the Minutes 
After the meeting, use the boilerplate format you created to type the minutes. In this 
section, you'll see some of WordStar's features that help make this task efficient and 
easy, while producing an impressive result. 

Using the Boilerplate Format You Created 
1 At the WordStar opening screen, open a new document. Name it something 

descriptive, for example, 121188.MTG. 

2 Press "KR and read in the MEETING.FOR file that you created for meeting minutes. 

3 The original text, headers, and footers you created appear in the new file. 

Using the Agenda Outline to Organize Your Minutes 
You can use the agenda of the meeting as an organizational outline for your minutes. 
You'll copy the outline from the memo you sent out to announce the meeting and add 
your notes to each category. 

1 Press "OK to open a window on the file containing your agenda. In our example, 
choose AGENDA.MEM as the file to open. 

2 Mark the agenda as a block and copy it into the meeting minutes file. 

3 Under each heading in the outline, add your notes on the meeting. For instance, 
under the first heading ("Opening remarks; president's report"), you might type 

Leo Williamson reported that the company stock has risen to a 
new high this guarter. He also announced that the documentation 
for the last release won an award for excellence and has 
received rave reviews. He said that the second half of the 
meeting would be devoted to discussing the design for the 
documentation of the new product. 

Making the Minutes Look Professional 
When you've finished typing the proceedings of the meeting, you can add boldfacing, 
underline, and font changes to emphasize different parts of the minutes. 

Here are some WordStar features you may want to use in your meeting minutes. 

Paragraph Margins 

A paragraph margin sets the left margin for the first line of each paragraph. 

1 To indentthe first line of each paragraph, type .pm .50". If your left margin is set 
at 0", the first line of each subsequent paragraph is indented half an inch. 

2 To turn paragraph margins off, type .pm. 
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Numbered Lists 
You can also use paragraph margins to begin the first line of every paragraph at the left 
margin and indent the rest of the paragraph. This is useful for creating numbered lists. 
Follow these directions to create a numbered list: 

1 Set the paragraph margin at A" and the left margin at .50". The commands to do this 
are .pm O"~ and .Im .5". 

2 Type the numbered list. At the beginning of each numbered item, press "OZ. This 
inserts variables in your file that are replaced by consecutive numbers, beginning 
with 1. 

3 At the end of the numbered list, set your margins back to normal. For example, 
type .pm ~ and .1m 0". 

Bulleted Lists 
A bulleted list is much like a numbered list. You can use a Shorthand key macro to set 
up your bulleted list. 

1 From the editing screen, press Esc? to define a new Shorthand character. 

2 For the Shorthand character to define, type 0 and press ~. 

3 Type a descriptive name for the Shorthand character. 

4 Define the Shorthand character as follows. (Each control command is preceded 
by "P.) 

.pm .1""P"M.Lm.5""P"M"P"PBo"P"PB"P" I 

The commands in the Shorthand character do the following: 

. pm .1" 
"PAM 

.1m .5" 

"P"M 

"P"PB 
o 

"P"PB 
"P"I 

Starts the first line of the paragraph at column 1 . 

Moves the cursor to the next line. 

Indents the rest of the paragraph to half an inch . 

Moves the cursor to the next line. 

Turns boldfacing on. 

Types a lower case 0 for the bullet. (If your printer can print a square 
bullet, you can type "P"PO (zero) and type the decimal code for the 
square instead of using the 0.) 

Turns boldfacing off. 

Moves to the first tab stop (same as pressing Tab). 

5 Press ~ to end the definition. 

6 Whenever you want to create a bulleted list, press Esc and type o. 
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(continued !rompage 1) 
weight. the diplomat jusl laughed. Finally the 
captain gave up. I found oUllater that his This sec/loll is available /0 01/ employees/or 
wife is famous for her duty-free bargains." posting /.H! adller·;temenls. We accept sales 

How was the !ood? 

"The food on the cruise was incredibly good. 
And so unusual. For eX8mple, one night they 
came out after dinner with tbis gig8nticswan 
made out of ice cream. I've never seen any­
thing like it. I especially liked all the fresh 
fruit. I'll never know how they managed that 
in the middle of the ocean." 

You mentioned'earlier thal something special 
happened to you on thai beach in Oahu. 
Would you care to go inlo moredeloi/? 

"Well; let's see. This is going to be ,dis· 
tributed to the whole company, right? 

"Frankly, I can't go into the incident on 
Oahu. II was a private moment for me. All I 
can say is, I especially recommend this cruise 
for the ladies in the company. And they can 
feel free to call me for details." 

Do you feel that the cruise will have a direct 
effect 011 your work? 

"I'm sure that it will. For one thing. I ran 
into some Hawaiian programmers who have a 
utility program that is the answer to our 
prayers and I'm recommending that we pur­
chase it immedia~ely." 

Pro",unmlnc 

T..,hS"ppol't 
WrI\Lnc 
ULllnc 
MarbUnc 
T.L.phon. 
S\lPI>OI't 
A'~\lnlLnc 

Manut..:\urlnc 

St.".E ..... nplou 
Joann. CLapp 
Joan Roblnl 
l .. n.Suppl,u 
HarrillO.lund 

~-=y~:;~berc 

El[~~~ 

ads. help wanted I ·""a/s. 
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WordStar can make any newsletter look crisp and professional. You can use print 
enhancements, different fonts, and special features to give your newsletter an exciting 
look. You'll also make the job of typing the newsletter a lot easier and faster by using 
some shortcuts. 

In this application, you'll create a special file that sets up the page design for a news­
letter. Then you'll add some text to that file. Whenever you want to type a new issue of 
the newsletter, you can easily read in this file, with its pretyped page layout com­
mands, banner, and staff credits. 

The example is set up for a Hewlett-Packard LaserJet+ printer with several sizes of 
Times Roman and Helvetica type. Adapt the format to your printer. 

Setting Up the Parameters 
You'll start by setting up the page layout for your newsletter. 

1 At the opening screen in WordStar, open a new document file. 

2 Name the file something descriptive, like NEWS.FOR. 

3 Decide on a font to use for you r newsletter. Press" P = and choose a font. Text, 
headers, and footers will appear in this font unless you change it later. In this exam­
ple, choose TmsRmn 10 pt. 

4 Now, set the margins for your document. Use the following list as a guideline. The 
list shows the settings you need to change and the commands to change them. The 
margin settings are appropriate for most laser printers. Adapt these values for your 
printer. Remember that each dot command must be on its own line and must begin 
in column 1. 

Top margin .mt .3" 

Bottom margin .mb 1.00" 

Page length .pl 11.00" 

Text right-justified .oj on 

5 You can also set the tab stops you're likely to need for the newsletter. For example, 
type .tb and set tabs at .5" and 5.00". 

Adding Text to the Format File 
You'll use the format file to set up the basic page design of a document. It can also 
include text. Any text you include will appear in a new file when you read in the con­
tents of this format file. This feature is useful for a newsletter, where you always want 
to have the same banner and credits. 
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Start by creating the banner for your newsletter. In our design, the banner looks 
like this: 

Vol. X, No. X January I, 1988 

All the news, all the time Big Business Beat Big Business, Inc. 

To create a banner like this one, follow these steps: 

1 Type Vol X, No. X. 

2 You'll right-align the next phrase. Press the Tab key to go to the tab at 5". Then type 
the correct date for the newsletter. For example, type January 1, 1989. Move the 
cursor to the first character in the date, and use the Spacebar to move the date as 
close to the right margin as it can be without wrapping to the next line. 

Creating a Double Line --___________ _ 

1 To create the double line in the sample banner, change to a larger font. Press "P= 
and choose Helv 14 pt. Use the shifted hyphen key (underbar) to type a line all the 
way across the page. 

2 Underline the line by pressing" PS at its beginning and end. Press ~ twice to insert 
a blank line. 

Note: If this technique doesn't work on your printer, there is an alternate way to get a 
double underline. Follow these steps instead: 

1 Use the shifted hyphen key to type a line across the page. 

2 Instead of pressing ~ at the end of the line, press "P~. This causes the next line to 
overprint the first line. 

3 Type another line across the page and super- or subscript it by pressing" PT 
(or "PV) at the beginning and end of the line. 

451 



APPLICATIONS 

Overprinting Several Lines for a Special Effect 
1 In our banner, the name of the newsletter is centered between phrases that al ign at 

the left and right margins. To do this, you'll overprint three different lines. Skip a 
line and type the title of the newsletter. (You should still be using the large font you 
used for the underline.) 

2 To center the newsletter name, press "Oc. Make a note of where the text on this 
line begins and ends. 

3 Overprint the next line. After the newsletter title, instead of pressing ~, press "P~I. 
The cursor moves to the left margin of the next line. 

4 To type the other phrases in the banner, switch to a smaller font. Press "p = and 
choose TmsRmn 10 pt. 

5 Type All the news, all the time. Check the inch indicator to be sure this text won't 
overprint the newsletter name. 

6 Type Big Business, Inc., and use the Tab key and the Spacebar to align the phrase at 
the right margin. Check the inch indicator to be sure this text won't overprint the 
newsletter name. 

7 To copy the double line, press ~ to leave a blank line, then move the cursor back 
to the double line. Make sure the underlining and font commands are on that line. 
Press "Y to remove the line. Without moving the cursor, restore the line with "U. 
Move to the end of the banner ("QC) and restore it again by pressing "U a second 
time. 

Note: If you used the alternate way to get the double underline (using two over­
printed lines), don't use "Y and "U. Instead, block copy both lines, making sure to 
include all print controls. 

8 Change the font back to the smaller size. For instance, press "P = and choose 
TmsRmn 10 pt. 

When you print the newsletter, the two phrases will align at the left and right margins, 
with the name of the newsletter centered between them in a larger typeface. 
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A Format for the Credits ____________ _ 

In the example, the editors and contributors are credited on the last page. Their names 
appear in a smaller font, surrounded by a smaller version of the double underline, as 
follows: 

Newsletter Representatives 

Programming 
Facilities 
Personnel 
Tech Support 
Writing 
Editing 
Marketing 
Telephone 
Support 
Accounting 
Production 
Manufacturing 

Steve Evangelou 
Joanne Clapp 
Joan Robins 
Irene Suppiger 
Harriet Oslund 
Tana Schimberg 
Marcy Telles 
Sande Stanley 
Alicia Spillman 
Amelia Reichsman 
Gabriel Grace 
Morgan Robinson 

To reproduce this effect, follow these steps: 

Type .pa to start a new page. 

2 Type a line with the shifted hyphen key. End the line when the inches indicator in 
the status line says 2.3". Use "PS to underline the line. 

3 Use the .tb command to set a tab for the title at .6/1 and a tab for the representatives' 
names at 1.2/1. 

4 Choose a smaller font. Press "P= and choose TmsRmn 8 pt. 
5 Change the line height, since you are working with a smaller font. Type .Ih 6. 

Typing the Credits _____________ -'---_ 

1 Tab to .6" and type Newsletter Representatives. 
2 Skip a line, type the name of the first department, and tab to 1.2/1. Type the name of 

the representative. 

3 Type the name of each department and representative on its own line. 

4 Skip a line and change to the font you used for the first double line. Then block 
copy the double line. 
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Now, whenever it's time to create a new issue of the newsletter, open a new docu­
ment, press "KR, and read in NEWS.FOR. The settings and text you created will be 
inserted into your new file. You can edit this text in each issue of the newsletter; 
for instance, you can update the volume number and date. You can also reedit 
NEWS.FOR and permanently change the text; for instance, if a new representative 
is added to the list. 

Here are some tips about newsletter style: 

• Decide on a font and style for headings and bylines. For example, headlines might 
appear in Times Roman 12 pt., boldfaced. Bylines might appear in Times Roman 
10 pt., italicized. You can put these commands in the format if you like, followed 
by some sample text, like, "This is the first heading," or "This is a byline." 

• If possible, make your newsletter an even number of pages. Then you can copy it 
two sides to a sheet of paper. 
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Employee Directory 

Sales 
Technical Support product Dev It. 

Jo Berlant 000-0000 
Amy Aiello 000-0000 Eric Azinger 000-0000 Joe Blecka 000-0000 
Bill Blaschke 000-0000 Ellen Baker 000-0000 Joanna Brady 000-0000 
Barbara Duncan 000-0000 Ed Berman 000-0000 Joanne Clapp 000-0000 
Alfred Dyer 000-0000 Erica Bressler 000-0000 Jeff Dalrymple 000-0000 
Ann Eldredge 000-0000 Ginny Burbank 000-0000 Jim Donetelli 000-0000 
Bea Goodwin 000-0000 Dan ,Druid 000-0000 Jeff Marble 000-0000 
Bob Holland 000-0000 Henry Frummer 000-0000 Joe Maxwell 000-0000 
Bill Hornbeck 000-0000 Ed Greenberg 000-0000 John Morris 000-0000 
April Keene 000-0000 Deborah Hamil 000-0000 Joan Robins 000-0000 
Alice Le 000-0000 Griff Hodge 000-0000 Jim Scherr 000-0000 
Andy Reichsman 000-0000 Ernst Hofmann 000-0000 
Bill Robinson 000-0000 Gary Jensen 000-0000 Manufacturing 
Beth Sinclair 000-0000 Lynn Jepson 000-0000 
Alice Spillman 000-0000 George Manning 000-0000 Judy Briggs 000-0000 
Barbara Troast 000-0000 Eric Nelson 000-0000 Karen Godfrey 000-0000 

Harriet Oslund 000-0000 Jul ie Ann Karl 000-0000 
Marketing Greg Quinones 000-0000 Jon Newman 000-0000 

Franz Reichsman 000-0000 John Nolan 000-0000 
Cindy Chew 000-0000 Glen Rotan 000-0000 Julie Patrone 000-0000 
Ann De La Cruz 000-0000 Helen Sellers 000-0000 Julie puryear 000-0000 
Candy Dell' Era 000-0000 Georg ia Tackno 000-0000 John Sellers 000-0000 
Carol DeMello 000-0000 Eileen Wallace 000-0000 
Cheryl Hanley 000-0000 Gayle Webb 000-0000 Legal 
Carol Harrison 000-0000 Dick Willett 000-0000 
Tbomas Lee 000-0000 Donnell Willis 000-0000 Kathy Meader 000-0000 
Bob Moriarty 000-0000 Elaine Wong 000-0000 Ann Partovi 000-0000 
Cindy Peringer 000-0000 June Rippens 000-0000' 
Cathy Shea 000-0000 Administration Karen Sadler 000-0000 

FAcilites Melanie Allen 000-0000 ~ccountinq 
Janet cray 000-0000 

Darcy Beardsly 000-0000 Herb Davis 000-0000 Kevin Baribalt 000-0000 
Dave Cannon 000-0000 Laurie Ozone 000-0000 Kay Cohn 000-0000 
Beth Cutler )00-0000 Frieda Reich 000-0000 Keith collins 000-0000 
Cindy Gergeley 000-0000 Marcy Telles 000-0000 Katie Flynn 000-0000 
David Harris 000-0000 Kitty Wright 000-0000 Kelly Horan 000-0000 
Dave Izuka 000-0000 Leda Wyszinski 000-0000 Kirk Hurford 000-0000 

Creating a Phone List in Landscape Mode 

In this application you'll create a directory of people and their phone numbers. You'll 
use a special page design and newspaper-style columns to divide sections of the list. 

Landscape mode prints text across the length of the page, as opposed to portrait mode, 
which prints text across the width of the page. Landscape mode can be a more effi­
cient use of space when you're printing a phone directory. 
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Note: Not all printers support landscape mode printing. Some printers that support 
landscape mode may have special requirements for its use. For example, you may 
need to use a particular font or character set when you print in landscape mode. Refer 
to your printer manual for more information. 

Setting Up Parameters 

The settings for a landscape document are very different from those for a regular, por­
trait mode document. 

1 At the WordStar opening screen, open a new document file. Name the file some­
thing descriptive, like LAND.FOR. 

2 Specify a font to use. For some printers, the fonts available in landscape mode are 
more limited than the ones available in portrait mode. Make sure to specify a non­
proportional font that is available in landscape mode. In this example, choose 
Courier 10. 

3 Now, set the margins for your document. Use the following list as a guideline. The 
list shows the settings you need to change and the commands to change them. 

Note: You can change most of these settings at the Margins and Tabs dialog box. 

The values for the margins are appropriate for most laser printers. Adapt these set­
tings for your printer if necessary. Remember that each dot command must be on its 
own line and begin in column 1. 

Top margin 

Bottom margin 

Right margin 

Page length 

Text ragged right 

Omit page numbers 

Use landscape mode 

Auto-align off 

.mt 

.mb 

.rm 

.pl 

.oj off 

.op 

.pr or= l 

.awoff 

.2" 

.5" 

9.0" 

8.5" 

Typing the Phone Directory ___________ _ 

First, you'll center the title of the phone list. Then you'll use WordStar's column feature 
to create a phone list in three newspaper-style columns. 

Type the title (in this example, type Employee Directory). Use "PB to boldface the 
title. 

2 Center the title. Press "OC. Then press ~ twice to insert a blank line below the 
title. 
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Adjusting the Tab Settings 
You need to adjust the tab settings for the phone numbers. You'll create a new ruler 
line with the settings you need. 

Insert a copy of the current ruler line into your text by pressing "00. 

2 Turn insert off by pressing the Ins key. Delete all the tabs on the ruler line by re­
placing the! characters with hyphens. Set a new tab by typing a ! character at 
column 19. 

3 Turn insert back on by pressing the Ins key. 

4 Change to newspaper-style columns by typing .co 3, 2. This creates three columns 
separated by two tenths of an inch. 

Typing an Alphabetized List ___________ _ 

You can use WordStar's block sort feature to alphabetize each sublist in your phone di­
rectory. There is no limit to the number of lines you can sort. 

Decide (before you type the list) whether you want the list alphabetized by first name 
or by last name. 

If you want the list alphabetized by first name, follow these steps: 

Type each name in the first sublist. After each name, press Tab, type the phone 
number, and press .,..J. 

2 Move the cursor to the top of the list. 

3 Mark all the names as a block. Move the cursor to the first letter of the first name 
and press "KB. Then move the cursor to the end of the last phone number. 
Press "KK. 

4 Press "KZ to sort the lines in the block. Indicate ascending order when you are 
prompted. 

To alphabetize the list by last name, follow these steps: 

Type each name in the first sublist (last name first, with no commas in between) 
and type the phone number. Separate the last name, first name, and phone number 
with a space; don't press the Tab key. For example, type 

Reichsman Anna 555-1200 

2 Move the cursor to the top of the list. 

3 Mark all the names as a block. Move the cursor to the first letter of the first name 
and press "KB. Then move the cursor to the end of the last phone number on the 
I ist. Press "KK. 
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4 Press "KZ to sort the lines in the block. Choose ascending order at the prompt. 

To reverse each name so it reads in the correct order, you'll use the Shorthand 
function. 

S First, move the cursor to the first name on your list. 

6 Press Esc? to create a new Shorthand character. Choose a character for this Short­
hand macro. In our example, we chose a for "alphabetize." 

7 Choose a descriptive name for the Shorthand character. 

8 You'll type a set of keystrokes to delete the last name, move past the first name 
and restore the last name, tab the phone number over, and move to the next line. 
Type the Shorthand definition as shown. (Each control command is preceded by 

. "P.) Note that the last command in the Shorthand definition uses "[ for the Esc 
key. This invokes the Shorthand macro (Esc a). This is a trick to get the macro to 
repeat over and over again. 

"P"T"P"F"P"U"P"F"P" I"P"QD"P"D"P" [a 

9 Press ~ to end the Shorthand definition. 

10 Press Esc and the Shorthand character for this macro to begin alphabetizing your 
list. For example, press Esc a. When the macro reaches the last name in the sub­
list, press" U to stop it. 

When you're finished, your file should look like this one (with display on): 
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A: LAND. FOR P1 L1Z CZ4 Z. 38" Insert 
File Edit===Go to====Uindow Layout====Style==Other'===EDIT= • -----------------------------------------------------+ 

<Courier 18 lin> < 
.mt .r' 1 
.mb .~' 1 
.rm 9.8" 
.pl a.s" 
. oj off 
.op 
.pr 01'=1 
.aw off 

ABI.ployee Directopy"B 
. 1'1'---------------, ------------------------------------------------------------+ 

.co 3,2 
ABTechnical Suppopt"B 

Amy Aiello 888-8888 
Bi II Blaschke 888-8888 
Ann Eldredge 888-8888 
Bea Goodw in 888-8888 
Alice Le 888-8888 
Andy Reichsman 888-8888 
Bill Robinson 888-8888_ 
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Contracts 
In this application, you'll create a library of standard paragraphs you can add to any 
document. You'll also create a master document for a contract. 

Creating a Library of Standard Paragraphs 
In your business, you probably use some standard paragraphs over and over. Rather 
than retyping these paragraphs each time, you can create a library of paragraphs that 
you add to your documents whenever you need them. In this example, you'll create 
two standard paragraph files for an equipment lease agreement. You can substitute 
names and text appropriate for your business. 

1 To create the first entry in your library, create a new document file from the open­
ing screen. 

2 Choose a descriptive name for the file. In this example, name the file 
LEASEOP.PAR. 

3 Type this text in the file: 

The loaned eguipment is available for sale or lease from Big 
Business, Inc., should the lessee decide to keep it after the 
loan period. 

4 Press "KD to save this file. 
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Next, you'll create the second standard paragraph file. 

From the opening screen, create another document file. 

2 Name this file PROBLEMS.PAR. 

3 Type this text in the file: 

Because of past problems with prompt return of eguipment, the 
lessee agrees to pay a fee of $10.00 per day after the agreed 
date, if the eguipment is not returned on time. 

4 Press "KD to save this file. 

TIP If you use a lot of standard paragraphs in your work, it might be helpful to make 
a library of them. Print each paragraph and label it with its filename. Store the para­
graphs in a file folder or binder. Then, if you can't remember the correct filename for 
the paragraph you want, you can refer to the binder. You can also use the ProFinder 
feature to find, organize, and rename all the relevant files. See the ProFinder documen­
tation for details. 

When you've finished your standard paragraphs, you're ready to create your contract. 

Creating a Master Document for a Contract ______ _ 

A master document contains variables instead of actual names. When you print the 
master document, WordStar asks you what names you want to use in the document, 
and it substitutes this information for the variab!es. You can print the master document 
many times and substitute different information each time. 

In this example, you'll create the master document for an equipment lease contract. 
Start by typing the text of the contract. 

1 Create a new document file from the opening screen. 

2 Name this file LEASE.CTR. 
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3 Type this text in your document: 

Lease Agreement 
This form shall constitute a formal agreement between 
&lessee& (the lessee) and Big Business, Inc. (the lessor). 
Under the terms of this agreement, the lessee agrees to the 
following conditions: 

&lessee& will receive, on loan, the &e~uipment& for the 
purpose of evaluation and testing. 

&lessee& agrees to be responsible for the &e~uipment&'s safe 
return to Big Business, Inc., in good working order, with 
allowances for normal wear and tear. 

In addition, the following clauses apply: 

Note: The ampersands around a word tell WordStar that this word is a variable. 

Next, you'll add clauses to the contract by drawing on your library of standard para­
graphs. In this example, you'll use conditional commands to tell WordStar to print 
the problems paragraph only if there have been problems in the past with recovering 
equipment on time from this lessee. 

First, have WordStar ask you at print time whether the lessee has been a problem in 
the past. 

Type .av problem. 

When you merge print this file, WordStar pauses at this command and asks 
PROBLEM? You can answer Y (for yes) or N (for no). 

Now you'll tell WordStar to print the problem paragraph only if you answer Y to the 
above question. 

Type .if &problem& = Y to tell WordStar to follow the next instruction only if you 
answer "yes" to the problem prompt. 

2 Type.fi problems.par to insert the problem paragraph. (Include a complete 
path name, if necessary.) , 

3 Type .ei to tell WordStar this is the end of the condition. WordStar will insert the 
paragraph whenever you answer Yio the problems question. 

You can add similar sections to have WordStar insert other paragraphs. 
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As a final step, you'll tell WordStar to ask you at print time for the name of the lessee 
and the type of equipment being leased. 

1 Move your cursor to the beginning of the document and type .av lessee. 

2 When you merge print this file, WordStar pauses at this command and asks LESSEE? 
You type the name of the lessee. 

3 Type .av equipment. 

4 When you merge print this file, WordStar pauses at this command and asks 
EQUIPMENT? You type the name of the equipment being leased. 

Your document should now look like this onscreen: 

C:LEASE.CTR PI LI7 C4 Insert Align RgtJust 
File' Edit==Go to~fndow Layout===Style===other===EDIT~ 

L-----! ----! ----! ----! ----! ----! ----! ----! ---- ! ----! ----! ------R 
. av 'lessee 
.av equipment 

Lease Agreement 

This form shall constitute a formal agreement between &lessee& 
(the lessee) and Big Business. Inc. (the lessor). Under the 
terms of th is agreement. the lessee agrees to the fo How i ng 
conditions: ' 

&lessee& will receive. on loan. the &equipmenU for the purpose 
of evaluation and testing. 

&lessee& agrees to be respons il> Ie for the &equ ipmenU' s safe 
return to Big Business. Inc .• in good working order. with 
allowances for normal wear and tear. 

In addition. the Following clauses apply: 

.av problem 

. if &prob lema = Y 

.fi problems. par 

.ei 

Whenever you merge print this file, WordStar asks you the name of the lessee and the 
type of equipment being leased. Your responses to these prompts will be inserted in 
place of the &Iessee& and &equipment& variables. It will also ask you about problems 
(recovering equipment on time from this lessee). If you answer Y to the PROBLEMS? 
prompt, WordStar inserts the problems paragraph. Otherwise, the paragraph won't be 
added. 
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Ms. Katherine Correa 
Worldwide Travel 
2340 Second Ave. 
San Francisco, CA 95999 

Dear Ms. Correa: 

Per your last order: 
3 radiation detectors at $175.00 
2 cases (model 104) at $6.00 
4 AC power supplies at $9.50 

Total due 

August 26, 1988 

$425.00 
$18.00 
$38.00 

$481.00 

If you have questions about your invoice, contact Gabriel 
Grace at our Western Regional Office, 12 San Pablo Rd" 
San Rafael, CA, 94903. 

Because you're such a good customer, we're offering a 
special 15% discount on all merchandise for the next 
month. Take advantage of this special offer to stock up on 
all your equipment needs. 

Sincerely, 

Mr. Big 
Big Business, Inc. 

Creating an Invoice with Data from a dBASf or Lotus File __ 

Preparing a series of invoices involves combining text and data. You need the cus­
tomer's name and address and the amount due. You may also need some other spe­
cialized information, such as which regional office the customer should contact if 
he or she has any questions. You may have individualized notes to add to certain cus­
tomers' invoices. 
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WordStar imports information from many database programs, which makes preparing 
a series of invoices easy, efficient, and accurate. WordStar's ability to import database 
information (without converting the files first) makes it possible for you to add data 
about a particular customer without editing the file each time and eliminates the pos­
sibility of typographical errors. You can even have WordStar figure the total due at 
print time. 

This application uses a dBASE III example. To follow the instructions exactly, you'll 
need a dBASE III file containing customers' names, addresses, and account data. If 
you use Lotus 1-2-3, or another program, adapt the instructions as necessary. 

Creating an Invoice Document 
You'll create a form letter to serve as an invoice. WordStar "fills in the blanks" at print 
time to create an individual invoice for each customer. To create the form letter, follow 
these steps: 

1 At the opening screen in WordStar, open a new document file. Name the new file 
INVOICE.DOC. 

2 On the first line of the file, type .df and the name of the dBASE file containing your 
customer information. Include a full path to this file. Remember that each dot com­
mand you use must be on its own line and must begin in column 1. 

3 Now type .rv* to use all the predefined field names in your dBASE file as WordStar 
variables. If you prefer, you can type .rv and type the variable names yourself, in 
the same order as they appear in the data file. 

4 Type the text for your invoice, as shown in the example below. Use your dBASE 
field names, instead of the ones shown here. 
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Ampersands (&) around text indicate a variable. Variables are replaced by actual 
data at print time. Add the "/0" parameter to the customer address fields. This 
ensures that lines won't be left blank, even if some customers don't have a second 
address line. 

The &@& date variable is a system variable. That means the information for that 
variable is inserted automatically from your computer's memory. If you entered the 
correct date when you booted your computer, today's date replaces this variable 
when the invoice is printed. Remember to leave enough room for the actual date to 
be printed, since it needs more space than the variable does. 



&Mr-M5& &full-narne& 
&addr1-0& 
&addr2-0& 
&city&, &5tate& &zip& 

Dear &Mr-M5& &full-narne&: 

Per your la5t order: 
&unit51& &equip1& at &co5tper1& 
&unit52& &equip2& at &co5tper2& 
&unit53& &equip3& at &co5tper3& 
Total due 

Sincerely, 

Mr. Big 
Big BU5ine55, Inc . 
. pa 

Determining Totals at Print Time 

INVOICES 

&@& 

You can use WordStar's math features to determine the subtotals and grand total due. 
These operations are done by WordStar at print time, and the correct results are 
printed for each invoice. 

1 Move the cursor to the line in your file just below the .rv* command. 

2 Use the .rna command to determine the subtotals. Type the names of the variables 
you want to multiply, but include only the variables that are numbers. In our exam­
ple, type 

.rna tota11 

.rna tota12 

.rna tota13 

&uni t51 & * &co5tper1 & 
&unit52& * &co5tper2& 
&unit53& * &co5tper3& 

The .rna command creates new variables, total 1 , total2, and total3, which repre­
sent the subtotals for each item ordered. 

3 Move the cursor to the space after the first = (equal sign) in the text of the letter. 
Press the Spacebar and type &totall &. Then move down to the space after the 
next =, press the Spacebar and type &totaI2&. Do the same for the third subtotal. 
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You can add another ,rna command to find the grand total due. You'll have WordStar 
print this amount on the line that represents the total due. 

I Press ~ to create a blank line and type 

.rna gtotal &tota11& + &tota12& + &tota13& 

2 Move the cursor just after the words "Total due." 

3 Press the Spacebar and type &gtotal&. 

Variable Number Formatting ___________ _ 

Now you'll add some commands to tell WordStar how to print the numbers that are 
inserted at print time. 

1 Move the cursor to the line just after the ,rna command. 

2 Type ,sv 1 = ($$$,$$$,99). 
This format tells WordStar to put a dollar sign in front of variables with th is parame­
ter. If the number is over 999, a comma is inserted after the thousands place. If the 
number is lower than 1,000, the dollar sign will be preceded by spaces. If the 
number is less than zero (for instance, if the customer has a credit), the number will 
be in parentheses. 

3 Move the cursor to all variables that represent a dollar amount. In our example, this 
includes the three &costper& variables and the &total& variables. Add the 11 pa­
rameter. For example, the &totall & variable would now look like this: 

&tota11/1& 

Variable Text Formatting _____________ _ 

You can also control the format of variables that are printed as text. In this example, 
you'll left-align the &equip& variables. 

1 Move the cursor to the line just below the ,sv command. Press ~ to create a blank 
line. 

2 Type ,sv 2 = LLLLLLLLLLLLLLL. (There are 1 5 Ls.) 

This tells WordStar to allow 15 spaces for the name of each kind of equipment pur­
chased. The equipment name will be left-aligned. If the equipment name is less 
than 15 spaces long, it will be followed by as many spaces as necessary to fill the 
15-character space. 

3 Move the cursor to the &equip& variables in your text. Add the 12 parameter to 
each one. For example, the &equipl & variable would now look like this. 

&eguip1/2& 
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Using Conditional Statements 
Sometimes the information you send to customers varies, depending on where they 
live, the amount of their balance, or the date the invoice is sent. In this application 
you'll add a paragraph telling customers which regional branch of your company to 
contact, depending on their address. 

Follow these steps to add a conditional paragraph: 

Move the cursor to the blank line above the word "Sincerely." 

2 To include your Western Regional Office information for customers living in a particu­
lar state, add a .if command: 

.if &state&=CA 

3 Type the paragraph containing information about the Western Regional Office. For 
instance, type 

If you have questions about your invoice, contact Gabriel 
Grace at our Western Regional Office, 12 San Pablo Road, San 
Rafael, CA 94903. 

4 On the line after the end of that paragraph, type .el to specify the paragraph to print 
if the customer lives in another state. 

S Type the information for the other customers. For example, type 

If you have questions about your invoice, contact Morgan J. 
Robinson at our Main Office, 1201 27th Street, Rockaway, NY 
11691. 

6 End the condition by typing a .ei command. 

Every customer in California will receive an invoice containing the W~stern Regional 
Office address. Other customers will be told to contact the Main Office. 
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Conditional Paragraphs Based on the Balance Due 

You may want to use your invoices as an opportunity to announce a special offer or 
sale. You can add a paragraph announcing a variable discount for customers, depend­
ing on their balance due. 

Customers who are paying the highest amount will receive the biggest discount. 
You'll add a conditional statement that offers a 15% discount to customers whose 
balance is higher than $300.00: 

Move the cursor to the line just above "Sincerely." 

2 Set up the condition. For example, type .if &gtotal& #> 300.00. 

3 Type the paragraph offering the discount. For instance, type 

Because you're such a good customer, we're offering a special 
15% discount on all merchandise for the next month. Take 
advantage of this special offer to stock up on all your 
eguipment needs. 

4 Now tell WordStar what to type if the customer spent less than $300.00 but more 
than $200.00. Type .el. Then type .if &gtotal& #> 200.00. 

5 Type a paragraph offering a lower discount for these customers. 

We're grateful for your patronage, and we're offering you a 
special 10% discount on all merchandise for the next month. 
Take advantage of this special offer to stock up on all your 
eguipment needs. 

6 Then type a paragraph for those who don't earn a discount. 

.el 
Thank you for shopping with us. 

7 End the conditions by typing two .ei commands. Each one must be on its own line. 
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Skipping Records in the Data File ----------
You dOh't want to print an invoice for customers who have no balance due. You can 
skip these customers by using the following technique. 

Move your cursor to the line below the last .sv command. 
Type .if &gtotal& #> O. 

2 Now press "QC to move the cursor to the end of the file (after the page break). 
Type .el. 

3 You can display a message to tell you that this customer's record won't be printed. 
To do this, type .dm &full-name& has no balance due. No invoice will be printed. 

4 Type .ei to end the conditional statement. 

Now, when WordStar finds a customer with no balance due, you'll see the message 
and no invoice will be printed. 

Including dBASf III Memo Fields - ________ _ 
The dBASE III and dBASE III PLUS programs have a memo field feature that allows you 
to make extensive notes about each record in your data file. If you want to include 
these notes for each customer, follow these steps: 

Move the cursor to the place in your invoice where you want the memo field to 
print. 

2 The memo field must be called NOTE. Therefore, the variable for that field is 
&note&. Type this variable name in your file. The entire memo field will be printed. 

Your document should now look like the following: 

.df c:\dbase\customers.dbf 

.rv* 

.ma tota11=&units1& * costper1t 

.ma tota12=&units2& * &costper2& 

.ma tota13=&units3& * &costper3& 

.ma 9tota1=&tota11& + &tota12& + &tota13& 

.sv 1=($$$,$$$.99) 

.sv 2=QLLLLLLLLLLLLLLL 

. if &tota1& #> 0 

&Mr-Ms& &fu11-name& 
&addr1/0& 
&addr2/0& 
&city&, &state& &zip& 

Dear &Mr-Ms& &fu11-name&: 

&@& 

(continued) 
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Per your last order: 
&units1& &equip1/2& at &costper1/1& &total1/1& 
&units2& &equip2/2& at &costper2/1& &tota12/1& 
&units3& &equip3/2& at &costper3/1& &tota13/1& 

Total due &gtota1l1 & 
.if &state&=CA 
If you have questions about your invoice, contact Gabriel 
Grace at our Western Regional Office, 12 San Pablo Road, San 
Rafael, CA, 94903. 

• e 1 
If you have questions about your invoice, contact Morgan J. 
Robinson at our Main Office, 1201 27th Street, Rockaway, 
NY 11691 
· e i 
.if &9total& #> 300.00 
Because you're such a good customer, we're offering a special 
15% discount on all merchandise for the next month. Take 
advantage of this special offer to stock up on all your 
equipment needs. 

· e 1 
.if &9total& #> 200.00 
We're grateful for your patronage; and we're offering you a 
special 10% discount on all merchandise for the next month. 
Take advantage of this special offer to stock up on all your 
equipment needs. 

· e 1 
Thank you for shopping with us. 
• e i 

· e i 
Sincerely, 
Mr. Big 
Big Business, Inc. 
&note& 
.pa 
· el 
.dm &full_name& has no balance due. No invoice will be printed 

• e i 

A copy of the invoice is printed for, each customer with a balance due. If the customer 
lives in California, the paragraph about the regional office is printed. Otherwise, the 
paragraph about the main office is printed. If the customer has a balance due of 
$300.00 or more, a 15% discount is offered. If the customer has a balance between 
$200.00 and $300.00, a 10% discount is offered. If no balance is due, no invoice is 
printed, and you see a message onscreen to that effect. 
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and Interest 

If you're involved in calculating percentages and equations, WordStar's print-time 
math abilities can help you immensely. The following application shows how to figure 
out the total amount of interest a customer will pay on a large purchase, and what the 
monthly payments for the purchase will be. It is set up in merge-print format, assum­
ing that the letter will go out to a group of customers. 

Setting Up the Merge Printing Pa.ra.meters 
You'll start by giving the commands to set up your page design and read in the proper 
data from your data file. 

Open a new document file from the opening screen of WordStar. 

2 On the first line of the file, type .oj off to turn justification off. This makes the inser­
tion of data at print time easier. Remember that each dot command you use must 
be on its own line and must begin in column 1. 

3 Type .op to omit page numbers, since this is the first page of a letter. 

4 Type .df and the name of your data file. 

S Type .rv and the names of the variables in your data file. If all the variables don't fit 
on one line, create a second .rv command. 

For this application, your data file must include variables for the amount of the pur­
chase or loan, the interest rate being charged, and the total number of payments 
(the length of the loan). In our example, these variables are: 

amount of purchase 

interest rate 

number of payments 

&purch& 

&int& 

&numpay& 
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Calculating Interest Rates 
The following equation is used to determine the monthly payment when you know the 
amount being financed, the interest rate, and the terms of the purchase. 

P = A * i * (i + 1 ) n / « i + 1 ) n-1 ) 

In the equation 

P is the amount of each payment. 

A is the amount being financed. 

is the interest rate. To find the interest per payment, i is divided by the number 
of payments per year and must be converted from a percentage to a decimal. 

n is the total number of payments. For example, monthly payments for fourteen 
years total 168 payments. 

Start by converting the interest rate from a percentage amount to a decimal figure. 
Then you'll determine how much interest is charged per monthly payment. Type 
,rna i = &int&/1200. 

2 Now determine the amount of the monthly payment. Type 

.ma P=&purch& * &i& * «&i&+1)" &numpay&)/«(&i&+1 )"&numpay&)-1) 

Setting Variable formats 
You'll determine the format for the variables that contain numeric values. 

1 First, create a format that puts a dollar sign in front of the number and a comma 
after the thousands place. Type ,sv a = $$$,$$$,99. 

2 Now, indicate which variables will be printed with the dollar sign format. Type 
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Typing Your Letter 
Now that you've defined the variables and created the equations you need, type the 
letter to your customers. 

Start by typing the salutation, using the variable names in the .rv command you 
typed at the beginning of the file. Note that the /0 parameter is used so lines won't 
be left blank if there is no data in certain fields. For example, type 

&Mr-Ms& &full-name& 
&addr1/0& 
&addr2/0& 
&city&, &state& &zip& 

Dear&Mr-Ms& &full-name&, 

2 Type the text for the letter, using the new &P& and &i& variables you created with 
the .ma commands. For example, type 

You recently purchased a &equip1& from our company. The total 
purchase price of the &equip1& was &purch&. This letter is to 
confirm the interest rates and payment schedule for your 
purchase. 

The interest rate for your purchase is &i&%. This works 
out to &numpay& payments of &P& each. 

If you have any questions, please don't hesitate to contact 
me at our main office. 

Sincerely, 

Mr. Small, Credit Manager 

3 Type .pa to insert a page break. 
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Your letter should look like the one in the following example . 

. oj off 

.op 

.df finance.dta 

.rv Mr-Ms,full-name,addr1 ,addr2,city,state,zip 

.rv purch,int,numpay 

.ma i=&int&/1200 

.ma P=&purch&*&i&*«&i&+1 )"&numpay&)/«(&i&+1 )"&numpay&)-1) 

.sv a=$$$,$$$.99 

.sv purch=&purch/a& 

.sv P=&P/a& 
&Mr-Ms&. &full-nameilt 
&addr1/0& 
&addr2/0& 
&city&, &state& &zip& 

Dear &Mr-Ms& &full-name&, 

You recently purchased a &equip1& from our company. The total 
purchase price of the &eguip1& was &purch&. This letter is to 
confirm the interest rates and payment schedule for your 
purchase. 

The interest rate for your purchase is &i&~. This works out 
to &numpay& payments of &P& each. 

If you have any questions, please don't hesitate to contact me 
at our main office. 

Sincerely, 

Mr. Small, Credit Manager 

.pa 

Using this form letter, you can calculate the monthly payments and interest rates for all 
the customers in your data file. 

474 



Organization 
Charts 

Big Business, Incorporated 

Mr. Big 

EVERYONE ELSE 

With WordStar's line- and box-drawing feature, you can create many different graphs 
and charts. In this application, you'll create an organization chart. Note that boxes 
look best printed on a printer that uses the IBM character set. If line-drawing charac­
ters are not available, WordStar uses the most similar available characters. 
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Creating a File for the Chart ___________ _ 
1 Start by opening a new file for your organization chart. At the opening screen, cre­

ate a new document file. Name it something descriptive. Be sure to use a nonpro­
portional font. 

2 Turn automatic aligning off with the .aw off command. Remember that each dot 
command you use must be on its own line and begin in column 1. 

3 Display the print controls (if they aren't already displayed) by pressing "OD. 

Working with Boxes - _____________ _ 

The instructions below tell you how to import boxes into your file, how to add boxes 
and connect them, how to enlarge and shrink boxes, and how to type text in boxes. 

Importing the Boxes 

WordStar comes with a file containing a ready-made box. You'll open this file and 
copy the box. (You can also draw boxes yourself with the box-drawing characters.) 

1 Press "OK to open a window into the sample file. Choose \WS5\BOX as the file to 
edit. 

2 Mark the box as a block. Press "OK to move back to your original file and copy the 
block into your original file with the "KA command. 

Making More Boxes 

You can copy boxes wherever you need them for your chart. 

1 Turn on column block mode by pressing "KN. 

2 Mark the box as a block. 

3 Move the cursor to a blank space. Copy the block by pressing "KC. 

Repeat this procedure as many times as necessary. Be careful not to go past the 
right margin of your file. 

Connecting the Boxes 

Use the I ine-drawing characters to connect the boxes. For information on these charac­
ters, see Drawing in the "Reference Guide." 
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Making Boxes Smaller or Larger 
To make a box larger or smaller, start by moving it to its own space. You can open a 
window into another file, or move the box to a blank area at the end of your current 
file. When the box is the right size, move ,it back to its previous location. Be sure to 
widen your right margin if you widen the box. 

Follow these steps to change the size of a box: 

Move the cursor to the top line of the box. If you're not already using column 
mode, change to column mode by pressing "KN. Mark the beginning of a block in 
the middle of the line. 

2 Move the cursor to the bottom line of the box. Mark the end of the block on the 
bottom line, a few characters right of the block beginning. 

3 To narrow the box, delete the marked block by pressing "KY. To widen the box, 
move the cursor to the top line of the box and copy the block by pressing "Kt. 

4 Turn column mode off by pressing "KN. 

To make a box taller or shorter, change the sides of the box. 

1 Move the cursor to any line between the top and bottom of the box. 

2 To make the box shorter, delete the line by pressing "Y. 

3 To make the box taller, mark the line as a block, press ~, and copy it (KC). 

Typing Text inside the Boxes 
Now you'll fill in each of the boxes you created. 

First, turn insert off by pressing Ins (or "V), so you don't destroy the alignment of the 
boxes when you type. 

2 With the cursor keys, move the cursor inside the top box. Type the name of the 
company president. 

3 Move down a line with the down arrow key. Type the president's title under the 
name. 

4 Repeat this process for each member of the organization. 
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Long Documents 
This chapter contains some tips that are particularly effective when you're working 
with long or complex documents. 

Recovering Deleted Text 
You can immediately restore the most recent block of text you deleted with the "U 
command. Usually, you cannot restore previously deleted text. This technique allows 
you to recover previously deleted text under certain circumstances. 

If you previously saved the file you're working on, you can open a window into the 
last version of that file. If you opened an existing file and then made extensive 
changes, you can recover text from the previous version of the file this way. 

To use this technique, follow these steps: 

To open a window on the current file, press "OK. 

2 Specify the filename of the file you're editing. 

3 Move the cursor to the section of text you want to recover. Use the "KB and "KK 
commands to mark the text as a block. 

4 Move the cursor to the first window by pressing "OK. Block copy the text into the 
first window with the AKA command. 

S Move the cursor back to the second window by pressing "OK again. 

Remember that the file you save last will overwrite the other file unless you rename 
one of them. If you think you might want more of the old file's information, use the 
"KT option to save the old version of the file with a different name. 
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Chain Printing Files 
WordStar makes editing a long document very efficient, since you can move to dif­
ferent locations in the file quickly and easily. However, there are times when you want 
to divide one file into smaller pieces (like chapters) and make each chapter its own 
file. For example, if different writers produce each chapter, dividing the file makes it 
easier to keep their work separate and to distribute the chapters for review. 

Once you have created the smaller files, you can chain print them with a simple com­
mand. 

To divide a large document into several smaller ones, follow these steps: 

1 Block mark a section of the large document. This can be as large as an entire chap-
ter. (The maximum size for a block depends on disk space.) 

2 Press "KW to write the block to another file. 

3 Type a new filename for this section of text and press ~. 

4 Repeat this process for each section of text. 

Some tips on organizing the files you've created: 

• Name the files systematically. For example, use the same three-letter file extension 
for each one, or number them (for example, FILE1.DOC, FILE2.DOC, and so on). 
Later, if you perform the same operation in each file, it will be easier to find them if 
they're systematically named. 

• Make sure all the resulting files are in the same subdirectory. You can create a sep­
arate subdirectory just for these files. To do this, use the Run a DOS program com­
mand to go to the operating system. Then type md and the name for the new subdi­
rectory and press ~. Press any key to return to WordStar. Tag and move the files 
into this new subdirectory with the ProFinder feature. 

• Use the ProFinder feature to organize the files in the new subdirectory. 

To chain print the files, follow these steps: 

1 Open the file that contains the beginning of the document. 

2 Press "QC to go to the end of the file. 

3 Type.fi and the name of the next file in your document. Remember that each dot 
command you use must be on its own line and begin in column 1. 

4 Repeat this process in each subsequent file until you've specified the last file for the 
document. 
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Compound Page Numbering 
When you chain print files, they are automatically numbered consecutively. However, 
this may not always be what you want. For instance, you may want to use a com­
pound numbering system, where each section is numbered according to its chapter 
number and each chapter begins with page 1 (1-1, 2-1, and so on). Follow these steps 
to produce compound page numbers: 

Edit each file in the chain-printed document. 

2 At the beginning of the file, type .pn and type 1 to have page numbering for this file 
begi n with 1. 

3 Type.fo to create a footer that prints on all pages. 

4 For the text of the footer, type the chapter number, a dash, and the page number 
system variable. For example, in the file containing chapter 1, type 1-&#&. 

5 Press "KD to save the file. 

Displaying Onscreen Messages When You Print 
You can display messages onscreen when you print a file or a series of files. This is 
helpful if you want to know where you are in the printing process. For example, you 
can add a message to the beginning of each chain-printed file that says, "Now printing 
filename," (you replace filename with the actual name of the file). These messages are 
not printed; they are displayed onscreen only while printing takes place. 

To display onscreen messages while printing, follow these steps: 

1 Open the first file of the document. 

2 At the beginning of the file, type .dm. 

3 On the same line, type your message. It can be up to 79 characters long. For exam­
ple, type Now printing filename, where filename is the name of the file. 

4 Repeat this process for each file that makes up the document. The message is dis­
played for each one at print time. 
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Controlling Page Breaks (Orphan/Widow Control) 

When you chain print several documents, the location of your page breaks will 
change unless you put a page break between each file. You can end up with awkward 
breaks in your text. You can control this. 

You can make sure that certain sections of text (like charts) are not separated by page 
breaks. You can also make sure that certain multiword phrases (like product names) 
are not separated by line breaks. 

To keep a section of text on one page, follow these steps: 

1 Move the cursor to the beginning of the section of text. 

2 Count the number of lines in the section to be kept together. 

3 Type .cp and the number of lines to keep together. 

Now, if the section would normally span two pages, WordStar will print the entire sec­
tion on the following page. Note that this won't work if the section has more lines than 
can fit on a single page. 

To keep a multiword phrase on one line, follow these steps. 

1 Move the cursor to the end of the first word in the phrase. 

2 Delete the space between the first and second word of the phrase by pressing the 
Del key or"G. 

3 Press "PO to keep the two words together with a binding space. 

4 Repeat this process between each word of the phrase. 

Appending Files 

You may prefer to append the files that make up your document. When the files are in 
their final form, you can consolidate them into one file with the append option. To do 
so, follow these steps. 

Open the second file that makes up your document. 

2 Mark the entire file as a block. 

3 Press "KW to write the block to a new file. You are prompted for a filename to 
write to. 

4 Specify the first file in your document as the file to write to. 

5 You are asked if you want to append the new file to the end of the first one, or over­
write the first file. Indicate that you want to append the file. 

6 Repeat this process for each subsequent file in the document. In each case, specify 
the first file as the file to write to. 
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ERROR MESSAGES 

APPENDIX A 

Error Messages 
This appendix lists error messages that may appear on your screen as you work with 
WordStar. Messages are listed alphabetically. Each explanation includes a sug­
gested solution for the problem. Most error messages are followed by the prompt, 
"Press Escape." Escape clears the error message, but does not correct the error. 

The word filename when underlined here is a substitute for an actual filename 
WordStar will display in the message. ' 

A filename is required. 

Type a filename to continue with the command, or press Esc to cancel. 

A printer driver is memory resident. 

You have selected a function (such as indexing or tables of contents) that uses a 
special printer driver. The driver cannot be loaded into memory because you 
have installed WordStar to use only the default printer driver. Use WSCHANGE 
to change WordStar so that you can use more than just the default printer driver. 

A word is too long to fit within the margins. 

A word in a paragraph you have just aligned is too long to fit between the mar­
gins. Unless you hyphenate the word, it will print beyond ~he right margin. 

Arithmetic error. 

Something in your AQM or .MA equation produces an invalid result; for ex­
ample, division by zero, the square root of a negative number, or use of a non­
numeric variable. 
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Background printing is turned off. 

Either background printing is turned off in WSCHANGE or you have insufficient 
memory. Finish editing the file you're in, then print the other file from the 
Opening screen. 

Can't create output file. 

WordStar can't create the print-to-disk file. Make sure there is enough room on 
your disk. If there is enough room, check your CONFIG.SYS file to make sure it 
contains a FILES=20 statement. If you need to add a FILES=20 statement, 
remember to reboot your computer afterward. 

Can't delete or rename the file being edited. 

Before you can delete or rename the file, end the edit session with AKQ, AKD, 
or AKX. 

Can't delete that file. Operating system error. 

Exit WordStar and delete the file using DOS. 

Can't edit temporary files ($ in filename extension). 

You cannot edit the temporary files that WordStar uses while editing. These files 
have extensions beginning with .$A, .$B, or .$C. If you want to edit the file and 
are sure that you won't create problems, you can rename the file or copy it to a 
new fi Ie, then edit it. 

Can't execute command. Your computer may not have enough memory. 

The operating system is unable to run a DOS command. Remember, WordStar 
stays resident in memory while the DOS command is running, so there must be 
enough memory for both WordStar and the command. Exit WordStar before run­
ning the command. 

Can't find COMMAND. COM. Check the boot (system) disk. 
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WordStar can't find the DOS program COMMAND.COM to run your DOS com­
mand. WordStar looks on the drive from which you first booted your system and 
on the default drive, which is the first one in the legal drive list. You can 
change the default drive with WSCHANGE. 

With a two floppy disk system, you may need to insert your boot disk to run a 
DOS command. With a hard disk system, be sure that COMMAND.COM is in a 
directory that is searched. 



ERROR MESSAGES 

Can't find file on disk. 

Be sure the filename is typed correctly. Include a drive letter or directory path if 
the file isn't on the logged drive or directory. 

Can't find that file. Create a new one (YIN)? 

This is a notification that you typed a new filename. If you want to create a new 
file, press Y. If you want to edit an existing file, press N, then type the correct 
filename. If the file is on a different drive or directory, be sure to type the cor­
rect path before the filename. 

Can't find that file. Press C to continue anyway or AU to stop. 

When printing or merge printing, WordStar couldn't find the file referred to with 
.fi, .df, or another dot command. Be sure you typed the filename correctly in the 
dot command and that you included a drive letter, directory path, or change 
command if the file is not on the logged drive, directory, or disk. If you want to 
continue printing without using the file, press C. Otherwise, press AU to quit 
printing, then correct the error. 

Can't find the file filename. 

If you have a two floppy disk computer, make sure you have the correct disk in 
the drive and that you have specified the correct location for WordStar program 
files. If you have a hard disk computer, make sure the files are in the \WS5 
directory. If they are in a different directory, use WSCHANGE to tell WordStar 
the new path to these fi les. 

Can't insert a password protected worksheet. 

You are trying to insert a spreadsheet program worksheet that is password 
protected. You must remove the protection before you can insert the worksheet. 

Can't insert a squeezed worksheet. 

You are trying to insert a spreadsheet program worksheet that has been 
squeezed (compressed). WordStar does not accept squeezed worksheets. 

Can't move to undefined marker. 

Use AKO-9 to set the marker before trying to move to it. 

Can't print. PDF or driver files couldn't be found. 

If you're using a two floppy system, be sure that the printer description file 
(PDF) and necessary driver files are on the program disk. If you're using a hard 
disk system, check whether the path to your \WS5 directory is set correctly. 
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Can't save file until printing is finished. 

You tried to save a file that is currently being used by background printing (for 
merge printing or printing to disk, for example). Wait until WordStar is finished 
printing this file, then save it. 

Can't store results. Disk full or file type conflict. 

WordStar can't create the index (.IOX) or table of contents (.TOC) file because 
your disk is full or your file uses the extension .IOX or .TOC. Create room on 
your disk by moving or deleting files, or rename the current file with a different 
extension. 

Can't update dictionary. Disk may be full, protected, not in the drive, or may not 
exist. 

WordStar was unable to add a word to the personal dictionary 
(PERSONAL.OCT). Be sure the correct disk is in the drive. If necessary, delete 
files to make room. Don't keep PERSONAL.OCT on a write-protected disk. 

Change disk. Press C when ready to continue. 

The file you are printing contains a command to insert a file from another disk. 
Put in the correct disk for the inserted file. 

Changes have been made. Abandon anyway (YIN)? 

You pressed I\KQ to exit the file without saving changes. If you want to aban­
don the changes, press Y. If you don't want to abandon the changes, press N. 
Then press I\KD to exit the file and save the changes. 

Cursor is not on a note. 

The note command you are using requires that the cursor be on the note. Move 
the cursor to the note and try again. 

End of block is at or before start of the block. 

The beginning block marker (I\KB) must be before the end block marker (I\KK) in 
your text. In column block mode, the beginning block marker must be to the 
left of the end block marker. 

End of block not below and to right of start of block. 
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The block markers do not mark a valid column. Set the beginning marker (I\KB) 
at the upper-left corner, and the end marker (I\KK) at the lower-right corner 
when working with column blocks. 
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Equation is too complex. 

Your math equation is too complicated for WordStar to handle. Reword the 
equation in several smaller equations. 

File access denied by DOS. Check subdirectory & device names. 

DOS is preventing you from opening a file because it has the same name as a 
subdirectory or DOS device. Rename the file and try again. 

File already exists. Overwrite (YIN) or append (A)? 

Press Y (for yes) if you want WordStar to erase the contents of the existing file 
and insert the new contents. Otherwise, press N (for no) and specify another 
filename, or press A (for append) to add the new text at the end of the existing 
file. 

File error. The disk may be full, or there is a disk write error, or CONFIG.5YS on 
your boot (system) disk lacks the line FILES=20. 

If necessary, delete files (AKJ) to make room. You may want to copy one or more 
files to another disk (AKO) before deleting them. Be sure that the CONFIC.5YS 
file on the boot disk contains the statement FILES=20. 

File won't rename. 

There are two possible reasons for this message to appear: 

• You specified a path or drive letter for the new file that is different from the 
original file. Rename the file without specifying a directory or drive, or press 0 
to copy the file to a new drive or directory. 

• The operating system won't let WordStar rename the file. The name you chose 
is probably already being used by a hidden file, a directory, or another system 
file. Choose a different filename. 

Global replacement word list is full. 

To clear the buffer, stop the spelling check (noting how far you got) and save the 
file. Then reopen the file, move to the spot where you left off, and begin the 
spelling check there. 

Help messages are not available. Either WordStar was unable to find the 
WSHELP.OVR file, or you have used WSCHANGE to turn help off or make 
messages memory resident. 

Make sure the WSHELP.OVR file is on your disk. Then use WSCHANGE to turn 
help on or to remove messages from memory. 
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Ignore replacement word list is full. 

To clear the buffer, stop the spelling check (noting how far you got) and save the 
file. Then reopen the file, move to the spot where you left off, and begin the 
spelling check there. 

Incorrect printer name or not enough memory. 

WordStar loads either the default printer driver or the one you named at the 
Printer name prompt. Either the driver is not valid or there is not enough 
memory available to hold it. 

Make sure you specify a valid driver name. You can check WordStar memory 
usage by pressing? at the Opening Menu. If you are running a memory-resident 
program with WordStar, exit WordStar, then the other program. 

Insufficient memory for background printing. 

Wait until you finish editing, then print the file from the Opening Menu. 

Invalid expression. 

You have typed incorrect information in a dialog box. Reenter the information. 

Line is too short to use as a ruler. 

You pressed AOF on a line containing less then two characters. WordStar uses 
the default ruler line instead. If you want to use the line as a ruler line, type 
more than two characters on it, then press AOF again. 

Merge print information is missing or incorrect. Press Cor I\U. 

Some of the necessary dot command information, such as a variable name, is 
missing or is invalid. Press AU to stop printing, then correct the error; or press C 
to continue printing despite the error. 

Mismatched parentheses. 

The number of left parentheses does not match the number of right parentheses. 
Check your equation and correct it. 

No block defined yet. 

Define both the beginning (AKB) and end (AKK) ofthe block before you copy it, 
delete it, move it, or write it to disk. 

No numbers in block to add or subtract. 
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No second window. 

No second window is open. There might not be enough available memory to 
open the window, or you have turned off the window feature in WSCHANGE. 

Not a valid directory path. 

The path you entered is misspelled, incomplete, or doesn't exist on the specified 
drive. Enter the correct path. 

Not a valid filename. 

Type the filename correctly. Include a drive letter or directory path if the file is 
not on the logged drive or directory. 

Not a valid worksheet range. 

The range you specified for the spreadsheet program worksheet doesn't exist. 
Check the worksheet and reenter the range information. 

Not a valid worksheet window. 

The window you specified for the spreadsheet program worksheet doesn't exist. 
Check the worksheet and reenter the window information. 

Not enough memory for nested file insertion (.FI). 

You can reduce WordStar's size slightly in WSCHANGE. If you are running a 
memory-resident program along with WordStar, you may need to remove the 
other program from memory. You can also restr~cture your document to use 
fewer nested .fi commands. 

Not enough memory to continue. 

Your computer has just enough available memory to start WordStar, but not 
enough to create necessary buffers and to load printer information. Press X to 
exit WordStar. You can reduce WordStar's size slightly in WSCHANGE. If you 
have other programs running in the background, exit some of these programs 
before you start WordStar again. 

Not enough space to store shorthand macro. 

You've used up all shorthand definition space. Delete some shorthand defini­
tions, make some definitions smaller, or use WSCHANGE to increase the total 
amount of space available. 

Not in the directory. 

The font, range, window, or color you have specified is not availpble. Choose 
one that is listed in the directory on the screen. 
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Please enter something. 

Enter some information at the prompt to continue with the command, or press 
Esc to cancel. . 

Printer may not be ready. Press C to continue. 

The printer may be offline, out of paper, or at the end of its ribbon. Press C 
when you want to continue. If you get this message frequently for no apparent 
reason, increase the value of the print timeout delay (PRNDL Y) with 
WSCHANGE. 

Save your work before printing this file. 

When using background printing for the file you are currently editing, WordStar 
prints the backup (.BAK) version of the file. The latest changes to this file have 
not been saved. Press AKS to save the changes. Then print the file. 

Second window is in use, or there is insufficient memory. 

Either you are trying to create a note when you have two windows open, or 
there is not enough memory to execute the command. 

Someone else may be using that file. Try again later. 

WordStar cannot save the file because someone else is either printing this file or 
using it with another program. Try again in a few minutes. 

Spelling check or thesaurus temporarily disabled. Cannot change disks while back­
ground printing is in progress. 

The spelling check requires you to take out your Program disk and insert your 
Dictionary disk. Because you are printing in the background you cannot 
remove your Program disk. Wait until printing is done before checking spelling. 

That drive is not on the list of legal drives. 

Type a legal drive letter. You can add drives to the list of legal drives in 
WINSTALL or WSCHANGE. When typing a filename, be sure to follow the 
drive letter with a colon. ' 

That drive is write-protected. 

Remove the write-protect tab or copy the file to a disk that is not write-
protected. . 
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That file is being edited. Temporary files with the same name exist. You can look 
at the file, but you can't change it. (You can look at only part of very large files.) 

Look at the protected file (YIN)? 

The logged drive/directory contains one or more files with the same name as the 
one you specified, but with an extension that begins with .$A, .$8, or .$C. 

This condition occurs primarily on LAN systems. Another user may be working 
with the file you want to edit, or may be editing another file with the same 
name but a different extension. (The temporary files for these two files would 
have identical filenames.) The temporary file(s) also could be left from a 
previous editing session that was aborted by a system failure. 

Press Y to view the protected file. If you want to edit the file, wait until the 
other person is done. If no one else is editing the file, check for the temporary 
files and erase them. If this condition is caused because two files have the same 
name but different extensions, change a filename or move a file to a different 
directory. 

That filename contains invalid characters. 

Type a filename that conforms to WordStar's rules for naming files. 

This command is unavailable during background printing. 

Wait until you finish printing, then execute the command. 

Too large to undo later. Delete anyway (YIN)? 

This text is so large that you won't be able to restore it using the undo com­
mand. Erase the text only if you are sure you won't want to restore it. You can 
change the size of the unerase buffer in WSCHANGE. 

Too many different and lor long merge print variables. 

You defined more merge print variables than WordStar can keep track of in 
memory. Reduce the number of different variables you use or use the same vari­
able names for different functions. You could also use shorter variable names or 
use .SV to make variables hold nothing while they aren't being used. 

Wrong version filename. 

This file is from a previous release of WordStar. If you have more than one 
release of WordStar on your disk, make sure the program files for Release 5 are 
in the \WSS directory. If you want them to reside in another directory, use 
WSCHANGE to specify where. If you're not using the previous release of 
WordStar, erase the old program files. See the IIStartingll section of the manual 
for a list of version 4.0 files to erase, and see README for a list of files from 
version 3.3. 
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APPENDIX B 

Transferring Files 
Between Releases 

You can transfer documents easily between different releases of WordStar 
Professional. You can use all of your existing WordStar documents directly with 
Release 5. 

To use Release 5 documents with a previous release of WordStar, you need to fol­
Iowa simple conversion procedure that removes all the new commands. 

For a complete list of the new features in WordStar Professional Release 5, refer to 
the What's New booklet. For information on installing Release 5, refer to the 
"Starting" tab section. 

Using WordStar Documents 
from Previous Releases with Release 5 

If you have WordStar documents and nondocuments from a previous release of 
WordStar, you can use all of these files directly with Release 5; you do not need to 
convert them. However, you may need to modify some ruler line settings. 

In previous releases, the width of a ruler line column was determined by the size of 
the font. In Release 5, each ruler line coillmn is a standard width, independent of 
the size of the font. If you used dot commands to change margins or tabs (.rm, .1m, 
.pm, .rr, .po, or .pe), you'll need to modify these dot commands based on the new 
column width. 
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For example, if you used a small font in a previous release, you may have set the 
right margin to 80 (.rm 80) to have text extend 6.5 inches across the page. In 
Release 5, you set the left margin at 65 columns or 6.5 inches (.rm 65 or .rm 6.5 11

), 

regardless of the the font you're using, to have text extend 6.5 inches across the 
page. 

TIP You can use the find and replace command (I\QAJ to locate every occur­
rence of .rm 80 and replace it with .rm 6.5". 

If you're not sure how the old dot command settings translate into inches, multiply 
the old setting by the character width in effect, and divide by 12. For example, if 
the old margin was 84 and the character width was set at 10, multiply 84 by 10 to 
get 840, then divide by 12 to get 70. Set the new margin at 70 (7.0"). 

Note: Because of the new printer information in Release 5, the .cw commands may 
choose different fonts than in Release 4. For best results, delete the .cw command 
and choose the font using the AP= command. 

Using Personal Dictionaries from a Previous Release 

You can use your old personal dictionaries with the new release, but you need to 
sort the words into alphabetical order. 

To sort a personal dictionary, open the dictionary as a non document file, mark the 
entire file as a block, and press AKZ to sort in ascending order. Then save the file. 

Note: Be sure to read the installation instructions for setting up the spelling and 
thesaurus dictionaries. The procedures and dictionaries are different for this release. 

Transferring Customizations 

If you made customizations in Release 4 that you want to transfer to Release 5, you 
can use the auto patcher feature in WSCHANGE. See Appendix C, "Customizing 
WordStar." Some customizations can't be transferred because the program has 
changed in those areas. Refer to README for a list of the user area labels that have 
changed since Release 4. 

Using WordStar Release 5 
Documents with Previous Releases _________ _ 

To use Release 5 files with a previous release of WordStar, you must first convert 
the files. (If you don't convert the files, you may damage them if you try to edit 
them.) When you convert a file, WordStar creates a new version of the file that is 
compatible with Release 4; the original file is not changed. 
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(If you have a two floppy disk computer, copy the WS4.PDF and the DRIVER4.0VR 
files from the printer data disk to your working copy of the Release 5 Program disk.) 

To convert a document, follow these steps: 

1 Start WordStar Professional Release 5. 

2 At the Opening screen, press P to print a file or choose Print a file from the File 
pull-down. (WordStar doesn't print the file to a printer; it "prints" it to a new file 
on your disk.) 

3 Type the name of the file you want to convert. 

4 Choose WS4 as the printer. 

5 Type a name for the new file at the Redirect output to prompt. 

6 Press I\K or F10. 

WordStar creates a new file compatible with Release 4. Release 5 commands that 
are not compatible with Release 4 are deleted from the new fi Ie, and comments are 
added to the fi Ie to let you know where these commands were located. 

Note: After conversion, tab and margin settings are set for 10 characters per inch 
and may need to be adjusted if you use other fonts in your document. See the 
Release 4 Reference Guide for information on setting tabs and margins. 
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Customizing 
WordStar 

WordStar comes set up to work the way most users prefer, but you can easily 
customize it to fit your needs exactly. 

When you first install WordStar, you use WINSTALL, a simple installation program 
that sets up WordStar to work with your computer. See the "Starting" tab section for 
information on using WINSTALL. 

This appendix tells you how to use WSCHANGE and PRCHANGE. 

WSCHANGf includes all the customizations from WINSTALL, plus many more. 
Using WSCHANGE, you can make WordStar work exactly the way you want; for 
example, you can change the default settings for things like auto-align, justification, 
or the help level, or you can change the colors on a color monitor. 

The section on WSCHANGE includes a menu map showing how the program is 
organized, a chart that shows you where to find the most common changes, and a 
few examples showing how to use the program. 

TIP WSCHANGE has extensive online help that explains each of the choices on 
every menu. Be sure to look at the help screen if you have questions about what a 
menu item does. 

For the more advanced users, there is a section on patching WordStar. 

PRCHANGf is WordStar's printer customization program. You can tell WordStar 
what printers you have and specify different settings for each printer. 
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The section on PRCHANGE explains how to make WordStar take best advantage of 
your printer. (This section also includes information on the PDFEDIT program.) 

VVSCHANGE ________________________ __ 

Starting WSCHANGf 

To start WSCHANGE, follow these instructions. 

If YOU HAVE A TWO fLOPPY DISI< COMPUTER 

Put your copy of the Program disk in drive A and the Installation disk (which 
contains the WSCHANGE.EXE and WSCHANGE.OVR files) in drive B. 

2 Type b: and press.J to log on to the B drive. B> should appear on your screen. 

3 Type wschange a:ws and press.J. You'll see the Main Installation Menu. 

IF YOU HA VE A HARD DISI< COMPUTER 

1 Log on to your \WS5 directory. 

2 Type wschange ws and press.J. You'll see the Main Installation Menu. 

Creating more than one customized version You can create more than one cus­
tomized version of WordStar; for example, you could create one version with the 
defaults set for legal documents and one with the defaults set for other documents. 

To create additional versions of WordStar, start WSCHANGE by typing only 
wschange. You'll be prompted for the name of the fi Ie you want to start with and 
the name of the file where you want to save the changes. When you quit 
WSCHANGE, all of the new settings will be saved to the filename you specify. 

To start this new version of WordStar, remember to type the name of the new file; 
for example, if you save the legal version in a file called WSLEGAL.EXE, you would 
type wslegal to start this version of WordStar. 
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Overview of WSCHANGE 

Once you start WSCHANGE, you see the Main Installation Menu. WSCHANGE is 
divided into categories to help you find the item you want to change. 

Create/ 

Modi fy PDF 
(Starts 

PRCHANGE) 

Mai n I nsta llati on Menu 
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Each category on the Main Installation Menu contains a different type of 
cLJstomization. 

Console This section lets you tell WordStar about your monitor and keyboard. For 
example, you can specify what type of monitor you have, or customize your func­
tion keys or, if you have a color monitor, you can change the menu colors. 

Printer This section lets you specify a default printer and start PRCHANGE, the 
printer customization program. 

Computer This section lets you tell WordStar about your computer; for example, 
you can specify what drives your computer has, and customize how you use the 
memory on your computer and where you store the WordStar files. 

If your computer has extra memory, you can use the memory to make WordStar run 
faster; for example, if you have a two floppy disk computer you might want to load 
the spelling dictionary into memory. Then when you run a spelling check, you 
won't have to swap disks every time. 

WordStar This section lets you customize many of the initial settings for 
WordStar's features; for example, if you mostly use legal paper, you can set the 
default page length to 14 inches instead of 11. Or, you can change the default 
menu display level to level 3, so the pull-downs aren't displayed. 

Remember that the default settings are the settings in effect when you start 
WordStar. You can also change many of these settings while you're using WordStar. 
But any changes you make to the settings while editing are temporary changes; the 
next time you start WordStar, your default settings will again be in effect. 

Patching This section lets you transfer customizations to other copies of WordStar, 
or reset all the items to their original settings. Technically oriented people can also 
use this section to patch WordStar directly. 

Choose the area you want to change by pressing the appropriate letter from the 
menu; for example, if you want to customize WordStar settings, press C. Many of 
the choices on this menu lead to submenus with more specific choices. 

TIP Much of the information about WSCHANCE is online. That is/ you can see it 
onscreen while you're using the program. At most menus, press the? key to see a 
help screen that explains the choices on the menu. 
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Changing a Setting 

To change a setting, go to the menu that contains that setting; for example, to 
change the right margin, press D, A, and A to get to the Page Sizing and Margins 
Menu. 

The menu shows a list of items you can change and the current settings for the 
items; for example, the Page Sizing and Margins Menu shows the current default 
setting for all the margins. (Some menus may also show codes in the right column. 
These codes are the user area labels, and are for advanced changes using the patch­
ing menus.) Press the letter for the item you want to change, and WSCHANGE 
prompts you for the new setting. 

For some settings, WSCHANGE checks that your answer falls within limits; for ex­
ample, if you type a number for the right margin that is too large, you'll see the 
message, Out of range . .. must be 00.72''-31.87''. Type a new number that is in­
side the limits. Remember that WSCHANGE can't check everything, so use com­
mon sense. 

The sections that follow tell you step by step how to change the most common 
settings. 

TIP You can press I\X at any menu to save the changes you've made so far and 
leave the installation program. You can press I\C to leave the installation program 
without saving any changes. 

Changing the Function Keys 

You can change the 40 function keys to issue whatever commands or letters you 
like. You can change the labels that appear at the bottom of the editing screen or 
you can turn these labels off. You can also reset the keys to match their settings in 
WordStar 3.3. 

To change the function keys, follow these steps: 

At the Main Installation Menu, press A to see the Console Menu. 

2 Press B to change the function keys. 

3 Follow the instructions onscreen to change any function keys you want. 

4 When you finish changing a function key, you'll be prompted to change the 
label for the function key. 

5 When you're finished, press X twice to return to the Main Installation Menu. 
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To set the function keys back to their settings in WordStar 3.3, follow these steps: 

1 At the Main Installation Menu, press E to see the Patching Menu. 

2 Press A to choose auto patcher. 

3 Type the filename WS3KEYS.PAT and press.J. (This file comes on your 
Installation disk.) 

4 Press any key. 

5 Press X to return to the Main Installation Menu. 

Changing the Help Level 

You can change the default help level to 4 (pull-down menus are displayed), 3 (all 
classic menus are displayed), 2 (the classic Edit Menu is not displayed, so you have 
more room for typing), 1 (no menus are displayed), or 0 (no menus or prompts are 
displayed). Here is an example of changing the default help level to 2: 

1 At the Main Installation Menu, press 0 to see the WordStar Menu. 

2 Press B to see the Editing Settings Menu. 

3 Press A to see the Edit Screen Menu. 

4 Press A to change the help level. 

5 Press 2 to specify the defau It level. 

6 Change any other editing screen defaults you want, then press X three times to 
return to the Main Installation Menu. 

Changing Colors on a Color Monitor 

If you have a color monitor, you can change the colors for the WordStar menus, 
status line, and other screen displays. To change the colors, follow these steps: 

1 At the Main Installation Menu, press A to see the Console Menu. 

2 Press C to change video attributes. 

3 Press A to select colors individually. 

4 Follow the instruction on the screen to choose the new colors you want. 

5 When you're through making changes, press X two times to return to the Main 
Installation Menu. 
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Changing Margins 

You can change most of the WordStar initial margin settings. Here is an example of 
changing the default top margin: 

1 At the Main Installation Menu, press 0 to see the WordStar Menu. 

2 Press A to see the Page Layout Menu. 

3 Press A to see the Page Sizing and Margins Menu. This menu offers you choices 
of page length, margins, and page layout. 

4 Press B to choose top margin. You'll see the prompt, Currently: .5". Enter new 
value (or.J if no change). 

5 Type the new top margin you want as the default and press ...I. 

6 Change any other items you want on this menu, then press X three limes to 
return to the Main Installation Menu. 

Returning to Original Settings 

You can return all the settings to the way they were when you first purchased this 
release of WordStar. Follow these steps: 

1 At the Main Installation Menu, press E to see the Patching Menu. 

2 Press C to choose reset all settings. 

3 Press Y to confirm that you want to reset all settings. 

4 Press X to return to the Main Installation Menu. 

Path to Common Changes 

The chart on the following pages shows you the path to the most common changes; 
for example, if you want to change the default help level, look up IIHeip level ll in 
the chart below. It shows the path from the Main Installation Menu to the help level 
customization. Simply press the letters shown in bold on the chart (0, B, A, A), then 
type the new setting. Press AX ...I to save your changes and leave the installation 
program. 
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The following chart shows the path to the most commonly used customization options in WSCHANGE. 

SETTING PATH 

Auto patcher E (Patching) 
Automatic backup D (WordStar) 
Colors on. color monitor A (Console) 
CONFIG.SYS C (Computer) 
Copy setti ngs from fi Ie E (Patching) 
Dictionary name/location D (WordStar) 

Directory display C (Computer) 
Disk drives C (Computer) 
Display print codes D (WordStar) 

Dollar format D (WordStar) 

Exit from WSCHANGE J\X 
Exit without saving changes J\C 

Filenames C (Computer) 
Find and replace options D (WordStar) 
Footnotes D (WordStar) 
Function key labels displayed A (Console) 

Function keys A (Console) 
Headers and footers D (WordStar) 
Help level D (WordStar) 
Hyphen help on/off D (WordStar) 
Indexing defaults D (WordStar) 

A (Auto patcher) 
C (Other features) 
C (Video attributes) 
F (Check CONFIG.SYS) 
A (Auto patcher) 
C (Other features) 

E (Directory display) 
A (Disk drives) 
B (Editing settings) 

C (Other features) 

Y 

D (WordStar files) 
B (Editing settings) 
A (Page layout) 
E (Keyboard) 

B (Function keys) 
A (Page layout) 
B (Editing settings) 
B (Editing settings) 
C (Other features) 

G (Miscellaneous) 
A (Select colors individually) 

A (Spelling checks) 

A (Valid disk drives) 
A (Edit screen) 

D (Shorthand) 

G (Find and replace) 
D (Endnotes and footnotes) 
A (Function keys) 

B (Headers and footers) 
A (Edit screen) 
C (Paragraph alignment) 
C (Indexing) 

J (Auto backup) 

B (Main spelling 
dictionary fi Ie) 

F (Normally show 
print controls) 

E (Dollar format 
for numbers) 

G (Onscreen function 
key labels) 

A (Help level) 
C (Hyphen help) 



Initial logged drive/directory C (Computer) E (Directory display) E (Initial directory log-on) 
Insert on/off D (WordStar) B (Editing settings) B (Typing) B (Insert characters) 
Justification on/off D (WordStar) B (Editing settings) C (Paragraph al ignment) A (Right justification) 
Margins D (WordStar) A (Page layout) A (Page size and margins) 
Memory defau Its C (Computer) C (Memory usage) 
Menu level D (WordStar) B (Editing settings) A (Edit screen) A (Help level) 
Merge print defaults D (WordStar) C (Other features) E (Merge printing) 
Mon itor type A (Console) A (Monitor) A (Monitor selection) 
Nondocument settings D (WordStar) C (Other features) B (Nondocument mode) 
Notes D (WordStar) A (Page layout) D (Endnotes and footnotes) 
Page length D (WordStar) A (Page layout) A (Page size and margins) A (Page length) 
Page number location D (WordStar) A (Page layout) B (Headers and footers) C (Position of page number) 
Page numbers on/off D (WordStar) A (Page layout) B (Headers and footers) B (Print page numbers) 
Path C (Computer) D (WordStar files) A (Fi Ie search path) 
Personal dictionary name D (WordStar) C (Other features) A (Spelling checks) D (Personal spelling 

dictionary file) 
Personal dictionary location D (WordStar) C (Other features) A (Spelling checks) E (Dictionary usage) 
Printer, default B (Printer) A (Default printer) 
Printer, installing (PRCHANGE) B (Printer) B (Create/modify PDF) 
Printing defaults D (WordStar) B (Editing settings) I (Printing defaults) 
Release 3.3 settings D (WordStar) B (Editing settings) H (WordStar 3.3 compatibility) 
Restore original settings E (Patch i ng) C (Reset all settings) 
Ruler lines D (WordStar) A (Page layout) E (Stored ruler lines) 
Save color settings in file A (Console) D (Monitor patches) D (Save colors) 
Save function key settings A (Console) E (Keyboard) C (Save function keys) 
Save installation changes in file E (Patching) B (Save settings) 
Screen size· A (Console) A (Monitor) C (Screen sizing) 
Shorthand defau Its D (WordStar) C (Other features) D (Shorthand) 
Soft space display D (WordStar) B (Editing settings) A (Edit screen) D (Soft space display) 
Spell i ng defau Its D (WordStar) C (Other features) A (Spelling checks) 

Strikeout character D (WordStar) B (Editing settings) I (Printing defaults) I (Strikeout character) 

Tab stops D (WordStar) A (Page layout) C (Tabs) 
Window, open as doc/nondoc D (WordStar) C (Other features) G (Miscellaneous) H (Prompt for. other window) 

VI 
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Transferring Customizations (Auto Patcher) 

The auto patcher section of WSCHANGE lets you transfer some or all of your 
customizations to another copy of WordStar. 

This is very useful if you get an upgrade of the program and want to customize it 
without rechoosing every item step by step, or if you want to trade customizations 
with another WordStar Professional Release 5 owneL 

The auto patcher lets you specify which customizations you want to save and then 
saves these changes in a nondocument file. You can then use WSCHANGE again to 
copy these customizations into the other copy of WordStar. 

Saving CListomizations 

To save your customizations to an auto patcher file, follow these steps: 

1 From the Main Installation Menu, press E to see the Patching Menu. (There are 
also choices in the function key and screen areas of WSCHANGE to save your 
function key and screen color settings.) 

2 Press B to choose Save settings. 

3 When prompted, type a filename where you'll save the customizations. 

4 When prompted, press .J to save the entire user area, or specify the location of 
the information you want to save. 

You can specify either the address or the label. We strongly recommend that 
you specify the location by label whenever possible. This is especially important 
if you want to copy your customizations to a new release of WordStar. 

5 When prompted, press any key to return to the Patching Menu. 

6 Press X to return to the Main Installation Menu. 

Note: When you use the auto patcher to transfer changes, WSCHANGE creates the 
special auto patcher files for you. Some programmers (or other technically minded 
people) may want to create or edit the auto patcher files themselves. For informa­
tion, read the section on patching below, especially the section on auto patcher 
files. 

Copying Customizations 

To copy an auto patcher file into your WordStar program file, follow these steps: 

1 From the Main Installation Menu, press E to see the Patching Menu. 
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2 Press A to choose Auto patcher. 

3 When prompted, type the name of the auto patcher fi Ie you want to copy and 
press ~. 

4 Press any key to return to the Patching Menu. 

5 Press X to return to the Main Installation Menu. 

WSCHANGE has transferred all the changes to this copy of WordStar. 

Patching 

To patch the program, choose one of the menu entries with the word "patches" in 
its name. 

C AUT ION Be careful when using patches from a previous release of 
WordStar. Patches that refer to data addresses may have disastrous results in this 
release since data has moved. However, patches that refer to user area labels rather 
than to addresses may work on this release since most labels have not changed. Try 
the patch on a copy of the program. (See README for a list of the changed or 
deleted labels.) 

Making patches is a very technical procedure. Rather than answering questions and 
letting WSCHANGE make the changes for you, you will actually type in the 
hexadecimal codes yourself. 

Because mistakes can have some far-reaching effects on WordStar, be sure to make 
a copy of the WS.EXE program before you begin. That way, if your patches don't 
work out as expected, you can go back to your original version. 

The User Area 

All the customizations to WS.EXE are made in a special area of the file called the 
"user area. II 

The user area is made up of many small sections, each of which affects a certain 
part of the program such as the left margin or the function keys. 

Many of these smaJl sections are given labels, such as LGLDRV or HITE. Each label 
refers to a specific section in the user area; for example, the label LGLDRV refers to 
the legal disk drives section and the label HITE refers to the screen height section. 

Each of these sections contains data. Some sections have only one data item; some 
contain more than one. The label is associated with the first data item in the 
section. 
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In addition to labels for sections of the user area, each data item in the user area has 
its own address. These addresses are simply consecutive hex numbers for each 
piece of information; for example, the labellNIEDT has a hex address of aCBO. 

Note: While the address is based on the location of the data and can change if the 
data is moved between releases of WordStar, labels always refer to specific data and 
move with that data when it moves. 

TIP To help you make changes, we've provided a readable copy of the user area in the 
PATCH.LST file (on the Advanced Customization disk). Beforeyou begin making changes, 
print this fife and determine what areas you want to change. Because this file has a large 
right margin, print it in a smaller font, or print it sideways on the page if your printer 
allows. Remember, the PATCH. LST fi Ie is just a readable copy of the user area; the actual 
user area is part of the WS.EXE program file. 

Here is a sample of the user area listing: 

When WordStar opens a file for editing, it uses the 
following initial conditions. 

De8D FF INIEDT DB TRUE ; Right justification when 
typing 

Oe81 FF DB TRUE ; Word wrap when typing at 
end of line 

De82 FF DB TRUE ; Insert on 
Oe83 FF DB TRUE ; Print controls displayed 
Oe84 00 DB FALSE ; No hyphen help 
Oe8S FF DB TRUE ; Ruler displayed 
De86 00 DB FALSE ; Not column mode 
Oe8? 00 DB FALSE ; Column replace off 
De88 01 DB 1 ; Single spacing 

The user area is a combination of program code and English words. 

At the far left side is the address that indicates where in the user area the data 
appears. The addresses are in ascending order and appear on the listing as a 
hexadecimal number. If a line has more than one data item, the next address is 
incremented accordingly. 

Immediately to the right of the address is the hex equivalent for the data stored 
there. 

Sometimes a label is showri next. When you patch WordStar, you can specify either 
the label or the address. Because the label applies only to the first data item in a 
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section, some data items don't have labels associated with them. You can refer to 
these data items by using labels such as INIEDT + 1 and INIEDT +2. 

The 08 or OW shown on each line is the assembler directive that actually defines 
the data. OB stands for "define by te" and OW stands for "define word;" for example, 
OB 3 means to define a byte that contains the number three. Similarly, OW 1 
means to define a word that contains the number one. 

A "word" is a data item with two bytes (16 bits) stored in two successive bytes, with 
the low-order byte first; for example, OW 12EFH means to store the hex word 12EF 
in the two bytes. The first byte contains EF and the next byte contains 12. 

The data that follows a DB or OW can be one of four things: 

• A number 

• TRUE or FALSE TRUE is the same as hex FF; FALSE is the same as hex 00. 

• A string A string is several characters whose ASCII codes are stored in succes­
sive bytes. Strings are shown in the user area listing surrounded by quotation 
marks; for example, the string' ABC' is stored in three bytes as hex 41,42, and 
43 (the ASCII codes for A, B, and C, respectively). 

• Duplicated If the word OUP follows a OB or OW, the value within parentheses 
is to be duplicated several times; for example, 10 OUP (0) means that the value 
zero is to be duplicated ten times. 

The last thing on each line in the example above is a comment that begins with a 
semicolon and describes the data in plain English. In most cases, these comments 
provide the most technical and most detailed information about the data. 

Using Patching Menus 

To patch changes in the user area, choose one of the patching menus in 
WSCHANGE. You'll see a menu of items from that part of the user area. Select one 
of the items from the menu or press the equal sign (=) to go to any other location in 
the user area. 

If you press =, you'll be prompted for an address or label from the user area. Since 
the address for information may change from one release of WordStar to another, 
it's best to signify location using labels. (You can also use label calculations such as 
LGLORV+1.) 

Once you specify what area to patch, WSCHANGE displays the address, the current 
value (in hex) for the 16 bytes beginning at that address, and their ASCII 
equivalents, for example: 

0575 02 0041 03 02 11 1002 0042 04 11 13 OF OF 02 .. A. ..... B ..... . 
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WSCHANGE always displays 16 bytes of information, regardless of the actual size 
of the data you're changing. If the data you are changing is only six bytes long, 
you'll see those six bytes plus ten bytes from the next data. The address at the left of 
the screen is for the first of the sixteen bytes displayed onscreen. 

To the right of the address, the bytes are shown as hexadecimal numbers. Beyond 
those appear the ASCII equivalents for the bytes. (If the byte is not in the range of 
hex 20 to 7E, it is not a displayable character and appears as a dot.) 

The cursor is positioned under the first digit of the first byte at the address shown. 
Change the byte above the cursor (or leave it unchanged) by typing any of the patch 
commands (these are also shown onscreen): 

COMMAND 

, (single quote) 

0-9,A-F 

• (period) 

X 

f- (Backspace) or "H 

"C 

"X 

DESCRIPTION 

To change the value of the digit-pair above the 
cursor to that of any other ASCII character, type a 
single quote (') and then the character, for example, 
'A. WSCHANGE translates this into the proper ASCII 
code equivalent (in this case, hex 41). 

To type a new hex value to replace the current 
value, type two digits. Each hex digit must be either 
a number or a letter between A and F . 

To redisplay the line showing any changes you've 
made, type a period. 

To leave the byte above the cursor unchanged and 
advance to the next byte, press .J. 

To save your changes and return to the menu, 
press X. 

Press ~ (Backspace) or "H to correct typing errors. 

To cancel all your changes so far and return to the 
operating system, press "c. 
To quit WSCHANGE and save your changes, 
press "X. 

After you change the 16th byte, the next 16 bytes are displayed. (You could actually 
go through the entire user area, 16 bytes at a time, but we don't recommend it.) 
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Creating or Editing Auto Patcher Files 

If you want to transfer your changes to another copy of WordStar, use the auto 
patcher. For information on saving changes to an auto patcher file and copying 
these changes to another copy of WordStar, see the "Transferring Customizations 
(Auto Patcher)1I section above. 

You can also create and edit auto patcher files yourself. An auto patcher file is a 
nondocument file that lists the starting location for the customization information, 
then the information for that location. Use WordStar nondocument mode to edit an 
existing auto patcher file or to create one of your own. 

Here is an example of an auto patcher file that patches the 20 bytes starting at the 
labellNIDOC in the user area: 

IN IDOC=03,08,42,01 ,OO,FF, 1 C,02,02,07 
=08,FF ,FF ,00,OC,08,OC,OA,03,08 

The label INIDOC followed by an equal sign (=) indicates where the patch starts. 
You can also use an address calculation such as INIDOC+5 or a hex address. 

Note that the second line of the example begins with an equal sign rather than an 
address. This signifies that it is a continuation of the previous line. Since the auto 
patcher can only handle lines shorter than 128 characters, use this method to break 
up long patches. The hex values for each byte follow the equal signs. 

Add strings to the file by surrounding them by either single or double quotes, for 
example: 

I N III D='Special test version' ,OD ,OA,OO 
TRMINI=FF,ERASCR,ERASCR/l00 

WordStar evaluates the values between commas to the right of the equal sign as 
byte values. They are always evaluated modulo 256. However, all arithmetic is 
done with words (16-bit values), and all numbers are assumed to be hexadecimal. 

You can use these operators in calculations: 

+ add 
subtract 

* multiply 
/ divide 
I and 
A or 

Calculations are evaluated strictly from left to right and cannot use parentheses. 
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Leaving WSCHANGf 

When you are finished with an item, press X to go back one menu. When you are 
through making changes, press AX to leave WSCHANGE and save your changes. (If 
you just want to leave WSCHANGE without saving your changes, press AC.) 

PRCHANGE __________________________ __ 

PRCHANGE is the printer customization program. Use it to install printers and to 
customize default printer settings such as what port your printer is attached to, what 
fonts are available on your printer, or whether form feeds are on or off. 

Starting PRCHANGf 

You can start PRCHANGE while you are running either of the installation programs 
(WINSTALL or WSCHANGE), or you can start it directly from the system prompt. 

To start PRCHANGE while running WINSTALL, choose Install Printer from the 
Main Installation Menu. You'll go directly to the Printer Selection Menu. To see the 
PRCHANGE Main Menu, press Esc. 

To start PRCHANGE while running WSCHANGE, choose Printer from the Main 
Installation Menu, then choose Change/modify PDF. You'll see the PRCHANGE 
Main Menu. 

To start PRCHANGE from the system prompt on a hard disk computer, log on to the 
WordStar directory (\WSS), type prchange, and press.J. You'll see the PRCHANGE 
Main Menu. 

To start PRCHANGE from the system prompt on a two floppy disk computer, put 
your working copy of the Program disk in drive A and the Installation disk in drive 
B. Type b: to log on to drive B, then type prchange and press .J. You'll see the 
PRCHANGE Main Menu. 
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Overview 

Once you start PRCHANGE, you see the PRCHANGE Main Menu. At the Main 
Menu you can install a printer to create a new printer description file (PDF), or you 
can modify an existing PDF. 

Printer Selection Menu 

For information on installing a printer, see the "Starting" tab section. The sections 
below give information on modifying a PDF. 

Printer Description Files (PDFs) 

WordStar stores information on more than 100 printers in the printer data files. 
When you install a printer, the information about your printer is copied from the 
printer data files to a separate little file called a printer description file (PDF). When 
you print a document, WordStar uses the information in the PDF to produce print 
enhancements and select fonts on your printer. 

Use one of these methods to create a PDF for your printer: 

• If your printer is on the Printer Selection Menu, simply choose it from the menu. 
The exact information for your printer is copied from the printer data files to a 
new PDF. This information lets WordStar take full advantage of your printer's 
features. 

• If your printer isn't listed on the Printer Selection Menu, check the Printer 
Information booklet to see if it works like another printer. If it does, choose the 
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other printer from the menu. The PDF that is created will work with your 
printer. 

• If your printer is not on the menu and isn't listed in the Printer Information 
booklet, you can use one of the generic PDFs: 

The DRAFT PDF is designed for printers that can perform a carriage return 
without a line feed. This PDF allows a printer to produce most of WordStar's 
print enhancements by overprinting a line. 

The TYPEWR PDF is designed for printers that can backspace one character at a 
time. It also allows a printer to produce most of WordStar's print enhancements 
by overprinting characters. 

The AUTOLF PDF is designed for printers that always advance the paper one 
line by issuing a line feed when the carriage is returned. In order to produce 
WordStar print enhancements, the printer must be able to backspace. WordStar 
normally produces line feeds itself. This PDF tells it not to send line feeds be­
cause the printer does it. 

These generic PDFs are designed to work with any printer, but they may not be 
able to use the fonts and other print enhancements available on your printer. 
You can use these PDFs without running PRCHANGE. 

Note: More advanced users should refer to the "Editing a PDP section later in 
this appendix for information on creating a PDF by typing in the printer codes 
for your printer. 

No matter which method you use to obtain a PDF, you can modify the PDF to work 
the way you want; for example, you can specify the port your printer is attached to, 
customize the list of fonts, or change the default printing settings. 

Modifying a PDF 

To modify a PDF, choose Modify PDF settings from the PRCHANGE Main Menu. 
You're prompted to choose the PDF you want to modify. 

Move the highlighting to the name of the PDF you want to modify and press -1. You 
see the PDF Modification Menu. 

Choose any items you want from this menu. For information about the items, refer 
to the online help and the Printer Information booklet. 

When you finish making changes, return to the Main Menu. You can modify 
another PDF or quit PRCHANGE. 

If you started PRCHANGE from within WINSTALL or WSCHANGE, you'll return to 
that program when you leave PRCHANGE. 
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Editing a PDF 

Advanced users can edit a PDF and customize all the codes in the PDF. These cus­
tomizations are generally needed only if your printer isn't on the menu of printers 
and you want to create a PDF that will take advantage of all your printer's features. 

To create a PDF to edit, you can either install a printer that is similar to yours and 
modify the PDF to fit your printer, or you can start with the CUSTOM or SIMPLE 
PDF and add the codes for your printer. Use the PDFEDIT program to edit the PDF. 

To start PDFEDIT on a hard disk computer, log on to the WordStar directory 
(\ WSS), type pdfedit, and press .J. 

To start PDFEDIT on a two floppy disk computer, make sure the appropriate PDF and 
driver are on the working copy of the Program disk. Put the Program disk in drive A and 
the Advanced Customization disk in drive B. Type b: to log on to drive B, then type pdfedit 
and press ~. 

Choose the PDF that you want to edit. WordStar comes with two PDFs for you to 
customize: SIMPLE and CUSTOM. 

The SIMPLE PDF really is simple. As it encounters print controls in the text, it sends 
to the printer the control sequence that you have defined for that control. SIMPLE 
makes one pass through the line from left to right. Many printers, however, aren't 
quite that easy to use. There are interactions between the various print controls, so 
if the SIMPLE PDF doesn't produce the results you want, try the CUSTOM PDF 
instead. 

The CUSTOM PDF is more sophisticated than the SIMPLE PDF in that it usually can 
compensate for a missing control sequence. For example, if you don't define con­
trol sequences for turning boldface on and off, the CUSTOM PDF will instead over­
strike the line several times. The SIMPLE PDF, on the other hand, would not be able 
to print any boldface at all. 

When you type the codes, check your printer manual very closely for the correct 
sequences. 

TIP If someone has created a customized PDF for your printer already, you can 
simply copy that PDF into your WordStar directory. 

You can also use this program to tell WordStar about any new features your printer 
has. 

For information about the items on the menu, refer to the online help and the 
Printer Information booklet. 

517 





APPENDIX D 

ASCII 
Conversion Chart 

This chart shows decimal, hexadecimal, and ASCII values for all characters. The 
characters with decimal values above 127 are the extended character set. 

Dec Hex CHR Dec Hex CHR Dec Hex CHR 
000 00 NUL 024 18 048 30 0 
001 01 @ 025 19 049 31 1 
002 02 • 026 lA 050 32 2 
003 03 • 027 lB 051 33 3 
004 04 • 028 lC 052 34 4 
005 05 .. 029 lD 053 35 5 
006 06 • 030 lE ... 054 36 6 
007 07 031 lF ... 055 37 7 
008 08 a 032 20 SPACE 056 38 8 
009 09 0 033 21 057 39 9 
010 OA • 034 22 058 3A 
011 OB c! 035 23 # 059 38 , 
012 OC <j? 036 24 $ 060 3C < 
013 OD ) 037 25 0/0 061 3D 
014 OE fi 038 26 & 062 3E > 
015 OF -¢- 039 27 063 3F ? 
016 10 ~ 040 28 064 40 @ 
017 11 .... 041 29 065 41 A 
018 12 042 2A " 06€ 42 B 
019 13 !! 043 2B + 067 43 C 
020 14 044 2C 068 44 D 
021 15 045 2D 069 45 E 
022 16 046 2E 070 46 F 
023 17 047 2F 071 47 G 
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Dec Hex CHR Dec Hex CHR Dec Hex CHR 
072 48 H 134 86 a 196 C4 
073 49 I 135 87 ~ 197 C5 + 
074 4A J 136 88 e 198 C6 1= 
075 4B K 137 89 e 199 C7 Ir-
076 4C L 138 8A e 200 C8 Ib 
077 40 M 139 8B i 201 C9 r;:: 
078 4E N 140 8C I 202 CA d..!:: 
079 4F 0 141 80 I 203 CB ::;;: 
080 50 P 142 8E A 204 CC I~ 
081 51 Q 143 8F A 205 CO 
082 52 R 144 90 E 206 CE JL 

1r 
083 53 S H5 91 aJ 207 CF d:: 
084 54 T 146 92 JE 208 DO ...lL 

085 55 U 147 93 6 209 01 =;= 
086 56 V 148 94 6 210 02 .."... 
087 57 W 149 95 6 211 03 IL 
088 58 X 150 96 U 212 D4 ~ 
089 59 Y 151 97 U 213 05 F-
090 5A Z 152 98 y, 214 06 rr 
091 5B [ 153 99 0 215 07 it 
on 5C \ 154 9A 0 216 08 =t= 
093 50 1 155 9B ¢ 217 D9 ...J 
094 5E 156 9C £ 218 DA r 
095 5F 157 90 ¥ 219 ·DB • 096 60 158 9E Pt 220 DC -097 61 a 159 9F f 221 DO • 098 62 b 160 AO a '222 DE • 099 63 c 161 A1 i 223 DF • 100 64 d 162 A2 6 224 EO u 
101 65 e 163 A3 U 225 E1 ~ 
102 66 f 164 A4 Ii 226 E2 I' 
103 67 9 165 AS N 227 E3 1T 
104 68 h 166 A6 ~ 228 E4 ~ 
105 69 167 A7 Q 229 E5 (J 

106 6A j 168 A8 (. 230 E6 fJ. 
107 6B k 169 A9 r- 231 E7 T 
108 6C I 170 AA ...., 232 E8 <) 
109 60 m 171 AB '12 233 E9 H 
110 6E n 172 AC 1/4 234 EA n 
111 6F 0 173 AD i 235 EB & 
112 70 P 174 AE 236 EC x 
113 71 q 175 AF 237 ED 0 
114 72 r 176 BO :-:« 238 EE E 
115 73 s 177 B1 239 EF n 
116 74 t 178 B2 :::::::: 240 FO iii! 

117 75 u 179 B3 I 241 F1 ± 
118 76 v 180 84- -l 242 F2 ~ 

119 77 w 181 B5 =-1 243 F3 ~ 

120 78 x 182 B6 -il 244 F4 r 
121 ,'9 Y 183 B7 11 245 F5 J 
122 7A z 184 B8 .~ 246 F6 
123 7B { 185 B9 ~I 247 F7 
124 7C I 186 BA Ii 248 F8 0 

I 

125 70 } 187 BS =;] 249 F9 • 
126 7E - 188 BC ::::!j 250 FA · 127 7F DEL 183 80 ..JI 251 FB V 
128 80 C; 190 BE d 252 FC n 
129 81 U 191 BF .., 253 FD 2 

130 82 e 192 CO L 254 FE • 131 83 a 193 C1 -L 255 FF blank 
132 84 a 194 C2 I 'FF' 
133 85 a 195 C3 I-
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"A or ("<-) 
move left one word, 112 
move to previous field (MaiIList), 

83,232 
abandon 

changes to a file ("KQ), 12,39, 
131,204 

and close a window ("KQ), 61, 
221 

a protected file ("KQ), 199 
accelerator commands, 163 

for formatting text, 76 
for the thesaurus, 40 
for typing, 76 

accent marks, 93 
acoustic modem, 296 
add word to personal dictionary, 

48 
addition 

onscreen calculator, 101 
See also math 

additional features, access from 
Opening Menu, 93 

Additional pull-down menu, 82, 
264 

addresses 
add to MailListdata file, 

230 - 232 
variable list for, 165 
See also data addresses (for 

patching) 
Advanced Page Preview. See page 

preview 
aligning text, 93 - 94 

auto-align text ("OA), 76,93 
document ("QU), 94 
dot command for (.AW), 94, 

222 
footnotes and endnotes 

("ONU),94 
paragraph ("B), 32, 76,94, 145 
in PC-Outline, 374 - 375 
at print time (.PF), 94, 169 -170 
right-justify text, 32, 441,451 

All/even/odd option (for printing), 
195 

alphabetize. See sort 
Alt-l (page preview), 187 - 189 
Alt-F (access File Menu), 12 
Alt-H (ProFinder help), 319 
alternate font (" PAl, 137 

choosing fonts with, 103 
See also fonts; pitch 

ampersand (&), and variable 
names, 86, 164 - 165, 242 

IN D EX 

annotations. See footnotes and 
endnotes 

answer mode, modems, 277, 278 
ANSWERBACK (TelMerge key­

word) 
defined, 288 
in telex script file, 267 

APPEND (TelMerge keyword) 
defined, 289 
and file problems, 304 
and logfiles, 274 

applications 
contracts, 459 - 462 
described, 423 - 426 
envelope printing, 428 - 429, 

433 -434 
form letters, 431 - 432 
invoices, 463 - 470 
letters, 427 - 428 
loans and interest, 471 -474 
long documents, 479 - 482 
meeting minutes, 439 - 447 
newsletters, 449 - 454 
organization charts, 475 - 477 
phone directory, 455 -458 

arrow keys 
cursor movement in MailList, 

83,232 
cursor movement while editing, 

21 
for editing in PC-Outline, 358, 

359 
to move between men us, 161 
to move menu highlight bar, 

162 
ascending sort order, 237 

for block of text, 209 
for a file list (ProFinder), 322 
for outline, 367 

ASCII conversion chart, 519 - 520 
ASCII files, 94 - 95 

converting, 95 
creating, 95, 197 
export from PC-Outl i ne, 379 
read into PC-Outline, 361 
view with ProFinder, 326, 332 

ASCII printer description file, 197 
ASCII sort order, for outline, 367 
ASCII transfer 

for data collection, 278 
described, 275 
and logfi les, 277 
receive a file, 277 

ASClI.WS file, 95, 198 
ask for variable command (.AV), 

167-168 
asterisk (*) 

to delete several files, 119 

ProFinder wild-card character, 
321,323 

send multiple files with 
TelMerge, 279 

asynchronous communications 
adapter card, 260 

ATDELAY (TelMerge keyword) 
and connection problems, 303 
defined,289 

ATTENTION (TelMerge keyword), 
defined, 289 

auto-align text. See under aligning 
text 

auto-answer. See answer mode 
auto-indent ("6 in nondocument 

mode), 95 - 96 
auto patcher 

address display, 510 
commands for, 512 
copy customizations, 508 - 509 
create or edit auto patcher files, 

513 
labels, 509 - 51 0 
patching menus, 511 - 512 
saving customizations, 508 
user area patches, 509 - 511 
See also customization 

AUTOLF printer description file, 
194,516 

AUTOLOG (TelMerge keyword), 
defined,289 

automated communication 
session, 284 - 285 

automatic file saves, for PC­
Outline, 389 

.AV (ask for variable), 167 - 168 

.AW (auto align on/off), 94, 222 

B ___ _ 
"B (align paragraph), 32, 76, 94, 

145 
background printing, 195 

print file while editing ("KP), 
194 

start, 196 
"\ (clearthe screen), 104 
Backspace key 

delete character to left, 22, 119 
in PC-Outline, 349 

backup files (.BAK), 24,96,203 
and PC-Outline, 389 

batch file, create with Pro Finder, 
337 

BAUD (TelMerge keyword) 
in communication service files, 

264 
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defined, 289 - 290 
in TELMERGE.SYS, 265 
and transmission problems, 276 

BBS. See bulletin boards 
BCD floating-point math, and the 

onscreen calculator, 102 
bidirectional printing (.BP), 96 
bin number (.BN), for sheet 

feeders, 205 
binary file transfer. See protocol 

transfer 
binding space ("PO), 97 

and aligning text, 94 
BITS (Tel Merge keyword), defined, 

290 
black and white attributes 

monitors and PC-Outline, 389 
PC-Outline command line 

parameter (lB), 419 
See also monitors 

blank lines, insert in document 
(~ or "N),97 

Block & Save Menu, accessing 
("K),64 

block operations, 98 - 100 
case conversion, 1 02 
in column block mode ("KN), 

70-71,99,104-105 
column replace mode, 71 
commands for, 99 - 100 
copy ("KC), 99,109 
copy between windows ("KA), 

60,100,109,221 
copy block in PC-Outline ("C), 

370 
delete ("KY), 99, 119 
delete block in PC-Outline 

("E),370 
delete column block, 71 
display marked block on/off 

("KH), 38, 99, 193 
export block into another 

program (PC~Outline), 
391 - 393 

hide marked block (" KH), 38, 
193 

import block from another 
program (PC-Outline), 

393 - 394 
mark column block, 71 
marking a block ("KB and 

"KK), 37 - 38,99 
math ("KM), 38, 97 
move ("KV), 38, 99 
move between windows ("KG), 

100,221 
overview of, 35 
ProFinder, 327 

522 

read block into file ("KR), 99, 
109 

sort a block ("KZ), 209 
in windows, 100 
word count of marked block 

("K?),221 
write block to file ("KW), 1 09, 

204 
.BM (bottom margin), 159 - 160 
.BN (paper bin number), 205 
boilerplate, for meeting minutes, 

439-443 
boldfacetext("PB),53,100-101 

find and replace, 133 
in headers and footers, 143 
in index entry page numbers, 

147 
boot computer, 5-12 
bottom margin. See margins 
box drawing, 129 - 130, 

475-477 
.BP (bidirectional printing on/off), 

96 
bulletin boards, TelMerge script 

file for, 276 - 277 
bullets 

in PC-Outl i ne, 377 
problems printing with PC­

Outline, 417 
shorthand macro for, 447 

business letters, 427 - 428 

________ C ________ _ 
"c 

choose sort order (MaiIList), 
236,238 

copy information (MaiIList), 232 
create or change filter (MaiIList), 

233 
exit WSCHANGE without 

saving changes, 503 
scroll down a screen, 112,204 

calculations. See math 
calculator ("QM), 1 01 - 1 02 
CALL (TelMerge keyword) 

automate entire session, 284, 
285 

defined,290 
call waiting, and TelMerge opera­

tion, 259 
cancel a command. See undo 
Caps Lock key, 102 

switch with the Control key, 
151 -152 

caret character (") 
as control key symbol, 288 

enter character as print code, 
115 

in TELMERGE.SYS scripts, 288 
carriage return 

as caret character (") in 
TELMERGE.SYS, 288 

change hard returns to soft 
returns ("6),95,209 

delete, 119 
finding, 133 
initialize modem string (POST­

MODEM),298 
insert in document (~ or "N), 

97 
send at end of TelMerge com­

mand line (function key 
customization), 282 

types of, 208 
case conversion, 102 

convert block to lowercase 
("K'), 100, 102 

convert block to uppercase 
("K"), 100,102 

convert fi rst letter of block 
sentences to uppercase 

("K.), 1 00, 102 
case sensitivity 

finding text, 133 
and ProFinder search, 326, 328 

.CB (column break), 107 

.CC (keep lines together), and 
newspaper-style columns, 

107 
centering text ("OC), 26 - 27, 

103 
center group of lines (.OC), 103 
center page numbers (.PC 0), 

186 
merge printed variables, 

177-178 
CGA monitors. See monitors 
chaining files. See nesting and 

chaining 
Change help level option, Other 

pull-down menu, 62 
chapters, compound page number­

ing of, 481 
character width (.CW), 103 - 104 

in fi les from earlier WordStar 
versions, 496 

characters 
allowed in filenames, 132 
deleting, 22 
in flag column, 135 - 136 
number of in block ("K?), 1 00 
in ruler line, 201 
special characters in keywords 

(Tel Merge), 288 



checksum. See XMODEM check­
, sum/CRC protocols 

children 
defined,350 
hide ("H or "L), 352, 382 - 384 
show (grey +), 352, 385 

Choose font option, Style pull­
down menu, 72 

classic Edit Menu, 64 
classic menus, 163 - 164 

described, 62 
install as default menu type, 

S-ll 
use of, S-3 
See also menus 

classic Opening Menu, 63 
Clear Indent, in PC-Outline ("X), 

372 
clear screen 

with "\,104 
with .CS, 180-181 
CLS (Tel Merge keyword), 290 

clear tabs (" RO), 117 
close 

and abandon window, f> 1 
window, 221 
window in PC-Outline, 386, 

407 
See also exit 

CLS (TelMerge keyword), defined, 
290 

.CO (turn on newspaper-style 
columns), 106 

color monitors. See monitors 
color printing ("P-), 1 04 
column block mode 

Edit Menu option, 70 
using "KN, 99, 104 - 105 

column break (.C8), 107 
column replace mode 

Edit pull-down menu option, 71 
using "KI, 99 

columns, 106 - 107 
COM 1 . See serial port 
comma 

delay modem dialing with, 266 
in index entries, 146 

COMMAND.COM, and Run a 
DOS command, 203 

command files, 107 -1 08 
chain print several files, 183 

command keys, for PC-Outline, 
409 -413 

command line options 
open a file i'n nondocument 

mode, 110,212,213 
open a specificfile, 110, 121, 

212 

for PC-Outline, 419 - 420 
ProFinder, 333 
for WordStar, 213 

comment lines, 108 
in TELMERGE.SYS, 288 

communications services 
add a new service to 

TELMERGE.5YS, 267 
automated session, 284 - 285 
data network access and 

HOSTID,266 
exit while online; 286 
listed, 311 - 313 
registering with, 263 
return online (F8), 286 
See also individual service 

names 
communications. See TelMerge 
compound page numbering of 

chapters, 481 
CompuServe 

address and information about, 
311 

CornpuServe A protocol, 275, 
279 

data transfer, 276 
function key customization and 

check mail, 281 - 282 
receiving mail, 273 
script file, 266 
send electronic mail, 270 
SERVICE keyword for, 301 
terminal emulation for, 276 

concordance generation, 147 
conditional commands 

in invoice example, 467 - 468, 
469 

in lease agreement example, 
461 

and merge printing, 171 - 1 76 
conditional page breaks (.CP), 

185 
for orphan/widow control, 482 

CONFIG.SYS 
FILES statement necessary, S-4, 

S-13 
install with WINSTALL, S-l 0 

configuration 
of PC-Outline, 388 - 389 
of ProFinder, 331 - 333 
See also customization; installa­

tion 
connection problems, with 

Tel Merge, 303 - 304 
console. See monitors 
continue printing after pause, 196 
continuous printing, PC-Outline, 

380 
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continuous underlining (.UL), 220 
contracts, 459 - 462 
control characters, find and 

replace, 133 
Control key (Ctrl), 108 

character (") in TELMERGE.SYS 
scripts, 288 

enter character as print code, 
115 

switch with the Caps Lock key, 
151-152 

copy 
a block ("KC), 99, 109 
block between windows ("KA), 

1 00, 109, 221 
block in PC-Outline ("C), 370 
customizations (auto patcher 

files), 508 - 509 
family between windows in 

PC-Outline ("Q), 387 
a file ("KO), 109 
files with ProFinder, 324 
information between 

'PC-Outline windows, 407 
information in MailList ("C), 

232 
marks in PC-Outline (F9), 365 
ruler line ("00),76,202 
text between wi ndows, 60 
text with ProFinder, 323 
WordStar disks, S-5 to S-7 

Copy block from other window 
option, Window pull-down 

menu, 60 
copy hot key (-), for ProFinder, 

323,332 
.CP (conditional page break), 185, 

482 ' 
CRe. See XMODEM check­

sum/CRC protocols 
create 

a document, 109 - 110 
a file, 10-11 
New Outline Entry (" ~ or 

"N), 350, 363 
New Subdirectory (PC-Outline), 

361 
cross-references, in index entries, 

147 
.CS (clear screen), and merge 

printing, 180-181 
Ctrl key, 1 08 
cursor, 110 
cursor diamond, 110 - 111 
cursor movement 

in blocks, 100 
in dialog boxes, 120 
editing and, 20 - 21 
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go to specific place in text, 135 
keys for, 111 - 114 
in Mail List forms, 83, 232 
in PC-Outline, 348, 358 - 359 
ProFinder, 320 

cursor speed 
in PC-Outline, 388 
See also keyboard delay 

custom print controls, 114 - 115 
CUSTOM printer description file, 

194,517 
Customer Service booklet, S-l 3 
custom ization 

change help level, 504 
color settings on a color monitor, 

504 
common customization options, 

506- 507 
customizations available, 502 
of function keys, 503 - 504 
margin settings, 505 
patches from earlier Word Star 

versions, 496 
patching Word Star, 508 - 513 
return to original settings, 505 
start WSCHANG E, 500 
of WordS tar, 115 -116 
See also installation; 

WSCHANGE 
.CV (convert note), 140 
.CW (character width), 103 - 104 

in files from'earlier WordStar 
versions, 496 

____ D 

~D 

move between menus, 161 
move right one character, 83, 

111; 232 
data addresses (for patching) 

display of, 510 
and patches from earlier 

WordStar versions, 509 
data entry form, 231 

inventory form, 239 - 240 
data files, 116 - 117 

character length limit, 166 
create list, 81 - 85 
define for merge printing (.DF), 

242 
for MailList, 230 
rules for, 116 
saving records ("W), 83, 85, 

232 
skip records in data file, 469 

524 

data networks, to access communi­
cations services, 266 

data separator character, 11 7 
database, PC-Outline application, 

398 - 399 
date 

change file date (ProFinder), 
325 

insertin PC-Outline, 391 
insert today's date (Esc @), 207 
predefined variable for merge 

printing, 165 
date field 

sorting of, 237 
and the &ymd& variable, 243 

dBASE 
create an invoice with dBASE 

data, 463 - 470 
include Memo fields, 469 - 470 
merge print data files from, 171 
and merge printing, 81 

decimal tabs ("Oil, 117 - 118, 
217 

default printer, select with 
WINSTALL, S-9 

defaults, explained, 118 
define file command (.DF), 86, 

117,166,242 
Del key, 118 

delete character at cursor, 22, 
119 

in PC-Outline, 349 
delays 

delay modem dialing with 
comma,266 

in WordStar, 118 
delete 

a block ("KY), 99 
block in PC-Outline ("E), 370 
a c~aracter (Del or Backspace), 

22 
column block, 71 
command summary, 119 
elements (PC-Outline), 353, 

363 
to end of line ("QY), 119 
files with ProFinder, 324 
font command, 137 
footnotes and endnotes, 119, 

139 
a line ("Y), 23, 119, 358 
MailList record ("E), 234 
MailL!st sort order ("E), 238 
outline entries (" D), 363 
an outline (in PC-Outline), 361 
place marker, 193 
print control symbols, 53 
shorthand character, 207 

a word ("T), 22,119 
word to right (Shift-+--), 358 
See also block operations 

Delete block option, Edit pull­
down menu, 71 

descending sort order, 237 
for block of text, 209 
for a file list (ProFinder), 322 
for outline, 367 

.DF (define file), 86, 117, 166, 
242 

dialing 
delay with comma, 266 
prefixes, 298 
prefixes and connection prob­

lems, 303 
redial,270 

dialog boxes, 120 
dictionary 

location of, S-ll 
See also personal dictionary; 

spelling check 
dictionary sort order, for outline, 

367 
DIP switch settings. See switch 

settings 
direct transfer procedure 

MODEM setting for, 296 
null modem script, 279 

directories, 120 -121 
change directory ("KL), 121, 

191 
changing in ProFinder, 321 
display on/off, 120 
logged directory, 155, 191 
path for PC-Outline, 360, 388 

disconnect. Sf2e hang up (FlO) 
disk drives, name with WINSTALL, 

S-10 
display 

commentlines("OND),108 
extended character set (" PO), 

132 
file directory, 120 
a file (ProFinder), 325 
fontlist("P=),137 
index entry ("OND), 147 
message while merge printing 

(.DM),180 
messages while printing, 481 
next MailList record ("N), 85, 

232 
note text ("ON D), 139 
page preview (Alt-l or "OP), 

187-189 
previous MailList record ("P), 

85,232 



print control commands in 
PC-Outline (Alt-Fl), 381 

printer control codes ("00), 
121 

RAM usage, 161 
ruler line ("OT), 76,202 
selected filenames (ProFinder), 

321 
shorthand definitions (Esc ?), 

206 
soft spaces ("OB), 208 
TelMerge keyword settings (F1), 

287 
Thesaurus Menu ("QJ), 50 

division 
onscreen calculator, 101 
See also math 

.DM (display message), 180 
document files, 121 -122 
DOS 

Go to DOS command 
(ProFinder), 333 - 334 

Run a DOS command ("KF), 
202 - 203 

dot commands, 122 - 128 
conditional commands for 

merge printing, 171 - 176 
in document and nondocument 

modes, 122 
, in files from earlier WordStar 

versions, 495 - 496 
for merge printing, 86, 

127-128,166-170,242 
for onscreen formatting, 

125-127 
for page numbering, 186 
for print formatting, 123 - 125 
for sheet feeders, 205 
use of, 31 

double spacing. See line spacing 
double strike text ("PO), 

128-129 
double underline 

creating, 451 
using the strikeout character, 

215 
double-width printing, on an 

Epson printer, 115 
double words, spelling check, 

209 
DRAFT printer description file, 

194,516 
drive 

change for PC-Outline, 360 
logged drive, 155, 191 

DRIVER4.0VR, 497 
.DTA files. See data files 
DTR signal, 302 

DUPLEX (TelMerge keyword) 
in communications service files, 

264 
defined, 290 
echo mode string, 298 
and screen display problems, 

304 

E ____ _ 

"E 
erase record (MaiIList), 234 
erase sort order (MaiIList), 238 
move cursor up one line, 111 
move menu highlight bar, 162 

EasyLink 
address and information about, 

311 
SERVICE keyword for, 301 

echo setting. See DUPLEX 
(TelMerge keyword) 

Edit Menu 
block commands, 37 
Column block mode option, 70 
Column replace mode option, 

71 
Delete block option, 71 
PC-Outline, 368 - 373 

Edit screen, 11, 19 
editing, 130 

cursor movement, 20 - 21 
delete text, 22 - 23 
EDIT menu bar, 11, 19 
open a fi Ie, 1 7 - 18 
overtype mode, 23 
save fi Ie, 24 
status line and, 20 
Undo command, 23 
See also block operations; 

formatting text 
Editing Screen, 162 
EGA monitors. See monitors 
.EI (END IF condition), 174 

and nested .IF commands, 
175 -176 

electronic mail 
create with WordStar, 269 
receiving Email, 273 - 274 
send Email, 270 
send paper mai I, 270 - 271 
types of, 269 
See also telex; TelMerge 

elements 
defined, 350 
delete, 353 
move, 352 

ELSE condition (.EL), 175 

IN 0 EX 

in invoice example, 467, 468, 
469 

ELSE (TelMerge keyword), defined, 
293 

Email. See electronic mail 
EMULATE (TelMerge keyword) 

defined, 290 - 291 
and mainframe computers, 276 

END IF condition (.EI), 174 
and nested .IF commands, 

175 -176 
End key 
. move to end of last onscreen 

line,l12 
move to last field (MaiIList), 83, 

232 
"End (move to end of fi Ie), 112 
END (TelMerge keyword) 

in bulletin board script file, 276 
in CompuServe scriptfile, 266 
defined,291 

endnotes. See footnotes and 
endnotes 

ENDIF (TelMerge keyword), 
defined, 293 

Enter key (~), 130 -131 
insert a blank line, 148 

entries in PC-Outline 
create (" ~ or "N), 359, 363 
defined,350 
delete ("0),353,363 
divide ("U), 366 
join ("J), 365 - 366 
mark/unmark (Alt-OO or F2), 

363 
move ("M), 362 
placement of, 377 

ENVELOPE.LST,247 
envelope 

merge printing for mass mailing, 
433 -434 

printing, 247 - 248, 428 - 429 
Epson pri nter, sample custom 

print control, 115 
equations 

merge printing and math 
operations, 169 

onscreen calculator, 101 - 102 
erase. See delete 
error messages, 131,485 - 493 
Esc! (insert current time), 207 
Esc # (enter last equation), 102, 

207 
Esc "J (help for shorthand), 206 
Esc $ (calculation result as dollar 

amount), 102, 207 
Esc = (result of calculation), 102, 

207 
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Esc? (display shorthand defini­
tions),206 

Esc @ (insert today's date), 207 
Esc key 

access shorthand macro, 65, 
207 

bypass options on PC-Outline 
menus, 349 

to clear error message, 485 
exit a pull-down menu, 162 
go to end offile (Mail List), 85 
return to TelMerge session, 286 
upgrade note about, S-4 

escape character, enter character 
as pri nt code, 11 5 

exclamation mark (!), in 
TELMERGE.SYS scripts, 288 

exclusion list, for concordance 
generation, 147 

exit 
commands for, 131 
MailList, 238 
ProFinder, 329 
a protected file, 199 
a pull-down menu (Esc), 162 
Thesaurus Menu (" U), 50 
WordStar, ("KX), 50,131,203 

EXIT (TelMerge keyword), defined, 
291 

exponentiation, onscreen calcula­
tor, 101 

export 
block from PC-Outline to 

another program, 391 - 393 
files from PC-Outline, 379 - 380 
See also write block to file 

("KW) 
extended character set, 131 - 132 

ASCII conversion chart, 
519 - 520 

display for TelMerge sessions, 
292 

paragraph and section symbols, 
191 

external modems, switch settings, 
260 

EXTLlST.PF, 334 

_____ F ____ _ 

.Fl ... 3, footer commands, 77 
Fl 

display keyword settings 
(TeIMerge),287 

help, 9, 10, 144 
ProFinder help, 319 

F3, go to DOS (TeIMerge), 286 

526 

F4, send a file (TeIMerge), 270, 
271,273,275 

F5 
receive a file with XMODEM 

(TeIMerge),277 
Snap Shot, 286 

F6, send a file with XMODEM 
(TeIMerge),275 

F7, logfile on/off toggle (TeIMerge), 
273 

F8 
print session while online 

(TeIMerge),274 
return online (TeIMerge), 286 
ShoFil,286 

F9 (view another file with 
ProFinder),327 

FlO 
begin printing, 15 
begin word search, 43 
hang up (TeIMerge), 270, 285, 

302 

"F or "--
move right one word, 112 
move to next field (MaiIList), 83, 

232 
.F (footer), 142 
facing pages, and page preview, 

187 
family 

copy between windows ("Q), 
387 

defined, 350 
move between windows ("W), 

388 
.FI (file insert), 182 - 183 
fields 

date field, 237, 243 
for outline sort, 367 - 368 
See also data files 

file management. See ProFinder 
File Menu, 10 

Merge print a file option, 87 
in PC-Outline, 359 - 362 

File option (for printing), 195 
File Options, PC-Outline, 361 
files 

appending to a document, 482 
chain printing of, 182 - 183 
copy, 109 
creating, 10-11 
deleteafile("KJ),l19 
naming, 14, 132 
open for editing, 17 -18 
printing, 14 - 15 
prompt before overwriting 

(PC-Outline),389 

read in a file ("KR), 99, 109, 
149 

rename, 200 
save automatically (PC-Outline), 

389 
saving, 12 - 13,39, 131, 

203 -204 
transferring between various 

versions of WordStar, 
495 -497 

word count of, 222 
See also ProFinder 

Files menu, 162 
FILESEND (TelMerge keyword) 

automate entire session, 284, 
285 

defined,291 
filter records, in MailList, 

233 -234 
finding files, with ProFinder, 

327 - 328 
finding text ("QF), 132 - 134 

accelerator commands, 44 - 45 
automatic replacing, 45 - 46 
font tag ("Q=), 133, 137 
footnotes and endnotes 

("ONG),139 
G option (search from beginning 

orend), 46 
Go To pull-down menu, 42 - 43 
N option (replace without 

asking),46 
options, 133 - 134 
in PC-Outline, 369 
with ProFinder, 326, 338 
repeat previous find/replace 

("L),43,44-45,132 
and replace ("QA), 45, 

132 -134 
FIRST (TelMerge keyword), de­

fined,291 
FK (Tel Merge keyword) 

automatic CompuServe mail 
checking, 281 - 282 

defined,292 
flag column, 20, 135 - 136 

page break symbol, 54 
Flatten Whole Outline, 394 
flip hot key (+) 

changing for ProFinder, 332 
ProFinder, 322 - 323 

floating-point math, and the 
onscreen calculator, 102 

floppy disk systems 
PC-Outline installation, 343 
starting PC-Outline, 344 
starting WordStar, S-13 
starting WSCHANGE, 500 



and TelMerge, 307 
WordStar installation, 5-6 to 5-7 

.FM (footer margin), 160 

.FO (footer), 77,142 
fonts 

add/remove with WINSTALL, 
5-9 

choosing with "P =, 71 - 72, 
136 -137, 199 

choosing with "PN and "PA, 
103 

find font tag ("Q =), 133, 137 
and pitch, 192 
proportional and fixed pitch 

fonts, 137 - 138 
set for PC-Outline printing, 381 

Footer option, Layout pull-down 
menu, 77 

footers. See headers and footers 
Footnote/endnote option, Other 

pull-down menu, 72 
footnotes and endnotes, 72, 

138 -140 
change margins of ("ON U), 94 
convert to different type, 

139-140 
creating, 73, 138 - 139 
edit note ("ON D), 139 
erasing, 119, 139 
finding, 133 
format of reference, 138 - 139 
and newspaper-style columns, 

107 
foreign characters 

and the extended character set, 
131 -132 

print accent marks ("PH), 93 
form document, merge printing 

of,171 
form feed 

insert in a document ("PL), 
140-141 

in PC-Outline, 381 
and sheet feeders, 205 
use form feeds option, 195 

form letters 
create master document, 

241-242 
I NVNTORY.DOT variables, 243 
MAILLlST.DOT variables, 243 
merge printing, 87, 244, 

431-432 
sample master document, 244 
See also Mail List; merge printing 

format definition 
for merge printed numeric 

variables, 1 78 - 180, 466 

for merge printed text variables, 
177- 178, 466 

formatting text, 140 
accelerator commands for, 76 
in document and nondocument 

modes, 122 
overview of, 25 
See also editing 

full duplex. See DUPLEX (TelMerge 
keyword) 

full-speed printing, 196 
FULLSCREEN (TelMerge keyword), 

defined, 292 
function keys 

customize for TelMerge, 
281 -282 

customize with WSCHANGE, 
503 - 504 

described, 141 
for line/box drawing, 129 
Tel Merge assignments, 

309 - 310 
See also individual function key 

entries 

_________ G ________ _ 
"G (delete character at cursor), 

119 
G option (search from beginning 

or end), find and replace text, 
46 

gas plasma monitor, and ProFinder 
installation, 318 

Global Outline Style, in 
PC-Outline, 375 - 377 

GO command (.GO top/bottom), 
175 

Go Start Printing ("P), PC-Outline, 
353,379 

Go To pull-down menu, 42 - 43 
Goto 

DOS during TelMerge session 
(F3),286 

DOS from ProFinder, 333 - 334 
DOS from WordStar, 202 - 203 
a hexadecimal location 

(ProFinder), 336 
a hexadecimal location 

(WordStar), 213 
a line ("QI), 135 
a page ("QI), 122, 135, 186 

GOODCLK.COM, 358 
GOTO (TelMerge keyword), 

defined, 292 
GRAPHIC (TelMerge keyword), 

defined, 292 

INDEX 

graphics monitors 
and PC-Outline, 389 
See also monitors 

Grid display, of page preview, 187 

H ___ _ 

.Hl ... 3, header commands, 77 
"H (delete previous character), 

119 
.H (header), 142 
half duplex. See DUPLEX 

(Tel Merge keyword) 
hang up (F1 0),270 

DTR signal, 302 
during automated session, 285 

hanging indent, 79 - 80, 189 
meeting minute example, 440 
in PC-Outline ("0),372 

HANG UP (TelMerge keyword) 
automate entire session, 284, 

285 
defined,293 

hard disk systems 
PC-Outline installation, 342 
starting PC-Outline, 343 
starting WordStar, 5-13 
starting WSCHANGE, 500 
WordStar installation, 5-5 

HARDCOPY (Tel Merge keyword). 
See PRINT (Tel Merge keyword) 

hardware requirements, for 
TelMerge, 259 

Hayes modems 
2400 modem and DTR switch, 

302 
switch settings, 260 - 261 

.HE (header), 77,142 
Header option, Layout pull-down 

menu, 77 
headers and footers, 141 - 143 

compound page numbering of 
chapters, 481 

dot commands for, 77 
footers described, 76 
headers described, 76 
margins for, 160 
meeting minutes example, 441, 

442 
on odd and even pages, 142 
page number included in (#), 

142,187 
print enhancements in, 142 

help, 144 
accessing from classic Opening 

Menu, 65 
change level of, 62, 164 
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change the level with 
WSCHANGE,504 

change type of menu displayed, 
143 -144 

levels described, 144 
~:>nline access (Fl), 9, 10 
m PC-Outline (Fl), 394 
for ProFinder (Fl or Alt-H), 319 
for shorthand macros (Esc "J or 

Fl),206 
for WSCHANGE (?), 502 

help screen, customize with 
ShoFil,286 

Hewlett-Packard LaserJet printers 
envelope printing, 247 
and PC-Outline, 416 

hexadecimal codes 
conversion chart, 519 - 520 
for custom print control 114 

115 " 
in user area addresses 510 

hexadecimal location ' 
go to with ProFinder, 336 
go to with WordStar 213 

hide ' 
marked block ("KH), 38 99 

193 ' , 

print control symbols ("OD) 
53 ' 

Hide Menu, PC-Outline 
382- 384 ' 

.HM (header margin), 160 
"hold button" phone system, and 

TelMerge operation, 259 
HOLD (TelMerge keyword) 

defined,293 ' 
Home key 

move to column 1 in first 
onscreen line, 112 

move to top (first) field (MaiIList) 
83,232 ' 

"Home (move to beginning of 
file),l12 

HOS!ID (TelMerge keyword), 266 
defmed, 293 

hot keys 
changing for ProFinder 

331-332 ' 
defaults for ProFinder, 322 - 323 

HP-ENVMM.LST,247 
HP2-ENVM.LST, 247 
hyphenation 

auto-hyphenation on/off (" OH) 
76, 144 -145 ' 

force hyphenation ("OE), 145 
soft hyphen insertion ("OE), 76 
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IBM monitors. See monitors 
.IDXfiles,148 
IF condition (.IF), 172 -174 

in invoice example, 467 - 468 
469 ' 

in lease agreement example 
461 ' 

and mailing label printing, 438 
nested .IF commands, 175 -176 

IF (TelMerge keyword), defined 
293 ' 

IFNOT (TelMerge keyword) 
defined, 293 ' 

:IG (comment line), 108 
Import 

block from another program to 
PC-Outline, 393 - 394 

files (PC-Outline), 361 - 362 
See also read a file into docu­

ment("KR) 
INCLUDE (TelMerge keyword) 

defined,294 ' 
Indent Marks (F8), 364 - 365 
I ndent Paragraph (" I), in 

PC-Outline,371-372 
indentation, 145 - 146 

auto-indent ("6 in nondocu­
ment mode), 95 - 96 

clear in PC-Outline ("X) 372 
hanging indent, 79 - 80,' 189 

440 ' 
of paragraphs, 78 - 79 
set number of spaces for 

(PC-Outline), 375 - 376 
temporary indent ("OG), 76 

94,145 ' 
index files (.NDX files), for 

MailList, 238 
indexing, 146-148 
INIT (TelMerge keyword), defined 

294 ' 
INIT~ (TelMerge keyword), de­

flned,294 
Input Other File Types, 

PC-Outline, 361 - 362 
Ins key (toggle insertlovertype 

mode), 23, 148 
Insert Deleted Text (Alt-U) 368 
~nserting text and files, 148 - 149 
Installation 

CONFIG.SYS, S-10 
copy diskettes, S-5 to S-7 
dictionary locations S-ll 
disk drives available: S-l 0 

finishing, S-12 
monitor installation, S-8 
of PC-Outline, 342 - 343 
printer installation, S-8 to S-9 
of ProFi nder, 318 
starting WINSTALL, S-7 to S-8 
of WordStar, S-5 to S-12, 149 
See also customization 

interactive mode (telex), 271, 
272 - 273 

INTERACTIVE (TelMerge keyword) 
defined, 294 - 295 

. in telex script file, 267 
~nterest rate calculation, 472 
Internal modems, switch settings 

261 ' 
interrupt printing. See pause 

printer 
inventory form, 239 - 240 
INVNTORY.DEF,231,239 
INVNTORY.DOT,241 

variables listed 243 
invoices, 463 -4'70 
italic text ("PY), 150 
ITT 

address and information about 
312 ' 

formatfor telex message, 271 
SERVICE keyword for, 301 
TIMETRAN to send message 

272 ' 
.IX (type index entry), 146 

"J (help), 144 
Join Outline Entries ("J), 

365 - 366 
jump to DOS, 202 - 203 

with Pro Finder, 333 - 334 
justification, 32 

commands for, 150 
of merge printed numeric 

variables, 1 79 
of merge printed text variables 

177 -178 ' 
?1icrojustification CUJ), 181 
In PC-Outline, 374 

K ____ _ 

"K 
access Block & Save Menu 64 
select key field for sort (M;iIList) 

237 ., 

start find operation, 132 



"K' (convert block to lowercase), 
100,102 

"K. (convert fi rst letter of block 
sentences to uppercase), 100, 

102 
"Kif (convert block to uppercase), 

100,102 
"K? (word count of marked 

block), 100, 222 
"K 0-9 (insert place marker), 193 
"KA (copy block between win­

dows), 60, 100, 109, 221 
"KB (mark beginning of block), 

37,99 
"KC (copy block), 99, 109 
"KD (save file, go to Opening 

Menu), 131, 203 
"KE (rename file while editing), 

200 
key definition ("K), PC-Outline, 

390,401 - 402 
keyboard buffer, and PC-Outline, 

420 
keyboard delay 

ProFinder, 332 
See also cursor speed 

keyboards, 1 50 - 1 52 
key descriptions, 151 

keys, for MailList sort, 236, 237 
keywords. See under Tel Merge 
"KF (run a DOS command), 

202 -203 
"KG (move block between 

windows), 100,221 
"KH (hide marked block), 38, 99, 

193 
"KI (column replace on/off), 99, 

105 
"KJ (delete a file), 119 
"KK (mark end of block), 37 - 38, 

99 
"KL (change drive/directory), 121 
"KN (column mode on/off), 

70 - 71,99, 104 - 105 
"KP (print file while editing), 194 
"KQ (quit file and abandon 

changes), 64, 131,204 
to exit protect file, 199 

"KR (read in a file), 99,109,149 
and column mode, 105 

"KS (save file and resume editing), 
203 

"KT (save and name file), 131, 
200,203 

"KV (move a block), 99 
"KW (write block to file), 99, 

109,203 

"KX (save file and exit), 50, 131, 
203 

"KY (delete block), 99, 119 
"KZ (sort block), 100, 209 

a list of names, 457 - 458 
personal dictionary, 212 

L ____ _ 

.L# (line numbering), 153 - 154 
"L 

find next instance of search text 
(ProFinder), 326 

as form feed symbol, 140 
move to last field (MaiIList), 83, 

232 
repeat previous find/replace, 

43,44-45,132 
LABEL3.LST,249 
LABEL (TelMerge keyword) 

in bulletin board script file, 276 
in CompuServe script file, 266 
defined, 295 

labels (for patching), 509 - 510 
labels (mailing), printing of, 

249 - 251 
landscape mode 

for phone directory, 455 - 456 
.PR OR = L, 152 

laser printers 
and envelope .LST files, 433 
mailing label printing, 249 
See also Hewlett-Packard 

LaserJet printers 
LaserJet printers. See Hewlett­

Packard LaserJet printers 
Layout pull-down menu, 27 

Footer option, 77 
Header option, 77 
Margins & Tabs dialog box, 

28-29 
New page option, 54 
Omit page numbering, 54 

leading. See line height 
leading spaces and zeros, in 

Mail List sort, 235 
lease agreement, 460 - 462 
left margin. See margins 
legal pleadings, line numbering 

of, 153 -154 
legal-size paper, and page length 

(.PL 14),185 
letters (on letterhead), 427 - 428 
.LH n (line height), 153 
library of standard paragraphs, 

459-460 

INDEX 

line-by-line mode, export block 
(PC-Outline), 392 

line 
delete, 23, 119, 358 
drawing of, 129 - 130, 

475-477 
go to specific line number 

("QI),135 
keep lines together (.CC), 107 
move to beginning of ("QS), 

204 
move to end of ("QD), 204 
overprint entire line ("P p), 

184 
line feed 

insert ("PJ), 152 
in PC-Outline, 381 

line height (.LH n), 153 
line number, predefined variable 

for merge printing, 165 
line numbering (.L#), 153 - 154 
line spacing ("OS), 154 -155 
LlNEDELAY (Tel Merge keyword) 

and connection problems, 303 
defined, 295 
and transmission problems, 276 

lines per page 
in PC-Outline, 380 
in WordStar (.PL), 54, 185 

List Windows ("Z), PC-Outline, 
387,405 

.LM (left margin), 30, 31, 158 
locate 

Mail List record, 234 
See also finding files; finding 

text 
.LOG file, 273 
logarithmic functions, onscreen 

calculator, 101 
LOGFILE (TelMerge keyword) 

in CompuServe script file, 266 
defined, 295 
and file problems, 304 

logfiles 
and ASCII transfer, 277 
erasure of, 304 
prompt for, 283 
in TelMerge, 273 - 274 
turn on/off (F7), 273 

logged drive and directory, 155, 
191 

LOGGING (TelMerge keyword), 
273 

automate entire session, 284, 
285 

in CompuServe script file, 266 
defined, 295 

LOGON (TelMerge keyword) 
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customize script file, 284 
defined, 296 

long distance prefixes, 303 
long documents, working with, 

479-482 
Lotus 1-2-3 

insert spreadsheet into docu-
ment, 149 

merge print data files from, 170 
and merge printing, 81 
sample Run command 

(ProFinder),334 
view files with ProFinder, 326, 

332 
lowercase characters. See case 

conversion 
.LQ (near letter quality printing), 

182 
.L5 (line spacing), 154 - 155 
LSRlABL3.l5T, 249 

____ M 

"M, carriage return character, 
288 

.MA (math) 
for merge printing, 169 
totals and subtotals for invoice, 

465 -466 
macros. See shorthand macros 
mailing labels 

merge printing of three-across 
labels, 434 - 438 

printing of, 249 - 251 
MAllLl5T.DOT, 241 

variables listed, 243 
Mail List 

add names and addresses, 
230 - 232 

backing up files, 239 
copy information ("C), 232 
create list, 81 -85 
cursor movement within forms, 

83,232 
data entry form, 231 
delete record, 234 
display next record ( "N), 85, 

232 
display previous record ("P), 

85,232 
edit mailing list, 85, 232 - 233 
exit, 238 
filter records, 233 - 234 
index files, 238 
label printing, 249-251 
locate a record, 234 
numbering of records, 230 

530 

overview of, 227 
report printing, 252 - 254 
Rolodex card printing, 249 - 250 
save record, ("W), 232 
sort records, 234 - 238 
starting, 229 - 230 
View and Edit Records Menu, 

85 
See also data files; form letters; 

master document; merge 
printing 

MAIL50RT.OVR,238 
mainframe computers, terminal 

emulation (TeIMerge), 276 
manual mode, export block 

(PC-Outline), 392 
margins, 156 - 160 

accelerator commands for, 76 
bottom margin (.BM), 159 -160 
change for notes ("ON U), 139 
change with ruler line, 202 
default values, 156 
for envelope printing, 428 
even right margins (PC-Outline), 

378 
header and footer margins, 160 
illustrated,157 
for landscape mode, 456 
left margin (.lM), 30, 31 
for letterhead, 427 
for meeting minutes, 439 
override margin setting ("OX), 

159 
page offset (.PO), 159 
paragraph margins (.PM), 145, 

160, 189 - 190, 446 
in PC-Outline 

display format, 374 - 375 
print format, 380 

print margin setting (proFinder), 
332 

release margin ("OX), 159 
right margin ("OR), 158 
right margin (.RM), 30, 31 
top margin (.MT), 159 - 160 

Margins & Tabs dialog box, 
28 - 29,158,218 

mark 
a block, 36 - 38, 98 
a block with ProFinder, 327 
a column block, 71 
PC-Outline entry (Alt-OO or 

F2),363 
markers 

go to place marker ("Q 0-9), 
135,193 

set place markers ("K 0-9), 193 
masking of variable data, 178 

mass mailings 
letter and envelope printing, 

431-434 
three-across mailing labels, 

434-438 
master document 

create, 85 - 87 
dot commands in, 166 -170 
end with .PA, 166 
for envelopes, 433 - 434 
for form letters, 431 - 432 
invoice example, 464 - 470 
lease agreement example, 

460 -462 
loan and interest rate example, 

474 
for merge printing, 241 - 242 
sample of, 244 
for three-across mailing labels, 

435-436 
math 

block operations, 38, 97 
interest rate calculation, 472 
and merge printing, 169 
onscreen calculator, 101 - 102 

math command (.MA), 169, 
465 -466 

Math Menu, 101 
MCIMail 

address and information about, 
312 

end of document marker (/), 
303 

receiving mail, 273 
send paper mail, 270- 271 
SERVICE keyword for, 301 

meeting minutes, 439 - 447 
memo field (dBA5E), 469 - 470 
memory. See RAM 
menu bar, 9 
Menu Bar, in PC-Outline, 357 
menus, 161 -164 

change between classic and 
pull-down, 5-4, 62 

change type with help level, 
5-4,143-144 

classic menus, 163 - 164 
create with ProFinder, 334 - 335 
in document and nondocument 

modes, 122 
install classic menus as default, 

5-11 
for patching, 511 - 512 
PRCHANGE menu map, 515 
pull-down menus, 161-163 
syntax for ProFinder menu file 

commands, 336 - 337 
WSCHANGE menu map, 501 



Merge print a file option, File pull­
down menu, 87 

merge printing, 164 -181 
conditional commands, 

171-176 
data files from other programs, 

171 
dot commands for, 86, 

127 - 128, 166 -170,242 
envelopes, 433 - 434 
form document, 171 
form letters, 87, 241 - 246, 

431 -432 
invoice example, 463 - 470 
loan and interest rate example, 

471 -474 
mailing labels, 249 - 251 
mailing labels (three-across), 

434-438 
messages while printing, 

180 -181 
and nested files, 183 
reports, 252 - 254 
Rolodex cards, 249 - 250 
variable number formatting, 

178 -180 
variable text formatti ng, 

177-178 
variables, 164 - 166 
See also Mai I List; master docu­

ment 
Message Bar, in PC-Outline, 358 
messages 

display while printing, 
180 - 181, 481 

error messages, 485 - 493 
microjustification (.UJ), 181 
minus key (-), Profinder copy hot 

key, 323 
MODEM (TelMerge keyword) 

in bulletin board script file, 276 
in communication service files, 

264 
defined, 296 
in TELMERGE.SYS, 265 

modems 
answer mode, 277, 278 
delay dialing with comma, 266 
dialing prefixes for, 298 
initialize, 294, 298 
set up of, 260 - 261 
speaker, on/off, 298, 301 

monitors 
CGA monitor installation, S-8 
color installation with 

WINSTALL, S-8 
color settings on a color monitor 

(WSCHANGE),504 

configuration for PC-Outline, 
389 

EGA monitor and 43-line 
display, S-8 

install with WINSTALL, S-8 
PC-Outline command line 

parameters, 419, 420 
and ProFi nder installation, 318 
See also snow 

monthly loan payment, master 
document for, 474 

move 
a block ("KV), 38, 99 
block between windows ("KG), 

100,221 
elements (PC-Outline), 352 
family between windows in 

PC-Outline ("W), 388 
files with ProFinder, 324 
marks in PC-Outline (Shift-FlO), 

365 
PC-Outline entries ("M), 352, 

362 
movement. See cursor movement 
.MT (top margin), 159 - 160 
multiline phones, and TelMerge 

operation, 259 
multiple copies, printing of, 

196-197 
multiple pages, and page preview, 

187 
multiplication 

onscreen calculator, 101 
See also math 

N ___ _ 

"N 
display next record (Mail List), 

85,232 
insert blank line, 97, 148 

N option (replace without asking), 
Find and replace text, 46 

names, add to MailListdata file, 
230- 232 

naming a file. See under files 
.NDX files, for MailList, 238 
near letter quality printing (.LQ), 

182 
nesting and chaining, 182 - 183 

chain printing files, 108, 183 
chaining shorthand definitions, 

70 
conditional page breaks, 482 
link files for printing (.FI), 182 
long document printing, 480 
nested .IF commands, 175 -176 

IN 0 EX 

nesting shorthand keys, 68 - 70 
NETWORK (TelMerge keyword), 

defined, 296 
new column command (.CB), 107 
New Outline New Window, 386 
New page option, Layout pull-

down menu, 54 
newsletters, 449 - 454 
newspaper-style columns (.CO), 

106 -107 
for phone di rectory, 457 

nondocument fj les, 95, 121 - 122 
create in a window, 222 
status line display, 214 

nondocument mode 
create a document, 110 
start from the command line, 

110 
Nondocumentoption (for print­

ing), 195 
nonprinting lines, 108 
normal font ("PN), 137 

choosing fonts with, 103 
See also fonts; pitch 

null modem transfer 
MODEM setting for, 296 
scriptfile for, 279 

Num Lock key, 150 
N umber of copies? option (for 

printing), 195 
NUMBER (TelMerge keyword) 

bulletin board script file, 276 
in CompuServe script file, 266 
defined, 297 

numbered list, 447 
outline example, 444 

numbering 
lines of text, 153 - 154 
of Mail List records, 230 
of an outline, 376 - 377 
of paragraphs, 190 - 191 
See also page numbering 

____ 0 ___ _ 

"0 
access Onscreen Format Menu, 

64 
set a tab interval in a nondocu­

ment,217 
/0, go to hexadecimal location 

(command line option), 213 
/0 (omit option) 

mailing label printing, 437 
and variable printing, 165 

"OA (auto-align text), 76, 93 
"OB (display soft spaces), 208 

531 
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"OC (center text), 103 
.OC on/off (center group of lines), 

103 
"00 (display/hide print control 

characters), 53, 121 
odd and even page numbers, 

headers and footers, 142 
"OE (soft hyphen), 76, 145 
"OF (create ruler from text), 202 
Official Airline Guides 

address and information about, 
312 

SERVICE keyword for, 301 
"OG (temporary indent), 76, 145 

and align text, 94 
"OH (hyphenation on/off), 76, 

144-145 
"01 (settabs), 117 - 118,217 
"OJ (justification), 150 
.OJ on/off (justification), 150 
"OK (open/switch between 

windows),221 
"OK (view another file with 

ProFinder),327 
"OL (Margins & Tabs dialog box), 

145,158 
"OM (size window), 221 
omit page numbering 

Layout pull-down menu option, 
54 

for merge printing (.OP), 87, 
242 

using .Or, 186 
"ONC (enter non printing com­

ment),108 
"OND (view or edit note), 139, 

147 
"ONG (find note), 139 
"ONI (type index entry), 140, 

146 
"ONL (spell check notes), 139 
Onscreen Format Menu, accessing 

("0),64, 163 
onscreen formatting, dot com­

mands, 125 -127 
ONTYME Messaging Service 

address and information about, 
312 

SERVICE keyword for, 301 
"ONU (change note margins), 

94,139 
"ONV (convert to different type 

of note), 139 
"00 (copy current ruler line), 

76,202 
.OP (omit page number), 186 

for merge printing, 87, 242 

532 

"OP (page preview), 76, 
187-189 

open 
a document file, 109 
a nondocument, 110 
an outline, 347 
PC-Outline window, 405 

open/switch between windows 
using "OK, 221 
Windows pull-down menu 

option, 59 
Opening Menu, PC-Outline, 347 
OPENING menu bar, 10, 18 
Opening screen, 9,161 
operators 

for auto patcher files, 513 
for IF condition (.IF), 172 

"OR (right margin), 158 
orphan control. See conditional 

page breaks (.CP) 
"OS (line spacing), 154 - 155 
"OT (ruler display on/off), 76, 

202 
Other pull-down menu 

Change help level option, 62 
Footnote/endnote option, 72 
Thesaurus Menu, 49 

outline 
create with WordStar, 443 - 444 
See also PC-Outline 

Outline Menu, PC-Outline, 
362 - 368 

outside lines 
accessing for TelMerge, 266 
dialing of, 303 

overprint character ("PH), 93, 
184 

overprinting lines ("P~), 451, 
452 

overtype mode, and editing, 23 
overwrite prompt, change setting 

for (PC-Outline), 389 
"OW (word wrap on/off), 76, 222 
"OX (margin release), 159 
"OZ (number paragraph), 

190-191 
create numbered list, 447 
outline example, 444 

p-----
"P 

access Print Controls Menu, 
164 

display previous record 
(MaiIList), 85, 232 

in shorthand macro definition, 
68 

"P! (custom print control), 
114-115 

.P# (paragraph numbering), 
190-191 

.P, hard page break (PC-Outline), 
373 

"P- (print in color), 104 
"P. (insert periods), 217 
"P = (choose font), 136 - 137, 

. 199 
"P ~ (overprint line), 184 
"P? (change default PDF file), 

194 
"PO (display extended character 

set),132 
"PA (alternate fonO, 137 

choosing fonts with, 103 
.PA (page advance), 185 

end master document with, 166 
for merge printing, 86, 242 

page breaks, 184 - 185 
column break (.CB), 107 
conditional (.CP), 482 
conditional page break, 185 
insert, 54 
page advance (.PA) for merge 

printing, 86, 242 
in PC-Outline (.P), 373, 380 

Page Down/Up. See PgDn; PgUp 
page length (.PL), 185 

default setting for, 54 
page numbering, 186 - 187 

compound numbering of 
chapters, 481 

in footer or header, 77 
and footers, 141 
omit, 54 
omit for merge printing (.OP), 

242 
omit from first page, 442 
PC-Outline, 380 
predefined variable for merge 

printing, 165 
symbol for (#), 77 

Page numbers option (for printing), 
195 

page offset (.PO), 159 
See also margins 

page preview (Alt-l or "OP), 76, 
187-189 

pages, go to specific page number 
("QI), 135, 186 

paper bin number (.BN), 205 
paper letter, 269 
paper trays. See sheet feeders 
paragraphs 



align rest of paragraph ("B), 32, 
76,94,145 

clear indent in PC-Outline ("X), 
372 

conditional insertion of (merge 
printing), 467 -468 

delete, 119 
hanging indent for, 79 - 80, 

189,440 
hanging indent in PC-Outline 

("0),372 
indent in PC-Outline ("I), 

371 - 372 
indentation setting, 78 - 79 
library of standard paragraphs, 

459-460 
margins for, 78, 145, 189 -190, 

446 
numbering of, 190 -191 
style of (PC-Outline), 374 - 375 

parent, defined, 350 
PARITY (TelMerge keyword), 

defined, 297 
password prompt customization, 

282 
PASSWORD (TelMerge keyword) 

in CompuServe script file, 266 
defined,297 

PATCH.LST,51O 
patching WordStar, 508 - 513 

See also customization 
paths, 191 

for PC-Outline, 389 
See also directories 

pause printer, 196 
command in text file ("PC), 

137,191-192 
between pages, 192, 195 

PAUSE (TelMerge keyword) 
automate entire session, 284, 

285 
defined,298 

"PB (boldface text), 53, 100 - 101 
in headers and footers, 143 

PBX systems. See outside lines 
PC-Outline 

access menus (FlO), 349 
Advance Printer One Line, 381 
Advance Printer Page, 381 
Advanced Menu, 388 - 394 
All Children at Level, 383 - 384, 

385 
All Children in Outline, 385 
All Family Children, 385 
All Family Text, 385 
All Text and Children, 353, 385 
All Text at Level, 384,385 
All Text in Outline, 384, 385 

Arrange Windows, 387,406 
backup files, 389 
boldface on/off, ("F3/"F4), 

370 
Change Current Drive or 

Directory, 360 
clear indent ("X), 372 
command keys listed, 409 - 413 
command line parameters, 

419-420 
conditional page break (.Cn), 

373 
configuration, 388 - 389 
continuousprinting, 380 
copy a block ("C), 370 
copy family between windows 

("Q),387 
copy marks (F9), 365 
create new outl ine entry (" ~ 

or "N), 359, 363 
create an outline, 350 - 353 
Current Entry's Children, 

hide/show, 352, 382 - 383, 
385 

Current Entry's Text, hide/show 
("PgDn),384 

Current Paragraph Style ("T), 
374 - 375 

cursor movement, 348, 
358 - 359 

Default Paragraph Style, 375 
delete 

block (" E), 370 
elements, 353 
to end of line (Shift-Del), 358 
entries ("D), 353, 363 
line ("Y), 358 
word to left (Shift--+), 358 
word to right (Shift-+-), 358 

Display Menu, 374 - 378 
divide outli ne entries (" U), 366 
double-strike on/off (Shift-

F5/Shift-F6), 371 
Edit Menu, 368 - 373 
Erase an Outline, 361 
Even Right Margins, 378 
export block, 391 - 393 
export fi les, 379 - 380 
File Menu, 359 - 362 
File Options, 361 
find and replace ("R), 369 
find string (" F), 369 
flatten outline, 394 
global outline style, 375 - 377 
hanging indent ("0),372 
help (Fl), 394 
Hide Menu, 382 - 384 

IN D EX 

hiding and showing text and 
children, 352 

import block, 393 - 394 
importfiles,361-362 
indent marks (F8), 364 - 365 
indent paragraph ("1),371 - 372 
insert live date (Shift-F2), 391 
insert live time (Shift-F4), 391 
insert static date (Shift-Fl), 391 
insert static time (Shift-F3), 391 
italic on/off ("F5/ "F6), 370 
join outline entries ("J), 

365 - 366 
key redefinition, 390, 401 - 402 
list windows ("Z), 387 
Load Existing Outline, 360 
Load Outline New Window, 

386 
load as RAM-resident (" \), 344 
macros, 388,401 - 402 
mark/unmark outline entries 

(Alt-OO or F2), 363 
menu use, 355 - 356 
move 

elements, 352 
family between windows 

("W),388 
marks (Shift-FlO), 365 
outline entries ("M), 362 
within the outline, 358 - 359 

numbering style of outline, 
376 - 377 

Opening Menu, 347 
option boxes, 356 
Outline Menu, 362 - 368 
overview of, 341 - 342 
page breaks, 373, 380 
paragraph style ("T), 374 - 375 
path/filename, 388, 389 
Place Outline Entry, 377 
printan outline, 353 
printer configuration, 415 - 417 
printer description files, 389, 

415-416 
printer feed, 380 
printer format, 370 - 371 
printer port, 389 
printing problems, 417 
printing to file, 379 
Project Management applica-

tion, 402 - 404 
promote marks (F7), 363 - 364 
quick key reference, 409 - 413 
quit, 353, 362 
Range Paragraph Style, 375 
range specification, 357, 379 
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Rename Current Outline, 360 
renumber outline, 378 
Ruler Bar, 358 
save an outline ("5), 353, 

359 - 360 
Set Device for Output, 379 - 380 
Set Page Format, 380 
Set Parent Directory, 361 
Set Printer Font, 381 
Set Range to Be Printed, 379 
shortcut keys, 356 
Show Menu, 384 - 385 
size a window, 387,406 
size of outline allowed, 376 
Skip Numbering, 378 
sorted lists, 398 - 399 
Start New Numbering, 378 
Start New Outline, 360 
starting, 343 - 344 
stop printing ("Break), 353 
subscript on/off ("F7/ .... F8), 371 
superscri pt on/off (Sh ift-F7 ISh ift-

F8),371 
tabs; 373 
templates, 400 - 401 
terminology used in, 350 
To-Do Lists, 396 - 398 
underline on/off ("Fl / "F2), 370 
undo a deletion (Alt-U), 368 
Window Bar, 358 
Window Menu, 386 - 388 
window operations, 404 - 407 
Zoom Window (gray -),387 

"PC (pause printer), 137, 
191-192 

.PC (print page number at specific 
location), 186 

PCo.CFG,375 
.PCO files, 347 
PCOLASER.PRN,416 
PCOMAC.CFG, 388 

and key definitions, 390 
PCOSTAN.PRN,416 
"PD (double strike text), 

128-129 
PDF file. See printer description 

file (PDF) 
PDFEDIT program, 51 7 
"PE (custom print control), 

114-115 
.PE (print endnote), 140 
"P~ (overprintline),451,452 
periods, insert in text ("P.), 217 
personal dictionary, 46 

add word to, 48; 211 - 212 
edit words in, 212 
use dictionary from earlier 

WordStar version, 5-4, 496 
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See also spelling check 
"PF (phantom character), 192 
.PF (print-time reformatting), 

169 -170 
and al igning text, 94 

PFINST,318 
"PG (phantom character), 192 
.PG (turn page numbering back 

on),186 
"PgDn (scroll down a line), 21, 

112,204 
PgDn (scroll down a screen), 112, 

204 
"PgUp (scroll up a line), 21, 112, 

204 
PgUp (scroll up a screen), 112, 

204 
"PH (overprint character), 93, 

184 
phantom characters, 192 
phone directory, 455 - 458 
phone numbers. See NUMBER 

(TelMerge keyword) 
phone systems 

with built-in modems, 261 
and TelMerge operation, 259 

"PI (inserttab character), 218 
Pick a Subdirectory, PC-Outline, 

361 
pitch,192 

See also fonts 
"PJ (insert line feed), 152 
"PK (index word), 146 
"PL (form feed), 140 
.PL (page length), 54,185 
place markers. See markers 
pleadings, line numbering of, 

153 -154 
plus key (+), ProFinder flip hot 

key, 322 - 323 
.PM (paragraph margin), 78, 145, 

189 -190, 446 
"PN (normal font), 137 

choosing fonts with, 103 
.PN (specify page number), 186 
"PO (binding space), 97 

and aligning text, 94 
.PO (page offset), 159 
PORT (TelMerge keyword) 

in communications service files, 
264 

defined, 298 
in TELMERGE.SYS, 265 

portrait mode (.PR OR = P), 152 
ports, 193 
POSTMODEM (TelMerge key­

word), defined, 298 

"PQ (custom print contro!), 
114-115 

"PR (custom print contra!), 
114-115 

.PR OR = (landscape/portrait 
mode),152 

landscape example, 455 - 456 
PRCHANGE,149 

creating a PDF, 515 - 516 
and custom print controls, 

114-115 
and customizing WordStar, 116 
described,499 - 500 
editing a PDF, 51 7 
menu map, 515 
modifying a PDF, 516 
and printing options, 195 
and sheet feeders, 205 
starting, 514 

PREFIX (Tel Merge keyword), 
defined,298 

PREMODEM (TelMerge keyword) 
defined,299 
and phone systems with built-in 

modems, 261 
previewing. See page preview; 

printing, to disk 
PRINT.TST, S-12 
print control codes 

delete, 53 
display on/off ("OD), 121 
display/hide in PC-Outline 

(Alt-Fl),381 
protocol transfer of, 275 
send printer-formatted output to 

file, 198 
stripped by TelMerge, 269, 305 

Print Controls Menu, 163, 164 
Print dialog box, options, 195 
PRINT (TelMerge keyword) 

automate entire session, 284, 
285 

defined,299 
and freezing up of communica­

tion, 304 
print session, 274 

print time reformatting command 
(.PF), 169 -170 

printer description file (PDF), 194 
change default PDF file while 

editing ("P?), 194 
creating, 515-516 
and custom print controls, 115 
editing, 517 
modifying, 516 
name with WIN5TALL, 5-9 
for printing to disk, 197 - 198 



send printer-formatted output to 
file, 198 

pri nter d river. See pri nter descri p­
tion file (PDF) 

Printer name option (for printing), 
195 

printers 
install with WINSTALL, S-8 to 

S-9 
PC-Outline configuration, 

415-417 
test installation, S-12 
See a/50 PRCHANGE 

printing 
boldface text ("PB), 53 
business letters, 427 - 428 
chain print several files, 

182 -183 
in color ("P-), 1 04 
communications session while 

online (F8), 274 
custom print controls, 114 - 115 
todisk,14-15,194,197-198 
display onscreen messages, 481 
dot commands for formatting, 

123 -125 
envelopes, 247 - 248, 

428 - 429,433 - 434 
afile,14-15 
a file while editing ("KP), 194 
form letters, 87, 244,431 - 432 
hide/display print control 

symbols ("OD), 53 
interrupting, 55 
italic text, 150 
long documents, 481 
mailing labels, 249 - 251, 

434-438 
messages while merge printing, 

180-181 
multiple copies, 196 -197 
near letter quality printing 

(.LQ),182 
options, 195 
outlines,353,379-381 
Printing Screen commands, 196 
ProFinder file list, 325 
ProFinder marked blocks ("KP 

or F6), 327 
reports from MailList data, 

252 - 254 
Rolodex cards, 249 - 250 
underlined text, 53, 219 - 220 

Printing dialog box, 15 
Printing screen commands, 196 
.PRN files, for PC-Outline, 379, 

416 

procedural numbering style, in 
PC-Outline, 376 

ProFinder, 317 - 338 
ASCII file format for viewing, 

326 
block operations, 327 
change date and time of files, 

325 
change directories, 321 
command line options, 333 
configuration options, 331 - 333 
copy files, 324 
copy hot key (-),323,332 
cursor movement, 320 
delete files, 324 
described, 317 
display selected filenames, 321 
exit, 329 
fi Ie titles, 320 
finding files, 327 - 328,337 
finding text, 326, 338 
flip hot key (+), 322 - 323, 332 
Go to DOS command, 

333 - 334 
group tag/untag offiles, 323, 

337 
hot keys, 322 - 323, 331 - 332 
installation of, 318 
keyboard delay, 332 
menu creation with, 334 - 337 
move files, 324 
print file list, 325 
print margin setting, 332 
print marked block ("KP or F6), 

327 
save configuration, 332 - 333 
sort a file list, 322 
start, 319 
start WordStar from, 322 - 323 
tab settings, 332 
tag/untag a file ("K or F3), 323, 

337 
view another fi Ie ("OK or F9), 

327 
viewing files, 325 
write filenames to a file, 325, 

337 
program fi Ie transfer. See protocol 

transfer 
Project Management, PC-Outline 

application, 402 - 404 
ProKey, deactivate for PC-Outline 

(lK),420 
PROMPT (Tel Merge keyword), 

defined,299 
prompts, 198 

customizing in TELMERGE.SYS, 
282 - 283 

IN 0 EX 

merge printing and the .AV 
command, 167 -168 

on pull-down menus, 162 
and the repeat answer command 

("R),198 
proportional fonts, 137 - 138 
proportional spacing 

on/off toggle (.PS), 199 
See a/50 fonts 

protect a fi Ie, 199 - 200 
Protected Mode, and backup files, 

96 
PROTOCOL (Tel Merge keyword) 

defined,300 
XMODEM CRC, 277 

protocol transfer 
bulletin boards, 277 
for data collection, 278 
described,275 
types supported by TelMerge, 

275 
"PrtSc, save and printfile, 77 
PRVIEW printer description file, 

197 
.PS (proportional spacing), 199 
"PS (underline text), 219 - 220 

in headers and footers, 143 
"PT (superscript), 215 
pull-down menus, 161 - 163 

described, 9 
File pull-down menu, 10 
Go To pull-down menu, 43 
Layout pull-down menu, 27 
in PC-Outline, 349 
Spelling Check Menu, 48 
Style pull-down menu, 52 
use of, S-2 
See a/50 menus 

pulse dialing, and PREFIX 
(TelMerge keyword), 298 

"PV (subscript), 215 
"PW (custom print contro!), 

114-115 
"PX (strikeout text), 214 - 215 
"PY (italics text), 150 

--------Q --------
"Q (quick movement command), 

112-114 
"Q = (find font tag), 133, 137 
"Q Del (delete line to left of 

cursor), 119 
"Q? (word count from beginning 

offile to cursor position), 222 
"Q 0-9 (go to place marker), 135, 

193 
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"QA (find and replace text), 132 
"QB (move to beginning of 

block), 100, 135 
"QC (move to end of fi Ie), 112 
"QD (move to end of line), 204 
"QF (find text), 132 

in ProFinder, 326 
"QG (go to next occurrence of 

specified character), 135 
"QG (WordStar/ASCII toggle for 

ProFinder), 326, 332 
"QH (go to previous occurrence 

of specified character), 135 
"QI (go to pagelline number), 

135, 186 
"QJ (thesaurus), 50, 218-219 
"QK (move to end of block), 100, 

135 
"QL (spell check entire docu­

ment), 210, 211 
"QM (calculator), 101 - 102 
"QN (spell check one word), 

210,211 
"QO (spell check word not in 

document), 210, 211 
"QP (return to previous location 

in text), 135 
"QQ (repeat a command), 

200-201 
"QS (move to beginning of line), 

204 
"QT (delete to specific character), 

119 
"QU (align rest of document), 94 
Quattro 

insert spreadsheet into docu­
ment, 149 

merge print data files from, 170 
question mark (?) 

access WSCHANGE help, 502 
and finding text, 134 
ProFinder wild-card character, 

321 
in TELMERGE.SYS scripts, 288 

Quick Menu, 163 
quick movement command ("Q), 

112-114 
QUIET (TelMerge keyword), 

defined,300 
quit 

and abandon changes (" KQ), 
64 

PC-Outline, 353, 362 
See also exit 

QUITMENU.PF,337 
"QV 

find previous instance of search 
text (ProFinder), 326 

536 

go to last find/replace or block, 
135 

"QW (scroll continuously up, 
one line at a time), 204 

"QX (move to right of last 
onscreen line), 112 

"QY (delete line to right of 
cursor), 119 

"QZ (scroll continuously down, 
one line at a time), 204 

____ R 

"RO (clear tabs), 117 
"R 

repeat answer at prompt, 198 
restore tabs, 11 7 
scroll up a screen, 112,204 

ragged right text, 32 
RAM-resident programs 

and freezing up ofTelMerge, 
304 

PC-Outl i ne loaded as ( " \), 
344 

remove PC-Outline from mem­
ory (" Backspace), 
344- 345 

use with TelMerge, 259 
and using with WordStar, 203 

RAM 
amount required (384K), 5-5 
amount to reserve for PC­

Outline, (1M), 419 
display RAM usage, 161 
memory usage by WordStar, 

161 
and opening windows, 58 
and shorthand macros, 67, 207 
and size of documents, 160 

RBBS. See bulletin boards 
RCA Telex/TELEXTRA 

address and information about, 
312 

SERVICE keyword for, 301 
read a file into document ("KR), 

99,109 
and column mode, 105 

read variable command (.RV), 
166-167 

read variable with range specifica­
tion command (.RV*), 171 

README program, 5-12 
Ready files, read into PC-Outline, 

361 
reboot computer, 5-12 
rebuild index files, 238 
receive a file 

ASCII transfer, 277 
XMODEM protocol (F5), 277 

Record Numberfield, in MailList, 
230 

records in MailList. See data files 
redial. See TRY (TelMerge keyword) 
Redirect output to option (for 

printing), 195, 198 
redline text ("PX), 214 - 215 
reformat text. See aligning text 
Registration Card, 5-13 
remove 

PC-Outline from memory 
( "Backspace), 344 - 345 

a thesaurus definition ("U), 50 
See also delete 

Rename Current Outline, 360 
rename a file ("KE), 200 
repeat 

answer at prompt ("R), 198 
, a command ("QQ), 200 - 201 

previous find/replace ("L), 43, 
44-45,132 

replace text. See under finding 
text 

reports, printing from MailList 
data, 252 - 254 

Reset All Places, 377 
Reset Numbering, in PC-Outline, 

378 
restore deleted text. See undo 

("U) 
restore tabs ("R), 11 7 
Return key. See Enter key (~) 
right-justify text. See under aligning 

text 
"[ (type escape character), 115 
right margin. See margins 
.RM (right margin), 30,31,158 
ROLODEX.LST, 249 
Rolodex cards, printing of, 

249-250 
.RP (repeat printing), 196 - 197 
.RR (embed ruler line), 77, 

201 -202 
and margin settings, 158 

rubout, 192 
Ruler Bar, in PC-Outline, 358 
ruler line, 201 - 202 

copy current ruler line ("00), 
76 

create versions in WSCHANGE, 
77 

default settings, 27 
display on/off ("OT), 76 
predefined rulers, 202 
tab stops, 28 - 29 

Run a DOS command, 202 - 203 



with ProFinder, 333 - 334 
.RV * (read variable with range 

specification), 171 
.RV (read variable), 86, 166 - 167, 

242 

____ s 
"S 

move between menus, 161 
move left one character, 83, 

111,232 
save sort order (MaiIList), 237 

.SAV files, 273 
save 

commands for, 203 - 204 
customizations, 508 
data record ("W), 83, 85, 232 
a file, 12 -13,24,39 
fileandexit("KX),131,203 
file and go to Opening Menu 

("KD), 131,203 
and name file ("KT), 131,200, 

203 
an outline ("S), 353, 359 - 360 
paragraph style settings 

PC-Outline),375 
and print file ("PrtSc), 77 
ProFinder configuration, 

332 - 333 
and resume editing ("KS), 203 
sort order ("U or "S), 237 

SAY (TelMerge keyword) 
bulletin board script file, 276 
create prompt, 274 
defined,300 

scientific notation 
for block math, 97 
onscreen calculator, 102 

screen capture 
during communications session 

(logfiles), 273 - 274 
with Snap Shot (F5), 286 

screen display, problems with 
TelMerge, 304 

screen updating, PC-Outline 
command line parameter (I T), 

420 
script files. See TELMERGE.SYS 
scrolling, 21 

commands for, 204 
and cursor movement, 

112-114 
the file directory, 120 

search for text. See finding text 
section numbering, 190-191 

send a file (F4), 275 
ASCII transfer, 275 
to CompuServe, 270 
CompuServe A protocol, 275 
to MCI Mail, 271 
telex message, 273 

send a file (F6), XMODEM check­
sum/CRC protocols, 277 

SEND (TelMerge keyword) 
automate entire session, 284, 

285 
defined, 300 

sentence, delete, 119 
sequential numbering style, in 

PC-Outline, 376 
serial port 

and modem connection, 260 
See also PORT (TelMerge 

keyword) 
SERVICE (TelMerge keyword) 

in CompuServe script file, 266 
defined,301 

set variable command (.5V), 168 
formatting of numbers for 

printing, 178 - 180 
and variable formatting, 

177 -178 
sheet feeders, 205 

install with WINSTALL, S-9 
ShoFil (F8), 286 
shorthand macros, 206 - 208 

for bullets, 447 
chaining shorthand definitions, 

70 
characters already defined, 65 
commands listed, 206 - 207 
define, 207 - 208 
define characters, 66 - 68 
described,65 
display currently defined 

characters, 67 
nesting shorthand keys, 68 - 70 
reverse names in a list, 458 

Shorthand Menu, 65, 163,207 
show. See display 
SideKick, load before WordStar 

caution, 203 
SIMPLE printer description file, 

194,517 
single-spaced text. See line height; 

line spaci ng 
"6 

auto-indent (nondocument 
mode), 95 - 96 

change hard returns to soft 
returns (document mode), 
95,209 

size of documents, and RAM, 160 

IN D EX 

size window 
using "OM, 221 
Window pull-down menu 

option, 60 - 61 
skip records in data file, 469 
snaking columns (newspaper-style 

columns), 106 - 107 
Snap Shot (F5), 286 
snow 

controlling for PC-Outline, 420 
correct for ProFinder, 332 
and PC-Outline display, 389 
See also monitors 

soft carriage returns, 208 - 209 
soft hyphen 

finding, 133 
inserting ("OE), 76, 145 

soft spaces, 208 
sort 

a block ("KZ), 1 00,209 
date field, 237 
a file list (ProFinder), 322 
a list of names, 457 - 458 
MailList records, 234 - 238 
PC-Outline levels, 367 - 368 

sorted lists, create with 
PC-Outline, 398 - 399 

Source Telecomputing. See The 
Source 

spaces 
and MailList sort, 235 
phantom space, 192 
soft spaces, 208 
See also binding space ("PO) 

speed 
of printing, 195 
and ProFinder video setting, 18 
of the repeat command, 195 
of scrolling ("QW/ "QZ), 204 

Speed Write, 11, 109,209 
spelling check, 209 - 212 

add word to personal dictionary, 
211-212 

bypass word once, 211 
commands for, 48 
double word check, 209 
entire document ("QL), 210, 

211 
footnotes and endnotes ("ON L), 

139 
global correction, 211 
ignore a word, 211 
insert word at cursor position, 

211 
location of dictionary, S-ll 
one word ("QN),210,211 
options, 211 
Other pull-down menu, 47 
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INDEX 

overview of, 46 
personal dictionary, 46 
stop check (" U), 210 
type a replacement word, 211 
word not in document ("QO), 

210,211 
Spelling Check Menu, 48 
spreadsheet mode, export block 

(PC-Outline),392 
spreadsheets 

insert into document, 149 
use data from for merge printing, 

170-171 
See a/so specific program 

names throughout index 
.5R (set roll for sub/superscripts), 

215 
starting 

PRCHANGE,514 
ProFinder, 319 
WordStar, S-13, 8, 212 - 213 

from ProFinder, 322 - 323 
Status Column, in PC-Outline, 

358 
status line, 20 

and column block mode, 70 
in document and nondocument 

modes, 122 
information contained in, 

213-214 
and windows, 59 

stop 
printing ("U), 55, 196 
printing an outline (" Break), 

353 
repeating a command ("U), 

200 
shorthand macro loop (" U), 70 
spell check ("U), 48, 210 

STOPS (TelMerge keyword), 
defined,301 

store-and-forward mode (telex), 
271,272 

strikeout text ("PX), 214 - 215 
structured files 

export outline file to, 380 
read into PC-Outline, 361 

Style pull-down menu, 52 
Choose font option, 72 

subscripts (" PV), 215 
subtotals for invoice, 465 - 466 
subtraction 

onscreen calculator, 101 
See a/50 math 

SUFFIX (TelMerge keyword), 
defined,301 

SuperKey, deactivate for 
PC-Outline UK), 420 

538 

superscripts ("PT), 215 
.SV (set variable), 168 

formatting of numbers for 
printing, 178 - 180 

in invoice example, 466 
and variable formatting, 

177-178 
switch between windows 

in PC-Outline (Alt 1-9), 387, 
405 

using "OK, 221 
Windows pull-down menu 

option, 59 
SWITCH.COM, 151 - 152 
switch settings, for Hayes modems, 

260-261 
Symphony 

insert spreadsheet into docu­
ment, 149 

merge print data files from, 170 
and merge printing, 81 

synonyms, 218 - 219 
looking up, 50 
user synonym file for ProFinder, 

326,328,331 
See a/50 thesaurus 

syntax, for ProFinder menu file 
commands, 336 - 337 

_________ T ________ _ 
"T 

delete word, 22, 119 
move to top (first) field (MaiIList), 

83,232 
tabbed columns, 106 
table of contents generation, 

216-217 
tables. See columns 
tabs, 21 7 - 218 

clear tabs ("RO), 29,117 
decimal tabs ("01), 117 -118 
in document and nondocument 

modes, 122 
Margins & Tabs dialog box, 

28-29,158,218 
in nondocuments, 217 - 218 
in PC-Outline, 373 
ProFinder settings, 332 
restore tabs ( "R), 11 7 
setting of ("01),29,217 

tagging and untagging offiles, in 
ProFinder, 323, 337 

.TB (tab setting), 117 

.TC (table of contents), 216 - 217 

.TEL files, 264 

telephone numbers. See NUMBER 
(TelMerge keyword) 

telex 
add service to TELMERGE.5YS, 

267 
interactive mode, 271, 

272 -273 
ITT format for message, 271 
line wrap problems, 304 
message format, 271 
punctuation marks lost in 

message, 305 
receive a telex, 273 
send a telex, 271 - 273 
store-and-forward mode, 271, 

272 
TELEXTRA. See RCA Telex/TELEX­

TRA 
TELMERGE.EXE,259 
TELMERGE.SYS, 259 

add new service to, 267 
add telex service to, 267 
adding information to, 

265 - 267 
automate entire session, 

284-285 
bulletin board scripts, 276 - 277 
comment lines in, 288 
communication service files, 

263 
CompuServe script file, 266 
control characters in, 288 
data collection script, 278 
keyword order, 287 
keywords listed, 288 - 302 
log-on customization, 284 
logfile name prompt, 283 
null modem script, 279 
password prompt customization, 

282 
printer or disk file output 

prompt,283 
reprogramming of, 282 - 285 
special characters in, 288 

TelMerge 
answer mode, 277, 278 
automated communications 

session, 284 - 285 
communications service files, 

create, 264 
communications service registra­

tion, 263 
connection problems, 303 - 304 
data networks to access service, 

266 
data transfer, types of, 275 
default settings 



communications service 
files, 264 

Hayes modem switches, 
260-261 

keywords, 288 - 302 
for TELMERGE.SYS, 265 
terminal emulation 

(VT100),276 
XMODEM checksum, 277 

delay modem dialing with 
comma,266 

display keyword settings (Fl), 
287 

exit while online, 286 
fi les created by other word 

processors, 305 
floppy disk systems and, 307 
function key assignments, 

309-310 
function key customization, 

281-282 
go to DOS (F3), 286 
hardware requirements, 259 
keywords 

display keyword settings 
(Fl),287 

listed, 288 - 302 
NUMBER required, 287 
order of, 287 
special characters in, 288 

logfiles, 273 - 274, 304 
modem setup, 260 - 261 
multiple file transfers with wild-

card character, 279 
null modem transfer, 279 
overviewof,257 
PC to PC transfers, 276 - 278 
print control commands stripped 

from files, 269, 305 
print session while online (F8), 

274 
printing problems, 305 
receive electronic mail, 

273 -274 
return online (F8), 286 
save current screen (F5), 286 
screen display problems, 304 
script file for, 265 - 267 
send electronic mail, 269 - 271 
send a file (F4), 275 
send telex document, 271 - 273 
setting up, 259 - 260 
ShoFil (F8), 286 
shortcuts, 281 - 286 
Snap Shot (F5), 286 
TelMerge to TelMerge transfer, 

279 
terminal emulation, 276 

troubleshooting, 303 - 305 
templates, PC-Outline application, 

400-401 
temporary fi les, 218 
temporary indent ("OG), 76, 145 

and align text, 94 
terminal emulation 

for Tel Merge, 276 
See also EMULATE (TelMerge 

keyword) 
TERMINAL (TelMerge keyword), 

defined,302 
text, defined (PC-Outline), 350 
The Source 

address and information about, 
312 

data transfer, 276 
SERVICE keyword for, 301 

thesaurus ("QJ), 218 - 219 
location of dictionary, 5-11 
options listed, 219 
use of, 49 - 50 

Thesaurus Menu, 49 
ThinkTank files, read into 

PC-Outline, 361 
three-across mailing labels, merge 

printing of, 434 - 438 
thumbnail display, and page 

preview, 188 
time 

change file time (ProFinder), 
325 

display of in PC-Outline, 358 
insert current time (Esc ]),207 
insert in PC-Outline, 391 
predefined variable for merge 

printing, 165 
Time/date stamp (ProFinder), 325 
TIMETRAN. See under ITT 
Title Toggle, in PC-Outline, 378 
TITLES.PF, 320 
To-Do Lists, create with 

PC-Outline, 396 - 398 
.TOC file, 216 
toggle commands, 219 
tone dialing, and PREFIX (TelMerge 

keyword), 298 
top margin. See margins 
totals for invoice, 465 - 466 
training,S - 87 
Training Work Disk, setting up, 

7-8 
Transfer Windows (Alt 1-9), 

PC-Outline, 387,405 
trigonometric functions, onscreen 

calculator, 101 
TRY (TelMerge keyword), 270 

defined,302 

IN D EX 

Turbo Lightning, synonym file and 
ProFinder, 326, 328 

tutorials,S - 87 
TYPEWR printer description file, 

194,516 
typing, accelerator commands for, 

76 

u ___ _ 
"U 

cancel printing, 196 
exit Thesaurus Menu, 50 
remove a definition (thesaurus), 

50 
return to editing from thesaurus, 

219 
save sort order and sort 

(MaiIList),237 
sort records (MaiIList), 235 
stop printing, 55 
stop shorthand macro loop, 70 
stop spell check, 210 . 
stop spelling check, 48 
undo,23,220 

column block erasure, 71 
and column mode, 105 
restore deleted text, 220, 479 

use filter (Mail List), 234 
. UJ (microjustification), 181 
.UL (underline spaces and words), 

220 
underline text ("PS), 53, 

219 - 220 
in headers and footers, 143 
underline spaces and words 

(.UL),220 
See also double underline 

undo (" U), 23, 220 
column block erasure, 71 
and column mode, 105 
restore deleted text, 220, 479 

unerasing. See undo 
untagging files, in ProFinder, 323 
upgrade notes 

file transfer from earlier versions, 
495 -496 

patches from earlier versions, 
509 

for users of older WordStar 
versions, S-4 to 5-5 

uppercase characters. See case 
conversion 

Use form feeds option (for print­
ing), 195 

USEDTR (TelMerge keyword), 
defined, 302 
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user area, 509 - 511 
user synonym file, for F'roFinder, 

326,328,331 
USERID (TelMerge keyword) 

in CompuServe script file, 266 
defined,302 

USERMENU.PF, 334, 335 
USERSYN .PF, 331 

__________ V ________ __ 

"V (insert mode on/off), 148 
variables 

ampersand and variable names, 
86,242 

and conditional commands, 
171-176 

formatting of numbers for 
printing, 178 -180 

formatting of text for printing, 
177 -178 

listing of, 243 
mask out character(s), 178 
number formatting, 466 
/0 (omit) option, 165 
predefined variables, 165 
rules for, 164 - 165 
.RV command (read variables 

from data file), 242 
text formatting, 466 

video. See monitors 
video retrace setting, for 

PC-Outline, 389 
VIDTEX terminal emulation 

described,276,291 
EMULATE keyword, 290 
FULLStREEN keyword, 292 

View and Edit Records Menu, 85 
view a file (ProFinder), 325 

set file format default, 332 
view another file with ProFinder 

("OK or F9), 327 
VT25 terminal. See VIDTEX 

terminal emulation 
vn 00 terminal emulation 

described, 276, 291 
EMULATE keyword, 290 
FULLSCREEN keyword, 292 

____ w ___ _ 
"W 

save data record (MaiIList), 83, 
85,232 

scroll di rectory, 120 
scroll up a line, 112,204 

WAIT (TelMerge keyword) 

540 

automate entire session, 284, 
285 

defined,302 
widow control. See conditional 

page breaks (.CP) 
wi Id-card characters 

display selected filenames 
(ProFinder),321 

and erasing files, 119 
and finding text, 133 
group tag files (ProFinder), 323, 

337 
multiple file transfers (TeIMerge), 

279 
Window pull-down menu, 58 

Close and abandon window 
option, 61 

Copy block from other window 
option, 60 

Open/switch between windows 
option, 59 

Size current window option, 
60-61 

windows, 221 
block operations in, 100 
close, 61, 221 
copy block between ("KA), 

1 00, 109,221 
copy text between windows, 60 
described,57 
move block between ("KG), 

100,221 
open, 58 - 59 
open/switch between ("OK), 

59,221 
in PC-Outline 

arrange, 387,406 
close, 407 
copy information between, 

407 
list, 405 
opening, 405 
sizing of, 406 
switch between (Alt 1-9), 387, 

405 
zoom (gray -), 387 

size window ("OM), 221 
sizing of, 60 - 61 
switch between, 59, 221 

WINSTALL,149 
CON FIG .SYS, S-l 0 
finishing the installation, S-12 
name disk drives, S-l 0 
printer installation, S-8 to S-9 
starting, S-7 to S-8 

word 
count number of words in block 

("K?),100 

delete ("T), 22, 119 
word (a data item), patching and, 

511 
word count, 222 

entire file or files, 222 
in marked block ("K?), 222 
text from beginning offile to 

cursor position ("Q?), 222 
word wrap, 222 

automatic indentation command 
(.PM),78 

and hanging indentation, 
79-80 

on/off toggle ("OW), 76 
word wrap mode, export block 

(PC-Outline),392 
WordStar 2000 

export outline file to, 380 
PC-Outline printer description 

file,415 
read file into PC-Outline, 362 

WordStar Professional 4 
conversion of WordS tar 5 files, 

496-497 
export outline file to, 380 
read file into PC-Outline, 361 
transfer customizations to new 

version, 496 
WS4 printer descri ption file, 

197 
See also upgrade notes 

WordStar ProfessionalS 
convert fi les to WordStar 4 

format, 496 - 497 
export outline file to, 380 
file transfer from earlier versions, 

495-496 
overview, S-l to S-3 
PC-Outline printer description 

file,416 
read file into PC-Outline, 361 
See also upgrade notes 

Working Screen, in PC-Outline, 
348,357 

worksheet. See spreadsheet 
write block to fi Ie ( "KW), 99, 

109,204 
WS3KEYS.PAT, 504 
WS4.PDF, 197,497 
WSCHANGE, 149,222 - 223 

change help level, 504 
changing a setting, 503 
color settings on a color monitor, 

504 
common customization options, 

506- 507 
create versions of ruler line, 77 



and customizing WordStar, 
115-116 

described,499 
exit, 514 
function key customization, 

503 - 504 
margin settings, 505 
menu map, 501 
patching WordStar, 508 - 513 
and printing options, 195 
return to original settings, 505 
starting, 500 

WSINDEX.XCL,147 
WSLlST.DEF, 231, 239 
WSLlSTDTA,230 

__________ X ________ __ 
"X 

move cursor down one line, 
111 

move menu highlight bar, 162 
save changes in WSCHANGE, 

503 
.XE (custom pri nt contro!), 114 
.XL (define form feed string), 141 
XMODEM checksum/CRC proto-

cols 
described, 275 
receive a file (F5), 277 
send a file (F6), 275, 277 

.XQ (custom print control), 114 

.XR (custom print control), 114 

IN D EX 

XTRACT printer description file, 
197 

.XW (custom print control), 114 

.XX (redefine strikeout character), 
215 

--------- y ---------
"Y (delete line), 23, 119,358 

__________ Z ________ __ 
"Z 

scroll directory, 120 
scroll down a line, 112,204 

zeros, and MailList sort, 235 
zoom, and page preview, 187 
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